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     [bookmark: pgfId-1260728]Preface 
      
      
 
     
 
 
    [bookmark: pgfId-1260729]This preface describes the audience, organization, and conventions of the Cisco DCNM Fundamentals Guide. It also provides information on how to obtain related documentation.
 
     
      [bookmark: pgfId-1247773]Audience
 
     [bookmark: pgfId-1208100]This guide is for experienced network administrators who are responsible for configuring and maintaining the Cisco MDS 9000 Family of multilayer directors and fabric switches.
 
    
 
     
      [bookmark: pgfId-1208101]Organization
 
     [bookmark: pgfId-1245982]This guide is organized as follows:
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1250225]Chapter 
          
  
         	 
           
           [bookmark: pgfId-1250227]Title 
          
  
         	 
           
           [bookmark: pgfId-1250229]Description 
          
  
        
 
         
         	[bookmark: pgfId-1250234]Chapter 1
  
         	[bookmark: pgfId-1250241]Introduction to Cisco Data Center Network Manager
  
         	[bookmark: pgfId-1250244]Provides a brief overview of Cisco DCNM Fundamentals.
  
        
 
         
         	[bookmark: pgfId-1253724]Chapter 4
  
         	[bookmark: pgfId-1253726]Cisco DCNM-SAN Overview
  
         	 
        
 
         
         	[bookmark: pgfId-1255256]Chapter 3
  
         	[bookmark: pgfId-1255260]Cisco Prime DCNM Web Client
  
         	[bookmark: pgfId-1255263]Provides a brief overview of Cisco DCNM-SAN.
  
        
 
         
         	[bookmark: pgfId-1250267]Chapter 5
  
         	[bookmark: pgfId-1250272]Configuring Cisco DCNM-SAN Server
  
         	[bookmark: pgfId-1250274]Provides in-depth descriptions of GUI and capabilities of Cisco DCNM-SAN Server.
  
        
 
         
         	[bookmark: pgfId-1250279]Chapter 6
  
         	[bookmark: pgfId-1250283]Configuring Authentication in Cisco DCNM-SAN
  
         	[bookmark: pgfId-1250286]Describes the authentication schemes between Cisco DCNM-SAN components and fabric switches.
  
        
 
         
         	[bookmark: pgfId-1250291]Chapter 7
  
         	[bookmark: pgfId-1250296]Configuring Cisco DCNM-SAN Client
  
         	[bookmark: pgfId-1250298]Provides in-depth descriptions of GUI and capabilities of Cisco DCNM-SAN.
  
        
 
         
         	[bookmark: pgfId-1250303]Chapter 8
  
         	[bookmark: pgfId-1250308]Device Manager
  
         	[bookmark: pgfId-1250310]Provides in-depth descriptions of GUI and capabilities of Device Manager.
  
        
 
         
         	[bookmark: pgfId-1250315]Chapter 9
  
         	[bookmark: pgfId-1250320]Configuring Performance Manager
  
         	[bookmark: pgfId-1250322]Provides overview of the Performance Manager architecture.
  
        
 
         
         	[bookmark: pgfId-1250339]Chapter 10
  
         	[bookmark: pgfId-1250344]Monitoring the Network
  
         	[bookmark: pgfId-1250346]Provides details on monitoring the network.
  
        
 
         
         	[bookmark: pgfId-1250351]Chapter 11
  
         	[bookmark: pgfId-1250356]Monitoring Performance
  
         	[bookmark: pgfId-1250358]Provides details on using Performance Manager.
  
        
 
         
         	[bookmark: pgfId-1250580]Chapter 12
  
         	[bookmark: pgfId-1250585]Overview of DCNM-LAN
  
         	[bookmark: pgfId-1250587]Provides an overview of what you need to do to start using Cisco Data Center Network Manager for LAN (DCNM-LAN).
  
        
 
         
         	[bookmark: pgfId-1250384]Chapter 13
  
         	[bookmark: pgfId-1250500]Installing and Launching the Cisco DCNM-LAN Client
  
         	[bookmark: pgfId-1250589]Describes how to install and set up the Cisco DCNM-LAN client.
  
        
 
         
         	[bookmark: pgfId-1250549]Chapter 14
  
         	[bookmark: pgfId-1250506]Using the Cisco DCNM-LAN Client
  
         	[bookmark: pgfId-1250623]Introduces the Cisco DCNM-LAN client and explains how to use it.
  
        
 
         
         	[bookmark: pgfId-1250553]Chapter 15
  
         	[bookmark: pgfId-1250514]Administering DCNM-LAN Authentication Settings
  
         	[bookmark: pgfId-1250657]Describes how to administer the Cisco DCNM-LAN server user accounts.
  
        
 
         
         	[bookmark: pgfId-1250559]Chapter 27
  
         	[bookmark: pgfId-1250520]Administering Device Discovery
  
         	[bookmark: pgfId-1250678]Describes how to use the Device Discovery feature.
  
        
 
         
         	[bookmark: pgfId-1250851]Chapter 28
  
         	[bookmark: pgfId-1250791]Administering Devices and Credentials
  
         	[bookmark: pgfId-1250766]Describes how to use the Devices and Credentials feature.
  
        
 
         
         	[bookmark: pgfId-1250862]Chapter 16
  
         	[bookmark: pgfId-1250801]Working with Topology
  
         	[bookmark: pgfId-1250770]Describes how to use the Topology feature.
  
        
 
         
         	[bookmark: pgfId-1250876]Chapter 29
  
         	[bookmark: pgfId-1250820]Administering Auto-Synchronization with Devices
  
         	[bookmark: pgfId-1250778]Describes how to use the Auto-Synchronization with Devices feature.
  
        
 
         
         	[bookmark: pgfId-1250882]Chapter 31
  
         	[bookmark: pgfId-1250826]Working With Threshold Rules
  
         	[bookmark: pgfId-1250780]Describes how to configure threshold rules.
  
        
 
         
         	[bookmark: pgfId-1250976]Chapter 30
  
         	[bookmark: pgfId-1250926]Administering Statistical Data Collection
  
         	[bookmark: pgfId-1250929]Describes how to control statistical data collection.
  
        
 
         
         	[bookmark: pgfId-1250982]Chapter 34
  
         	[bookmark: pgfId-1250934]Working with Network Analysis
  
         	[bookmark: pgfId-1250936]Describes how to track and monitor the latency between two specified switches.
  
        
 
         
         	[bookmark: pgfId-1250986]Chapter 32
  
         	[bookmark: pgfId-1250940]Administering DCNM-LAN Server Log Settings
  
         	[bookmark: pgfId-1250943]Describes how to control Cisco DCNM-LAN server logs.
  
        
 
         
         	[bookmark: pgfId-1250991]Chapter 25
  
         	[bookmark: pgfId-1250947]Starting and Stopping Cisco DCNM-LAN Servers
  
         	[bookmark: pgfId-1250950]Describes how to start and stop the Cisco DCNM-LAN server.
  
        
 
         
         	[bookmark: pgfId-1250996]Chapter 35
  
         	[bookmark: pgfId-1250954]Maintaining the Cisco DCNM-LAN Database
  
         	[bookmark: pgfId-1250957]Describes how to maintain the Cisco DCNM-LAN database.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1208840]Document Conventions
 
     [bookmark: pgfId-1208858]Command descriptions use these conventions: 
 
      
       
        
         
         	[bookmark: pgfId-1208843]boldface font
  
         	[bookmark: pgfId-1208845]Commands and keywords are in boldface.
  
        
 
         
         	[bookmark: pgfId-1208847]italic font
  
         	[bookmark: pgfId-1208849]Arguments for which you supply values are in italics.
  
        
 
         
         	[bookmark: pgfId-1208851][ ]
  
         	[bookmark: pgfId-1208853]Elements in square brackets are optional.
  
        
 
         
         	[bookmark: pgfId-1208855][ x | y | z ]
  
         	[bookmark: pgfId-1208857]Optional alternative keywords are grouped in brackets and separated by vertical bars.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1208884]Screen examples use these conventions: 
 
      
       
        
         
         	[bookmark: pgfId-1208861]screen font
  
         	[bookmark: pgfId-1208863]Terminal sessions and information the switch displays are in screen font.
  
        
 
         
         	[bookmark: pgfId-1208865]boldface screen font
  
         	[bookmark: pgfId-1208867]Information you must enter is in boldface screen font.
  
        
 
         
         	[bookmark: pgfId-1208869]italic screen font
  
         	[bookmark: pgfId-1208871]Arguments for which you supply values are in italic screen font.
  
        
 
         
         	[bookmark: pgfId-1208873]< >
  
         	[bookmark: pgfId-1208875]Nonprinting characters, such as passwords, are in angle brackets.
  
        
 
         
         	[bookmark: pgfId-1208877][ ]
  
         	[bookmark: pgfId-1208879]Default responses to system prompts are in square brackets.
  
        
 
         
         	[bookmark: pgfId-1208881]!, #
  
         	[bookmark: pgfId-1208883]An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1208885]This document uses the following conventions:
 
      
       
     
 
     
 
     [bookmark: pgfId-1208886]Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the manual.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1208887] 
      Caution Means 
      reader be careful. In this situation, you might do something that could result in equipment damage or loss of data. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1251319]In this document, the following shortened names are used:
 
      
      	 [bookmark: pgfId-1251320]Cisco Data Center Network Manager for SAN is also referred to as DCNM-SAN.
 
      	 [bookmark: pgfId-1251321]Cisco Data Center Network Manager for LAN is also referred to as DCNM-LAN.
 
     
 
    
 
     
      [bookmark: pgfId-1252749][bookmark: marker-1252747]Related Documentation[bookmark: marker-1252748]
 
     [bookmark: pgfId-1252752]This section contains information about the documentation available for Cisco DCNM and for the platforms that Cisco DCNM manages.
 
     [bookmark: pgfId-1252757]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1252760]Cisco DCNM Documentation
 
      	 [bookmark: pgfId-1252764]Cisco Nexus 1000V Series Switch Documentation
 
      	 [bookmark: pgfId-1252768]Cisco Nexus 2000 Series Fabric Extender Documentation
 
      	 [bookmark: pgfId-1252772]Cisco Nexus 3000 Series Switch Documentation
 
      	 [bookmark: pgfId-1252776]Cisco Nexus 4000 Series Switch Documentation
 
      	 [bookmark: pgfId-1252780]Cisco Nexus 5000 Series Switch Documentation
 
      	 [bookmark: pgfId-1252784]Cisco Nexus 7000 Series Switch Documentation
 
     
 
      
       [bookmark: pgfId-1252789][bookmark: 70739]Cisco DCNM Documentation
 
      [bookmark: pgfId-1252793]The Cisco DCNM documentation is available at the following URL:
 
      [bookmark: pgfId-1252796]http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html
 
      [bookmark: pgfId-1252799]The documentation set for Cisco DCNM includes the following documents:
 
     
 
      
       [bookmark: pgfId-1252801]Release Notes
 
      [bookmark: pgfId-1252804]Cisco DCNM Release Notes, Release 7.1.x
 
     
 
      
       [bookmark: pgfId-1254662]Cisco DCNM
 
      [bookmark: pgfId-1254663]The following publications support both Cisco DCNM for LAN and DCNM for SAN, and address the new licensing model, the new installation process, and the new features of Cisco DCNM:
 
       
       	 [bookmark: pgfId-1254664]Cisco DCNM Fundamentals Guide, Release 7.1.x
 
       	 [bookmark: pgfId-1254665]Cisco DCNM Installation Guide, Release 7.1.x
 
      
 
     
 
      
       [bookmark: pgfId-1252816]Cisco DCNM for LAN Configuration Guides
 
      [bookmark: pgfId-1255738]FabricPath Configuration Guide, Cisco DCNM for LAN
 
      [bookmark: pgfId-1255739]Interfaces Configuration Guide, Cisco DCNM for LAN
 
      [bookmark: pgfId-1255740]Layer 2 Switching Configuration Guide, Cisco DCNM for LAN
 
      [bookmark: pgfId-1255741]Security Configuration Guide, Cisco DCNM for LAN
 
      [bookmark: pgfId-1255742]System Management Configuration Guide, Cisco DCNM for LAN
 
      [bookmark: pgfId-1255743]Unicast Configuration Guide, Cisco DCNM for LAN
 
      [bookmark: pgfId-1255744]Virtual Device Context Configuration Guide, Cisco DCNM for LAN
 
      [bookmark: pgfId-1255745]Virtual Device Context Quick Start, Cisco DCNM for LAN
 
      [bookmark: pgfId-1252851]Web Services API Guide, Cisco DCNM for LAN
 
     
 
      
       [bookmark: pgfId-1252854][bookmark: 56774]Cisco DCNM for SAN Configuration Guides
 
      [bookmark: pgfId-1255811]System Management Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255812]Interfaces Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255813]Fabric Configuration Guide, Cisco DCNM for SAN 
 
      [bookmark: pgfId-1255814]Quality of Service Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255815]Security Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255816]IP Services Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255817]Intelligent Storage Services Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255818]High Availability and Redundancy Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1255819]Inter-VSAN Routing Configuration Guide, Cisco DCNM for SAN
 
      [bookmark: pgfId-1252893]SMI-S and Web Services Programming Guide, Cisco DCNM for SAN
 
     
 
      
       [bookmark: pgfId-1252900][bookmark: 46564]Cisco Nexus 1000V Series Switch Documentation
 
      [bookmark: pgfId-1252903]The Cisco Nexus 1000V Series switch documentation is available at the following URL:
 
      [bookmark: pgfId-1252906]http://www.cisco.com/en/US/products/ps9902/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252910][bookmark: 42534]Cisco Nexus 2000 Series Fabric Extender Documentation
 
      [bookmark: pgfId-1252914]The Cisco Nexus 2000 Series Fabric Extender documentation is available at the following URL:
 
      [bookmark: pgfId-1252917]http://www.cisco.com/en/US/products/ps10110/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252919][bookmark: 92320]Cisco Nexus 3000 Series Switch Documentation
 
      [bookmark: pgfId-1252922]The Cisco Nexus 3000 Series switch documentation is available at the followingURL:
 
      [bookmark: pgfId-1252925]http://www.cisco.com/en/US/products/ps11541/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252927][bookmark: 55748]Cisco Nexus 4000 Series Switch Documentation
 
      [bookmark: pgfId-1252930]The Cisco Nexus 4000 Series switch documentation is available at the following URL:
 
      [bookmark: pgfId-1252933]http://www.cisco.com/en/US/products/ps10596/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252935][bookmark: 42671]Cisco Nexus 5000 Series Switch Documentation
 
      [bookmark: pgfId-1252938]The Cisco Nexus 5000 Series switch documentation is available at the following URL:
 
      [bookmark: pgfId-1252941]http://www.cisco.com/en/US/products/ps9670/tsd_products_support_series_home.html
 
     
 
      
       [bookmark: pgfId-1252943][bookmark: 97219]Cisco Nexus 7000 Series Switch Documentation
 
      [bookmark: pgfId-1252946]The Cisco Nexus 7000 Series switch documentation is available at the following URL:
 
      [bookmark: pgfId-1252949]http://www.cisco.com/en/US/products/ps9902/tsd_products_support_series_home.html
 
     
 
    
 
     
      [bookmark: pgfId-1251665]Additional Related Documentation for Cisco MDS 9000
 
     [bookmark: pgfId-1251650]The documentation set for the Cisco MDS 9000 Family includes the following documents. To find a document online, use the Cisco MDS NX-OS Documentation Locator at:
 
     [bookmark: pgfId-1249440]http://www.cisco.com/en/US/docs/storage/san_switches/mds9000/roadmaps/doclocater.htm
 
      
       [bookmark: pgfId-1249441]Release Notes 
 
       
       	 [bookmark: pgfId-1249442] Cisco MDS 9000 Family Release Notes for Cisco MDS NX-OS Releases  
 
       	 [bookmark: pgfId-1249443] Cisco MDS 9000 Family Release Notes for MDS SAN-OS Releases 
 
       	 [bookmark: pgfId-1249444] Cisco MDS 9000 Family Release Notes for Cisco MDS 9000 EPLD Images 
 
      
 
     
 
      
       [bookmark: pgfId-1249446]Regulatory Compliance and Safety Information 
 
       
       	 [bookmark: pgfId-1249447]Regulatory Compliance and Safety Information for the Cisco MDS 9000 Family 
 
      
 
     
 
      
       [bookmark: pgfId-1249448]Compatibility Information 
 
       
       	 [bookmark: pgfId-1249449]Cisco Data Center Interoperability Support Matrix
 
       	 [bookmark: pgfId-1249450]Cisco MDS 9000 NX-OS Hardware and Software Compatibility Information and Feature Lists
 
       	 [bookmark: pgfId-1249451] Cisco MDS 9000  Family Switch-to-Switch Interoperability Configuration Guide 
 
      
 
     
 
      
       [bookmark: pgfId-1249452]Hardware Installation 
 
       
       	 [bookmark: pgfId-1249453]Cisco MDS 9500 Series Hardware Installation Guide 
 
       	 [bookmark: pgfId-1249454]Cisco MDS 9200 Series Hardware Installation Guide 
 
       	 [bookmark: pgfId-1249455] Cisco MDS 9100 Series Hardware Installation Guide 
 
       	 [bookmark: pgfId-1249456]Cisco MDS 9124 and Cisco MDS 9134 Multilayer Fabric Switch Quick Start Guide
 
      
 
     
 
      
       [bookmark: pgfId-1249457]Software Installation and Upgrade 
 
       
       	 [bookmark: pgfId-1249458]Cisco MDS 9000 NX-OS Software Upgrade and Downgrade Guide
 
      
 
     
 
      
       [bookmark: pgfId-1249459]Cisco NX-OS 
 
       
       	 [bookmark: pgfId-1249460]Cisco MDS 9000 Family NX-OS Licensing Guide
 
       	 [bookmark: pgfId-1249461]Cisco MDS 9000 Family NX-OS Fundamentals Configuration Guide
 
       	 [bookmark: pgfId-1249462]Cisco MDS 9000 Family NX-OS System Management Configuration Guide
 
       	 [bookmark: pgfId-1249463]Cisco MDS 9000 Family NX-OS Interfaces Configuration Guide
 
       	 [bookmark: pgfId-1249464]Cisco MDS 9000 Family NX-OS Fabric Configuration Guide
 
       	 [bookmark: pgfId-1249465]Cisco MDS 9000 Family NX-OS Quality of Service Configuration Guide
 
       	 [bookmark: pgfId-1249466]Cisco MDS 9000 Family NX-OS Security Configuration Guide
 
       	 [bookmark: pgfId-1249467]Cisco MDS 9000 Family NX-OS IP Services Configuration Guide
 
       	 [bookmark: pgfId-1249468] Cisco MDS 9000 Family NX-OS Intelligent Storage Services Configuration Guide 
 
       	 [bookmark: pgfId-1249469]Cisco MDS 9000 Family NX-OS High Availability and Redundancy Configuration Guide 
 
       	 [bookmark: pgfId-1249470] Cisco MDS 9000 Family NX-OS Inter-VSAN Routing Configuration Guide 
 
       	 [bookmark: pgfId-1249471]Cisco MDS 9000 Family Cookbook for Cisco MDS SAN-OS
 
      
 
     
 
      
       [bookmark: pgfId-1249484]Command-Line Interface 
 
       
       	 [bookmark: pgfId-1249485]Cisco MDS 9000 Family Command Reference 
 
      
 
     
 
      
       [bookmark: pgfId-1249486]Intelligent Storage Networking Services Configuration Guides 
 
       
       	 [bookmark: pgfId-1249487]Cisco MDS 9000 Family I/O Acceleration Configuration Guide
 
       	 [bookmark: pgfId-1249488]Cisco MDS 9000 Family SANTap Deployment Guide 
 
       	 [bookmark: pgfId-1249489]Cisco MDS 9000 Family Data Mobility Manager Configuration Guide 
 
       	 [bookmark: pgfId-1249490]Cisco MDS 9000 Family Storage Media Encryption Configuration Guide 
 
      
 
     
 
      
       [bookmark: pgfId-1249491]Troubleshooting and Reference 
 
       
       	 [bookmark: pgfId-1249492]Cisco MDS 9000 Family and Nexus 7000 Series System Messages Reference
 
       	 [bookmark: pgfId-1249493]Cisco MDS 9000 Family SAN-OS Troubleshooting Guide 
 
       	 [bookmark: pgfId-1249494]Cisco MDS 9000 Family NX-OS MIB Quick Reference 
 
       	 [bookmark: pgfId-1249495]Cisco DCNM for SAN Database Schema Reference
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1249496][bookmark: 55984]Obtaining Documentation and Submitting a Service Request
 
     [bookmark: pgfId-1249497]For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:
 
     [bookmark: pgfId-1249499]http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-98950]New and Changed Information 
      
      
 
     
 
 
    [bookmark: pgfId-103038]The information in the new Cisco Fabric Manager Fundamentals Configuration Guide previously existed in Part 1:Getting Started, Part 8: Network and Switch Monitoring, and various Appendices of the Cisco MDS 9000 Family Fabric Manager Configuration Guide. 
 
    [bookmark: pgfId-102178]Table ii-1 lists the New and Changed features for this guide. 
 
    [bookmark: pgfId-102221]
 
     
      
       
       [bookmark: pgfId-114308]Table ii-1 [bookmark: 22488]New and Changed Features for Cisco DCNM Release 7.2.x 
 
       
       
        
        	 
          
          [bookmark: pgfId-114316]Feature 
         
  
        	 
          
          [bookmark: pgfId-114318]New or Changed Topics 
         
  
        	 
          
          [bookmark: pgfId-114320]Changed in Release 
         
  
        	 
          
          [bookmark: pgfId-114322]Where Documented 
         
  
       
 
        
        	[bookmark: pgfId-117217]Configuring Templates
  
        	[bookmark: pgfId-117219]Template Structure
  
        	[bookmark: pgfId-117221]7.2(3)
  
        	[bookmark: pgfId-117223]Chapter 3, “Cisco Prime DCNM Web Client”
  
       
 
        
        	[bookmark: pgfId-114324]Border Leaf/Edge Router Auto-Configuration
  
        	[bookmark: pgfId-114326]Border Leaf Settings
 [bookmark: pgfId-114327]Connect New Border leaf to the Edge Router
  
        	[bookmark: pgfId-114329]7.1(1)
  
        	[bookmark: pgfId-114333]Chapter 3, “Cisco Prime DCNM Web Client”
  
       
 
        
        	[bookmark: pgfId-114336]VxLAN Support for Nexus 6000 Series and Nexus 9000 Series Switches
  
        	[bookmark: pgfId-114338]Viewing Inventory Information
  
        	[bookmark: pgfId-114340]7.1(1)
  
        	[bookmark: pgfId-114344]Chapter 3, “Cisco Prime DCNM Web Client”
  
       
 
        
        	[bookmark: pgfId-114347]Config sync on POAP
  
        	[bookmark: pgfId-114349]Power-On Auto Provisioning (POAP)
  
        	[bookmark: pgfId-114351]7.1(1)
  
        	[bookmark: pgfId-114355]Chapter 3, “Cisco Prime DCNM Web Client”
  
       
 
        
        	[bookmark: pgfId-114358]Multiple Orchestrators Support
  
        	[bookmark: pgfId-114360]L2 Segment ID Range Management
  
        	[bookmark: pgfId-114362]7.1(1)
  
        	[bookmark: pgfId-114366]Chapter 3, “Cisco Prime DCNM Web Client”
  
       
 
        
        	[bookmark: pgfId-114369]Three Tier Topology
  
        	[bookmark: pgfId-114371]Inter Switch Links View
  
        	[bookmark: pgfId-114373]7.1(1)
  
        	[bookmark: pgfId-114377]Chapter 3, “Cisco Prime DCNM Web Client”
  
       
 
        
        	[bookmark: pgfId-114380]Secure LDAP for Fabric
  
        	[bookmark: pgfId-114382]Fabric
  
        	[bookmark: pgfId-114384]7.1(1)
  
        	[bookmark: pgfId-114388]Chapter 3, “Cisco Prime DCNM Web Client”
  
       
 
        
        	[bookmark: pgfId-114391]Multiple Mobility Domains with VLAN Translation
  
        	[bookmark: pgfId-114393]Mobility Domains
  
        	[bookmark: pgfId-114395]7.1(1)
  
        	[bookmark: pgfId-114399]Chapter 3, “Cisco Prime DCNM Web Client”
  
       
 
        
        	[bookmark: pgfId-114402]Slow drain
  
        	[bookmark: pgfId-114404]Slow Drain Analysis
  
        	[bookmark: pgfId-114406]7.1(1)
  
        	[bookmark: pgfId-114410]Chapter 3, “Cisco Prime DCNM Web Client”
  
       
 
       
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-106411][bookmark: 56803]Introduction to Cisco Data Center Network Manager 
      
      
 
     
 
 
    [bookmark: pgfId-103609]Cisco Data Center Network Manager (DCNM) is a management system for the Cisco Unified Fabric. It enables you to provision, monitor, and troubleshoot the data center network infrastructure. It provides visibility and control of the unified data center so that you can optimize for the quality of service (QoS) required to meet service-level agreements.
 
    [bookmark: pgfId-103612]Cisco DCNM increases overall data center infrastructure uptime and reliability, thereby improving business continuity. It provides a robust framework and comprehensive feature set that meets the routing, switching, and storage administration needs of data centers. Cisco DCNM streamlines the provisioning for the unified fabric and monitors the SAN and LAN components. Cisco DCNM provides a high level of visibility and control through a single web-based management console for Cisco Nexus, Cisco MDS, and Cisco Unified Computing System products.
 
    [bookmark: pgfId-103677]Cisco DCNM also supports the installation of the Cisco DCNM for SAN and Cisco DCNM for LAN components with a single installer. All Cisco DCNM for SAN and Cisco DCNM for LAN product documentation is now published to the Data Center Network Manager listing page on Cisco.com: 
 
    [bookmark: pgfId-103024]http://www.cisco.com/en/US/products/ps9369/tsd_products_support_configure.html.
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1519285][bookmark: 92652]Cisco Prime DCNM User Roles 
      
      
 
     
 
 
    [bookmark: pgfId-1550393]Cisco DCNM defines what operations a user can perform in Cisco DCNM Web Client by controlling what features are available in the menu and tool bar items. Cisco DCNM role-based authorization limits access to the server operations depending on the user roles. 
 
    [bookmark: pgfId-1550394]This chapter contains following sections:
 
     
     	 [bookmark: pgfId-1550398]Cisco DCNM Credentials
 
     	 [bookmark: pgfId-1550399]Cisco DCNM Users
 
     	 [bookmark: pgfId-1550606]DCNM Roles
 
     	 [bookmark: pgfId-1550891]Roles from Cisco DCNM Perspective
 
    
 
   
 
    
     [bookmark: pgfId-1519342][bookmark: 40876]Cisco DCNM Credentials
 
    [bookmark: pgfId-1543292]Cisoc DCNM has two sets of credentials, namely:
 
     
     	 [bookmark: pgfId-1561944]Device credentials—used to discover and manage devices
 
     	 [bookmark: pgfId-1561960]Cisco DCNM credentials—used to access the Cisco DCNM server.
 
    
 
    [bookmark: pgfId-1549812]This document describes about DCNM credentials and how user roles are mapped to specific set of DCNM server operations.
 
   
 
    
     [bookmark: pgfId-1519468][bookmark: 52660]Cisco DCNM Users
 
    [bookmark: pgfId-1550814]Cisco DCNM user-based access allows the administrator to control the access to the Cisco DCNM server by using the DCNM client (Web Client or LAN client). The user access is secured by a password. 
 
   
 
    
     [bookmark: pgfId-1550836][bookmark: 13802]DCNM Roles
 
    [bookmark: pgfId-1562396]Cisco DCNM performs authorization of access to the users based on roles. The role-based authorization limits access to the Cisco DCNM server operations based on the roles to which the users are assigned. Cisco DCNM does not define new roles to access the DCNM server; however, the Cisco DCNM leverages the existing roles that are supported on the devices monitored, such as Cisco MDS 9000 Series Switches, and Cisco Nexus Switches. 
 
    [bookmark: pgfId-1562464]Cisco DCNM supports following roles:
 
     
     	 [bookmark: pgfId-1551353]global-admin
 
     	 [bookmark: pgfId-1551381]network-admin
 
     	 [bookmark: pgfId-1551400]lan-network-admin
 
     	 [bookmark: pgfId-1551424]san-network-admin
 
     	 [bookmark: pgfId-1551454]san-admin
 
     	 [bookmark: pgfId-1551476]server-admin
 
     	 [bookmark: pgfId-1551490]sme-admin
 
     	 [bookmark: pgfId-1551714]sme-stg-admin
 
     	 [bookmark: pgfId-1551754]sme-kmc-admin
 
     	 [bookmark: pgfId-1551789]sme-recovery
 
     	 [bookmark: pgfId-1551823]network-operator
 
    
 
    [bookmark: pgfId-1551861]In a typical enterprise environment, users and their roles are defined in a centralized place such as, TACACS+, RADIUS or LDAP. As Cisco DCNM supports the existing device roles, the administrator need not define new roles specifically.
 
   
 
    
     [bookmark: pgfId-1557030][bookmark: 37948]Roles from Cisco DCNM Perspective
 
    [bookmark: pgfId-1557040]Cisco DCNM perspective defines the operations a user can perform on the Cisco DCNM client by controlling the menu and tool bar items. Different perspectives define different set of operations.
 
    [bookmark: pgfId-1562596]For example, the Admin perspective allows all the operations by showing all the menu and tool bar items where as Operator perspective allows limited set of operation by hiding Admin and Config Menu items. 
 
    [bookmark: pgfId-1557041]Each DCNM user role is mapped to a particular DCNM perspective, which allows limited access to server features. DCNM clients support following four perspectives:
 
     
     	 [bookmark: pgfId-1557031]Admin Perspective
 
     	 [bookmark: pgfId-1557106]Server Admin Perspective
 
     	 [bookmark: pgfId-1557120]SME Perspective
 
     	 [bookmark: pgfId-1557125]Operator Perspective
 
    
 
    [bookmark: pgfId-1557406]Table 2-1 describes how DCNM roles are mapped to client perspectives.
 
    [bookmark: pgfId-1557465]
 
     
      
       
       [bookmark: pgfId-1557410]Table 2-1 [bookmark: DCNM_Roles_and_Perspectives_Mapping_Table]DCNM Roles and Perspectives Mapping Table
 
       
       
        
        	 
          
          [bookmark: pgfId-1557414]Role 
         
  
        	 
          
          [bookmark: pgfId-1557416]Perspective 
         
  
       
 
        
        	[bookmark: pgfId-1557418]global-admin
  
        	 [bookmark: pgfId-1557420]Admin Perspective
  
       
 
        
        	[bookmark: pgfId-1557422]network-admin
  
       
 
        
        	[bookmark: pgfId-1557426]san-admin
  
       
 
        
        	[bookmark: pgfId-1557430]san-network-admin
  
       
 
        
        	[bookmark: pgfId-1557434]lan-network-admin (Web Client)
  
       
 
        
        	[bookmark: pgfId-1557438]server-admin
  
        	[bookmark: pgfId-1557440]Server Admin Perspective
  
       
 
        
        	[bookmark: pgfId-1557442]sme-admin
  
        	 [bookmark: pgfId-1557444]SME Perspective
  
       
 
        
        	[bookmark: pgfId-1557446]sme-sgt-admin
  
       
 
        
        	[bookmark: pgfId-1557450]sme-kmc-admin
  
       
 
        
        	[bookmark: pgfId-1557454]sme-recovery
  
       
 
        
        	[bookmark: pgfId-1557458]network-operator
  
        	 [bookmark: pgfId-1557460]Operator Perspective
  
       
 
        
        	[bookmark: pgfId-1557462]lan-network-admin (SAN Thick Client)
  
       
 
       
     
 
    
 
     
      [bookmark: pgfId-1557786][bookmark: 34586]Admin Perspective
 
     [bookmark: pgfId-1558530]Admin Perspective can be accessed through the Cisco DCNM Web Client and SAN Client only, by the users who are assigned the role of global-admin, network-admin, san-admin, san-network-admin and lan-network-admin.
 
    
 
     
      [bookmark: pgfId-1557814]Web Client Admin Perspective
 
     [bookmark: pgfId-1557857]Web client admin perspective has full control of the DCNM server and can access all the features. Via the access to the Admin menu items, the users also has full control of Cisco DCNM authentication settings.
 
    
 
     
      [bookmark: pgfId-1557863]SAN Thick Client Admin Perspective
 
     [bookmark: pgfId-1557904]SAN thick client admin perspective has full control of the DCNM server and can access all the features. All the top-level menu items are accessible.
 
    
 
     
      [bookmark: pgfId-1557910][bookmark: 30647]Server Admin Perspective
 
     [bookmark: pgfId-1559307]Server admin perspective can be accessed via web client and SAN thick client only by the users who are assigned the role of server-admin.
 
    
 
     
      [bookmark: pgfId-1557940]Web Client Server Admin Perspective
 
     [bookmark: pgfId-1559395]Web client server admin perspective has access to all the web client features. Via the access to the Admin menu items, the users also has full control of Cisco DCNM authentication settings.
 
    
 
     
      [bookmark: pgfId-1557986]SAN Thick Client Server Admin Perspective
 
     [bookmark: pgfId-1559534]The configuration capabilities of a server admin role are limited to FlexAttach and relevant data. The server admin can pre-configure SAN for new servers, move a server to another port on the same NPV device or another NPV device and replace a failed server onto the same port without involving the SAN administrator. The server admin will not be able to manage Fabric Manager users or connected clients. The menu items that are not related to server management are not accessible, e.g. Zone, Performance, etc. SAN thick client server admin perspective has no access to Discover button, Fabrics and License Files tabs. The server admin is not able to manage Fabric Manager users or connected clients in SAN thick client.
 
    
 
     
      [bookmark: pgfId-1558035][bookmark: 60444]SME Perspective
 
     [bookmark: pgfId-1559921]Storage Media Encryption (SME) perspective is designed for sme-admin, sme-sgt-admin, sme-kmc-admin and sme-recovery role-based users. It can be categorized to five different sme admin perspective according to the roles:
 
      
      	 [bookmark: pgfId-1560114]Web Client SME Admin Perspective
 
      	 [bookmark: pgfId-1560148]SME Storage Perspective
 
      	 [bookmark: pgfId-1560162]SME Key Management Perspective
 
      	 [bookmark: pgfId-1560176]SME Recovery Perspective
 
      	 [bookmark: pgfId-1560190]SAN Thick Client SME Perspective
 
     
 
    
 
     
      [bookmark: pgfId-1558063][bookmark: 88955]Web Client SME Admin Perspective 
 
     [bookmark: pgfId-1559888]Web client sme admin perspective is designed to sme-admin role users who have no access to Admin and Config menu items in the Web client and cannot use features under those menu items. On the other hand, the SME provision features are accessible.
 
    
 
     
      [bookmark: pgfId-1560642][bookmark: 94629]SME Storage Perspective 
 
     [bookmark: pgfId-1560643]SME storage perspective is designed to the sme-stg-admin role users. sme-stg-admin role users have same perspective as sme-admin role except you cannot manage the key management features.
 
    
 
     
      [bookmark: pgfId-1560802][bookmark: 78223]SME Key Management Perspective
 
     [bookmark: pgfId-1560858]SME key management perspective is designed to the sme-kmc-admin role users. sme-kmc-admin role users have same perspective as sme-admin role except that you cannot perform SME configurations.
 
    
 
     
      [bookmark: pgfId-1565394][bookmark: 25961]SME Recovery Perspective
 
     [bookmark: pgfId-1565395]SME recovery perspective is designed to the sme-recovery role users for master key recovery. sme-recovery role users have same perspective as sme-admin role except that you cannot perform the storage and key management features.
 
    
 
     
      [bookmark: pgfId-1565397][bookmark: 17986]SAN Thick Client SME Perspective
 
     [bookmark: pgfId-1565398]SAN thick client SME perspective has no access to Discover button, Fabrics and License Files tabs.All the SME related perspective would not be able to manage Fabric Manager users or connected clients, as well as operator perspective.
 
    
 
     
      [bookmark: pgfId-1558374][bookmark: 21904]Operator Perspective
 
     [bookmark: pgfId-1561257]Operator perspective is designed for network-operator and lan-network-admin role users, and lan-network-admin role only has SAN thick client operator perspective. 
 
    
 
     
      [bookmark: pgfId-1558248]Web Client Operator Perspective
 
     [bookmark: pgfId-1561315]Web client operator perspective has no access to Admin and Config menu items and the features under those menu items cannot be used. All the other features can be used.
 
    
 
     
      [bookmark: pgfId-1558458]SAN Thick Client Operator Perspective
 
     [bookmark: pgfId-1561267]SAN thick client operator perspective has no access to Discover button, Fabrics and License Files tabs, and would not be able to manage Fabric Manager users or connected clients.
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1614587][bookmark: 19264]Cisco Prime DCNM Web Client 
      
      
 
     
 
 
    [bookmark: pgfId-1607240]Using Cisco Prime DCNM Web Client, you can monitor Cisco MDS and Nexus family switch events, performance and inventory, and perform minor administrative tasks.
 
    [bookmark: pgfId-1607241]Cisco Prime DCNM Web Client has few Graphical User Interface related changes. The new Cisco Prime DCNM Web Client is user experience (UX) 1.7 compliant.
 
    [bookmark: pgfId-1607242]The default user credentials to access DCNM 7.1.x are as configured during the deployment of the installers.
 
    [bookmark: pgfId-1607243]Cisco Prime DCNM Web Client provides the following features: 
 
     
     	 [bookmark: pgfId-1607247]Navigating DCNM Web Client
 
     	 [bookmark: pgfId-1607251]Downloading Cisco Prime DCNM-SAN Client
 
     	 [bookmark: pgfId-1607255]Downloading Cisco Prime DCNM-LAN Client
 
     	 [bookmark: pgfId-1607259]Downloading Cisco Device Manager Client
 
     	 [bookmark: pgfId-1607263]Connecting to a Switch using the CLI
 
     	 [bookmark: pgfId-1607267]Viewing Dashboard Information
 
     	 [bookmark: pgfId-1607271]Viewing Health Information
 
     	 [bookmark: pgfId-1607275]Viewing Performance Information
 
     	 [bookmark: pgfId-1607279]Viewing Inventory Information
 
     	 [bookmark: pgfId-1607283]Viewing and Creating Custom Reports
 
     	 [bookmark: pgfId-1607287]Configuring Cisco Prime DCNM Web Client
 
     	 [bookmark: pgfId-1607291]Administering Cisco Prime DCNM Web Client
 
     	 [bookmark: pgfId-1607295]Using Cisco Prime DCNM Web Client with SSL
 
    
 
   
 
    
     [bookmark: pgfId-1607297][bookmark: 91275]Navigating DCNM Web Client
 
    [bookmark: pgfId-1607298]The DCNM Web Client has standardized certain navigation conventions.
 
     
     	 [bookmark: pgfId-1607302]Scope Menu
 
     	 [bookmark: pgfId-1607306]Admin Menu
 
     	 [bookmark: pgfId-1607310]Table and Filtering Navigation
 
     	 [bookmark: pgfId-1607314]Printing
 
     	 [bookmark: pgfId-1607318]Exporting to a File
 
     	 [bookmark: pgfId-1607322]Sorting Columns
 
     	 [bookmark: pgfId-1607326]Cisco Prime DCNM Web Search Engine
 
    
 
     
      [bookmark: pgfId-1607328][bookmark: 81853]Scope Menu 
 
     [bookmark: pgfId-1607329]Beginning with Cisco NX-OS Release 6.x, a new drop-down list called Scope is added to Cisco Prime DCNM Web Client that applies to all pages except the Admin pages.
 
     [bookmark: pgfId-1607330]You can use the scope menu to filter network information by:
 
      
      	 [bookmark: pgfId-1607331]Default_LAN 
 
      	 [bookmark: pgfId-1607332]Default_SAN 
 
      	 [bookmark: pgfId-1607333]Individual Fabric 
 
      	 [bookmark: pgfId-1607334]Group
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1607335]Note You can organize your fabrics and LAN switches in the Admin > Groups page.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607336]The features accessible from the tabs are limited to the areas that you choose in the filter tree.
 
    
 
     
      [bookmark: pgfId-1607338][bookmark: 53807]Admin Menu
 
     [bookmark: pgfId-1607339]You can use the admin menu to:
 
      
      	 [bookmark: pgfId-1607340]Set Default LAN Credentials: These credentials will be used when connecting to the DCNM LAN devices. 
 
      	 [bookmark: pgfId-1607341]Change Password: Changes the password for the current logged in user. 
 
      	 [bookmark: pgfId-1607342]Logout: Logout from the DCNM Web Client. 
 
     
 
    
 
     
      [bookmark: pgfId-1607344][bookmark: 85497]Table and Filtering Navigation
 
     [bookmark: pgfId-1607345]Some tables that can be filtered will have a filter option to view subsets of the information. Either choose the filter menu or click Filter. An editable row at the top of the table appears. Enter values into the table cells and click Return to display matching rows.
 
    
 
     
      [bookmark: pgfId-1607347][bookmark: 57161]Printing
 
     [bookmark: pgfId-1607348]Click Print to view the table in a printer-friendly format. You can then print the page from the browser. 
 
    
 
     
      [bookmark: pgfId-1607350][bookmark: 73189]Exporting to a File
 
     [bookmark: pgfId-1607351]An Export icon is in the lower right corner of some tables or top right corner of the window. Click this icon to export the data to Microsoft Excel. 
 
    
 
     
      [bookmark: pgfId-1607353][bookmark: 76328]Sorting Columns
 
     [bookmark: pgfId-1607354]Not all columns are sortable but you can click a sortable column head to sort the information for that column. 
 
    
 
     
      [bookmark: pgfId-1607356][bookmark: 16856]Cisco Prime DCNM Web Search Engine 
 
     [bookmark: pgfId-1607357]The search engine helps you to locate records according to the following search criteria: 
 
      
      	 [bookmark: pgfId-1607358]Search by Name. 
 
      	 [bookmark: pgfId-1607359]Search by IP Address. 
 
      	 [bookmark: pgfId-1607360]Search by WWN. 
 
      	 [bookmark: pgfId-1607361]Search by Alias. 
 
      	 [bookmark: pgfId-1607362]Search by MAC Address. 
 
      	 [bookmark: pgfId-1607363]Search by Serial Number. 
 
     
 
     [bookmark: pgfId-1607367]For more information see the section Using the Cisco Prime DCNM Search Engine.
 
    
 
     
      [bookmark: pgfId-1607369][bookmark: 49266]Using the Cisco Prime DCNM Search Engine 
 
     
 
     [bookmark: pgfId-1607370]Step 1 Click Search box on the top right corner of the main window. 
 
     [bookmark: pgfId-1607371]You see the search text box. 
 
     [bookmark: pgfId-1607372]Step 2 Use the drop-down to search by: 
 
      
      	 [bookmark: pgfId-1607373]Name 
 
      	 [bookmark: pgfId-1607374]IP Address 
 
      	 [bookmark: pgfId-1607375]WWN 
 
      	 [bookmark: pgfId-1607376]Alias 
 
     
 
     [bookmark: pgfId-1607377]Step 3 Enter the value based on the search option and click the arrow to begin the search. 
 
     [bookmark: pgfId-1607378]The search results are displayed in a new window. 
 
     [bookmark: pgfId-1607379]Step 4 Select Inventory or Performance tabs to view specific search results. 
 
    
 
   
 
    
     [bookmark: pgfId-1607381][bookmark: 50667]Downloading Cisco Prime DCNM-SAN Client
 
    [bookmark: pgfId-1607382]You must use Cisco Prime DCNM Web Client to launch Cisco Prime DCNM-SAN Client.
 
    
 
    [bookmark: pgfId-1607383]Step 1 On the DCNM Web Client home screen, click Cisco Prime DCNM-SAN. 
 
    [bookmark: pgfId-1607384]If you are launching Cisco Prime DCNM-SAN Client for the first time, you see a message asking if you want to create shortcuts for Cisco Prime DCNM-SAN.
 
    [bookmark: pgfId-1607385]Step 2 Click Yes to create shortcuts for Cisco Prime DCNM-SAN.
 
    [bookmark: pgfId-1607386]Step 3 If you have the latest Java version installed, a Warning message is displayed.
 
     
      
    
 
    
 
    [bookmark: pgfId-1607387]Note The DCNM-LAN client supports JRE versions 1.6 and 1.7.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1607388]Step 4 Click Run with the latest version button.
 
    [bookmark: pgfId-1607389]Step 5 Enter the user credentials to log on to Cisco Prime DCNM-SAN client. This message appears only the first time you launch Cisco Prime DCNM-SAN Client.
 
   
 
    
     [bookmark: pgfId-1607391][bookmark: 10682]Downloading Cisco Prime DCNM-LAN Client 
 
    [bookmark: pgfId-1607392]You must use Cisco Prime DCNM Web Client to launch Cisco Prime DCNM-LAN Client. 
 
    
 
    [bookmark: pgfId-1607393]Step 1 On the DCNM Web Client home screen, click Cisco Prime DCNM-LAN. 
 
    [bookmark: pgfId-1607394]If you are launching Cisco Prime DCNM-LAN Client for the first time, you see a message asking if you want to create shortcuts for Cisco Prime DCNM-LAN. 
 
    [bookmark: pgfId-1607395]Step 2 Click Yes to create shortcuts for Cisco Prime DCNM-LAN. 
 
    [bookmark: pgfId-1607396]Step 3 If you have the latest Java version installed, a Warning message is displayed. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1607397]Note The DCNM-SAN client supports JRE versions 1.6 and 1.7.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1607398]Step 4 Click Run with the latest version button. 
 
    [bookmark: pgfId-1607399]Step 5 Enter the user credentials to log on to Cisco Prime DCNM-LAN client. This message appears only the first time you launch Cisco Prime DCNM-LAN Client.
 
   
 
    
     [bookmark: pgfId-1607401][bookmark: 46606]Downloading Cisco Device Manager Client 
 
    [bookmark: pgfId-1607402]You must use Cisco Prime DCNM Web Client to Install Cisco Device Manager client. 
 
    
 
    [bookmark: pgfId-1607403]Step 1 On the DCNM Web Client home screen, click DM. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1607404]Note Cisco Prime DCNM Device Manager supports JRE versions 1.6 and 1.7. Follow the instructions in the Cisco Device Manager installer wizard to proceed with the installation. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1607405]Step 2 Once the installation is complete, enter the user credentials to log on to the Cisco Device Manager client.
 
   
 
    
     [bookmark: pgfId-1607407][bookmark: 28868]Connecting to a Switch using the CLI 
 
    [bookmark: pgfId-1607408]You can use the Cisco Prime DCNM Web Client to connect to a switch using the CLI. 
 
    
 
    [bookmark: pgfId-1607409]Step 1 On the DCNM Web Client home screen, click CLI. 
 
    [bookmark: pgfId-1607410]Step 2 Click the Connect button. 
 
    [bookmark: pgfId-1607411]Step 3 In the configuration window, use the check-box to select the switches. 
 
    [bookmark: pgfId-1607412]Step 4 Enter the user credentials and click the Connect button. 
 
    [bookmark: pgfId-1607413]Step 5 Use the switch panel to specify the command for a specific switch. 
 
     
      [bookmark: pgfId-1607414]Adding a Security Exception 
 
     
 
     [bookmark: pgfId-1607415]Step 1 On the warning page, click Or you can add an exception. 
 
     [bookmark: pgfId-1607416]Step 2 Click Add Exception. 
 
     [bookmark: pgfId-1607417]The Add Security Exception dialog box appears. 
 
     [bookmark: pgfId-1607418]Step 3 Click Get Certificate. 
 
     [bookmark: pgfId-1607419]Read the text that describes the problems with this site. 
 
     [bookmark: pgfId-1607420]Step 4 Click Confirm Security Exception. 
 
      
      	 [bookmark: pgfId-1607421]MAC Address 
 
      	 [bookmark: pgfId-1607422]Serial Number 
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1607424][bookmark: 28343]Viewing Dashboard Information 
 
    [bookmark: pgfId-1607425]The Cisco Prime DCNM Web Client dashboard gives you comprehensive information of the following: 
 
     
     	 [bookmark: pgfId-1607429]Summary - You can view the summary dashboard which displays the overall functioning of all the devices connected. It gives you daily statistics of the connected devices.
 
     	 [bookmark: pgfId-1607433]Fabric - You can view the status of the inter switch links and edge ports. 
 
     	 [bookmark: pgfId-1607437]Compute - You can view the details and events for a particular Host along with its events and topology. 
 
     	 [bookmark: pgfId-1607441]Switch Dashboard - You can view details pertaining to a switch along with its current status and licensing information. 
 
     	 [bookmark: pgfId-1607445]Storage - You can view details about the storage device along with its events and topology. 
 
    
 
     
      [bookmark: pgfId-1607448][bookmark: 69939]Summary 
 
     [bookmark: pgfId-1607449]The intent of the summary dashboard is to enable network and storage administrators to focus on particular areas of concern around health and performance of the data center switching as a snapshot of the last 24 hours. The functional view of the LAN and SAN switching consists of six dynamic portlets that display information in context of the selected scope. The scope can be adjusted in the upper center of the page to display more focused information particular to the managed domain and offers details of the specific topology or set of topologies part of the data center scope.
 
     [bookmark: pgfId-1607450]The various scopes available on the Cisco Prime DCNM Web Client are:
 
      
      	 [bookmark: pgfId-1607451]datacenter
 
      	 [bookmark: pgfId-1607452]defailt_SAN
 
      	 [bookmark: pgfId-1607453]defailt_LAN
 
     
 
     [bookmark: pgfId-1607454]The following portlets are displayed on the summary dashboard, based on the scope of the Web Client:
 
      
      	 [bookmark: pgfId-1607458]Health
 
      	 [bookmark: pgfId-1607462]Inventory
 
      	 [bookmark: pgfId-1607466]Top CPU
 
      	 [bookmark: pgfId-1607470]Top ISLs/Trunks
 
      	 [bookmark: pgfId-1607474]Top SAN Host Ports
 
      	 [bookmark: pgfId-1607478]Top SAN Storage Ports
 
      	 [bookmark: pgfId-1607482]Topology
 
     
 
    
 
     
      [bookmark: pgfId-1607484][bookmark: 43837]Health
 
     [bookmark: pgfId-1607485]Broken into two sections listing specific problem areas by type of alert (host, ISL/trunks, VSAN, switch, storage) and events in the form of traps and syslogs listed in order of their severity for a period of 24 hours. The events and problems are hyper-linked to Health > Events and are filtered only for the clicked entity allowing you to drill down to particular problem or event for the contextual information. The events and problems change in context of the selected topology scope to display fabrics (SAN) and switches (LAN) that are part of the default or user defined group. The Health pane will display counts for Path not redundant and Missing Paths which will redirect to the SAN Path Errors section.To customize these groups to display more granular information see the Managing Switch Groups section.
 
    
 
     
      [bookmark: pgfId-1607493][bookmark: 87598]Inventory
 
     [bookmark: pgfId-1607494]Displays the currently discovered inventory based on the selected scope. Switch inventory is broken into FC (Director vs Switch) and Ethernet and Virtual environment totals (VSAN and VLAN configuration). The bar graphs depicts used vs. available for capacity planning. 
 
     [bookmark: pgfId-1607495]Click the + icon in the upper right corner to display 6 new boxes displaying detailed inventory for the logical environment, physical switches, ISLs of various types, modules installed (director class line cards and switches are shown), Ports which are broken into type (FC vs. Ethernet) with sub-categories showing counts based on speed. The final box displays Port Capacity, which shows percentage of ports used and calculates the days remaining of available ports based on consumption of available ports. By clicking the square icon in the upper right corner you will return to the previous view
 
    
 
     
      [bookmark: pgfId-1607497][bookmark: 23560]Top CPU
 
     [bookmark: pgfId-1607498]Displays CPU utilization for the discovered switches over the last 24 hours with a red bar displaying the high watermark for that 24 hour period.
 
     [bookmark: pgfId-1607499]Click the + symbol in the upper right corner to display more detailed information of the average percentage of usage, peak percentage of usage, and the last time the information was updated
 
    
 
     
      [bookmark: pgfId-1607501][bookmark: 42187]Top ISLs/Trunks
 
     [bookmark: pgfId-1607502]Displays the performance data for the top 10 performing ISLs and/or Trunk ports. Each entry shows current receive and transmit percentage with a graph depicting the percentage of time each trunk spent exceeding the currently configured thresholds, see the Performance Manager Collections section. Clicking on the bar graph to the left of each entry will provide a 24 hour graph for the selected item to provide context to the performance data being shown.
 
     [bookmark: pgfId-1607506]Click the + symbol in the upper right corner to display more detailed information on each entry by displaying the speed of the ISL/Trunk, the average and peak receive data, the average and peak transmit data, the combined receive and transmit data, the total number of errors and discards in the last 24 hours, and the time the data was last updated. By clicking the square icon in the upper right corner you will return to the previous view.
 
    
 
     
      [bookmark: pgfId-1607508][bookmark: 72473]Top SAN Host Ports
 
     [bookmark: pgfId-1607509]Displays the performance data for the top 10 performing SAN host ports. Each entry shows current receive and transmit percentage with a graph depicting the percentage of time each trunk spent exceeding the currently configured thresholds, see the Performance Manager Collections section. Clicking on the bar graph to the left of each entry will provide a 24 hour graph for the selected item to provide context to the performance data being shown.
 
     [bookmark: pgfId-1607513]Click the + symbol in the upper right corner to display more detailed information on each entry by displaying the speed of the ISL/Trunk, the average and peak receive data, the average and peak transmit data, the combined receive and transmit data, the total number of errors and discards in the last 24 hours, and the time the data was last updated. By clicking the square icon in the upper right corner you will return to the previous view.
 
    
 
     
      [bookmark: pgfId-1607515][bookmark: 16029]Top SAN Storage Ports
 
     [bookmark: pgfId-1607516]Displays the performance data for the top 10 performing SAN host ports. Each entry shows current receive and transmit percentage with a graph depicting the percentage of time each trunk spent exceeding the currently configured thresholds, see the Performance Manager Collections section. Clicking on the bar graph to the left of each entry will provide a 24 hour graph for the selected item to provide context to the performance data being shown.
 
     [bookmark: pgfId-1607520]Click the + symbol in the upper right corner to display more detailed information on each entry by displaying the speed of the ISL/Trunk, the average and peak receive data, the average and peak transmit data, the combined receive and transmit data, the total number of errors and discards in the last 24 hours, and the time the data was last updated. By clicking the square icon in the upper right corner you will return to the previous view.
 
    
 
     
      [bookmark: pgfId-1607521]Viewing Health Summary Information 
 
     
 
     [bookmark: pgfId-1607522]Step 1 From the menu bar, choose Dashboard > Summary and then see the Health Summary view. 
 
     [bookmark: pgfId-1607523]In the left side of the window, you see a summary table of problems and in the right side of the window, you see a summary table of events in the last 24 hours. 
 
     [bookmark: pgfId-1607524]Step 2 Click the warnings next to Switches, ISLs, Hosts, or Storage (other than 0) to see an inventory of switches, ISLs, or end devices for that fabric. 
 
     [bookmark: pgfId-1607525]Step 3 Choose the number of events next to the event severity levels (Emergency, Alert, Critical, Error, Warning, Notice, Info, or Debug) to see a summary of events and descriptions. 
 
    
 
     
      [bookmark: pgfId-1607527][bookmark: 50086]Viewing Performance Summary Information
 
    
 
     
      [bookmark: pgfId-1607528]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1607529]To view performance information, you must activate performance collector. 
 
     [bookmark: pgfId-1607530]From the menu bar, choose Dashboard > Summary, and then click Daily Performance view. 
 
     [bookmark: pgfId-1607531]You see the Summary information. 
 
     [bookmark: pgfId-1607532]The Top SAN Ports, Top SAN Storage Ports, Top ISL’s/Trunks and Top Access Ports are Performance pods that are displayed depending on the pods selected. 
 
     [bookmark: pgfId-1607533]If you select the Scope as default_SAN, a new area Daily Performance is displayed. For more information see the New Area - Daily Performance section.
 
    
 
     
      [bookmark: pgfId-1607538][bookmark: 15749]Viewing Inventory Summary Information 
 
     
 
     [bookmark: pgfId-1607539]Step 1 From the menu bar, choose Dashboard > Summary. 
 
     [bookmark: pgfId-1607540]The Inventory summary pane is displayed. 
 
     [bookmark: pgfId-1607541]Step 2 Click the + icon or double-click the Inventory summary pane to view information for the selected scope only.
 
     [bookmark: pgfId-1607542]The complete inventory details are displayed. 
 
    
 
     
      [bookmark: pgfId-1607544][bookmark: 49866]Differences by changing the Scope to default LAN or configured switch group
 
      
       
     
 
     
 
     [bookmark: pgfId-1607548]Note To configure switch groups, see the Managing Switch Groups section.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1607549]Health - Only LAN events are displayed.
 
      	 [bookmark: pgfId-1607550]Inventory - Only LAN switch data is displayed
 
      	 [bookmark: pgfId-1607551]Top ISLs/Trunks - Only displays LAN based ISLs/Trunks
 
      	 [bookmark: pgfId-1607552]Top CPU - Only displays CPU data for the LAN switches
 
      	 [bookmark: pgfId-1607553]Top Access Ports - Displays LAN access port performance information.
 
      	 [bookmark: pgfId-1607557]A new area Topology is displayed. For more information, see the Topology section.
 
     
 
    
 
     
      [bookmark: pgfId-1607559][bookmark: 10948]Topology
 
     [bookmark: pgfId-1607560]This displays the current physical topology with color- coding (displayed with a key in the lower right corner) for ISL utilization. You can hover over the switch indication circles to display the configured switch name, IP address, switch model, firmware version, last polled CPU utilization, and last polled memory utilization.
 
     [bookmark: pgfId-1607561]The memory or CPU utilization are displayed on the switch indicators. In addition the ISL/Trunk paths are also color-coded based on their TX+RX peak utilization. You can hover over the ISL/Trunk to show list of ports that create the connection and click on individual paths to launch the performance chart showcasing TX and RX utilization for the last 24 hours.
 
     [bookmark: pgfId-1607562]Click the + symbol in the upper-right corner to maximize the window and enables you to drag the switch icons to best display their infrastructure. Once icons are placed in the most desirable position you can save the layout by clicking the Save icon in the upper-left corner of the topology map. If the layout is moved you can restore the previously saved layout during the current session by clicking the Restore icon in the upper-left corner next to the save icon.
 
     [bookmark: pgfId-1607563]When the number of nodes is large, the switch information will not be displayed, as it cannot be accommodated on the page. However, if you click the Switch Name or use filters down to a subset, you will be able to view the switch information.
 
     [bookmark: pgfId-1607564]VxLAN VTEPs are shown in topology with VTEP icons. Click on the filter in top right corner in topology screen to search VTEPs based on VNI (VNI value > 4095) or multicast address. A Details link appears below the filter box. Click on the Details link below the filter box to view the search data in tabular format. In VNI search context, click VTEP to view the VTEP active peers.
 
     [bookmark: pgfId-1607565]The L2 view shows VLANs configured among the discovered devices. You can choose to view your topology based on the VLANs or Mapped Fabric Path topology. It also provides a visual representation of forwarding and non-forwarding links between Cisco Nexus devices in a data center network for configured VLANs.
 
    
 
     
      [bookmark: pgfId-1607566]FabricPath View
 
     [bookmark: pgfId-1607567]FabricPath support for L2MP capable devices, running the L2MP-ISIS protocol, is available in the L2 View of the Topology drawer. The L2 View contains a dialog box that allows you to select the type of graph to display. In each topology, a broadcast graph (multi-destination graph) is created by default to carry broadcast traffic and unknown unicast traffic. When you select the Fabricpath view in the dialog box, you can display the following types of graphs:
 
      
      	 [bookmark: pgfId-1607568]Multi-destination—A multi-destination or broadcast graph built by ISIS for specified VLAN range to which the topology is mapped to in fabric path cloud.
 
     
 
     [bookmark: pgfId-1607569]ISIS maintains reachability information from each node to all other nodes that are present in fabric path cloud. Give a node, DCNM will enable users to view which all other nodes in fabric path cloud are not reachable.
 
      
      	 [bookmark: pgfId-1607570]Unicast—A unicast graph displays equal cost routes between nodes in the fabric path cloud.
 
      	 [bookmark: pgfId-1607571]Multicast—A multicast graph displays the multicast traffic from a specified device to all hosts that are listening to a particular IGMP group.
 
     
 
     [bookmark: pgfId-1607572]The FabricPath Topology Wizard allows you to do many operations, such as add to the FabricPath topology, display inventory, and display end devices.
 
     [bookmark: pgfId-1607573]To view the FabricPath topology in the L2 view:
 
     
 
     [bookmark: pgfId-1607574]Step 1 Navigate to Dash Board > Topology. Expand the LAN topology. 
 
     [bookmark: pgfId-1607575]Step 2 Select L2 view > FabricPath. 
 
     [bookmark: pgfId-1607576]Step 3 Enter the Topology ID. The resulting action highlights all the links which are part of the specified topology.
 
     [bookmark: pgfId-1607577]Step 4 To view the broadcast graph, select the Multi destination option in the graph selection window. Select the anchor device for which the broadcast graph must be displayed.
 
     [bookmark: pgfId-1607578]Step 5 To view the unicast graph, select Unicast in the graph selection window. Select the source and the destination nodes.
 
     [bookmark: pgfId-1607579]Step 6 To view the multicast graph, select Multicast in the graph selection window. Select the IGMP address and the ftag ID, and the anchor node for which the multicast graph must be displayed.
 
     [bookmark: pgfId-1607580]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1607581]VLAN View
 
     [bookmark: pgfId-1607582]VLAN view allows you to see the layer 2 network for the given range of VLAN. All the information related to STP such as protocol, STP role, STP root information are shown to the operator on topology. It is possible to see this information for a particular Switch group.
 
     [bookmark: pgfId-1607583]Spanning Tree Protocol (STP) is used to prevent loops when switches are interconnected via redundant links in a switched network. STP identifies the loops in a network and shuts down the redundant links to prevent the loops from forming. In the event of a link failure, STP will automatically activate the corresponding redundant link. In case of a switched network with multiple VLANs, loop-free paths will have to be computed for every VLAN.
 
     [bookmark: pgfId-1607584]During shallow discovery we are already fetching the information related to VLAN. Layer 2 Topology provides a visual representation of forwarding and non-forwarding links between networks of Nexus Devices for VLANs configured on them. VLAN view helps network administrators to manage STP protocol by providing a visual display of blocking and forwarding links and view information such as STP states (forwarding, blocking, learning, listening), STP roles(root, designated) and the root switch for STP. 
 
     [bookmark: pgfId-1607585]To view the VLAN topology in the L2 view:
 
     
 
     [bookmark: pgfId-1607586]Step 1 Navigate to Dash Board > Topology. Expand the LAN topology. 
 
     [bookmark: pgfId-1607587]Step 2 Select L2 view > VLAN. 
 
     [bookmark: pgfId-1607588]Step 3 Enter the VLAN range like “1-10”. 
 
     [bookmark: pgfId-1607589]Step 4 Click on Fetch button. 
 
     [bookmark: pgfId-1607590]By default, the forwarding and blocked links are shown in the topology. All the forwarding links are in green, blocked in red and the other links are greyed out. It will take some time to populate the topology since the information is fetched from the devices on demand. Select a given link and it will show all the information about that link.
 
     [bookmark: pgfId-1607591]Uncheck the option Show Non-Forwarding link, only forwarding links are shown in the topology. Uncheck the option Show Forwarding link, only blocked links are shown in the topology.
 
     [bookmark: pgfId-1607592]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1607593]Port Channel and vPC View
 
     [bookmark: pgfId-1607594]To view the PC vPC topology in the L2 view:
 
     
 
     [bookmark: pgfId-1607595]Step 1 Select Scope as default_LAN or DataCenter.
 
     [bookmark: pgfId-1607596]Step 2 Navigate to Dashboad > Summary.
 
     [bookmark: pgfId-1607597]Step 3 Select the appropriate Device Group and open Topology.
 
      
       
     
 
     
 
     [bookmark: pgfId-1607598]Note Note: The port channels and vPC links are displayed when the user switches to PC vPC view on the topology screen supporting both LAN and SAN devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607599]The PC vPC displays the vPCs, port channels, and physical links that are not part of vPC or port channel.
 
     [bookmark: pgfId-1607600]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1607601]Differences by changing the Scope to default SAN or configured switch group
 
      
       
     
 
     
 
     [bookmark: pgfId-1607605]Note To configure switch groups, see the Managing Switch Groups section.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1607606]Health - Only SAN within scope events are displayed.
 
      	 [bookmark: pgfId-1607607]Inventory: Only SAN switch data within the inventory is displayed
 
      	 [bookmark: pgfId-1607608]Top SAN Host Ports: Displays SAN host port performance information within scope. 
 
      	 [bookmark: pgfId-1607609]Top SAN Storage Ports: Displays SAN storage port performance information within scope. 
 
      	 [bookmark: pgfId-1607610]Topology: Displays SAN topology within scope.
 
      	 [bookmark: pgfId-1607613]A new area Daily Performance is displayed. For more information, see the New Area - Daily Performance section.
 
     
 
    
 
     
      [bookmark: pgfId-1607616][bookmark: 43995]New Area - Daily Performance
 
     [bookmark: pgfId-1607617]This area displays the total performance of the displayed scope broken into three sections. ISL, Host and Storage. Total monitored port count per area is shown below the circular graph.
 
     [bookmark: pgfId-1607618]Each of the circular graphs will display the percentage of utilization based on 3 different thresholds depicted with color differentiation as follows: 
 
      
      	 [bookmark: pgfId-1607619]0-50%: Green
 
      	 [bookmark: pgfId-1607620]51-80%: Yellow
 
      	 [bookmark: pgfId-1607621]81-100%: Red 
 
     
 
     [bookmark: pgfId-1607622]You can click each displayed area to view performance data for only the ports, which fall within each performance scope. This will display more detailed information on each entry by displaying the name of the port. Click the bar graph icon to display the historical performance data for the selected port. A full performance graph also appears on the bottom of the screen displaying the last 24 hours, week, month, and year. 
 
     [bookmark: pgfId-1607623]You can switch the graph to be displayed as a histogram and to perform predictive analysis on the port showing the most likely performance over the next 6 months based on the historical data gathered for the port. Click the + icon in the bar graph to overlay the performance data of any other port by clicking on the + icon and then clicking the graph icon next to another port listed above. The VSAN/VLAN configuration, speed of the trunk/ISL the average and peak receive data, the average and peak transmit data, the combined receive and transmit, the total number of errors and discards in the last 24 hours, and the last time the data was updated are also displayed. 
 
     [bookmark: pgfId-1607624]To return to the summary view, from the menu bar select Dashboard>Network.
 
    
 
     
      [bookmark: pgfId-1607626]Fabric
 
     [bookmark: pgfId-1607627]The topology for the Fabric provides a tiered, scalable display for all the spines and leaves in the fabric. The topology feature also provides a visualization showing the health of the Central Point of Management (CPoM)(, which includes accessibility of DCNM to different services such as Power on Auto Provisioning (POAP) and Lightweight Directory Access Protocol service ( LDAP).
 
     [bookmark: pgfId-1607628]The topology views are also integrated with an event/messaging mechanism using the open source package BlazeDS to dynamically update the display whenever any changes in the network are detected
 
     [bookmark: pgfId-1607629]There are two separate views:
 
      
      	 [bookmark: pgfId-1607633]Inter Switch Links View
 
      	 [bookmark: pgfId-1607637]Edge Ports View
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1607638]Note You can use the Topology View or Table View icons to switch between different views.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1607641][bookmark: 71587]Inter Switch Links View
 
      
       
     
 
     
 
     [bookmark: pgfId-1607642]Note These features appear on your Cisco Prime DCNM Web Client application only if you have deployed the DCNM installer in the Unified Fabric mode.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607643]This view displays the super spines, spines and leaves in a tiered fashion. The super spines are displayed in the top tier under the section <number of> Super Spines, the spines are displayed in the middle tier under the section <number of> Spines, and the leaves are displayed under the section <number of> Leaves. Any spine that has tier level defined as 3 or above is considered as a Super Spine. If there are no super spines defined, then the spines and leaves are shown in 2 tiers.
 
     [bookmark: pgfId-1607644]The leaves can be grouped into Pods. Leaves inside a pod are shown as circles inside a box. Pod is defined for the switch by using the command fabric connectivity pod <podname>. The pod name is considered as the title for the pod. Any switch that do not have pods defined are shown under the Default pod. Border leaves and Edge Routers, are shown in vertical tiers in the BL/Edge Router pod with a dashed line border around the pod. BL/Edge Router is the standard default name for the pod showing border leaves and edge routers.
 
     [bookmark: pgfId-1607645]The Pods are ordered as Default pod, followed by user-defined pods in alphabetical order, followed by BL/Edge Router pod. Pod can be maximized using the '+' button at the top-right corner. Pressing the button again will bring it back to the original size. The size of the node inside the pod depends on the pod size and the number of nodes inside the pod.
 
     [bookmark: pgfId-1607646]All the nodes are shown as circles. The color of the circle depends on the status of the links or the status of the switch according to the color coding legend displayed under the Nodes section in the left-hand pane. The numbers on the circles indicate how many links are down currently on the switch. The numbers are not displayed in case of green (all links are OK) or grey circle (unreachable).
 
     [bookmark: pgfId-1607647]Clicking on the spine or leaf node disables all other nodes in that tier and displays detailed information about the links for the selected node in the left-side pane. The status column in the table shows the status of the link as an icon.
 
     [bookmark: pgfId-1607648]When the mouse is hovered over the target switch, the link between the 2 nodes is shown as a line along with a detailed popup. The popup displays the source port, target port, and status. Also, the corresponding row in the table on the left side panel is highlighted
 
     [bookmark: pgfId-1607649]Clicking on the selected node again will deselect the node and enable all the disabled nodes.
 
     [bookmark: pgfId-1607650]The color of the line specifying the link between the switches depends on the status of the link as defined below.
 
     [bookmark: pgfId-1607651]Green – Links status is Normal.
 
     [bookmark: pgfId-1607652]Red – Link is down
 
     [bookmark: pgfId-1607653]Blue – Cable/Tier mismatch detected
 
     [bookmark: pgfId-1607654]Orange – Wrong Configuration Detected
 
     [bookmark: pgfId-1607655]When a node is selected, the status of the link between the selected node and all the target nodes that the selected node is connected to is depicted by a colored halo around the original circle. The color of the halo depends on the status of the link, as specified above.
 
     [bookmark: pgfId-1607656]Check Show Links to view links between the Spines and the Leaves, and the links between the Border Leaves and the Edge Router.
 
    
 
     
      [bookmark: pgfId-1607657]Search
 
     [bookmark: pgfId-1607658]The search box in the left side panel provides a quicker way to search for a spine or leaf by name. It also supports VM search, where a user can enter a VM name (partial or complete) or VM IP or VM Mac or Segment ID or VxLAN ID or Multicast Group and search for the leaf/leaves that the VM(s) belong to.
 
     [bookmark: pgfId-1607659]The search box provides an auto-complete feature, which filters and shows the matched switch names in a drop down as the user types into the text box. User can type the partial or complete switch name in the box and enter to see the filtered results. A 'Details' link is shown under the search text box that can be clicked to see the search results. If only one node matches the entered text, then that node is selected and the rest of the nodes in the tier are disabled. The details for the links for that node are displayed on the left side panel. If multiple switch names match the entered text, all the matched nodes are, but no details are shown in the left side panel.
 
    
 
     
      [bookmark: pgfId-1607662][bookmark: 72210]Edge Ports View
 
     [bookmark: pgfId-1607663]Edge Ports view provides a view of the leaf nodes as VPC pairs. The visualization provides an interface similar to Fabric Path Links view but with details specific to VPC feature.
 
     [bookmark: pgfId-1607664]Each leaf is shown as paired with its VPC peer, with the line between the pair indicating the VPC link. The numbers on the nodes indicate the number of edge ports down for that node.
 
     [bookmark: pgfId-1607665]The color of the circle depends on the status of the edge ports or the status of the switch.
 
     [bookmark: pgfId-1607666]Clicking on a node selects the node and its peer (if any) and shows the edge port status details for that node in the left side panel, as shown below.
 
     [bookmark: pgfId-1607667]On Selecting a single VPC pair, specific information about the VPC setup such as VPC domain ID, VPC peer names, VPC consistency state, VPC Peerlink consistency, Primary VPC Port Channel ID, VPC role for each peer, primary VPC peer link ID, Secondary VPC port channel ID and secondary VPC peerlink ID are all displayed in a short table above the interface listing.
 
     [bookmark: pgfId-1607668]No specific information is overloaded on the link colors, since the link is intended to represent both the Peer link and the keep alive link between peers
 
    
 
     
      [bookmark: pgfId-1607669]Health
 
     [bookmark: pgfId-1607670]This view (popup) can be accessed by clicking on ‘Health’ hyperlink on any of the topology visualization screens.
 
     [bookmark: pgfId-1607671]This view shows health of different services as defined by their accessibility from DCNM. These services include POAP (Power on Auto Provisioning), XCP (Extensible Communications Platform) service, LDAP (Lightweight Directory Access Protocol) service, etc., and the orchestrator which in turn is connected to different vCDs.
 
     [bookmark: pgfId-1607672]The node color is either green, which means the service is up and running and is accessible to DCNM, or red, which mean the service is down and cannot be accessed.
 
    
 
     
      [bookmark: pgfId-1607676][bookmark: 37475][bookmark: 94874]Switch Dashboard
 
     [bookmark: pgfId-1607677]The switch dashboard displays the details of the selected switch. The system information area includes the logical name of the switch, the group where the switch belongs, model number of the switch, serial number of the switch, the switch version, the location of the switch, IP address, model, world wide name (WWN) if available, uptime, DCNM license, status of the switch, indicators to determine whether the switch is sending traps and syslog information, current central processor unit (CPU) and memory utilization. 
 
     
 
     [bookmark: pgfId-1607678]Step 1 From the menu bar, choose Dashboard > Network. 
 
     [bookmark: pgfId-1607679]Step 2 An inventory of all the switches that are discovered by Cisco Prime DCNM Web Client appears. Click on a switch in the Name column. The switch dashboard appears.
 
     [bookmark: pgfId-1607680]Step 3 (Optional) Click ssh to access the switch through Secure Shell (SSH). 
 
     [bookmark: pgfId-1607681]Step 4 (Optional) Click Device Manager to access the switch through Hypertext Transfer Protocol (HTTP) for that switch. 
 
     [bookmark: pgfId-1607685]Step 5 (Optional) Click Accounting to go to the Viewing Accounting Information page for that switch. 
 
     [bookmark: pgfId-1607689]Step 6 (Optional) Click Backup to go to the Viewing a Configuration page. 
 
     [bookmark: pgfId-1607693]Step 7 (Optional) Click Events to go to the Viewing Events Registration page. 
 
     [bookmark: pgfId-1607694]This physical port capacity feature is available for Cisco Prime DCNM licensed switches only. 
 
     [bookmark: pgfId-1607695]The physical port capacity area includes the available ports in each tier, such as 40G, 10G, 8G, 4G, 2G, and 1G and also the predicted number of days remaining to reach the maximum (100%) utilization. 
 
     [bookmark: pgfId-1607696]Step 8 Click a number under the Days left column to view the capacity trend. 
 
     [bookmark: pgfId-1607697]Step 9 Choose the Modules tab to display all the modules that are discovered on the switch. 
 
     [bookmark: pgfId-1607698]Step 10 Choose the Interfaces tab to display all the interfaces that are discovered for the switch. Select an interface row and right -click to view the following options:
 
      
       
       	 [bookmark: pgfId-1607699]Port up... - Brings up a port.
 
       	 [bookmark: pgfId-1607700]Port down... - Brings down a port.
 
       	 [bookmark: pgfId-1607701]Access mode - Sets port in access mode.
 
       	 [bookmark: pgfId-1607702]Trunk mode - Sets port in trunk mode.
 
      
 
     
 
     [bookmark: pgfId-1607703]Step 11 Select an option and in the CLI Authentication for the port window, specify the User Name and Password and click Connect to connect to the switch.
 
      
       
     
 
     
 
     [bookmark: pgfId-1607704]Note The CLI Authentication is required only if this is the first time you are performing an operation on an interface for a particular switch. For subsequent operations on the same switch, the authentication is not required.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607705]A CLI window is displayed with the CLI details of the specific operation displayed at the bottom of the window.
 
     [bookmark: pgfId-1607706]Step 12 When you press Enter on your keyboard, a dialog is displayed confirming if you want to change the config on a selected interface.
 
     [bookmark: pgfId-1607707]Step 13 Close the Blades tab to display a list of UCS blades and their attributes.
 
     [bookmark: pgfId-1607708]Step 14 Click OK to continue or Cancel to abort the operation.
 
     [bookmark: pgfId-1607709]When you click on a link in the ConnectedTo column, you see the other end of where the interface is connected. For example, if the other end of the interface is a switch interface, then it launches the Interfaces tab of the switch that the interface is connected. If the interface is connected to an end device, then it launches the host or storage dashboard. 
 
     [bookmark: pgfId-1607710]Step 15 Choose the Licenses tab to display all the licenses installed on the switch. 
 
     [bookmark: pgfId-1607711]Step 16 Choose the Features tab to display a list of all the features installed on the switch. The features tab is displayed only on Cisco Prime DCNM-SAN switches.
 
     [bookmark: pgfId-1607712]Step 17 Choose the VxLAN tab to display all VNIs, Multicast address, VNI Status and mapped VLAN for the VTEP. The VTEP IP address is displayed in left panel.
 
      
       
     
 
     
 
     [bookmark: pgfId-1607713]Note VxLAN support is available on Cisco Nexus 6000 Series and Nexus 9000 Series switches only.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1607716][bookmark: 19892]Compute 
 
     [bookmark: pgfId-1607717]The compute dashboard provides you with all the information related to the discovered SAN and LAN hosts. It provides detailed information related to the network, such as I/O traffic, disk latency, CPU, memory statistics, topology, and events about each individual host and virtual machines that are configured on top of the virtual host. The compute dashboard consists of four panels: 
 
      
      	 [bookmark: pgfId-1607718]Host Enclosures panel—Lists the hosts and their network attributes. 
 
      	 [bookmark: pgfId-1607719]Traffic panel—Provides the I/O statistics, CPU and memory information, and disk latency of individual hosts or virtual machines. 
 
      	 [bookmark: pgfId-1607720]Topology panel—Provides end-to-end topology layout and path information between host enclosures and storage enclosures. The discovered virtual machines are displayed and when you select the virtual machine, the path to the SAN data source is displayed. You can toggle this view to list all data paths. 
 
      	 [bookmark: pgfId-1607721]Event panel—Provides information about events of all of the switch ports that are configured within a specific host enclosure. 
 
     
 
     [bookmark: pgfId-1607722]This section contains the following topics: 
 
      
      	 [bookmark: pgfId-1607726]Viewing Host Enclosures
 
      	 [bookmark: pgfId-1607730]Viewing Host Events
 
      	 [bookmark: pgfId-1607734]Viewing Host Topology
 
      	 [bookmark: pgfId-1607738]View Host Traffic
 
     
 
    
 
     
      [bookmark: pgfId-1607740][bookmark: 26168]Viewing Host Enclosures 
 
     [bookmark: pgfId-1607741]Beginning with Cisco NX-OS Release 6.x, you can view and search the network servers that are connected to the Cisco NX-OS devices. Cisco Prime DCNM extends the fabric visibility up to the server and allows you to discover and search the end devices that are attached to the network. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1607742]Note Beginning with Cisco NX-OS Release 6.x, Server Credentials, Servers, and Static Server-Adapter Mapping are no longer available. 
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1607743]Step 1 From the menu bar, choose Dashboard > Compute. 
 
     [bookmark: pgfId-1607744]You see the list of hosts in the host enclosures table. 
 
     [bookmark: pgfId-1607745]Step 2 Click the Show details icon next to the host enclosure to view more details. 
 
     [bookmark: pgfId-1607746]You see the Events, topology and Traffic information in the dashboard. 
 
     [bookmark: pgfId-1607747]Step 3 To edit the host name, double-click the Host Name, edit and then click the Apply Changes icon. 
 
     [bookmark: pgfId-1607748]Step 4 You can click the Show Filter to filter the storage enclosures by Name or by IP Address.
 
    
 
     
      [bookmark: pgfId-1607750][bookmark: 75828]Viewing Host Events 
 
     
 
     [bookmark: pgfId-1607751]Step 1 From the menu bar, choose Dashboard > Compute. 
 
     [bookmark: pgfId-1607752]You see the list of hosts in the host enclosures table. 
 
     [bookmark: pgfId-1607753]Step 2 Click the Events icon next to the host enclosure to view the Events panel. 
 
     [bookmark: pgfId-1607754]Step 3 Click the + icon in the Events panel to expand. 
 
     [bookmark: pgfId-1607755]A list of all the events for the selected Host is displayed. 
 
    
 
     
      [bookmark: pgfId-1607757][bookmark: 71916]Viewing Host Topology 
 
     
 
     [bookmark: pgfId-1607758]Step 1 From the menu bar, choose Dashboard>Compute. 
 
     [bookmark: pgfId-1607759]You see the list of hosts in the host enclosures table 
 
     [bookmark: pgfId-1607760]Step 2 Click the Show details icon next to the host enclosure to view the host topology details. 
 
     [bookmark: pgfId-1607761]Step 3 Click the magnifier icons to zoom-in or zoom-out. 
 
     [bookmark: pgfId-1607762]Step 4 Click the Fabric/Network icon to view the Fabric/Network path. 
 
     [bookmark: pgfId-1607763]Step 5 Click the All Paths icon to view the complete set-up. 
 
     [bookmark: pgfId-1607764]Step 6 Click the First Shortest Path icon to view the first shortest path. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1607765]Note Click Map View icon to enable the icons listed in Step 4, 5 and 6 above. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607766]Step 7 Click the Tabular View icon to view the host topology in tabular format. 
 
    
 
     
      [bookmark: pgfId-1607768][bookmark: 55184]View Host Traffic 
 
     
 
     [bookmark: pgfId-1607769]Step 1 From the menu bar, choose Dashboard > Compute. 
 
     [bookmark: pgfId-1607770]You see the list of hosts in the host enclosures table 
 
     [bookmark: pgfId-1607771]Step 2 Click the Show details icon next to the host enclosure to view the host topology details. 
 
     [bookmark: pgfId-1607772]Step 3 Use the drop-down to select the traffic according to the time duration. 
 
     [bookmark: pgfId-1607773]Step 4 Select the icons to view the traffic as a Grid, Line Chart or Stacked Chart. 
 
     [bookmark: pgfId-1607774]Step 5 In the Traffic pane, the Enclosure Traffic is displayed by default. Click the Traffic Utilization icon to view the traffic utilization. The daily average percentage of traffic utilization of the enclosure ports is displayed as a pie chart. 
 
    
 
     
      [bookmark: pgfId-1607776]Network 
 
     [bookmark: pgfId-1607777]Cisco Prime DCNM Web Client enables you to view details of the switch including the system information, switch capacity, modules, interfaces, and licenses. 
 
     
 
     [bookmark: pgfId-1607778]Step 1 From the menu bar, choose Dashboard > Network. 
 
     [bookmark: pgfId-1607779]Step 2 An inventory of all the switches that are discovered by Cisco Prime DCNM Web Client appears. Click on a switch in the Name column to view the Switch Dashboard.
 
    
 
     
      [bookmark: pgfId-1607785][bookmark: 84701]Storage
 
     [bookmark: pgfId-1607786]The Storage dashboard provides you all the information about the SAN and LAN storage. 
 
     [bookmark: pgfId-1607787]This section contains the following topics: 
 
      
      	 [bookmark: pgfId-1607791]Viewing Storage Enclosure
 
      	 [bookmark: pgfId-1607795]Viewing Storage Enclosure Events
 
      	 [bookmark: pgfId-1607799]Viewing Storage Enclosure Topology
 
      	 [bookmark: pgfId-1607803]Viewing Storage Enclosure Traffic
 
      	 [bookmark: pgfId-1607807]Viewing Storage Systems
 
     
 
    
 
     
      [bookmark: pgfId-1607809][bookmark: 78314]Viewing Storage Enclosure 
 
     [bookmark: pgfId-1607810]Once a datasource is configured and the discovery is completed, the discovered storage system(s) are displayed in the Name column in storage enclosures
 
     
 
     [bookmark: pgfId-1607811]Step 1 From the menu bar, choose Dashboard > Storage. Use the drop-down to select All, SAN Storage Enclosures or Storage Systems.
 
     [bookmark: pgfId-1607812]You see the storage enclosures table. 
 
     [bookmark: pgfId-1607813]Step 2 Click the Show details icon next to the storage name to view more details. 
 
     [bookmark: pgfId-1607814]You see the Events, Topology and Traffic information in the dashboard. 
 
     [bookmark: pgfId-1607815]Step 3 You can click the Show Filter to filter the storage enclosures by Name or by IP Address. 
 
     [bookmark: pgfId-1607816]Step 4 In the Traffic pane, the Enclosure Traffic is displayed by default. Click the Traffic Utilization icon to view the traffic utilization. The daily average percentage of traffic utilization of the enclosure ports is displayed as a pie chart.
 
     [bookmark: pgfId-1607817]Clicking on an individual port slice of the pie chart will display specific traffic utilization details for that port.
 
      
       
     
 
     
 
     [bookmark: pgfId-1607818]Note Only EMC and NetApp vendors are supported. The ‘Other’ storage discovery handler is vendor neutral, so it depends on the vendor’s conformity to SMI-S standards to retrieve and display information.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1607820][bookmark: 50577]Viewing Storage Enclosure Events 
 
     
 
     [bookmark: pgfId-1607821]Step 1 From the menu bar, choose Dashboard > Storage. Use the drop-down to select All, SAN Storage Enclosures or Storage Systems.
 
     [bookmark: pgfId-1607822]You see the list of storage enclosures in the table. 
 
     [bookmark: pgfId-1607823]Step 2 Click the Events icon next to the storage enclosure to view the Events panel. 
 
     [bookmark: pgfId-1607824]Step 3 Click the + icon in the Events panel to expand. 
 
     [bookmark: pgfId-1607825]A list of all the events for the selected storage enclosure is displayed. 
 
    
 
     
      [bookmark: pgfId-1607827][bookmark: 76814]Viewing Storage Enclosure Topology 
 
     
 
     [bookmark: pgfId-1607828]Step 1 From the menu bar, choose Dashboard > Storage. Use the drop-down to select All, SAN Storage Enclosures or Storage Systems.
 
     [bookmark: pgfId-1607829]You see the list of storage enclosures in the table. 
 
     [bookmark: pgfId-1607830]Step 2 Click the Show details icon next to the storage enclosure to view the topology details. 
 
     [bookmark: pgfId-1607831]Step 3 Click the magnifier icons to zoom-in or zoom-out. 
 
     [bookmark: pgfId-1607832]Step 4 Click the Fabric/Network icon to view the Fabric/Network path. 
 
     [bookmark: pgfId-1607833]Step 5 Click the All Paths icon to view the complete set-up. 
 
     [bookmark: pgfId-1607834]Step 6 Click the First Shortest Path icon to view the shortest path. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1607835]Note Click Map View icon to enable the icons listed in Step 4, 5 and 6 above. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607836]Step 7 Click the Tabular View icon to view the host topology in tabular format. 
 
    
 
     
      [bookmark: pgfId-1607838][bookmark: 32375]Viewing Storage Enclosure Traffic 
 
     
 
     [bookmark: pgfId-1607839]Step 1 From the menu bar, choose Dashboard > Storage. Use the drop-down to select All, SAN Storage Enclosures or Storage Systems.
 
     [bookmark: pgfId-1607840]You see the list of storage enclosures in the table 
 
     [bookmark: pgfId-1607841]Step 2 Click the Show details icon next to the storage enclosure to view the topology details. 
 
     [bookmark: pgfId-1607842]Step 3 Use the drop-down to select the traffic according to the time duration. 
 
     [bookmark: pgfId-1607843]Step 4 Select the icons to view the traffic as a Grid, Line Chart or Stacked Chart. 
 
     [bookmark: pgfId-1607844]Step 5 Click the Show Events icon to view the events.
 
     [bookmark: pgfId-1607845]Step 6 Use the options at the bottom of the screen to view a pie chart or a line chart. Click on each name on the chart to view its details.
 
    
 
     
      [bookmark: pgfId-1607848][bookmark: 97891]Viewing Storage Systems
 
     
 
     [bookmark: pgfId-1607849]Step 1 From the menu bar, choose Dashboard > Storage. Use the drop-down to select All, SAN Storage Enclosures or Storage Systems.
 
      
       
     
 
     
 
     [bookmark: pgfId-1607850]Note The datasource must be configured and discovered at least once to display the discovered storage system(s). For more information see Adding, editing, removing, rediscovering and refreshing SMI-S Storage.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607854]Step 2 Select Click to see more details...icon to view the storage systems summary.
 
     [bookmark: pgfId-1607855]Step 3 Use the drop-down to select the Storage System. Only EMC and NetApp vendors are supported.
 
     [bookmark: pgfId-1607856]The default view consists of the storage system summary along with counts of it’s elements and graph indicating the total aggregate space used vs. free space.Click each name in the graph to go to the item in the left menu.
 
     [bookmark: pgfId-1607857]Step 4 The storage systems elements and their views are as follows:
 
      
       
       	 [bookmark: pgfId-1607861]Components 
 
       	 [bookmark: pgfId-1607865]Pools
 
       	 [bookmark: pgfId-1607869]LUNs
 
       	 [bookmark: pgfId-1607873]Filer Volumes
 
       	 [bookmark: pgfId-1607877]Hosts
 
       	 [bookmark: pgfId-1607881]Storage Processors
 
       	 [bookmark: pgfId-1607885]Storage Ports
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1607887][bookmark: 60803]Components
 
     [bookmark: pgfId-1607888]Components are containers for a set or sub-set of the disks in a storage system.The Component elements view displays a table of the disks in the collection, total number of disks managed and a summary of the collection’s used vs. raw space.
 
     
 
     [bookmark: pgfId-1607889]Step 1 Use the Storage System drop-down to select the storage system.
 
     [bookmark: pgfId-1607890]Step 2 The right-hand pane displays a summary of the storage components. Click each name to go to the item in the left menu
 
     [bookmark: pgfId-1607891]Step 3 Hover the mouse cursor on the graph to display its details.
 
     [bookmark: pgfId-1607892]Step 4 In the left-hand pane, select the storage component to view its details.
 
     [bookmark: pgfId-1607893]The number of disks managed along with its details are displayed.
 
     [bookmark: pgfId-1607894]Step 5 Click a Serial Number to display the disk and the mapped LUNs details.
 
     [bookmark: pgfId-1607895]Step 6 You can use the search box to search for a specific component.
 
    
 
     
      [bookmark: pgfId-1607897][bookmark: 10298]Pools
 
     [bookmark: pgfId-1607898]Pools are user-defined collections of LUNs displaying the pool storage. The pools elements view displays a summary of the pools, lists the LUNs in the pool and also displays the total managed and raw space.
 
     
 
     [bookmark: pgfId-1607899]Step 1 Use the Storage System drop-down to select the storage system.
 
     [bookmark: pgfId-1607900]The bar graph next to each pool indicates the total managed space of that pool.
 
     [bookmark: pgfId-1607901]Step 2 In the left-hand pane, select a pool to display:
 
      
       
       	 [bookmark: pgfId-1607902]Status of the pool
 
       	 [bookmark: pgfId-1607903]LUN’s in the pool displaying the total raw space and the total managed space.
 
       	 [bookmark: pgfId-1607904]Raid Type 
 
       	 [bookmark: pgfId-1607905]Disk Type
 
       	 [bookmark: pgfId-1607906]Details of the LUNs in the pool
 
      
 
     
 
     [bookmark: pgfId-1607907]Step 3 You can use the search box to search for a specific pool.
 
    
 
     
      [bookmark: pgfId-1607909][bookmark: 31923]LUNs
 
     [bookmark: pgfId-1607910]LUNs refer to a storage volume or a collection of volumes abstracted into a single volume. It is a unit of storage which can be pooled for access protection and management. Each LUN in the LUN Element View is displayed along with the mapping from Hosts to LUNs. If the associated Fabric has also been discovered, additional information concerning the end-to-end connection between a host and LUN is also displayed. 
 
     
 
     [bookmark: pgfId-1607911]Step 1 Use the Storage System drop-down to select the storage system.
 
     [bookmark: pgfId-1607912]Step 2 In the left-hand pane, select a LUN to display:
 
      
       
       	 [bookmark: pgfId-1607913]The LUN details along with its status and the number of Associated Hosts.
 
       	 [bookmark: pgfId-1607914]The Host LUN Mapping details along with the Access (Granted) information.
 
      
 
     
 
     [bookmark: pgfId-1607915]If the associated Fabric has also been discovered, additional information about the switch interfaces and zoning concerning the end-to-end connection between the Host and LUN is also displayed.
 
      
       
     
 
     
 
     [bookmark: pgfId-1607916]Note All fabrics that are discovered must be licensed or the fabric correlation will be disabled in the Web Client. When the feature is disabled, all correlation fields display “Unlicensed Fabric”.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607917]Step 3 You can use the search box to search for a specific LUN.
 
    
 
     
      [bookmark: pgfId-1607919][bookmark: 15414]Filer Volumes
 
     [bookmark: pgfId-1607920]Filer Volumes are applicable only for NetApp. The Filer Volume Element view displays the Status, Containing Aggregate along with the total capacity and used space.
 
     
 
     [bookmark: pgfId-1607921]Step 1 Use the Storage System drop-down to select the storage system.
 
     [bookmark: pgfId-1607922]Step 2 In the left-hand pane, select the filer to display:
 
      
       
       	 [bookmark: pgfId-1607923]The status of the filer along with the containing aggregate name.
 
       	 [bookmark: pgfId-1607924]Hover the mouse cursor over the graph to view the total capacity and available storage of the filer.
 
      
 
     
 
     [bookmark: pgfId-1607925]Step 3 You can use the search box to search for a specific Filer.
 
    
 
     
      [bookmark: pgfId-1607927][bookmark: 70098]Hosts
 
     [bookmark: pgfId-1607928]The Hosts only describes the NWWN(s) associated with a host or host enclosure along with the associated Host LUN Mapping and the Host Ports. If the associated Fabric has also been discovered, additional information concerning the end-to-end connection between a host and LUN is also displayed.
 
     
 
     [bookmark: pgfId-1607929]Step 1 Use the Storage System drop-down to select the storage system.
 
     [bookmark: pgfId-1607930]Step 2 In the left-hand pane, select a host to display:
 
      
       
       	 [bookmark: pgfId-1607931]The NWWN (Node WWN) is the WWN of the device connected to the switch.
 
       	 [bookmark: pgfId-1607932]The Host Ports along with the Host LUN Mapping.
 
       	 [bookmark: pgfId-1607933]In the Host Ports section, click a Host Enclosure Name to view its Events, Topology and SAN Traffic. For more information see the Storage section.
 
       	 [bookmark: pgfId-1607940]In the Host Ports sections, click a Host Interface to view the Switch Dashboard.
 
       	 [bookmark: pgfId-1607943]In the Host LUN Mapping section, click a Storage Interface to view the Switch Dashboard.
 
       	 [bookmark: pgfId-1607945]In the Host LUN Mapping section, click a Storage Name to view its Events, Topology and SAN Traffic. For more information see the Storage section.
 
      
 
     
 
     [bookmark: pgfId-1607949]If the associated Fabric has also been discovered, additional information about the switch interfaces and zoning concerning the end-to-end connection between the Host and LUN is also displayed.
 
      
       
     
 
     
 
     [bookmark: pgfId-1607950]Note All fabrics that are discovered must be licensed or the fabric correlation will be disabled in the Web Client. When the feature is disabled, all correlation fields display “Unlicensed Fabric”.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607951]Step 3 You can use the search box to search for a specific host.
 
    
 
     
      [bookmark: pgfId-1607953][bookmark: 37622]Storage Processors
 
     [bookmark: pgfId-1607954]Storage Processors are elements on a storage system, which enable some of its features. A storage processor includes the collection of Storage Ports it manages. In the Storage Processor Element View, the list of Storage Ports associated with a Storage Processor is displayed.
 
     
 
     [bookmark: pgfId-1607955]Step 1 Use the Storage System drop-down to select the storage system.
 
     [bookmark: pgfId-1607956]Step 2 In the left-hand pane, select a storage processor to display:
 
      
       
       	 [bookmark: pgfId-1607957]The status, adapter details and the number of ports of the storage processor.
 
       	 [bookmark: pgfId-1607958]The storage ports details.
 
      
 
     
 
     [bookmark: pgfId-1607959]Step 3 You can use the search box to search for a specific storage processor.
 
    
 
     
      [bookmark: pgfId-1607961][bookmark: 94245]Storage Ports
 
     [bookmark: pgfId-1607962]A storage port is a single port on the Storage System. It displays the summary information of each port selected.
 
     
 
     [bookmark: pgfId-1607963]Step 1 Use the Storage System drop-down to select the storage system.
 
     [bookmark: pgfId-1607964]Step 2 In the left-hand pane, select a storage port to display its details.
 
     [bookmark: pgfId-1607965]Step 3 You can use the search box to search for a specific storage port.
 
    
 
   
 
    
     [bookmark: pgfId-1607967][bookmark: 78800]Viewing Health Information 
 
    [bookmark: pgfId-1607968]The Health menu shows events and issues for the selected items that are persistent across user sessions. The Health menu contains the following submenus: 
 
     
     	 [bookmark: pgfId-1607969]Accounting—Shows a list of accounting events. 
 
     	 [bookmark: pgfId-1607970]Events—Shows a detailed list of data center events. You can filter these events by scope, date, and type of event. 
 
     	 [bookmark: pgfId-1607971]Virtual Port Channels (LAN only) 
 
    
 
    [bookmark: pgfId-1607972]This section includes the following topics: 
 
     
     	 [bookmark: pgfId-1607976]Viewing Accounting Information
 
     	 [bookmark: pgfId-1607980]Viewing Events Information 
 
     	 [bookmark: pgfId-1607984]SAN Host Redundancy
 
     	 [bookmark: pgfId-1607988]Viewing a vPC 
 
    
 
     
      [bookmark: pgfId-1607991][bookmark: 42914]Viewing Accounting Information 
 
     
 
     [bookmark: pgfId-1607992]Step 1 From the menu bar, choose Health > Accounting. 
 
     [bookmark: pgfId-1607993]The fabric name or the group name along with the accounting information is displayed.
 
     [bookmark: pgfId-1607994]Step 2 Select the Filter icon to search the accounting information by Source, User Name and Description. Use the Time drop-down to select the timeline for the search. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1607995]Note The Time drop-down appears only if you select the Filter icon. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607996]Step 3 You can also select a row and use the Delete icon to delete accounting information from the list. 
 
     [bookmark: pgfId-1607997]Step 4 You can use the Print icon to print the accounting details and use the Export to Excel icon to export the data to a Microsoft Excel spreadsheet.
 
    
 
     
      [bookmark: pgfId-1608000][bookmark: 56099]Viewing Events Information 
 
     [bookmark: pgfId-1608001]You can view the events and syslog from Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1608002]Step 1 From the menu bar, choose Health > Events. 
 
     [bookmark: pgfId-1608003]The fabrics along with the switch name and the events details are displayed.
 
     [bookmark: pgfId-1608004]The Count column displays the number of times that the same event has occurred during the time period that is shown in the Last Seen column. 
 
     [bookmark: pgfId-1608005]If you click a switch name displayed in the Switch column, Cisco Prime DCNM Web Client displays the switch dashboard. 
 
     [bookmark: pgfId-1608006]If you click the IP address displayed in the Description column, the search feature displays all search results pertaining to that device. From here, you can choose the results that you wish to view.
 
     [bookmark: pgfId-1608007]Step 2 Select one or more events in the table and click the Add Suppressor icon to open the shortcut of adding an event suppressor rule. For detailed information about adding event suppressor rules, please refer to Add Event Suppression Rules.
 
     [bookmark: pgfId-1608011]Step 3 Select a fabric and click the Acknowledge icon to acknowledge the event information for the fabric. Once you have acknowledged the event for a fabric, the acknowledge icon is displayed in the Ack column next to the fabric. 
 
     [bookmark: pgfId-1608012]Step 4 You can cancel an acknowledgment for a fabric by selecting the fabric and clicking the Unacknowledge icon. 
 
     [bookmark: pgfId-1608013]Step 5 You can use the Filter icon to enable filters for the columns displayed. 
 
     [bookmark: pgfId-1608014]Step 6 Select a fabric and use the Delete icon to delete the fabric and it’s event information from the list. 
 
     [bookmark: pgfId-1608015]Step 7 You can use the Print icon to print the event details and use the Export to Excel icon to export the data to a Microsoft Excel spreadsheet.
 
    
 
     
      [bookmark: pgfId-1608018][bookmark: 16786]SAN Host Redundancy
 
     [bookmark: pgfId-1608019]The SAN Host Redundancy check enables you to view the non-redundant host storage paths. It helps you identify the host enclosure errors along with the resolution to fix the errors.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608020]Note All fabrics that are discovered must be licensed or this feature will be disabled in the Cisco Prime DCNM Web Client. When the feature is disabled, a notification is displayed stating unlicensed fabrics are discovered.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608021]From the menu bar, choose Health > Diagnostics > SAN Host Redundancy.
 
     [bookmark: pgfId-1608022]The following tabs are displayed:
 
      
       
       	 [bookmark: pgfId-1608026]SAN Path Errors – Displays the summary section of the errors along with a table of errors.
 
       	 [bookmark: pgfId-1608030]Settings – Displays the optional checks you can run along with the exclusion lists.
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1608032][bookmark: 87989]SAN Path Errors
 
     
 
     [bookmark: pgfId-1608033]Step 1 From the menu bar, choose Health > Diagnostics > SAN Host Redundancy > SAN Path Errors tab.
 
     [bookmark: pgfId-1608034]Step 2 Use the Error Types checkboxes to filter the types of host redundancy errors from the table.
 
     [bookmark: pgfId-1608035]The Good, Skipped and Errored host enclosure counts are displayed. These are counts of the unique host enclosures as a whole and not path counts.
 
     [bookmark: pgfId-1608036]The Error Types table provides individual path error counts of host enclosures seeing an error. The Host Enclosure column displays the hosts that contain the errors. These are counts of each path in the host enclosures seeing an error. Click a host to view the Compute details.
 
     [bookmark: pgfId-1608040]The Storage Enclosure/Storage Port column displays the connected storage that is involved the errors. 
 
     [bookmark: pgfId-1608044]Step 3 Click a storage to view the Storage details. 
 
     [bookmark: pgfId-1608045]Step 4 In the Fix? column, hover the mouse cursor on the ? icon to view a solution to fix the error.
 
     [bookmark: pgfId-1608046]Step 5 Click Re-run Check Now to run the check at anytime.
 
     [bookmark: pgfId-1608047]Step 6 Click Clear All to clear all the errors displayed.
 
     [bookmark: pgfId-1608048]Step 7 Click Ignore Hosts to add the selected row(s) host enclosure to an exclusion list. The errors from that host will no longer be reported and the current errors will be purged from the database.
 
     [bookmark: pgfId-1608049]Step 8 Click Ignore Storage to add the selected row(s) storage enclosure to an exclusion list. The storage name is an hyperlink to the storage page. Select a row to delete the storage from the ignored list.
 
     [bookmark: pgfId-1608050]Step 9 Click Ignore Host-Storage Pair to add the selected row(s) host-storage pair enclosure to an exclusion list. The host name is an hyperlink to the compute page and the storage name is an hyperlink to the storage page. Select a row to delete the storage pair from the ignored list
 
      
       
     
 
     
 
     [bookmark: pgfId-1608051]Note If you click on Ignore Hosts, Ignore Storage or Ignore Storage Pair before you select a row, an error message appears.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608052]Step 10 Click the Print icon to print the summary section and the errors as tables.
 
     [bookmark: pgfId-1608053]Step 11 Click the Export to Excel icon to export the summary section and the errors as tables to a Microsoft excel spreadsheet.
 
     [bookmark: pgfId-1608054]The Dashboard > Summary > Health will display counts for Path not redundant and Missing Paths which will be hyperlinks to SAN Path errors section.
 
     [bookmark: pgfId-1608055]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608057][bookmark: 23151]Settings
 
     
 
     [bookmark: pgfId-1608058]Step 1 From the menu bar, choose Health > Diagnostics > SAN Host Redundancy> Settings.
 
     [bookmark: pgfId-1608059]Step 2 Under the Test for pane, use the check boxes to select the host redundancy optional checks. 
 
     [bookmark: pgfId-1608060]Step 3 Select the Automatically Run Check Every 24 hours checkbox to enable periodic running of the checker. The checker will run every 24 hours starting 10 minutes after the server starts.
 
     [bookmark: pgfId-1608061]Step 4 Select Excluded VSAN check box. Enter VSAN or VSAN range in the text field to skip the host enclosures that belong to VSAN(s) from the redundancy check.
 
     [bookmark: pgfId-1608062] a. The Ignored Hosts pane displays the list of host enclosures that have been skipped/ignored by the redundancy check along with the reason the host enclosure check was skipped. The following reasons may be displayed:
 
     [bookmark: pgfId-1608063] – Skipped: Enclosure has only one HBA
 
     [bookmark: pgfId-1608064] – Host was ignored by the user.
 
     [bookmark: pgfId-1608065] – Host ports managed by more than one federated servers. Check can’t be run.
 
     [bookmark: pgfId-1608066] – Skipped: No path to storage found.
 
     [bookmark: pgfId-1608067] b. The Ignored Storage tab displays the list of storage enclosures that have been selected to be ignored during redundancy check.
 
     [bookmark: pgfId-1608068] c. The Ignored Host Storage Pairs tab displays the list of host-storage pairs that have been selected to be ignored during redundancy check.
 
     [bookmark: pgfId-1608072]Step 5 The column displays the The Click a host to view the Compute details.
 
     [bookmark: pgfId-1608073]Step 6 Select a host enclosure and click the Delete button to remove the host from the ignored list and begin receiving errors about a host you had chosen to ignore. However, you can delete entries with message “Host was ignored by user”.
 
     [bookmark: pgfId-1608074]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608076]Slow Drain Analysis
 
     [bookmark: pgfId-1608077]The Slow Drain Analysis enables you to view slow drain statistics at the switch level and the port level. You can monitor the slow drain issue within any time frame. You can display the data in a chart format and export the data for analysis also.
 
     [bookmark: pgfId-1608078]The slow drain statistics are stored in the cache memory. Therefore, the statistics will be lost when the server is restarted or a new diagnostic request is placed. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1608079]Note The jobs run in the background, even after you log off.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608080]To configure and view the slow drain statistics,
 
     
 
     [bookmark: pgfId-1608081]Step 1 From the menu bar, choose Health > Diagnostics > Slow Drain Analysis.
 
     [bookmark: pgfId-1608082]Step 2 In the Scope field, select the Fabric from the drop-down list.
 
     [bookmark: pgfId-1608083]Step 3 Use the radio button to select the desired Interval to collect data.
 
     [bookmark: pgfId-1608084]Step 4 Click the Play icon to begin polling. 
 
     [bookmark: pgfId-1608085]The server begins to collect the slow drain statistics based on the scope defined by the user. The Time Remaining is displayed in the right-side of the page.
 
     [bookmark: pgfId-1608086]Step 5 Click the Stop icon to stop polling.
 
     [bookmark: pgfId-1608087]The server maintains the counters in the cache, until a new diagnostic request is placed. You can stop the polling before the time is up.
 
     [bookmark: pgfId-1608088]Step 6 Click on the arrow next to Current jobs to display the slow drain details for the jobs running on the fabric. The Fabric Name, the Status of polling and Details icon for each fabric is displayed.
 
     [bookmark: pgfId-1608089]Step 7 Click on the Detail icon to view the saved information.
 
     [bookmark: pgfId-1608090]Step 8 Click on Interface chart icon to display the slow drain value for the switch port in chart format.
 
     [bookmark: pgfId-1608091]Step 9 Click on the Filter icon to display the details based on the defined value for each column.
 
     [bookmark: pgfId-1608092]Step 10 Select the Data Rows Only checkbox to filter and display the non-zero entries in the statistics.
 
     [bookmark: pgfId-1608093]Step 11 Click on the Print icon to Prints the slow drain details.
 
     [bookmark: pgfId-1608094]Step 12 Click on the Export icon to export the slow drain statistics to a Microsoft Excel spreadsheet.
 
    
 
     
      [bookmark: pgfId-1608097][bookmark: 28277]Viewing a vPC
 
     [bookmark: pgfId-1608098]The virtual port channel (vPC) feature enables you to view the links that are physically connected to different devices as a single port channel. A vPC is an extended form of a port channel which allows you to create redundancy and increase bisectional bandwidth by enabling multiple parallel paths between nodes and allowing load balancing traffic. Traffic is distributed among two single device vPC end points. If there is an inconsistency in the vPC configurations, the vPC does not function correctly. 
 
     [bookmark: pgfId-1608099]The Cisco Prime DCNM Web Client helps you to identify the inconsistent vPCs and resolve the inconsistencies in each vPC or in all vPCs. 
 
     [bookmark: pgfId-1608100]This section contains the following: 
 
      
      	 [bookmark: pgfId-1608104]Viewing vPC Inconsistencies
 
      	 [bookmark: pgfId-1608108]Resolving vPC Inconsistencies
 
     
 
     [bookmark: pgfId-1608109]From the menu bar, choose Health > Virtual Port Channels (vPC). 
 
     [bookmark: pgfId-1608110]Cisco Prime DCNM Web Client displays both the consistent and inconsistent vPCs. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1608111]Note The vPC inconsistency page displays inconsistencies only for the devices that have required Cisco Prime DCNM licenses installed on them. The devices that do not have Cisco Prime DCNM LAN license installed on them do not appear on this page. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608177]Table 3-1 displays the following vPC configuration details in the data grid view.
 
      
       
        
        [bookmark: pgfId-1608118]Table 3-1 [bookmark: 64781]vPC Configuration Details
 
        
        
         
         	 
           
           [bookmark: pgfId-1608122]Column 
          
  
         	 
           
           [bookmark: pgfId-1608124]Description 
          
  
        
 
         
         	[bookmark: pgfId-1608126]vPC ID
  
         	[bookmark: pgfId-1608128]You can view all the multichassis vPC end points and corresponding peer switches for each vPC ID.
  
        
 
         
         	[bookmark: pgfId-1608130]Domain ID
  
         	[bookmark: pgfId-1608132]Domain ID of the vPC peer switches. 
  
        
 
         
         	[bookmark: pgfId-1608134]Multi-chassis vPC End Point - Device Name 
  
         	[bookmark: pgfId-1608136]Details of the corresponding to peer single chassis primary vPC end points.
  
        
 
         
         	[bookmark: pgfId-1608138]Multi-chassis vPC End Point - Port Channel ID
  
         	[bookmark: pgfId-1608140]Single port channel that is connected to two single chassis vPC end points. 
  
        
 
         
         	[bookmark: pgfId-1608142]Primary vPC Peer - Peer Port Channel
  
         	[bookmark: pgfId-1608144]Details of the corresponding multichassis vPC end points.
  
        
 
         
         	[bookmark: pgfId-1608146]Primary vPC Peer - Port Channel
  
         	[bookmark: pgfId-1608148]Single port channel that is connected to two single chassis vPC end points.
  
        
 
         
         	[bookmark: pgfId-1608150]Primary vPC Peer - Device Name 
  
         	[bookmark: pgfId-1608152]Hostname of the vPC peer switches. 
  
        
 
         
         	[bookmark: pgfId-1608154]Secondary vPC Peer - Peer Port Channel 
  
         	[bookmark: pgfId-1608156]Details that correspond to the peer single chassis secondary vPC end points. 
  
        
 
         
         	[bookmark: pgfId-1608158]Secondary vPC Peer -Port Channel 
  
         	[bookmark: pgfId-1608160]Secondary port channel that is connected to two single chassis vPC end points.
  
        
 
         
         	[bookmark: pgfId-1608162]Secondary vPC Peer -Device Name 
  
         	[bookmark: pgfId-1608164]Secondary Hostname of the vPC peer switches.
  
        
 
         
         	[bookmark: pgfId-1608166]Consistency - Global 
  
         	[bookmark: pgfId-1608168]Configuration consistency between vPC peer port channels and vPC port channels. The valid values are Consistent and Inconsistent.
  
        
 
         
         	[bookmark: pgfId-1608170]Consistency - Global 
  
         	[bookmark: pgfId-1608172]Configuration consistency between vPC peer switches that form a peer link. 
  
        
 
         
         	[bookmark: pgfId-1608174]Consistency -vPC
  
         	[bookmark: pgfId-1608176]Configuration consistency between vPC peer port channels. 
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1608179][bookmark: 13306]Viewing vPC Inconsistencies 
 
     [bookmark: pgfId-1608180]You can view vPC inconsistencies from the Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1608181]Step 1 From the menu bar, choose Health > Virtual Port Channels (vPC).
 
     [bookmark: pgfId-1608182]Step 2 Click a specific cell to view the global or vPC inconsistencies. 
 
     [bookmark: pgfId-1608183]A popup window displays the inconsistencies between the parameters. 
 
     [bookmark: pgfId-1608184]All the conflicts in the configuration for the vPC primary device and the secondary device are displayed in red. 
 
    
 
     
      [bookmark: pgfId-1608186][bookmark: 32678]Resolving vPC Inconsistencies 
 
     [bookmark: pgfId-1608187]You can resolve vPC inconsistencies from the Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1608188]Step 1 Click the Resolve All Conflicts button to resolve all vPC inconsistencies. 
 
     [bookmark: pgfId-1608189]Step 2 Click the Print icon to print the page. 
 
     [bookmark: pgfId-1608190]Step 3 Click the Export to Excel icon to export the data to a Microsoft Excel spreadsheet. 
 
    
 
   
 
    
     [bookmark: pgfId-1608192][bookmark: 40454]Viewing Performance Information
 
    [bookmark: pgfId-1608193]The Performance option displays an overview of the average and peak throughput and link utilization of the SAN components. The Filter drop-down list at the top-right of the screen allows you to filter the data based on various time periods.
 
    [bookmark: pgfId-1608194]In a large scale environment, we recommend that you select only select only "Trunks" and not the "Access or Errors and Discards" option during Performance Collections operations. This will ensure optimal performance monitored and managed entities in DCNM and allow successful Performance collection.
 
    [bookmark: pgfId-1608195]All performance pages allows you to print the page and export to Excel, By default, the Export To Excel icon is the export traffic number in raw digit format. You can export the same unit number for the traffic data, such as GB/Gb/MB/Mb/KB/Kb/B/b, For example; If you want to display the traffic numbers in GB, you need to modify the server.properties fileto set export.unitless=false and export.unit=GB. 
 
    [bookmark: pgfId-1608196]If you set export.unitless=false, and do not enter a value for the export.unit, it will display the default Web Client unit value. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1608197]Note You do not have to restart the DCNM server. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1608198]The Performance menu contains the following submenus:
 
     
     	 [bookmark: pgfId-1608199]Switch—Shows the CPU, memory and traffic information. 
 
     	 [bookmark: pgfId-1608200]End Devices—Shows a detailed list of end devices (host or storage), port traffic and errors. 
 
     	 [bookmark: pgfId-1608201]ISLs—Shows a detailed list of ISL traffic and errors. 
 
     	 [bookmark: pgfId-1608202]NPV Links— Shows a detailed list of traffic between NPV devices and ports. 
 
     	 [bookmark: pgfId-1608203]Flows—Shows a detailed list of host-to-storage traffic. 
 
     	 [bookmark: pgfId-1608204]Ethernet—Shows a detailed list of Ethernet interfaces. 
 
     	 [bookmark: pgfId-1608205]Others—Shows a detailed list of other statistics. 
 
     	 [bookmark: pgfId-1608206]Virtual Port Channels—Shows a list of vPC utilization.
 
     	 [bookmark: pgfId-1608207]N3K Buffer Usage - Displays performance of the N3K buffer usage and the total number of bursts during a specific time.
 
    
 
     
      [bookmark: pgfId-1608209][bookmark: 98564]Rx/Tx Calculation
 
      
      	 [bookmark: pgfId-1608210]Average Rx/Tx % = Average Rx/Tx divided by Speed * 100
 
      	 [bookmark: pgfId-1608211]Peak Rx/Tx % = Peak Rx/Tx divided by Speed * 100
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608212]Note The conversion for Fabrics is 10 bit = 1 byte and for LAN traffic, the conversion is 8 bit = 1 byte.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608214]Viewing Switch CPU Information
 
     
 
     [bookmark: pgfId-1608215]Step 1 From the menu bar, choose Performance > Switch > CPU.
 
     [bookmark: pgfId-1608216]You see the CPU pane. This pane displays the CPU information for the switches in that scope.
 
     [bookmark: pgfId-1608217]Step 2 You can use the drop-down to filter the view by 24 Hours, Week, Month and Year.
 
     [bookmark: pgfId-1608221]Step 3 In the Switch column, click the switch name to view the Switch Dashboard.
 
     [bookmark: pgfId-1608222]Step 4 Click the chart icon in the Switch column to view the CPU utilization. You can also change the chart timeline to 24 hours, Week, Month and Year.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608226]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608228]Viewing Switch Memory Information
 
     
 
     [bookmark: pgfId-1608229]Step 1 From the menu bar, choose Performance > Switch > Memory.
 
     [bookmark: pgfId-1608230]You see the memory panel. This panel displays the memory information for the switches in that scope
 
     [bookmark: pgfId-1608231]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year.
 
     [bookmark: pgfId-1608232]Step 3 Click the chart icon in the Name column to see a graph of the memory usage of the switch.
 
     [bookmark: pgfId-1608236]Step 4 In the Switch column, click the switch name to view the Switch Dashboard.
 
     [bookmark: pgfId-1608237]Step 5 You can use the drop-down to view the chart in different time lines. Use the chart icons to view the traffic chart in varied views.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608241]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608243]Viewing Switch Traffic and Errors Information
 
     
 
     [bookmark: pgfId-1608244]Step 1 .From the menu bar, choose Performance > Switch > Traffic.
 
     [bookmark: pgfId-1608245]You see the Switch Traffic and Errors panel. This panel displays the traffic on that device for the past 24 hours. 
 
     [bookmark: pgfId-1608246]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year. 
 
     [bookmark: pgfId-1608247]Step 3 To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save 
 
     [bookmark: pgfId-1608251]Step 4 Click the switch name to view the Switch Dashboard. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1608255]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608257]Viewing ISL Traffic and Errors Information
 
     
 
     [bookmark: pgfId-1608258]Step 1 From the menu bar, choose Performance > ISLs/Trunks.
 
     [bookmark: pgfId-1608259]You see the ISL Traffic and Errors pane. This panel displays the ISL information for the end devices in that scope. You can reduce or expand the scope of what is displayed by using the scope menu.
 
     [bookmark: pgfId-1608260]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year.
 
     [bookmark: pgfId-1608261]Notation NaN (Not a Number) in the data grid means that the data is not available.
 
     [bookmark: pgfId-1608262]There are variations to this procedure. In addition to these basic steps, you can perform the following steps to view detailed information for ISLs:
 
      
       
       	 [bookmark: pgfId-1608263]To change the time range for this graph, select it from the drop-down list in the upper-right corner.
 
       	 [bookmark: pgfId-1608264]To view the detailed information for a specific period, drag the slider control to choose the time interval for which you need the information.
 
       	 [bookmark: pgfId-1608265]Use the chart icons to view the traffic chart in varied views.You can also use the icons to Append, Predict and Interpolate Data. To view real-time information, choose Real Time from the drop-down list in the upper right corner. The real-time data is updated in every 10 seconds.
 
       	 [bookmark: pgfId-1608266]To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save.
 
       	 [bookmark: pgfId-1608270]For the Rx/Tx calculation, see the Rx/Tx Calculation section.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608274]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608276]Viewing Performance Information for Ethernet Ports
 
     
 
     [bookmark: pgfId-1608277]Step 1 From the menu bar, choose Performance > Ethernet.
 
     [bookmark: pgfId-1608278]You see the Ethernet Traffic and Errors window. 
 
     [bookmark: pgfId-1608279]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year.
 
     [bookmark: pgfId-1608280]There are variations to this procedure. In addition to these basic steps, you can also perform the following steps:
 
      
       
       	 [bookmark: pgfId-1608281]Select the time range, and click Filter to filter the display. 
 
       	 [bookmark: pgfId-1608282]Select the name of an Ethernet port from the Name column to see a graph of the traffic across that Ethernet port for the past 24 hours. You can change the time range for this graph by selecting it from the drop-down list in the upper-right corner. To view real-time information, choose Real Time from the drop-down list in the upper-right corner. 
 
       	 [bookmark: pgfId-1608283]To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save 
 
       	 [bookmark: pgfId-1608284]Use the chart icons to view the traffic chart in varied views.You can also use the icons to Append, Predict and Interpolate Data.
 
       	 [bookmark: pgfId-1608288]For the Rx/Tx calculation, see the Rx/Tx Calculation section.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608292]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608294]Viewing Other Statistics
 
     
 
     [bookmark: pgfId-1608295]Step 1 From the menu bar, choose Performance > Others.
 
     [bookmark: pgfId-1608296]You see the Others window. 
 
     [bookmark: pgfId-1608297]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year.
 
     [bookmark: pgfId-1608298]There are variations to this procedure. In addition to these basic steps, you can also do the following:
 
      
      	 [bookmark: pgfId-1608299]Select the time range, and click Filter to filter the display. 
 
      	 [bookmark: pgfId-1608300]Click the chart icon in the Switch column to see a graph of the performance for this user defined object. You can change the time range for this graph by selecting it from the drop-down list in the upper right corner. 
 
      	 [bookmark: pgfId-1608301]To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save 
 
      	 [bookmark: pgfId-1608302]Use the chart icons to view the traffic chart in varied views.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608306]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608308]Viewing Performance Information for NPV Links
 
     
 
     [bookmark: pgfId-1608309]Step 1 From the menu bar, choose Performance > NPV Links 
 
     [bookmark: pgfId-1608310]You see the NPV Link and Traffic Errors window. This window displays the NPV links for the selected scope. 
 
     [bookmark: pgfId-1608311]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year. 
 
     [bookmark: pgfId-1608312]Step 3 Click the chart icon in the Name column to see a list of the traffic for the past 24 hours.
 
     [bookmark: pgfId-1608313]There are variations to this procedure. In addition to these basic steps, you can also perform the following steps to view detailed information for NPV links:
 
      
       
       	 [bookmark: pgfId-1608314]You can change the time range for this information by selecting from the drop-down list in the upper-right corner. 
 
       	 [bookmark: pgfId-1608315]To view the detailed information for a specific period, drag the slider control to choose the time interval for which you need the information. 
 
       	 [bookmark: pgfId-1608316]Use the chart icons to view the traffic chart in varied views. You can also use the icons to Append, Predict and Interpolate Data. 
 
       	 [bookmark: pgfId-1608317]To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save. 
 
       	 [bookmark: pgfId-1608318]To view real-time information, choose Real Time from the drop-down list in the upper right corner. The real-time data is updated in every 10 seconds. 
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608322]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608324]Viewing Performance Information on All Ports
 
     [bookmark: pgfId-1608325]You can view the performance of devices connected to all ports.
 
     
 
     [bookmark: pgfId-1608326]Step 1 From the menu bar, choose Performance > End Devices > All Ports. 
 
     [bookmark: pgfId-1608327]You see the All Ports Traffic and Errors window. 
 
     [bookmark: pgfId-1608328]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year.
 
     [bookmark: pgfId-1608329]Step 3 To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save.
 
     [bookmark: pgfId-1608330]Step 4 Click the chart icon in the Name column to see:
 
      
      	 [bookmark: pgfId-1608331]A graph of the traffic on that device according to the selected timeline.
 
      	 [bookmark: pgfId-1608332]Use the chart icons to view the traffic chart in varied views. To view real-time information, choose Real Time from the drop-down list in the upper right corner. The real-time data is updated in every 10 seconds.You can also use the icons to Append, Predict and Interpolate Data. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608336]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608338]Viewing Performance Information on Host Ports
 
     [bookmark: pgfId-1608339]You can view the performance of devices connected to the host ports
 
     
 
     [bookmark: pgfId-1608340]Step 1 From the menu bar, choose Performance > End Devices > Host Ports.
 
     [bookmark: pgfId-1608341]You see the Host Ports Traffic and Errors window. 
 
     [bookmark: pgfId-1608342]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year
 
     [bookmark: pgfId-1608343]Step 3 To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save
 
     [bookmark: pgfId-1608344]Step 4 Click the chart icon in the Name column to see 
 
      
      	 [bookmark: pgfId-1608345]A graph of the traffic on that device according to the selected timeline.
 
      	 [bookmark: pgfId-1608346]Use the chart icons to view the traffic chart in varied views. To view real-time information, choose Real Time from the drop-down list in the upper right corner. The real-time data is updated in every 10 seconds. You can also use the icons to Append, Predict and Interpolate Data. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608350]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608352]Viewing Performance Information on Storage Ports
 
     [bookmark: pgfId-1608353]You can view the performance of devices connected to the storage ports.
 
     
 
     [bookmark: pgfId-1608354]Step 1 From the menu bar, choose Performance > End Devices > Storage Ports. 
 
     [bookmark: pgfId-1608355]You see the Storage Ports Traffic and Errors window. 
 
     [bookmark: pgfId-1608356]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year. 
 
     [bookmark: pgfId-1608357]Step 3 To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save. 
 
     [bookmark: pgfId-1608358]Step 4 Click the chart icon in the Name column to see: 
 
      
      	 [bookmark: pgfId-1608359]A graph of the traffic on that device according to the selected timeline.
 
      	 [bookmark: pgfId-1608360]Use the chart icons to view the traffic chart in varied views. To view real-time information, choose Real Time from the drop-down list in the upper right corner. The real-time data is updated in every 10 seconds.You can also use the icons to Append, Predict and Interpolate Data.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608364]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608366]Viewing Performance Information on Host Enclosure
 
     [bookmark: pgfId-1608367]You can view the performance of devices connected to the host enclosure.
 
     
 
     [bookmark: pgfId-1608368]Step 1 From the menu bar, choose Performance > End Devices > Host Enclosure. 
 
     [bookmark: pgfId-1608369]You see the Host Enclosures Traffic and Errors window. 
 
     [bookmark: pgfId-1608370]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year. 
 
     [bookmark: pgfId-1608371]Step 3 To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save. 
 
     [bookmark: pgfId-1608372]Step 4 Click the chart icon in the Name column to see:
 
      
      	 [bookmark: pgfId-1608373]A graph of the traffic on that device according to the selected timeline. 
 
      	 [bookmark: pgfId-1608374]Use the chart icons to view the traffic chart in varied views. 
 
      	 [bookmark: pgfId-1608375]You can also use the icons to Append, Predict and Interpolate Data. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608379]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608381]Viewing Performance Information on Storage Enclosure 
 
     [bookmark: pgfId-1608382]You can view the performance of devices connected to the storage enclosure.
 
     
 
     [bookmark: pgfId-1608383]Step 1 .From the menu bar, choose Performance > End Devices > Storage Enclosure. 
 
     [bookmark: pgfId-1608384]You see the Storage Enclosures Traffic and Errors window. 
 
     [bookmark: pgfId-1608385]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year. 
 
     [bookmark: pgfId-1608386]Step 3 To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save. 
 
     [bookmark: pgfId-1608387]Step 4 Click the chart icon in the Name column to see: 
 
      
      	 [bookmark: pgfId-1608388]A graph of the traffic on that device according to the selected timeline. 
 
      	 [bookmark: pgfId-1608389]Use the chart icons to view the traffic chart in varied views.
 
      	 [bookmark: pgfId-1608390]You can also use the icons to Append, Predict and Interpolate Data.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608394]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608396]Viewing Performance Information on Port Groups
 
     [bookmark: pgfId-1608397]You can view the performance of devices connected to the port groups.
 
     
 
     [bookmark: pgfId-1608398]Step 1 From the menu bar, choose Performance > End Devices > Port Groups. 
 
     [bookmark: pgfId-1608399]You see the Port Groups Traffic and Errors window. 
 
     [bookmark: pgfId-1608400]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year. 
 
     [bookmark: pgfId-1608401]Step 3 Click the name port group to see the members of that port group.
 
     [bookmark: pgfId-1608402]There are variations to this procedure. In addition to these basic steps, you can also perform the following steps to view detailed information for the port groups:
 
      
       
       	 [bookmark: pgfId-1608403]To change the time range for this graph, select it from the drop-down list in the upper right corner. 
 
       	 [bookmark: pgfId-1608404]To view the detailed information for a specific period, drag the slider control to choose the time interval for which you need the information. 
 
       	 [bookmark: pgfId-1608405]Use the chart icons to view the traffic chart in varied views. 
 
       	 [bookmark: pgfId-1608406]You can also use the icons to Append, Predict and Interpolate Data. 
 
       	 [bookmark: pgfId-1608407]To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608411]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608413]Viewing Performance Information for FC Flows
 
     [bookmark: pgfId-1608414]You can view the performance of the FC Flow traffic.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608415]Note Restart the Performance Manager in the Cisco Prime DCNM Web Client when you add or remove an FC FLOW from the switch configuration, for it to reflect under the Performance > FC Flows.
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1608416]Step 1 From the menu bar, choose Performance > FC Flows.
 
     [bookmark: pgfId-1608417]You see the Flow Traffic window.
 
     [bookmark: pgfId-1608418]Step 2 You can use the drop-down to filter the view by 24 hours, Week, Month and Year. 
 
     [bookmark: pgfId-1608419]Step 3 To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save. 
 
     [bookmark: pgfId-1608420]Step 4 Click the chart icon in the Name column to see:
 
      
      	 [bookmark: pgfId-1608421]A graph of the traffic on that device according to the selected timeline.
 
      	 [bookmark: pgfId-1608422]Use the chart icons to view the traffic chart in varied views. To view real-time information, choose Real Time from the drop-down list in the upper right corner.
 
      	 [bookmark: pgfId-1608423]You can also use the icons to Append, Predict and Interpolate Data.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608427]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608429]Viewing Performance Information for Virtual Port Channels
 
     [bookmark: pgfId-1608430]You can view the relationship among virtual port channels (vPCs). You can view the statistics of all member interfaces and the aggregate of the statistics at the port channel level.
 
     
 
     [bookmark: pgfId-1608431]Step 1 From the menu bar, choose Performance > Virtual Port Channels (vPC). 
 
     [bookmark: pgfId-1608432]The vPC performance statistics appears and the aggregated statistics of all vPCs are displayed in a tabular manner. 
 
     [bookmark: pgfId-1608433]Step 2 Click on a device name in the Primary vPC peer or Secondary vPC peer column to view its member interface.
 
     [bookmark: pgfId-1608434]A popup window displays the member interfaces of the selected device.
 
     [bookmark: pgfId-1608435]Step 3 Click the Chart icon of the corresponding interface to view its historical statistics.
 
     [bookmark: pgfId-1608436]The traffic distribution statistics appear at the bottom of the vPC window. By default, the Cisco Prime DCNM Web Client displays the historical statistics for 24 hours.
 
     [bookmark: pgfId-1608437]There are variations to this procedure. In addition to these basic steps, you can also perform the following steps to view detailed information for flows:
 
      
       
       	 [bookmark: pgfId-1608438]To change the time range for this graph, select it from the drop-down list in the upper right corner. 
 
       	 [bookmark: pgfId-1608439]To view the detailed information for a specific period, drag the slider control to choose the time interval for which you need the information. 
 
       	 [bookmark: pgfId-1608440]Use the chart icons to view the traffic chart in varied views. 
 
       	 [bookmark: pgfId-1608441]You can also use the icons to Append, Predict and Interpolate Data. 
 
       	 [bookmark: pgfId-1608442]To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608446]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608448]N3K Buffer Usage
 
     [bookmark: pgfId-1608449]You can view the performance of the N3K buffer usage and the total number of bursts during a specific time.
 
     
 
     [bookmark: pgfId-1608450]Step 1 From the menu bar, choose Performance > N3K Buffer Usage
 
     [bookmark: pgfId-1608451]You see the N3K Buffer Usage window which displays the average number of burst per hour, maximum number of burst per hour and the total number of burst per hour.
 
     [bookmark: pgfId-1608452]Step 2 To export the data into a spreadsheet, click the Export to Excel icon in the upper-right corner and then click Save.
 
     [bookmark: pgfId-1608453]Step 3 Click the chart icon in the Name column to see:
 
      
      	 [bookmark: pgfId-1608454]A bar chart of the hourly based burst number for the selected interface.
 
      	 [bookmark: pgfId-1608455]Clicking each item in the bar chart will open a detailed buffer burst window for the selected hour.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608459]Note If the performance tables do not contain any data, see the Performance Manager Collections section to turn on performance data collection.
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1608461][bookmark: 46753]Viewing Inventory Information
 
    [bookmark: pgfId-1608462]Beginning with Cisco Prime DCNM release 6.x, you can view the inventory and the performance for both SAN and LAN switches by using the global Scope pane. You can select LAN, SAN, or both to view the inventory information. You can also export and print the inventory information.
 
    [bookmark: pgfId-1608463]You can either Print this information or export to Microsoft Excel.
 
    [bookmark: pgfId-1608464]The Inventory menu includes the following submenus:
 
     
     	 [bookmark: pgfId-1608465]Switches—Displays details about switches. 
 
     	 [bookmark: pgfId-1608466]Modules—Displays details for MDS switching and services modules, fans and power supplies. 
 
     	 [bookmark: pgfId-1608467]ISLs/Trunks—Displays the Inter-Switch Links. 
 
     	 [bookmark: pgfId-1608468]Licenses—Displays details about the licenses in use in the fabric. 
 
     	 [bookmark: pgfId-1608469]NPV Links—Displays the links between NPV devices and ports. 
 
     	 [bookmark: pgfId-1608470]VSANs—Displays details about VSANs. 
 
     	 [bookmark: pgfId-1608471]Active Zones— Displays details about the Regular and IVR zones. 
 
     	 [bookmark: pgfId-1608472]FC End Devices—Displays details about the devices connected to the various ports. 
 
     	 [bookmark: pgfId-1608473].Port Mapper—Displays the port mapper information.
 
     	 [bookmark: pgfId-1608474]VxLAN—Displays the VxLAN configured for the switch.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1608475]Note You can use the Print icon to print the information displayed or you can also use the Export to Excel icon to export the information displayed to a Microsoft Excel spreadsheet.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1608478][bookmark: 60573]Viewing Inventory Information for Switches
 
     
 
     [bookmark: pgfId-1608479]Step 1 From the menu bar, choose Inventory > Switches.
 
     [bookmark: pgfId-1608480]You see the Switches window displaying a list of all the switches for a selected Scope. 
 
     [bookmark: pgfId-1608481]Step 2 You can also view the following information.
 
      
      	 [bookmark: pgfId-1608485]In the Name column, select a switch to display the Switch Dashboard. For more information about switch dashboard, see the Switch Dashboard section.
 
      	 [bookmark: pgfId-1608489]Use the drop-down to view All, Warning or Unmanaged switches.
 
     
 
     [bookmark: pgfId-1608490]Step 3 In the Health column, the switch health is calculated by the capacity manager based on the following formula in the server.properties file. 
 
     [bookmark: pgfId-1608491]The function to implement is 
 
     [bookmark: pgfId-1608492]# calculate(x, x1, y, y1, z)
 
     [bookmark: pgfId-1608493]# @param x: Total number of modules
 
     [bookmark: pgfId-1608494]# @param x1: Total number of modules in warning
 
     [bookmark: pgfId-1608495]# @param y: Total number of switch ports
 
     [bookmark: pgfId-1608496]# @param y1: Total number of switch ports in warning
 
     [bookmark: pgfId-1608497]# @param z: Total number of events with severity of warning or above
 
     [bookmark: pgfId-1608498]Step 4 The value in the Health column is calculated based on the following default equation.
 
     [bookmark: pgfId-1608499]((x-x1)*1.0/x) *0.4 + ((y-y1)*1.0/y)*0.3 + ((z*1.0/1000>=1) ? 0: ((1000-z)*1.0/1000)*0.3).
 
     [bookmark: pgfId-1608500]In the above formula, the switch health value is calculated based on the following:
 
      
       
       	 [bookmark: pgfId-1608501]Percentage of Warning Modules (Contributes 40% of the total health).
 
       	 [bookmark: pgfId-1608502]Percentage of Warning Ports (Contributes 30% of the total health)
 
       	 [bookmark: pgfId-1608503]Percentage of events with severity of Warning or above (Contributes 30% of the total health. If there are more than 1000 warning events, the event health value is 0).
 
      
 
     
 
     [bookmark: pgfId-1608504]You may also have your own health calculation formula by implementing the common interface class:com.cisco.dcbu.sm.common.rif.HealthCalculatorRif. Add the.jar file to the DCNM server and modify the health.calculator property to point to the class name you have created.
 
     [bookmark: pgfId-1608505]The default Java class is defined as:health.calculator=com.cisco.dcbu.sm.common.util.HealthCalculator.
 
      
       
       	 [bookmark: pgfId-1608506]Capacity Manager calculates health only for the license switches. If the health column does not display a value, the switch either does not have a license or it has missed the capacity manager’s daily cycle.
 
       	 [bookmark: pgfId-1608507]If the switch is unlicensed, in the DCNM License column click Unlicensed. The Admin>License window appears which allows you to assign a license to the user.
 
       	 [bookmark: pgfId-1608508]The capacity manager runs two hours after the DCNM server starts. So, if you discover a device after two hours of the DCNM start time, the health will be calculated 24 hours after this DCNM start time
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1608510]Viewing Inventory Information for Modules
 
     
 
     [bookmark: pgfId-1608511]Step 1 From the menu bar, choose Inventory > Modules. 
 
     [bookmark: pgfId-1608512]You see the Modules window displaying a list of all the switches and its details for a selected Scope. 
 
     [bookmark: pgfId-1608513]You can also view the following information:
 
     [bookmark: pgfId-1608517]Step 2 In the Name column, select a switch to display the Switch Dashboard. For more information about switch dashboard, see the Switch Dashboard section.
 
     [bookmark: pgfId-1608521]Step 3 Use the drop-down to view All, Warning or Unmanaged switches
 
    
 
     
      [bookmark: pgfId-1608523]Viewing Inventory Information for ISLs/Trunks
 
     
 
     [bookmark: pgfId-1608524]Step 1 From the menu bar, choose Inventory > ISLs/Trunks. 
 
     [bookmark: pgfId-1608525]You see the ISLs window displaying the ISL details along with the speed and status of the ISLs. 
 
     [bookmark: pgfId-1608526]Step 2 Use the drop-down to view All or Warning information for the ISLs. 
 
    
 
     
      [bookmark: pgfId-1608528]Viewing Inventory Information for Licenses
 
     
 
     [bookmark: pgfId-1608529]Step 1 From the menu bar, choose Inventory > Licenses. 
 
     [bookmark: pgfId-1608530]You see the Licenses window displaying the license type and the warnings. based on the selected Scope. 
 
     [bookmark: pgfId-1608534]Step 2 In the Name column, select a switch to display the Switch Dashboard. For more information about switch dashboard, see the Switch Dashboard section. 
 
     [bookmark: pgfId-1608538]Step 3 Use the drop-down to view All, Warning or Unmanaged switches.
 
    
 
     
      [bookmark: pgfId-1608540]Viewing Inventory Information for NPV Links 
 
     
 
     [bookmark: pgfId-1608541]Step 1 From the menu bar, choose Inventory > NPV Links
 
     [bookmark: pgfId-1608542]You see the NPV Links window displaying the NPV details along with the speed and status of the NPV links.
 
     [bookmark: pgfId-1608543]Step 2 Use the drop-down to view All, Warning or Unmanaged switches.
 
    
 
     
      [bookmark: pgfId-1608545]Viewing Inventory Information for VSANs 
 
     
 
     [bookmark: pgfId-1608546]Step 1 From the menu bar, choose Inventory > VSANs.
 
     [bookmark: pgfId-1608547]You see the VSAN window displaying the VSAN details along with the status and Activate Zoneset details.
 
     [bookmark: pgfId-1608548]Step 2 Use the drop-down to view All or Warning information for the VSANs.
 
    
 
     
      [bookmark: pgfId-1608550]Viewing Inventory Information for Regular Zones
 
     
 
     [bookmark: pgfId-1608551]Step 1 From the menu bar, choose Inventory > Active Zones > Regular Zones.
 
     [bookmark: pgfId-1608552]You see the Regular Zones window displaying the inventory details of the fabrics in the regular zone.
 
     [bookmark: pgfId-1608553]Step 2 Click the Show Filter icon to enable filtering by VSAN or Zone. 
 
    
 
     
      [bookmark: pgfId-1608555]Viewing Inventory Information for IVR Zones
 
     
 
     [bookmark: pgfId-1608556]Step 1 From the menu bar, choose Inventory > Active Zones > IVR Zones 
 
     [bookmark: pgfId-1608557]You see the IVR Zones window displaying the inventory details of the fabrics in the IVR zone. 
 
     [bookmark: pgfId-1608558]Step 2 Click the Show Filter icon to enable filtering by Zone.
 
    
 
     
      [bookmark: pgfId-1608560]Viewing Inventory Information for All Ports on FC End Devices 
 
     
 
     [bookmark: pgfId-1608561]Step 1 From the menu bar, choose Inventory > End Devices > All Ports. 
 
     [bookmark: pgfId-1608562]You see the End Devices window displaying details of the FC End Devices on the all the ports. 
 
     [bookmark: pgfId-1608563]Step 2 Use the drop-down to view All or Warning information for the FC End devices. 
 
     [bookmark: pgfId-1608564]Step 3 Click the Show Filter icon to enable filtering by Enclosure, Name or VSAN.
 
    
 
     
      [bookmark: pgfId-1608566]Viewing Inventory Information for Host Ports on FC End Devices
 
     
 
     [bookmark: pgfId-1608567]Step 1 From the menu bar, choose Inventory > End Devices > Host Ports.
 
     [bookmark: pgfId-1608568]You see the End Devices>Host Ports window displaying details of the FC End Devices on the host ports. 
 
     [bookmark: pgfId-1608569]Step 2 Use the drop-down to view All or Warning information for the FC End devices on host ports. 
 
     [bookmark: pgfId-1608570]Step 3 Click the Show Filter icon to enable filtering by Enclosure, Name or VSAN.
 
    
 
     
      [bookmark: pgfId-1608572]Viewing Inventory Information for Storage Ports on FC End Devices 
 
     
 
     [bookmark: pgfId-1608573]Step 1 From the menu bar, choose Inventory > End Devices > Storage Ports.
 
     [bookmark: pgfId-1608574]You see the End Devices>Storage Ports window displaying details of the FC End devices on the storage ports 
 
     [bookmark: pgfId-1608575]Step 2 Use the drop-down to view All or Warning information for the FC End devices on storage ports. 
 
     [bookmark: pgfId-1608576]Step 3 Click the Show Filter icon to enable filtering by Enclosure, Name or VSAN. 
 
    
 
     
      [bookmark: pgfId-1608578]Viewing Inventory Information for Port Mapper
 
     [bookmark: pgfId-1608579]Beginning with Cisco NX-OS Release 6.x, you can view information about all the logical and physical ethernet interfaces of all the devices that are discovered by the Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1608580]Step 1 From the menu bar, choose Inventory > Port Mapper.
 
     [bookmark: pgfId-1608646]You see the Port Mapper window displaying the details listed in Table 3-2
 
      
       
        
        [bookmark: pgfId-1608587]Table 3-2 Port Mapper Inventory[bookmark: 27652]
 
        
        
         
         	 
           
           [bookmark: pgfId-1608591]Column 
          
  
         	 
           
           [bookmark: pgfId-1608593]Description 
          
  
        
 
         
         	[bookmark: pgfId-1608595]Device
  
         	[bookmark: pgfId-1608597]Name of the device to which the interface belongs.
  
        
 
         
         	[bookmark: pgfId-1608599]Interface Name 
  
         	[bookmark: pgfId-1608601]Name of the interface.
  
        
 
         
         	[bookmark: pgfId-1608603]Description 
  
         	[bookmark: pgfId-1608605]Description of the interface.
  
        
 
         
         	[bookmark: pgfId-1608607]Mode
  
         	[bookmark: pgfId-1608609]Mode of the interface.
  
        
 
         
         	[bookmark: pgfId-1608611]Admin Status
  
         	[bookmark: pgfId-1608613]Admin status of the port.
  
        
 
         
         	[bookmark: pgfId-1608615]Operational status 
  
         	[bookmark: pgfId-1608617]Operational status for the port.
  
        
 
         
         	[bookmark: pgfId-1608619]Speed 
  
         	[bookmark: pgfId-1608621]Speed for the interface. It is not the configured speed. 
  
        
 
         
         	[bookmark: pgfId-1608623]Duplex
  
         	[bookmark: pgfId-1608625]Single port channel that is connected to two single chassis vPC end points. 
  
        
 
         
         	[bookmark: pgfId-1608627]STP Protocol 
  
         	[bookmark: pgfId-1608629]Spanning Tree Protocol (STP) whether or not the Per-VLAN Spanning Tree (PVST), Multiple Spanning Tree (MST), and rapid-PVST is configured. 
  
        
 
         
         	[bookmark: pgfId-1608631]Access/Allowed VLANs
  
         	[bookmark: pgfId-1608633]Access VLAN is displayed if the port mode is access or displays allowed VLAN if the port mode is trunk.
  
        
 
         
         	[bookmark: pgfId-1608635]Built-in MAC Address
  
         	[bookmark: pgfId-1608637]MAC address for the port. 
  
        
 
         
         	[bookmark: pgfId-1608639]IP Address/Mask 
  
         	[bookmark: pgfId-1608641]IP address configured on the port and the IP mask. 
  
        
 
         
         	[bookmark: pgfId-1608643]SFP Serial Number
  
         	[bookmark: pgfId-1608645]Serial number of the Small Form-Factor Pluggable (SFP) if it is attached on the port
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1608647]Step 2 Click the Show Filter icon to filter the port mapping information.
 
     [bookmark: pgfId-1608648]The filter options in the Device, Interface Name, Description, Access/Allowed VLANs, Built-in MAC Address, IP Address/Mask, and SFP SerialNumber column allows you to enter text inputs in the respective field and search. In addition, you can use the drop-down list in the Mode, Admin Status, Operational Status, Speed, Duplex, and STP Protocol column to limit the objects that appear in the report.
 
     [bookmark: pgfId-1608649]Step 3 Click the Print icon to print the port mapping report of the selected device.
 
     [bookmark: pgfId-1608650]Step 4 Click the Export to Excel icon to export the port mapping report of the selected device to a Microsoft Excel spreadsheet. 
 
     [bookmark: pgfId-1608651]Step 5 Click a cell in the STP Protocol column 
 
     [bookmark: pgfId-1608652]A popup window displays the STP settings of the port.
 
     [bookmark: pgfId-1608653]Step 6 Click the Show Filter icon to filter the STP settings.
 
    
 
   
 
    
     [bookmark: pgfId-1608655][bookmark: 98693]Viewing and Creating Custom Reports
 
    [bookmark: pgfId-1608656]The Reports menu allows you to create customized reports based on historical performance, events, and inventory information gathered by Cisco Prime DCNM. You can create aggregate reports with summary and detailed views. You can also view previously saved reports.
 
     
      
    
 
    
 
    [bookmark: pgfId-1608657]Note Beginning with Cisco Prime DCNM Release 6.x versions, reports can be generated for SAN and LAN. The global view Scope pane will contain SAN, LAN, and Default LAN configurations. You can select any of these configurations, and generate reports.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1608659][bookmark: wp1416930]The Report menu includes the following sub-menus:
 
     
     	 [bookmark: pgfId-1608660]View—Displays previously saved reports. 
 
     	 [bookmark: pgfId-1608661]Generate—Generates a custom report based on the selected report template. 
 
     	 [bookmark: pgfId-1608662]Create SAN User Defined—Allows you to generate a report based on a new custom template or select an existing template along with the Configuration of Scope, Inventory, Performance, Health and User Selection.
 
     	 [bookmark: pgfId-1608663]Jobs—Displays scheduled jobs based on the selected report template.
 
    
 
    [bookmark: pgfId-1608665][bookmark: wp1416935]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1608669]Viewing Reports
 
     	 [bookmark: pgfId-1608673]Generating a Report
 
     	 [bookmark: pgfId-1608677]Creating SAN User Defined Reports
 
     	 [bookmark: pgfId-1608681]Deleting a Report Template 
 
     	 [bookmark: pgfId-1608685]Modifying a Custom Report Template 
 
     	 [bookmark: pgfId-1608689]Modifying a Custom Report Template
 
    
 
     
      [bookmark: pgfId-1608692][bookmark: 42868]Viewing Reports 
 
     [bookmark: pgfId-1608693]You can view the saved reports based on the following selection options:
 
      
      	 [bookmark: pgfId-1608694]By Template 
 
      	 [bookmark: pgfId-1608695]By User 
 
      	 [bookmark: pgfId-1608696]From the menu bar, select Reports > View. 
 
     
 
     [bookmark: pgfId-1608697]You see the view reports window. displaying the View Reports By tree on the left pane. 
 
     
 
     [bookmark: pgfId-1608698]Step 1 In the left pane, expand By Template or By User folder. 
 
     [bookmark: pgfId-1608699]Step 2 Select the report you wish to view. You can view the report in the main screen or you can select the report in the Report column to view the HTML version of the report in a new browser.
 
     [bookmark: pgfId-1608700]Step 3 To delete a specific report, select the check box and click the Delete Report icon.
 
     [bookmark: pgfId-1608701]Step 4 To delete all reports, check the check box in the header, and click the Delete Report icon.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608702]Note If you have multiple fabrics, you can select the DCNM-SAN group in the Scope to view Host to Storage connectivity of multiple fabrics in a single report.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608703]The report is divided into two sections:
 
      
      	 [bookmark: pgfId-1608704]A summary report for all the devices that have faulty modules. The table displays information for every device that includes the device host name, number of faulty modules and the module number with its PID.
 
      	 [bookmark: pgfId-1608705]A detailed information for the device of the module. The table contains details about the tests failed.
 
     
 
     [bookmark: pgfId-1608706]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608709][bookmark: 50121]Generating a Report
 
     [bookmark: pgfId-1608710]You can generate reports based on a selected template or you can schedule the report to run at a specified time.
 
     
 
     [bookmark: pgfId-1608711]Step 1 In the configuration window, use the drop-down to define the scope for report generation. 
 
     [bookmark: pgfId-1608712]In the Scope drop-down, you can select a scope group with dual fabrics, the traffic data generated by hosts and storage end devices are displayed side-by-side which enables you to view and compare traffic data generated on dual fabrics. To View this report, in the Other Predefined folder, select Traffic by VSAN (Dual Fabrics). Click Options to select the Device Type and Fabrics. Click Save to save the configuration.
 
     [bookmark: pgfId-1608713]Step 2 From the menu bar, select Reports > Generate.
 
     [bookmark: pgfId-1608714]You see the Generate Report window.
 
     [bookmark: pgfId-1608715]Step 3 In the Generate a Report Using pane, expand the folders and select the report.
 
     [bookmark: pgfId-1608716]In the Other Pre-defined folder, you can use the drop-down to select either All Devices or Host Devices while generating a report. 
 
     [bookmark: pgfId-1608717]Step 4 (Optional) In the Report Options pane, you can edit the Report Name. 
 
     [bookmark: pgfId-1608718]Step 5 (Optional) Check the Report is only visible to the Owner check box to change the attribute of the report. If selected, the report can be viewed only by the specific user and network administrator. 
 
     [bookmark: pgfId-1608719]Step 6 .(Optional) Check the Export to Csv/Excel check box to export the report in to a Microsoft Excel spreadsheet. 
 
     [bookmark: pgfId-1608720]Step 7 In the Repeat radio buttons, if you select: 
 
      
       
       	 [bookmark: pgfId-1608721]Never - The report is generated only during the current session. 
 
       	 [bookmark: pgfId-1608722]Once - The report is generated on a specified date and time apart from the current session. 
 
       	 [bookmark: pgfId-1608723]Daily -The report is generated everyday based on the Start and End date at a specified time. 
 
       	 [bookmark: pgfId-1608724]Weekly - The report is generated once a week based on the Start and End date at a specified time. 
 
       	 [bookmark: pgfId-1608725].Monthly - The report is generated once every month based on the Start and End date at a specified time. 
 
      
 
     
 
     [bookmark: pgfId-1608726]Step 8 (Optional) In the Email Report radio buttons, if you select: 
 
      
       
       	 [bookmark: pgfId-1608727]No - You will not receive an e-mail notification. 
 
       	 [bookmark: pgfId-1608728]Link Only - You will receive only a link to the report in the e-mail notification. You can specify the e-mail address of the recipient along with a desired subject. 
 
       	 [bookmark: pgfId-1608729]Contents - You will receive the report contents in the e-mail notification. You can specify the e-mail address of the recipient along with a desired subject. 
 
      
 
     
 
     [bookmark: pgfId-1608730]Step 9 Click the Create button to generate a report based on the specifications.
 
     [bookmark: pgfId-1608732][bookmark: wp1422472]You see the report results in a new browser window. 
 
     [bookmark: pgfId-1608733]Alternatively, you can view the report by choosing Report > View and selecting the report name from the report template that you used in the navigation pane
 
      
       
     
 
     
 
     [bookmark: pgfId-1608734]Note The Start Date must be at least five minutes earlier than the End Date.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608735]The report is divided into two sections:
 
      
      	 [bookmark: pgfId-1608736]A summary report for all the devices that have faulty modules. The table displays information for every device that includes the device host name, number of faulty modules and the module number with its PID.
 
      	 [bookmark: pgfId-1608737]A detailed information for the device of the module. The table contains details about the tests failed.
 
     
 
     [bookmark: pgfId-1608738]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608741][bookmark: 93692]Creating SAN User Defined Reports
 
     [bookmark: pgfId-1608742]You can create custom reports from all or any subset of information obtained by Cisco Prime DCNM-SAN. You create a report template by selecting events, performance, and inventory statistics you want in your report and set the desired SAN, fabrics or VSAN to limit the scope of the template. You can generate and schedule a report of your fabric based on this template immediately or at a later time. DCNM Web Client saves each report based on the report template used and the time you generate the report.
 
     [bookmark: pgfId-1608743]Since the Cisco MDS NX-OS Release 5.0, the report template design has changed to resolve the limitations of the earlier versions. With the new design model, you can perform add, delete, and modify functionalities on a single page. You can choose multiple fabrics and VSANs using the new navigation system, which allows you to add new items and categories in the future.
 
     [bookmark: pgfId-1608744]The new design model has three panels:
 
      
      	 [bookmark: pgfId-1608745]Templates panel - The Customs panel allows you to add new templates, modify existing templates and delete existing templates. 
 
      	 [bookmark: pgfId-1608746]Configuration panel - The Configuration panel allows you to configure a new template when it is added and modify an existing template. The options in the configuration panel are disabled until you either add a new template or select an existing template. The upper portion of the configuration panel contains many categories that you can choose and configure. 
 
      	 [bookmark: pgfId-1608747]User Selection panel - The User Selection panel displays your configuration options in real-time. While the configuration panel can display information pertaining to one category at a time, the User Selection panel displays all of your selections or configurations.
 
     
 
     [bookmark: pgfId-1608748]Follow the steps to create custom reports
 
     
 
     [bookmark: pgfId-1608749]Step 1 From the menu bar, choose Report > Create SAN User Defined 
 
     [bookmark: pgfId-1608750]You see the Create SAN User Defined window. 
 
     [bookmark: pgfId-1608751]Step 2 In the Templates panel, under the Name column, select CLICK TO ADD NEW CUSTOM to edit the Name of the new report.
 
     [bookmark: pgfId-1608752]In the Configuration Panel: 
 
     [bookmark: pgfId-1608753]Step 3 Click Scope to define scope of the report. The default scope will have Data Center, SAN, LAN, and Fabric configurations. 
 
     [bookmark: pgfId-1608754]Step 4 Click Inventory and use the checkbox to select the inventory information required in the report. You can also use the drop-down to filter by selecting the Top performance and the timeline required in the report. 
 
     [bookmark: pgfId-1608755]Step 5 Click Performance and use the checkbox to select the performance information required in the report. 
 
     [bookmark: pgfId-1608756]Step 6 Click Health and use the checkbox to select the health information required in the report. 
 
     [bookmark: pgfId-1608757]Step 7 Click Save to save this report template.
 
     [bookmark: pgfId-1608758]A confirmation message is displayed confirming that the report is saved
 
     [bookmark: pgfId-1608759]This section also contains:
 
      
      	 [bookmark: pgfId-1608763]Deleting a Report Template
 
      	 [bookmark: pgfId-1608767]Modifying a Custom Report Template
 
     
 
    
 
     
      [bookmark: pgfId-1608769][bookmark: 99242]Deleting a Report Template
 
     
 
     [bookmark: pgfId-1608770]Step 1 In the Template panel, select the report template that you want to delete. 
 
     [bookmark: pgfId-1608771]Step 2 Click the Trash icon to delete the report. 
 
     [bookmark: pgfId-1608772]Step 3 In the confirmation pop-up, click Yes to delete the template.
 
    
 
     
      [bookmark: pgfId-1608774][bookmark: 18862]Modifying a Custom Report Template
 
     
 
     [bookmark: pgfId-1608775]Step 1 From the menu bar, choose Reports > Create SAN User Defined.
 
     [bookmark: pgfId-1608776]You see the Template, Configuration and User Selection panels.
 
     [bookmark: pgfId-1608777]Step 2 Select a report from the Templates panel.
 
     [bookmark: pgfId-1608778]You see the current information about this report in the User Selection panel.
 
     [bookmark: pgfId-1608779]Step 3 Modify the information in the Configuration panel.
 
     [bookmark: pgfId-1608780]Step 4 Click Save to save the report template.
 
     [bookmark: pgfId-1608781]A confirmation message is displayed confirming that the report is saved.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608782]Note You cannot change the scope for an existing report. You must generate a new report for a new scope.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608784]Viewing Scheduled Jobs Based on a Report Template
 
     
 
     [bookmark: pgfId-1608785]Step 1 From the menu bar, choose Reports > Jobs. 
 
     [bookmark: pgfId-1608786]You see the Jobs window displaying details of the reports scheduled for generation along with its status.
 
     [bookmark: pgfId-1608787]Step 2 Select the checkbox for a specific report and click Edit Job icon to edit the report generation settings. 
 
     [bookmark: pgfId-1608788]Step 3 Select the checkbox for a specific report and click the Delete Job icon to delete a report.
 
    
 
   
 
    
     [bookmark: pgfId-1608790][bookmark: 21273]Configuring Cisco Prime DCNM Web Client
 
    [bookmark: pgfId-1608792][bookmark: wp1429566]Using Cisco Prime DCNM Web Client, you can periodically start and backup the running configurations of a switch. You can also view backed-up configurations, schedule configuration backups, compare two backed-up configurations and copy a backed-up configuration.
 
     
      
    
 
    
 
    [bookmark: pgfId-1608793]Note You must configure a backup server with Admin/SFTP credentials to create a new backup job. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1608794]Beginning with Cisco Prime DCNM Release 6.x, the backup for the LAN configuration are also supported and the backup is skipped for the all the switches where there are no configuration changes.
 
    [bookmark: pgfId-1608796][bookmark: wp1427146]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1608800]Viewing a Configuration 
 
     	 [bookmark: pgfId-1608804]Comparing Configurations 
 
     	 [bookmark: pgfId-1608808]Copying a Configuration 
 
     	 [bookmark: pgfId-1608812]Configuring Jobs 
 
     	 [bookmark: pgfId-1608816]Storage Media Encryption 
 
     	 [bookmark: pgfId-1608821]Configuring Templates[bookmark: wp1427175]
 
     	 [bookmark: pgfId-1608825]Power-On Auto Provisioning (POAP)
 
     	 [bookmark: pgfId-1608829]Fabric
 
    
 
     
      [bookmark: pgfId-1608832][bookmark: 21999]Viewing a Configuration 
 
     
 
     [bookmark: pgfId-1608833]Step 1 From the menu bar, choose Config >View.
 
     [bookmark: pgfId-1608834]You see the Groups, Eligible Switches and their configuration information. 
 
     [bookmark: pgfId-1608835]Step 2 Select a fabric from the Groups list.
 
     [bookmark: pgfId-1608836]The Groups pane displays the global view with SAN, LAN, and Default LAN groups. Depending upon the value selected in the Groups pane, the eligible switches and their configurations are listed. 
 
     [bookmark: pgfId-1608837]Step 3 From the Eligible Switch(es) list, select a switch.
 
     [bookmark: pgfId-1608838]Step 4 From the Configuration file list, select a configuration filename. 
 
     [bookmark: pgfId-1608839]Step 5 Click View to view the configuration file. 
 
     [bookmark: pgfId-1608840]Step 6 Click Delete to delete the configuration file. 
 
     [bookmark: pgfId-1608841]Step 7 Click Copy Local File to DB... to upload the configuration from the local machine to the database.
 
     [bookmark: pgfId-1608842]Step 8 Select the Show All checkbox to display all the configurations present, irrespective of the options selected in the global Scope pane
 
     [bookmark: pgfId-1608843]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608846][bookmark: 86106]Comparing Configurations
 
     
 
     [bookmark: pgfId-1608847]Step 1 From the menu bar, select Config>Compare.
 
     [bookmark: pgfId-1608848]You see the compare configuration information with the Compare and Differences tabs. 
 
     [bookmark: pgfId-1608849]Step 2 .From the Groups list, select a fabric. 
 
     [bookmark: pgfId-1608850]Step 3 .From the Eligible Switch(es) list, select a switch. 
 
     [bookmark: pgfId-1608851]Step 4 (Optional) Click the Archive, Running, or Startup radio button. 
 
     [bookmark: pgfId-1608852]Step 5 Click Compare. 
 
     [bookmark: pgfId-1608853]Step 6 Click the Differences tab to view differences in configuration based on the specified legend. 
 
     [bookmark: pgfId-1608854]Step 7 Select the difference line and click the bookmark button to bookmark/toggle bookmark.
 
     [bookmark: pgfId-1608855]Step 8 Use the Next/Previous, Next book mark/Previous bookmark buttons to navigate over the differences blocks.
 
     [bookmark: pgfId-1608856]Step 9 Click on the colored overview to strip to navigate to the difference
 
     [bookmark: pgfId-1608857]Step 10 Select the Show All checkbox to display all the configurations present, irrespective of the options selected in the global Scope pane.
 
    
 
     
      [bookmark: pgfId-1608860][bookmark: 88312]Copying a Configuration
 
     
 
     [bookmark: pgfId-1608861]Step 1 From the menu bar, select Config > Copy.
 
     [bookmark: pgfId-1608862]You see the Groups, Eligible Switches and their configuration information. 
 
     [bookmark: pgfId-1608863]Step 2 From the Groups List, select a fabric. 
 
     [bookmark: pgfId-1608864]Step 3 From the Eligible Switch(es) list, select a switch. 
 
     [bookmark: pgfId-1608865]Step 4 From the Configuration file list, select a configuration file name. 
 
     [bookmark: pgfId-1608866]Step 5 Click Copy to copy the configuration file. 
 
     [bookmark: pgfId-1608867]Step 6 Select the Show All checkbox to display all the configurations present, irrespective of the options selected in the global Scope pane.
 
    
 
     
      [bookmark: pgfId-1608870][bookmark: 67983]Configuring Jobs
 
     [bookmark: pgfId-1608871]You must set the SFTP/TFTP credentials before you configure Jobs. On the DCNM Web Client, navigate to Admin > SFTP/TFTP Credentials to set configure.
 
     
 
     [bookmark: pgfId-1608872]Step 1 From the menu bar, choose Config > Jobs. 
 
     [bookmark: pgfId-1608873]You see the scheduled jobs information along with its status. 
 
     [bookmark: pgfId-1608874]Step 2 From the Scope selector. select a single fabric or a single LAN group.
 
     [bookmark: pgfId-1608875]Note You can create jobs for a single fabric or a single LAN group. 
     
 
     [bookmark: pgfId-1608876]Step 3 Click Create Job icon to create a new config archive job.
 
     [bookmark: pgfId-1608877]A backup will be scheduled as defined.
 
     [bookmark: pgfId-1608878]Step 4 Specify the Repeat information, Start and End date, Time and Comment.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608879]Note Cisco Prime DCNM will not archive the configuration of a switch, if it is not modified after the completion of the previous archive job.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608880]Step 5 Select a job and click Delete Job to delete a specific job.
 
     [bookmark: pgfId-1608881]Click on the Status column to view the job execution details for that particular job.
 
     [bookmark: pgfId-1608882]Step 6 View Job execution details in the Job Status History tab.
 
     [bookmark: pgfId-1608883]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608884]You can also configure the Cisco Prime DCNM to retain the backup and restore configuration file for a defined time period and the number of job status entries per device. Navigate to Admin > general > Server properties on the Cisco Prime DCNM Web Client, and update the configFile.Days2Keep and config.JobStatusPerDevice fields.
 
    
 
     
      [bookmark: pgfId-1608886]Job Status History
 
     [bookmark: pgfId-1608887]From the menu bar, select Config > Jobs > Job Status History. This feature allows you to view details about the jobs archived on the Cisco Prime DCNM.
 
      
       
        
        [bookmark: pgfId-1608891]
 
        
        
         
         	 
           
           [bookmark: pgfId-1608895]Field 
          
  
         	 
           
           [bookmark: pgfId-1608897]Description 
          
  
        
 
         
         	[bookmark: pgfId-1608899]Show Filter
  
         	[bookmark: pgfId-1608901]Filters list of switches based on the defined value for each column.
  
        
 
         
         	[bookmark: pgfId-1608903]Job Name
  
         	[bookmark: pgfId-1608905]Displays the system-generated job name.
  
        
 
         
         	[bookmark: pgfId-1608907]User
  
         	[bookmark: pgfId-1608909]Specifies the persona of the person who created the job.
  
        
 
         
         	[bookmark: pgfId-1608911]Group
  
         	[bookmark: pgfId-1608913]Specifies fabric or the LAN group under which the job was created.
  
        
 
         
         	[bookmark: pgfId-1608915]Device
  
         	[bookmark: pgfId-1608917]Specifies the IP Address of the Device.
  
        
 
         
         	[bookmark: pgfId-1608919]Server
  
         	[bookmark: pgfId-1608921]Specifies the IP Address of the DCNM Server to which the device is associated with.
  
        
 
         
         	[bookmark: pgfId-1608923]Execution time
  
         	[bookmark: pgfId-1608925]Specifies the time at which the job was last executed.
  
        
 
         
         	[bookmark: pgfId-1608927]Status
  
         	[bookmark: pgfId-1608929]Specifies the status of the job.
  
        
 
         
         	[bookmark: pgfId-1608931]Description
  
         	[bookmark: pgfId-1608933]Specifies the description of the status.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1608937][bookmark: 44226]Storage Media Encryption
 
     [bookmark: pgfId-1608938]Encrypting storage media in the data center has become a critical issue. Numerous high profile incidents of lost or stolen tape and disk devices have underscored the risk and exposure companies face when sensitive information falls into the wrong hands. To satisfy the most demanding requirements, Cisco MDS 9000 Family Storage Media Encryption (SME) for the Cisco MDS 9000 family switches offers a highly scalable, reliable, and flexible solution that integrates encryption transparently as a fabric service for Fibre Channel SANs.
 
     [bookmark: pgfId-1608939]This section contains the following:
 
      
      	 [bookmark: pgfId-1608943]Selecting the Key Manager and SSL Settings 
 
      	 [bookmark: pgfId-1608947]Viewing SME Clusters
 
      	 [bookmark: pgfId-1608951]Creating a Cluster
 
     
 
    
 
     
      [bookmark: pgfId-1608953][bookmark: 29966]Selecting the Key Manager and SSL Settings
 
     
 
     [bookmark: pgfId-1608954]Step 1 From the menu bar, select Config>Provision.
 
     [bookmark: pgfId-1608955]The Key Manager Settings window is displayed with the following options:
 
      
      	 [bookmark: pgfId-1608956]None-No Key Manager selected for SME. 
 
      	 [bookmark: pgfId-1608957]Cisco-Cisco Key Manager selected for SME. 
 
      	 [bookmark: pgfId-1608958]RSA-RSA Key Manager selected for SME
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1608959]Note Once you have selected a Key Manager, you will not be able to change it. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608960]Step 2 Select one of the Radio buttons and click Submit Settings.
 
     [bookmark: pgfId-1608961]The Key Manager Settings window is displayed.
 
     [bookmark: pgfId-1608963][bookmark: wp1431893]The KMC SSL Settings pane displays the location where the certificate is stored.
 
     [bookmark: pgfId-1608964]Step 3 If you want to edit the SSL Settings, click Edit SSL Settings.
 
     [bookmark: pgfId-1608965]Step 4 Use the drop-down to select the SME KMC Trust Certificate. 
 
     [bookmark: pgfId-1608966]Step 5 Use the drop-down to select the SME KMC Server Certificate. 
 
     [bookmark: pgfId-1608967]Step 6 Specify and confirm the Server Cert Password. 
 
     [bookmark: pgfId-1608968]Step 7 Click Submit SSL Settings. 
 
     [bookmark: pgfId-1608969]Step 8 In the High Availability Settings pane, click Edit HA Settings to specify the KMC Role of this Server and SME Secondary Server Address. 
 
     [bookmark: pgfId-1608970]Step 9 Click Submit HA Settings to confirm.
 
     [bookmark: pgfId-1608971]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608973][bookmark: 47390]Viewing SME Clusters 
 
     
 
     [bookmark: pgfId-1608974]Step 1 From the menu bar, select Config>Provision and select SME from the ribbon.
 
     [bookmark: pgfId-1608975]You see the SME: Clusters window displaying the Cluster Name, Status, Fabrics and Key Management Server.
 
     [bookmark: pgfId-1608976]Step 2 Click the cluster in the Name column to view its details.
 
     [bookmark: pgfId-1608977]Step 3 In the Type option, click Convert to Signature Mode... to convert the cluster type to Disk Signature.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608978]Note Once you have chosen to convert the cluster type, you will not be able to change it again
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608979]Step 4 In the Confirm Action window, click Next.
 
     [bookmark: pgfId-1608980]Step 5 In the Convert Cluster window, click Auto to automatically convert the cluster type to Disk Signature.
 
     [bookmark: pgfId-1608981]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608983][bookmark: 13165]Creating a Cluster
 
     
 
     [bookmark: pgfId-1608984]Step 1 From the menu bar, select Config>Provision and select SME from the ribbon.
 
     [bookmark: pgfId-1608985]Step 2 You see the SME: Clusters window displaying the Cluster Name, Status, Fabrics and Key Management Server. 
 
     [bookmark: pgfId-1608986]Step 3 Select Create to create a new cluster 
 
     [bookmark: pgfId-1608987]Step 4 Select the Cluster Type, specify a Cluster Name and click Next. 
 
     [bookmark: pgfId-1608988]Step 5 Select the Fabric(s) and click Next.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608989]Note You can select multiple fabrics by holding the Ctrl key on your keyboard and selecting the fabrics. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1608990]Step 6 Select the SME Interfaces from the list and click Next. 
 
     [bookmark: pgfId-1608991]Step 7 Select the Security Type for the cluster and click Next. 
 
     [bookmark: pgfId-1608992]Step 8 Specify the Primary Key Management Server and the Secondary Key Management Server of the cluster. Alternatively, you can also use the drop-down to select the Key Management Servers for the cluster and click Next. 
 
     [bookmark: pgfId-1608993]Step 9 Specify the Transport Settings for the cluster. 
 
     [bookmark: pgfId-1608994]Step 10 Click Confirm to confirm the new cluster setup
 
     [bookmark: pgfId-1608995]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1608998][bookmark: 17020]Configuring Templates
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1609002]Field 
          
  
         	 
           
           [bookmark: pgfId-1609004]Description 
          
  
        
 
         
         	[bookmark: pgfId-1609006]Name
  
         	[bookmark: pgfId-1609008]Displays the name of the configured template.
  
        
 
         
         	[bookmark: pgfId-1609010]Description
  
         	[bookmark: pgfId-1609012]Displays the description provided while configuring templates.
  
        
 
         
         	[bookmark: pgfId-1609014]Platforms
  
         	[bookmark: pgfId-1609016]Displays the supported Cisco Nexus platforms compatible with the template.
  
        
 
         
         	[bookmark: pgfId-1609018]Tags
  
         	[bookmark: pgfId-1609020]Displays the tag assigned for the template and aids to filter templates based on the tags.
  
        
 
         
         	[bookmark: pgfId-1609022]Template Type
  
         	[bookmark: pgfId-1609024]Displays the type of the template.
  
        
 
         
         	[bookmark: pgfId-1609026]Published
  
         	[bookmark: pgfId-1609028]Specifies if the template is published or not.
  
        
 
         
         	[bookmark: pgfId-1609030]Modified Time
  
         	[bookmark: pgfId-1609032]Displays the date and time when the template was last modified, in the format YYYY-MM-DD HH:MM:SS.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1609043]This section contains the following:
 
      
      	 [bookmark: pgfId-1609047]Template Structure
 
      	 [bookmark: pgfId-1609051]Adding a Template
 
      	 [bookmark: pgfId-1609055]Configuring Template Job
 
      	 [bookmark: pgfId-1609059]Modifying a Template
 
      	 [bookmark: pgfId-1609063]Importing a Template
 
      	 [bookmark: pgfId-1609067]Exporting a Templatef
 
      	 [bookmark: pgfId-1609071]Deleting a Template
 
     
 
    
 
     
      [bookmark: pgfId-1609073][bookmark: 44450]Template Structure
 
     [bookmark: pgfId-1609074]The configuration template content mainly consists of four parts. You can click on the Help icon next to the Template Content window for information about editing the content of the template. Click on the Help icon next to the Template Content window for information about editing the content of the template.
 
     [bookmark: pgfId-1609075]This section contains the following:
 
      
      	 [bookmark: pgfId-1609079]Template Format
 
      	 [bookmark: pgfId-1609083]Template Variables
 
      	 [bookmark: pgfId-1609087]Variable meta property
 
      	 [bookmark: pgfId-1609091]Variable Annotation
 
      	 [bookmark: pgfId-1609095]Templates Content
 
      	 [bookmark: pgfId-1609099]Advanced Features
 
     
 
    
 
     
      [bookmark: pgfId-1609101][bookmark: 66478]Template Format
 
     [bookmark: pgfId-1609102]This section describes the basic information of the template. The possible fields are as detailed in the table below.
 
     [bookmark: pgfId-1609115]The name of the template
 
     [bookmark: pgfId-1609117]Text
 
     [bookmark: pgfId-1609119]No
 
     [bookmark: pgfId-1609121]description
 
     [bookmark: pgfId-1609123]Brief description about the template
 
     [bookmark: pgfId-1609125]Text
 
     [bookmark: pgfId-1609127]Yes
 
     [bookmark: pgfId-1609129]userDefined
 
     [bookmark: pgfId-1609131]Indicates whether the user created the template. Value is ‘true’ if user created.
 
     [bookmark: pgfId-1609133]“true” or “false”
 
     [bookmark: pgfId-1609135]Yes
 
     [bookmark: pgfId-1609137]supportedPlatforms
 
     [bookmark: pgfId-1609139]List of device platforms supports this config template. Specify ‘All’ to support all platforms.
 
     [bookmark: pgfId-1609141]“All” or combination of C6500, N1010, N1110, N1K, N3K, N4K, N7K, N6K, N5K, N5500, MDS, UCS list separated by comma.
 
     [bookmark: pgfId-1609143]No
 
     [bookmark: pgfId-1609145]configType
 
     [bookmark: pgfId-1609147]Specifies the Template used for
 
     [bookmark: pgfId-1609149]“CLI” or “POAP:
 
     [bookmark: pgfId-1609151]Yes
 
     [bookmark: pgfId-1609153]published
 
     [bookmark: pgfId-1609155]Used to Mark the template as read only and avoids changes to it.
 
     [bookmark: pgfId-1609157]“true” or “false”
 
     [bookmark: pgfId-1609159]Yes
 
     [bookmark: pgfId-1609161]timestamp
 
     [bookmark: pgfId-1609163]Shows the template modified time
 
     [bookmark: pgfId-1609165]Modified date and time in the format YYYY-MM-DD HH:MM:SS
 
     [bookmark: pgfId-1609193]Free text
 
     [bookmark: pgfId-1609194]Example: Description for the variable
 
     [bookmark: pgfId-1609196]No
 
     [bookmark: pgfId-1609198]boolean
 
     [bookmark: pgfId-1609200]true|false
 
     [bookmark: pgfId-1609202]No
 
     [bookmark: pgfId-1609204]enum
 
     [bookmark: pgfId-1609206]Example: running-config, startup-config
 
     [bookmark: pgfId-1609208]No
 
     [bookmark: pgfId-1609210]float
 
     [bookmark: pgfId-1609212]Floating number format
 
     [bookmark: pgfId-1609214]No
 
     [bookmark: pgfId-1609216]Integer
 
     [bookmark: pgfId-1609218]Any number
 
     [bookmark: pgfId-1609220]No
 
     [bookmark: pgfId-1609222]ipAddress
 
     [bookmark: pgfId-1609224]IPv4 OR IPv6 address
 
     [bookmark: pgfId-1609226]No
 
     [bookmark: pgfId-1609228]ipV4Address
 
     [bookmark: pgfId-1609230]IPv4 address
 
     [bookmark: pgfId-1609232]No
 
     [bookmark: pgfId-1609234]ipV6Address
 
     [bookmark: pgfId-1609236]IPv6 address
 
     [bookmark: pgfId-1609238]No
 
     [bookmark: pgfId-1609240]ipV4AddressWithSubnet
 
     [bookmark: pgfId-1609242]Example: 192.168.1.1/24
 
     [bookmark: pgfId-1609244]No
 
     [bookmark: pgfId-1609246]macAddress
 
     [bookmark: pgfId-1609248]14 or 17 character length MAC address format
 
     [bookmark: pgfId-1609250]No
 
     [bookmark: pgfId-1609252]interface
 
     [bookmark: pgfId-1609254]Format: <if type><slot>[/<sub slot>]/<port>
 
     [bookmark: pgfId-1609255]Example: eth1/1, fa10/1/2 etc.
 
     [bookmark: pgfId-1609257]No
 
     [bookmark: pgfId-1609259]integerRange
 
     [bookmark: pgfId-1609261]Contiguous numbers separated by “-“
 
     [bookmark: pgfId-1609262]Discrete numbers separated by “,”
 
     [bookmark: pgfId-1609263]Example: 1-10,15,18,20
 
     [bookmark: pgfId-1609265]Yes
 
     [bookmark: pgfId-1609267]floatRange
 
     [bookmark: pgfId-1609269]Example: 10.1,50.01
 
     [bookmark: pgfId-1609271]Yes
 
     [bookmark: pgfId-1609273]ipV4AddressRange
 
     [bookmark: pgfId-1609275]Example: 172.22.31.97 - 172.22.31.99, 172.22.31.105 - 172.22.31.109
 
     [bookmark: pgfId-1609277]Yes
 
     [bookmark: pgfId-1609279]interfaceRange
 
     [bookmark: pgfId-1609281]Example: eth10/1/20-25, eth11/1-5
 
     [bookmark: pgfId-1609283]Yes
 
     [bookmark: pgfId-1609285]string[]
 
     [bookmark: pgfId-1609287]Example: {a,b,c,str1,str2}
 
     [bookmark: pgfId-1609289]Yes
 
     [bookmark: pgfId-1609291]ipAddress[]
 
     [bookmark: pgfId-1609293]Example:{192.168.1.1, 192.168.1.2, 10.1.1.1}
 
     [bookmark: pgfId-1609295]Yes
 
     [bookmark: pgfId-1609297]wwn 
 
     [bookmark: pgfId-1609298](Available only in the Web Client)
 
     [bookmark: pgfId-1609300]Example: 20:01:00:08:02:11:05:03
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1609318]Variable Type 
          
  
         	 
           
           [bookmark: pgfId-1609326]Description 
          
  
         	 
           
           [bookmark: pgfId-1609334]Variable meta property 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1609362]defaultValue 
          
  
         	 
           
           [bookmark: pgfId-1609364]validValues 
          
  
         	 
           
           [bookmark: pgfId-1609366]decimalLength 
          
  
         	 
           
           [bookmark: pgfId-1609368]min 
          
  
         	 
           
           [bookmark: pgfId-1609370]max 
          
  
         	 
           
           [bookmark: pgfId-1609372]minSlot 
          
  
         	 
           
           [bookmark: pgfId-1609374]maxSlot 
          
  
         	 
           
           [bookmark: pgfId-1609376]minPort 
          
  
         	 
           
           [bookmark: pgfId-1609378]maxPort 
          
  
         	 
           
           [bookmark: pgfId-1609380]minLength 
          
  
         	 
           
           [bookmark: pgfId-1609382]maxLength 
          
  
         	 
           
           [bookmark: pgfId-1609384]regularExpr 
          
  
        
 
         
         	[bookmark: pgfId-1609386]string
  
         	[bookmark: pgfId-1609388]literal string
  
         	 
         	 
         	 
         	 
         	 
         	[bookmark: pgfId-1609410]
  
         	[bookmark: pgfId-1609412]
  
        
 
         
         	[bookmark: pgfId-1609414]boolean
  
         	[bookmark: pgfId-1609416]A boolean value.
 
           
           [bookmark: pgfId-1609417]Example: true 
          
  
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	 
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609471]float
  
         	[bookmark: pgfId-1609473]signed real number.
 
           
           [bookmark: pgfId-1609474]Example: 75.56, -8.5 
          
  
         	[bookmark: pgfId-1609476]
  
         	[bookmark: pgfId-1609478]
  
         	[bookmark: pgfId-1609480]
  
         	[bookmark: pgfId-1609482]
  
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609500]integer
  
         	[bookmark: pgfId-1609502]signed number
 
           
           [bookmark: pgfId-1609503]Example: 50, -75 
          
  
         	[bookmark: pgfId-1609505]
  
         	[bookmark: pgfId-1609507]
  
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609529]ipAddress
  
         	[bookmark: pgfId-1609531]IP address in IPv4 or IPv6 format
  
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609557]ipV4Address
  
         	[bookmark: pgfId-1609559]IPv4 address
  
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609585]ipV6Address
  
         	[bookmark: pgfId-1609587]IPv6 address
  
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	 
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609641]macAddress
  
         	[bookmark: pgfId-1609643]MAC address
  
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609669]interface
  
         	[bookmark: pgfId-1609671]specifies interface/port
 
           
           [bookmark: pgfId-1609672]Example: Ethernet 5/10 
          
  
         	[bookmark: pgfId-1609674]
  
         	[bookmark: pgfId-1609676]
  
         	 
         	 
         	[bookmark: pgfId-1609686]
  
         	[bookmark: pgfId-1609688]
  
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609698]integerRange
  
         	[bookmark: pgfId-1609700]Range of signed numbers
 
           
           [bookmark: pgfId-1609701]Example: 50-65 
          
  
         	[bookmark: pgfId-1609703]
  
         	[bookmark: pgfId-1609705]
  
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609727]floatRange
  
         	[bookmark: pgfId-1609729]range of signed real numbers
 
           
           [bookmark: pgfId-1609730]Example: 50.5 - 54.75 
          
  
         	[bookmark: pgfId-1609732]
  
         	[bookmark: pgfId-1609734]
  
         	[bookmark: pgfId-1609736]
  
         	[bookmark: pgfId-1609738]
  
         	 
         	 
         	 
         	 
        
 
         
         	 
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	 
         	[bookmark: pgfId-1609788]
  
         	[bookmark: pgfId-1609790]
  
         	 
         	 
         	[bookmark: pgfId-1609800]
  
         	[bookmark: pgfId-1609802]
  
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609812]string[]
  
         	[bookmark: pgfId-1609814]string literals separated by a comma (,)
 
           
           [bookmark: pgfId-1609815]Example: {string1, string2} 
          
  
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609841]ipAddress[]
  
         	[bookmark: pgfId-1609843]List of IP addresses separated by a comma (,)
  
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609869]wwn
  
         	[bookmark: pgfId-1609871]WWN address
  
         	 
         	 
         	 
         	 
         	 
         	 
        
 
         
         	[bookmark: pgfId-1609897]struct
  
         	[bookmark: pgfId-1609899]set of parameters bundled under a single variable
  
         	 
         	 
         	 
         	 
         	 
         	 
        
 
        
      
 
     
 
      
      [bookmark: pgfId-1609925]Example: Meta Property usage 
     
 
      
      [bookmark: pgfId-1609926]##template variables 
     
 
      
      [bookmark: pgfId-1609927] 
     
 
      
      [bookmark: pgfId-1609928]integer VLAN_ID { 
     
 
      
      [bookmark: pgfId-1609929]min = 100; 
     
 
      
      [bookmark: pgfId-1609930]max= 200; 
     
 
      
      [bookmark: pgfId-1609931]}; 
     
 
      
      [bookmark: pgfId-1609932]string USER_NAME { 
     
 
      
      [bookmark: pgfId-1609933]defaultValue = admin123; 
     
 
      
      [bookmark: pgfId-1609934]minLength = 5; 
     
 
      
      [bookmark: pgfId-1609935]}; 
     
 
      
      [bookmark: pgfId-1609936]## 
     
 
    
 
     
      [bookmark: pgfId-1609938][bookmark: 30404]Variable Annotation
 
     [bookmark: pgfId-1609939]You can configure the variable properties marking the variables using annotations. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1609940]Note Variable Annotations are available for POAP only. However, the annotations do not impact on the template type ‘CLI’.
 
      
      
 
     
 
     
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1609944]Annotation Key 
          
  
         	 
           
           [bookmark: pgfId-1609946]Valid Values 
          
  
        
 
         
         	[bookmark: pgfId-1609948]DisplayName
  
         	[bookmark: pgfId-1609950]Text
 [bookmark: pgfId-1609951]Note You must enclose the text with quotes, if there is space.
  
        
 
         
         	[bookmark: pgfId-1609953]Description
  
         	[bookmark: pgfId-1609955]Text
  
        
 
         
         	[bookmark: pgfId-1609957]IsManagementIP
  
         	[bookmark: pgfId-1609959]“True” or “False”
 [bookmark: pgfId-1609960]Note This annotation must be marked only for variable “ipAddress”.
  
        
 
         
         	[bookmark: pgfId-1609962]IsDeviceID
  
         	[bookmark: pgfId-1609964]“True” or “False”
  
        
 
         
         	[bookmark: pgfId-1609966]IsInternal
  
         	[bookmark: pgfId-1609968]“True” or “False”
  
        
 
         
         	[bookmark: pgfId-1609970]IsMandatory
  
         	[bookmark: pgfId-1609972]“True” or “False”
  
        
 
         
         	[bookmark: pgfId-1609974]UsePool
  
         	[bookmark: pgfId-1609976]“True” or “False”
  
        
 
         
         	[bookmark: pgfId-1609978]Username
  
         	[bookmark: pgfId-1609980]Text
  
        
 
         
         	[bookmark: pgfId-1609982]Password
  
         	[bookmark: pgfId-1609984]Text
  
        
 
         
         	[bookmark: pgfId-1609986]DataDepend
  
         	[bookmark: pgfId-1609988]Text
  
        
 
        
      
 
     
 
      
      [bookmark: pgfId-1609990]Example: Variable Annotation 
     
 
      
      [bookmark: pgfId-1609991]##template variables 
     
 
      
      [bookmark: pgfId-1609992]@(DisplayName="Host Name", Description = "Description of the host") 
     
 
      
      [bookmark: pgfId-1609993]String hostname; 
     
 
      
      [bookmark: pgfId-1609994]@(DisplayName="Host Address", Description = " test description" IsManagementIP=true) 
     
 
      
      [bookmark: pgfId-1609995]ipAddress hostAddress; 
     
 
      
      [bookmark: pgfId-1609996]## 
     
 
    
 
     
      [bookmark: pgfId-1609998][bookmark: 88213]Templates Content
 
     [bookmark: pgfId-1609999]This section includes the configuration commands and any parameters that you want to include in the template. These commands can include the variables declared in the template variables section. During the command generation process the variable values are substituted appropriately in the template content.
 
      
       
     
 
     
 
     [bookmark: pgfId-1610000]Note You must specify the commands that you include as if you were entering them in the global configuration command mode on any device. You must consider the command mode when you include commands.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1610022]if-else if-else Statement—makes a logical decision in inclusion/exclusion of set of configuration command based on the value assigned for the variable in it.
 
     
 
      
      [bookmark: pgfId-1610023]Syntax: if(<operand 1> <logical operator> <operand 2>){ 
     
 
      
      [bookmark: pgfId-1610024]command1 .. 
     
 
      
      [bookmark: pgfId-1610025]command2.. 
     
 
      
      [bookmark: pgfId-1610026].. 
     
 
      
      [bookmark: pgfId-1610027]} else if (<operand 3> <logical operator> <operand 4> ) 
     
 
      
      [bookmark: pgfId-1610028]{ 
     
 
      
      [bookmark: pgfId-1610029]Command3 .. 
     
 
      
      [bookmark: pgfId-1610030]Command4.. 
     
 
      
      [bookmark: pgfId-1610031].. 
     
 
      
      [bookmark: pgfId-1610032]} else 
     
 
      
      [bookmark: pgfId-1610033]{ 
     
 
      
      [bookmark: pgfId-1610034]Command5 .. 
     
 
      
      [bookmark: pgfId-1610035]Command6.. 
     
 
      
      [bookmark: pgfId-1610036].. 
     
 
      
      [bookmark: pgfId-1610037]} 
     
 
      
      [bookmark: pgfId-1610038]Example: if-else if-else statement 
     
 
      
      [bookmark: pgfId-1610039]if($$USER_NAME$$ == 'admin'){ 
     
 
      
      [bookmark: pgfId-1610040]Interface2/10 
     
 
      
      [bookmark: pgfId-1610041]no shut 
     
 
      
      [bookmark: pgfId-1610042]} else { 
     
 
      
      [bookmark: pgfId-1610043]Interface2/10 
     
 
      
      [bookmark: pgfId-1610044]shut 
     
 
      
      [bookmark: pgfId-1610045]} 
     
 
      
      [bookmark: pgfId-1610046] 
     
 
      
      	 [bookmark: pgfId-1610047]foreach Statement—used for iterating a block of commands. The iteration is performed based on the assigned loop variable value.
 
     
 
      
      [bookmark: pgfId-1610048]Syntax: 
     
 
      
      [bookmark: pgfId-1610049]foreach <loop index variable> in $$<loop variable>$$ { 
     
 
      
      [bookmark: pgfId-1610050]@<loop index variable> .. 
     
 
      
      [bookmark: pgfId-1610051]} 
     
 
      
      [bookmark: pgfId-1610052] 
     
 
      
      [bookmark: pgfId-1610053]Example: foreach Statement 
     
 
      
      [bookmark: pgfId-1610054]foreach ports in $$MY_INF_RANGE$${ 
     
 
      
      [bookmark: pgfId-1610055]interface @ports 
     
 
      
      [bookmark: pgfId-1610056]no shut 
     
 
      
      [bookmark: pgfId-1610057]} 
     
 
      
      [bookmark: pgfId-1610058] 
     
 
      
      	 [bookmark: pgfId-1610059]Optional parameters—By default all parameters are mandatory. To make a parameter optional, you must annotate the parameter.
 
     
 
     [bookmark: pgfId-1610060]In the variable section, include the following command:
 
     [bookmark: pgfId-1610061]@(IsMandatory=false)
 
     [bookmark: pgfId-1610062]Integer frequency;
 
     [bookmark: pgfId-1610063]In the template content section, a command can be excluded or included without using "if" condition check, by assigning a value to the parameter. The optional command can be framed as below:
 
     [bookmark: pgfId-1610064]probe icmp [frequency frequency-value] [timeout seconds] [retry-count retry-count-value]
 
    
 
     
      [bookmark: pgfId-1610066][bookmark: 62194]Advanced Features
 
      
      	 [bookmark: pgfId-1610067]Assignment Operation
 
     
 
     [bookmark: pgfId-1610068]Config template supports assignment of variable values inside the template content section. The values are validated for the declared data type of the variable. If there is a mismatch, the value is not assigned.
 
     [bookmark: pgfId-1610069]Assignment operation can be used under the following guidelines:
 
     [bookmark: pgfId-1610070] – The operator on the left hand side must be any of the template parameter or a for loop parameter. 
 
     [bookmark: pgfId-1610071] – The operator on the right hand side values can be any of value from template parameter, for loop parameter, literal string values surrounded by quotes or simple string values. 
 
      
      	 [bookmark: pgfId-1610094]Evaluate methods
 
     
 
     [bookmark: pgfId-1610095]Config template uses the Java runtime provided Java script environment to perform arithmetic operations (such as ADD, SUBTRACT, and so on), string manipulations, and so on.
 
     [bookmark: pgfId-1610096]Locate the javascript file in the template repository path. This file contains primary set of arithmetic, string functions. You can also add custom Javascript methods.
 
     [bookmark: pgfId-1610101]Also the evalscript can be called inside if conditions as below:
 
      
      [bookmark: pgfId-1610102]if($$range$$ > evalscript(sum, $$vlan_id$$, -10)){ 
     
 
      
      [bookmark: pgfId-1610103]do something… 
     
 
      
      [bookmark: pgfId-1610104]} 
     
 
     [bookmark: pgfId-1610105]You can call a method which is in the backend of the Java script file. 
 
      
      	 [bookmark: pgfId-1610106]Dynamic decision
 
     
 
     [bookmark: pgfId-1610107]Config templates provides a special internal variable “LAST_CMD_RESPONSE”. This variable stores the last command response from th device during the execution of the command. This can be used in the config template content to make dynamic decisions to deliver the commands based on the device condition.
 
     [bookmark: pgfId-1610108]An example use case is create a VLAN, if it is does not exist on the device.
 
      
      [bookmark: pgfId-1610109]Example: Create VLAN 
     
 
      
      [bookmark: pgfId-1610110]##template content 
     
 
      
      [bookmark: pgfId-1610111]show vlan id $$vlan_id$$ 
     
 
      
      [bookmark: pgfId-1610112]if($$LAST_CMD_RESPONSE$$ contains "not found"){' 
     
 
      
      [bookmark: pgfId-1610113]vlan $$vlan_id$$ 
     
 
      
      [bookmark: pgfId-1610114]} 
     
 
      
      [bookmark: pgfId-1610115]## 
     
 
      
      [bookmark: pgfId-1610116] 
     
 
     [bookmark: pgfId-1610117]This special implicit variable can be used only in the “IF” blocks. 
 
      
      	 [bookmark: pgfId-1610118]Template referencing
 
     
 
    
 
     
      [bookmark: pgfId-1610162][bookmark: 76362]Adding a Template
 
     [bookmark: pgfId-1610163]You can add user-defined templates and schedule jobs.
 
     [bookmark: pgfId-1610164]<<add topic ID: admin_template_add>>
 
     
 
     [bookmark: pgfId-1610165]Step 1 From the menu bar, select Config > Delivery >Templates.
 
     [bookmark: pgfId-1610166]You see the name of the template along with its description, Platforms and Tags. 
 
     [bookmark: pgfId-1610167]Step 2 Click the Add icon to add a new template.
 
     [bookmark: pgfId-1610168]Step 3 Specify a Template Name, Template Description and a Tags for the new template.
 
     [bookmark: pgfId-1610169]Step 4 From the Imports drop-down, select the base template. 
 
     [bookmark: pgfId-1610170]The base template content is displayed in the Template content window. The base template provide few parameters and template content provides certain CLI commands. This can be imported in to another template and the base template content is substituted in the appropriate place of the extending template. When the user launches the extended template, the parameter inputs for the base template are also obtained. Additionally, the substituted content is used for complete CLI command generation.
 
     [bookmark: pgfId-1610171]Step 5 Select the Supported Platforms that the template must support.
 
     [bookmark: pgfId-1610172]Step 6 Click in the Template Content window to edit the template syntax.
 
     [bookmark: pgfId-1610176]For information about the structure of the Configuration Template, see “Template Structure”. 
 
     [bookmark: pgfId-1610177]Step 7 Select POAP to make this template available when you power on the application.
 
      
       
     
 
     
 
     [bookmark: pgfId-1610178]Note The template will be considered as a CLI template if POAP is not selected.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1610179]Step 8 Select Published to make the template read-only. You cannot edit a published template.
 
     [bookmark: pgfId-1610180]Step 9 Click Validate Template Syntax to validate the template values.
 
     [bookmark: pgfId-1610181]Step 10 Click Save to save the template.
 
     [bookmark: pgfId-1610182]Step 11 Click Save and Exit to save the configuration and go back to the configuring templates screen.
 
     [bookmark: pgfId-1610183]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610186][bookmark: 71802]Configuring Template Job
 
     [bookmark: pgfId-1610187]<<need to add TopicID: config_templates_job_wizard
 
     [bookmark: pgfId-1610188]You can configure and schedule jobs for individual templates from the Config > Delivery > Templates page. 
 
     
 
     [bookmark: pgfId-1610189]Step 1 From the menu bar, select Config > Templates.
 
     [bookmark: pgfId-1610190]You see the name of the template along with its description, Platforms and Tags.
 
     [bookmark: pgfId-1610191]Step 2 Use the checkbox to select a template from the list.
 
     [bookmark: pgfId-1610192]Step 3 Click the Launch Job Creation Wizard icon and click Next. 
 
     [bookmark: pgfId-1610193]Step 4 Use the drop-down to select the Device Scope. The devices configured under the selected Device Scope are displayed.
 
     [bookmark: pgfId-1610194]Step 5 Use the arrows to move the devices to the right column for job creation and click Next.
 
     [bookmark: pgfId-1610195]Step 6 Specify the VSAN_ID, VLAN_ID, ETH_SLOT_NUMBER, VFC_SLOT_NUMBER, SWITCH_PORT_MODE, ETH_PORT_RANGE and ALLOWED_VLANS values. 
 
     [bookmark: pgfId-1610196]Step 7 Use the checkbox Edit variables per device to edit the variables for specific devices and click Next. 
 
     [bookmark: pgfId-1610197]Step 8 If you have selected multiple devices, use the drop-down to select a specific device and preview its configuration.Click Back to edit the configuration or click Next. 
 
     [bookmark: pgfId-1610198]Step 9 Specify a Job Description and enter the Device Credentials.
 
     [bookmark: pgfId-1610199]Step 10 Use the radio button to select Deliver Instantly or Choose time to deliver. If you select Choose time to deliver, specify the date and time for the job delivery.
 
     [bookmark: pgfId-1610200]Step 11 Use the checkbox to select Copy Run to Start.
 
     [bookmark: pgfId-1610201]Step 12 If you want to configure additional Transaction and Delivery options, use the checkbox to select Show more options.
 
     [bookmark: pgfId-1610202]Step 13 Under Transaction Options (Optional), if you have a device with rollback feature support, select Enable Rollback checkbox and select the appropriate radio button.
 
     [bookmark: pgfId-1610203]Step 14 Under Delivery Options (Optional), specify the Timeout in seconds and use the radio button to select the Delivery Order.
 
     [bookmark: pgfId-1610204]Step 15 Click Finish to create the job.
 
     [bookmark: pgfId-1610205]A confirmation message is displayed that the job has been successfully created.
 
     [bookmark: pgfId-1610206]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610208][bookmark: 40554]Modifying a Template
 
     [bookmark: pgfId-1610209]You can edit the user-defined templates. However, the pre-defined templates cannot be edited. You cannot edit a template if it is already Published.
 
     
 
     [bookmark: pgfId-1610210]Step 1 From the menu bar, select Config > Templates.
 
     [bookmark: pgfId-1610211]You see the name of the template along with its description, Platforms and Tags.
 
     [bookmark: pgfId-1610212]Step 2 Select a template from the list and click the Modify/View template icon 
 
     [bookmark: pgfId-1610213]Step 3 Edit the Template Description, Tags.
 
     [bookmark: pgfId-1610214]The edited Template content is displayed in the right-hand pane.
 
     [bookmark: pgfId-1610215]Step 4 From the Imports drop-down, select the base template. 
 
     [bookmark: pgfId-1610216]The base template content is displayed in the Template content window. You can edit the template content based on your requirement in the Template Content window. Click on the Help icon next to the Template Content window for information about editing the content of the template.
 
     [bookmark: pgfId-1610217]Step 5 Edit the Supported Platforms for the template.
 
     [bookmark: pgfId-1610218]Step 6 Click Validate Template Syntax to validate the template values.
 
     [bookmark: pgfId-1610219]Step 7 Click Save to save the template.
 
     [bookmark: pgfId-1610220]Step 8 Click Save and Exit to save the configuration and go back to the configuring templates screen.
 
     [bookmark: pgfId-1610221]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610223][bookmark: 47042]Importing a Template
 
     
 
     [bookmark: pgfId-1610224]Step 1 From the menu bar, select Config > Templates and click on the Import template icon.
 
     [bookmark: pgfId-1610225]Step 2 Browse and select the template saved on your computer.
 
     [bookmark: pgfId-1610228]Step 3 You can edit the template parameters, if required. For information, see Modifying a Template.
 
     [bookmark: pgfId-1610230]Step 4 Click Validate Template Syntax to validate the template.
 
     [bookmark: pgfId-1610231]Step 5 Click Save to save the template or Save and Exit to save the template and exit.
 
     [bookmark: pgfId-1610232]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610234][bookmark: 39525]Exporting a Templatef
 
     
 
     [bookmark: pgfId-1610235]Step 1 From the menu bar, select Config > Templates.
 
     [bookmark: pgfId-1610236]Step 2 Use the checkbox to select a template(s) and click the Export template icon.
 
     [bookmark: pgfId-1610237]Step 3 Specify a name for the template and select a location to save the template on your computer.
 
     [bookmark: pgfId-1610238]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610240][bookmark: 88560]Deleting a Template
 
     [bookmark: pgfId-1610241]You can delete the user-defined templates. However, you cannot delete the pre-defined templates.
 
     
 
     [bookmark: pgfId-1610242]Step 1 From the menu bar, select Config > Templates.
 
     [bookmark: pgfId-1610243]Step 2 Use the checkbox to select a template(s) and click the Remove template icon.
 
     [bookmark: pgfId-1610244]Step 3 In the confirmation dialog box, click Yes to delete the template.
 
     [bookmark: pgfId-1610245]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610247]Configuring Jobs
 
     
 
     [bookmark: pgfId-1610248]Step 1 From the menu bar, select Config > Delivery > Jobs.
 
     [bookmark: pgfId-1610249]The jobs are listed along with the Job ID, description and status.
 
     [bookmark: pgfId-1610250]Step 2 Click the Show Filter icon to filter the jobs by Job ID, Description, Devices and Status. In the Status column, use the drop-down to select the job status.
 
     [bookmark: pgfId-1610251]Step 3 Select a job and click the Delete icon to delete the job.
 
     [bookmark: pgfId-1610252]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1610254][bookmark: 14242]Power-On Auto Provisioning (POAP)
 
    [bookmark: pgfId-1610255]POAP automates the process of upgrading software images and installing configuration files on Cisco Nexus switches that are being deployed in the network for the first time.
 
    [bookmark: pgfId-1610256]When a Cisco Nexus switch with the POAP feature boots and does not find the startup configuration, the switch enters POAP mode, locates a DHCP server and bootstraps itself with its interface IP address, gateway, and DNS server IP addresses. It also obtains the URL of an SCP server and downloads a configuration script that is run on the switch to download and install the appropriate software image and configuration file.
 
     
      
    
 
    
 
    [bookmark: pgfId-1610257]Note When you move the mouse cursor over an error identified in a specific parameter in any window, it will display the exact error message before you move to the next screen.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1610258]There are five main steps to configure a POAP device:
 
    
 
    [bookmark: pgfId-1610259]Step 1 DHCP Scope Creation
 
    [bookmark: pgfId-1610260]Step 2 Add the boot, startup, image and server information.
 
    [bookmark: pgfId-1610261]Step 3 Startup configuration creation
 
    [bookmark: pgfId-1610262]Step 4 Cable plan.
 
    [bookmark: pgfId-1610263]Step 5 Script and files (license) attachment
 
     
      [bookmark: pgfId-1610266][bookmark: 65002]POAP Launchpad
 
      
       
     
 
     
 
     [bookmark: pgfId-1610267]Note These features appear on your Cisco Prime DCNM Web Client application only if you have deployed the DCNM installer in the Unified Fabric mode.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1610268]The POAP launchpad contains the following configuration steps:
 
      
      	 [bookmark: pgfId-1610272]DHCP Scope - Create and manage scopes for POAP creation.
 
      	 [bookmark: pgfId-1610276]Images and Configuration - Set a server for images and configuration files.
 
      	 [bookmark: pgfId-1610280]POAP Definitions - Generate from template or upload existing configuration.
 
      	 [bookmark: pgfId-1610284]Cable Plan - Create, Publish and Deploy Cable Plans.
 
     
 
    
 
     
      [bookmark: pgfId-1610287][bookmark: 59472]DHCP Scope
 
     [bookmark: pgfId-1610288]DHCP scope is a well-defined term in DHCP arena. It is used to define a policy for giving out IP addresses and other options to host on a specific IP subnet. In DCNM, we use the DCHP scope to distribute IPv4 address, PYTHON bootscript, (or other supported protocol + access credential + server) which stores the bootscript. 
 
     [bookmark: pgfId-1610289]From the menu bar, select Config>Power-On Auto Provisioning (POAP)>DHCP Scope.
 
     [bookmark: pgfId-1610293]The columns in table Table 3-3are displayed
 
     [bookmark: pgfId-1610332]Table 3-3 [bookmark: 91100]:DHCP Scope
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1610297]DHCP Scope 
          
  
         	 
           
           [bookmark: pgfId-1610299]Comment 
          
  
        
 
         
         	[bookmark: pgfId-1610301]Scope Name
  
         	[bookmark: pgfId-1610303]The DHCP scope name must be unique amongst the switch scopes. This name is not used by ISC DHCP but used to identify the scope.
  
        
 
         
         	[bookmark: pgfId-1610305]Scope Subnet
  
         	[bookmark: pgfId-1610307]The IPv4 subnet used by the DHCP servers.
  
        
 
         
         	[bookmark: pgfId-1610309]IP Address Range
  
         	[bookmark: pgfId-1610311]The IP address ranges allocated to the POAP switches. Multiple IP addresses can be used, separated by comma.
  
        
 
         
         	[bookmark: pgfId-1610313]Lease Time
  
         	[bookmark: pgfId-1610315]Maximum lease time for the DHCP lease.
  
        
 
         
         	[bookmark: pgfId-1610317]Default Gateway
  
         	[bookmark: pgfId-1610319]The default gateway for the DHCP scope. You must enter a valid IP as the default gateway.
  
        
 
         
         	[bookmark: pgfId-1610321]Domain Name Servers
  
         	[bookmark: pgfId-1610323]The domain name server for the DHCP scope.
  
        
 
         
         	[bookmark: pgfId-1610325]Bootscript Name
  
         	[bookmark: pgfId-1610327]The Python Bootup script.
  
        
 
         
         	[bookmark: pgfId-1610329]Bootscript Server
  
         	[bookmark: pgfId-1610331]The server that holds the bootscript.
  
        
 
        
      
 
     
 
      
      	 [bookmark: pgfId-1610336]Adding a DHCP Scope
 
      	 [bookmark: pgfId-1610340]Editing an existing DHCP Scope
 
      	 [bookmark: pgfId-1610344]Deleting a DHCP Scope
 
     
 
    
 
     
      [bookmark: pgfId-1610346][bookmark: 90153]Adding a DHCP Scope
 
     
 
     [bookmark: pgfId-1610347]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>DHCP Scope.
 
     [bookmark: pgfId-1610348]Step 2 Click Add scope icon.
 
     [bookmark: pgfId-1610352]Step 3 In the Add DHCP Scope window, specify values in the fields according to the information in Table 3-3.
 
     [bookmark: pgfId-1610353]Step 4 Click Add.
 
    
 
     
      [bookmark: pgfId-1610355][bookmark: 23315]Editing an existing DHCP Scope
 
      
       
     
 
     
 
     [bookmark: pgfId-1610356]Note Once the DCNM is accessed for the first time, you must edit the default scope named 'enhanced_fab_mgmt" and add free IP address ranges.
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1610357]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>DHCP Scope.
 
     [bookmark: pgfId-1610358]Step 2 Use the checkbox to select the DHCP scope.
 
     [bookmark: pgfId-1610359]Step 3 Click Edit scope icon.
 
     [bookmark: pgfId-1610360]Step 4 In the Edit DHCP Scope window, edit the DHCP scopes.
 
     [bookmark: pgfId-1610361]Step 5 Click Apply to save the changes.
 
    
 
     
      [bookmark: pgfId-1610363][bookmark: 64650]Deleting a DHCP Scope
 
     
 
     [bookmark: pgfId-1610364]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>DHCP Scope.
 
     [bookmark: pgfId-1610365]Step 2 Use the checkbox to select the DHCP scope.
 
     [bookmark: pgfId-1610366]Step 3 Click Delete scope icon.
 
     [bookmark: pgfId-1610367]Step 4 In the delete notification, click Yes to delete the DHCP scope.
 
      
       
     
 
     
 
     [bookmark: pgfId-1610368]Note You may click the Refresh icon to refresh the DHCP Scopes list.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610371][bookmark: 41069]Images and Configuration
 
     [bookmark: pgfId-1610372]This feature enables you to specify the servers & credential used to access the device images and the uploaded or DCNM generated/published device configuration. The server containing the images could be different from the one containing the configurations. If the same server contains both images and configurations, you must provide the server IP address and credentials twice for each server, if the directories holding images and configuration files are different. By default, DCNM server will be the default image and configuration server. 
 
     [bookmark: pgfId-1610373]Copy Kickstart and system images into the repository prior to defining POAP definitions for devices. If the DCNM is the image repository, copy the image files into /var/lib/dcnm/ directory.
 
      
      	 [bookmark: pgfId-1610377]Add Image or Configuration Server URL
 
      	 [bookmark: pgfId-1610381]Editing an Image or Configuration Server URL
 
      	 [bookmark: pgfId-1610385]Deleting an Image or Configuration Server URL
 
     
 
    
 
     
      [bookmark: pgfId-1610387][bookmark: 65782]Add Image or Configuration Server URL
 
     
 
     [bookmark: pgfId-1610388]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>Image and Config Servers.
 
     [bookmark: pgfId-1610389]Step 2 Click the Add icon.
 
     [bookmark: pgfId-1610390]Step 3 In the Add Image or Configuration Servers URL window, specify a Name for the image.
 
     [bookmark: pgfId-1610391]Step 4 Enter Hostname/Ipaddress and Path to download or upload files.
 
     [bookmark: pgfId-1610392]Step 5 Specify the Username and Password.
 
     [bookmark: pgfId-1610393]Step 6 Click OK to save.
 
    
 
     
      [bookmark: pgfId-1610395][bookmark: 30772]Editing an Image or Configuration Server URL
 
     
 
     [bookmark: pgfId-1610396]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>Image and Config Servers.
 
     [bookmark: pgfId-1610397]Step 2 Select an existing Image and Configuration Server from the list, and Click the Edit icon.
 
     [bookmark: pgfId-1610398]Step 3 In the Edit Image or Configuration Servers URL window, edit the required fields.
 
     [bookmark: pgfId-1610399]Step 4 Click OK to save.
 
    
 
     
      [bookmark: pgfId-1610401][bookmark: 71123]Deleting an Image or Configuration Server URL
 
     
 
     [bookmark: pgfId-1610402]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>Image and Config Servers.
 
     [bookmark: pgfId-1610403]Step 2 Select an existing Image and Configuration Server from the list, and Click the Delete icon.
 
     [bookmark: pgfId-1610404]Step 3 In the delete notification, click Yes to delete the image and configuration server.
 
      
       
     
 
     
 
     [bookmark: pgfId-1610405]Note The default SCP Repository cannot be deleted.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610408][bookmark: 31304]POAP Templates
 
     [bookmark: pgfId-1610409]Templates can be created or imported into the template builder of DCNM. There are some predefined Fabric specific POAP templates bundled with DCNM. The template builder can be invoked from the GUI, Config->Delivery -> Templates. The templates dedicated to POAP will be used to generate many different POAP device configurations
 
     [bookmark: pgfId-1610410]The following icons are listed at the menu bar of the window to customize the view of the information in the window:
 
     [bookmark: pgfId-1610411] – Use the Show Filter icon to filter the templates.
 
     [bookmark: pgfId-1610412] – Use the Print icon to print the list of templates and their details.
 
     [bookmark: pgfId-1610413] – Use the Export icon to export the list of templates to a Microsoft Excel spreadsheet.
 
     [bookmark: pgfId-1610414]This section contains the following:
 
      
      	 [bookmark: pgfId-1610418]Add POAP template
 
      	 [bookmark: pgfId-1610422]Editing a Template
 
      	 [bookmark: pgfId-1610426]Cloning a Template
 
      	 [bookmark: pgfId-1610430]Importing a Template
 
      	 [bookmark: pgfId-1610434]Exporting a Template
 
      	 [bookmark: pgfId-1610438]Deleting a Template
 
     
 
    
 
     
      [bookmark: pgfId-1610440][bookmark: 20549]Add POAP template
 
     
 
     [bookmark: pgfId-1610441]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>POAP Definitions.
 
     [bookmark: pgfId-1610442]Step 2 In the Configuration Steps, click the template hyperlink in the POAP Definitions section.
 
     [bookmark: pgfId-1610443]Step 3 Click Add template icon.
 
     [bookmark: pgfId-1610444]Step 4 Specify the Template Name, Template Description and Tags.
 
     [bookmark: pgfId-1610445]Step 5 Use the checkbox to specify the Supported Platforms.
 
     [bookmark: pgfId-1610446]Step 6 Select the POAP checkbox or else by default, the DCNM will consider it as a CLI template.
 
     [bookmark: pgfId-1610447]Step 7 Select the Published checkbox if you want the template to have ‘Read Only’ access.
 
     [bookmark: pgfId-1610448]Step 8 In the Template Content pane, you can specify the content of the template. For help on creating the template content, click the Help icon next to the Template Content header. For information about POAP template annotations see the POAP Template Annotation section.
 
     [bookmark: pgfId-1610452]Step 9 Click Validate Template Syntax to validate syntax errors.
 
     [bookmark: pgfId-1610453]Step 10 Click Save to save the template.
 
     [bookmark: pgfId-1610454]Step 11 Click Save and Exit to save the template and exit the window.
 
     [bookmark: pgfId-1610455]Step 12 Click Cancel to discard the template.
 
    
 
     
      [bookmark: pgfId-1610457][bookmark: 74394]Editing a Template
 
     
 
     [bookmark: pgfId-1610458]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>POAP Definitions.
 
     [bookmark: pgfId-1610459]Step 2 In the Configuration Steps, click the template hyperlink in the POAP Definitions section.
 
     [bookmark: pgfId-1610460]Step 3 Select a template from the list and click Modify/View template icon.
 
     [bookmark: pgfId-1610461]Step 4 Edit the template content and click Save to save the template or Save and Exit to save and exit the screen.
 
    
 
     
      [bookmark: pgfId-1610463][bookmark: 85512]Cloning a Template
 
     
 
     [bookmark: pgfId-1610464]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>POAP Definitions.
 
     [bookmark: pgfId-1610465]Step 2 In the Configuration Steps, click the template hyperlink in the POAP Definitions section.
 
     [bookmark: pgfId-1610466]Step 3 Select a template from the list and click Modify/View template icon.
 
     [bookmark: pgfId-1610467]Step 4 Edit the template and click Save to save the template or Save and Exit to save and exit the screen.
 
    
 
     
      [bookmark: pgfId-1610469][bookmark: 38634]Importing a Template
 
     
 
     [bookmark: pgfId-1610470]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>POAP Definitions.
 
     [bookmark: pgfId-1610471]Step 2 In the Configuration Steps, click the template hyperlink in the POAP Definitions section.
 
     [bookmark: pgfId-1610472]Step 3 Select a template from the list and click Import template icon.
 
     [bookmark: pgfId-1610473]Step 4 Select the template file and upload.
 
    
 
     
      [bookmark: pgfId-1610475][bookmark: 48107]Exporting a Template
 
     
 
     [bookmark: pgfId-1610476]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>POAP Definitions.
 
     [bookmark: pgfId-1610477]Step 2 In the Configuration Steps, click the template hyperlink in the POAP Definitions section.
 
     [bookmark: pgfId-1610478]Step 3 Select a template from the list and click Export template icon.
 
     [bookmark: pgfId-1610479]Step 4 Select a location for the file download.
 
    
 
     
      [bookmark: pgfId-1610481][bookmark: 77914]Deleting a Template
 
      
       
     
 
     
 
     [bookmark: pgfId-1610482]Note Only user-defined templates can be deleted.
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1610483]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>POAP Definitions.
 
     [bookmark: pgfId-1610484]Step 2 In the Configuration Steps, click the template hyperlink in the POAP Definitions section.
 
     [bookmark: pgfId-1610485]Step 3 Select a template from the list and click Remove template icon.
 
     [bookmark: pgfId-1610486]Step 4 Click Yes to confirm.
 
    
 
     
      [bookmark: pgfId-1610488][bookmark: 28920]POAP Template Annotation
 
     [bookmark: pgfId-1610489]Annotation is used to add sematic, validation logic and description to the template variable. 
 
     [bookmark: pgfId-1610490]The Annotation for a given template variable is required to precede the given template variable. Only one annotation statement is required for each template variable. When a template variable has an associated annotation statement, the template variable has to be declared on a single line, Multiple variables cannot be declared under the same annotation statement.
 
     [bookmark: pgfId-1610491]Format of an annotation statement is as follows:
 
     [bookmark: pgfId-1610492]@(<key1>=<value1>,<key2>=<value2>, …, <keyN>=<valueN>)
 
      
       
     
 
     
 
     [bookmark: pgfId-1610493]Note • Each annotation statement is composed of one or more key-values pair. 
 
      
      	 [bookmark: pgfId-1610494]The value can be true, false, or a string. 
 
      	 [bookmark: pgfId-1610495]If the value is a string, it should be double quoted.
 
     
 
     [bookmark: pgfId-1610496]The following is a sample template variable, “hostname”, with annotation statement with the keys “DisplayName”, and “Description”:
 
     [bookmark: pgfId-1610497]@(DisplayName=”Host Name”, Description = “Description of the host”)
 
     [bookmark: pgfId-1610498]String hostname;
 
     [bookmark: pgfId-1610499]The table displays the supported keys in the annotation statement:
 
     [bookmark: pgfId-1610615]Table 3-4 Annotation Keys
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1610502]Key Name 
          
  
         	 
           
           [bookmark: pgfId-1610504]Default Value 
          
  
         	 
           
           [bookmark: pgfId-1610506]Description 
          
  
        
 
         
         	[bookmark: pgfId-1610508]DisplayName
  
         	[bookmark: pgfId-1610510]Empty String
  
         	[bookmark: pgfId-1610512]The value is displayed as a variable label in the template form GUI, on POAP definition screen.
  
        
 
         
         	[bookmark: pgfId-1610514]Description
  
         	[bookmark: pgfId-1610516]Empty String
  
         	[bookmark: pgfId-1610518]Displays the description next or below the template variable field in the template form GUI.
  
        
 
         
         	[bookmark: pgfId-1610520]IsManagement
  
         	[bookmark: pgfId-1610522]false
  
         	[bookmark: pgfId-1610524]The associated variable is of IP Address type. This will be used as the management IP address. DCNM used this IP address to manage the devices.
  
        
 
         
         	[bookmark: pgfId-1610526]IsMultiplicity
  
         	[bookmark: pgfId-1610528]false
  
         	[bookmark: pgfId-1610530]If true, this single value can take multiple values. For example; when it is used with IsManagement annotation, it allows you to type in multiple IP addresses and assign each IP address to a device.
  
        
 
         
         	[bookmark: pgfId-1610532]IsSwitchName
  
         	[bookmark: pgfId-1610534]false
  
         	[bookmark: pgfId-1610536]The associated variable value is used as the device host name.
  
        
 
         
         	[bookmark: pgfId-1610538]IsMandatory
  
         	[bookmark: pgfId-1610540]true
  
         	[bookmark: pgfId-1610542]It marks the field as mandatory if the value is set as ‘true’.
  
        
 
         
         	[bookmark: pgfId-1610544]UseDNSReverseLookup
  
         	[bookmark: pgfId-1610546]false
  
         	[bookmark: pgfId-1610548]This annotation compliments the IsSwitchName annotation. Once they are associated with a variable. The variable is populated with the reverse DNS name, if available during the creation time of the corresponding POAP definition record.
  
        
 
         
         	[bookmark: pgfId-1610550]IsFabricPort
  
         	[bookmark: pgfId-1610552]false
  
         	[bookmark: pgfId-1610554]The associated variable value contains a list of the ports used as fabric ports. The variable value will be used by the cable plan generation from POAP
  
        
 
         
         	[bookmark: pgfId-1610556]IsHostPort
  
         	[bookmark: pgfId-1610558]false
  
         	[bookmark: pgfId-1610560]Trunk ports connected to host/servers.
  
        
 
         
         	[bookmark: pgfId-1610562]IsVPCDomainID
  
         	[bookmark: pgfId-1610564]false
  
         	[bookmark: pgfId-1610566]Used as theVPC Domain ID.
  
        
 
         
         	[bookmark: pgfId-1610568]IsVPCPeerLinkSrc
  
         	[bookmark: pgfId-1610570]false
  
         	[bookmark: pgfId-1610572]Used as the VPC IPv4 source address.
  
        
 
         
         	[bookmark: pgfId-1610574]IsVPCPeerLinkDst
  
         	[bookmark: pgfId-1610576]false
  
         	[bookmark: pgfId-1610578]Used as the VPC IPv4 peer address.
  
        
 
         
         	[bookmark: pgfId-1610580]IsVPCPeerLinkPortChannel
  
         	[bookmark: pgfId-1610582]false
  
         	[bookmark: pgfId-1610584]Used for VPC port channel.
  
        
 
         
         	[bookmark: pgfId-1610586]IsVPCLinkPort
  
         	[bookmark: pgfId-1610588]false
  
         	[bookmark: pgfId-1610590]Used for VPC interface.
  
        
 
         
         	[bookmark: pgfId-1610592]IsVPC
  
         	[bookmark: pgfId-1610594]false
  
         	[bookmark: pgfId-1610596]Used as a VPC record.
  
        
 
         
         	[bookmark: pgfId-1610598]IsVPCID
  
         	[bookmark: pgfId-1610600]false
  
         	[bookmark: pgfId-1610602]Individual VPC ID.
  
        
 
         
         	[bookmark: pgfId-1610604]IsVPCPortChannel
  
         	[bookmark: pgfId-1610606]false
  
         	[bookmark: pgfId-1610608]Individual VPC port channel.
  
        
 
         
         	[bookmark: pgfId-1610610]IsVPCPort
  
         	[bookmark: pgfId-1610612]false
  
         	[bookmark: pgfId-1610614]VPC Interface.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1610618][bookmark: 27586]POAP Definitions
 
     [bookmark: pgfId-1610619]The POAP switch definition has two major functions:
 
      
      	 [bookmark: pgfId-1610620]Monitoring switch POAP process
 
      	 [bookmark: pgfId-1610621]Managing POAP switch configuration
 
     
 
     [bookmark: pgfId-1610622]You must copy the Cisco Prime DCNM license files to the /var/lib/dcnm/license directory to install as part of the POAP process.
 
     [bookmark: pgfId-1610623]You must also copy the device licenses to the /var/lib/dcnm/licenses folder. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1610624]Note The device licenses refers to the devices monitored by the Cisco Prime DCNM.
 
      
      
 
     
 
     
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1610628]Fields and Icons 
          
  
         	 
           
           [bookmark: pgfId-1610630]Description 
          
  
        
 
         
         	[bookmark: pgfId-1610632]Serial Number
  
         	[bookmark: pgfId-1610634]Specifies the serial number for the switch.
  
        
 
         
         	[bookmark: pgfId-1610636]Switch ID
  
         	[bookmark: pgfId-1610638]Specifies the ID defined for the switch
  
        
 
         
         	[bookmark: pgfId-1610640]Management IP
  
         	[bookmark: pgfId-1610642]Specifies the Management IP for the switch.
  
        
 
         
         	 [bookmark: pgfId-1610644]Status
  
        
 
         
         	[bookmark: pgfId-1610648]Switch Status
  
         	[bookmark: pgfId-1610650]Indicates if the switch is published or not.
  
        
 
         
         	[bookmark: pgfId-1610652]Publish Status
  
         	[bookmark: pgfId-1610654]Indicates if this POAP template has been published successfully to the TFTP site.
  
        
 
         
         	[bookmark: pgfId-1610656]Bootscript Status
  
         	[bookmark: pgfId-1610658]Indicates the Bootscript execution state when the device executed POAP. For details, view the “Boot Log” file.
  
        
 
         
         	[bookmark: pgfId-1610660]Diff State
  
         	[bookmark: pgfId-1610662]Specifies if the configuration defined in POAP is different from the running configuration on the device. If a difference is detected, the user has an option to make changes to the device configuration, thereby ensuring that the configuration on the device in sync with the POAP configuration.1 The different states are:
 
           
           	 [bookmark: pgfId-1610666]NA—Specifies that no POAP definition is configured on DCNM for the particular device; therefore, no difference computation can be made.
 
           	 [bookmark: pgfId-1610667]Diff Detected—Specifies that few configuration differences are detected between POAP definition in DCNM and the running configuration on the switch. You can review the difference statements and choose the commands to deploy to the device, and synchronize the running configuration with the POAP definition.
 
           	 [bookmark: pgfId-1610668]No Diff Detected—Specifies that there was no configuration diff perceived between POAP definition and the running configuration on the switch.
 
           	 [bookmark: pgfId-1610669]Error—Specifies that an error has occurred during diff computation. Refer to the logs to troubleshoot the issue.
 
          
  
        
 
         
         	[bookmark: pgfId-1610671]Model
  
         	[bookmark: pgfId-1610673]Specifies the model of the switch.
  
        
 
         
         	[bookmark: pgfId-1610675]Template/Config File Name
  
         	[bookmark: pgfId-1610677]Specifies the template used for creating the POAP definition.
 [bookmark: pgfId-1610678]Fabric and IPFabric POAP templates are available.
  
        
 
         
         	[bookmark: pgfId-1610680]Bootscript Last Updated Time
  
         	[bookmark: pgfId-1610682]Specifies the last updated time for bootscript.
  
        
 
         
         	[bookmark: pgfId-1610684]Last Published
  
         	[bookmark: pgfId-1610686]Specifies the last published time for the POAP definition.
  
        
 
         
         	[bookmark: pgfId-1610688]Last Saved
  
         	[bookmark: pgfId-1610690]Specifies the last saved time for the POAP definition.
  
        
 
         
         	[bookmark: pgfId-1610692]POAP Creation Time
  
         	[bookmark: pgfId-1610694]Specifies the time when the POAP definition was created.
  
        
 
         
         	[bookmark: pgfId-1610696]System Image
  
         	[bookmark: pgfId-1610698]Specifies the System Image used while creating the POAP definition.
  
        
 
         
         	[bookmark: pgfId-1610700]Kickstart Image
  
         	[bookmark: pgfId-1610702]Specifies the kickstart image used the PAOP definition
  
        
 
         
         	 [bookmark: pgfId-1610704]Icons
  
        
 
         
         	[bookmark: pgfId-1610708]Add
  
         	[bookmark: pgfId-1610710]Allows you to add a POAP definition. For more information, see Creating a POAP definition.
  
        
 
         
         	[bookmark: pgfId-1610715]Edit
  
         	[bookmark: pgfId-1610717]Allows you to edit a POAP definition. For more information, see Editing a POAP Definition.
  
        
 
         
         	[bookmark: pgfId-1610722]Delete
  
         	[bookmark: pgfId-1610724]Allows you to delete a POAP definition. For more information, see Deleting POAP Definitions.
  
        
 
         
         	[bookmark: pgfId-1610729]Publish 
  
         	[bookmark: pgfId-1610731]Allows you to publish a POAP definition. For more information, see Publishing POAP definitions.
  
        
 
         
         	[bookmark: pgfId-1610736]Write Erase and Reload
  
         	[bookmark: pgfId-1610738]Allows you to reboot and reload a POAP definition. For more information, see Write, Erase and Reload the POAP Switch Definition.
  
        
 
         
         	[bookmark: pgfId-1610743]Change Image
  
         	[bookmark: pgfId-1610745]Allows you to change the image for the defined POAP definition. For more information, see Change Image.
  
        
 
         
         	[bookmark: pgfId-1610750]Boot Log
  
         	[bookmark: pgfId-1610752]Display the list and view log files from the device bootflash.
  
        
 
         
         	[bookmark: pgfId-1610754]Refresh Switch
  
         	[bookmark: pgfId-1610756]Refreshes the list of switches.
  
        
 
         
         	[bookmark: pgfId-1610758]Show Filter
  
         	[bookmark: pgfId-1610760]Filters list of switches based on the defined value for each column.
  
        
 
         
         	[bookmark: pgfId-1610762]Print
  
         	[bookmark: pgfId-1610764]Prints the list of devices and their details.
  
        
 
         
         	[bookmark: pgfId-1610766]Export
  
         	[bookmark: pgfId-1610768]Exports the list of devices and their details to a Microsoft Excel spreadsheet.
  
        
 
         
         	[bookmark: pgfId-1610770]Select Columns
  
         	[bookmark: pgfId-1610772]Displays the columns to be displayed. You can choose to show/hide a column.
  
        
 
        
      
 
     
 
      
       
        
        	 1.[bookmark: pgfId-1610665]You can discover the device manually also. Navigate to Admin < Data Sources on the Web Client to initiate a “Diff state” comparison for each device.
  
       
 
       
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1610774]Note Each annotation statement is composed of one or more key-values pair. The value can be true, false or a string. If the value is a string, it should be mentioned in double-quotes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1610775]This section contains the following:
 
      
      	 [bookmark: pgfId-1610779]Creating a POAP definition
 
      	 [bookmark: pgfId-1610783]Uploading a POAP Definition
 
      	 [bookmark: pgfId-1610787]Editing a POAP Definition
 
      	 [bookmark: pgfId-1610791]Deleting POAP Definitions
 
      	 [bookmark: pgfId-1610795]Publishing POAP definitions
 
      	 [bookmark: pgfId-1610799]Write, Erase and Reload the POAP Switch Definition
 
     
 
    
 
     
      [bookmark: pgfId-1610801][bookmark: 27792]Creating a POAP definition
 
     
 
     [bookmark: pgfId-1610802]Step 1 From the menu bar, select Config > Power-On Auto Provisioning (POAP)>POAP Definitions.
 
     [bookmark: pgfId-1610803]Step 2 Click Add to add a new POAP definition.
 
     [bookmark: pgfId-1610804]Step 3 Use the radio button and select Generate Definition to generate POAP definition from a template, and click Next to specify the switch details.
 
     [bookmark: pgfId-1610805]Step 4 Enter the serial number of switches separated by comma. Alternatively, you can click the Import from CSV File button to import the list of switches.
 
     [bookmark: pgfId-1610806]Step 5 Use the drop-down to select the Switch Type.
 
     [bookmark: pgfId-1610807]Step 6 Use the drop-down to select the Image Server.
 
     [bookmark: pgfId-1610808]Step 7 Use the drop-down to select the System Image and Kickstart image.
 
     [bookmark: pgfId-1610809]Step 8 Use the drop-down to select the Config Server, and specify the Switch User Name and Password.
 
     [bookmark: pgfId-1610810]Step 9 Use the drop-down in the Add Switches to Group to add the POAP devices to a specific group, and specify the Switch User Name and Switch Password.
 
     [bookmark: pgfId-1610811]Step 10 Click Next to Select the Switch Config Template.
 
     [bookmark: pgfId-1610812]Step 11 Use the drop-down to select the Template and click View to specify the Template Parameters.
 
     [bookmark: pgfId-1610813]Step 12 Enter Template Parameters.
 
     [bookmark: pgfId-1610814]Step 13 Use the drop-down to select the Settings File. If the settings file in unavailable, click Save Parameter as New Settings File button to specify a name for the settings file, select the variables and click Save. The new settings file will now be listed in the Settings File drop-down.
 
     [bookmark: pgfId-1610815]Step 14 Click View to view the settings file parameters.
 
     [bookmark: pgfId-1610816]Step 15 Click Manage to modify the settings file parameters.
 
     [bookmark: pgfId-1610817]Step 16 Click Next to generate the configuration.
 
    
 
     
      [bookmark: pgfId-1610819][bookmark: 75025]Uploading a POAP Definition
 
     
 
     [bookmark: pgfId-1610820]Step 1 From the menu bar, select Config > Power-On Auto Provisioning (POAP) > POAP Definitions.
 
     [bookmark: pgfId-1610821]Step 2 Use the radio button and select Upload Startup Config to upload startup config to the POAP repository Server, and click Next to Enter the switch details.
 
     [bookmark: pgfId-1610822]Step 3 Enter the serial number of switches separated by comma.
 
     [bookmark: pgfId-1610823]Step 4 Use the drop-down to select the Switch Type.
 
     [bookmark: pgfId-1610824]Step 5 Use the drop-down to select the Image Server.
 
     [bookmark: pgfId-1610825]Step 6 Use the drop-down in the Add Switches to Group to add the POAP devices to a specific group.
 
     [bookmark: pgfId-1610826]Step 7 Use the drop-down to select the System Image and Kickstart Image.
 
     [bookmark: pgfId-1610827]Step 8 Use the drop-down to select the Config Server, and specify the Switch User Name and Password.
 
     [bookmark: pgfId-1610828]Step 9 Click Browse to select the upload configuration file.
 
     [bookmark: pgfId-1610829]Step 10 Click Save to save the uploaded the configuration file or Publish to publish the POAP definition.
 
    
 
     
      [bookmark: pgfId-1610831][bookmark: 52555]Editing a POAP Definition
 
     
 
     [bookmark: pgfId-1610832]Step 1 From the menu bar, select Config > Power-On Auto Provisioning (POAP) > Select the POAP switch definitions from the list and click the Edit icon.
 
     [bookmark: pgfId-1610839]Step 2 Follow the steps listed in Creating a POAP definition and Uploading a POAP Definition sections.
 
      
       
     
 
     
 
     [bookmark: pgfId-1610840]Note You can select multiple POAP definitions with similar parameters to edit POAP definition.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610842][bookmark: 65676]Deleting POAP Definitions
 
     
 
     [bookmark: pgfId-1610843]Step 1 From the menu bar, select Config > Power-On Auto Provisioning (POAP) > Select the POAP switch definitions from the list and Click the Delete icon.
 
     [bookmark: pgfId-1610844]Step 2 Click Yes to delete the switch definitions.
 
     [bookmark: pgfId-1610845]A prompt appears to delete the device from the data source.
 
     [bookmark: pgfId-1610846]Step 3 Click OK to confirm to delete the device from the data source also.
 
    
 
     
      [bookmark: pgfId-1610848][bookmark: 32364]Publishing POAP definitions
 
     
 
     [bookmark: pgfId-1610849]Step 1 From the menu bar, select Config > Power-On Auto Provisioning (POAP) > Select the POAP switch definitions from the list and Click the Publish icon.
 
     [bookmark: pgfId-1610850]Step 2 Click Yes to publish the switch definitions.
 
    
 
     
      [bookmark: pgfId-1610852][bookmark: 91748]Write, Erase and Reload the POAP Switch Definition
 
     
 
     [bookmark: pgfId-1610853]Step 1 From the menu bar, select Config > Power-On Auto Provisioning (POAP) > Select the POAP switch definitions from the list.
 
     [bookmark: pgfId-1610854]Step 2 Click the Write, Erase and Reload icon.
 
     [bookmark: pgfId-1610855]Step 3 Click Continue to reboot and reload the switch definitions.
 
    
 
     
      [bookmark: pgfId-1610857][bookmark: 64892]Change Image
 
     
 
     [bookmark: pgfId-1610858]Step 1 From the menu bar, select Config > Power-On Auto Provisioning (POAP) > Select the POAP switch definitions from the list.
 
     [bookmark: pgfId-1610859]Step 2 Select the switch for which you need to change the image. Click Change Image.
 
      
       
     
 
     
 
     [bookmark: pgfId-1610860]Note You can select multiple POAP definitions with similar parameters to change the image for booting the device.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1610861]The Multi Device Image Change screen appears.
 
     [bookmark: pgfId-1610862]Step 3 From the Image Server dropdown list, select the server where the new image is stored.
 
     [bookmark: pgfId-1610863]Step 4 From the System Image dropdown list, select the new system image.
 
     [bookmark: pgfId-1610864]Step 5 From the Kickstart Image dropdown list, select the new image which will replace the old image.
 
     [bookmark: pgfId-1610865]Step 6 Click Publish to apply and change the image.
 
    
 
     
      [bookmark: pgfId-1610868][bookmark: 73461]Cable Plan
 
     [bookmark: pgfId-1610869]The Cable plan configuration screen has the following options:
 
      
      	 [bookmark: pgfId-1610873]Create a Cable Plan
 
      	 [bookmark: pgfId-1610877]Viewing an Existing Cable Plan Deployment
 
      	 [bookmark: pgfId-1610881]Deleting a Cable Plan
 
      	 [bookmark: pgfId-1610885]Deploying a Cable Plan
 
      	 [bookmark: pgfId-1610889]Revoking a Cable Plan
 
      	 [bookmark: pgfId-1610893]Viewing a Deployed Cable Plan from Device
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1610894]Note If you are generating POAP definitions from the uploaded configuration, then generation of cable plan using the option of “Generate Cable Plan from POAP definition” will not work as the POAP definitions generated from the uploaded configuration will not have the required meta-data to generate the cable plans. You must select either “Capture from Existing Deployment” or “Import Cable plan file” to create a cable plan.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1610896][bookmark: 96149]Create a Cable Plan
 
     
 
     [bookmark: pgfId-1610897]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>Cable Plan.
 
     [bookmark: pgfId-1610898]Step 2 Click Create Cable Plan.
 
     [bookmark: pgfId-1610899]In the Create Cable Plan pop-up, use the radio button to select the options.
 
     [bookmark: pgfId-1610900]Step 3 If you select:
 
     [bookmark: pgfId-1610901] a. Generate Cable Plan from POAP definition: You can use the switches defined in the POAP flow and produce a port-to-port cable plan to be used when wiring the physical devices.
 
     [bookmark: pgfId-1610902] b. Capture from existing deployment: You can ascertain he Inter-Switch Links between existing switches managed by DCNM and “lock down” the cable plan based on the existing wiring.
 
     [bookmark: pgfId-1610903] c. Import Cable Plan File: You decide how to wire the switches (or how they are already wired) and select an XML file for import into DCNM.
 
    
 
     
      [bookmark: pgfId-1610905][bookmark: 16597]Viewing an Existing Cable Plan Deployment
 
     
 
     [bookmark: pgfId-1610906]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>Cable Plan.
 
     [bookmark: pgfId-1610907]Step 2 Click View.
 
     [bookmark: pgfId-1610908]Step 3 In the Cable Plan - Existing_Deployment window, you can view the existing cable plan deployments.
 
     [bookmark: pgfId-1610909]Step 4 You can use the Table View and XML View icons to change the view of the cable plan deployments table.
 
    
 
     
      [bookmark: pgfId-1610911][bookmark: 12194]Deleting a Cable Plan
 
     
 
     [bookmark: pgfId-1610912]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>Cable Plan.
 
     [bookmark: pgfId-1610913]Step 2 Click Delete from DCNM.
 
     [bookmark: pgfId-1610914]Step 3 Click Yes to confirm deletion.
 
    
 
     
      [bookmark: pgfId-1610916][bookmark: 72510]Deploying a Cable Plan
 
     
 
     [bookmark: pgfId-1610917]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>Cable Plan.
 
     [bookmark: pgfId-1610918]Step 2 In the Switches table, use the checkbox to select cable plan(s) and click Deploy a Cable Plan.
 
     [bookmark: pgfId-1610919]Step 3 Click Yes to confirm deployment.
 
    
 
     
      [bookmark: pgfId-1610921][bookmark: 92721]Revoking a Cable Plan
 
     
 
     [bookmark: pgfId-1610922]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>Cable Plan.
 
     [bookmark: pgfId-1610923]Step 2 In the Switches table, use the checkbox to select cable plan(s) and click Revoke a Cable Plan.
 
     [bookmark: pgfId-1610924]Step 3 Click Yes to confirm.
 
    
 
     
      [bookmark: pgfId-1610926][bookmark: 14983]Viewing a Deployed Cable Plan from Device
 
     
 
     [bookmark: pgfId-1610927]Step 1 From the menu bar, select Config>Power-On Auto Provisioning (POAP)>Cable Plan.
 
     [bookmark: pgfId-1610928]Step 2 In the Switches table, click In Sync or Out of Sync hyperlink in the cable plan status column.
 
     [bookmark: pgfId-1610929]Step 3 You can use the Table View and XML View icons to change the view of the cable plan table.
 
    
 
   
 
    
     [bookmark: pgfId-1610932][bookmark: 84579]Fabric
 
     
      
    
 
    
 
    [bookmark: pgfId-1610933]Note These features appear on your Cisco Prime DCNM Web Client application only if you have deployed the DCNM installer in the Unified Fabric mode.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1610934]This feature automates network provisioning and provides a new layer of automation integration in which the data center fabric-switching infrastructure is automatically provisioned for the physical or virtual workload that is being instantiated.
 
    [bookmark: pgfId-1610935]The following icons are listed at the menu bar of the window to customize the view of the information in the window:
 
    [bookmark: pgfId-1611135]
 
     
      
       
       [bookmark: pgfId-1610938]Table 3-5 
 
       
       
        
        	 
          
          [bookmark: pgfId-1610944]Field/Icons 
         
  
        	 
          
          [bookmark: pgfId-1610948]Description 
         
  
       
 
        
        	 [bookmark: pgfId-1610950]Organizations Section
  
       
 
        
        	 [bookmark: pgfId-1610956]Organization/Partition Name
  
        	[bookmark: pgfId-1610960]Specifies the organization or the partition name.
  
       
 
        
        	 [bookmark: pgfId-1610962]Description
  
        	[bookmark: pgfId-1610966]Specifies the description for the organization.
  
       
 
        
        	 [bookmark: pgfId-1610968]Partition ID
  
        	[bookmark: pgfId-1610972]Specifies the partition ID to be associated with the partition.
  
       
 
        
        	 [bookmark: pgfId-1610974]Orchestration Engine
  
        	[bookmark: pgfId-1610978]Specifies the Orchestrator name for the organization.
  
       
 
        
        	 [bookmark: pgfId-1610980]Service Node IP Address
  
        	[bookmark: pgfId-1610984]Specifies the IP address for the service node for a partition
  
       
 
        
        	 [bookmark: pgfId-1610986]Edge Router ID
  
        	[bookmark: pgfId-1610990]Specifies the Edge Router ID.
  
       
 
        
        	 [bookmark: pgfId-1610992]Extension Status
  
        	[bookmark: pgfId-1610996]Specifies if the extension is enabled or disabled.
  
       
 
        
        	 [bookmark: pgfId-1610998]Profile
  
        	[bookmark: pgfId-1611002]Specifies the default profile used.
  
       
 
        
        	 [bookmark: pgfId-1611004]Networks Section
  
       
 
        
        	 [bookmark: pgfId-1611010]Network Name
  
        	[bookmark: pgfId-1611014]Specifies the name to identify the network.
  
       
 
        
        	 [bookmark: pgfId-1611016]Partition Name
  
        	[bookmark: pgfId-1611020]Allows you to select the partition to be applied for the network.
  
       
 
        
        	 [bookmark: pgfId-1611022]Segment ID
  
        	[bookmark: pgfId-1611026]Specifies the segment ID to be used for partition extension.
  
       
 
        
        	 [bookmark: pgfId-1611028]Mobility Domain
  
        	[bookmark: pgfId-1611030]VLAN ID
  
        	[bookmark: pgfId-1611032]Specified the VLAN ID for the mobility domain.
  
       
 
        
        	[bookmark: pgfId-1611036]Mobility Domain ID
  
        	[bookmark: pgfId-1611038]Allows you to select the mobility domain ID from the drop-down list.
  
       
 
        
        	 [bookmark: pgfId-1611040]Profile Name
  
        	[bookmark: pgfId-1611044]Specifies the default profile used.
  
       
 
        
        	 [bookmark: pgfId-1611046]DHCP Scope
  
        	[bookmark: pgfId-1611048]Subnet
  
        	[bookmark: pgfId-1611050]Specifies the subnet for the network.
  
       
 
        
        	[bookmark: pgfId-1611054]Gateway
  
        	[bookmark: pgfId-1611056]Specifies the gateway for the network.
  
       
 
        
        	[bookmark: pgfId-1611060]IP Range
  
        	[bookmark: pgfId-1611062]Specifies the IP address range available for the network.
  
       
 
        
        	 [bookmark: pgfId-1611064]Add
  
        	[bookmark: pgfId-1611068]Allows you to add Organization, Partition, or Network.
  
       
 
        
        	 [bookmark: pgfId-1611070]Edit
  
        	[bookmark: pgfId-1611074]Allows you to edit Organization, Partition, or Network.
  
       
 
        
        	 [bookmark: pgfId-1611076]Delete
  
        	[bookmark: pgfId-1611080]Allows you to delete Organization, Partition, or Network.
  
       
 
        
        	 [bookmark: pgfId-1611082]Enable Extension
  
        	[bookmark: pgfId-1611086]Allows you to enable the extension for the selected Organization.
  
       
 
        
        	 [bookmark: pgfId-1611088]Disable Extension
  
        	[bookmark: pgfId-1611092]Allows you to disable the selected extension.
  
       
 
        
        	 [bookmark: pgfId-1611094]Deploy Configuration
  
        	[bookmark: pgfId-1611098]Allows you to deploy the network for the selected partition.
  
       
 
        
        	 [bookmark: pgfId-1611100]Undeploy Configuration
  
        	[bookmark: pgfId-1611104]Allows you to undeploy the network configuration.
  
       
 
        
        	 [bookmark: pgfId-1611106]Refresh
  
        	[bookmark: pgfId-1611110]Refreshes the list of items in the view.
  
       
 
        
        	 [bookmark: pgfId-1611112]Show Filter
  
        	[bookmark: pgfId-1611116]Filters list of items based on the defined value for each column.
  
       
 
        
        	 [bookmark: pgfId-1611118]Print
  
        	[bookmark: pgfId-1611122]Prints the list of Organizations or Networks along with their details.
  
       
 
        
        	 [bookmark: pgfId-1611124]Export
  
        	[bookmark: pgfId-1611128]Exports the list of items and their details to a Microsoft Excel spreadsheet.
  
       
 
        
        	 [bookmark: pgfId-1611130]Maximize
  
        	[bookmark: pgfId-1611134]Allows you to maximize the view for Organizations or Networks.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1611136]Fabric provides the following configuration options:
 
     
     	 [bookmark: pgfId-1611137]Organizations
 
    
 
    [bookmark: pgfId-1611141] – Adding an Organization
 
    [bookmark: pgfId-1611145] – Editing an Organization
 
    [bookmark: pgfId-1611149] – Deleting an Organization
 
    [bookmark: pgfId-1611153] – Adding a Partition
 
    [bookmark: pgfId-1611157] – Editing a Partition
 
    [bookmark: pgfId-1611161] – Deleting a Partition
 
     
     	 [bookmark: pgfId-1611162]Networks
 
    
 
    [bookmark: pgfId-1611166] – Adding a Network
 
    [bookmark: pgfId-1611170] – Editing a Network
 
    [bookmark: pgfId-1611174] – Deleting a Network
 
     
      [bookmark: pgfId-1611176][bookmark: 46789]Adding an Organization
 
     
 
     [bookmark: pgfId-1611177]Step 1 From the menu bar, select Config > Auto-Configuration > Organizations > Add > Organization.
 
     [bookmark: pgfId-1611178]Step 2 In the Add Organization window, specify the Name and Description of the organization.
 
     [bookmark: pgfId-1611179]Step 3 Specify the Orchestration Engine.
 
     [bookmark: pgfId-1611180]Step 4 Click Add.
 
    
 
     
      [bookmark: pgfId-1611182][bookmark: 39840]Editing an Organization
 
     
 
     [bookmark: pgfId-1611183]Step 1 From the menu bar, select Config > Auto-Configuration > Organizations.
 
     [bookmark: pgfId-1611184]Step 2 Select an organization from the List and click the Edit icon.
 
     [bookmark: pgfId-1611185]Step 3 In the Edit Organization window, change the configuration.
 
     [bookmark: pgfId-1611186]Step 4 Click Edit to save the changes.
 
    
 
     
      [bookmark: pgfId-1611188][bookmark: 76807]Deleting an Organization
 
      
       
     
 
     
 
     [bookmark: pgfId-1611189]Note You must delete all partitions under an organization before deleting the organization.
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1611190]Step 1 From the menu bar, select Config > Auto-Configuration > Organizations.
 
     [bookmark: pgfId-1611191]Step 2 Select an organization from the List and click the Delete icon.
 
     [bookmark: pgfId-1611192]Step 3 Click Yes to confirm.
 
    
 
     
      [bookmark: pgfId-1611194][bookmark: 57699]Adding a Partition
 
     
 
     [bookmark: pgfId-1611195]Step 1 From the menu bar, select Config > Auto-Configuration > Organizations > Add>Partition.
 
     [bookmark: pgfId-1611196]Step 2 In the Add Partition window, use the drop-down to select the organization.
 
     [bookmark: pgfId-1611197]Step 3 Specify the Name for the partition.
 
     [bookmark: pgfId-1611198]Step 4 Specify the VRF name and provide description for the partition.
 
     [bookmark: pgfId-1611199]Step 5 Specify the Edge Router ID for the partition. 
 
     [bookmark: pgfId-1611200]Select the checkbox if you choose to extend the partition across the fabric.
 
     [bookmark: pgfId-1611201]If you do not select the checkbox, this partition will not be extended across the Fabric.
 
     [bookmark: pgfId-1611202]Step 6 Specify the DNS Server and the Secondary DNS server for the partition.
 
     [bookmark: pgfId-1611203]Step 7 From the drop-down list, select the default Profile Name.
 
     [bookmark: pgfId-1611204]The values for the Profile Parameters are auto-populated based on the default Profile Name.
 
     [bookmark: pgfId-1611205]Step 8 Click OK to configure the partition.
 
    
 
     
      [bookmark: pgfId-1611207][bookmark: 55626]Editing a Partition
 
     
 
     [bookmark: pgfId-1611208]Step 1 From the menu bar, select Config>Auto-Configuration>Organizations.
 
     [bookmark: pgfId-1611209]Step 2 Click an organization from the List and select the Partition.
 
     [bookmark: pgfId-1611210]Step 3 Click the Edit icon
 
     [bookmark: pgfId-1611211]Step 4 In the Edit Partition window, change the configuration.
 
     [bookmark: pgfId-1611212]Step 5 Click Edit to save the changes.
 
    
 
     
      [bookmark: pgfId-1611214][bookmark: 33284]Deleting a Partition
 
      
       
     
 
     
 
     [bookmark: pgfId-1611215]Note You mst delete all networks under the partition before deleting the partition.
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1611216]Step 1 From the menu bar, select Config>Auto-Configuration>Organizations.
 
     [bookmark: pgfId-1611217]Step 2 Click an organization from the List and select the Partition.
 
     [bookmark: pgfId-1611218]Step 3 Click the Delete icon
 
     [bookmark: pgfId-1611219]Step 4 Click Yes to confirm.
 
    
 
     
      [bookmark: pgfId-1611221][bookmark: 84735]Adding a Network
 
     
 
     [bookmark: pgfId-1611222]Step 1 From the menu bar, select Config > Auto-Configuration > Networks >Add.
 
     [bookmark: pgfId-1611223]Step 2 In the Add Network window, use the drop-down to select the Organization and Partition.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611224]Note If there is only one organization and partition configured, the values for these fields are automatically populated.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611225]Step 3 Specify the VRF Name for the partition.
 
     [bookmark: pgfId-1611226]The VRF Name must be of the format organizationName:partitionName.
 
     [bookmark: pgfId-1611227]Step 4 Specify the Network Name to identify the network.
 
     [bookmark: pgfId-1611228]Step 5 Specify the Multicast Group Address.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611229]Note The Multicast Group Address is used to Enable VxLAN Encapsulation on the Admin > Fabric Encapsulation Settings page.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611230]Step 6 Select the Network Role from the drop-down list based on the type of the network.
 
     [bookmark: pgfId-1611231]Step 7 In the Network ID section, choose one of the following:
 
      
      	 [bookmark: pgfId-1611232]Segment ID Only
 
     
 
     [bookmark: pgfId-1611233] – Specify the Segment ID for the network.
 
      
      	 [bookmark: pgfId-1611234]Mobility Domain and VLAN
 
     
 
     [bookmark: pgfId-1611235] – Specify the Segment ID for your network.
 
     [bookmark: pgfId-1611236] – Select Generate Seg ID to generate segment ID automatically.
 
     [bookmark: pgfId-1611237] – Specify the VLAN ID and Mobility Domain ID if you need to create a VLAN + Mobility Domain network.
 
     [bookmark: pgfId-1611238]Step 8 In the DHCP Scope section, specify the IP Range.
 
     [bookmark: pgfId-1611239]Step 9 Use the drop-down to select the Profile.
 
     [bookmark: pgfId-1611240]Step 10 Specify the Profile parameters.
 
     [bookmark: pgfId-1611241]Step 11 Specify the Service Configuration parameters.
 
     [bookmark: pgfId-1611242]Step 12 Click Add.
 
    
 
     
      [bookmark: pgfId-1611244][bookmark: 37802]Editing a Network
 
     
 
     [bookmark: pgfId-1611245]Step 1 From the menu bar, select Config>Auto-Configuration>Networks.
 
     [bookmark: pgfId-1611246]Step 2 Select a network from the List and click the Edit icon
 
     [bookmark: pgfId-1611247]Step 3 In the Edit Partition window, change the configuration.
 
     [bookmark: pgfId-1611248]Step 4 Click Edit to save the changes.
 
    
 
     
      [bookmark: pgfId-1611250][bookmark: 18907]Deleting a Network
 
     
 
     [bookmark: pgfId-1611251]Step 1 From the menu bar, select Config>Auto-Configuration>Networks.
 
     [bookmark: pgfId-1611252]Step 2 Select a network from the List and click the Delete icon.
 
     [bookmark: pgfId-1611253]Step 3 Click Yes to confirm.
 
    
 
   
 
    
     [bookmark: pgfId-1611255]Profiles
 
    [bookmark: pgfId-1611256]Profiles provide the following configuration options:
 
     
     	 [bookmark: pgfId-1611257]Profiles
 
    
 
    [bookmark: pgfId-1611261] – Adding a profile
 
    [bookmark: pgfId-1611265] – Editing a Profile
 
    [bookmark: pgfId-1611269] – Delete a Profile
 
     
     	 [bookmark: pgfId-1611270]Profile Instance
 
    
 
    [bookmark: pgfId-1611274] – Editing a Profile Instance
 
     
      [bookmark: pgfId-1611276][bookmark: 51196]Adding a profile
 
     
 
     [bookmark: pgfId-1611277]Step 1 From the menu bar, select Config > Profiles > Add.
 
     [bookmark: pgfId-1611278]Step 2 In the Add Profile window, specify the Name and Description of the profile.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611279]Note A global VLAN is a fabricpath-enabled VLAN which is not mapped to a Segment ID. Before Cisco Prime DCNM 7.2(2), the user-defined Global VLAN profile names must end with “GblVlanProfile” (case-insensitive), for the network to auto-refresh.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611280]Step 3 Use the drop-down, select the Type of the Profile.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611281]Note Devices with different platforms may use profiles of different profile types. For this release, FPVLAN, FPBD, IPVLAN, IPBD are supported.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611282]Step 4 From the drop down, select Sub Type. Sub Type of profiles differentiate profile categories, such as :
 
      
      	 [bookmark: pgfId-1611283]individual profile
 
      	 [bookmark: pgfId-1611284]universal profile
 
      	 [bookmark: pgfId-1611285]network profile
 
      	 [bookmark: pgfId-1611286]partition profile
 
      	 [bookmark: pgfId-1611287]DCI profile and so on.
 
     
 
     [bookmark: pgfId-1611288]
 
     [bookmark: pgfId-1611289]For more information, see Cisco Dynamic Fabric Automation Configuration Guide.
 
     [bookmark: pgfId-1611292] – partition:universal - Universal profile for a partition
 
     [bookmark: pgfId-1611293] – network:universal - Universal profile for a network
 
     [bookmark: pgfId-1611294] – bl-er:universal - Universal profile for a Border Leaf or Edge Router
 
     [bookmark: pgfId-1611295] – bl-er:universal,er - Universal profile for a Edge Router
 
     [bookmark: pgfId-1611296] – bl-er:universal,bl - Universal profile for a Border Leaf
 
     [bookmark: pgfId-1611297] – partition:individual - Individual profile for a partition
 
     [bookmark: pgfId-1611298] – network:individual - Individual profile for a network
 
      
      	 [bookmark: pgfId-1611301]anycast-gateway
 
      	 [bookmark: pgfId-1611302]proxy-gateway 
 
      	 [bookmark: pgfId-1611303]none
 
     
 
     [bookmark: pgfId-1611304]Step 6 Enter the Profile Content from collection of CLI commands to discover a specific configuration.
 
     [bookmark: pgfId-1611305]Step 7 Click Add.
 
     [bookmark: pgfId-1611306]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1611308][bookmark: 10278]Editing a Profile
 
     
 
     [bookmark: pgfId-1611309]Step 1 From the menu bar, select Config > Profiles.
 
     [bookmark: pgfId-1611310]Step 2 Select a profile from the list and click the Edit icon.
 
     [bookmark: pgfId-1611311]Step 3 In the Edit profile window, change the configuration.
 
     [bookmark: pgfId-1611312]Step 4 Click Edit to save the changes.
 
    
 
     
      [bookmark: pgfId-1611314][bookmark: 92183]Delete a Profile
 
     
 
     [bookmark: pgfId-1611315]Step 1 From the menu bar, select Config>Profiles.
 
     [bookmark: pgfId-1611316]Step 2 Select a profile from the list and click the Delete icon.
 
     [bookmark: pgfId-1611317]Step 3 Click Yes to confirm.
 
    
 
     
      [bookmark: pgfId-1611319][bookmark: 52273]Editing a Profile Instance
 
     
 
     [bookmark: pgfId-1611320]Step 1 From the menu bar, select Config>Profiles.
 
     [bookmark: pgfId-1611321]Step 2 Select a profile from the list and click the Edit icon.
 
     [bookmark: pgfId-1611322]Step 3 In the Edit Profile Instance window, change the configuration.
 
     [bookmark: pgfId-1611323]Step 4 Click Edit to save the changes.
 
    
 
   
 
    
     [bookmark: pgfId-1611325][bookmark: 28153]Administering Cisco Prime DCNM Web Client
 
    [bookmark: pgfId-1611328]The [bookmark: marker-1611326]Admin options allows you to perform minor administrative and configuration tasks on the [bookmark: marker-1611327]Cisco Prime DCNM-SAN Server. 
 
    [bookmark: pgfId-1611329]The Admin option contains the following sub-menus:
 
     
     	 [bookmark: pgfId-1611330] Status —Displays the status of the Database Server and allows you to start and stop Performance collector services on your server. You should restart services only if something is not working properly or if too large a percentage of system resources are being consumed.
 
     	 [bookmark: pgfId-1611331]Data Sources—Allows you to view all the data sources such as Fabric, LAN, VMware, SMIS and so on.
 
     	 [bookmark: pgfId-1611332] Logs —Allows you to view all the logs from the various services running on the Cisco Prime DCNM-SAN Server.
 
     	 [bookmark: pgfId-1611333]Server Properties—Allows you to view all the fields defined in the server.properties config file.
 
     	 [bookmark: pgfId-1611334]SFTP Credentials—Allows you to view the SFTP credentials.
 
     	 [bookmark: pgfId-1611335]License—Allows you to view the licensing details.
 
     	 [bookmark: pgfId-1611336]Federation—Allows you to view the server federation details.
 
     	 [bookmark: pgfId-1611337]Clients—Allows you to view all the clients connected to the Cisco Prime DCNM-SAN Server.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1611338]Note You cannot start or stop the Database Server services using DCNM Web Client. If you are using the Microsoft Windows operating system, you need to use Microsoft Management Console to stop, start, or restart the Database Server. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1611340] – If you see a [bookmark: marker-1611339]database file lock error in the database log, you can fix it by shutting down and restarting the database server using the Web Client.
 
    [bookmark: pgfId-1611341] – Only network administrators can access the DCNM Web Client Admin options. Network operators cannot view the Admin options.
 
    [bookmark: pgfId-1611342]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1611346]Starting, Restarting, and Stopping Services
 
     	 [bookmark: pgfId-1611350]Administering Datasources
 
    
 
     
      [bookmark: pgfId-1611353][bookmark: 43871]Starting, Restarting, and Stopping Services
 
     
 
     [bookmark: pgfId-1611354]Step 1 DETAILED STEPSFrom the menu bar, choose Admin > General > Status.
 
     [bookmark: pgfId-1611358]You see a table of services per server and the status of each as shown in Figure 3-1.
 
     [bookmark: pgfId-1611360]Figure 3-1 [bookmark: 94141]DCNM-SAN Services Status
 
     [bookmark: pgfId-1611363]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1611364]Step 2 In the Actions column, use the Start, (Re)start or Stop icons to start, restart, or stop any of the services.
 
    
 
     
      [bookmark: pgfId-1611367][bookmark: 19646]Administering Datasources
 
     [bookmark: pgfId-1611368]You can manage the Fabrics, LAN and VMWare using the datasources option. This section contains the following: 
 
      
      	 [bookmark: pgfId-1611372]Adding, Editing, Re-discovering, Purging and Removing Managed Fabrics 
 
      	 [bookmark: pgfId-1611375]Adding, Editing, Re-discovering, Purging and Removing LAN, LAN Tasks and Switch
 
      	 [bookmark: pgfId-1611380]Adding, Editing, Re-discovering and Removing VMware Servers
 
      	 [bookmark: pgfId-1611384]Adding, editing, removing, rediscovering and refreshing SMI-S Storage
 
     
 
    
 
     
      [bookmark: pgfId-1611386][bookmark: 89876]Adding, Editing, Re-discovering, Purging and Removing Managed Fabrics 
 
     [bookmark: pgfId-1611387]Cisco Prime DCNM Web Client reports information obtained by the Cisco Prime DCNM-SAN on any fabric known to Cisco Prime DCNM-SAN. 
 
     [bookmark: pgfId-1611388]This section contains the following: 
 
      
      	 [bookmark: pgfId-1611392]Adding a Fabric 
 
      	 [bookmark: pgfId-1611396]Editing a Fabric 
 
      	 [bookmark: pgfId-1611400]Rediscovering a Fabric
 
      	 [bookmark: pgfId-1611404]Purging a Fabric 
 
      	 [bookmark: pgfId-1611408]Removing a Fabric
 
      	 [bookmark: pgfId-1611412]Moving Fabrics to Another Server Federation 
 
     
 
    
 
     
      [bookmark: pgfId-1611414][bookmark: 34343]Adding a Fabric 
 
     [bookmark: pgfId-1611415]You can discover new fabric and start managing a fabric from Cisco Prime DCNM Web Client. Before you discover a new fabric, ensure you create a SNMP user on the switch.
 
     
 
     [bookmark: pgfId-1611416]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611417]You see a list of fabrics (if any) managed by Cisco Prime DCNM-SAN in the Opened column. 
 
     [bookmark: pgfId-1611418]Step 2 Click Add Fabric to add a new fabric.
 
     [bookmark: pgfId-1611419]You see the Add Fabric dialog box. 
 
     [bookmark: pgfId-1611420]Step 3 Enter the Fabric Seed Switch IP address for this fabric. 
 
     [bookmark: pgfId-1611421]Step 4 (Optional) Check the SNMPV3 check box. If you check SNMPV3, the fields Read Community and Write Community change to Username and Password. 
 
     [bookmark: pgfId-1611422]Step 5 Enter the User Name and Password for this fabric. 
 
     [bookmark: pgfId-1611423]Step 6 Select the privacy settings from the Auth-Privacy drop-down list. 
 
     [bookmark: pgfId-1611424]Step 7 (Optional) Check the Limit Discovery by VSAN checkbox to specify the included VSAN list or excluded VSAN list from the VSANs provided to discover a new fabric. 
 
     [bookmark: pgfId-1611425]Step 8 (Optional) Check the Enable NPV Discovery in all Fabrics check box. If you check enable NPV discovery in all fabrics, the changes are applied to all the fabrics that are previously discovered. 
 
     [bookmark: pgfId-1611426]Step 9 Click Add to begin managing this fabric. 
 
     [bookmark: pgfId-1611427]You can remove single or multiple fabrics from the Cisco Prime DCNM Web Client.
 
    
 
     
      [bookmark: pgfId-1611429][bookmark: 89419]Editing a Fabric 
 
     
 
     [bookmark: pgfId-1611430]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611431]Step 2 Select the check box next to the fabric that you want to edit and click Edit Fabric. 
 
     [bookmark: pgfId-1611432]You see the Edit Fabric dialog box. You can edit only one fabric at a time.
 
     [bookmark: pgfId-1611433]Step 3 Enter a new fabric Name.
 
     [bookmark: pgfId-1611434]Step 4 (Optional) Check the SNMPV3 check box. If you check SNMPV3, the Community field change to Username and Password. 
 
     [bookmark: pgfId-1611435]Step 5 Enter the User Name and Password, privacy and specify how you want DCNM Web Client to manage the fabric by selecting one of the status options.
 
     [bookmark: pgfId-1611436]Step 6 Change the fabric management state to Managed, Unmanaged, or Managed Continuously.
 
     [bookmark: pgfId-1611437]Step 7 Click Apply to save the changes. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1611438]Note In the Admin>Datasources>Fabric, Select the fabric for which the fabric switch password is changed. Click Edit Fabric, unmanage the fabric, specify the new password and then manage the fabric. You will not be able to open the fabric as the new password will not sync with the database. To open the fabric, you must log into the DCNM-SAN client, Go to Server>Admin and click the Open tab. Select the fabric and change the password manually in the Client Password/Community column.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1611440][bookmark: 13404]Rediscovering a Fabric 
 
     
 
     [bookmark: pgfId-1611441]Step 1 From the menu bar, choose Admin>General>Datasources. 
 
     [bookmark: pgfId-1611442]Step 2 Select the check box next to the fabric and click the Re-discover Fabric icon. 
 
     [bookmark: pgfId-1611443]Step 3 Click Yes in the pop-up window. 
 
     [bookmark: pgfId-1611444]The Fabric will now be re-discovered. 
 
    
 
     
      [bookmark: pgfId-1611446][bookmark: 10676]Purging a Fabric 
 
     
 
     [bookmark: pgfId-1611447]Step 1 From the menu bar, choose Admin>General>Datasources. 
 
     [bookmark: pgfId-1611448]Step 2 Select the check box next to the fabric and click the Purge Fabric icon. 
 
     [bookmark: pgfId-1611449]Step 3 Click Yes in the pop-up window. 
 
     [bookmark: pgfId-1611450]The Fabric will now be purged. 
 
    
 
     
      [bookmark: pgfId-1611452][bookmark: 45630]Removing a Fabric 
 
     
 
     [bookmark: pgfId-1611453]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611454]Step 2 Select the check box next to the fabric that you want to remove and click Remove Fabric icon to remove the fabric from the datasource and to discontinue data collection for that fabric.
 
    
 
     
      [bookmark: pgfId-1611456][bookmark: 55700]Moving Fabrics to Another Server Federation 
 
     [bookmark: pgfId-1611457]This feature is only available on the federation setup and the Move Fabric is only displayed in the federation setup screen. 
 
     [bookmark: pgfId-1611458]You can move the fabrics from a sever that is down to an active server. The management state will remain the same. 
 
     
 
     [bookmark: pgfId-1611459]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611460]Step 2 Select the fabrics from the fabric table. Click Move Fabrics to another Federation Server, or Move LAN Tasks to another DCNM Server. 
 
     [bookmark: pgfId-1611461]Step 3 Select the fabrics that need to be moved and click Move Fabric.
 
     [bookmark: pgfId-1611462]Step 4 In the Move Fabrics to another Federation server dialog box, select the DCNM server where the fabrics will be moved. The server drop-down list will list only the active servers.
 
     [bookmark: pgfId-1611463]Step 5 In the Move LAN Tasks to another DCNM Server dialog box, enter the LAN tasks that need to be moved and specify the DCNM server. 
 
    
 
     
      [bookmark: pgfId-1611465][bookmark: 98580]Adding, Editing, Re-discovering, Purging and Removing LAN, LAN Tasks and Switch
 
     [bookmark: pgfId-1611466]Cisco Prime DCNM Web Client reports information obtained by the Cisco Prime DCNM-LAN devices. 
 
     [bookmark: pgfId-1611467]This section contains the following: 
 
      
      	 [bookmark: pgfId-1611471]Adding LAN Devices
 
      	 [bookmark: pgfId-1611475]Editing LAN Devices 
 
      	 [bookmark: pgfId-1611479]Purging LAN 
 
      	 [bookmark: pgfId-1611483]Removing LAN Devices 
 
      	 [bookmark: pgfId-1611487]Edit LAN Task
 
      	 [bookmark: pgfId-1611491]Re-discover LAN Task
 
      	 [bookmark: pgfId-1611495]Click Yes in the pop-up window to re-discover the LAN.
 
      	 [bookmark: pgfId-1611499]Moving LAN Devices Under a Task 
 
      	 [bookmark: pgfId-1611503]Remove LAN Task/Switch
 
      	 [bookmark: pgfId-1611507]Delete a Switch
 
      	 [bookmark: pgfId-1611511]Toggle between Task and Device view
 
     
 
    
 
     
      [bookmark: pgfId-1611513][bookmark: 81878]Adding LAN Devices 
 
     
 
     [bookmark: pgfId-1611514]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611515]You see the list of LAN devices in the Name column. 
 
     [bookmark: pgfId-1611516]Step 2 Click Add LAN Task to add LAN.
 
     [bookmark: pgfId-1611517]You see the Add LAN dialog box. 
 
     [bookmark: pgfId-1611518]Step 3 Select Hops from Seed Switch, Switch List or FWSM. The fields vary depending on your selection.
 
     [bookmark: pgfId-1611519]Step 4 Enter the Seed Switch IP address for the fabric. 
 
     [bookmark: pgfId-1611520]Step 5 The options vary depending on the discovery type selected. For example; If you select SNMPV1 or SNMPV3/CLI check box varied fields are displayed. 
 
     [bookmark: pgfId-1611521]Step 6 Select the switch group and specify the Scan Time-out.
 
     [bookmark: pgfId-1611522]Step 7 Specify the user credentials and the Optional Enable Password.
 
     [bookmark: pgfId-1611523]Step 8 Use the drop-down to select the switch group.
 
     [bookmark: pgfId-1611524]Step 9 Click Next to begin the Shallow Discovery. 
 
     [bookmark: pgfId-1611525]Step 10 In the Shallow LAN Discovery window, you can select all switches by using the checkbox next to the switch name column or select individual switches. Click Previous to go back and edit the parameters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611526]Note In the Status column, if the switch status is Time-out or Cannot be contacted, these switches cannot be added.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611527]Step 11 Select a switch and click Add to add a switch to the switch group.
 
     [bookmark: pgfId-1611528]If the seed switch(es) are not reachable, it will be shown as “unknown” on the shallow Discovery window.
 
    
 
     
      [bookmark: pgfId-1611530][bookmark: 88389]Editing LAN Devices 
 
     [bookmark: pgfId-1611531]You can modify a LAN from Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1611532]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611533]Step 2 Select the check box next to the LAN that you want to edit and click Edit LAN by CDP Seed. 
 
     [bookmark: pgfId-1611534]You see the Edit LAN dialog box. 
 
     [bookmark: pgfId-1611535]Step 3 Enter the User Name and Password.
 
     [bookmark: pgfId-1611536]Step 4 Select the LAN status as Managed or Unmanaged. 
 
     [bookmark: pgfId-1611537]Step 5 Select the Candidate Switches for Deep Discovery. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1611538]Note You can hold the Ctrl key on your keyboard to select multiple candidate switches. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611539]Step 6 Click Apply to save the changes. 
 
    
 
     
      [bookmark: pgfId-1611542][bookmark: 72082][bookmark: 91119]Purging LAN 
 
     
 
     [bookmark: pgfId-1611543]Step 1 From the menu bar, choose Admin>General>Datasources.
 
     [bookmark: pgfId-1611544]Step 2 Click the Purge unreachable devices or dead links in selected LAN icon.
 
     [bookmark: pgfId-1611545]Step 3 Click Yes in the pop-up window to purge the LAN device. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1611546]Note In case of a Federation set-up, you will have to select the LAN to purge.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1611548][bookmark: 24327]Removing LAN Devices 
 
     [bookmark: pgfId-1611549]You can remove a LAN from Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1611550]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611551]Step 2 Select the check box next to the LAN that you want to remove and click the Remove LAN by CDP Seed icon to remove the switches and all their data.
 
     [bookmark: pgfId-1611552]Step 3 Click Yes to review the LAN device. 
 
     [bookmark: pgfId-1611553]You can also remove an individual LAN Switch 
 
     
 
     [bookmark: pgfId-1611554]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611555]Step 2 Click the arrow next to the DCNM Server check box to expand the field. 
 
     [bookmark: pgfId-1611556]Step 3 In the Switch column, click Delete Switch icon to delete a switch connected to the DCNM server. 
 
    
 
     
      [bookmark: pgfId-1611558][bookmark: 20163]Edit LAN Task
 
     
 
     [bookmark: pgfId-1611559]Step 1 From the menu bar, choose Admin>General>Datasources
 
     [bookmark: pgfId-1611560]Step 2 In the Discovery Task column, click the Edit LAN Task icon.
 
     [bookmark: pgfId-1611561]Step 3 In the Edit LAN Task dialog box, specify the user credentials and the Optional Enable Password.
 
     [bookmark: pgfId-1611562]Step 4 Use the radio button to select the Status.
 
     [bookmark: pgfId-1611563]Step 5 Click Apply to save the changes.
 
    
 
     
      [bookmark: pgfId-1611565][bookmark: 35161]Re-discover LAN Task 
 
     
 
     [bookmark: pgfId-1611566]Step 1 From the menu bar, choose Admin>General>Datasources.
 
     [bookmark: pgfId-1611567]Step 2 In the Discovery Task column, click the Re-discover LAN icon.
 
     [bookmark: pgfId-1611569]Step 3 Click Yes in the pop-up window to re-discover the LAN. [bookmark: 34884]
 
    
 
     
      [bookmark: pgfId-1611571][bookmark: 43964]Moving LAN Devices Under a Task
 
     [bookmark: pgfId-1611572]You can move LAN devices under a task to a different server using Cisco Prime DCNM Web Client. This feature is available only in the federation setup and the Move LAN is displayed in the federation setup screen. 
 
     [bookmark: pgfId-1611573]You can move the LAN from a sever that is down to an active server. The management state remains the same.
 
     
 
     [bookmark: pgfId-1611574]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611575]Step 2 Choose the LAN from the LAN table. Click Move LAN Tasks to another Federated Server.
 
     [bookmark: pgfId-1611576]Step 3 In the Move LAN Tasks to another DCNM Server dialog box, enter the LAN tasks that need to be moved and specify the DCNM server. All the LAN devices under the selected tasks will be moved.
 
    
 
     
      [bookmark: pgfId-1611578][bookmark: 32324]Remove LAN Task/Switch
 
     
 
     [bookmark: pgfId-1611579]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611580]Step 2 In the Discovery Task column, click the Remove LAN Task icon.
 
     [bookmark: pgfId-1611581]Step 3 In the confirmation dialog box, click Yes to remove the LAN task.
 
    
 
     
      [bookmark: pgfId-1611583][bookmark: 44173]Delete a Switch
 
     [bookmark: pgfId-1611584]You can also delete an individual switch connected to a DCNM Server.
 
     
 
     [bookmark: pgfId-1611585]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611586]Step 2 In the Switch column, click the Delete Switch icon.
 
     [bookmark: pgfId-1611587]Step 3 In the confirmation dialog box, click Yes to delete the switch
 
    
 
     
      [bookmark: pgfId-1611589][bookmark: 31650]Toggle between Task and Device view
 
     
 
     [bookmark: pgfId-1611590]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611591]Step 2 Click the Toggle between Task and Device view icon.
 
     [bookmark: pgfId-1611592]By default, the Device view is displayed.
 
     [bookmark: pgfId-1611593]Step 3 In the Device view:
 
      
       
       	 [bookmark: pgfId-1611594]In the Group column, use the drop-down to select the LAN group.
 
       	 [bookmark: pgfId-1611598]Click the Add LAN Task icon to add a LAN. For more information see the Adding LAN Devices section.
 
       	 [bookmark: pgfId-1611599]In the Discovery Task column, click the Edit LAN Task icon to edit the LAN task. For more information, see the Editing LAN Devices section.
 
       	 [bookmark: pgfId-1611603]In the Discovery Task column, click the Re-discover LAN icon to rediscover the LAN. For more information see the Purging LAN section.
 
       	 [bookmark: pgfId-1611607]In the Discovery Task column, click the Remove LAN Task icon to delete the LAN task. For more information, see the Removing LAN Devices section.
 
       	 [bookmark: pgfId-1611611]In the Switch column, click Re-discover Switch icon to rediscover the switch. 
 
       	 [bookmark: pgfId-1611612]In the Switch column, click the Delete Switch icon to delete the switch.
 
       	 [bookmark: pgfId-1611613]Click the Toggle between Task and Device view icon to toggle to the task view
 
      
 
     
 
     [bookmark: pgfId-1611614]Step 4 In the Task view:
 
      
       
       	 [bookmark: pgfId-1611615]Under Discovery Task, use the checkbox to select the task.
 
       	 [bookmark: pgfId-1611619]Click the Add LAN Task icon to add a LAN. For more information see the Adding LAN Devices section.
 
       	 [bookmark: pgfId-1611620]Use the checkbox to select the task and then click the Edit LAN Task icon at the upper-right corner above the table to edit the LAN task. For more information, see the Editing LAN Devices section.
 
       	 [bookmark: pgfId-1611624]Use the checkbox to select the task and then click the Remove LAN Task icon at the upper-right corner above the table to delete the LAN task. For more information, see the Removing LAN Devices section.
 
       	 [bookmark: pgfId-1611628]Use the checkbox to select the task and then click the Re-discover LAN icon at the upper-right corner above the table to rediscover the LAN. For more information see the Purging LAN section.
 
       	 [bookmark: pgfId-1611632]Click the Refresh icon to refresh the LAN table.
 
       	 [bookmark: pgfId-1611633]Click the Purge unreachable devices or dead links in selected LAN icon to purge the LAN. For more information see the Purging LAN section.
 
       	 [bookmark: pgfId-1611637]Click the Toggle between Task and Device view icon to toggle to the device view.
 
       	 [bookmark: pgfId-1611638]Click Re-discover Switch icon to rediscover the switch. 
 
       	 [bookmark: pgfId-1611639]Click the Delete Switch icon to delete the switch.
 
       	 [bookmark: pgfId-1611640]In the Group column, use the drop-down to select the LAN group.
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1611642][bookmark: 74758]Adding, Editing, Re-discovering and Removing VMware Servers 
 
     [bookmark: pgfId-1611643]DCNM Web Client reports information gathered by Cisco Prime DCNM-SAN on any VMware servers supported by Cisco Prime DCNM-SAN.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611644]Note Ensure that the LAN and SAN are discovered before you add the vCenter on the datasource.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611645]This section contains the following: 
 
      
      	 [bookmark: pgfId-1611649]Managing a VMware Server 
 
      	 [bookmark: pgfId-1611653]Removing a VMware Server 
 
      	 [bookmark: pgfId-1611657]Modifying a VMware Server 
 
      	 [bookmark: pgfId-1611661]Rediscovering a VMware Server 
 
     
 
    
 
     
      [bookmark: pgfId-1611663][bookmark: 24905]Managing a VMware Server 
 
     [bookmark: pgfId-1611664]You can manage a VMware server from Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1611665]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611666]You see the list of VMware servers (if any) that are managed by Cisco Prime DCNM-SAN in the table. 
 
     [bookmark: pgfId-1611667]Step 2 Click the Add Virtual Center icon.
 
     [bookmark: pgfId-1611668]You see the Add VMware dialog box. 
 
     [bookmark: pgfId-1611669]Step 3 Enter the Virtual Center Server IP address for this VMware server. 
 
     [bookmark: pgfId-1611670]Step 4 Enter the User Name and Password for this VMware server. 
 
     [bookmark: pgfId-1611671]Step 5 Click Add to begin managing this VMware server. 
 
    
 
     
      [bookmark: pgfId-1611673][bookmark: 77108]Removing a VMware Server 
 
     [bookmark: pgfId-1611674]You can remove a VMware server from the Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1611675]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611676]Step 2 Select the check box next to the VMware server that you want to remove and click Remove Virtual Center to discontinue data collection for that VMware server. 
 
    
 
     
      [bookmark: pgfId-1611678][bookmark: 44692]Modifying a VMware Server 
 
     [bookmark: pgfId-1611679]You can modify a VMware server from Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1611680]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611681]Step 2 Check the check box next to the VMware server that you want to edit and click Edit Virtual Center icon. 
 
     [bookmark: pgfId-1611682]You see the Edit VMware dialog box. 
 
     [bookmark: pgfId-1611683]Step 3 Enter a the User Name and Password. 
 
     [bookmark: pgfId-1611684]Step 4 Select managed or unmanaged status. 
 
     [bookmark: pgfId-1611685]Step 5 Click Apply to save the changes. 
 
    
 
     
      [bookmark: pgfId-1611687][bookmark: 31357]Rediscovering a VMware Server 
 
     [bookmark: pgfId-1611688]You can rediscover a VMware server from Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1611689]Step 1 From the menu bar, choose Admin > General > Data Sources. 
 
     [bookmark: pgfId-1611690]Step 2 Select the check box next to the VMware that you want to rediscover. 
 
     [bookmark: pgfId-1611691]Step 3 Click Rediscover Virtual Center icon. 
 
     [bookmark: pgfId-1611692]Step 4 Click Yes in the dialog box. 
 
    
 
     
      [bookmark: pgfId-1611694][bookmark: 77800]Adding, editing, removing, rediscovering and refreshing SMI-S Storage
 
     [bookmark: pgfId-1611695]The SMI-S providers are managed using the DCNM Web Client.
 
     [bookmark: pgfId-1611696]This section contains the following:
 
      
      	 [bookmark: pgfId-1611700]Adding SMI-S Provider.
 
      	 [bookmark: pgfId-1611704]Editing SMI-S Provider.
 
      	 [bookmark: pgfId-1611708]Deleting SMI-S Provider.
 
      	 [bookmark: pgfId-1611712]Re-Discover SMI-S Provider.
 
      	 [bookmark: pgfId-1611716]Refresh SMI-S Provider
 
     
 
    
 
     
      [bookmark: pgfId-1611718][bookmark: 13710]Adding SMI-S Provider
 
     
 
     [bookmark: pgfId-1611719]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611720]Step 2 Click the Add SMIS Provider icon.
 
     [bookmark: pgfId-1611721]Step 3 In the Add SMI-S Provider window, use the drop-down to select the Vendor. Only EMC and NetApp are currently supported. Additional SMI-S storage vendors are discovered through a ‘best effort’ handler using the ‘Other’ vendor option in the drop-down.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611722]Note At least one valid DCNM license must be provisioned before adding SMI-S storage discovery datasources.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611723]Step 4 Specify the SMI-S Server IP, User Name and Password.
 
     [bookmark: pgfId-1611724]Step 5 Specify the Name Space and Interop Name Space.
 
     [bookmark: pgfId-1611725]Step 6 By default, the Port number is pre-populated. If you select the Secure checkbox, then the default secure port number is populated. 
 
     [bookmark: pgfId-1611726]When using the Secure mode with EMC, the default setting is mutual authentication. For more information, see EMC’s documentation about adding an SSL certificate to their trust store, or set SSLClientAuthentication value to ‘None’ in the Security_Settings.xml config file and then restart the ECOM service.
 
     [bookmark: pgfId-1611727]Step 7 Click Add. The credentials are validated and if it’s valid the storage discovery starts. If the credential check fails, you will be prompted to enter valid credentials.
 
    
 
     
      [bookmark: pgfId-1611729][bookmark: 36668]Editing SMI-S Provider
 
     
 
     [bookmark: pgfId-1611730]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611731]Step 2 Use the check-box to select the SMI-S provider and click the Edit SMIS Provider icon.
 
     [bookmark: pgfId-1611732]Step 3 In the Edit SMI-S Provider window, use the drop-down to select the Vendor.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611733]Note Only EMC and NetApp are currently supported.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611734]Step 4 Specify the SMI-S Sever IP, User Name and Password.
 
     [bookmark: pgfId-1611735]Step 5 Specify the Name Space and Interop Name Space.
 
     [bookmark: pgfId-1611736]Step 6 By default, the Port number is pre-populated. If you select the Secure checkbox, then the default secure port number is populated.
 
     [bookmark: pgfId-1611737]Step 7 Click Apply. The Storage Discovery is stopped and a new task is created using the new information and the Storage Discover is re-started.
 
    
 
     
      [bookmark: pgfId-1611739][bookmark: 37261]Deleting SMI-S Provider
 
     
 
     [bookmark: pgfId-1611740]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611741]Step 2 Use the check-box to select the SMI-S provider and click the Remove SMIS Provider icon.
 
     [bookmark: pgfId-1611742]The provider is removed and all data associated with the provider is purged from the system.
 
    
 
     
      [bookmark: pgfId-1611744][bookmark: 55818]Re-Discover SMI-S Provider
 
     
 
     [bookmark: pgfId-1611745]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611746]Step 2 Use the check-box to select the SMI-S provider and click the Re-discover SMIS Provider icon
 
    
 
     
      [bookmark: pgfId-1611748][bookmark: 21306]Refresh SMI-S Provider
 
     
 
     [bookmark: pgfId-1611749]Step 1 From the menu bar, choose Admin > General > Data Sources.
 
     [bookmark: pgfId-1611750]Step 2 Use the check-box to select the SMI-S provider and click the Refresh Table icon.
 
     [bookmark: pgfId-1611751]The providers are re-discovered.
 
    
 
     
      [bookmark: pgfId-1611753]Viewing Log Information
 
     [bookmark: pgfId-1611754]This feature enables you to view the Cisco Prime DCNM Web Client log. These processes have no corresponding GUI that allows you to view information about these log files. If you see errors, preserve these two files for viewing. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1611755]Note Logs cannot be viewed from a remote server in a federation. 
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1611756]Step 1 From the menu bar, choose Admin > General > Logs. 
 
     [bookmark: pgfId-1611757]You see a list of viewable logs in the left column. 
 
     [bookmark: pgfId-1611758]Step 2 Click a log file to view it. 
 
     [bookmark: pgfId-1611759]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1611761]Configuring Cisco Prime DCNM-SAN Server Properties
 
     [bookmark: pgfId-1611762]To configure Cisco Prime DCNM-SAN Server properties
 
     
 
     [bookmark: pgfId-1611763]Step 1 From the menu bar, choose Admin > General > Server Properties. 
 
     [bookmark: pgfId-1611764]Step 2 Follow the on-screen instructions and click Apply to confirm the changes. 
 
     [bookmark: pgfId-1611765]While connecting to some switches if the connection is getting timed out, in the #CLI session channel type, change default the cli.channel.type value from exec to shell.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611766]Note After configuring the server properties, you need to restart the DCNM server only if you receive a notification stating that the server must be restarted.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611767]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1611769]Configuring SFTP/TFTP Credentials 
 
     [bookmark: pgfId-1611770]You can configure the SFTP/TFTP credentials for the File store.
 
     [bookmark: pgfId-1611771]A file server is required to collect device configuration and restoring configurations to the device.
 
     
 
     [bookmark: pgfId-1611772]Step 1 From the menu bar, choose Admin > General > SFTP/TFTP Credentials.
 
     [bookmark: pgfId-1611773]You see the SFTP/TFTP credentials page.
 
     [bookmark: pgfId-1611774]TFTP Credentials option is disabled for DFA deployment of Open Virtual Appliance and ISO installers.
 
     [bookmark: pgfId-1611775]Step 2 In the Server Type field, use the radio button to select SFTP.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611776]Note You must have a SFTP server on the DCNM Server to perform backup operation. The SFTP directory must be an absolute Linux/SSH path format and must have read/write access to the SFTP User.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611777] a. Enter the SFTP Username and SFTP Password.
 
     [bookmark: pgfId-1611778] b. Enter the SFTP Directory path.
 
     [bookmark: pgfId-1611779]The path must be in absolute Linux path format.
 
     [bookmark: pgfId-1611780] c. From the Verification Switch drop-down, select the switch.
 
     [bookmark: pgfId-1611781] d. Click Apply to apply the configuration. 
 
     [bookmark: pgfId-1611782] e. Click Verify and Apply to verify and apply the configuration. If there are any failures during the verification, the new changes will not be stored.
 
     [bookmark: pgfId-1611783] f. Click Clear SSH Hosts to clear SSH hosts for all switches or selected switches. If there is a failure in any of the switches, an error message is displayed. Go to Config > Job > Job Status History to view the number of successful and unsuccessful switches.
 
     [bookmark: pgfId-1611784]Step 3 In the Server Type field, use the radio button to select TFTP.
 
     [bookmark: pgfId-1611785]Cisco Prime DCNM uses an internal TFTP server for data transfer. Ensure that there is no external TFTP server running on the DCNM server.
 
      
       
     
 
     
 
     [bookmark: pgfId-1611786]Note Ensure that your switch user role includes the copy command. Operator roles will receive a ‘permission denied’ error. You can change your credentials from the Admin > DataSources page.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611787] a. From the Verification Switch drop-down, select the switch.
 
     [bookmark: pgfId-1611788] b. Click Apply to apply the configuration. 
 
     [bookmark: pgfId-1611789] c. Click Verify and Apply to verify and apply the configuration. If there are any failures during the verification, the new changes will not be stored.
 
     [bookmark: pgfId-1611790]Step 4 From the menu bar, choose Config > Jobs > Job Status History to view individual device verification status.
 
     [bookmark: pgfId-1611791]The configurations that are backed up are removed from the file server and are stored in the database.
 
     [bookmark: pgfId-1611792]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1611796][bookmark: 53766][bookmark: 85556]Managing Switch Groups
 
     [bookmark: pgfId-1611797]Beginning with Cisco NX-OS Release 6.x, you can configure switch groups by using Cisco Prime DCNM Web Client. You can add, delete, rename or move a switch to a group or move a group of switches to another group. 
 
     [bookmark: pgfId-1611798]This section contains the following: 
 
      
      	 [bookmark: pgfId-1611802]Adding Switch Groups 
 
      	 [bookmark: pgfId-1611806]Renaming a Group 
 
      	 [bookmark: pgfId-1611810]Deleting a Group or a Member of a Group
 
      	 [bookmark: pgfId-1611814]Moving a Switch to Another Group
 
      	 [bookmark: pgfId-1611818]Moving a Switch Group to Another Group 
 
     
 
    
 
     
      [bookmark: pgfId-1611820][bookmark: 38957]Adding Switch Groups 
 
     [bookmark: pgfId-1611821]You can add a switch group from the Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1611822]Step 1 From the menu bar, choose Admin > General > Switch Groups.
 
     [bookmark: pgfId-1611823]Step 2 Click the Add Group icon or press the Insert key on your keyboard. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1611824]Note A field appears that allows you to enter the name for the switch group. The Insert key does not work unless you highlight the group table first. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611825]Step 3 Enter the name of the switch group and click outside the text field or press the Return key to complete adding the switch group. Press the Esc key on your keyboard to discard the text input and exit. 
 
     [bookmark: pgfId-1611826]The switch group name validation and the maximum tree depth is 10.If you do not choose a parent group before adding a new switch group, the new group is added on the top of the hierarchy 
 
    
 
     
      [bookmark: pgfId-1611828][bookmark: 64964]Renaming a Group 
 
     [bookmark: pgfId-1611829]You can rename a switch group from the Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1611830]Step 1 Double-click on the switch group name that you want to rename. 
 
     [bookmark: pgfId-1611831]Step 2 Enter a new name to rename the group. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1611832]Note The name of the group cannot contain any of these special characters: ()<>,;:\\\[]`~!#$% *=}|/?. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1611833]Step 3 Press the Return key to apply changes or press the Esc key on your keyboard to discard the modification. 
 
    
 
     
      [bookmark: pgfId-1611835][bookmark: 66406]Deleting a Group or a Member of a Group 
 
     [bookmark: pgfId-1611836]You can delete group(s) and/or member(s) of a group from the Cisco Prime DCNM Web Client. When you delete a group, the associated group(s) are deleted and the fabrics or Ethernet switches of the deleted group(s) are moved back to the default SAN or LAN. 
 
     
 
     [bookmark: pgfId-1611837]Step 1 Choose the switch group or member(s) of a group that you want to remove. 
 
     [bookmark: pgfId-1611838]Step 2 Click the Remove icon or press the Delete key on your keyboard. 
 
     [bookmark: pgfId-1611839]A dialog box prompts you to confirm the deletion of the switch group or the member of the group. Click Yes to delete or No to cancel the action 
 
    
 
     
      [bookmark: pgfId-1611841][bookmark: 10855]Moving a Switch to Another Group 
 
     
 
     [bookmark: pgfId-1611842]Step 1 Use the checkbox to choose a switch from the group.
 
     [bookmark: pgfId-1611843]Step 2 Select the Move the selected Switch/Fabric to Group icon.
The Move LAN Member dialog box appears. 
 
     [bookmark: pgfId-1611844]Step 3 Select the switch group from the list and click Apply. 
 
    
 
     
      [bookmark: pgfId-1611846][bookmark: 59546]Moving a Switch Group to Another Group 
 
     
 
     [bookmark: pgfId-1611847]Step 1 Use the checkbox to choose a switch group. 
 
     [bookmark: pgfId-1611848]Step 2 Click Move Switch/Fabric to selected Group icon.
The Move LAN Member Group dialog box appears. 
 
     [bookmark: pgfId-1611849]Step 3 Select the switch group from the list and click Apply. 
 
    
 
     
      [bookmark: pgfId-1611851]Managing Custom Port Groups
 
     [bookmark: pgfId-1611852]Custom Port groups aids you to test the performance of the interfaces in the group. You can view the defined custom ports and their configurations from Admin > Custom Port Groups on the Cisco Prime DCNM Web Client.
 
     [bookmark: pgfId-1611853]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1611857]Adding Custom Port Groups
 
      	 [bookmark: pgfId-1611861]Configuring Switch and Interface to the Port Group
 
      	 [bookmark: pgfId-1611865]Generating Reports for the Custom Port Groups
 
      	 [bookmark: pgfId-1611869]Removing Port Group Member
 
      	 [bookmark: pgfId-1611873]Removing Port Group
 
     
 
    
 
     
      [bookmark: pgfId-1611875][bookmark: 40404]Adding Custom Port Groups
 
     [bookmark: pgfId-1611876]You can add a custom port group from the Cisco Prime DCNM Web Client. 
 
     
 
     [bookmark: pgfId-1611877]Step 1 From the menu bar, choose Admin > Custom Port Groups.
 
     [bookmark: pgfId-1611878]Step 2 In the Defined Groups block, click the Add Group icon.
 
     [bookmark: pgfId-1611879]Step 3 Enter the name for the custom port group in the Add Group Dilog.
 
     [bookmark: pgfId-1611880]A custom port group is created in the Defined Groups block.
 
    
 
     
      [bookmark: pgfId-1611882][bookmark: 89344]Configuring Switch and Interface to the Port Group
 
     [bookmark: pgfId-1611883]You can configure the custom port group to include switches and their interfaces.
 
     
 
     [bookmark: pgfId-1611884]Step 1 From the menu bar, choose Admin > Custom Port Groups.
 
     [bookmark: pgfId-1611885]Step 2 In the Defined Groups block, select the port group for which you need to add the switch and interfaces.
 
     [bookmark: pgfId-1611886]Step 3 In the Configuration block, click the Add Group Member icon.
 
     [bookmark: pgfId-1611887]The Port Configuration window appears for the selected Custom Port Group.
 
     [bookmark: pgfId-1611888]Step 4 In the Switches tab, select the switch that you need to include in custom port group.
 
     [bookmark: pgfId-1611889]The list of available Interfaces appears.
 
     [bookmark: pgfId-1611890]Step 5 Select all the interfaces for which you need to check the performance.
 
     [bookmark: pgfId-1611891]Step 6 Click Submit.
 
     [bookmark: pgfId-1611892]The list of interfaces is added to the custom port group.
 
    
 
     
      [bookmark: pgfId-1611894][bookmark: 23516]Generating Reports for the Custom Port Groups
 
     [bookmark: pgfId-1611895]You can generate the reports to monitor the performance of the interfaces in the custom port group.
 
     
 
     [bookmark: pgfId-1611896]Step 1 From the menu bar, choose Reports > Generate.
 
     [bookmark: pgfId-1611897]Step 2 From the Scope dropdownlist, select the port group for which you need to generate the performance report.
 
     [bookmark: pgfId-1611900]Step 3 Generate the Performance report. For information about how to Generate Reports, see Generating a Report.
 
     [bookmark: pgfId-1611902]Step 4 Verify if the report is generated for all the interfaces that were added in the custom port group.
 
    
 
     
      [bookmark: pgfId-1611904][bookmark: 10805]Removing Port Group Member
 
     [bookmark: pgfId-1611905]You can remove or delete the port group member from the Custom Port group.
 
     
 
     [bookmark: pgfId-1611906]Step 1 From the menu bar, choose Admin > Custom Port Groups.
 
     [bookmark: pgfId-1611907]Step 2 In the Defined Groups block, select the port group for which you need to add the switch and interfaces.
 
     [bookmark: pgfId-1611908]Step 3 In the Configuration clock, select the switch name and interface that must be deleted. 
 
     [bookmark: pgfId-1611909]Step 4 In the Defined Groups block, select the group for which you which must be deleted. Click Remove Group Member icon.
 
     [bookmark: pgfId-1611910]A confirmation window appears.
 
     [bookmark: pgfId-1611911]Step 5 Click Yes to delete the member from the custom port group .
 
    
 
     
      [bookmark: pgfId-1611913][bookmark: 44243]Removing Port Group
 
     [bookmark: pgfId-1611914]You can remove or delete the port group from the Cisco Prime DCNM Web Client.
 
     
 
     [bookmark: pgfId-1611915]Step 1 From the menu bar, choose Admin > Custom Port Groups.
 
     [bookmark: pgfId-1611916]Step 2 In the Defined Groups block, select the group which must be deleted. Click Remove Group icon.
 
     [bookmark: pgfId-1611917]A confirmation window appears.
 
     [bookmark: pgfId-1611918]Step 3 Click Yes to delete the custom group.
 
    
 
     
      [bookmark: pgfId-1611921][bookmark: 89048]Managing Licenses
 
     [bookmark: pgfId-1611922]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1611926]Viewing Licenses Using the Cisco Prime DCNM Wizard
 
      	 [bookmark: pgfId-1611930]Automatic License Assignment
 
      	 [bookmark: pgfId-1611934]Adding Cisco Prime DCNM Licenses
 
      	 [bookmark: pgfId-1611938]Assigning Licenses
 
      	 [bookmark: pgfId-1611942]Unassigning Licenses to a Switch
 
     
 
    
 
     
      [bookmark: pgfId-1611944][bookmark: 53746]Viewing Licenses Using the Cisco Prime DCNM Wizard
 
     [bookmark: pgfId-1611945]You can view the existing Cisco Prime DCNM licenses by DETAILED STEPSselecting Admin > License to start the license wizard. 
 
     [bookmark: pgfId-1611949]Figure 3-2 displays the license information.
 
     [bookmark: pgfId-1611954]Figure 3-2 [bookmark: 19673]Cisco Prime DCNM Licenses 
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1611955]Note By default, the Switch Licenses tab appears.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612001]Table 3-6 displays the Cisco Prime DCNM server license fields.
 
      
       
        
        [bookmark: pgfId-1611965]Table 3-6 [bookmark: 87395]Cisco Prime DCNM Server License Files 
 
        
        
         
         	 
           
           [bookmark: pgfId-1611969]Field 
          
  
         	 
           
           [bookmark: pgfId-1611971]Description 
          
  
        
 
         
         	[bookmark: pgfId-1611973]File Name
  
         	[bookmark: pgfId-1611975]Name of the license file. 
  
        
 
         
         	[bookmark: pgfId-1611977]Feature
  
         	[bookmark: pgfId-1611979]Describes the feature name specified in the license file. The following values are supported: 
 
           
           	 [bookmark: pgfId-1611980]DCNM-LAN
 
           	 [bookmark: pgfId-1611981]DCNM-SAN
 
           	 [bookmark: pgfId-1611982]DCNM-SAN-LAN
 
           	 [bookmark: pgfId-1611983]LAN-ENT-N7K
 
          
  
        
 
         
         	[bookmark: pgfId-1611985]PID
  
         	[bookmark: pgfId-1611987]Describes the product ID found in the vendor string of the license file. For example, DCNM-N7K-K0 is an enterprise license for Cisco Nexus 7000 series switches.
  
        
 
         
         	[bookmark: pgfId-1611989]SAN (Free or Total)
  
         	[bookmark: pgfId-1611991]Lists the number of SAN licenses used and available.
  
        
 
         
         	[bookmark: pgfId-1611993]LAN (Free or Total)
  
         	[bookmark: pgfId-1611995]Lists the number of LAN licenses used and available.
  
        
 
         
         	[bookmark: pgfId-1611997]Eval Expiration 
  
         	[bookmark: pgfId-1611999]Displays the expiry date of the license. 
 
           
            
          
 
          
 [bookmark: pgfId-1612000]Note Text in the eval expiration field will be in red for licenses that expire in seven days. 
 
           
           
 
          

  
        
 
        
      
 
     
 
     [bookmark: pgfId-1612049]Table 3-7 displays the Cisco Prime DCNM switch license fields.
 
      
       
        
        [bookmark: pgfId-1612011]Table 3-7 [bookmark: 79094]Cisco Prime DCNM Switch Licenses 
 
        
        
         
         	 
           
           [bookmark: pgfId-1612015]Field 
          
  
         	 
           
           [bookmark: pgfId-1612017]Description 
          
  
        
 
         
         	[bookmark: pgfId-1612019]Group
  
         	[bookmark: pgfId-1612021]Displays if it is a fabric or LAN group.
  
        
 
         
         	[bookmark: pgfId-1612023]Switch Name
  
         	[bookmark: pgfId-1612025]Displays the name of the switch.
  
        
 
         
         	[bookmark: pgfId-1612027]Model
  
         	[bookmark: pgfId-1612029]Displays the model of the device. For example, DS-C9124 or N5K-C5020P-BF.
  
        
 
         
         	[bookmark: pgfId-1612031]License State
  
         	[bookmark: pgfId-1612033]Displays the license state of the switch that can be one of the following:
 
           
           	 [bookmark: pgfId-1612034]Permanent
 
           	 [bookmark: pgfId-1612035]Eval
 
           	 [bookmark: pgfId-1612036]Unlicensed
 
           	 [bookmark: pgfId-1612037]Not Applicable
 
           	 [bookmark: pgfId-1612038]Expired
 
           	 [bookmark: pgfId-1612039]Invalid 
 
          
  
        
 
         
         	[bookmark: pgfId-1612041]License Type
  
         	[bookmark: pgfId-1612043]Displays if the license is a switch-based embedded license or a server-based license.
  
        
 
         
         	[bookmark: pgfId-1612045]Eval Expiration
  
         	[bookmark: pgfId-1612047]Displays the expiry date of the license. 
 
           
            
          
 
          
 [bookmark: pgfId-1612048]Note Text in the eval expiration field will be in Red for licenses that expires in seven days. 
 
           
           
 
          

  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1612051][bookmark: 42776]Automatic License Assignment
 
     [bookmark: pgfId-1612052]When the Fabric is first discovered if the switch does not have a valid switch-based license, a license is automatically assigned to the Fabric from the file license pool until no more licenses are left in the pool. Also, if you have an existing Fabric and a new switch is added to the Fabric, the new switch will be assigned a license if one is available in the file license pool and if it does not already have a switch-based license. 
 
    
 
     
      [bookmark: pgfId-1612054][bookmark: 89653]Adding Cisco Prime DCNM Licenses
 
     [bookmark: pgfId-1612055]You must have network administrator privileges to complete the following procedure. 
 
     
 
     [bookmark: pgfId-1612056]Step 1 Choose Admin > License to start the license wizard. 
 
     [bookmark: pgfId-1612057]Step 2 Choose the Server License Files tab.
The valid Cisco Prime DCNM-LAN and DCNM-SAN license files appear. 
 
     [bookmark: pgfId-1612058]Ensure that the security agent is disabled when you load licenses. 
 
     [bookmark: pgfId-1612059]Step 3 Download the license pack file that you received from Cisco into a directory on the local system.
 
     [bookmark: pgfId-1612060]Step 4 Click Add License File and then select the license pack file that you saved on the local machine. The file will be uploaded to the server machine, saved into the server license directory and then loaded on to the server. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1612061]Note Ensure that you do not edit the contents of the.lic file or the Cisco Prime DCNM software ignores any features that are associated with that license file. The contents of the file are signed and must remain intact. When you accidentally copy, rename, or insert the license file multiple times, the duplicate files are ignored, but the original will be counted. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612063][bookmark: 47303]Assigning Licenses
 
    
 
     
      [bookmark: pgfId-1612064]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1612065]You must have network administrator privileges to complete the following procedure.
 
     
 
     [bookmark: pgfId-1612066]Step 1 DETAILED STEPSChoose Admin > License to start the license wizard.
You see the licenses table. 
 
     [bookmark: pgfId-1612067]Step 2 From the table, choose the switch that you want to assign the license to.
 
     [bookmark: pgfId-1612068]Step 3 Click Assign License.
 
    
 
     
      [bookmark: pgfId-1612070][bookmark: 81034]Unassigning Licenses to a Switch
 
    
 
     
      [bookmark: pgfId-1612071]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1612072]You must have network administrator privileges to complete the following procedure.
 
     [bookmark: pgfId-1612073]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1612074]Step 1 Choose Admin > License to start the license wizard.
You see the licenses table. 
 
     [bookmark: pgfId-1612075]Step 2 From the table, choose the switch that you want to unassign the license.
 
     [bookmark: pgfId-1612076]Step 3 Click Unassign License.
 
    
 
     
      [bookmark: pgfId-1612078]Viewing Server Federation 
 
     
 
     [bookmark: pgfId-1612079]Step 1 From the menu bar, choose Admin > General > Federation. 
 
     [bookmark: pgfId-1612080]The list of Servers along with its Status, Local Time and Data Sources are displayed. 
 
     [bookmark: pgfId-1612081]Step 2 Use the Enable Automatic Failover checkbox to turn on/off the failover functionality.
 
     [bookmark: pgfId-1612082]Step 3 In the Location column, double-click to edit the location.
 
      
       
     
 
     
 
     [bookmark: pgfId-1612083]Note If the status of one of the servers in the federation is Inactive, then some functionality may not work unless the server status changes to Active in the federation.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1612084]Note Before upgrading Cisco Prime DCNM, ensure that Enable Automatic Failover is unchecked. Otherwise, if one server within the federation is down, the devices discovered by the server will be moved to the other DCNM server which comes up first after upgrade. To prevent the auto move for DCNM upgrade, you need to disable the auto move on all DCNMs within the federation, and then upgrade the DCNM server one by one. Only after all the DCNMs upgrade successfully and run normally, then enable the auto move again. 
To enable / disable Auto Move, please go to Admin > Federation from DCNM web page, click on the checkbox at top left for Enable Automatic Failover.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612086]Configuring AAA Properties 
 
     [bookmark: pgfId-1612087]To configure AAA properties, 
 
     
 
     [bookmark: pgfId-1612088]Step 1 From the menu bar, choose Admin > Management Users > Remote AAA Properties.
 
     [bookmark: pgfId-1612089]The AAA properties configuration page appears.
 
     [bookmark: pgfId-1612090]Step 2 Use the radio button to select one of the following Authentication Modes:
 
      
       
       	 [bookmark: pgfId-1612094]Local - In this mode the authentication will authenticate with the local server.
 
       	 [bookmark: pgfId-1612098]Radius - In this mode the authentication will authenticate against the Radius servers specified.
 
       	 [bookmark: pgfId-1612102]TACACS+- In this mode the authentication will authenticate against the TACAS servers specified.
 
       	 [bookmark: pgfId-1612106]Switch - In this mode the authentication will authenticate against the switches specified.
 
       	 [bookmark: pgfId-1612110]LDAP - In this mode the authentication will authenticate against the LDAP server specified.
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1612112][bookmark: 39675]Local
 
     
 
     [bookmark: pgfId-1612113]Step 1 Use the radio button and select Local as the authentication mode.
 
     [bookmark: pgfId-1612114]Step 2 Click Apply to confirm the authentication mode.
 
    
 
     
      [bookmark: pgfId-1612116][bookmark: 25808]Radius
 
     
 
     [bookmark: pgfId-1612117]Step 1 Use the radio button and select Radius as the authentication mode.
 
     [bookmark: pgfId-1612118]Step 2 Specify the Primary server details and click Test to test the server.
 
     [bookmark: pgfId-1612119]Step 3 (Optional) Specify the Secondary and Tertiary server details and click Test to test the server.
 
     [bookmark: pgfId-1612120]Step 4 Click Apply to confirm the authentication mode.
 
    
 
     
      [bookmark: pgfId-1612122][bookmark: 59303]TACACS+
 
     
 
     [bookmark: pgfId-1612123]Step 1 Use the radio button and select TACACS+ as the authentication mode.
 
     [bookmark: pgfId-1612124]Step 2 Specify the Primary server details and click Test to test the server.
 
     [bookmark: pgfId-1612125]Step 3 (Optional) Specify the Secondary and Tertiary server details and click Test to test the server. 
 
     [bookmark: pgfId-1612126]Step 4 Click Apply to confirm the authentication mode.
 
    
 
     
      [bookmark: pgfId-1612128][bookmark: 37838]Switch
 
     
 
     [bookmark: pgfId-1612129]Step 1 Use the radio button to select Switch as the authentication mode.
 
     [bookmark: pgfId-1612130]Step 2 Specify the Primary Switch name and click Apply to confirm the authentication mode.
 
     [bookmark: pgfId-1612131]Step 3 (Optional) Specify the Secondary and Tertiary Switch name and click Apply to confirm the authentication mode.
 
    
 
     
      [bookmark: pgfId-1612133][bookmark: 63138]LDAP
 
     
 
     [bookmark: pgfId-1612134]Step 1 Use the radio button and select LDAP as the authentication mode.
 
     [bookmark: pgfId-1612135]Step 2 In the Host field, enter DNS address of the host.
 
     [bookmark: pgfId-1612136]Step 3 Click Test to test the AAA server.
 
     [bookmark: pgfId-1612137]Step 4 Enter a valid Username and Password.
 
     [bookmark: pgfId-1612138]A dialog box appears confirming the status of the AAA server test. If the test has failed, the LDAP Authentication Failed dialog box appears.
 
     [bookmark: pgfId-1612139]Step 5 In the Port field, enter a port number.
 
     [bookmark: pgfId-1612140]Step 6 (Optional) Select the SSL Enabled check box, if SSL is enabled on the AAA server.
 
     [bookmark: pgfId-1612141]Step 7 In the Base DN field, enter the base domain name.
 
     [bookmark: pgfId-1612142]Step 8 In the Filter field, specify the filter parameters.
 
     [bookmark: pgfId-1612143]Step 9 Choose an option to determine a role by either Attribute or Admin Group Map.
 
     [bookmark: pgfId-1612144]Step 10 In the Role Admin Group field, enter the name of the role.
 
     [bookmark: pgfId-1612145]Step 11 In the Map to DCNM Role field, enter the name of the role to be mapped.
 
     [bookmark: pgfId-1612146]Step 12 Click Apply to apply the LDAP configuration.
 
    
 
     
      [bookmark: pgfId-1612148]Adding and Removing Users 
 
     [bookmark: pgfId-1612149]You can use Cisco Prime DCNM Web Client to add and remove Web Client users. 
 
     [bookmark: pgfId-1612150]This section contains the following: 
 
      
      	 [bookmark: pgfId-1612154]Adding Local Users 
 
      	 [bookmark: pgfId-1612158]Editing a User
 
      	 [bookmark: pgfId-1612162]Removing a User 
 
     
 
    
 
     
      [bookmark: pgfId-1612164][bookmark: 80946]Adding Local Users 
 
     
 
     [bookmark: pgfId-1612165]Step 1 From the menu bar, choose Admin > Management Users > Local. 
You see the Local Database page. 
 
     [bookmark: pgfId-1612166]Step 2 Click Add. 
 
     [bookmark: pgfId-1612167]You see the Add User dialog box. 
 
     [bookmark: pgfId-1612168]Step 3 Enter the username in the Username field. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1612169]Note The username guest is a reserved name (case insensitive). The guest user can only view reports. The guest user cannot change the guest password, or access the Admin options in DCNM Web Client. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612170]Step 4 From the Role drop-down list, select a role for the user. 
 
     [bookmark: pgfId-1612171]Step 5 In the Password field, enter the password. 
 
     [bookmark: pgfId-1612172]Step 6 In the Confirm Password field, enter the password again. 
 
     [bookmark: pgfId-1612173]Step 7 Click Add to add the user to the database. 
 
     [bookmark: pgfId-1612174]Step 8 Repeat Steps 2through 7 to continue adding users. 
 
    
 
     
      [bookmark: pgfId-1612176][bookmark: 91373]Editing a User 
 
     
 
     [bookmark: pgfId-1612177]Step 1 From the menu bar, choose Admin > Management Users > Local. 
 
     [bookmark: pgfId-1612178]Step 2 Use the checkbox to select a user and click the Edit Local User icon. 
 
     [bookmark: pgfId-1612179]Step 3 In the Edit Local User window, the User Name and Role is mentioned by default. Specify the Password and Confirm Password. 
 
     [bookmark: pgfId-1612180]Step 4 Click Apply to save the changes. 
 
    
 
     
      [bookmark: pgfId-1612182][bookmark: 23562]Removing a User 
 
     
 
     [bookmark: pgfId-1612183]Step 1 From the menu bar, choose Admin > Management Users > Local. 
 
     [bookmark: pgfId-1612184]Step 2 Select the check box next to the user(s) you want to remove and click Remove.
 
    
 
     
      [bookmark: pgfId-1612186]Managing Clients
 
     [bookmark: pgfId-1612187]You can use the DCNM Web Client to disconnect DCNM Client Servers.
 
     
 
     [bookmark: pgfId-1612188]Step 1 From the menu bar, click Admin>Clients.
 
     [bookmark: pgfId-1612189]A list of DCNM Servers are displayed.
 
     [bookmark: pgfId-1612190]Step 2 Use the check box to select a DCNM server and click Disconnect Client icon to disconnect the DCNM server.
 
      
       
     
 
     
 
     [bookmark: pgfId-1612191]Note You cannot disconnect a current client session.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612194][bookmark: 49578]Performance Manager Collections 
 
     [bookmark: pgfId-1612195]If you are managing your switches with the Performance Manager, you must set up an initial set of flows and collections on the switch. You can use Cisco Prime DCNM Web Client to add and remove performance collections. The switch has to be licensed and in the Managed Continuously state before a collection for the switch can be created. 
 
     [bookmark: pgfId-1612196]To add a collection follow these steps: 
 
     
 
     [bookmark: pgfId-1612197]Step 1 From the menu bar, click Admin>Collections. 
 
     [bookmark: pgfId-1612198]Step 2 Under Generate a threshold event when traffic exceeds % of capacity, use the checkbox to specify the Critical at and Warning at values. User can also use the For ISL/Trunk Only checkbox to limit the threshold events generated to ISL and Trunk events only and then click Apply.
 
     [bookmark: pgfId-1612199]Step 3 In the Licensed Fabrics panel, use the checkboxes to select the Fabric, ISLs/NPV Links, Hosts, Storage, FC Flows and FC Ethernet to enable performance collection for these data types. 
 
     [bookmark: pgfId-1612200]Step 4 In the Licensed LAN Switches panel, use the checkboxes to enable performance data collection for Trunks, Access and Errors & Discards.
 
     [bookmark: pgfId-1612201]Step 5 Use the checkboxes to select the type(s) of LAN switches for which you want to collect performance data. 
 
     [bookmark: pgfId-1612202]Step 6 Click Apply to save the configuration. 
 
     [bookmark: pgfId-1612203]Step 7 In the confirmation dialog box, click Yes to restart the performance collector.
 
    
 
     
      [bookmark: pgfId-1612205]Configuring the RRD Database 
 
     [bookmark: pgfId-1612206]Configuring the Round Robin Database (RRD) allows you to set the intervals at which data samples are collected. After applying the configuration, the database storage format is converted to a new format at those intervals. Because database formats are incompatible with each other, you must copy the old data (before the conversion) to the $INSTALLDIR/pm directory. See the "Importing the RRD Statistics Index" topic. 
 
     
 
     [bookmark: pgfId-1612210]Step 1 From the menu bar, choose Admin > Performance > Databases. 
 
     [bookmark: pgfId-1612211]You see the Performance Database (collection interval) page.
 
     [bookmark: pgfId-1612212]Step 2 In the top row of the Days column, enter the number of days to collect samples at 5-minute intervals.
 
     [bookmark: pgfId-1612213]Step 3 In the second row of the Days column, enter the number of days to collect samples at 30-minute intervals. 
 
     [bookmark: pgfId-1612214]Step 4 In the third row of the Days column, enter the number of days to collect samples at 2-hour intervals. 
 
     [bookmark: pgfId-1612215]Step 5 In the bottom row of the Days column, enter the number of days to collect samples at 1-day intervals. 
 
     [bookmark: pgfId-1612216]As of Cisco SAN-OS Release 3.1(1) and later releases, you can configure the sampling interval for ISLs. Select a sampling interval from the ISLs drop-down list. 
 
     [bookmark: pgfId-1612217]Step 6 Click Apply to apply your changes, or click Defaults to reset the file sizes to the default values.
 
     [bookmark: pgfId-1612218]If you are applying new values, or if the current values are not the default values, you see a message indicating that the conversion of the RRD files take a certain amount of time and that the database is unavailable until then. The time it takes depends on the difference between the old and new values. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1612219]Note The system allows you to convert data, one process at a time. When you start converting the data, the Apply and Default buttons change to Refresh and Cancel so that another process cannot be inadvertently started. The display is the same for all browsers that access the server during this time. Click Refresh to view the latest progress. Click Cancel to cancel the process of converting the data. If the job is successfully canceled, you see the Apply and Default buttons again. If the cancel job is not successful, you see a message indicating that the cancellation has failed.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612220]If you want to perform this procedure, perform it before collecting a lot of data because data conversion can take a long time. 
 
    
 
     
      [bookmark: pgfId-1612222][bookmark: 28288]Importing the RRD Statistics Index 
 
     
 
     [bookmark: pgfId-1612223]Step 1 Stop Cisco Prime DCNM-SAN Server. 
 
     [bookmark: pgfId-1612224]Step 2 Copy the original RRD file into $INSTALLDIR/pm/db. 
 
     [bookmark: pgfId-1612225]Step 3 Run $INSTALLDIR/bin/pm.bat s. 
 
     [bookmark: pgfId-1612226]Step 4 Restart Cisco Prime DCNM-SAN and add the fabric. 
 
    
 
     
      [bookmark: pgfId-1612228]Configuring Other Statistics 
 
     
 
     [bookmark: pgfId-1612229]Step 1 From the menu bar, choose Admin > Performance > Others. 
 
     [bookmark: pgfId-1612230]You see the Others page. 
 
     [bookmark: pgfId-1612231]Step 2 Click Add. 
 
     [bookmark: pgfId-1612232]You see the Add SNMP Statistic dialog box. 
 
     [bookmark: pgfId-1612233]Step 3 From the Switch table, select the switch for which you want to add other statistics. 
 
     [bookmark: pgfId-1612234]Step 4 From the SNMP OID drop-down list, select the OID. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1612235]Note For SNMP OID ModuleX_Temp,IFHCInOctets.IFINDEX,IFHCOutOctest.IFINDEX, selected from drop down box, you must replace'X' with correct module number or the corresponding IFINDEX.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612236]Step 5 In the Display Name box, enter a new name. 
 
     [bookmark: pgfId-1612237]Step 6 From the Type drop-down list, select the type. 
 
     [bookmark: pgfId-1612238]Step 7 Click Add to add this statistic. 
 
    
 
     
      [bookmark: pgfId-1612241][bookmark: 81568]Viewing Events Registration 
 
     [bookmark: pgfId-1612242]To enable Send Syslog, Send Traps and Delayed Traps you need to configure the following in the DCNM-SAN client:
 
      
      	 [bookmark: pgfId-1612243]Enabling Send Syslog - Log into the DCNM-SAN client. In the Physical Attributes pane, Select Events>Syslog>Servers. Click the Create Row icon, provide the required details and click Create.
 
      	 [bookmark: pgfId-1612244]Enabling Send Traps - Log into the DCNM-SAN client. In the Physical Attributes pane, Select Events>SNMP Traps>Destination. Click the Create Row icon, provide the required details and click Create.
 
      	 [bookmark: pgfId-1612245]Enabling Delayed Traps - Log into the DCNM-SAN client. In the Physical Attributes pane, Select Events>SNMP Traps>Delayed Traps. In the Feature Enable column, use the checkboxes to enable delayed traps for the switch and specify the delay in minutes.
 
     
 
     
 
     [bookmark: pgfId-1612246]Step 1 From the menu bar, choose Admin > Events > Registration. 
 
     [bookmark: pgfId-1612247]The SNMP and Syslog receivers along with the statistics information are displayed. 
 
     [bookmark: pgfId-1612248]Step 2 Select Enable Syslog Receiver checkbox and click Apply to enable the syslog receiver if it is disabled in the server property. 
 
     [bookmark: pgfId-1612249]To configure the Event Registration/Syslog properties, select Admin>Server Properties and follow the on-screen instructions.
 
     [bookmark: pgfId-1612250]Step 3 Select Copy Syslog Messages to DB and click Apply to copy the syslog messages to the database. If this option is not select, the events will not be displayed in the events page of the Web client.
 
     [bookmark: pgfId-1612251]Step 4 The columns in the second table displays the following:
 
      
       
       	 [bookmark: pgfId-1612252]Switches sending traps
 
       	 [bookmark: pgfId-1612253]Switches sending syslog
 
       	 [bookmark: pgfId-1612254]Switches sending syslog accounting
 
       	 [bookmark: pgfId-1612255]Switches sending delayed traps 
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1612257]Adding Notification Forwarding 
 
     [bookmark: pgfId-1612258]This section contains the following:
 
      
      	 [bookmark: pgfId-1612262]Adding Notification Forwarding
 
      	 [bookmark: pgfId-1612266]Removing Notification Forwarding
 
     
 
    
 
     
      [bookmark: pgfId-1612268][bookmark: 86583]Adding Notification Forwarding
 
     [bookmark: pgfId-1612269]You can use Cisco Prime DCNM Web Client to add and remove notification forwarding for system messages. 
 
     [bookmark: pgfId-1612270]Cisco Prime DCNM Web Client forwards fabric events through e-mail or SNMPv1 traps. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1612271]Note Test forwarding will only work for the licensed fabrics.
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1612272]Step 1 From the menu bar, choose Admin > Events > Forwarding. 
 
     [bookmark: pgfId-1612273]Step 2 The events forwarding scope, the recipient email address, severity of the event and type of the event is displayed. The description Regex field is applicable only when the forwarding source is selected as Syslog while adding the events forwarder. 
 
     [bookmark: pgfId-1612274]Step 3 Select the Enable checkbox to enable events forwarding. 
 
     [bookmark: pgfId-1612275]Step 4 Specify the SMTP Server details and the From e-mail address. Click Apply to save the configuration or in the Apply and Test icon, use the drop-down to select the fabric and click Apply and Test to save and test the configuration. 
 
     [bookmark: pgfId-1612276]Step 5 Select the Snooze checkbox and specify the Start date and time and the End date and time. Click Apply to save the configuration.
 
     [bookmark: pgfId-1612277]Step 6 Click the Add Forwarder icon. 
 
     [bookmark: pgfId-1612278]You see the Add Notification dialog box. 
 
     [bookmark: pgfId-1612279]Step 7 In the Forwarding Method, choose either E-Mail or Trap. If you choose Trap, a Port field is added to the dialog box. 
 
     [bookmark: pgfId-1612280]Step 8 In the Address field, enter the IP address. 
 
     [bookmark: pgfId-1612281]Step 9 From the Scope drop-down list, choose the fabric or LAN group for notification. 
 
     [bookmark: pgfId-1612282]Step 10 In the Source field select DCNM or Syslog. 
 
     [bookmark: pgfId-1612283]If you select DCNM, then: 
 
     
 
     [bookmark: pgfId-1612284]Step 1 In the VSAN Scope, choose either All or List. 
 
     [bookmark: pgfId-1612285]Step 2 From the Type drop-down list, choose an event type. 
 
     [bookmark: pgfId-1612286]Step 3 Check the Storage Ports Only check box to select only the storage ports. 
 
     [bookmark: pgfId-1612287]Step 4 From the Minimum Severity drop-down list, select the severity level of the messages to receive. 
 
     [bookmark: pgfId-1612288]Step 5 Click Add to add the notification. 
 
     [bookmark: pgfId-1612289]If you select Syslog, then: 
 
     
 
     [bookmark: pgfId-1612290]Step 1 In the Facility list, select the syslog facility. 
 
     [bookmark: pgfId-1612291]Step 2 Specify the syslog Type. 
 
     [bookmark: pgfId-1612292]Step 3 In the Description Regex field, specify a description that needs to be matched with the event description. 
 
     [bookmark: pgfId-1612293]Step 4 From the Minimum Severity drop-down list, select the severity level of the messages to receive. 
 
     [bookmark: pgfId-1612294]Step 5 Click Add to add the notification. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1612295]Note The minimum Severity option is available only if the Event Type is set to All. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612296]The traps sent by Cisco Prime DCNM correspond to the severity type followed by a text description: 
 
      
      [bookmark: pgfId-1612297]trap type(s) = 40990 (emergency) 40991 (alert) 40992 (critical) 40993 (error) 40994 (warning) 40995 (notice) 40996 (info) 40997 (debug)textDescriptionOid = 1, 3, 6, 1, 4, 1, 9, 9, 40999, 1, 1, 3, 0  
     
 
    
 
     
      [bookmark: pgfId-1612299][bookmark: 96646]Removing Notification Forwarding
 
     [bookmark: pgfId-1612300]You can remove notification forwarding. 
 
     
 
     [bookmark: pgfId-1612301]Step 1 From the menu bar, choose Admin > Events > Forwarding. 
 
     [bookmark: pgfId-1612302]Step 2 Select the check box in front of the notification that you want to remove and click Remove. 
 
    
 
     
      [bookmark: pgfId-1612304]Configuring EMC CallHome
 
     [bookmark: pgfId-1612305]Cisco Prime DCNM Release 7.1.x DCNM enhances EMC call home messages. DCNM version information is displayed in with the call home message.
 
     [bookmark: pgfId-1612306]You can configure EMC Callhome from the Cisco Prime DCNM Web Client for EMC supported SAN switches. 
 
    
 
     
      [bookmark: pgfId-1612307]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1612308]Step 1 From the menu bar, choose Admin > Events > EMC CallHome.
 
     [bookmark: pgfId-1612309]Step 2 Select the Enable check box to enable this feature.
 
     [bookmark: pgfId-1612310]Step 3 Use the check box to select the fabrics.
 
     [bookmark: pgfId-1612311]Step 4 Enter the general e-mail information.
 
     [bookmark: pgfId-1612312]Step 5 Click the Apply to update the e-mail options.
 
     [bookmark: pgfId-1612313]Step 6 Click Apply and Test to update the e-mail options and test the results.
 
     [bookmark: pgfId-1612314]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1612316]Event Suppression
 
    [bookmark: pgfId-1612317]Cisco Prime DCNM allows you to suppress the specified events based on the user-specified suppressor rules. Such events will not be displayed on the Cisco Prime DCNM Web Client and SAN Client. The events will neither be persisted to DCNM database, nor forwarded via email/SNMP trap.
 
    [bookmark: pgfId-1612318]You can view, add, modify and delete suppressor rules from the table. You can create a suppressor rule from the existing event table. Select a given event as the template, and invoke the rule dialog window. Event details are automatically ported from the selected event in the event table to the input fields of the rule creation dialog window.
 
    [bookmark: pgfId-1612319]This section includes the following:
 
     
     	 [bookmark: pgfId-1612323]Add Event Suppression Rules
 
     	 [bookmark: pgfId-1612327]Delete Event Suppression Rule
 
     	 [bookmark: pgfId-1612331]Modify Event Suppression Rule
 
    
 
     
      [bookmark: pgfId-1612333][bookmark: 86180]Add Event Suppression Rules
 
     [bookmark: pgfId-1612334]To add rules to the Event Suppression, do the following tasks:
 
     
 
     [bookmark: pgfId-1612335]Step 1 From the menu bar, select Admin > Event Suppression.
 
     [bookmark: pgfId-1612336]Step 2 In the Add Event Suppressor Rule window, specify the Name for the rule.
 
     [bookmark: pgfId-1612337]Step 3 Select the required Scope for the rule based on the event source.
 
     [bookmark: pgfId-1612338]You can choose SAN, LAN, Port Groups or Any. For SAN and LAN, select the scope of the event at the Fabric or Group or Switch level. User can only select group(s) for Port Group scope. If use selects "Any" as the scope, the suppressor rule will be applied globally.
 
     [bookmark: pgfId-1612339]Step 4 Enter the Facility name or choose from the SAN/LAN Switch Event Facility List.
 
     [bookmark: pgfId-1612340]If you do not specify a facility, wild card will be applied.
 
     [bookmark: pgfId-1612341]Step 5 From the drop down list, select the Event Type.
 
     [bookmark: pgfId-1612342]If you do not specify the event type, wild card will be applied.
 
     [bookmark: pgfId-1612343]Step 6 In the Description Matching field, specify a matching string or regular expression. 
 
     [bookmark: pgfId-1612344]The rule matching engine uses regular expression supported by Java Pattern class to find a match against an event description text. 
 
     [bookmark: pgfId-1612345]Step 7 (Optional) Check the Active Between box and select a valid time range during which the event will be suppressed.
 
     [bookmark: pgfId-1612346]By default, the time range is not enabled, i.e., the rule will be always active.
 
      
       
     
 
     
 
     [bookmark: pgfId-1612347]Note In general, user should not suppress accounting events. Suppressor rule for Accounting events might be created only for certain rare situations where Accounting events are generated by actions of DCNM or switch software. For example, lots of 'sync-snmp-password' AAA syslog events are automatically generated during password synchronization between DCNM and managed switches. To suppress Accounting events, user can browse web client to Suppressor table and invoke Add Event Suppressor Rule dialog window.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1612348]Note You can go to Health > Events table of Web Client to create a suppressor rule for a known event. While there is no such shortcut to create suppressor rules for Accounting events.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612349]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612351][bookmark: 26511]Delete Event Suppression Rule
 
     [bookmark: pgfId-1612352]To delete event suppressor rules, do the following tasks:
 
     
 
     [bookmark: pgfId-1612353]Step 1 From the menu bar, select Admin > Event Suppression.
 
     [bookmark: pgfId-1612354]Step 2 Select the rule from the list and click Delete icon.
 
     [bookmark: pgfId-1612355]Step 3 Click Yes to confirm.
 
     [bookmark: pgfId-1612356]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612358][bookmark: 79558]Modify Event Suppression Rule
 
     [bookmark: pgfId-1612359]To modify the event suppressor rules, do the following tasks:
 
     
 
     [bookmark: pgfId-1612360]Step 1 From the menu bar, select Admin > Event Suppression.
 
     [bookmark: pgfId-1612361]Step 2 Select the rule from the list and click Edit icon.
 
     [bookmark: pgfId-1612362]You can edit the Facility, Type, Description Matching string, and the Valid time range.
 
     [bookmark: pgfId-1612363]Step 3 Click Apply to save the changes,
 
     [bookmark: pgfId-1612364]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1612367][bookmark: 35555]Using Cisco Prime DCNM Web Client with SSL[bookmark: marker-1612366]
 
    [bookmark: pgfId-1612369]By default, Cisco Prime DCNM Web Client uses HTTP. If you want to install [bookmark: marker-1612368]SSL certificates and use Cisco Prime DCNM Web Client over HTTPS (using [bookmark: marker-1612370]TCP port 443 or another custom port), you need a certificate for each external IP address that accepts secure connections. You can purchase these certificates from a well-known Certificate Authority ([bookmark: marker-1612371]CA).
 
    [bookmark: pgfId-1612372]To enable SSL, you must set up the keystore to use either a self-signed certificate or a certificate from a trusted third-party company such as VeriSign.
 
    [bookmark: pgfId-1612373]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1612377]Using a self signed SSL Certificate
 
     	 [bookmark: pgfId-1612381]Using a SSL Certificate when certificate request is generated using OpenSSL
 
     	 [bookmark: pgfId-1612385]Using a SSL Certificate when certificate request is generated using Keytool
 
     	 [bookmark: pgfId-1612389]SSL for Federated (High Availability) setup
 
    
 
     
      [bookmark: pgfId-1612391][bookmark: 19870]Using a self signed SSL Certificate 
 
     
 
     [bookmark: pgfId-1612392]Step 1 From command prompt, navigate to <DCNM install root>/dcm/java/jre1.7/bin/.
 
     [bookmark: pgfId-1612393]Step 2 Rename keystore located at
 
     [bookmark: pgfId-1612394]<DCNM_install_root>\dcm\jboss-as-7.2.0.Final\standalone\configuration\fmserver.jks
 
     [bookmark: pgfId-1612395]to 
 
     [bookmark: pgfId-1612396]<DCNM_install_root>\dcm\jboss-as-7.2.0.Final\standalone\configuration\fmserver.jks.old
 
     [bookmark: pgfId-1612397]Step 3 Generate a self signed certificate using following command
 
     [bookmark: pgfId-1612401]Step 5 Restart the DCNM Services.
 
     [bookmark: pgfId-1612402]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612404][bookmark: 58919]Using a SSL Certificate when certificate request is generated using OpenSSL
 
     
 
     [bookmark: pgfId-1612405]Step 1 From command prompt, navigate to <DCNM install root>/dcm/java/jre1.7/bin/
 
     [bookmark: pgfId-1612406]Step 2 Rename keystore located at
 
     [bookmark: pgfId-1612407]<DCNM_install_root>\dcm\jboss-as-7.2.0.Final\standalone\configuration\fmserver.jks 
 
     [bookmark: pgfId-1612408]to 
 
     [bookmark: pgfId-1612421]Step 6 Convert the PKCS 7 certificate chain to X509 certificate chain
 
     [bookmark: pgfId-1612432]Step 10 Restart the DCNM Services.
 
     [bookmark: pgfId-1612433]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612435][bookmark: 42531]Using a SSL Certificate when certificate request is generated using Keytool
 
     
 
     [bookmark: pgfId-1612437]Step 1 [bookmark: 58286]From command prompt, navigate to <DCNM install root>/dcm/java/jre1.7/bin/.
 
     [bookmark: pgfId-1612438]Step 2 Rename keystore located at
 
     [bookmark: pgfId-1612439]<DCNM_install_root>\dcm\jboss-as-7.2.0.Final\standalone\configuration\fmserver.jks
 
     [bookmark: pgfId-1612440]to
 
     [bookmark: pgfId-1612441]<DCNM_install_root>\dcm\jboss-as-7.2.0.Final\standalone\configuration\fmserver.jks.old
 
     [bookmark: pgfId-1612442]Step 3 Generate the public-private key pair in DCNM keystore 
 
     [bookmark: pgfId-1612459]Step 6 [bookmark: 38268]Convert the PKCS 7 certificate chain to X509 certificate chain using openssl
 
     [bookmark: pgfId-1612467]Step 9 Restart the DCNM Services.
 
     [bookmark: pgfId-1612468]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612470][bookmark: 87285]SSL for Federated (High Availability) setup
 
     
 
     [bookmark: pgfId-1612471]Step 1 Generate the SSL certificate for primary node and import all the certificates at the appropriate location as mentioned above.
 
     [bookmark: pgfId-1612472]Step 2 Copy the fmserver.jks from the primary node located at <DCNM_install_root>\dcm\jboss-as-7.2.0.Final\standalone\configuration.
 
     [bookmark: pgfId-1612473]Step 3 Paste the fmserver.jks to the secondary node located at <DCNM_install_root>\dcm\jboss-as-7.2.0.Final\standalone\configuration.
 
     [bookmark: pgfId-1612474]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1612476]Fabric—General Settings
 
     
      
    
 
    
 
    [bookmark: pgfId-1612477]Note These features appear on your Cisco Prime DCNM Web Client application only if you have deployed the DCNM installer in the Unified Fabric mode.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1612478]You can specify the general settings for the Fabric.
 
    
 
    [bookmark: pgfId-1612479]Step 1 From the menu bar, select Admin > Fabric > General Settings.
 
    [bookmark: pgfId-1612480]Step 2 Specify the Fabric settings based on the required configuration and click Apply.
 
    [bookmark: pgfId-1612481]Step 3 Click Yes to save the configuration.
 
    [bookmark: pgfId-1612482]Step 4 Click Health to view status of the Fabric components. 
 
    [bookmark: pgfId-1612483]
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-1612489]Border Leaf Settings
 
     	 [bookmark: pgfId-1612493]Border Leaf Device Pairing
 
     	 [bookmark: pgfId-1612497]Border Leaf Extended Partitions
 
     	 [bookmark: pgfId-1612501]POAP Settings
 
     	 [bookmark: pgfId-1612505]L2 Segment ID Range Management
 
     	 [bookmark: pgfId-1612509]Mobility Domains
 
    
 
   
 
    
     [bookmark: pgfId-1612512][bookmark: 96214]Border Leaf Settings
 
    [bookmark: pgfId-1612513]Border Leaf Settings allows you to globally enable Border Leaf/Edge Router auto-configuration, and specify its settings such as load balancing algorithm and redundancy factor. 
 
    [bookmark: pgfId-1612514]By default, the Border Leaf/Edge Router auto configuration is disabled. 
 
    [bookmark: pgfId-1612515]From the menu bar, select Admin > Border Leaf Settings.
 
     
     	 [bookmark: pgfId-1612519]Configuring Border Leaf Settings
 
     	 [bookmark: pgfId-1612523]Creating an Edge Router
 
     	 [bookmark: pgfId-1612527]Connect New Border leaf to the Edge Router
 
     	 [bookmark: pgfId-1612531]Deleting Edge Router/Border leaf devices
 
    
 
     
      [bookmark: pgfId-1612533][bookmark: 93637]Configuring Border Leaf Settings
 
     
 
     [bookmark: pgfId-1612534]Step 1 Check the Enable Border Leaf/Edge Router Auto-configuration to globally enable Border Leaf/Edge Router auto-configuration.
 
     [bookmark: pgfId-1612535]Step 2 Specify the autonomous system (AS) number to compose the Route Target using the BGP protocol. This AS number is the same across the fabric.
 
      
       
     
 
     
 
     [bookmark: pgfId-1612536]Note If you do not specify AS number, DCNM will be disabled.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612537]Step 3 From the Load Balancing Algorithm list, select the algorithm that must be used by DCNM to determine whether to choose border leaf based on the least load, fair share, round robin, resource consumption, speed or other criteria.
 
      
       
     
 
     
 
     [bookmark: pgfId-1612538]Note In Cisco Prime DCNM Release 7.1 (1), only Round Robin algorithm is supported.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612539]If your setup has vPC pair of border leaf, the vPC pair is chosen with priority over Round Robin. If a switch that is part of vPC pair is selected for partition (VRF) extension, DCNM will also select the vPC pair for the same partition (VRF) extension for load balancing.
 
     [bookmark: pgfId-1612540]Step 4 Specify the Redundancy Factor to ensure VRFs is extended on the specified number sets of border leaf switch.
 
      
       
     
 
     
 
     [bookmark: pgfId-1612541]Note The selected number of Border Leaf/Edge Router pairs for partition (VRF) extension also depends on the Border Leaf/Edge Router pairing topology. Therefore the number of pairs is equal to or greater than the specified redundancy factor. 
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1612544][bookmark: 59892]Border Leaf Device Pairing
 
    [bookmark: pgfId-1612545]This feature allows you to pair Border Leaf with the Edge Router and specify device associated configurations such as interface between Border Leaf and Edge Router. DCNM selects appropriate Border Leaf/Edge Router pairs during partition (VRF) extension. 
 
    [bookmark: pgfId-1612546]The following icons are listed at the menu bar of the window to customize the view of the information in the window:
 
    [bookmark: pgfId-1612618]
 
     
      
       
       [bookmark: pgfId-1612549]
 
       
       
        
        	 
          
          [bookmark: pgfId-1612553]Field 
         
  
        	 
          
          [bookmark: pgfId-1612555]Description 
         
  
       
 
        
        	[bookmark: pgfId-1612557]Edge Router/Border Leaf
  
        	[bookmark: pgfId-1612559]Specifies the Name of the Edge Router or the connected Border Leaf.
  
       
 
        
        	[bookmark: pgfId-1612561]IP Address
  
        	[bookmark: pgfId-1612563]Specifies the IP address of the Border Leaf/Edge Router.
  
       
 
        
        	[bookmark: pgfId-1612565]Interface Name/Port Channel
  
        	[bookmark: pgfId-1612567]Specify the interface name or port channel between Border Leaf and Edge Router.
  
       
 
        
        	[bookmark: pgfId-1612569]Profile Name
  
        	[bookmark: pgfId-1612571]Specifies the default profile name.
  
       
 
        
        	[bookmark: pgfId-1612573]Type
  
        	[bookmark: pgfId-1612575]Specifies if the device is an Edge Router configuration or a Border Leaf configuration.
  
       
 
        
        	[bookmark: pgfId-1612577]Partition Utilization
  
        	[bookmark: pgfId-1612579]Specifies the partitions utilized and the maximum partitions available for the device.
  
       
 
        
        	[bookmark: pgfId-1612581]Add
  
        	[bookmark: pgfId-1612583]Allows you to add a Border Leaf/Edge Router. For more information, see Creating an Edge Router.
  
       
 
        
        	[bookmark: pgfId-1612588]Edit
  
        	[bookmark: pgfId-1612590]Allows you to edit a Border Leaf/Edge Router.
  
       
 
        
        	[bookmark: pgfId-1612592]Delete
  
        	[bookmark: pgfId-1612594]Allows you to delete a Border Leaf/Edge Router. For more information, see Deleting Edge Router/Border leaf devices.
  
       
 
        
        	[bookmark: pgfId-1612599]View Profile
  
        	[bookmark: pgfId-1612601]Allows you to view the profile created
  
       
 
        
        	[bookmark: pgfId-1612603]Refresh
  
        	[bookmark: pgfId-1612605]Refreshes the list of switches.
  
       
 
        
        	[bookmark: pgfId-1612607]Show Filter
  
        	[bookmark: pgfId-1612609]Filters list of switches based on the defined value for each column.
  
       
 
        
        	[bookmark: pgfId-1612611]Print
  
        	[bookmark: pgfId-1612613]Prints the list of devices and their details.
  
       
 
        
        	[bookmark: pgfId-1612615]Export
  
        	[bookmark: pgfId-1612617]Exports the list of devices and their details to a Microsoft Excel spreadsheet.
  
       
 
       
     
 
    
 
     
     	 [bookmark: pgfId-1612622]Creating an Edge Router
 
     	 [bookmark: pgfId-1612626]Connect New Border leaf to the Edge Router
 
     	 [bookmark: pgfId-1612630]Deleting Edge Router/Border leaf devices
 
    
 
     
      [bookmark: pgfId-1612632][bookmark: 44313]Creating an Edge Router
 
     
 
     [bookmark: pgfId-1612633]Step 1 From the menu bar, select Config > Border Leaf Device Pairing.
 
     [bookmark: pgfId-1612634]Step 2 Click Add. Select Edge Router.
 
     [bookmark: pgfId-1612635]Step 3 To configure the Edge Router:
 
     [bookmark: pgfId-1612636] a. Use the radio button to select Configure an Edge Router.
 
      
       
     
 
     
 
     [bookmark: pgfId-1612637]Note The Configure an Edge Router option will be selected by default.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612638] b. Select Notify Edge Router when relevant partitions are changed to notify the Edge Router.
 
     [bookmark: pgfId-1612639] c. Select the Device Name from the drop-down list to identify an Edge Router.
 
     [bookmark: pgfId-1612640] d. Specify the IP Address for the Edge Router.
 
     [bookmark: pgfId-1612641] e. Specify the Maximum Number of Partitions required for the Edge Router.
 
     [bookmark: pgfId-1612642]Step 4 To configure a Border PE:
 
     [bookmark: pgfId-1612643] a. Use the radio button to select Configure a Border PE.
 
     [bookmark: pgfId-1612644] b. Select Notify Edge Router when relevant partitions are changed to notify the Edge Router.
 
     [bookmark: pgfId-1612645] c. Select the Device Name from the drop-down list to identify an Edge Router.
 
     [bookmark: pgfId-1612646] d. Specify the IP Address for the Edge Router.
 
     [bookmark: pgfId-1612647] e. Specify the Maximum Number of Partitions required for the Edge Router.
 
     [bookmark: pgfId-1612648] f. Define the Profile Parameters.
 
     [bookmark: pgfId-1612649] – asn—specifies the autonomous system (AS) number for the Border PE
 
     [bookmark: pgfId-1612650] – vrfSegmentId—specifies the vrf segment ID.
 
     [bookmark: pgfId-1612651] – rsvdGlobalAsn—specifies the reserved global autonomous system number.
 
     [bookmark: pgfId-1612652] – dciId—specifies the Edge Router ID for the Border PE
 
     [bookmark: pgfId-1612653] – vrfName—Specifies the vrf name
 
      
       
     
 
     
 
     [bookmark: pgfId-1612654]Note Note: The value for vrfName must be of the format 'organizationName:partitionName'.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612655]Step 5 Click OK to save the configuration.
 
    
 
     
      [bookmark: pgfId-1612657][bookmark: 68143]Connect New Border leaf to the Edge Router
 
     
 
     [bookmark: pgfId-1612658]Step 1 From the menu bar, select Config > Border Leaf Device Pairing.
 
     [bookmark: pgfId-1612659]Step 2 Click Add. Select Border Leaf.
 
     [bookmark: pgfId-1612689]Step 3 Define the parameters for the Border leaf configuration and edge router configuration for pairing.
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1612662]Field 
          
  
         	 
           
           [bookmark: pgfId-1612664]Description 
          
  
        
 
         
         	[bookmark: pgfId-1612666]Name
  
         	[bookmark: pgfId-1612668]Select the name from the drop-down list for the Border leaf.
  
        
 
         
         	[bookmark: pgfId-1612670]IP Address
  
         	[bookmark: pgfId-1612672]The IP address is auto-populated based on the selected Border Leaf.
  
        
 
         
         	[bookmark: pgfId-1612674]Port Channel or the Interface Name
  
         	[bookmark: pgfId-1612676]Specify the interface name or port channel between Border Leaf and Edge Router.
  
        
 
         
         	[bookmark: pgfId-1612678]Maximum Number of Partitions
  
         	[bookmark: pgfId-1612680]Specifies the number of partitions required for the configuration
  
        
 
         
         	[bookmark: pgfId-1612682]Default Profile Name
  
         	[bookmark: pgfId-1612684]Select the default profile name from the drop-down list to apply for the profile.
  
        
 
         
         	[bookmark: pgfId-1612686]Notify Border Leaf when relevant partitions
  
         	[bookmark: pgfId-1612688]Select to notify the Border Leaf when relevant partitions are created.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1612690]Step 4 Click OK to connect the new border leaf device to the Edge router. 
 
    
 
     
      [bookmark: pgfId-1612692][bookmark: 85638]Deleting Edge Router/Border leaf devices
 
     
 
     [bookmark: pgfId-1612693]Step 1 From the menu bar, select Config > Border Leaf Device Pairing.
 
     [bookmark: pgfId-1612694]Step 2 Select the Edge Router/Border leaf device definitions from the list and click Delete.
 
     [bookmark: pgfId-1612695]Step 3 Click Yes to confirm and delete the profile.
 
    
 
   
 
    
     [bookmark: pgfId-1612698][bookmark: 37056]Border Leaf Extended Partitions
 
    [bookmark: pgfId-1612699]This screen lists the extended partitions, selected Border Leaf/Edge Router pairs, and their corresponding profiles and configurations. From the menu bar, select Config > Extended Partitions.
 
    [bookmark: pgfId-1612700]The following icons are listed at the menu bar of the window to customize the view of the information in the window:
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1612703]Field 
         
  
        	 
          
          [bookmark: pgfId-1612705]Description 
         
  
       
 
        
        	[bookmark: pgfId-1612707]VRF
  
        	[bookmark: pgfId-1612709]Specifies the VRF name for the extended partition.
  
       
 
        
        	[bookmark: pgfId-1612711]Organization
  
        	[bookmark: pgfId-1612713]Specifies the name of organization which the extended partition belongs to.
  
       
 
        
        	[bookmark: pgfId-1612715]Partition
  
        	[bookmark: pgfId-1612717]Specifies the name of the partition that is extended.
  
       
 
        
        	[bookmark: pgfId-1612719]Redundancy Factor
  
        	[bookmark: pgfId-1612721]Specifies the run-time redundancy factor for that partition extension.
  
       
 
        
        	[bookmark: pgfId-1612723]Edge Router
  
        	[bookmark: pgfId-1612725]Specifies the name of the Edge Router.
  
       
 
        
        	[bookmark: pgfId-1612727]Edge Router IP Address
  
        	[bookmark: pgfId-1612729]Specifies the IP address of the Edge Router device.
  
       
 
        
        	[bookmark: pgfId-1612731]Edge Router Profile
  
        	[bookmark: pgfId-1612733]Specifies the default profile for the edge router.
  
       
 
        
        	[bookmark: pgfId-1612735]Border Leaf (BL)
  
        	[bookmark: pgfId-1612737]Specifies the name of the Border Leaf device
  
       
 
        
        	[bookmark: pgfId-1612739]BL IP Address
  
        	[bookmark: pgfId-1612741]Specifies the IP address of the Border Leaf device.
  
       
 
        
        	[bookmark: pgfId-1612743]BL Profile
  
        	[bookmark: pgfId-1612745]Specifies the default profile for the border leaf device.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1612748][bookmark: 43064]POAP Settings
 
    [bookmark: pgfId-1612749]This allows you to set common parameters which will be populated as default values in POAP templates. For a new POAP template, values defined in this global settings page, will be automatically pre-populated. From the menu bar, select Admin->Fabric->POAP Settings. 
 
    [bookmark: pgfId-1612799]Specify the parameters for the following fields:
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1612752]Field 
         
  
        	 
          
          [bookmark: pgfId-1612754]Description 
         
  
       
 
        
        	[bookmark: pgfId-1612756]MGMT_PREFIX
  
        	[bookmark: pgfId-1612758]Specify the Management prefix.
  
       
 
        
        	[bookmark: pgfId-1612760]DEFAULT_GATEWAY
  
        	[bookmark: pgfId-1612762]Specify the default gateway.
  
       
 
        
        	[bookmark: pgfId-1612764]MANAGEMENT_VLAN
  
        	[bookmark: pgfId-1612766]Specify the management VLAN.
  
       
 
        
        	[bookmark: pgfId-1612768]LDAP_SERVER_NAME
  
        	[bookmark: pgfId-1612770]Specify the LDAP server name.
  
       
 
        
        	[bookmark: pgfId-1612772]LDAP_SERVER_IP
  
        	[bookmark: pgfId-1612774]Specify the LDAP server IP address.
  
       
 
        
        	[bookmark: pgfId-1612776]LDAP2_SERVER_NAME
  
        	[bookmark: pgfId-1612778]Specify the secondary LDAP server name.
  
       
 
        
        	[bookmark: pgfId-1612780]LDAP2_SERVER_IP
  
        	[bookmark: pgfId-1612782]Specify the secondary LDAP server IP address.
  
       
 
        
        	[bookmark: pgfId-1612784]LDAP_USERNAME
  
        	[bookmark: pgfId-1612786]Specify the LDAP username.
  
       
 
        
        	[bookmark: pgfId-1612788]LDAP_PASSWORD
  
        	[bookmark: pgfId-1612790]Specify the LDAP password.
  
       
 
        
        	[bookmark: pgfId-1612792]XMPP_SERVER
  
        	[bookmark: pgfId-1612794]Specify the XMPP server name.
  
       
 
        
        	[bookmark: pgfId-1612796]XMPP_SERVER_IP
  
        	[bookmark: pgfId-1612798]Specify the XMPP IP address.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1612800]Step 4 Click Apply to save the POAP settings for the fabric.
 
   
 
    
     [bookmark: pgfId-1612802]Fabric Encapsulation Settings
 
    [bookmark: pgfId-1612803]To configure encapsulation settings, do the following:
 
    
 
    [bookmark: pgfId-1612804]Step 1 From the menu bar, select Admin > Fabric Encapsulation Settings.
 
    [bookmark: pgfId-1612805]Step 2 Select Enable Fabric Path Encapsulation to enable FabricPath-based Auto-Configuration on Nexus 5600, Nexus 6000 and Nexus 7000 Series devices.
 
    [bookmark: pgfId-1612806]You can choose from the combination of available leaf networks.
 
    [bookmark: pgfId-1612807]Step 3 Select Enable VxLAN Encapsulation to enable VxLAN-based Auto-Configuration on Nexus 5600, Nexus 7000 and Nexus 9000 Series devices.
 
    [bookmark: pgfId-1612808]You can choose from the combination of available leaf network in your topology. The first three options are related to “Phantom-RP with PIM BIDIR”. The second three options are related to “Anycast-RP PIM ASM/SSM”.
 
    [bookmark: pgfId-1612809] a. In the Multicast Group Subnet Range field, specify the Multicast IP Address with subnet for the multicast group.
 
    [bookmark: pgfId-1612810]This Multicast Group address range is shared between L2 and L3. This field is auto-populated from the Network page at Config > Auto-Configuration > Networks section. However, the value can be modified.
 
    [bookmark: pgfId-1612811] b. In the Number of Rendezvous Points (RPs) field, to divide the multicast group subnet into buckets, which the user can configure.
 
    [bookmark: pgfId-1612812]The valid value for RPs are 1, 2, 4, and 8.
 
    [bookmark: pgfId-1612813] c. The RPx Multicast Group Subnet field is auto-populated based on Multicast Group Subnet. “X” is the RP count.
 
    [bookmark: pgfId-1612814]This is applicable only for Phantom-RP with PIM BIDIR.
 
    [bookmark: pgfId-1612815] d. In the RPx Phantom IP Address field, enter the Phantom IP Addresses for the RPs. “X” is the RP count.
 
    [bookmark: pgfId-1612816]This is applicable only for Phantom-RP with PIM BIDIR.
 
    [bookmark: pgfId-1612817] e. In the RPx IP Address field, enter the RP IP Addresses for the RPs. “X” is the RP count.
 
    [bookmark: pgfId-1612818]This is applicable only for Anycast-RP PIM ASM/SSM.
 
    [bookmark: pgfId-1612819] f. In the Anycast IP Address field, enter the Anycast IP Address.
 
    [bookmark: pgfId-1612820]This is applicable only for Anycast-RP PIM ASM/SSM.
 
    [bookmark: pgfId-1612821]Step 4 Click Apply to save the settings.
 
    [bookmark: pgfId-1612822]This settings are used during Auto-Configuration and POAP.
 
    [bookmark: pgfId-1612823]
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1612839]Note Cisco Prime DCNM Release 7.2(2) is packaged with the following profiles:
 
     
     	 [bookmark: pgfId-1612840]VXLAN-EVPN configuration profiles for Nexus 5600, Nexus 7000, and Nexus 9000 Series Leaf Network. 
 
     	 [bookmark: pgfId-1612841]FabricPath configuration profiles for Nexus 5660, Nexus 6000, and Nexus 7000 Series Leaf Network. 
 
    
 
    [bookmark: pgfId-1612842]The universal network/partition profiles is supported for the VXLAN-EVPN-based standalone Fabric.
 
    [bookmark: pgfId-1612843]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1612846][bookmark: 98947]L2 Segment ID Range Management
 
    [bookmark: pgfId-1612847]Cisco Prime DCNM allows you to create a new Segment ID range, and map the orchestrator ID. DCNM will associate the range with the specified orchestrator ID.
 
    [bookmark: pgfId-1612848]The following icons are listed at the menu bar of the window to customize the view of the information in the window:
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1612851]Field 
         
  
        	 
          
          [bookmark: pgfId-1612853]Description 
         
  
       
 
        
        	[bookmark: pgfId-1612855]Orchestrator Name
  
        	[bookmark: pgfId-1612857]Specifies the Orchestrator name.
  
       
 
        
        	[bookmark: pgfId-1612859]Section ID Range
  
        	[bookmark: pgfId-1612861]Specifies the segment ID range for that Orchestrator.
 [bookmark: pgfId-1612862]The Segment ID range is unique for all Orchestrators. The default Segment ID range cannot be used for any orchestrator.
  
       
 
        
        	[bookmark: pgfId-1612864]Add
  
        	[bookmark: pgfId-1612866]Allows you to add a new Orchestrator.
  
       
 
        
        	[bookmark: pgfId-1612868]Edit
  
        	[bookmark: pgfId-1612870]Allows you to edit the selected Orchestrator and segment ID range.
  
       
 
        
        	[bookmark: pgfId-1612872]Delete
  
        	[bookmark: pgfId-1612874]Allows you to delete the Orchestrator.
  
       
 
        
        	[bookmark: pgfId-1612876]Refresh
  
        	[bookmark: pgfId-1612878]Refreshes the list of Orchestrators.
  
       
 
        
        	[bookmark: pgfId-1612880]Show Filter
  
        	[bookmark: pgfId-1612882]Filters list of switches based on the defined value for each column.
  
       
 
        
        	[bookmark: pgfId-1612884]Print
  
        	[bookmark: pgfId-1612886]Prints the list of Orchestrator and their details.
  
       
 
        
        	[bookmark: pgfId-1612888]Export
  
        	[bookmark: pgfId-1612890]Exports the list of Orchestrators and their details to a Microsoft Excel spreadsheet.
  
       
 
       
     
 
    
 
     
     	 [bookmark: pgfId-1612894]Add Orchestrator
 
     	 [bookmark: pgfId-1612898]Modify Orchestrator
 
     	 [bookmark: pgfId-1612902]Delete Orchestrator
 
    
 
     
      [bookmark: pgfId-1612904][bookmark: 46283]Add Orchestrator
 
     
 
     [bookmark: pgfId-1612905]Step 1 From the menu bar, select Admin > L2 Segment ID Range Management.
 
     [bookmark: pgfId-1612906]Step 2 Click Add to add a new orchestrator.
 
     [bookmark: pgfId-1612907]Step 3 In the Orchestrator Name field, specify the name for the Orchestrator.
 
     [bookmark: pgfId-1612908]Step 4 In the Segment ID Range field, specify Segment ID range to be associated with the Orchestrator.
 
     [bookmark: pgfId-1612909]By default, DCNM continues to support the default Segment ID range defined in the DCNM Admin > Fabric page.
 
    
 
     
      [bookmark: pgfId-1612911][bookmark: 24409]Modify Orchestrator
 
     
 
     [bookmark: pgfId-1612912]Step 1 From the menu bar, select Admin > L2 Segment ID Range Management.
 
     [bookmark: pgfId-1612913]Step 2 Select the orchestrator from the list and click Edit.
 
     [bookmark: pgfId-1612914]Step 3 Update and click OK to save the settings.
 
    
 
     
      [bookmark: pgfId-1612916][bookmark: 26526]Delete Orchestrator 
 
     
 
     [bookmark: pgfId-1612917]Step 1 From the menu bar, select Admin > L2 Segment ID Range Management.
 
     [bookmark: pgfId-1612918]Step 2 Select the orchestrator from the list and click Delete.
 
     [bookmark: pgfId-1612919]Step 3 Click Yes to delete the orchestrator.
 
     [bookmark: pgfId-1612920]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1612923][bookmark: 93813]Mobility Domains
 
    [bookmark: pgfId-1612924]Cisco Prime DCNM allows you to create mobility domains to configure a Mobility Doman Network. The Mobility Domains configured on this page can be used in Config > Auto-Configuration > Networks page.
 
    [bookmark: pgfId-1612925]The following icons are listed at the menu bar of the window to customize the view of the information in the window:
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1612928]Field 
         
  
        	 
          
          [bookmark: pgfId-1612930]Description 
         
  
       
 
        
        	[bookmark: pgfId-1612932]Mobility Name
  
        	[bookmark: pgfId-1612934]Specifies the name for the mobility domain.
  
       
 
        
        	[bookmark: pgfId-1612936]Detectable VLAN Range
  
        	[bookmark: pgfId-1612938]Specifies detectable VLAN range for the particular mobility domain.
  
       
 
        
        	[bookmark: pgfId-1612940]Add
  
        	[bookmark: pgfId-1612942]Allows you to add a new mobility domain.
  
       
 
        
        	[bookmark: pgfId-1612944]Edit
  
        	[bookmark: pgfId-1612946]Allows you to edit the selected mobility domain and the VLAN range.
  
       
 
        
        	[bookmark: pgfId-1612948]Delete
  
        	[bookmark: pgfId-1612950]Allows you to delete the mobility domain.
  
       
 
        
        	[bookmark: pgfId-1612952]Refresh
  
        	[bookmark: pgfId-1612954]Refreshes the list of mobility domains.
  
       
 
        
        	[bookmark: pgfId-1612956]Show Filter
  
        	[bookmark: pgfId-1612958]Filters list of domains based on the defined value for each column.
  
       
 
        
        	[bookmark: pgfId-1612960]Print
  
        	[bookmark: pgfId-1612962]Prints the list of mobility domains and VLAN range.
  
       
 
        
        	[bookmark: pgfId-1612964]Export
  
        	[bookmark: pgfId-1612966]Exports the list of mobility domains and their details to a Microsoft Excel spreadsheet.
  
       
 
       
     
 
    
 
     
     	 [bookmark: pgfId-1612970]Add Mobility Domains
 
     	 [bookmark: pgfId-1612974]Modify Mobility Domains
 
     	 [bookmark: pgfId-1612978]Delete Mobility Domains
 
    
 
     
      [bookmark: pgfId-1612980][bookmark: 44268]Add Mobility Domains
 
     
 
     [bookmark: pgfId-1612981]Step 1 From the menu bar, select Admin > Mobility Domains.
 
     [bookmark: pgfId-1612982]Step 2 Click Add to add a new mobility domain.
 
     [bookmark: pgfId-1612983]Step 3 In the Mobility Domain Name field, specify the name for the Mobility Domain.
 
     [bookmark: pgfId-1612984]Step 4 In the Detectable VLAN Range field, specify the VLAN IP address range for mobility domain.
 
     [bookmark: pgfId-1612985]Step 5 Click OK to add a mobility domain.
 
     [bookmark: pgfId-1612986]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612988][bookmark: 28561]Modify Mobility Domains
 
     
 
     [bookmark: pgfId-1612989]Step 1 From the menu bar, select Admin > Mobility Domains.
 
     [bookmark: pgfId-1612990]Step 2 Select the mobility domain from the list and click Edit.
 
     [bookmark: pgfId-1612991]Step 3 Update and click OK to save the settings.
 
     [bookmark: pgfId-1612992]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612994][bookmark: 67974]Delete Mobility Domains
 
     
 
     [bookmark: pgfId-1612995]Step 1 From the menu bar, select Admin > Mobility Domains.
 
     [bookmark: pgfId-1612996]Step 2 Select the mobility domain from the list and click Delete.
 
     [bookmark: pgfId-1612997]Step 3 Click Yes to delete the mobility domain.
 
     [bookmark: pgfId-1612998]
 
      
      
 
     
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1163974][bookmark: 883]Cisco DCNM-SAN Overview 
      
      
 
     
 
 
    [bookmark: pgfId-1163975]This chapter provides an overview of the basic Cisco DCNM-SAN components and includes the following sections: 
 
     
     	 [bookmark: pgfId-1162952]DCNM-SAN Server
 
     	 [bookmark: pgfId-1162012]Authentication in DCNM-SAN Client
 
     	 [bookmark: pgfId-1162013]DCNM-SAN Client
 
     	 [bookmark: pgfId-1162014]Device Manager
 
     	 [bookmark: pgfId-1162015]DCNM-SAN Web Client
 
     	 [bookmark: pgfId-1162016]Performance Manager
 
     	 [bookmark: pgfId-1162017]Cisco Traffic Analyzer
 
     	 [bookmark: pgfId-1163059]Network Monitoring
 
     	 [bookmark: pgfId-1163060]Performance Monitoring
 
    
 
     
      [bookmark: pgfId-1163837][bookmark: 27324]DCNM-SAN Server 
 
     [bookmark: pgfId-1163838]DCNM-SAN Server is a platform for advanced MDS monitoring, troubleshooting, and configuration capabilities. DCNM-SAN Server provides centralized MDS management services and performance monitoring. SNMP operations are used to efficiently collect fabric information. The Cisco DCNM-SAN software, including the server components, requires about 60 MB of hard disk space on your workstation. Cisco DCNM-SAN Server runs on Windows 2000, Windows 2003, Windows 2008, Windows XP, Windows 7, Solaris 9 and 10, and Red Hat Enterprise Linux AS Release 5.
 
     [bookmark: pgfId-1162303]Each computer configured as a Cisco DCNM-SAN Server can monitor multiple Fibre Channel SAN fabrics. Up to 16 clients (by default) can connect to a single Cisco DCNM-SAN Server concurrently. The Cisco DCNM-SAN Clients can also connect directly to an MDS switch in fabrics that are not monitored by a Cisco DCNM-SAN Server, which ensures that you can manage any of your MDS devices from a single console.
 
    
 
     
      [bookmark: pgfId-1162304][bookmark: 19728]DCNM-SAN Client
 
     [bookmark: pgfId-1162496]Cisco DCNM-SAN Client is a Java and SNMP-based network fabric and device management tool with a GUI that displays real-time views of your network fabric, including Cisco Nexus 5000 Series switches, Cisco MDS 9000 Family switches and third-party switches, hosts, and storage devices.
 
     [bookmark: pgfId-1162497]DCNM-SAN Client provides Fibre Channel troubleshooting tools, in addition to complete configuration and status monitoring capabilities for Cisco MDS 9000 Family switches and Cisco Nexus 5000 Series switches. You can use these health and configuration analysis tools on the MDS 9000 Family switch or Cisco Nexus 5000 Series switch to perform Fibre Channel ping and traceroute.
 
     [bookmark: pgfId-1162498]Fabric Manager Release 4.1(1b) and later releases provide a multilevel security system by adding a server admin role that allows access to limited features. The configuration capabilities of a server admin is limited to configuring FlexAttach and relevant data. Advanced mode option is available only for network administrators and provides all of the DCNM-SAN features, including security, IVR, iSCSI, and FICON. 
 
    
 
     
      [bookmark: pgfId-1162305][bookmark: 15424]Device Manager
 
     [bookmark: pgfId-1162521]Device Manager provides a graphical representation of a Cisco MDS 9000 Family switch chassis, Cisco Nexus 5000 Series switch chassis, or Cisco Nexus 7000 Series switch chassis (FCoE only) along with the installed switching modules, the supervisor modules, the status of each port within each module, the power supplies, and the fan assemblies.
 
     [bookmark: pgfId-1164351]The tables in the DCNM-SAN Information pane basically correspond to the dialog boxes that appear in Device Manager. However, while DCNM-SAN tables show values for one or more switches, a Device Manager dialog box shows values for a single switch. Device Manager also provides more detailed information for verifying or troubleshooting device-specific configuration than DCNM-SAN.
 
     [bookmark: pgfId-1162350]Device Manager provides two views: Device View and Summary View. Use Summary View to monitor interfaces on the switch. Use Device View to perform switch-level configurations including the following configurations:
 
      
      	 [bookmark: pgfId-1162536]Configuring virtual Fibre Channel interfaces
 
      	 [bookmark: pgfId-1162537]Configuring Fibre Channel over Ethernet (FCoE) features
 
      	 [bookmark: pgfId-1162538]Configuring zones for multiple VSANs
 
      	 [bookmark: pgfId-1162539]Managing ports, PortChannels, and trunking
 
      	 [bookmark: pgfId-1162540]Managing SNMPv3 security access to switches
 
      	 [bookmark: pgfId-1162541]Managing CLI security access to the switch
 
      	 [bookmark: pgfId-1162542]Managing alarms, events, and notifications
 
      	 [bookmark: pgfId-1162543]Saving and copying configuration files and software image
 
      	 [bookmark: pgfId-1162544]Viewing hardware configuration
 
      	 [bookmark: pgfId-1162530]Viewing chassis, module, port status, and statistics
 
     
 
    
 
     
      [bookmark: pgfId-1162306][bookmark: 40139]DCNM-SAN Web Client
 
     [bookmark: pgfId-1164125]With DCNM-SAN Web Client you can monitor Cisco MDS switch events, performance, and inventory from a remote location using a web browser. 
 
      
      	 [bookmark: pgfId-1162710]Performance Manager Summary reports—The Performance Manager summary report provides a high-level view of your network performance. These reports list the average and peak throughput and provides hot-links to additional performance graphs and tables with additional statistics. Both tabular and graphical reports are available for all interconnections monitored by Performance Manager. 
 
      	 [bookmark: pgfId-1163418]Performance Manager drill-down reports—Performance Manager can analyze daily, weekly, monthly and yearly trends. You can also view the results for specific time intervals using the interactive zooming functionality. These reports are only available if you create a collection using Performance Manager and start the collector.
 
      	 [bookmark: pgfId-1162681]Zero maintenance database for statistics storage—No maintenance is required to maintain Performance Manager’s round-robin database, because its size does not increase over time. At prescribed intervals the oldest samples are averaged (rolled-up) and saved. A full two days of raw samples are saved for maximum resolution. Gradually the resolution is reduced as groups of the oldest samples are rolled up together.
 
     
 
    
 
     
      [bookmark: pgfId-1162785][bookmark: 14816]Performance Manager
 
     [bookmark: pgfId-1162836]The primary purpose of DCNM-SAN is to manage the network. A key management capability is network performance monitoring. Performance Manager gathers network device statistics historically and provides this information graphically using a web browser. Performance Manager presents recent statistics in detail and older statistics in summary. Performance Manager also integrates with external tools such as Cisco Traffic Analyzer.
 
     [bookmark: pgfId-1162839]Performance Manager has three operational stages:
 
      
      	 [bookmark: pgfId-1162840]Definition—The Flow Wizard sets up flows in the switches.
 
      	 [bookmark: pgfId-1162841]Collection—The Web Server Performance Collection screen collects information on desired fabrics.
 
      	 [bookmark: pgfId-1162842]Presentation—Generates web pages to present the collected data through DCNM-SAN Web Server.
 
     
 
     [bookmark: pgfId-1162843]Performance Manager can collect statistics for ISLs, hosts, storage elements, and configured flows. Flows are defined based on a host-to-storage (or storage-to-host) link. Performance Manager gathers statistics from across the fabric based on collection configuration files. These files determine which SAN elements and SAN links Performance Manager gathers statistics for. Based on this configuration, Performance Manager communicates with the appropriate devices (switches, hosts, or storage elements) and collects the appropriate information at fixed five-minute intervals.
 
    
 
     
      [bookmark: pgfId-1164041][bookmark: 57645]Authentication in DCNM-SAN Client
 
     [bookmark: pgfId-1164038]Administrators launch DCNM-SAN Client and select the seed switch that is used to discover the fabric. The user name and password are passed to DCNM-SAN Server and are used to authenticate to the seed switch. If this user name and password are not a recognized SNMP user name and password, either DCNM-SAN Client or DCNM-SAN Server opens a CLI session to the switch (SSH or Telnet) and retries the user name and password pair. If the user name and password are recognized by the switch in either the local switch authentication database or through a remote AAA server, then the switch creates a temporary SNMP user name that is used by DCNM-SAN Client and DCNM-SAN Server.
 
    
 
     
      [bookmark: pgfId-1162787][bookmark: 57115]Cisco Traffic Analyzer
 
     [bookmark: pgfId-1163580]Cisco Traffic Analyzer provides real-time analysis of SPAN traffic or analysis of captured traffic through a Web browser user interface. Traffic encapsulated by one or more Port Analyzer Adapter products can be analyzed concurrently with a single workstation running Cisco Traffic Analyzer, which is based on ntop, a public domain software enhanced by Cisco for Fibre Channel traffic analysis.
 
     [bookmark: pgfId-1163518]Cisco Traffic Analyzer monitors round-trip response times, SCSI I/Os per second, SCSI read or traffic throughput and frame counts, SCSI session status, and management task information. Additional statistics are also available on Fibre Channel frame sizes and network management protocols.
 
    
 
     
      [bookmark: pgfId-1162309][bookmark: 81780]Network Monitoring
 
     [bookmark: pgfId-1162880]DCNM-SAN provides extensive SAN discovery, topology mapping, and information viewing capabilities. DCNM-SAN collects information on the fabric topology through SNMP queries to the switches connected to it. DCNM-SAN recreates a fabric topology, presents it in a customizable map, and provides inventory and configuration information in multiple viewing options such as fabric view, device view, summary view, and operation view.
 
     [bookmark: pgfId-1162882]Once DCNM-SAN is invoked, a SAN discovery process begins. Using information polled from a seed Cisco MDS 9000 Family switch, including Name Server registrations, Fibre Channel Generic Services (FC-GS), Fabric Shortest Path First (FSPF), and SCSI-3, DCNM-SAN automatically discovers all devices and interconnects on one or more fabrics. All available switches, host bus adapters (HBAs), and storage devices are discovered. The Cisco MDS 9000 Family switches use Fabric-Device Management Interface (FMDI) to retrieve the HBA model, serial number and firmware version, and host operating-system type and version discovery without host agents. DCNM-SAN gathers this information through SNMP queries to each switch. The device information discovered includes device names, software revision levels, vendor, ISLs, PortChannels, and VSANs.
 
    
 
     
      [bookmark: pgfId-1162301][bookmark: 34090]Performance Monitoring
 
     [bookmark: pgfId-1162892]DCNM-SAN and Device Manager provide multiple tools for monitoring the performance of the overall fabric, SAN elements, and SAN links. These tools provide real-time statistics as well as historical performance monitoring.
 
     [bookmark: pgfId-1162899]Real-time performance statistics are a useful tool in dynamic troubleshooting and fault isolation within the fabric. Real-time statistics gather data on parts of the fabric in user-configurable intervals and display these results in DCNM-SAN and Device Manager.
 
     [bookmark: pgfId-1162901]Device Manager provides an easy tool for monitoring ports on the Cisco MDS 9000 Family switches. This tool gathers statistics at a configurable interval and displays the results in tables or charts. These statistics show the performance of the selected port in real-time and can be used for performance monitoring and troubleshooting. For a selected port, you can monitor any of a number of statistics including traffic in and out, errors, class 2 traffic, and FICON data. You can set the polling interval from ten seconds to one hour, and display the results based on a number of selectable options including absolute value, value per second, and minimum or maximum value per second.
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-280582][bookmark: 1072]Configuring Cisco DCNM-SAN Server 
      
      
 
     
 
 
    [bookmark: pgfId-279660]This chapter describes Cisco DCNM-SAN Server, which is a platform for advanced MDS monitoring, troubleshooting, and configuration capabilities. No additional software needs to be installed. The server capabilities are an integral part of the Cisco DCNM-SAN software. 
 
    [bookmark: pgfId-279661]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-257606]Information About Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-270238]Licensing Requirements For Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-257614]Installing and Configuring Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-257618]Managing a Cisco DCNM-SAN Server Fabric
 
     	 [bookmark: pgfId-257626]Modifying Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-265686]Server Federation
 
     	 [bookmark: pgfId-270281]Additional References
 
    
 
    [bookmark: pgfId-286744]
 
   
 
    
     [bookmark: pgfId-265693][bookmark: 65100]Information About Cisco DCNM-SAN [bookmark: marker-265692]Server
 
    [bookmark: pgfId-257633]Install Cisco DCNM-SAN Server on a computer that you want to provide centralized MDS management services and performance monitoring. SNMP operations are used to efficiently collect fabric information. The Cisco DCNM-SAN software, including the server components, requires about 60 MB of [bookmark: marker-257634]hard disk space on your workstation. Cisco DCNM-SAN Server runs on [bookmark: marker-257635]Windows 2000, Windows 2003, Windows XP, [bookmark: marker-257636]Solaris 9 and 10, and [bookmark: marker-257637]Red Hat Enterprise Linux AS Release 5.
 
    [bookmark: pgfId-257638]Each computer configured as a Cisco DCNM-SAN Server can monitor multiple Fibre Channel SAN fabrics. Up to 16 clients (by default) can connect to a single Cisco DCNM-SAN Server concurrently. The Cisco DCNM-SAN Clients can also connect directly to an MDS switch in fabrics that are not monitored by a Cisco DCNM-SAN Server, which ensures you can manage any of your MDS devices from a single console.
 
     
      [bookmark: pgfId-257644][bookmark: 44619]DCNM-SAN Server Features[bookmark: marker-257643]
 
     [bookmark: pgfId-257200]Cisco DCNM-SAN Server has the following features:
 
      
      	 [bookmark: pgfId-257201] Multiple fabric management — DCNM-SAN Server monitors multiple physical fabrics under the same user interface. This facilitates managing redundant fabrics. A licensed DCNM-SAN Server maintains up-to-date discovery information on all configured fabrics so device status and interconnections are immediately available when you open the DCNM-SAN Client.
 
      	 [bookmark: pgfId-257204] Continuous health monitoring— MDS health is monitored continuously, so any events that occurred since the last time you opened the DCNM-SAN Client are captured.
 
      	 [bookmark: pgfId-257205] Roaming user profiles —The licensed DCNM-SAN Server uses the roaming user profile feature to store your preferences and topology map layouts on the server, so that your user interface will be consistent regardless of what computer you use to manage your storage networks.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-257206]Note You must have the same release of Cisco DCNM-SAN Client and Cisco DCNM-SAN Server.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-280018]Note You will not be able to manage a SAN fabric if the DCNM-SAN Server is going through a IP NAT firewall to access the SAN fabric. All the IP addresses that are discovered in a SAN fabric must be directly reachable by the DCNM-SAN Server.
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-270131][bookmark: 57824]Licensing Requirements For Cisco DCNM-SAN Server
 
    [bookmark: pgfId-270132]When you install DCNM-SAN, the basic unlicensed version of Cisco DCNM-SAN Server is installed with it. To get the licensed features, such as Performance Manager, remote client support, and continuously monitored fabrics, you need to buy and install the Cisco DCNM-SAN Server package.
 
    [bookmark: pgfId-301836]However, trial versions of these licensed features are available. To enable the trial version of a feature, you run the feature as you would if you had purchased the license. You see a dialog box explaining that this is a demo version of the feature and that it is enabled for a limited time.
 
     
      
    
 
    
 
    [bookmark: pgfId-301837]Note DCNM SAN allows the you to open one unlicensed fabric on the DCNM server. For OVA installation, you need an xwindow installation. To open fabrics from remote client or open more than one fabric, the fabrics have to be licensed.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-301840][bookmark: 87127]Installing and Configuring Cisco DCNM-SAN Server[bookmark: marker-301839] 
 
     
      
    
 
    
 
    [bookmark: pgfId-274276]Note Prior to running Cisco DCNM-SAN Server, you should create a special Cisco DCNM-SAN administrative user on each switch in the fabric or on a remote AAA server. Use this user to discover your fabric topology. 
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-280792]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257657]Step 1 Install Cisco DCNM-SAN Client and Cisco DCNM-SAN Server on your workstation. See the “Installing Cisco DCNM-SAN Server”.
 
     [bookmark: pgfId-257664]Step 2 [bookmark: 74149]Log in to DCNM-SAN.
 
     [bookmark: pgfId-257673]Step 3 [bookmark: 56908]Set Cisco DCNM-SAN Server to continuously monitor the fabric. See the “Managing a Cisco DCNM-SAN Server Fabric”.
 
     [bookmark: pgfId-257681]Step 4 Repeat Step 2 through Step 3 for each fabric that you want to manage through Cisco DCNM-SAN Server.
 
     [bookmark: pgfId-257684]Step 5 Install DCNM-SAN Web Server. See the “Verifying Performance Manager Collections”.
 
     [bookmark: pgfId-257688]Step 6 Verify Performance Manager is collecting data. See the “Verifying Performance Manager Collections”.
 
     [bookmark: pgfId-279716]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-257693][bookmark: 64897]Installing [bookmark: marker-257692]Cisco DCNM-SAN Server
 
     [bookmark: pgfId-275952]When you install DCNM-SAN, the basic version of the Cisco DCNM-SAN Server (unlicensed) is installed with it. After you click the DCNM-SAN icon, a dialog box opens and you can enter the IP address of a computer running the Cisco DCNM-SAN Server component. If you do not see the Cisco DCNM-SAN Server IP address text box, click Options to expand the list of configuration options. If the server component is running on your local machine, leave localhost in that field. If you try to run DCNM-SAN without specifying a valid server, you are prompted to start the Cisco DCNM-SAN Server locally.
 
     [bookmark: pgfId-257695]On a Windows PC, you install the Cisco DCNM-SAN Server as a service. This service can then be administered using Services in the Administrative Tools. The default setting for the Cisco DCNM-SAN Server service is that the server is automatically started when the Windows PC is rebooted. You can change this behavior by modifying the properties in Services.
 
     [bookmark: pgfId-267625]For switches running Cisco MDS 9000 FabricWare, you must install DCNM-SAN from the CD-ROM included with your switch, or you can download DCNM-SAN from Cisco.com.
 
      
       
     
 
     
 
     [bookmark: pgfId-267626]Note You can have only one instance of Cisco DCNM-SAN Server running on a computer. If you have a DCNM-SAN Standalone version on your computer, you may need to uninstall it before you install Cisco DCNM-SAN Server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-267627]To download the software from Cisco.com, go to the following website:
 
     [bookmark: pgfId-275996]http://cisco.com/cgi-bin/tablebuild.pl/mds-fm
 
      
       
     
 
     
 
     [bookmark: pgfId-275997]Note If you are upgrading from an earlier version to 5.0(1a) or later, that is configured with HTTPS to use your own self-provisioned or a third-party issued SSL certificate, make sure that you set the keystore password and then restart the DCNM-SAN Server. To set the keystore password, run $INSTALLDIR/dcm/fm/bin encrypter.bat ssl. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-264023]DETAILED STEPS
 
     
 
     [bookmark: pgfId-262974]Step 1 Click the Install Management Software link.
 
     [bookmark: pgfId-262975]Step 2 Choose Management Software > Cisco DCNM-SAN.
 
     [bookmark: pgfId-262976]Step 3 Click the Installing DCNM-SAN link.
 
     [bookmark: pgfId-262977]Step 4 Click the FM Installer link.
 
     [bookmark: pgfId-263044]You see the welcome message in the Cisco DCNM-SAN Installer window shown in Figure 5-1.
 
     [bookmark: pgfId-286761]Figure 5-1 [bookmark: 64895]Welcome to the Management Software Setup Wizard
 
      
      [image: ] 
     
 
     [bookmark: pgfId-263261]Step 5 Click the Custom radio button, and then click Next to begin installation. 
 
     [bookmark: pgfId-263311]Step 6 Check the I accept the terms of the License Agreement check box, and then click Next.
 
     [bookmark: pgfId-263518]You see the Install Options dialog box as shown in Figure 5-2. 
 
     [bookmark: pgfId-286778]Figure 5-2 [bookmark: 54217]Install Options Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-263520]Step 7 Click the Cisco DCNM-SAN Server (Licensed) radio button to install the server components for Cisco DCNM-SAN Server. 
 
     [bookmark: pgfId-268006]Step 8 Click Add server to an existing server federation to add the server to a federation.
 
      
       
     
 
     
 
     [bookmark: pgfId-277547]Note You may need to add the following line in the pg-hba.conf file under # IPv4 local connections in order to allow remote hosts to connect to PostgreSQL database:

host all all 0.0.0.0/0 md5

After adding, save the configuration file, restart the PostgreSQL database before you install the second server node.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-268635]Note If you are joining more then three DCNM-SAN Servers in a federation, you need to use an Oracle database with the following settings.
 
      
      
 
     
 
     
 
      
      [bookmark: pgfId-267544]C:\Documents and Settings\Administrator>sqlplus /nolog  
     
 
      
      [bookmark: pgfId-267545]SQL*Plus: Release 10.2.0.1.0 - Production on Wed Jan 6 17:19:32 2010  
     
 
      
      [bookmark: pgfId-267546]Copyright (c) 1982, 2005, Oracle. All rights reserved.  
     
 
      
      [bookmark: pgfId-267547]SQL> connect / as sysdba; 
     
 
      
      [bookmark: pgfId-267548]Connected. 
     
 
      
      [bookmark: pgfId-267549] 
     
 
      
      [bookmark: pgfId-267550]SQL> alter system set processes=150 scope=spfile;  
     
 
      
      [bookmark: pgfId-267551]System altered. 
     
 
      
      [bookmark: pgfId-267553]SQL> alter system set open_cursors=500 scope=spfile;  
     
 
      
      [bookmark: pgfId-267554]System altered. 
     
 
      
      [bookmark: pgfId-267555]  
     
 
      
      [bookmark: pgfId-267558]SQL> shutdown immediate; 
     
 
      
      [bookmark: pgfId-267559]Database closed. 
     
 
      
      [bookmark: pgfId-267560]Database dismounted. 
     
 
      
      [bookmark: pgfId-267561]ORACLE instance shut down. 
     
 
      
      [bookmark: pgfId-267562]SQL> startup; 
     
 
      
      [bookmark: pgfId-267364]ORACLE instance started. 
     
 
      
      [bookmark: pgfId-267868]Total System Global Area 805306368 bytes 
     
 
      
      [bookmark: pgfId-267869]Fixed Size 1453836 bytes 
     
 
      
      [bookmark: pgfId-267870]Variable Size 218714356 bytes 
     
 
      
      [bookmark: pgfId-267871]Database Buffers 583008256 bytes 
     
 
      
      [bookmark: pgfId-267872]Redo Buffers 2129920 bytes 
     
 
      
      [bookmark: pgfId-267873]Database mounted. 
     
 
      
      [bookmark: pgfId-267874]Database opened. 
     
 
      
      [bookmark: pgfId-267855]SQL> show parameter processes; 
     
 
      
      [bookmark: pgfId-267814] 
     
 
      
      [bookmark: pgfId-267842]Total System Global Area 805306368 bytes 
     
 
      
      [bookmark: pgfId-267815]Fixed Size 1453836 bytes 
     
 
      
      [bookmark: pgfId-267816]Variable Size 218714356 bytes 
     
 
      
      [bookmark: pgfId-267817]Database Buffers 583008256 bytes 
     
 
      
      [bookmark: pgfId-267818]Redo Buffers 2129920 bytes 
     
 
      
      [bookmark: pgfId-267819]Database mounted. 
     
 
      
      [bookmark: pgfId-267820]Database opened. 
     
 
      
      [bookmark: pgfId-267579]SQL> show parameter processes; 
     
 
      
      [bookmark: pgfId-267812] 
     
 
      
      [bookmark: pgfId-267542]NAME TYPE VALUE 
     
 
      
      [bookmark: pgfId-267365]------------------------------------ ----------- ------------------------------ 
     
 
      
      [bookmark: pgfId-267366]aq_tm_processes integer 0 
     
 
      
      [bookmark: pgfId-267367]db_writer_processes integer 4 
     
 
      
      [bookmark: pgfId-267368]gcs_server_processes integer 0 
     
 
      
      [bookmark: pgfId-267369]job_queue_processes integer 4 
     
 
      
      [bookmark: pgfId-267370]log_archive_max_processes integer 2 
     
 
      
      [bookmark: pgfId-267178]processes integer 100 
     
 
      
      [bookmark: pgfId-267433] 
     
 
     [bookmark: pgfId-263796]Step 9 Select an installation folder on your workstation for Cisco DCNM-SAN. On Windows, the default location is C:\Program Files\Cisco Systems. 
 
     [bookmark: pgfId-263923]Step 10 Click Next.
 
     [bookmark: pgfId-263927]You see the Database Options dialog box as shown in Figure 5-3. 
 
     [bookmark: pgfId-286795]Figure 5-3 [bookmark: 50705]Database Options Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-264043]
 
     [bookmark: pgfId-279728]
 
     [bookmark: pgfId-263976]Step 11 Click the radio button for either Install PostgreSQL or Use existing DB to specify which database you want to use.
 
     [bookmark: pgfId-264282]If you choose Install PostgreSQL, accept the defaults and enter a password. The PostgreSQL database will be installed.
 
      
       
     
 
     
 
     [bookmark: pgfId-264372]Note If you choose to install PostgreSQL, you must disable any security software you are running, because PostgreSQL may not install certain folders or users.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-264362]Note Before you install PostgreSQL, remove the cygwin/bin from your environment variable path if Cygwin is running on your system.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-264350]Step 12 If you select Use existing DB, click the radio button for either PostgreSQL 8.1/8.2 or Oracle10g.
 
     [bookmark: pgfId-264320]Step 13 Click Next in the Database Options dialog box.
 
     [bookmark: pgfId-264416]You see the Configuration Options dialog box as shown in Figure 5-4.
 
     [bookmark: pgfId-286812]Figure 5-4 [bookmark: 72779]Configuration Options dialog box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-264421]Step 14 Click Install to install Cisco DCNM-SAN Server.
 
     [bookmark: pgfId-263370]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-262560]If you are evaluating one of these Cisco DCNM-SAN Server features and want to stop the evaluation period for that feature, you can do that using Device Manager.
 
    
 
     
      [bookmark: pgfId-262615]Data Migration in Cisco DCNM-SAN Server
 
     [bookmark: pgfId-262616]The database migration should be limited to the existing database. Data collision can occur when you merge the data between the several databases.
 
     [bookmark: pgfId-262564]When you upgrade a non federation mode database to a federation mode database for the first time, the cluster sequence table is filled with the values larger than the corresponding ones in the sequence table and conforming to the cluster sequence number format for that server ID.
 
    
 
     
      [bookmark: pgfId-262569][bookmark: 42737][bookmark: 60758][bookmark: 88287]Verifying Performance [bookmark: marker-262568]Manager Collections
 
     [bookmark: pgfId-257718]Once Performance Manager collections have been running for five or more minutes, you can verify that the collections are gathering data by choosing Performance Manager > Reports in DCNM-SAN. You see the first few data points gathered in the graphs and tables.
 
    
 
   
 
    
     [bookmark: pgfId-257725][bookmark: 72565][bookmark: 55042]Managing a Cisco DCNM-SAN Server Fabric
 
    [bookmark: pgfId-257727]You can continuously[bookmark: marker-257726] manage a Cisco DCNM-SAN Server fabric, whether or not a client has that fabric open. A continuously managed fabric is automatically reloaded and managed by Cisco DCNM-SAN Server whenever the server starts.
 
     
      [bookmark: pgfId-280903][bookmark: 99610]Selecting a Fabric to Manage Continuously
 
    
 
     
      [bookmark: pgfId-280904]DETAILED STEPS
 
     
 
     [bookmark: pgfId-280905]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-280907]You see the Control Panel dialog box with the Fabrics tab open as shown in Figure 5-5.
 
      
       
     
 
     
 
     [bookmark: pgfId-257292]Note The Fabrics tab is only accessible to network administrators.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-286826]Figure 5-5 [bookmark: 22350]Fabrics Tab in Control Panel Dialog Box
 
     [bookmark: pgfId-286830]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-257299]Note You can preconfigure a user name and password to manage fabrics. In this instance, you should use a local switch account, not a TACACS+ server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-257300]Step 2 Choose one of the following Admin options:
 
     [bookmark: pgfId-257301] a. Manage Continuously—The fabric is automatically managed when Cisco DCNM-SAN Server starts and continues to be managed until this option is changed to Unmanage.
 
     [bookmark: pgfId-257302] b. Manage—The fabric is managed by Cisco DCNM-SAN Server until there are no instances of DCNM-SAN viewing the fabric.
 
     [bookmark: pgfId-257303] c. Unmanage—Cisco DCNM-SAN Server stops managing this fabric.
 
     [bookmark: pgfId-257304]Step 3 Click Apply.
 
     [bookmark: pgfId-257305]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-274325]Note If you are collecting data on these fabrics using Performance Manager, you should now configure flows and define the data collections.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-274331][bookmark: 24097]Cisco DCNM-SAN Server Properties File[bookmark: marker-274330]
 
     [bookmark: pgfId-257760]The Cisco DCNM-SAN Server properties file (MDS 9000\server.properties) contains a list of properties that determine how the Cisco DCNM-SAN Server will function. You can edit this file with a text editor, or you can set the properties through the DCNM-SAN Web Services GUI, under the Admin tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-257761]Note As of Cisco NX-OS Release 4.1(1b) and later, you can optionally encrypt the password in the server.properties and the AAA.properties files.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-257762]The server properties file contains these nine general sections:
 
      
      	 [bookmark: pgfId-257763] GENERAL —Contains the general settings for the server.
 
      	 [bookmark: pgfId-257764] SNMP SPECIFIC —Contains the settings for SNMP requests, responses, and traps.
 
      	 [bookmark: pgfId-257765] SNMP PROXY SERVER SPECIFIC —Contains the settings for SNMP proxy server configuration and TCP port designation.
 
      	 [bookmark: pgfId-257766] GLOBAL FABRIC —Contains the settings for fabrics, such as discovery and loading.
 
      	 [bookmark: pgfId-257767] CLIENT SESSION —Contains the settings for DCNM-SAN Clients that can log into the server.
 
      	 [bookmark: pgfId-257768] EVENTS —Contains the settings for syslog messages.
 
      	 [bookmark: pgfId-257769]PERFORMANCE CHART—Contains the settings for defining the end time to generate a Performance Manager chart.
 
      	 [bookmark: pgfId-257770]EMC CALL HOME—Contains the settings for the forwarding of traps as XML data using e-mail, according to EMC specifications.
 
      	 [bookmark: pgfId-257771]EVENT FORWARD SETUP—Contains the settings for forwarding events logged by Cisco DCNM-SAN Server through e-mail.
 
     
 
     [bookmark: pgfId-257772]The following server properties are added or changed in the Cisco DCNM-SAN Release 3.x and later.
 
     [bookmark: pgfId-257773]SNMP Specific
 
      
      	 [bookmark: pgfId-257774] snmp.preferTCP —If this option is set to true, TCP is the default protocol for Cisco DCNM-SAN Server to communicate with switches. By default, this setting is  true . For those switches that do not have TCP enabled, Cisco DCNM-SAN Server uses UDP. The advantage of this setting is the ability to designate one TCP session for each SNMP user on a switch. It also helps to reduce timeouts and increase scalability.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-259206]Note If you set this option to false, the same choice must be set in DCNM-SAN. The default value of snmp.preferTCP for DCNM-SAN is true.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-259207]Performance Chart
 
      
      	 [bookmark: pgfId-257777] pmchart.currenttime —Specifies the end time to generate a Performance Manager chart. This should only be used for debugging purposes.
 
     
 
     [bookmark: pgfId-257778]EMC Call Home
 
      
      	 [bookmark: pgfId-257779] server.callhome.enable —Enables or disables EMC Call Home. By default, it is disabled.
 
      	 [bookmark: pgfId-257780] server.callhome.location —Specifies the Location parameter.
 
      	 [bookmark: pgfId-257781] server.callhome.fromEmail —Specifies the From Email list. 
 
      	 [bookmark: pgfId-257782] server.callhome.recipientEmail —Specifies the recipientEmail list.
 
      	 [bookmark: pgfId-257783] server.callhome.smtphost —Specifies the SMTP host address for outbound e-mail.
 
      	 [bookmark: pgfId-257784] server.callhome.xmlDir —Specifies the path to store the XML message files.
 
      	 [bookmark: pgfId-257785] server.callhome.connectType —Specifies the method to use to remotely connect to the server.
 
      	 [bookmark: pgfId-257786] server.callhome.accessType —Specifies the method to use to establish remote communication with the server.
 
      	 [bookmark: pgfId-257787] server.callhome.version —Specifies the version number of the connection type.
 
      	 [bookmark: pgfId-257788] server.callhome.routerIp —Specifies the public IP address of the RSC router.
 
     
 
     [bookmark: pgfId-257789]Event Forwarding
 
      
      	 [bookmark: pgfId-257790] server.forward.event.enable —Enables or disables event forwarding.
 
      	 [bookmark: pgfId-257791] server.forward.email.fromAddress —Specifies the From Email list.
 
      	 [bookmark: pgfId-257792] server.forward.email.mailCC —Specifies the CC Email list.
 
      	 [bookmark: pgfId-257793]server.forward.email.mailBCC—Specifies the BCC Email list.
 
      	 [bookmark: pgfId-257794] server.forward.email.smtphost —Specifies the SMTP host address for outbound e-mail.
 
     
 
     [bookmark: pgfId-258854]Deactivation
 
      
      	 [bookmark: pgfId-258871] deactivate.confirm=deactivate —Specific Request for User to type a String for deactivation. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-264867]Note In a federated server environment, you should not change Cisco DCNM-SAN Server properties by modifying server.properties file. You must modify the server.properties using web client menu Admin > Configure > Preferences.
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-271024][bookmark: 28887]Modifying Cisco DCNM-SAN Server
 
    [bookmark: pgfId-271026]Fabric Manager Release 2.1(2) or later allows you to [bookmark: marker-271025]modify certain Cisco DCNM-SAN Server settings without stopping and starting the server. 
 
     
     	 [bookmark: pgfId-257806]Changing the Cisco DCNM-SAN Server Username and Password
 
     	 [bookmark: pgfId-265091]Changing the Cisco DCNM-SAN Server Username and Password
 
     	 [bookmark: pgfId-280516]Changing the DCNM-SAN Server Fabric Discovery Username and Password
 
     	 [bookmark: pgfId-284121]Changing the Polling Period and Fabric Rediscovery Time
 
     	 [bookmark: pgfId-284083]Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS WINDOWS Server
 
     	 [bookmark: pgfId-284420]Changing the IP Address of the Cisco DCNM-SAN for Federated Windows Setup
 
     	 [bookmark: pgfId-284085]Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS LINUX Server
 
     	 [bookmark: pgfId-265097]Using Device Aliases or FC Aliases
 
    
 
     
      [bookmark: pgfId-257464][bookmark: 76467][bookmark: 77508][bookmark: 11389]Changing the Cisco DCNM-SAN Server Username and Password
 
     [bookmark: pgfId-257466]You can modify the username or password[bookmark: marker-257465] used to access a fabric from DCNM-SAN Client without restarting Cisco DCNM-SAN Server.
 
    
 
     
      [bookmark: pgfId-257467]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257468]Step 1 Choose Server > Admin. 
 
     [bookmark: pgfId-257847]You see the Control Panel dialog box with the Fabrics tab open as shown in Figure 5-5.
 
     [bookmark: pgfId-257473]Step 2 Set the Name or Password for each fabric that you are monitoring with Cisco DCNM-SAN Server. 
 
     [bookmark: pgfId-257474]Step 3 Click Apply to save these changes.
 
     [bookmark: pgfId-280156]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-280326][bookmark: 32129]Changing the DCNM-SAN Server Fabric Discovery Username and Password
 
    
 
     
      [bookmark: pgfId-280399]DETAILED STEPS
 
     
 
     [bookmark: pgfId-280427]Step 1 Click Server > Admin in Cisco DCNM-SAN.
 
     [bookmark: pgfId-280428]You see the Control Panel dialog box with the Fabrics tab open (see Figure 5-6). 
 
     [bookmark: pgfId-286852]Figure 5-6 [bookmark: 76727]Fabrics Tab in Control Panel Dialog Box
 
     [bookmark: pgfId-286856]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-280438]Step 2 Click the fabrics that have updated user name and password information.
 
     [bookmark: pgfId-280440]Step 3 [bookmark: 66295]From the Admin listbox, select Unmanage and then click Apply.
 
     [bookmark: pgfId-280442]Step 4 [bookmark: 50160]Enter the appropriate user name and password and then click Apply.
 
     [bookmark: pgfId-280422]For more information, see the ““Performance Manager Authentication” section”.
 
     [bookmark: pgfId-280492]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-257478][bookmark: 93493][bookmark: 20202]Changing the [bookmark: marker-257477]Polling Period and Fabric Rediscovery Time
 
     [bookmark: pgfId-257479]Cisco DCNM-SAN Server periodically polls the monitored fabrics and periodically rediscovers the full fabric at a default interval of five cycles.You can modify these settings from DCNM-SAN Client without restarting Cisco DCNM-SAN Server.
 
    
 
     
      [bookmark: pgfId-257481]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257482]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-257855]You see the Control Panel dialog box with the Fabrics tab open as shown in Figure 5-5.
 
     [bookmark: pgfId-257487]Step 2 For each fabric that you are monitoring with Cisco DCNM-SAN Server, set the Polling Interval to determine how frequently Cisco DCNM-SAN Server polls the fabric elements for status and statistics.
 
     [bookmark: pgfId-257488]Step 3 For each fabric that you are monitoring with Cisco DCNM-SAN Server, set the Rediscover Cycles to determine how often Cisco DCNM-SAN Server rediscovers the full fabric.
 
     [bookmark: pgfId-270462]Step 4 Click Apply to save these changes.
 
     [bookmark: pgfId-270463]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-283980][bookmark: 19615]Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS WINDOWS Server
 
     [bookmark: pgfId-283981]To change the IP address of a Cisco DCNM-SAN & DCNM-SMIS Server, follow these steps:
 
      
       
     
 
     
 
     [bookmark: pgfId-283984]Note To change the IP Address of a Cisco DCNM-LAN Server, see Changing the IP Address of the Cisco DCNM-LAN for WINDOWS OS.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-283986]Detailed Steps
 
     
 
     [bookmark: pgfId-283987]Step 1 Stop the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-283988]Step 2 Change the old IP Address with the new IP Address in the following files
 
      
      	 [bookmark: pgfId-283989] $INSTALLDIR\jboss-as-7.2.0.Final\bin\service\sanservice.bat 
 
      	 [bookmark: pgfId-283990] $INSTALLDIR\jboss-as-7.2.0.Final\standalone\configuration\standalone-san.xml(Including DB url) 
 
      	 [bookmark: pgfId-283991] $INSTALLDIR\fm\conf\server.properties 
 
     
 
     [bookmark: pgfId-283992]Step 3 Enter the following command to assign a new IP address.
 
      
      [bookmark: pgfId-283993]run $INSTALLDIR\fm\bin\PLMapping.bat -p newipaddress 0 
     
 
      
      [bookmark: pgfId-283994] 
     
 
     [bookmark: pgfId-283995]Assume $INSTALLDIR is the top directory of DCNM installation. The above command is for single server instance, where 0 is the server ID.
 
     [bookmark: pgfId-283996]Step 4 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\smis.properties
 
     [bookmark: pgfId-283997]Step 5 Start the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-283998]
 
      
      
 
     
  
     
 
    
 
     
      [bookmark: pgfId-284423][bookmark: 79092]Changing the IP Address of the Cisco DCNM-SAN for Federated Windows Setup
 
     [bookmark: pgfId-284526]To change the IP address of a Cisco DCNM-SAN for federated Windows OS, follow these steps:
 
      
      	 [bookmark: pgfId-284657]Changing the IP address of primary server
 
      	 [bookmark: pgfId-284764]Changing the IP address of secondary server
 
     
 
    
 
     
      [bookmark: pgfId-284596][bookmark: 93031]Changing the IP address of primary server
 
     
 
     [bookmark: pgfId-284830]Step 1 Stop the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-284931]Step 2 Change the old IP Address with the new IP Address in the file $INSTALLDIR\jboss-as-7.2.0.Final\bin\service\sanservice.bat
 
     [bookmark: pgfId-284932]Step 3 Change the old IP Address with the new IP Address in the file $INSTALLDIR\jboss-as-7.2.0.Final\standalone\configuration\standalone-san.xml.
 
     [bookmark: pgfId-284933]Step 4 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\server.properties
 
      
       
     
 
     
 
     [bookmark: pgfId-284934]Note If DB is installed locally(URL pointing to LocalHost),No DB URL change required in standalone-san.xml , server.properties .
 
      
      
 
     
 
     
 
     [bookmark: pgfId-284935]Step 5 Enter the following command to assign a new IP address.
 
     [bookmark: pgfId-284936]run $INSTALLDIR\fm\bin\PLMapping.bat -p newipaddress 0
 
     [bookmark: pgfId-285072]Assume $INSTALLDIR is the top directory of DCNM installation. The above command is for primary server instance, where 0 is the server ID.
 
     [bookmark: pgfId-284938]Step 6 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\smis.properties
 
     [bookmark: pgfId-284939]Step 7 Start the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-284689]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-284732][bookmark: 71439]Changing the IP address of secondary server
 
     
 
     [bookmark: pgfId-284734]Step 1 Stop the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-285197]Step 2 Change the old IP Address with the new IP Address in the file $INSTALLDIR\jboss-as-7.2.0.Final\bin\service\sanservice.bat
 
     [bookmark: pgfId-285198]Step 3 Change the old IP Address with the new IP Address in the file $INSTALLDIR\jboss-as-7.2.0.Final\standalone\configuration\standalone-san.xml
 
     [bookmark: pgfId-285199]Step 4 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\server.properties.
 
     [bookmark: pgfId-285200]Step 5 Change DB URL in standalone-san.xml, server.properties, postgresql.cfg.xml\ oracle.cfg.xml files, if there is ipaddress change in primary server.
 
     [bookmark: pgfId-285201]postgresql.cfg.xml\ oracle.cfg.xml can be found under $INSTALLDIR\jboss-as-7.2.0.Final\standalone\ conf\ directory.
 
     [bookmark: pgfId-285202]Step 6 Enter the following command to assign a new IP address.
 
     [bookmark: pgfId-285203] run $INSTALLDIR\fm\bin\PLMapping.bat -p newipaddress 1 .
 
      
       
     
 
     
 
     [bookmark: pgfId-285204]Note ServerID can be got by run $INSTALLDIR\fm\bin\PLMapping.bat -show.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-285205]Assume $INSTALLDIR is the top directory of DCNM installation. The above command 1 is the server ID.
 
     [bookmark: pgfId-285206]Step 7 Change the old IP Address with the new IP Address in the file $INSTALLDIR\fm\conf\smis.properties
 
     [bookmark: pgfId-285207]Step 8 Start the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-284737]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-284000][bookmark: 83394]Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS LINUX Server
 
     [bookmark: pgfId-284001]To change the IP address of a Cisco DCNM-SAN & DCNM-SMIS Server, follow these steps:
 
      
       
     
 
     
 
     [bookmark: pgfId-284004]Note To change the IP Address of a Cisco DCNM-LAN Server, see Changing the IP Address of the Cisco DCNM-LAN on Linux OS.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-284006]Detailed Steps
 
     
 
     [bookmark: pgfId-284007]Step 1 Stop the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-284008]Step 2 Change the old IP Address with the new IP Address in the following files:
 
      
      	 [bookmark: pgfId-284009] $INSTALLDIR/jboss-as-7.2.0.Final/bin/init.d/sanservice.sh 
 
      	 [bookmark: pgfId-284010] /etc/init.d/FMServer 
 
      	 [bookmark: pgfId-284011] $INSTALLDIR/jboss-as-7.2.0.Final/standalone/configuration/standalone-san.xml (Including DB url) 
 
      	 [bookmark: pgfId-284012] $INSTALLDIR/fm/conf/server.properties 
 
     
 
     [bookmark: pgfId-284013]Step 3 Enter the following command to assign a new IP address.
 
      
      [bookmark: pgfId-284014]run $INSTALLDIR/fm/bin/PLMapping.bat -p newipaddress 0 
     
 
      
      [bookmark: pgfId-284015] 
     
 
     [bookmark: pgfId-284016]Assume $INSTALLDIR is the top directory of DCNM installation. The above command is for single server instance, where 0 is the server ID. 
 
     [bookmark: pgfId-284017]Step 4 Change the old IP Address with the new IP Address in the file $INSTALLDIR/fm/conf/smis.properties.
 
      
       
     
 
     
 
     [bookmark: pgfId-298320]Note If this is a DCNM virtual appliance (OVA/ISO) deployed without any Fabric enhancements, update the property DCNM_IP_ADDRESS in the file /root/packaged-files/properties/installer.properties with the new IP Address.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-284018]Step 5 Start the Cisco DCNM-SAN and DCNM-SMIS Servers.
 
     [bookmark: pgfId-283969]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-270466][bookmark: 10470]Using Device [bookmark: marker-270465]Aliases or FC Aliases
 
     [bookmark: pgfId-257494]You can change whether DCNM-SAN uses FC aliases or global device aliases[bookmark: marker-257493] from DCNM-SAN Client without restarting Cisco DCNM-SAN Server.
 
    
 
     
      [bookmark: pgfId-257495]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257496]Step 1 Choose Server > Admin. 
 
     [bookmark: pgfId-257863]You see the Control Panel dialog box with the Fabrics tab open as shown in Figure 5-5.
 
     [bookmark: pgfId-257501]Step 2 For each fabric that you are monitoring with Cisco DCNM-SAN Server, check or uncheckthe FC Alias check box.
 
     [bookmark: pgfId-282822]If you check the FC Alias checkbox, DCNM-SAN will use FC Alias from DCNM-SAN Client. If you uncheck the FC Alias checkbox, DCNM-SAN will use global device alias from DCNM-SAN Client.
 
     [bookmark: pgfId-257502]Step 3 Click Apply to save these changes.
 
     [bookmark: pgfId-259310]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-286877]Configuring Security Manager
 
    [bookmark: pgfId-286878]The security at Fabric Manager Server level control access to different features of the Fabric Manager. The existing security controls in the Fabric Manager allows a user to continue even after many unsuccessful login attempts. With the new security manager, the Fabric Manager will perform a lock-out for the specific user after a specified number of unsuccessful login attempts. System administrators will be able to generate a report of login attempts.
 
    [bookmark: pgfId-286879]To see the number of failed login attempts, follow these steps:
 
    
 
    [bookmark: pgfId-286880]Step 1 In the Fabric Manager Control Panel, click Local FM Users.
 
    [bookmark: pgfId-286884]You see the control panel as show in Figure 5-7
 
    [bookmark: pgfId-286888]Figure 5-7 [bookmark: 34676]Number 
 
     
     [image: ] 
    
 
    [bookmark: pgfId-286889]Step 2 
 
    [bookmark: pgfId-286890]Step 3 
 
   
 
    
     [bookmark: pgfId-224899][bookmark: 41089]Server Federation
 
    [bookmark: pgfId-261692]Server Federation is a distributed system that includes a collection of intercommunicated servers or computers that is utilized as a single, unified computing resource. With Cisco DCNM-SAN Server Federation, you can communicate with multiple servers together in order to provide scalability and easy manageability of data and programs running within the federation. The core of server federation includes several functional units such as Cisco DCNM-SAN Server, embedded web servers, database and DCNM-SAN Client that accesses the servers. 
 
    [bookmark: pgfId-261701]The Cisco DCNM-SAN Server in the federation uses the same database to store and retrieve data. The database is shared among different servers to share common information. A DCNM-SAN Client or DCNM-SAN Web Client can open fabrics from the Cisco DCNM-SAN Server using the mapping table. A fabric can be moved from one logical server to another. A logical server also can be moved from one physical machine to another machine.
 
     
      [bookmark: pgfId-270247]Restrictions
 
      
      	 [bookmark: pgfId-264946]You cannot upgrade more than one Cisco DCNM-SAN Server in an existing federation. If you choose to do so, you may not be able to migrate the Performance Manager statistics and other information on that server. 
 
      	 [bookmark: pgfId-265033]You may require to synchronize the time on all the DCNM-SAN Servers in a federated server environment. 
 
     
 
    
 
     
      [bookmark: pgfId-261708]Mapping Fabric ID to Server ID
 
     [bookmark: pgfId-261722]The IP address of the physical server will be mapped to the server ID during the installation of the Cisco DCNM-SAN Server whenever the IP address of the physical server is changed, you need to map the IP address to the server ID using the PLMapping script provided with the Cisco DCNM-SAN Server. Whenever the you open or discover a fabric, the fabric ID will be mapped to the server ID . You can move a fabric to a different server ID using the control panel. 
 
    
 
     
      [bookmark: pgfId-261747]DETAILED STEPS
 
     
 
     [bookmark: pgfId-261812]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-261836]You see the Control Panel as shown in Figure 5-8.
 
     [bookmark: pgfId-286907]Figure 5-8 [bookmark: 19704]Control Panel
 
      
      [image: ] 
     
 
     [bookmark: pgfId-261838]Step 2 Select the fabric that you want to move to a different server and then click Move.
 
     [bookmark: pgfId-261861]You see the Move Fabric dialog box as shown in Figure 5-9.
 
     [bookmark: pgfId-286924]Figure 5-9 [bookmark: 95855]Move Fabric Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-261857]Step 3 You see the fabrics that you selected in the Fabrics to Move list box. From the Move To Server drop-down list select the server you want to move the fabric to. 
 
     [bookmark: pgfId-261930]Step 4 Click Move.
 
     [bookmark: pgfId-261937]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-261709]Opening the Fabric on a Different Server
 
    
 
     
      [bookmark: pgfId-261957]DETAILED STEPS
 
     
 
     [bookmark: pgfId-261967]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-261965]You see the Control Panel as shown in Figure 5-10.
 
     [bookmark: pgfId-286941]Figure 5-10 [bookmark: 82166]Control Panel
 
      
      [image: ] 
     
 
     [bookmark: pgfId-279746]
 
     [bookmark: pgfId-264931]Step 2 Click Discover.
 
     [bookmark: pgfId-261996]You see the Discover New Fabric dialog box as shown in Figure 5-11.
 
     [bookmark: pgfId-286958]Figure 5-11 [bookmark: 60035]Discover new Fabric
 
      
      [image: ] 
     
 
     [bookmark: pgfId-264939]Step 3 In the Seed Switch list box, enter the IP Address of the seed switch.
 
     [bookmark: pgfId-264940]Step 4 In the User Name field, enter the username.
 
     [bookmark: pgfId-264941]Step 5 In the password field, enter the password. 
 
     [bookmark: pgfId-261997]Step 6 From the Auth-Privacy drop-down list, choose the privacy protocol you want to apply.
 
     [bookmark: pgfId-264945]Step 7 To open the selected fabric in a different server, select the server ID from the Server drop-down list.
 
     [bookmark: pgfId-262057]Step 8 Click Discover. 
 
      
       
     
 
     
 
     [bookmark: pgfId-264964]Note You may receive an error message when you discover a fabric in a federation while another Cisco DCNM-SAN Server is joining the federation. You can discover the fabric on after the installation or upgradation is complete.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-281235]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-261707]Viewing the Sessions in a Federation
 
    
 
     
      [bookmark: pgfId-262078]DETAILED STEPS
 
     
 
     [bookmark: pgfId-262085]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-262095]Step 2 Click the Connected Clients tab.
 
     [bookmark: pgfId-281260]You see the Control Panel as shown inFigure 5-12.
 
     [bookmark: pgfId-286975]Figure 5-12 [bookmark: 14179]Connected Clients
 
      
      [image: ] 
     
 
     [bookmark: pgfId-286976]
 
    
 
     
      [bookmark: pgfId-281256]Viewing the Servers in a Federation
 
    
 
     
      [bookmark: pgfId-262136]DETAILED STEPS
 
     
 
     [bookmark: pgfId-262137]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-262138]Step 2 Click the Servers tab.
 
     [bookmark: pgfId-283428]You see the Control Panel as shown in Figure 5-13.
 
    
 
     
      [bookmark: pgfId-283437]Discover Devices Managed by SVI
 
     
 
     [bookmark: pgfId-283505]Step 1 Log on to the DCNM Web Client.
 
     [bookmark: pgfId-283506]Step 2 Select Admin>Server Properties.
 
     [bookmark: pgfId-283507]Step 3 Scroll down to the GENERAL->DATA SOURCE FABRIC section.
 
     [bookmark: pgfId-283508]Step 4 Set the fabric.managementIpOverwrite property to false.
 
     [bookmark: pgfId-283509]Step 5 Click Apply.
 
     [bookmark: pgfId-283510]Step 6 Restart the DCNM service.
 
      
       
     
 
     
 
     [bookmark: pgfId-283511]Note If you experiences technical issues using DCNM, you must restart the database service manually.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-283512]Step 7 Delete any previously discovered switch that incorrectly shows the mgmt0 IP address.
 
     [bookmark: pgfId-283499]Step 8 Retry the discovery. 
 
      
       
     
 
     
 
     [bookmark: pgfId-283680]Note Each SVI switch must be discovered separately.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-286993]Figure 5-13 [bookmark: 41955]Servers
 
      
      [image: ] 
     
 
    
 
   
 
    
     [bookmark: pgfId-283431][bookmark: 14554]Additional References
 
     
     	 [bookmark: pgfId-283432]Server Federation is a licensed feature. For more information on Cisco DCNM-SAN Server Licensing, see Cisco MDS 9000 Family NX-OS Licensing Guide.
 
     	 [bookmark: pgfId-270275]For more information on deploying Cisco DCNM-SAN Server in a federation, see Cisco Fabric Manager Server Federation Deployment Guide.
 
    
 
    [bookmark: pgfId-270269]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-226803]Configuring [bookmark: 1072]Authentication in Cisco DCNM-SAN 
      
      
 
     
 
 
    [bookmark: pgfId-226804]This chapter describes the interdependent software components in Cisco DCNM-SAN that communicate with the switches, authentication steps and the best practices for setting up your fabric and components for authentication.
 
    [bookmark: pgfId-226805]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-226809]Information About Cisco DCNM-SAN Authentication
 
     	 [bookmark: pgfId-226813]Best Practices for Discovering a Fabric
 
     	 [bookmark: pgfId-226817]Performance Manager Authentication
 
     	 [bookmark: pgfId-226821]Cisco DCNM-SAN Web Client Authentication
 
    
 
   
 
    
     [bookmark: pgfId-226827][bookmark: 65100]Information About Cisco DCNM-SAN [bookmark: marker-226826]Authentication
 
    [bookmark: pgfId-226829]Cisco DCNM-SAN contains multiple components that interact to manage a fabric. 
 
    [bookmark: pgfId-226830]These components include:
 
     
     	 [bookmark: pgfId-226831]Cisco DCNM-SAN Client
 
     	 [bookmark: pgfId-226832]Cisco DCNM-SAN Server
 
     	 [bookmark: pgfId-226833]Performance Manager
 
     	 [bookmark: pgfId-226834]Interconnected fabric of Cisco MDS 9000 switches and storage devices
 
     	 [bookmark: pgfId-226835]AAA server (optional)
 
    
 
    [bookmark: pgfId-236860]Figure 6-1 shows an example configuration for these components.
 
    [bookmark: pgfId-236863]Figure 6-1 [bookmark: 33746]Cisco DCNM-SAN Authentication[bookmark: marker-236862] Example
 
    [bookmark: pgfId-236867]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-226849]Administrators launch Cisco DCNM-SAN Client and select the seed switch that is used to discover the fabric. The user name and password used are passed to Cisco DCNM-SAN Server and used to authenticate to the seed switch. If this user name and password are not a recognized SNMP user name and password, either Cisco DCNM-SAN Client or Cisco DCNM-SAN Server opens a CLI session to the switch (SSH or Telnet) and retries the user name and password pair. If the user name and password are recognized by the switch in either the local switch authentication database or through a remote AAA server, then the switch creates a temporary SNMP user name that is used by Cisco DCNM-SAN Client and server.
 
     
      
    
 
    
 
    [bookmark: pgfId-226851]Note You may encounter a delay in authentication if you use a [bookmark: marker-226850]remote AAA server to authenticate Cisco DCNM-SAN or Device Manager.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-226853]Note You must allow CLI sessions to pass through any [bookmark: marker-226852]firewall that exists between Cisco DCNM-SAN Client and Cisco DCNM-SAN Server. 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-244797]Note We recommend that you use the same password for the SNMPv3 user name authentication and privacy passwords as well as the matching CLI user name and password.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-244801][bookmark: 44619]Best Practices for [bookmark: marker-244800]Discovering a Fabric
 
    [bookmark: pgfId-226864]Cisco DCNM-SAN Server monitors multiple physical fabrics under the same user interface. This facilitates managing redundant fabrics. A licensed Cisco DCNM-SAN Server maintains up-to-date discovery information on all configured fabrics so device status and interconnections are immediately available when you launch Cisco DCNM-SAN Client.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-226865] 
     Caution If the Cisco DCNM-SAN Server’s CPU usage exceeds 50 percent, it is recommended that you switch to a higher CPU-class system. 
      
      
 
     
 
    
 
    [bookmark: pgfId-226869]We recommend that you use these best practices for discovering your network and setting up Performance Manager. This ensures that Cisco DCNM-SAN Server has a complete view of the fabric. Subsequent Cisco DCNM-SAN Client sessions can filter this complete view based on the privileges of the client logging in. For example, if you have multiple VSANs in your fabric and you create users that are limited to a subset of these VSANs, you want to initiate a fabric discovery through Cisco DCNM-SAN Server using a network administrator or network operator role so that Cisco DCNM-SAN Server has a view of all the VSANs in the fabric. When a VSAN-limited user launches Cisco DCNM-SAN Client, that user sees only the VSANs they are allowed to manage.
 
     
      
    
 
    
 
    [bookmark: pgfId-226870]Note Cisco DCNM-SAN Server should always monitor fabrics using a local switch account, do not use a AAA (RADIUS or TACACS+) server. You can use a AAA user account to log into the clients to provision fabric services. 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-245013]Note Even when remote AAA server authentication is enabled on the switch, use the local switch account that is not defined in the remote AAA server for fabric discovery. In other words, when a user is not found in the remote AAA server, then local switch user authentication will be allowed by the switch for SNMPv3 clients like DCNM.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-226874]Setting Up Discovery for a Fabric 
 
    
 
     
      [bookmark: pgfId-226875]DETAILED STEPS
 
     
 
     [bookmark: pgfId-226876]Step 1 Create a special Cisco DCNM-SAN administrative user name in each switch on your fabric with network administrator or network operator roles. Or, create a special Cisco DCNM-SAN administrative user name in your AAA server and set every switch in your fabric to use this AAA server for authentication.
 
     [bookmark: pgfId-226877]Step 2 Verify that the roles used by this Cisco DCNM-SAN administrative user name are the same on all switches in the fabric and that this role has access to all VSANs.
 
     [bookmark: pgfId-226878]Step 3 Launch Cisco DCNM-SAN Client using the Cisco DCNM-SAN administrative user. This step ensures that your fabric discovery includes all VSANs.
 
     [bookmark: pgfId-226880]Step 4 [bookmark: 56908]Set Cisco DCNM-SAN Server to continuously monitor the fabric. 
 
     [bookmark: pgfId-244921]Step 5 Repeat Step 4 for each fabric that you want to manage through Cisco DCNM-SAN Server.
 
     [bookmark: pgfId-244922]
 
      
      
 
     
. 
     
 
    
 
   
 
    
     [bookmark: pgfId-244926][bookmark: 68600][bookmark: 43309]Performance [bookmark: marker-244925]Manager Authentication
 
    [bookmark: pgfId-226895]Performance Manager uses the user name and password information stored in the Cisco DCNM-SAN Server database. If this information changes on the switches in your fabric while Performance Manager is running, you need to update the Cisco DCNM-SAN Server database and restart Performance Manager. Updating the Cisco DCNM-SAN Server database requires removing the fabric from Cisco DCNM-SAN Server and rediscovering the fabric.
 
     
      [bookmark: pgfId-226897]DETAILED STEPS
 
     
 
     [bookmark: pgfId-226898]Step 1 Click Server > Admin in Cisco DCNM-SAN.
 
     [bookmark: pgfId-226902]You see the Control Panel dialog box with the Fabrics tab open (see Figure 6-2). 
 
     [bookmark: pgfId-238060]Figure 6-2 [bookmark: 76727]Fabrics Tab in Control Panel Dialog Box
 
     [bookmark: pgfId-238064]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-226909]Step 2 Click the fabrics that have updated user name and password information.
 
     [bookmark: pgfId-226910]Step 3 [bookmark: 66295]From the Admin listbox, choose Unmanage and then click Apply.
 
     [bookmark: pgfId-226923]Step 4 [bookmark: 50160]Enter the appropriate user name and password and then click Apply.
 
     [bookmark: pgfId-233443]Step 5 From the Admin listbox, choose Manage and then click Apply.
 
     [bookmark: pgfId-233456]Step 6 To rediscover the fabric, click Open tab and check the check box(es) next to the fabric(s) you want to open in the Select column.
 
     [bookmark: pgfId-226925]Step 7 [bookmark: 70419]Click Open to rediscover the fabric. Cisco DCNM-SAN Server updates its user name and password information.
 
     [bookmark: pgfId-226932]Step 8 Repeat Step 3 through Step 7 for any fabric that you need to rediscover.
 
     [bookmark: pgfId-226933]Step 9 Choose Performance > Collector > Restart to restart Performance Manager and use the new user name and password.
 
     [bookmark: pgfId-236732]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-236735][bookmark: 60758]Cisco DCNM-SAN [bookmark: marker-236734]Web Client Authentication
 
    [bookmark: pgfId-236736]Cisco DCNM-SAN Web Server does not communicate directly with any switches in the fabric. Cisco DCNM-SAN Web Server uses its own user name and password combination that is either stored locally or stored remotely on an AAA server.
 
    [bookmark: pgfId-226943]We recommend that you use a RADIUS or TACACS+ server to authenticate users in Cisco DCNM-SAN Web Server.
 
     
      [bookmark: pgfId-226946]DETAILED STEPS
 
     
 
     [bookmark: pgfId-226947]Step 1 Launch Cisco DCNM-SAN Web Client. 
 
     [bookmark: pgfId-226952]Step 2 Choose Admin > Management Users > Remote AAA to update the authentication used by Cisco DCNM-SAN Web Client.
 
     [bookmark: pgfId-226954]Step 3 Set the authentication mode attribute to radius.
 
     [bookmark: pgfId-226955]Step 4 Set the RADIUS server name, shared secret, authentication method, and ports used for up to three RADIUS servers.
 
     [bookmark: pgfId-226956]Step 5 Click Modify to save this information.
 
     [bookmark: pgfId-226957]
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-226960]Step 1 Launch Cisco DCNM-SAN Web Client. 
 
     [bookmark: pgfId-226965]Step 2 Choose Admin > Management Users > Remote AAA to update the authentication used by Cisco DCNM-SAN Web Client.
 
     [bookmark: pgfId-226967]Step 3 Set the authentication mode attribute to tacacs.
 
     [bookmark: pgfId-226968]Step 4 Set the TACACS+ server name, shared secret, authentication method, and port used for up to three TACACS+ servers.
 
     [bookmark: pgfId-226969]Step 5 Click Modify to save this information.
 
     [bookmark: pgfId-226970]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-221891]Note Cisco DCNM-SAN does not support SecureID because it is not compatible with SNMP authentication. Cisco DCNM-SAN uses the same login credentials for all the switches in a fabric. Since SecureID cannot be used more than once for authentication, Cisco DCNM-SAN will not be able to establish a connection to the second switch using a SecureID.
 
      
      
 
     
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-344059]Configuring Cisco [bookmark: 71490]DCNM-SAN Client 
      
      
 
     
 
 
    [bookmark: pgfId-344060]This chapter describes about the Cisco DCNM-SAN Client, which is a java-based GUI application that provides access to the Cisco DCNM-SAN applications from a remote workstation.
 
    [bookmark: pgfId-394145]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-344065]Information About DCNM-SAN Client
 
     	 [bookmark: pgfId-344073]Cisco DCNM-SAN Client Quick Tour: Server Admin Perspective
 
     	 [bookmark: pgfId-309708]Cisco DCNM-SAN Client Quick Tour: Admin Perspective
 
     	 [bookmark: pgfId-381170]Launching Cisco DCNM-SAN Client
 
     	 [bookmark: pgfId-344085]Setting Cisco DCNM-SAN Preferences
 
     	 [bookmark: pgfId-344089]Network Fabric Discovery
 
     	 [bookmark: pgfId-344093]Modifying the Device Grouping
 
     	 [bookmark: pgfId-344097]Controlling Administrator Access with Users and Roles
 
     	 [bookmark: pgfId-344101]Using Cisco DCNM-SAN Wizards
 
     	 [bookmark: pgfId-344105]Cisco DCNM-SAN Troubleshooting Tools
 
     	 [bookmark: pgfId-377620]Integrating Cisco DCNM-SAN and Data Center Network Management Software
 
    
 
   
 
    
     [bookmark: pgfId-344111][bookmark: 34479]Information About DCNM-SAN Client[bookmark: marker-344110]
 
    [bookmark: pgfId-364571]Cisco DCNM-SAN is a Java and SNMP-based network fabric and device management tool with a GUI that displays real-time views of your network fabric, including Cisco Nexus 5000 Series switches, Cisco MDS 9000 Family and third-party switches, hosts, and storage devices.
 
    [bookmark: pgfId-381434]In addition to complete configuration and status monitoring capabilities for Cisco MDS 9000 Family switches and Cisco Nexus 5000 Series switches, Cisco DCNM-SAN Client provides Fibre Channel troubleshooting tools. You can use these health and configuration analysis tools on the MDS 9000 Family switch or Cisco Nexus 5000 Series switch to perform Fibre Channel ping and traceroute. 
 
    [bookmark: pgfId-381441]Cisco DCNM-SAN Release 4.1(1b) and later provides multilevel security system by adding a server admin role that allows access to limited features. The configuration capabilities of a server admin is limited to FlexAttach and relevant data. 
 
     
      
    
 
    
 
    [bookmark: pgfId-296145]Note You must use the same release of Cisco DCNM-SAN Client and Cisco DCNM-SAN Server.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-344117]Cisco DCNM-SAN Advanced Mode[bookmark: marker-344116]
 
     [bookmark: pgfId-344118]Advanced mode is enabled by default and provides the full suite of Cisco DCNM-SAN features, including security, [bookmark: marker-344119]IVR, [bookmark: marker-344120]iSCSI, and [bookmark: marker-344121]FICON. To simplify the user interface, from the list box in the upper right corner of the Cisco DCNM-SAN Client, choose Simple. In simple mode, you can access basic MDS 9000 features such as VSANs, zoning, and configuring interfaces. Advanced mode option is not available for server admin role.
 
    
 
   
 
    
     [bookmark: pgfId-314707][bookmark: 10613][bookmark: 73390][bookmark: 67257][bookmark: 20981]Cisco DCNM-SAN Client Quick Tour: Server Admin Perspective
 
    [bookmark: pgfId-369514]Cisco DCNM-SAN provides a multilevel security system by adding a server admin role that allows access only to limited features. The configuration capabilities of a server admin role is limited to FlexAttach and relevant data. The server admin can pre-configure SAN for new servers, move a server to another port on the same NPV device or another NPV device and replace a failed server onto the same port without involving the SAN administrator. The server role admin will not be able to manage Cisco DCNM-SAN users or connected clients. 
 
    [bookmark: pgfId-369557]Cisco DCNM-SAN provides a much improved user interface by including movable and dockable panes to let users arrange the Physical Attributes pane, Logical Domains pane, Fabric pane and Information pane according to requirements, making it easier to manage the workflow. The dockable panes are also called as dockable frames. A dockable frame can be standalone (floating), minimized or maximized. The logical, physical, information and the fabric panes can be can be collapsed and expanded as needed. These panes can also be docked at either the right side left side or to the bottom of the workspace.
 
     
      [bookmark: pgfId-394158]Cisco DCNM-SAN Main Window 
 
     [bookmark: pgfId-394159]This section describes the Cisco DCNM-SAN Client interface that is specific to server admin users as shown in Figure 7-1.
 
     [bookmark: pgfId-394167]Figure 7-1 [bookmark: 57854]Cisco DCNM-SAN Main Window: Server Admin Perspective
 
      
      [image: ] 
     
 
      
      [bookmark: pgfId-394174]2 
     
 
     [bookmark: pgfId-394176]Toolbar—Provides icons for direct access to the most commonly used options on the File, Tools, and Help menus.
 
      
      [bookmark: pgfId-394178]3 
     
 
     [bookmark: pgfId-394180]Information pane—Displays information about whatever option is selected in the menu tree. 
 
      
      [bookmark: pgfId-394182]4 
     
 
     [bookmark: pgfId-394184]Status Bar (right side)—Shows the last entry displayed by the discovery process and the possible error message.
 
      
      [bookmark: pgfId-394186]5 
     
 
     [bookmark: pgfId-394188]Fabric pane—Displays a map of the network fabric, including switches, hosts, and storage. It also provides tabs for displaying log and event data.
 
      
      [bookmark: pgfId-394190]6 
     
 
     [bookmark: pgfId-394192]Status Bar (left side)—Shows short-term transient messages, such as the number of rows displayed in a table. 
 
      
      [bookmark: pgfId-394194]7 
     
 
     [bookmark: pgfId-394196]Physical Attributes pane—Displays a tree of available configuration tasks depending on the fabric, VSAN, or zone selected previously. Lists the switches in the logical selection. 
 
      
      [bookmark: pgfId-394198]8 
     
 
    
 
     
      [bookmark: pgfId-329199]Menu Bar
 
     [bookmark: pgfId-314763]The menu bar at the top of the Cisco DCNM-SAN main window provides options for managing and for controlling the display of information on the Fabric pane. Server admin will not have all the options that are available for SAN admin. The menu bar provides the following menus:
 
      
      	 [bookmark: pgfId-309343]File—Opens a new fabric, rediscovers the current fabric, locates switches, sets preferences, prints the map.
 
      	 [bookmark: pgfId-309344]View—Changes the appearance of the map (these options are duplicated on the Fabric pane toolbar).
 
      	 [bookmark: pgfId-309345]Tools—Manages the Server and configuration using the FlexAttach virtual pWWN feature.
 
      	 [bookmark: pgfId-316497]Help—Displays online help topics for specific dialog boxes in the Information pane.
 
     
 
    
 
     
      [bookmark: pgfId-344296]Tool Bar
 
     [bookmark: pgfId-344297]The Cisco DCNM-SAN main toolbar (specific to server admin) provides icons for accessing the most commonly used menu bar options as shown in Table 7-1.
 
      
      [bookmark: pgfId-394220]Icon 
     
 
      
      [bookmark: pgfId-394222]Description 
     
  
     
 
     [bookmark: pgfId-394229]Opens switch fabric.
  
     
 
     [bookmark: pgfId-394236]Rediscovers current fabric.
  
     
 
     [bookmark: pgfId-394243]Finds in the map.
  
     
 
     [bookmark: pgfId-394250]Shows online help.
 
    
 
   
 
    
     [bookmark: pgfId-344336]Logical Domains Pane 
 
    [bookmark: pgfId-360110]Use the Logical Domains pane to view fabrics and to access user-defined groups. You can expand the groups to see different user-defined groups. The non-editable groups created for each core switch contains their NPV switches.
 
    [bookmark: pgfId-344341]To select an option, click a folder to display the options available and then click the option. You see the table with information for the selected option in the Information pane. The Physical Attributes pane provides the following main folders:
 
     
     	 [bookmark: pgfId-344342]Switches—Views and configures hardware, system, licensing, and configuration files. 
 
     	 [bookmark: pgfId-344343]Interfaces—Views and configures FC physical, FC logical, VFC (FCoE), Ethernet, SVC, and PortChannel interfaces.
 
    
 
   
 
    
     [bookmark: pgfId-344344][bookmark: 34238]Information Pane
 
    [bookmark: pgfId-349696]Use the Information pane to display tables of information associated with the option selected from the menu tree in the Logical Domains or Physical Attributes panes. The Information pane toolbar provides buttons for performing one or more of the operations shown in Table 5-2.
 
     
     [bookmark: pgfId-349788]Icons 
    
 
     
     [bookmark: pgfId-349790]Description 
    
  
    
 
    [bookmark: pgfId-349845]Applies configuration changes.
  
    
 
    [bookmark: pgfId-349852]Refreshes table values.
  
    
 
    [bookmark: pgfId-349859]Copies data from one row to another.
  
    
 
    [bookmark: pgfId-349866]Pastes the data from one row to another.
  
    
 
    [bookmark: pgfId-349873]Undoes the most recent change.
  
    
 
    [bookmark: pgfId-349880]Finds a specified string in the table.
  
    
 
    [bookmark: pgfId-349887]Exports and saves information to a file.
  
    
 
    [bookmark: pgfId-350045]Prints the contents of the Information pane.
  
    
 
    [bookmark: pgfId-350052]Displays a non-editable copy of the table in the Information pane in its own window, which you can move around the screen.
 
   
 
    
     [bookmark: pgfId-349770][bookmark: 70248]Fabric Pane
 
    [bookmark: pgfId-344414]Use the Fabric pane to display the graphical representation of your fabric. Table 5-1 explains the graphics you may see displayed, depending on which devices you have in your fabric. 
 
    [bookmark: pgfId-344415]The bottom of the Fabric pane has the following tabs: 
 
     
     	 [bookmark: pgfId-344416]Fabric—When displaying multiple fabrics, each fabric has its own tab. You can switch between fabrics by clicking on their respective tabs. 
 
     	 [bookmark: pgfId-344417]Log—Displays messages that describe Cisco DCNM-SAN operations, such as fabric discovery. . 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-316241]Note Fabric map display is based on what you select in the logical domain pane. When you select a fabric node, all the switches that belong to that fabric will be enabled. When you select the group node, all the switches that belong to the groups listed under that group node will be enabled. When you select only a group, all the switches that belong to the specific group will be enabled.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-311387]Note You can view information about Events using the DCNM Web Client. 
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344437][bookmark: 95985]Cisco DCNM-SAN Client Quick Tour: Admin Perspective
 
    [bookmark: pgfId-394269]This section describes the Cisco DCNM-SAN Client interface shown in Figure 7-2.
 
    [bookmark: pgfId-394272]Figure 7-2 [bookmark: 1085]Cisco DCNM-SAN Main Window[bookmark: marker-394271]
 
    [bookmark: pgfId-394276]
 
     
     [image: ] 
    
 
     
     [bookmark: pgfId-394283]2 
    
 
    [bookmark: pgfId-394285]Toolbar—Provides icons for direct access to the most commonly used options on the File, Tools, and Help menus.
 
     
     [bookmark: pgfId-394287]3 
    
 
    [bookmark: pgfId-394289]Information pane—Displays information about whatever option is selected in the menu tree.
 
     
     [bookmark: pgfId-394291]4 
    
 
    [bookmark: pgfId-394293]Status Bar (right side)—Shows the last entry displayed by the discovery process and the possible error message.
 
     
     [bookmark: pgfId-394295]5 
    
 
    [bookmark: pgfId-394297]Fabric pane—Displays a map of the network fabric, including switches, hosts, and storage. It also provides tabs for displaying log and event data.
 
     
     [bookmark: pgfId-394299]6 
    
 
    [bookmark: pgfId-394301]Status Bar (left side)—Shows short-term transient messages, such as the number of rows displayed in a table.
 
     
     [bookmark: pgfId-394303]7 
    
 
    [bookmark: pgfId-394305]Physical Attributes pane—Displays a tree of available configuration tasks depending on the fabric, VSAN, or zone selected previously. Lists the switches and end devices in the logical selection.
 
     
     [bookmark: pgfId-394307]8 
    
 
    [bookmark: pgfId-394309]Logical Domains pane—Displays a tree of configured SAN, fabrics, VSANs, and zones, and provides access to user-defined groups. The label next to the segmented VSAN indicates the number of segments.
 
   
 
    
     
   
 
   
 
   [bookmark: pgfId-394311]Note You can resize each pane by dragging the boundaries between each region or by clicking the Minimize or Maximize controls.
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-296321]Menu Bar
 
    [bookmark: pgfId-296323]The menu[bookmark: marker-296322] bar at the top of the Cisco DCNM-SAN main window provides options for managing and troubleshooting the current fabric and for controlling the display of information on the Fabric pane. The menu bar provides the following menus:
 
     
     	 [bookmark: pgfId-296324]File—Opens a new fabric, rediscovers the current fabric, locates switches, sets preferences, prints the map, and exports the Fabric pane log.
 
     	 [bookmark: pgfId-296325]View—Changes the appearance of the map (these options are duplicated on the Fabric pane toolbar).
 
     	 [bookmark: pgfId-296326]Zone—Manages zones, zone sets, and inter-VSAN routing (IVR).
 
     	 [bookmark: pgfId-296329]Tools—Verifies and troubleshoots connectivity and configuration, as described in the “Cisco DCNM-SAN Troubleshooting Tools”.
 
     	 [bookmark: pgfId-296331]Performance—Runs and configures Performance Manager and Cisco Traffic Analyzer, and generates reports.
 
     	 [bookmark: pgfId-296332]Server—Runs administrative tasks on clients and fabrics. Provides Cisco DCNM-SAN Server management and a  purge command. Lists fabrics being managed.
 
     	 [bookmark: pgfId-296333]Help—Displays online help topics for specific dialog boxes in the Information pane.
 
    
 
   
 
    
     [bookmark: pgfId-352384]File
 
    [bookmark: pgfId-352412]The file menu provides the following options: 
 
     
     	 [bookmark: pgfId-352392]Open Fabric—Opens a new switch fabric.
 
     	 [bookmark: pgfId-352854]Locate Switches and Devices— Uses the SNMPv2 protocol to discover devices responding to SNMP requests with the read-only community string public. You may use this feature if you want to locate other Cisco MDS 9000 switches in the subnet, but are not physically connected to the fabric.
 
     	 [bookmark: pgfId-352821]Rediscover—Initiates an on-demand discovery to learn recent changes from the switches and update the Cisco DCNM-SAN Client. You may use this option when Cisco DCNM-SAN Server is not in sync with switches in the fabric and you do not want to wait until the next polling cycle. The rediscover option does not delete the fabric and add it again. You may delete and add the fabric only if the rediscover option fails to update Cisco DCNM-SAN Server.
 
     	 [bookmark: pgfId-352442]Resync All Open Fabrics— Cisco DCNM-SAN Server forces all the fabrics to close and re-open. You may use this option when Cisco DCNM-SAN Client is not in sync with Cisco DCNM-SAN Server. 
 
     	 [bookmark: pgfId-352877]Rediscover SCSI Targets— Initiates an on-demand discovery to learn recent changes from the SCSI target switches. You may use this option when Cisco DCNM-SAN Server is not in sync with SCSI target switches in the fabric and you do not want to wait until the next polling cycle.
 
     	 [bookmark: pgfId-352878]Preferences—Sets your preferences to customize the behavior of the Cisco DCNM-SAN Client. 
 
     	 [bookmark: pgfId-352887]Import Enclosures—Imports saved enclosures.
 
     	 [bookmark: pgfId-352888]Export
 
    
 
    [bookmark: pgfId-352891] – Map Image—Generates and export the map to a specified location.
 
    [bookmark: pgfId-352895] – Visio—Exports the map to a Visio file.
 
    [bookmark: pgfId-352896] – Table—Exports the table data to a text file.
 
    [bookmark: pgfId-352897] – Log—Exports the log to a text file.
 
    [bookmark: pgfId-352898] – Events—Exports the events to a text file.
 
    [bookmark: pgfId-352899] – Enclosures—Exports the enclosure values to a text file.
 
     
     	 [bookmark: pgfId-352889]Print —Prints the map.
 
     	 [bookmark: pgfId-352900]Exit—Exit Cisco DCNM-SAN.
 
    
 
   
 
    
     [bookmark: pgfId-352903]View
 
    [bookmark: pgfId-354160]View menu provides the following options: 
 
     
     	 [bookmark: pgfId-352909]Refresh Map—Refreshes the current map.
 
     	 [bookmark: pgfId-352910]Layout
 
    
 
    [bookmark: pgfId-352920] – Cancel—Cancels the current layout.
 
    [bookmark: pgfId-352924] – Spring—Displays the layout based on spring algorithm.
 
    [bookmark: pgfId-352925] – Quick—Quickly displays the layout when the switch has many end devices. 
 
     
     	 [bookmark: pgfId-352914]Zoom
 
    
 
    [bookmark: pgfId-352928] – In—Zooms in the view.
 
    [bookmark: pgfId-352929] – Out—Zooms out the view.
 
    [bookmark: pgfId-352930] – Fit—Fits the view in the fabric pane.
 
     
     	 [bookmark: pgfId-352915]Grid—Enables the grid view.
 
     	 [bookmark: pgfId-352916]Overview Window—Allows you to center the Fabric pane on the area of the fabric that you want to see. This option is useful for large fabrics that cannot be displayed entirely within the Fabric pane.
 
     	 [bookmark: pgfId-352917]Legend—Shows all the legends used in the fabric map.
 
     	 [bookmark: pgfId-352918]Find in Map—Finds a device in the fabric map.
 
    
 
   
 
    
     [bookmark: pgfId-352389]Zone
 
    [bookmark: pgfId-354245]The zone menu provides the following options: 
 
     
     	 [bookmark: pgfId-352943]Edit Local Full Zone Database—Allows you to create zones across multiple switches. Zones provide a mechanism for specifying access control. Zone sets are a group of zones to enforce access control in the fabric. All zoning features are available through the Edit Local Full Zone Database dialog box. 
 
     	 [bookmark: pgfId-353895]Deactivate Zoneset—Deactivates an active zone set.
 
     	 [bookmark: pgfId-353901]Copy Full Zone Database—Creates a new zone set. On the Cisco MDS Family switches, you cannot edit an active zone set. However, you can copy an active zone set to create a new zone set that you can edit.
 
     	 [bookmark: pgfId-352947]Merge Analysis—Enables you to determine if zones will merge successfully when two Cisco MDS switches are interconnected. If the interconnected switch ports allow VSANs with identical names or contain zones with identical names, then Cisco DCNM-SAN verifies that the zones contain identical members. You can use merge analysis tool before attempting a merge, or after fabrics are interconnected to determine zone merge failure causes.
 
     	 [bookmark: pgfId-358172]Merge Fail Recovery—Recovers the port from its isolated state either by importing the neighboring switch's active zone set database and replacing the current active or by exporting the current database to the neighboring switch.
 
     	 [bookmark: pgfId-352940]Migrate Non-MDS Database—Migrate a non-MDS database using Cisco DCNM-SAN (you may need to use the Zone Migration Wizard to accomplish this task).
 
     	 [bookmark: pgfId-353915]IVR
 
    
 
    [bookmark: pgfId-353917] – Deactivate Zoneset—Deactivates an active zone set.
 
    [bookmark: pgfId-353028] – Copy Full Zone Database—Recovers an IVR zone database by copying the IVR full zone database from another switch.
 
    [bookmark: pgfId-353042] – Copy Full Topology—Recovers a topology by copying from the active zone database or the full zone database. 
 
   
 
    
     [bookmark: pgfId-353044]Tools
 
    [bookmark: pgfId-354250]Tools menu provides the following options: 
 
     
     	 [bookmark: pgfId-353048]Health
 
    
 
    [bookmark: pgfId-353059] – Switch Health—Determines the status of the components of a specific switch. 
 
    [bookmark: pgfId-353060] – Fabric Configuration—Analyzes the configuration of a switch by comparing the current configuration to a specific switch or to a policy file. You can save a switch configuration to a file and then compare all switches against the configuration in the file.
 
    [bookmark: pgfId-353061] – Show Tech Support—Collects large amount of information about your switch for troubleshooting purposes. When you issue a show tech support command from Cisco DCNM-SAN for one or more switches in a fabric, the results of each command are written to a text file, one file per switch, in a directory you specify. You can then view these files using Cisco DCNM-SAN.
 
     
     	 [bookmark: pgfId-353067]Connectivity
 
    
 
    [bookmark: pgfId-353068] – End to End Connectivity—Determines connectivity and routes among devices with the switch fabric. This tool checks to see that every pair of end devices can talk to each other, using a Ping test and by determining if they are in the same VSAN or in the same active zone. 
 
    [bookmark: pgfId-354313] – Ping—Determines connectivity from another switch to a port on your switch.
 
    [bookmark: pgfId-354314] – Trace Route—Verifies connectivity between two end devices that are currently selected on the Fabric pane.
 
    [bookmark: pgfId-358159] – Compact Flash Report—Automatically scans the fabric and generate a report that shows the status of CompactFlash.
 
     
     	 [bookmark: pgfId-353087]NPV
 
    
 
    [bookmark: pgfId-353091] – CFS Static Peer Setup—Manage the peer list used during CFS on NPV-enabled switches. After setting up the static peers list, the CFS discovery on the switches will be changed to static mode for all peers in the list. Cisco DCNM-SAN does not automatically update static peers list. You may need to update the list using the CFS Static Peer Setup Wizard when a new switch is added to the fabric.
 
    [bookmark: pgfId-357444] – Traffic Map Setup—Configures the list of external interfaces to the servers, and enabling or disabling disruptive load balancing. Using Traffic Map Setup you can specify the external ports that a server should use for traffic management. 
 
    [bookmark: pgfId-357372] – Flex Attach Pre-Configure Server—Sets the port configurations for all the ports in a switch such as enabling or disabling FlexAttach, setting the default VSAN ID, and setting the interface status.
 
    [bookmark: pgfId-353092] – Flex Attach Move Server—Moves a server to another port on the same NPV device or another NPV device without changing the SAN. 
 
    [bookmark: pgfId-353093] – Flex Attach Replace Server—Replaces a failed server with a new server on the same port without changing the SAN. 
 
     
     	 [bookmark: pgfId-353109]Data Mobility Manager
 
    
 
    [bookmark: pgfId-353110] – Server Based—Performs server-based data migration.
 
    [bookmark: pgfId-353127] – Storage based—Performs storage-based data migration.
 
    [bookmark: pgfId-353128] – Server LUN Discovery—Performs LUN discovery to select the LUNs available for migration and automates the session creation by matching the LUNs in the existing and new storage.
 
     
     	 [bookmark: pgfId-377340]FCoE—Launches the FCoE Configuration Wizard to create virtual Fibre Channel interfaces.
 
     	 [bookmark: pgfId-353126]Port Channel—Creates PortChannels from selected ISL either manually or automatically. 
 
     	 [bookmark: pgfId-354799]DPVM Setup—Establishes dynamic port VSAN membership, enables autolearning, and activates the DPVM database.
 
     	 [bookmark: pgfId-353112]IP SAN
 
    
 
    [bookmark: pgfId-353113] – FCIP Tunnel—Creates FCIP links between Gigabit Ethernet ports. Enables Fibre Channel write acceleration and IP compression.
 
    [bookmark: pgfId-353114] – iSCSI Setup—Creates zones for iSCSI initiators and adds a VSAN to a target-allowed VSAN list.
 
    [bookmark: pgfId-353107] – SAN Extension Tuner—Optimizes FCIP performance by generating either direct access (magnetic disk) or sequential access (magnetic tape) SCSI I/O commands and directing such traffic to a specific virtual target. This option is used to generate SCSI I/O commands (read and write) to the virtual target based on your configured options. 
 
     
     	 [bookmark: pgfId-353514]Security
 
    
 
    [bookmark: pgfId-353515] – Port Security—Prevents unauthorized access to a switch port in the Cisco MDS 9000 Family, rejects intrusion attempts and reports these intrusions to the administrator. 
 
    [bookmark: pgfId-353516] – IP ACL—Creates an ordered list of IP filters in a named IPv4-ACL or IPv6-ACL profile using the IPv4-ACL Wizard.
 
     
     	 [bookmark: pgfId-354808]Install 
 
    
 
    [bookmark: pgfId-354809] – License—Facilitate download and installation of licenses in selected switches in the fabric.
 
    [bookmark: pgfId-354810] – Software—Verifies image compatibility and installs software images on selected switches in the fabric.
 
     
     	 [bookmark: pgfId-354352]Flow Load Balance Calculator —Allows you to get the best load-balancing configuration for your FICON flows. The calculator does not rely on any switch or flow discovery in the fabric. 
 
     	 [bookmark: pgfId-354393]Device Manager—Invokes Device Manager for a switch.
 
     	 [bookmark: pgfId-353553]Command Line Interface —Enables command-line operations.
 
     	 [bookmark: pgfId-353554]Run CLI Commands—Runs command-line operations on more than one switch at a time.
 
    
 
   
 
    
     [bookmark: pgfId-353565]Performance
 
    [bookmark: pgfId-354255]The performance menu provides the following options: 
 
     
     	 [bookmark: pgfId-353566]Create Flows—Creates host-to-storage, storage-to-host, or bidirectional flows. You can add these flows to a collection configuration file to monitor the traffic between a host or storage element pair.
 
    
 
   
 
    
     [bookmark: pgfId-353568]Server
 
    [bookmark: pgfId-354273]The server menu provides the following options: 
 
     
     	 [bookmark: pgfId-353569]Admin—Opens the control panel.
 
     	 [bookmark: pgfId-353570]Purge Down Elements—Purges all down elements in the fabric.
 
    
 
   
 
    
     [bookmark: pgfId-353572]Help
 
    [bookmark: pgfId-354286]The help menu provides the following options: 
 
     
     	 [bookmark: pgfId-353573]Contents —Launches the online help contents.
 
     	 [bookmark: pgfId-355627]Config Guide—Launches the Cisco DCNM-SAN Configuration Guide.
 
     	 [bookmark: pgfId-355628]About—Displays information about Cisco DCNM-SAN.
 
    
 
   
 
    
     [bookmark: pgfId-355778]Toolbar
 
    [bookmark: pgfId-394332]The Cisco DCNM-SAN main toolbar provides[bookmark: marker-355373] icons for accessing the most commonly used menu bar options as shown in Table 7-3.
 
    [bookmark: pgfId-394507]
 
     
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-394339]Table 7-3 [bookmark: 19686]Cisco DCNM-SAN Client Main Toolbar 
 
       
       
        
        	 
          
          [bookmark: pgfId-394343]Icon 
         
  
        	 
          
          [bookmark: pgfId-394345]Description 
         
  
       
 
       
          
        	[bookmark: pgfId-394352]Opens switch fabric.
  
       
 
       
          
        	[bookmark: pgfId-394359]Rediscovers current fabric.
  
       
 
       
          
        	[bookmark: pgfId-394366]Finds in the map.
  
       
 
       
          
        	[bookmark: pgfId-394373]Creates VSAN.
  
       
 
       
          
        	[bookmark: pgfId-394380]Launches DPVM wizard.
  
       
 
       
          
        	[bookmark: pgfId-394387]Launches Port Security wizard.
  
       
 
       
          
        	[bookmark: pgfId-394394]Edits full zone database.
  
       
 
       
          
        	[bookmark: pgfId-394401]Launches IVR zone wizard.
  
       
 
       
          
        	[bookmark: pgfId-394408]Launches the FCoE configuration wizard.
  
       
 
       
          
        	[bookmark: pgfId-394415]Launches PortChannel wizard.
  
       
 
       
          
        	[bookmark: pgfId-394422]Launches FCIP wizard.
  
       
 
       
          
        	[bookmark: pgfId-394429]Launches iSCSI wizard.
  
       
 
       
          
        	[bookmark: pgfId-394436]Launches NPVM wizard.
  
       
 
       
          
        	[bookmark: pgfId-394443]Launches QoS wizard.
  
       
 
       
          
        	[bookmark: pgfId-394450]Configures users and roles.
  
       
 
       
          
        	[bookmark: pgfId-394457]Launches IP-ACL wizard.
  
       
 
       
          
        	[bookmark: pgfId-394464]Launches License Install wizard.
  
       
 
       
          
        	[bookmark: pgfId-394471]Launches Software Install wizard.
  
       
 
       
          
        	[bookmark: pgfId-394478]Performs switch health analysis.
  
       
 
       
          
        	[bookmark: pgfId-394485]Performs fabric configuration analysis.
  
       
 
       
          
        	[bookmark: pgfId-394492]Performs end-to-end connectivity analysis.
  
       
 
       
          
        	[bookmark: pgfId-394499]Monitors ISL performance. Brings up real-time ISL performance information for all interfaces in the fabric, in the Information pane.
  
       
 
       
          
        	[bookmark: pgfId-394506]Shows online help.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-344670]Logical Domains Pane
 
    [bookmark: pgfId-381701]Use the Logical Domains pane to manage attributes for fabrics, VSANs, and zones, and to access user-defined groups. Starting from NX-OS Release 4.2(0), SAN and LAN nodes are listed under Datacenter node and all the fabrics are listed under SAN node. When you select Datacenter node in the tree, Cisco DCNM-SAN displays all the switches and ISLs. When you select LAN node, Cisco DCNM-SAN displays only Ethernet switches and Ethernet links. Under the fabric node, VSANs are ordered by a VSAN ID. The segmented VSANs are placed under the fabric node. The label next to the segmented VSAN indicates the number of segments. You can expand a segmented VSAN and the segments under that VSAN. Right-click one of the folders in the tree and click a menu item from the pop-up menu. You see the appropriate configuration dialog box. 
 
    [bookmark: pgfId-344672]The default name for the fabric is the name, IP address, or WWN for the principal switch in VSAN 1. If VSAN 1 is segmented, the default name is chosen from a principal switch with the smallest WWN. The fabric names you see are as follows:
 
     
     	 [bookmark: pgfId-344673]Fabric <sysName>
 
     	 [bookmark: pgfId-344674]Fabric <ipAddress>
 
     	 [bookmark: pgfId-344675]Fabric <sWWN>
 
    
 
    [bookmark: pgfId-344676]You can change the fabric name using Cisco DCNM-SAN.
 
   
 
    
     [bookmark: pgfId-398557]DETAILED STEPS
 
    
 
    [bookmark: pgfId-344677]Step 1 Choose Server > Admin.
 
    [bookmark: pgfId-344678]You see the Control Panel dialog box.
 
    [bookmark: pgfId-344679]Step 2 Double-click the fabric name and enter the new name of the fabric.
 
    [bookmark: pgfId-344680]Step 3 Click Apply to change the name.
 
    [bookmark: pgfId-394512]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344683]Filtering[bookmark: marker-344682]
 
    [bookmark: pgfId-344684]Cisco DCNM-SAN has a filtering mechanism that displays only the data that you are interested in. To filter, first select the fabric and VSAN from the Logical Domains pane. This action narrows the scope of what is displayed in the Fabric pane. Any information that does not belong to the selected items is dimmed. Also, any information that does not belong to the selected items is not displayed in the tables in the Information pane. The filter that you select is displayed at the top right of the Cisco DCNM-SAN window.
 
    [bookmark: pgfId-344688]To further narrow the scope, select attributes from the Physical Attributes pane. The Cisco DCNM-SAN table, display, and filter criteria change accordingly.
 
   
 
    
     [bookmark: pgfId-344690]Physical [bookmark: marker-344689]Attributes Pane
 
    [bookmark: pgfId-344691]Use the Physical Attributes pane to display a tree of the options available for managing the switches in the currently selected fabric, VSAN, or zone. 
 
    [bookmark: pgfId-344692]To select an option, click a folder to display the options available and then click the option. You see the table with information for the selected option in the Information pane. The Physical Attributes pane provides the following main folders:
 
     
     	 [bookmark: pgfId-344693]Switches—Views and configures hardware, system, licensing, and configuration files.
 
     	 [bookmark: pgfId-344694]Interfaces—Views and configures FC physical, FC logical, VFC (FCoE), Ethernet, SVC, and PortChannel interfaces.
 
     	 [bookmark: pgfId-344695]FC Services—Views and configures Fibre Channel network configurations.
 
     	 [bookmark: pgfId-344696]IP—Views and configures IP storage and IP services.
 
     	 [bookmark: pgfId-344698]Security—Views and configures MDS management and FC-SP security.
 
     	 [bookmark: pgfId-377387]FCoE—Views and configures FCoE interfaces.
 
     	 [bookmark: pgfId-344699]ISLs—Views and configures Inter-Switch Links.
 
     	 [bookmark: pgfId-347196]End Devices—Views and configures end devices.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-360210]Note You cannot view the detailed physical attributes of the data center switches or monitor the connections. When you select either a data center node or a LAN node the physical attributes pane will be blank.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-347365]Context Menu for Tables
 
    [bookmark: pgfId-347366]When you right-click in the table, you see a pop-up menu with options that vary depending on the type of option you selected in the Physical Attributes pane. You can perform various operations by right-clicking the device listed in the table. To view various options available for switches, ISLs, and end devices, refer to the procedures in the sections that follows:
 
   
 
    
     [bookmark: pgfId-347431]Viewing Switch Options
 
    [bookmark: pgfId-347458]When you select the datacenter node, the switch table displays all the switches that are discovered. When you select the SAN node or the fabric node, the switch table displays all the Fibre Channel switches and when you select the LAN node, the switch table displays all the Ethernet switches. 
 
   
 
    
     [bookmark: pgfId-360323]DETAILED STEPS
 
    
 
    [bookmark: pgfId-347894]Step 1 Click Switches in the Physical Attributes pane.
 
    [bookmark: pgfId-347896]Step 2 Right-click the device in the table. 
 
    [bookmark: pgfId-347898]The pop-up menu provides the following options:
 
     
     	 [bookmark: pgfId-347568]Apply Changes—Applies the changes to the switch.
 
     	 [bookmark: pgfId-347663]Refresh Values—Refreshes the current values.
 
     	 [bookmark: pgfId-347668]Undo Changes—Undoes modifications to the switch.
 
     	 [bookmark: pgfId-347694]Export to File—Export the values to a file.
 
     	 [bookmark: pgfId-347707]Print Table—Prints the table.
 
     	 [bookmark: pgfId-347720]Detach Table—Detaches the table.
 
     	 [bookmark: pgfId-347658]Switch Attributes—Changes the switch properties.
 
     	 [bookmark: pgfId-365218]Interface Attributes—Changes the interface properties.
 
     	 [bookmark: pgfId-365219]Element Manager—Manages this switch.
 
     	 [bookmark: pgfId-365220]Command Line Interface—Enables to perform command line operations.
 
     	 [bookmark: pgfId-347462]Copy—Copies the switch.
 
     	 [bookmark: pgfId-347463]Purge—Purges the switch.
 
     	 [bookmark: pgfId-347464]Fix Location—Fixes the switch in the current location.
 
     	 [bookmark: pgfId-347465]Align—Aligns the switch.
 
     	 [bookmark: pgfId-347466]Show End Devices—Shows the end devices.
 
     	 [bookmark: pgfId-347467]Expand Multiple Links—Expands the links to this switch.
 
     	 [bookmark: pgfId-347468]Other—Other options.
 
     	 [bookmark: pgfId-360268]Group—Groups switches.
 
    
 
    [bookmark: pgfId-360269]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-360270]Viewing ISL Options
 
    [bookmark: pgfId-347737]When you select the data center node, the ISLs table displays all of the Fibre Channel and Ethernet links. When you select the LAN node, the ISLs table displays all the Ethernet links. 
 
   
 
    
     [bookmark: pgfId-360334]DETAILED STEPS
 
    
 
    [bookmark: pgfId-347855]Step 1 In the Physical Attributes pane, click ISLs and then click Summary tab. 
 
    [bookmark: pgfId-347859]Step 2 Right-click the device in the table. 
 
    [bookmark: pgfId-347860]The pop-up menu provides the following options:
 
     
     	 [bookmark: pgfId-347739]Refresh Values—Refreshes the current values.
 
     	 [bookmark: pgfId-350535]Copy—Copies information from a specific field.
 
     	 [bookmark: pgfId-347741]Find—Conducts search based on the input string.
 
     	 [bookmark: pgfId-350547]Export to File—Exports the values to a file.
 
     	 [bookmark: pgfId-347742]Print Table—Prints the table.
 
     	 [bookmark: pgfId-347743]Detach Table—Detaches the table.
 
     	 [bookmark: pgfId-347745]Interface Attributes—Changes the interface properties.
 
     	 [bookmark: pgfId-347746]Element Manager—Manages the device.
 
     	 [bookmark: pgfId-347999]FCIP Tunnel Attributes—Changes FCIP tunneling properties.
 
     	 [bookmark: pgfId-348000]Create Port Channel—Creates port channel.
 
     	 [bookmark: pgfId-348024]Re-enable—Reenables a disabled device.
 
     	 [bookmark: pgfId-348002]Enable FC-SP—Enables FC-SP.
 
     	 [bookmark: pgfId-347752]SAN Extention Tuner—Optimizes FCIP performance.
 
     	 [bookmark: pgfId-347648]Purge—Purges the device.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-348059]Note When you select a port channel from the table, the pop-up menu will have the following additional options:
 
     
     	 [bookmark: pgfId-348114]Member Attributes—Changes the member properties.
 
     	 [bookmark: pgfId-348212]Channel Attributes—Changes the port channel properties.
 
     	 [bookmark: pgfId-348213]Edit—Edits the channel properties.
 
    
 
    [bookmark: pgfId-348214]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-347883]Viewing End Device Options
 
   
 
    
     [bookmark: pgfId-348257]DETAILED STEPS 
 
    
 
    [bookmark: pgfId-348293]Step 1 In the Physical Attributes pane, click End Devices and then click the Summary tab. 
 
    [bookmark: pgfId-348373]Step 2 Right-click the device in the table.
 
    [bookmark: pgfId-348379]The pop-up menu provides the following options:
 
     
     	 [bookmark: pgfId-348477]Apply Changes—Applies the changes to the device.
 
     	 [bookmark: pgfId-348381]Refresh Values—Refreshes the current values.
 
     	 [bookmark: pgfId-350557]Copy—Copies the information specific to the field.
 
     	 [bookmark: pgfId-350558]Paste—Pastes the copied text.
 
     	 [bookmark: pgfId-348382]Undo Changes—Undoes modifications to the device.
 
     	 [bookmark: pgfId-350567]Find—Searches for information depending on the input string.
 
     	 [bookmark: pgfId-348383]Export to File—Exports the values to a file.
 
     	 [bookmark: pgfId-348384]Print Table—Prints the table.
 
     	 [bookmark: pgfId-348385]Detach Table—Detaches the table.
 
     	 [bookmark: pgfId-348386]Device Attributes—Changes the device properties.
 
     	 [bookmark: pgfId-348387]Interface Attributes—Changes the interface properties.
 
     	 [bookmark: pgfId-348388]Element Manager—Manages this device.
 
     	 [bookmark: pgfId-348389]Command Line Interface—Enables you to perform command line operations.
 
     	 [bookmark: pgfId-348390]Copy—Copies the switch.
 
     	 [bookmark: pgfId-348391]Purge—Purges the switch.
 
     	 [bookmark: pgfId-348392]Fix Location—Fixes the switch in the current location.
 
     	 [bookmark: pgfId-348393]Align—Aligns the switch.
 
     	 [bookmark: pgfId-348394]Ping—Pings another device.
 
     	 [bookmark: pgfId-348395]Trace Route—Determines the route taken by packets across the network.
 
     	 [bookmark: pgfId-348396]Select Dependent Ports—Selects dependent ports.
 
     	 [bookmark: pgfId-348397]Group—Groups devices.
 
    
 
   
 
    
     [bookmark: pgfId-347199]Information [bookmark: marker-347198]Pane
 
    [bookmark: pgfId-394525]Use the Information pane to display tables of information associated with the option selected from the menu tree in the Logical Domains or Physical Attributes panes. The Information pane toolbar provides buttons for performing one or more of the operations shown in Table 7-4.
 
    [bookmark: pgfId-394619]
 
     
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-394535]Table 7-4 [bookmark: 47737]Information Pane Toolbar 
 
       
       
        
        	 
          
          [bookmark: pgfId-394539]Icon 
         
  
        	 
          
          [bookmark: pgfId-394541]Description 
         
  
       
 
       
          
        	[bookmark: pgfId-394548]Applies configuration changes.
  
       
 
       
          
        	[bookmark: pgfId-394555]Refreshes table values.
  
       
 
       
          
        	[bookmark: pgfId-394562]Opens the appropriate dialog box to make a new row in the table.
  
       
 
       
          
        	[bookmark: pgfId-394569]Deletes the currently highlighted rows from the table.
  
       
 
       
          
        	[bookmark: pgfId-394576]Copies data from one row to another.
  
       
 
       
          
        	[bookmark: pgfId-394583]Pastes the data from one row to another.
  
       
 
       
          
        	[bookmark: pgfId-394590]Undoes the most recent change.
  
       
 
       
          
        	[bookmark: pgfId-394597]Finds a specified string in the table.
  
       
 
       
          
        	[bookmark: pgfId-394604]Exports and saves information to a file.
  
       
 
       
          
        	[bookmark: pgfId-394611]Prints the contents of the Information pane.
  
       
 
       
          
        	[bookmark: pgfId-394618]Displays a non-editable copy of the table in the Information pane in its own window, which you can move around the screen.
  
       
 
       
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-344792]Note After making changes, you must save the configuration or the changes will be lost when the device is restarted. 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-344793]Note The buttons that appear on the toolbar vary according to the option that you select. They are activated or deactivated (dimmed) according to the field or other object that you select in the Information pane.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344795]Detachable Tables[bookmark: marker-344794]
 
    [bookmark: pgfId-344796]Detachable tables in Cisco DCNM-SAN allow you to detach tables and move them to different areas on your desktop so that you can compare similar tables from different VSANs. You can keep informational tables open from one view while you examine a different area in Cisco DCNM-SAN. To detach tables, click the Detach Table icon in the Information pane in Cisco DCNM-SAN.
 
   
 
    
     [bookmark: pgfId-344797]Fabric Pane
 
    [bookmark: pgfId-394628]Use the Fabric pane to display the graphical representation of your fabric. Table 7-5 explains the graphics you may see displayed, depending on[bookmark: marker-394627] which devices you have in your fabric.
 
    [bookmark: pgfId-394803]
 
     
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-394635]Table 7-5 [bookmark: 1171]Cisco DCNM-SAN Graphics 
 
       
       
        
        	 
          
          [bookmark: pgfId-394639]Icon or Graphic 
         
  
        	 
          
          [bookmark: pgfId-394641]Description 
         
  
       
 
       
          
        	[bookmark: pgfId-394648]Director class MDS 9000 Fibre Channel switch.
  
       
 
       
          
        	[bookmark: pgfId-394655]Non-director class MDS 9000 Fibre Channel switch.
  
       
 
       
          
        	[bookmark: pgfId-394662]Nexus 7000 switch.
  
       
 
       
          
        	[bookmark: pgfId-394669]Nexus FCoE or Fibre Channel switch.
  
       
 
       
          
        	[bookmark: pgfId-394676]Catalyst LAN switch.
  
       
 
       
          
        	[bookmark: pgfId-394683]Generic Fibre Channel switch.
  
       
 
       
          
        	[bookmark: pgfId-394690]Cisco SN5428.
  
       
 
       
          
        	[bookmark: pgfId-394697]Dashed or dotted orange line through a device indicates that the device is manageable but there are operational problems.
  
       
 
       
          
        	[bookmark: pgfId-394704]Dashed or dotted orange X through a device or link indicates that the device or ISL is not working properly.
  
       
 
       
          
        	[bookmark: pgfId-394711]A red line through a device indicates that the device is not manageable.
  
       
 
       
          
        	[bookmark: pgfId-394718]A red X through a device or link indicates that the device is down or that the ISL is down.
  
       
 
       
          
        	[bookmark: pgfId-394725]Fibre Channel HBA (or enclosure).
  
       
 
       
          
        	[bookmark: pgfId-394732]Fibre Channel target (or enclosure).
  
       
 
       
          
        	[bookmark: pgfId-394739]iSCSI host.
  
       
 
       
          
        	[bookmark: pgfId-394746]Fibre Channel ISL and edge connection.
  
       
 
       
          
        	[bookmark: pgfId-394753]Fibre Channel PortChannel.
  
       
 
       
          
        	[bookmark: pgfId-394760]IP ISL and edge connection.
  
       
 
       
          
        	[bookmark: pgfId-394767]IP PortChannel.
  
       
 
       
          
        	[bookmark: pgfId-394774]DWDM connection.
  
       
 
       
          
        	[bookmark: pgfId-394781]NPV connection.
  
       
 
       
          
        	[bookmark: pgfId-394788]Fibre Channel loop (storage).
  
       
 
       
          
        	[bookmark: pgfId-394795]IP cloud (hosts). This icon is also used to represent a fabric when viewing a SAN (multiple fabrics) in the Cisco DCNM-SAN Fabric pane.
  
       
 
       
          
        	[bookmark: pgfId-394802]Any device, cloud, or loop with a box around it means that there are hidden links attached.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-344957]If a switch or director is grayed out, Cisco DCNM-SAN can no longer communicate with it.
 
    [bookmark: pgfId-344959]The bottom of the Fabric pane has the following [bookmark: marker-344958]tabs:
 
     
     	 [bookmark: pgfId-344960]Fabric—When displaying multiple fabrics, each fabric has its own tab. You can switch between fabrics by clicking on their respective tabs.
 
     	 [bookmark: pgfId-344961]Log—Displays messages that describe Cisco DCNM-SAN operations, such as fabric discovery.
 
    
 
    [bookmark: pgfId-344964]When viewing [bookmark: marker-344963]large fabrics in the Fabric pane, it is helpful to do the following tasks:
 
     
     	 [bookmark: pgfId-344965]Turn off end device labels.
 
     	 [bookmark: pgfId-344966]Collapse loops.
 
     	 [bookmark: pgfId-344967]Collapse expanded multiple links (collapsed multiple links are shown as very thick single lines).
 
     	 [bookmark: pgfId-344968]Dim or hide portions of your fabric by VSAN.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-344970]Note When a VSAN, zone, or zone member is selected in the VSAN tree, the [bookmark: marker-344969]map highlighting changes to identify the selected objects. To remove this highlighting, click the Clear Highlight button on the Fabric pane toolbar or choose Clear Highlight from the pop-up menu.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344971]Context Menus
 
    [bookmark: pgfId-344972]When you right-click an icon in the Fabric pane, you see a pop-up menu with options that vary depending on the type of icon selected. The various options available for different objects include the following:
 
     
     	 [bookmark: pgfId-344973]Open an instance of Device Manager for the selected switch.
 
     	 [bookmark: pgfId-344974]Open a CLI session for the selected switch.
 
     	 [bookmark: pgfId-344975]Copy the display name of the selected object.
 
     	 [bookmark: pgfId-344976]Execute a  ping or  traceroute command for the device.
 
     	 [bookmark: pgfId-344977]Show or hide end devices.
 
     	 [bookmark: pgfId-344978]View attributes.
 
     	 [bookmark: pgfId-344979]Quiesce and disable members for PortChannels.
 
     	 [bookmark: pgfId-344980]Set the trunking mode for an ISL.
 
     	 [bookmark: pgfId-344981]Create or add to a PortChannel for selected ISLs.
 
    
 
    [bookmark: pgfId-344982]The Fabric pane has its own toolbar with options for saving, printing, and changing the appearance of the map. When you right-click the map, a pop-up menu appears that provides options (duplicated on the toolbar) for changing the appearance of the map.
 
     
      
    
 
    
 
    [bookmark: pgfId-344983]Note You can launch web-based or non-web-based applications from the Fabric pane. To do this, you assign an IP address to the storage port or enclosure. Then right-click to bring up the pop-up menu, and select Device Manager.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-344984]Saving the Map
 
    [bookmark: pgfId-344986]You can save the [bookmark: marker-344985]map in the Fabric Pane as an image, or as an editable Visio diagram. You can save the map with or without labels on the links. The created Visio diagram is editable and saved in two layers:
 
     
     	 [bookmark: pgfId-344987]The default layer includes all switches and links in the fabric.
 
     	 [bookmark: pgfId-344988]The end devices layer includes the end devices and can be turned off to remove end devices from the Visio diagram.
 
    
 
    [bookmark: pgfId-344991]To save the [bookmark: marker-344989]map as a [bookmark: marker-344990]Visio diagram, choose Files > Export > Visio and choose Map or Map with link labels. The saved Visio diagram retains the viewing options that you selected from the Fabric pane. For example, if you collapse multiple links in the map and export the links as a Visio diagram, the Visio diagram shows those multiple links as one solid link.
 
    [bookmark: pgfId-344992]The Show Tech Support option from the Tools menu also supports saving the map as a Visio diagram.
 
   
 
    
     [bookmark: pgfId-344993]Purging Down Elements
 
    [bookmark: pgfId-344995]The Fabric pane allows you to refresh the [bookmark: marker-344994]map at any time by clicking the Refresh Map icon. The Refresh Map icon redraws the map but does not [bookmark: marker-344996]purge elements that are down. To purge down elements you can:
 
     
     	 [bookmark: pgfId-344997]Choose Server > Purge Down Elements. This purges all down elements in the fabric.
 
     	 [bookmark: pgfId-344998]Right-click the  Fabric pane and choose Purge Down Elements.
 
     	 [bookmark: pgfId-344999]Right-click a down element and choose Purge. This action purges only this element from the fabric.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-345000]Note If you select an element that is not down and purge it, that element will reappear on the next fabric discovery cycle.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-345001]Multiple Fabric Display
 
    [bookmark: pgfId-345005]Cisco DCNM-SAN can display multiple fabrics in the same pane as shown in Figure 7-3.
 
    [bookmark: pgfId-406061]Figure 7-3 [bookmark: 63407]Cisco DCNM-SAN’s Multiple Fabric Display Window
 
    [bookmark: pgfId-406065]
 
     
     [image: ] 
    
 
     
     [bookmark: pgfId-406072]2 
    
 
    [bookmark: pgfId-406074]The Fabric view tab for fabric 172.23.46.153. When selected, the Fabric view displays fabric 172.23.46.153.
 
     
     [bookmark: pgfId-406076]3 
    
 
    [bookmark: pgfId-406078]SAN tab (selected), showing two fabrics.
 
   
 
   [bookmark: pgfId-345017]The information for both fabrics is displayed; you do not need to select a seed switch. To see details of a fabric, select the tab for that fabric at the bottom of the Fabric pane, or double-click the Cloud icon for the fabric in the SAN tab.
 
    
     
   
 
   
 
   [bookmark: pgfId-345018]Note Enclosure names should be unique. If the same enclosure name is used for each port, Cisco DCNM-SAN shows a host/target enclosure connected to both fabrics. To fix this problem, you can either disable auto-creation or create unique enclosure names.
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-345019]Filtering by Groups
 
    [bookmark: pgfId-345021]You can filter the Fabric pane display by creating [bookmark: marker-345020]groups of switches or end ports. 
 
   
 
    
     [bookmark: pgfId-398630]DETAILED STEPS
 
    
 
    [bookmark: pgfId-345022]Step 1 Right-click a switch or end port in the Fabric pane map and select Group > Create. 
 
    [bookmark: pgfId-345026]You see the Edit User Defined Group dialog box as shown in Figure 7-4. 
 
    [bookmark: pgfId-406093]Figure 7-4 [bookmark: 52125]Edit User Defined Group Dialog Box
 
    [bookmark: pgfId-406097]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-345033]Step 2 Enter a group name in the Name field. 
 
    [bookmark: pgfId-351267]Step 3 Use the arrows to move additional switches or end ports from the Available column to the Selected column.
 
    [bookmark: pgfId-345035]Step 4 Click OK to save the group.
 
    [bookmark: pgfId-345036]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-345037]To add a switch or end port to an existing group in Cisco DCNM-SAN.
 
   
 
    
     [bookmark: pgfId-398664]DETAILED STEPS
 
    
 
    [bookmark: pgfId-345038]Step 1 Right-click a switch or end device and select Group > Add To > YourGroupName. 
 
    [bookmark: pgfId-345042]You see the Edit User Defined Group dialog box as shown in see Figure 7-4.
 
    [bookmark: pgfId-345043]Step 2 Use the arrows to move additional switches or end ports from the Available column to the Selected column.
 
    [bookmark: pgfId-345044]Step 3 Click OK to save the updated group.
 
    [bookmark: pgfId-345045]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-345046]To filter the display by a group you have created.
 
   
 
    
     [bookmark: pgfId-398728]DETAILED STEPS
 
    
 
    [bookmark: pgfId-345047]Step 1 Expand the Groups folder in the Logical Domains pane. 
 
    [bookmark: pgfId-345051]You see the list of groups that you have created as shown in Figure 7-5.
 
    [bookmark: pgfId-406119]Figure 7-5 [bookmark: 60186]Group Highlighted in Fabric Pane Map
 
    [bookmark: pgfId-406123]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-345058]Step 2 Click the name of the group that you want to filter.
 
    [bookmark: pgfId-345059]In the Fabric pane, the switches or end devices in your group are shown normally; all other switches and end devices are shown in gray.
 
    [bookmark: pgfId-345060]Step 3 Click the Groups folder in the Logical Domains pane to return the display to normal.
 
     
      
    
 
    
 
    [bookmark: pgfId-350690]Note User-defined groups tables are filtered based on switches in the group except for switches where CFS-controlled features are enabled when all CFS member switches are displayed to avoid misconfigurations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-394850]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-296873]Status Bar
 
    [bookmark: pgfId-296875]The status bar[bookmark: marker-296874] at the bottom of the Cisco DCNM-SAN window shows the last entry displayed by the discovery process, and the possible error message on the right side. The status bar displays a message stating that something has changed in the fabric and a new discovery is needed. The status bar shows both short-term, transient messages (such as the number of rows displayed in the table) and long-term discovery issues.
 
   
 
    
     [bookmark: pgfId-381726][bookmark: 62032]Launching Cisco DCNM-SAN Client
 
    [bookmark: pgfId-394855]As of Cisco SAN-OS 3.x and NX-OS Release 4.x, the Fabric Manager Client login procedure has changed.
 
     
      [bookmark: pgfId-394862]Launching Fabric Manager Client in Cisco SAN-OS Release 3.2(1) and Later
 
     [bookmark: pgfId-394863]You can launch Fabric Manager Client.
 
      
       
     
 
     
 
     [bookmark: pgfId-394864]Note Network administrators must initially launch Cisco DCNM-SAN Client using Cisco DCNM-SAN Web Server, as described in the following procedure. Once an administrator has installed the Cisco DCNM-SAN Client icon on your desktop, you can double-click the icon to launch the Cisco DCNM-SAN Client.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-398760]DETAILED STEPS
 
     
 
     [bookmark: pgfId-394865]Step 1 Open your browser and enter the IP address where you installed Cisco DCNM-SAN Server, or enter localhost if you installed Cisco DCNM-SAN Server on your local workstation. 
 
     [bookmark: pgfId-394866]You see the Cisco DCNM Web Client Login dialog box.
 
     [bookmark: pgfId-406131]Figure 7-6 DCNM-SAN Web Client Login Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-394871]Step 2 Enter your user name and password and click Login.
 
     [bookmark: pgfId-394872]You see the Cisco DCNM Web Client Summary page.
 
     [bookmark: pgfId-394873]Step 3 Click the Download link in the upper right corner of the page.
 
     [bookmark: pgfId-394874]You see the Download page for Cisco DCNM-SAN and Device Manager.
 
     [bookmark: pgfId-406139]Figure 7-7 Download Page for DCNM-SAN and Device Manager
 
      
      [image: ] 
     
 
     [bookmark: pgfId-394879]Step 4 Click the link for Cisco DCNM-SAN.
 
     [bookmark: pgfId-394880]If you are launching Cisco DCNM-SAN Client for the first time, you see a message asking whether you want to create shortcuts for Cisco DCNM-SAN.
 
     [bookmark: pgfId-406147]Figure 7-8 DCNM-SAN Create Shortcut(s) Message
 
      
      [image: ] 
     
 
     [bookmark: pgfId-394885]Step 5 Click Yes to create shortcuts for Cisco DCNM-SAN.
 
      
       
     
 
     
 
     [bookmark: pgfId-394886]Note This message only appears the first time you launch Cisco DCNM-SAN Client. If you select No, your selection will be remembered and you will not be prompted to make a selection again. In this case, you will need to launch Cisco DCNM-SAN Client using the Cisco DCNM-SAN Web Client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-394887]Step 6 When the software is installed and icons are created on your desktop, double-click the Cisco DCNM-SAN icon to launch Cisco DCNM-SAN.
 
     [bookmark: pgfId-394888]You see the Cisco DCNM-SAN Login dialog box.
 
     [bookmark: pgfId-406152]Figure 7-9 DCNM-SAN Login Dialog Box
 
     [bookmark: pgfId-406156]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-394894]Step 7 Enter the Cisco DCNM-SAN Server user name and password.
 
     [bookmark: pgfId-394895]Step 8 Check the Use SNMP Proxy check box if you want Cisco DCNM-SAN Client to communicate with Cisco DCNM-SAN Server through a TCP-based proxy server.
 
     [bookmark: pgfId-394896]Step 9 Click Login. Once you successfully log in to Cisco DCNM-SAN Server, you can set the seed switch and open the fabrics that you are entitled to access.
 
      
       
     
 
     
 
     [bookmark: pgfId-394897]Note When you launch Cisco DCNM-SAN Client for the first time or when there are no available fabrics, you see the Discover New Fabric dialog box.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-394898]You see the Discover New Fabric dialog box.
 
     [bookmark: pgfId-406161]Figure 7-10 Discover New Fabric Dialog Box
 
     [bookmark: pgfId-406165]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-394904]Note Only network administrators can discover new fabrics.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-441224]Note Even when remote AAA server authentication is enabled on the switch, use the local switch account that is not defined in the remote AAA server for fabric discovery. In other words, when a user is not found in the remote AAA server, then local switch user authentication will be allowed by the switch for SNMPv3 clients like DCNM.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-394905]Step 10 Click the Ethernet (CDP) radio button to discover using Cisco Discovery Protocol (CDP).
 
     [bookmark: pgfId-394906]Step 11 Starting from NX-OS Release 4.2(0), Fabric Manager uses Cisco Discovery Protocol to discover Ethernet switches such as Nexus 5000, Nexus 7000, Catalyst 4000, and Catalyst 6000 switches. You need to use a CDP seed switch for a CDP discovery. 
Set the fabric seed switch to the Cisco MDS 9000 Family switch or Cisco Nexus 5000 Series that you want Fabric Manager to use. 
 
     [bookmark: pgfId-394910]Step 12 Choose the Auth-Privacy option according to the privacy protocol you have configured on your switch:
 
     [bookmark: pgfId-394911] a. If you have not configured the switch with a privacy protocol, then choose Auth-Privacy option MD5 (no privacy). 
 
     [bookmark: pgfId-394912] b. If you have configured the switch with your privacy protocol, choose your Auth-Privacy choice.
 
      
       
     
 
     
 
     [bookmark: pgfId-394913]Note You may use SNMP v2 credentials for CDP discovery as the most of the Catalyst switches do not use MD5-DES for configuration.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-394914]Note If you want a clean fabric discovery, remove the fabric and rediscover it. If you want a clean LAN discovery, unmanage LAN, remove the CDP seed switch and then rediscover it.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-394915]Step 13 Enter the username and password for the switch.
 
     [bookmark: pgfId-394916]Step 14 (Optionsl) To limit the discovery, specify the VSAN range. 
Scoping limits the resources discovered by Cisco DCNM-SAN client. You can either include a range of VSANs to be discovered or exclude a range of VSANs from being discovered.
 
     [bookmark: pgfId-394917] a. To limit the discovery to a range of VSANs, click Included VSAN List radio button. Specify the range of VSANs.
 
     [bookmark: pgfId-394918] b. To exclude a range of VSANs from being discovered, click Excluded VSAN List radio button. Specify the range of VSANs to be excluded.
 
     [bookmark: pgfId-394919]Step 15 Click Discover.
 
     [bookmark: pgfId-394920]You see the Control Panel dialog box.
 
     [bookmark: pgfId-406173]Figure 7-11 Control Panel Dialog Box: Open Tab
 
      
      [image: ] 
     
 
     [bookmark: pgfId-380137]
 
     [bookmark: pgfId-380138]You see the included and excluded VSANs list under the Fabric tab.
 
     [bookmark: pgfId-406181]Figure 7-12 Control Panel Dialog Box: Fabrics Tab
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-395033]Note In the open tab, you see all the discovered fabrics displayed in the control panel. You need to click on the Open button to see all the discovered Ethernet switches.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-395034]Step 16 Check the check box(es) next to the fabric(s) you want to open in the Select column, or click Discover to add a new fabric.
 
      
       
     
 
     
 
     [bookmark: pgfId-395035]Note Only network administrators can continuously manage or unmanage fabrics. For more information, see the “Selecting a Fabric to Manage Continuously” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-395039]Step 17 Click Open to open the selected fabric(s).
 
      
       
     
 
     
 
     [bookmark: pgfId-395040]Note • If you have an incomplete view of your fabric, rediscover the fabric with a user that has no 
 VSAN restriction.
 • If the fabric includes a Cisco Nexus 5000 Series switch, then the Layer 2 node appears under 
 the Switches > Interfaces > Ethernet tree, the VFC (FCoE) node appears under the 
 Switches > Interfaces tree, and the FCoE node appears under the Switches tree in the 
 Physical Attributes pane.
 • For Cisco Nexus 5000 Series switches in the fabric, the tooltip for the switch shows the bind
 information of a virtual Fibre Channel interface to its corresponding Ethernet interface, such
 as vfc2(eth1/4).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-395047]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-395048]You can launch Cisco DCNM-SAN Client from within a running instance of Cisco DCNM-SAN.
 
    
 
     
      [bookmark: pgfId-398849]DETAILED STEPS
 
     
 
     [bookmark: pgfId-395049]Step 1 Choose File > Open or click the Open Switch Fabric icon on the Cisco DCNM-SAN toolbar. 
 
     [bookmark: pgfId-395050]You see the Control Panel dialog box.
 
     [bookmark: pgfId-395051]Step 2 Check the check box(es) next to the fabric(s) you want to open in the Select column and click Open. 
 
      
       
     
 
     
 
     [bookmark: pgfId-395052]Note Changes made using Cisco DCNM-SAN are applied to the running configuration of the switches that you are managing. If you have made changes to the configuration or performed an operation (such as activating zones), Cisco DCNM-SAN prompts you to save your changes before you exit.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-380169]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-395057]Launching Cisco DCNM-SAN Client Using Launch Pad
 
     [bookmark: pgfId-395058]Starting from Cisco NX-OS Release 4.2(0), you can use Cisco DCNM-SAN launch pad to connect to any server by specifying the IP address of the server. With launch pad, you can connect to any Cisco DCNM-SAN Server version 3.3(0) and later. Launch pad establishes connection with the server using HTTP protocol.
 
    
 
     
      [bookmark: pgfId-395059]DETAILED STEPS
 
     
 
     [bookmark: pgfId-395060]Step 1 Open your browser and enter the IP address where you installed Cisco DCNM-SAN Server, or enter localhost if you installed Cisco DCNM-SAN Server on your local workstation. 
 
     [bookmark: pgfId-395061]You see the Cisco DCNM-SAN Web Server Login dialog box.
 
     [bookmark: pgfId-406189]Figure 7-13 DCNM-SAN Web Client Login Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-395066]Step 2 Enter your user name and password and click Login.
 
     [bookmark: pgfId-395067]You see the Cisco DCNM-SAN Web Client Summary page.
 
     [bookmark: pgfId-395068]Step 3 Click the Download link in the upper right corner of the page.
 
     [bookmark: pgfId-395069]You see the Download page for Cisco DCNM-SAN and Device Manager.
 
     [bookmark: pgfId-406197]Figure 7-14 Download Page for DCNM-SAN and Device Manager
 
      
      [image: ] 
     
 
     [bookmark: pgfId-395074]Step 4 Click the link for Cisco DCNM-SAN.
 
     [bookmark: pgfId-380200]You see the Cisco DCNM-SAN Server launch pad.
 
     [bookmark: pgfId-395112]Step 5 Enter the host name of the server or IP address in the Server URL drop-down list. 
 
     [bookmark: pgfId-395113]Step 6 Click Start.
 
     [bookmark: pgfId-406202]Figure 7-15 DCNM-SAN Launch Pad
 
     [bookmark: pgfId-380210]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-345070][bookmark: 58950]Setting [bookmark: marker-345068]Cisco DCNM-SAN Preferences[bookmark: marker-345069]
 
    [bookmark: pgfId-345071]To set your preferences for the behavior of the Cisco DCNM-SAN, choose File > Preferences from the Cisco DCNM-SAN menu bar. You see the Preferences dialog box with the following tabs for setting different components of the application:
 
     
     	 [bookmark: pgfId-345072]General
 
     	 [bookmark: pgfId-345073]SNMP
 
     	 [bookmark: pgfId-345074]Map
 
    
 
    [bookmark: pgfId-345076]The default [bookmark: marker-345075]General preferences for Cisco DCNM-SAN are as follows:
 
     
     	 [bookmark: pgfId-345078] Show Device Name by [bookmark: marker-345077]—Displays the switches in the Fabric pane by IP address, DNS name, or logical name. The default setting for this value is Logical Name.
 
     	 [bookmark: pgfId-345080] Show WorldWideName (WWN) Vendor [bookmark: marker-345079]—Displays the world wide name vendor name in any table or listing displayed by Cisco DCNM-SAN. Check the Prepend Name check box to display the name in front of the IP address of the switch. Check the Replacing Vendor Bytes check box to display the name instead of the IP address. The default is the Prepend Name option.
 
     	 [bookmark: pgfId-345082] Show End Device Using [bookmark: marker-345081]—Displays end devices in the Fabric pane using alias or pWWN alias. The default setting for this value is Alias.
 
     	 [bookmark: pgfId-345084] Show Shortened iSCSI Names [bookmark: marker-345083]—Displays the default setting for this value is OFF.
 
     	 [bookmark: pgfId-345086] Show Timestamps as Date/Time [bookmark: marker-345085]—Displays timestamps in the date/time format. If this preference is not checked, timestamps are displayed as elapsed time. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-345088] Telnet Path [bookmark: marker-345087]—Displays the path for the telnet.exe file on your system. The default is  telnet.exe , but you need to browse for the correct location.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-345089]Note If you browse for a path or enter a path and you have a space in the pathname (for example, c:\program files\telnet.exe), then the path will not work. To get the path to work, you must manually place quotes around it (for example, "c:\program files\telnet.exe").
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-345091] Use Secure Shell instead of Telnet [bookmark: marker-345090]—Specifies whether to use SSH or Telnet when using the CLI to communicate with the switch. If enabled, you must specify the path to your SSH application. The default setting is disabled.
 
     	 [bookmark: pgfId-345093] Confirm Deletion [bookmark: marker-345092]—Displays a confirmation pop-up window when you delete part of your configuration using Cisco DCNM-SAN. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-345095] Export Tables with Format [bookmark: marker-345094]—Specifies the type of file that is created when you export a table using Device Manager. The options are tab-delimited or XML. The default setting is Tab-Delimited.
 
     	 [bookmark: pgfId-345097][bookmark: marker-345096]Show CFS Warnings—Shows warning messages if CFS is not enabled on all switches for a selected feature.
 
    
 
    [bookmark: pgfId-345098]The default SNMP preferences for Cisco DCNM-SAN are as follows:
 
     
     	 [bookmark: pgfId-345100] Retry request 1 time(s) after 5 sec timeout [bookmark: marker-345099]—You can set the retry value to 0-5, and the timeout value to 3-30.
 
     	 [bookmark: pgfId-345102] Trace SNMP packets in Log [bookmark: marker-345101]—The default setting for this value is ON.
 
     	 [bookmark: pgfId-345104] Enable Audible Alert when Event Received [bookmark: marker-345103]—The default setting for this value is OFF.
 
    
 
    [bookmark: pgfId-345106]The default M[bookmark: marker-345105]ap preferences for Cisco DCNM-SAN are as follows:
 
     
     	 [bookmark: pgfId-345108] Display Unselected VSAN Members [bookmark: marker-345107]—Displays the unselected VSAN members in the Fabric pane. The default setting for this value is ON.
 
     	 [bookmark: pgfId-345110] Display End Devices [bookmark: marker-345109]—Displays the fabric’s end devices in the Fabric pane. The default setting for this value is ON.
 
     	 [bookmark: pgfId-345112] Display End Device Labels [bookmark: marker-345111]—Displays the fabric’s end device labels in the Fabric pane. The default setting for this value is OFF.
 
     	 [bookmark: pgfId-345114] Expand Loops [bookmark: marker-345113]—Displays the loops in the fabric as individual connections in the Fabric pane. The default setting for this value is OFF.
 
     	 [bookmark: pgfId-345116] Expand Multiple Links [bookmark: marker-345115]—Displays multiple links in the Fabric pane as separate lines instead of one thick line. The default setting for this value is OFF.
 
     	 [bookmark: pgfId-345118] Open New Device Manager Each Time [bookmark: marker-345117]—Opens a new instance of Device Manager each time that you invoke it from a switch in your fabric. The default value is OFF, which means that only one instance of Device Manager is open at a time.
 
     	 [bookmark: pgfId-345120] Select Switch or Link from Table [bookmark: marker-345119]—Allows you to select a switch or link in the Fabric pane by clicking the switch or link in a table in the Information pane. The default setting for this value is disabled (unchecked), which means clicking a switch or link in the table does not change the switch or link selection in the Fabric pane.
 
     	 [bookmark: pgfId-345122] Layout New Devices Automatically [bookmark: marker-345121]—Automatically places new devices in the Fabric pane in an optimal configuration. The default setting for this value is OFF. In this mode, when you add a new device, you must manually reposition it if the initial position does not suit your needs.
 
     	 [bookmark: pgfId-345124] Use Quick Layout when Switch has 30 or more End Devices [bookmark: marker-345123]—Displays the default setting for this value (30). You can enter any number in this field. Enter 0 to disable Quick Layout.
 
     	 [bookmark: pgfId-345126] Override Preferences for Non-default Layout [bookmark: marker-345125]—Displays the default setting for this value (ON).
 
     	 [bookmark: pgfId-345128] Automatically Save Layout [bookmark: marker-345127]—If this option is enabled, any changes in the layout are automatically saved. The default setting for this value is ON. 
 
     	 [bookmark: pgfId-345130] Detach Overview Window [bookmark: marker-345129]—Allows you to easily center the Fabric pane on the area of the fabric that you want to see. (This feature is useful for large fabrics that cannot be displayed entirely within the Fabric pane.) Bring up the overview window by clicking the Show/Hide Overview Window button. It overlays the fabric window and remains there until you click the Show/Hide Overview Window button again. If you enable this preference, you can detach the overview window and move it to one side while you access the Fabric pane. The default setting for this value is disabled (unchecked).
 
    
 
   
 
    
     [bookmark: pgfId-345133][bookmark: 1323]Network [bookmark: marker-345132]Fabric Discovery
 
    [bookmark: pgfId-345134]Cisco DCNM-SAN collects information about the fabric topology through SNMP queries to the switches that are connected to Cisco DCNM-SAN. The switch replies after having discovered all devices connected to the fabric by using the information from its FSPF technology database and the Name Server database and collected using the Fabric Configuration Server’s request/response mechanisms that are defined by the FC-GS-3/4 standard. When you start Cisco DCNM-SAN, you enter the IP address (or host name) of a seed switch for discovery.
 
    [bookmark: pgfId-345135]After you start Cisco DCNM-SAN and the discovery completes, Cisco DCNM-SAN presents you with a view of your network fabric, including all discovered switches, hosts, and storage devices.
 
   
 
    
     [bookmark: pgfId-369178]Network LAN Discovery
 
    [bookmark: pgfId-369179]Starting from NX-OS Release 4.2(0), you can discover Nexus and Catalyst Ethernet switches using Cisco Discovery Protocol (CDP). DataCenter 3(DC3) switches are displayed under Datacenter and LAN nodes. Cisco DCNM-SAN displays basic information about DC3 switches and its ISLs. 
 
     
      [bookmark: pgfId-366421]Viewing Ethernet Switches
 
    
 
     
      [bookmark: pgfId-367123]DETAILED STEPS
 
     
 
     [bookmark: pgfId-377966]Step 1 Click the LAN node under Datacenter node.
 
     [bookmark: pgfId-377967]Step 2 Click Switches tab in the Information pane.
 
     [bookmark: pgfId-377971]You can see the switch information as shown in Figure 7-16. 
 
     [bookmark: pgfId-406220]Figure 7-16 [bookmark: 34146]Ethernet Switch Information
 
     [bookmark: pgfId-406224]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-367903]
 
      
       
     
 
     
 
     [bookmark: pgfId-367908]Note Datacenter is the parent node of SAN and LAN nodes. The SAN node remains in the tree as the parent for all the fabrics.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-367933]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-368203]Removing a LAN 
 
    
 
     
      [bookmark: pgfId-368504]DETAILED STEPS
 
     
 
     [bookmark: pgfId-368542]Step 1 Choose Server > Admin.
 
     [bookmark: pgfId-368861]You can see the switch information as shown in Figure 7-17.
 
     [bookmark: pgfId-406241]Figure 7-17 [bookmark: 93327]Control Panel
 
      
      [image: ] 
     
 
     [bookmark: pgfId-368900]Step 2 Click to select the switch IP of the LAN you want to remove.
 
     [bookmark: pgfId-368976]Step 3 Click Remove.
 
     [bookmark: pgfId-368863]
 
      
      
 
     
 
     
 
      
       [bookmark: pgfId-345142]DETAILED STEPS
 
      
 
      [bookmark: pgfId-345144]Step 1 [bookmark: 1338 ]Expand End Devices and then choose Storage or Hosts in the Physical Attributes pane.
 
      [bookmark: pgfId-345145]You see the end devices displayed in the Information pane.
 
      [bookmark: pgfId-345147]Step 2 [bookmark: 1341 ]Click one of the devices in the Fabric pane, or click the Enclosures tab of the Information pane, and then click the device name (in the Name field) that you want to include in the enclosure.
 
      [bookmark: pgfId-345149]Step 3 [bookmark: 1343 ]Enter a name to identify the new enclosure in the Fabric pane map.
 
      [bookmark: pgfId-345151]Step 4 [bookmark: 1345 ]Click once on the device name in the Name field. To select more than one name, press the Shift key and click each of the other names.
 
      [bookmark: pgfId-345153]Step 5 [bookmark: 1347 ]Press Ctrl-C to copy the selected name(s).
 
      [bookmark: pgfId-345155]Step 6 [bookmark: 1349 ]Press Ctrl-V to paste the device name into the Name field.
 
       
        
      
 
      
 
      [bookmark: pgfId-345156]Note To remove devices from an enclosure, triple click the device name and press Delete. To remove an enclosure, repeat this step for each device in the enclosure.
 
       
       
 
      
 
      
 
      [bookmark: pgfId-398964]
 
       
       
 
      
 
      
 
     
 
      
       [bookmark: pgfId-345158]Using Alias Names as Enclosures
 
     
 
      
       [bookmark: pgfId-345160]DETAILED STEPS
 
      
 
      [bookmark: pgfId-345161]Step 1 Expand End Devices and choose Hosts or Storage from the Physical Attributes pane. 
 
      [bookmark: pgfId-345162]You see the list of devices in the Information pane. The NxPorts tab is the default.
 
      [bookmark: pgfId-345163]Step 2 Right-click the enclosure names that you want to convert to alias names and choose Alias > Enclosure as shown in Figure 7-18.
 
      [bookmark: pgfId-406255]Figure 7-18 [bookmark: 71847]Alias Enclosure
 
      [bookmark: pgfId-406259]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-351837]The Ailas > Enclosures window appears as shown in Figure 7-19. It contains a list of expressions. You can also add expressions to the list and modify expressions in the current list. 
 
      [bookmark: pgfId-406276]Figure 7-19 [bookmark: 74098]List of Expressions
 
       
       [image: ] 
      
 
      [bookmark: pgfId-351668]Step 3 Click the Apply Changes icon to save the changes and then click Close.
 
       
        
      
 
      
 
      [bookmark: pgfId-351616]Note Cisco DCNM-SAN uses the regular expressions to convert multiple alias names into one enclosure. The alias names should be in the same expression pattern rule. You can create enclosure names from selected aliases using the regular expresssions list.
 
       
       
 
      
 
      
 
      [bookmark: pgfId-395189]
 
       
       
 
      
 
      
 
     
 
      
       [bookmark: pgfId-359874]Using Alias Names as Descriptions
 
     
 
      
       [bookmark: pgfId-359876]DETAILED STEPS
 
      
 
      [bookmark: pgfId-359647]Step 1 Choose End Devices and from the Physical Attributes pane.
 
      [bookmark: pgfId-359669]Step 2 Click the General tab.
 
      [bookmark: pgfId-359674]You see the list of devices in the Information pane. 
 
      [bookmark: pgfId-359718]Step 3 Select the device names that you want to populate the description with alias names and then click Alias > Enclosure button as shown in Figure 7-20.
 
      [bookmark: pgfId-359719]You see the alias names are copied to corresponding rows in the description column.
 
      [bookmark: pgfId-406290]Figure 7-20 [bookmark: 48366]Data Population: Alias to Description
 
       
        
      
 
      
 
      [bookmark: pgfId-359771]Note Cisco DCNM-SAN does not parse or format the alias name while copying.
 
       
       
 
      
 
      
 
      [bookmark: pgfId-359770]
 
       
       
 
      
 
      
 
      [bookmark: pgfId-345179]The default-role contains the access permissions needed by a user to access the GUI (Cisco DCNM-SAN and Device Manager). These access permissions are automatically granted to all users in order for them to use the GUI.
 
      [bookmark: pgfId-345180]Cisco Cisco DCNM-SAN uses SNMPv3 to establish role-based management access. After completing the setup routine, a single role, user name, and password are established. The role assigned to this user allows the highest level of [bookmark: marker-345181]privileges, which includes creating users and roles. Use the Cisco Cisco DCNM-SAN to create roles and users and to assign [bookmark: marker-345182]passwords as required for secure management access in your network.
 
     
 
      
       [bookmark: pgfId-345185][bookmark: 10418][bookmark: 31611]Using Cisco DCNM-SAN Wizards[bookmark: marker-345184]
 
      [bookmark: pgfId-345187]Cisco DCNM-SAN Client provides the following [bookmark: marker-345186]wizards to facilitate common configuration tasks:
 
       
       	 [bookmark: pgfId-345189][bookmark: marker-345188]VSAN—Creates VSANs on multiple switches in the fabric and sets VSAN attributes including interop mode, load balancing, and FICON.
 
       	 [bookmark: pgfId-345191][bookmark: marker-345190]Zone Edit Tool—Creates zone sets, zones, and aliases. Adds members to zones and edits the zone database.
 
       	 [bookmark: pgfId-345193][bookmark: marker-345192]IVR Zone—Creates IVR zone sets, zones, and aliases. Enables IVR NAT and auto-topology. Adds members to IVR zones, and edits the IVR zone database.
 
       	 [bookmark: pgfId-377300][bookmark: marker-377299]FCoE—Creates virtual Fibre Channel (FC) interfaces and VLAN-VSAN mappings, and binds virtual FC interfaces to Ethernet interfaces or PortChannels.
 
       	 [bookmark: pgfId-345195][bookmark: marker-345194]PortChannel—Creates PortChannels from selected ISLs either manually or automatically. Sets PortChannel attributes such as channel ID and trunking mode. 
 
       	 [bookmark: pgfId-345197][bookmark: marker-345196]FCIP—Creates FCIP links between Gigabit Ethernet ports. Enables Fibre Channel write acceleration and IP compression.
 
       	 [bookmark: pgfId-345199][bookmark: marker-345198]DPVM—Establishes dynamic port VSAN membership, enables autolearning, and activates the DPVM database.
 
       	 [bookmark: pgfId-345201][bookmark: marker-345200]Port Security—Prevents unauthorized access to Cisco MDS switches and reports these intrusions to the administrator.
 
       	 [bookmark: pgfId-345203][bookmark: marker-345202]iSCSI—Creates zones for iSCSI initiators and adds a VSAN to a target-allowed VSAN list. 
 
       	 [bookmark: pgfId-345205][bookmark: marker-345204]NPV—Reduces the number of Fibre Channel domain IDs in SANs.
 
       	 [bookmark: pgfId-345207][bookmark: marker-345206]QoS—Sets QoS attributes for zones in the selected VSAN. 
 
       	 [bookmark: pgfId-345209][bookmark: marker-345208]IP ACL—Creates ordered IP access control lists and distributes to selected switches in the fabric.
 
       	 [bookmark: pgfId-345211][bookmark: marker-345210]License Install—Facilitates download and installation of licenses in selected switches in the fabric.
 
       	 [bookmark: pgfId-345213][bookmark: marker-345212]Software Install—Verifies image compatibility and installs software images on selected switches in the fabric.
 
      
 
     
 
      
       [bookmark: pgfId-371002][bookmark: 13144]Cisco DCNM-SAN Troubleshooting Tools[bookmark: marker-371001]
 
      [bookmark: pgfId-371004]Cisco DCNM-SAN has several [bookmark: marker-371003]troubleshooting tools available from the toolbar or Tools menu
 
       
       	 [bookmark: pgfId-371009] Zone Merge Analysis [bookmark: marker-371008]—The zone merge analysis tool (available from the Zone menu) enables you to determine if zones will merge successfully when two Cisco MDS switches are interconnected. If the interconnected switch ports allow VSANs with identical names or contain zones with identical names, then Cisco DCNM-SAN verifies that the zones contain identical members. The merge analysis tool can be run before attempting a merge or after fabrics are interconnected to determine zone merge failure causes.
 
       	 [bookmark: pgfId-345225] End-to-End Connectivity [bookmark: marker-345224]—Cisco DCNM-SAN’s end-to-end connectivity analysis tool uses FC Ping to verify interconnections between Cisco MDS switches and end-device (HBAs and storage devices) in a particular VSAN. In addition to basic connectivity, Cisco DCNM-SAN can optionally verify the following:
 
      
 
      [bookmark: pgfId-345226] – Paths are redundant.
 
      [bookmark: pgfId-345227] – Zones contain at least two members.
 
      [bookmark: pgfId-345228]End devices are connected to a manageable switch (have a currently active in-band or out-of-band management path.)
 
       
       	 [bookmark: pgfId-345229] Switch Health Analysis —You can run an in-depth switch health analysis with Cisco DCNM-SAN. It verifies the status of all critical Cisco MDS switches, modules, ports, and Fibre Channel services. Over 40 conditions are checked. This tool provides a very fast, simple, and thorough way to assess Cisco MDS switch health.
 
       	 [bookmark: pgfId-345230] Fabric Configuration Analysis —Cisco DCNM-SAN includes a fabric configuration analysis tool. It compares the configurations of all Cisco MDS switches in a fabric to a reference switch or a policy file. You can define what functions to check and what type of checks to perform. The analysis can look for mismatched values, and missing or extra values. If all configuration checking is performed for all functions, over 200 checks are performed for each Cisco MDS switch.
 
      
 
      [bookmark: pgfId-345231]After the analysis is run, the results are displayed with details about the issues that were discovered. You can automatically resolve configuration differences by selecting them and clicking the Resolve button. Cisco DCNM-SAN automatically changes the configuration to match the reference switch or policy file.
 
     
 
      
       [bookmark: pgfId-291154][bookmark: 80568]Integrating Cisco DCNM-SAN and Data Center Network Management Software
 
      [bookmark: pgfId-372411]Cisco DCNM-SAN and Data Center Network Management (DCNM) software are the two major components in the Cisco next-generation data center environment. Cisco DCNM-SAN configures Cisco Nexus 5000 Series switches and Cisco MDS 9000 Series switches. DCNM software configures Cisco Nexus 5000 and Cisco Nexus 7000 Series switches. The Scope of the Cisco DCNM-SAN software is confined to SAN while the scope of the DCNM-LAN software is limited to the LAN network. 
 
      [bookmark: pgfId-372507]In a typical data center environment, the mixture of SAN and LAN topology are becoming increasingly common. Since the two management software are not designed to work across their topology limits, users are not able to navigate to Cisco DCNM-SAN from DCNM-LAN software and vice versa. 
 
      [bookmark: pgfId-372521]Integrating Cisco DCNM-SAN and DCNM-LAN provides a single platform to manage the networks in data center 3.0 and it provides seamless user experience under specific configuration. Starting from Cisco MDS NX-OS Release 4.2, the directory structure has changed to accommodate the integration of Cisco DCNM-SAN with Cisco Nexus 5000 Series products. 
 
       
        [bookmark: pgfId-372412]Launching a Switch from the Topology Map
 
      
 
       
        [bookmark: pgfId-372562]DETAILED STEPS
 
       
 
       [bookmark: pgfId-372564]Step 1 In the Cisco DCNM-SAN fabric pane, right-click the Nexus switch in the LAN map that you want to open with DCNM.
 
       [bookmark: pgfId-372735]You see the pop-up menu as shown in Figure 7-21.
 
       [bookmark: pgfId-406311]Figure 7-21 [bookmark: 49706]Open with DCNM
 
        
        [image: ] 
       
 
       [bookmark: pgfId-372718]Step 2 In the pop up menu, click DCNM and select appropriate context.
 
       [bookmark: pgfId-372758]
 
        
        
 
       
 
       
 
      
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-255677][bookmark: 21918]Device Manager 
      
      
 
     
 
 
    [bookmark: pgfId-258659]This chapter contains descriptions and instructions for using the Device Manager. This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-254782]Information About Device Manager
 
     	 [bookmark: pgfId-257366]Device Manager Features
 
     	 [bookmark: pgfId-254786]Using Device Manager Interface
 
     	 [bookmark: pgfId-254794]Setting Device Manager Preferences
 
    
 
   
 
    
     [bookmark: pgfId-246879]Information [bookmark: 65260]About Device Manager[bookmark: marker-253689]
 
    [bookmark: pgfId-246881]Device Manager provides a graphical representation of a Cisco MDS 9000 Family switch chassis, a Cisco Nexus 5000 Series switch chassis, or a Cisco Nexus 7000 Series switch chassis including the installed switching modules, the supervisor modules, the status of each port within each module, the power supplies, and the fan assemblies.
 
     
      
    
 
    
 
    [bookmark: pgfId-259782]Note Device Manager support for Cisco Nexus 7000 Series switches is only for FCoE. Non-FCoE modules appear as Unsupported Card.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-253876]The tables in the DCNM-SAN Information pane basically correspond to the dialog boxes that appear in Device Manager. However, while DCNM-SAN tables show values for one or more switches, a Device Manager dialog box shows values for a single switch. Also, Device Manager provides more detailed information for verifying or troubleshooting device-specific configuration than DCNM-SAN.
 
    [bookmark: pgfId-253877]Device Manager Release 4.2 and later provides enhanced security using multiple perspectives (simple and advanced) allowing role based-access to its features. The Device Manager perspective filters out menu items that are not relevant to the user. Users with server admin role, can only access a subset of the fabric related features. The server admin role will not be able to manage Device Manager users or connected clients. 
 
    [bookmark: pgfId-256691]Device Manager Release 5.0 and later supports all the software features that are offered by Cisco NX-OS for managing Cisco MDS 9148 and 9124 Multilayer Fabric switches. Cisco MDS 9148 Multilayer Fabric Switch is a 48-port (1/2/4/8G) FC 1RU switch based on the Sabre ASIC andCisco MDS 9124 Multilayer Fabric switch is a 1/2/4/8G switch module for HP BladeServer based on the Sabre ASIC. Device Manager and DCNM-SAN allow you to discover, display, configure, monitor and service both these new switches. Device Manager also supports the following Cisco Nexus 2000 Series Fabric Extenders on a Cisco Nexus 5000 Series switch that runs Cisco NX-OS Release 5.0(1):
 
     
     	 [bookmark: pgfId-256243]Cisco Nexus 2148T Fabric Extender—It has four 10-Gigabit Ethernet fabric interfaces for its uplink connection to the parent Cisco Nexus 5000 Series switch and eight 1-Gigabit Ethernet or 10-Gigabit Ethernet host interfaces for its downlink connection to servers or hosts.
 
     	 [bookmark: pgfId-256244]Cisco Nexus 2232PP Fabric Extender—It has eight 10-Gigabit Ethernet fabric interfaces with SFP+ interface adapters for its uplink connection to the parent Cisco Nexus 5000 Series switch and 32 10-Gigabit Ethernet fabric interfaces with SFP+ interface adapters for its downlink connection to servers or hosts.
 
     	 [bookmark: pgfId-256318]Cisco Nexus 2248TP Fabric Extender—It has four 10-Gigabit Ethernet fabric interfaces with small form-factor pluggable (SFP+) interface adapters for its uplink connection to the parent Cisco Nexus 5000 Series switch and 48 1000BASE-T (1-Gigabit) Ethernet host interfaces for its downlink connection to servers or hosts.
 
    
 
    [bookmark: pgfId-256245]Device Manager allows you to discover and display these Fabric Extenders. Cisco Device Manager and the Cisco DCNM-SAN client support provisioning and monitoring of the 48-port 8-Gbps Advanced Fibre Channel switching module (DS-X9248-256K9) and the 32-port 8-Gbps Advanced Fibre Channel switching module (DS-X9232-256K9).
 
     
      [bookmark: pgfId-254943][bookmark: 16205]Device Manager Features
 
     [bookmark: pgfId-254945]Device Manager provides two views: Device View and Summary View. Use Summary View to monitor interfaces on the switch. Use Device View to perform switch-level configurations including the following:
 
      
      	 [bookmark: pgfId-253695]Configure virtual Fibre Channel interfaces.
 
      	 [bookmark: pgfId-253696]Configure Fibre Channel over Ethernet (FCoE).
 
      	 [bookmark: pgfId-246890]Configure zones for multiple VSANs.
 
      	 [bookmark: pgfId-246891]Manage ports, PortChannels, and trunking.
 
      	 [bookmark: pgfId-246892]Manage SNMPv3 security access to switches.
 
      	 [bookmark: pgfId-246893]Manage CLI security access to the switch.
 
      	 [bookmark: pgfId-246894]Manage alarms, events, and notifications.
 
      	 [bookmark: pgfId-246895]Save and copy configuration files and software image.
 
      	 [bookmark: pgfId-246896]View hardware configuration.
 
      	 [bookmark: pgfId-246897]View chassis, module, port status, and statistics.
 
     
 
    
 
     
      [bookmark: pgfId-256009][bookmark: 85361][bookmark: 10419]Using Device Manager Interface
 
     [bookmark: pgfId-258667]This section describes the Device Manager interface as shown in Figure 8-1.
 
     [bookmark: pgfId-258670]Figure 8-1 [bookmark: 48952]Device Manager, Device Tab[bookmark: marker-258669]
 
     [bookmark: pgfId-258696]
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      [bookmark: pgfId-246941]Menu Bar
 
     [bookmark: pgfId-246942]The menu bar at the top of the Device Manager main window provides options for managing and troubleshooting a single switch. The menu bar provides the following options:
 
      
      	 [bookmark: pgfId-246943]Device—Opens an instance of Device Manager, sets management preferences, sets the page layout, opens a Telnet/SSH session with the current switch, exports a device image, and closes the Device Manager application.
 
      	 [bookmark: pgfId-246944]Physical—Allows you to view and manage inventory, modules, temperature sensors, power supplies, fans, and the entire system.
 
      	 [bookmark: pgfId-246945]Interface—Allows you to configure and manage PortChannels, as well as Fibre Channel, Ethernet, iSCSI, and FICON ports. Also provides diagnostic, management and monitoring capabilities, as well as SPAN and port tracking.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-256266]Note The Interface > Port Channels menu option does not appear if the Cisco Nexus 5000 Series switch is in NPV mode and runs a Cisco NX-OS release prior to 4.2(1).
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-256558]FC—Allows you to configure and manage VSAN, domain, and name server characteristics. Also provides advanced configuration capabilities.
 
      	 [bookmark: pgfId-253955]FCoE—Allows you to configure the FCoE parameters and map VSANs to VLANs on a Cisco Nexus 5000 Series switch.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-253963]Note The FCoE menu option appears only if the Cisco Nexus 5000 Series switch runs Cisco NX-OS Release 4.0(1a) or later releases.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-246947]FICON—Allows you to configure and manage FICON VSANs, configure RLIR ERL information, swap selected FICON ports, and view FICON port numbers.
 
      	 [bookmark: pgfId-246948]IP—Allows you to configure and manage the following types of information: FCIP, iSCSI, iSNS, routes, VRRP, and CDP.
 
      	 [bookmark: pgfId-246949]Security—Allows you to configure and manage FCSP, port security, iSCSI security, SNMP security, common roles, SSH, AAA, and IP ACLs.
 
      	 [bookmark: pgfId-246950]Admin—Allows you to save, copy, edit, and erase the switch configuration, monitor events, manipulate Flash files, manage licenses, configure NTP, use CFS, and reset the switch. Also enables you to use the show tech support, show cores, and show image commands.
 
      	 [bookmark: pgfId-246951]Logs—Shows the various logs: message, hardware, events, and accounting. Also displays FICON link incidents, and allows you to configure the syslog setup.
 
      	 [bookmark: pgfId-246952]Help—Displays online help topics for specific dialog boxes in the Information pane.
 
     
 
    
 
     
      [bookmark: pgfId-256031]Toolbar Icons
 
      
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
       
        
        [bookmark: pgfId-235606]Table 8-1 [bookmark: 80867][bookmark: marker-256054]Device Manager Main Toolbar 
 
        
        
         
         	 
           
           [bookmark: pgfId-235610]Icon 
          
  
         	 
           
           [bookmark: pgfId-235612]Description 
          
  
        
 
        
          Open Device 
         	[bookmark: pgfId-235619]Opens the Device Manager view for another switch, with the option to open this view in a separate window.
  
        
 
        
          Refresh Display 
         	[bookmark: pgfId-235626]Communicates with the switch and displays the information in the Device Manager view.
  
        
 
        
          Command-Line Interface 
         	[bookmark: pgfId-235633]Opens a separate CLI command window to the switch.
  
        
 
        
          Configure Selected 
         	[bookmark: pgfId-235640]Opens a configuration dialog box for the selected component (line card or port).
  
        
 
        
          SysLog 
         	[bookmark: pgfId-235647]Opens a window that lists the latest system messages that occurred on the switch.
  
        
 
        
          VSANs 
         	[bookmark: pgfId-235661]Opens the VSAN dialog box that provides VSAN configuration for the switch.
  
        
 
        
          Save Configuration 
         	[bookmark: pgfId-235675]Saves the current running configuration to the startup configuration.
  
        
 
        
          Copy 
         	[bookmark: pgfId-235682]Copies configuration file between server and switch.
  
        
 
        
          Toggle FICON/Interface Port Labels 
         	[bookmark: pgfId-235689]Toggles the FICON and interface port labels.
  
        
 
        
          Select VSAN 
         	[bookmark: pgfId-237289]Filters the port display to show only those ports belonging to the selected VSAN.
  
        
 
        
          Help 
         	[bookmark: pgfId-235752]Accesses online help for Device Manager.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-256044]Dialog Boxes
 
     [bookmark: pgfId-256045]If a toolbar icon is selected, a dialog box may open that allows configuration of the selected feature. The dialog box may include table manipulation icons. See the “Information Pane” for descriptions of these icons.
 
    
 
     
      [bookmark: pgfId-255292]Tabs[bookmark: marker-255291]
 
     [bookmark: pgfId-255293]Click the Device tab on the Device Manager main window to see a graphical representation of the switch chassis and components.
 
      
       
     
 
     
 
     [bookmark: pgfId-256290]Note The Device view also shows the switch chassis information of the Cisco Nexus 2000 Series Fabric Extenders (FEXs) that are connected to a Cisco Nexus 5000 Series switch that runs Cisco NX-OS Release 5.0(1).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-255294]Click the Summary tab on the Device Manager main window to see a summary of active interfaces on a single switch, as well as Fibre Channel and IP neighbor devices. The Summary View also displays port speed, link utilization, and other traffic statistics. There are two buttons in the upper left corner of the Summary View tab used to monitor traffic. To monitor traffic for selected objects, click the Monitor Selected Interface Traffic Util% button. To display detailed statistics for selected objects, click the Monitor Selected Interface Traffic Details button. You can set the poll interval, the type or Rx/Tx display, and the thresholds.
 
      
       
     
 
     
 
     [bookmark: pgfId-255295]Note The Summary tab does not display the utilization statistics (Util%) of virtual Fibre Channel interfaces for Cisco Nexus 5000 Series switches that run Cisco NX-OS Release 4.2.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-246976]Legend[bookmark: marker-246975]
 
     [bookmark: pgfId-246978]The legend at the bottom right of the Device Manager indicates [bookmark: marker-246977]port status, as follows:
 
     [bookmark: pgfId-246979]Colors
 
      
      	 [bookmark: pgfId-246980]Green—The port is up.
 
      	 [bookmark: pgfId-246981]Brown—The port is administratively down.
 
      	 [bookmark: pgfId-246982]Red cross—The port is down or has failed as a result of either hardware failure, loopback Diagnostic failure, or link failure.
 
      	 [bookmark: pgfId-260139]Red square—The port is down or has failed as a result of failure other than described for red cross.
 
      	 [bookmark: pgfId-246983]Amber—The port has a minor fault condition as a result of either signal loss, synchronization loss, credit loss, LIP F8 receiver failure, non operational sequence receiver, or off-line sequence receiver failure.
 
      	 [bookmark: pgfId-246984]Gray—The port is unreachable.
 
      	 [bookmark: pgfId-246985]Blue—The port is out of service.
 
     
 
     [bookmark: pgfId-246986]Labels
 
      
      	 [bookmark: pgfId-246987]X—Link failure
 
      	 [bookmark: pgfId-246988]E—ISL
 
      	 [bookmark: pgfId-246989]TE—Multi-VSAN ISL
 
      	 [bookmark: pgfId-246990]F—Host/storage
 
      	 [bookmark: pgfId-260194]FL—F loop
 
      	 [bookmark: pgfId-260195]I— iSCSI 
 
      	 [bookmark: pgfId-260196]SD—SPAN destination
 
      	 [bookmark: pgfId-246994]CH—Channel
 
      	 [bookmark: pgfId-246995]CU—Control Unit
 
      	 [bookmark: pgfId-253710]NP—Proxy N-Port (NPV Mode)
 
      	 [bookmark: pgfId-254378]TNP—Trunking NP_Port (NPV Mode)
 
      	 [bookmark: pgfId-254391]TF—Trunking F_Port
 
      	 [bookmark: pgfId-253714]f—vFC Present (Cisco Nexus 5000 Series switches only)
 
     
 
    
 
     
      [bookmark: pgfId-255305]Supervisor and [bookmark: marker-255303]Switching Modules[bookmark: marker-255304]
 
     [bookmark: pgfId-255306]In the Device View, you can right-click an object and get information on it, or configure it. If you right-click a module, the menu shows the module number and gives you the option to configure or reset the module. If you right-click a port, the menu shows the port number and gives you the option to configure, monitor, enable/disable, set beacon mode, or perform diagnostics on the port.
 
      
       
     
 
     
 
     [bookmark: pgfId-255307]Tip You can select multiple ports in Device Manager and apply options to all the selected ports at one time. Either select the ports by clicking the mouse and dragging it around them, or hold down the Control key and click each port.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-255309]To [bookmark: marker-255308]enable or disable a port, right-click the port and click Enable or Disable from the pop-up menu. To enable or disable multiple ports, drag the mouse to select the ports and then right-click the selected ports. Then click Enable or Disable from the pop-up menu.
 
     [bookmark: pgfId-255311]To manage [bookmark: marker-255310]trunking on one or more ports, right-click the ports and click Configure. In the dialog box that appears, right-click the current value in the Trunk column and click nonTrunk, trunk, or auto from the pull-down list.
 
     [bookmark: pgfId-255313]To create [bookmark: marker-255312]PortChannels using Device Manager, click PortChannels from the Interface menu. 
 
      
       
     
 
     
 
     [bookmark: pgfId-255314]Note To create a PortChannel, all the ports on both ends of the link must have the same port speed, trunking type, and administrative state.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-247011]Context Menus
 
     [bookmark: pgfId-247013]C[bookmark: marker-247012]ontext menus are available in both Device Manager views by right-clicking a device or table.
 
     [bookmark: pgfId-247014]From Device View:
 
      
      	 [bookmark: pgfId-247015]Device—Right-click a system, module, or power supply to bring up a menu that gives you the option to configure or reset the device.
 
      	 [bookmark: pgfId-247016]Port— Right-click a port to bring up a menu that shows you the number of the port you have clicked, and to give you the option to configure, monitor, enable, disable, set beacon mode, or perform diagnostics on the port.
 
     
 
     [bookmark: pgfId-247017]From Summary View:
 
      
      	 [bookmark: pgfId-247018]Table— Right-click the table header to show a list of which columns to display in that table: Interface, Description, VSANs, Mode, Connected To, Speed (Gb), Rx, Tx, Errors, Discards, and Log. Click the Description field to bring up the appropriate configuration dialog box for the port type.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-257273]Launching Device Manager
 
    [bookmark: pgfId-258730]To launch Device Manager from your desktop, double-click the Device Manager icon and follow the instructions described in the Cisco DCNM Installation and Licensing Guide.
 
     
      [bookmark: pgfId-257278]DETAILED STEPS
 
     
 
     [bookmark: pgfId-257279]Step 1 You can choose one of the following three steps
 
     [bookmark: pgfId-257280] a. Right-click the switch you want to manage on the Fabric pane map and choose Device Manager from the menu that appears.
 
     [bookmark: pgfId-257281] b. Double-click a switch in the Fabric pane map.
 
     [bookmark: pgfId-257282] c. Select a switch in the Fabric pane map and choose Tools > Device Manager.
 
     [bookmark: pgfId-257286]You see the Device Manager open dialog box as shown in Figure 8-2
 
     [bookmark: pgfId-261281]Figure 8-2 [bookmark: 39362]Device Manager: Open Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-257292]Step 2 Enter the IP adress of the device.
 
     [bookmark: pgfId-257293]Step 3 Enter the user name and password.
 
     [bookmark: pgfId-257294]Step 4 Check the Proxy SNMP through FMS check box if you want Device Manager Client to use a TCP-based proxy server.
 
     [bookmark: pgfId-257295]Step 5 Choose the Auth-Privacy option according to the privacy protocol you have configured on your switch:
 
     [bookmark: pgfId-257296] a. If you have not configured the switch with a privacy protocol, then choose Auth-Privacy option MD5 (no privacy).
 
     [bookmark: pgfId-257297] b. If you have configured the switch with your privacy protocol, choose your Auth-Privacy choice.
 
     [bookmark: pgfId-257298]Step 6 Click Open to open the Device Manager.
 
     [bookmark: pgfId-259264]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-255320][bookmark: 1610]Setting Device Manager Preferences[bookmark: marker-255319]
 
    [bookmark: pgfId-255322]To set your [bookmark: marker-255321]preferences for the behavior of the Device Manager application, choose Device > Preferences from the Device menu. You can set the following preferences:
 
     
     	 [bookmark: pgfId-255323] Retry Requests x Time(s) After x sec Timeout —Allows you to set the retry request values. The default settings are 1 time after a 5-second timeout.
 
     	 [bookmark: pgfId-255324] Enable Status Polling Every x secs —Allows you to set the status polling value. The default setting is enabled (checked) with a time of 40 seconds.
 
     	 [bookmark: pgfId-255325] Trace SNMP Packets in Message Lo g—Allows you to set whether Device Manager traces SNMP packets and logs the trace. The default setting is disabled (unchecked).
 
     	 [bookmark: pgfId-255326] Register for Events After Open, Listen on Port 116 3—Allows you to register this switch so that events are logged once you open Device Manager. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-255327] Show WorldWideName (WWN) Vendor —Displays the world wide name vendor name in any table or listing displayed by Device Manager. If Prepend is checked, the name is displayed in front of the IP address of the switch. If Replace is checked, the name is displayed instead of the IP address. The default setting is enabled (checked) with the Prepend option.
 
     	 [bookmark: pgfId-255328] Show Timestamps as Date/Time —Displays timestamps in the date/time format. If this preference is not checked, timestamps are displayed as elapsed time. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-255329] Telnet Path —Sets the path for the telnet.exe file on your system. The default is  telnet.exe , but you need to browse for the correct location.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-255330]Note If you browse for a path or enter a path and you have a space in the pathname (for example, c:\program files\telnet.exe, then the path will not work. To get the path to work, manually place quotes around it (for example, "c:\program files\telnet.exe").
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-261286] Use Secure Shell Instead of Telnet —Specifies whether to use SSH or Telnet when using the CLI to communicate with the switch. If enabled, you must specify the path to your SSH application. The default setting is disabled.
 
     	 [bookmark: pgfId-255332] CLI Session Timeout x secs (0= disable) —Specifies the timeout interval for a CLI session. Enter 0 to disable (no timeout value). The default setting is 30 seconds.
 
     	 [bookmark: pgfId-255333] Show Tooltips in Physical View —Determines whether tooltips are displayed in Physical (Device) View. The default setting is enabled (checked).
 
     	 [bookmark: pgfId-255334] Label Physical View Ports With: —Specifies the type of label to assign to the ports when you are in Physical (Device) View. The options are FICON and Interface. The default setting is Interface.
 
     	 [bookmark: pgfId-255335] Export Table —Specifies the type of file that is created when you export a table using Device Manager. The options are Tab-Delimited or XML. The default setting is Tab-Delimited.
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1277444]Configuring [bookmark: 47275]Performance Manager 
      
      
 
     
 
 
    [bookmark: pgfId-1277445]This chapter describes how DCNM-SAN is used to monitor and manage a network. This chapter includes the following topics:
 
     
     	 [bookmark: pgfId-1277450]Information About Performance Manager
 
     	 [bookmark: pgfId-1277454]Flow Statistics
 
     	 [bookmark: pgfId-1286093]Flow Setup Wizards
 
    
 
   
 
    
     [bookmark: pgfId-1277460]Information About [bookmark: 48420]Performance Manager
 
    [bookmark: pgfId-1286104]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1286118]Data Interpolation
 
     	 [bookmark: pgfId-1286150]Data Collection
 
     	 [bookmark: pgfId-1286161]Using Performance Thresholds
 
     	 [bookmark: pgfId-1286165]Creating a Flow Using Performance Manager Flow Wizard
 
    
 
    [bookmark: pgfId-1286177]Performance Manager gathers network device statistics historically and provides this information graphically using a web browser. It presents recent statistics in detail and older statistics in summary. Performance Manager also integrates with external tools such as Cisco Traffic Analyzer.
 
    [bookmark: pgfId-1286173]The Performance Manager has three operational stages:
 
     
     	 [bookmark: pgfId-1277465]Definition—The Flow Wizard sets up flows in the switches.
 
     	 [bookmark: pgfId-1277466]Collection—The Web Server Performance Collection screen collects information on desired fabrics.
 
     	 [bookmark: pgfId-1277467]Presentation—Generates web pages to present the collected data through DCNM-SAN Web Server.
 
    
 
    [bookmark: pgfId-1277472]Performance Manager can collect statistics for [bookmark: marker-1277468]ISLs, [bookmark: marker-1277469]hosts, [bookmark: marker-1277470]storage elements, and configured [bookmark: marker-1277471]flows. Flows are defined based on a host-to-storage (or storage-to-host) link. Performance Manager gathers statistics from across the fabric based on collection configuration files. These files determine which SAN elements and SAN links Performance Manager gathers statistics for. Based on this configuration, Performance Manager communicates with the appropriate devices (switches, hosts, or storage elements) and collects the appropriate information at fixed five-minute intervals.
 
    [bookmark: pgfId-1277473]Performance Manager uses a round-robin database to hold the statistical data collected from the fabric. This data is stored based on the configured parameters in the collection configuration file. At each polling interval, Performance Manager gathers the relevant statistics and stores them in the round-robin database. This database is a fixed size and will not grow beyond its preset limits.
 
    [bookmark: pgfId-1277474]Performance Manager creates a series of archived data to hold summarized information present in the real-time round-robin database. This archived data is used to generate daily, weekly, monthly, and yearly consolidated reports. In this way, Performance Manager maintains significant historical data without the cost of an ever-increasing database size.
 
     
      
    
 
    
 
    [bookmark: pgfId-1277475]Note You must restart Performance Manager if you change the user credentials on DCNM-SAN Server.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1277477][bookmark: 94195]Data Interpolation[bookmark: marker-1277476]
 
     [bookmark: pgfId-1287366]One of the unique features of Performance Manager is its ability to interpolate data when statistical polling results are missing or delayed. Other performance tools may store the missing data point as zero, but this can distort historical trending. Performance Manager interpolates the missing data point by comparing the data point that preceded the missing data and the data point stored in the polling interval after the missing data. This maintains the continuity of the performance information.
 
    
 
     
      [bookmark: pgfId-1287369][bookmark: 34520]Data Collection[bookmark: marker-1287368]
 
     [bookmark: pgfId-1287370]One year’s worth of data for two variables (Rx and Tx bytes) requires a round-robin database (rrd) file size of 76 K. If errors and discards are also collected, the rrd file size becomes 110 K. The default internal values are as follows:
 
      
      	 [bookmark: pgfId-1277482]600 samples of 5 minutes (2 days and 2 hours)
 
      	 [bookmark: pgfId-1277483]700 samples of 30 minutes (12.5 days)
 
      	 [bookmark: pgfId-1277484]775 samples of 2 hours (50 days)
 
      	 [bookmark: pgfId-1277485]300 samples of 1 day
 
     
 
     [bookmark: pgfId-1277486]A 1000-port SAN requires 110 MB for a year’s worth of historical data that includes errors and discards. If there were 20 switches in this SAN with equal distribution of fabric ports, about two to three SNMP packets per switch would be sent every 5 minutes for a total of about 100 request or response SNMP packets required to monitor the data.
 
     [bookmark: pgfId-1277487]Because of their variable counter requests, flows are more difficult to predict storage space requirements for. But in general you can expect that, each extra flow adds another 76 KB.
 
      
       
     
 
     
 
     [bookmark: pgfId-1277488]Note Performance Manager does not collect statistics on nonmanageable and non-MDS switches. Loop devices (FL/NL) are not collected.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1295242]To setup a shared RRD path to collect PM data, perform these steps:
 
     
 
     [bookmark: pgfId-1295243]Step 1 Locate the server.properties file.
 
     [bookmark: pgfId-1295244]For Windows setup, location is: C:\Program Files\Cisco Systems\dcm\fm\conf
 
     [bookmark: pgfId-1295245]For Linux setup, location is: /usr/local/cisco/dcm/fm/conf.
 
     [bookmark: pgfId-1295246]Step 2 Add pm.rrdpath property file information to the server.properties file.
 
     [bookmark: pgfId-1295247]For example:
 
     [bookmark: pgfId-1295248]Add server location accessible from the DCNM server in the format:
 
     [bookmark: pgfId-1295249]pm.rrdpath=\\server_ip\\public\\cisco\\data
 
     [bookmark: pgfId-1295250]Step 3 Save server.properties file.
 
     [bookmark: pgfId-1295251]Step 4 Restart the Cisco DCNM server.
 
     [bookmark: pgfId-1295252]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1295253]Note After the Performance Manager server is ready, the new updated location will be used to save the RRD files. Performance Manager creates a new directory pm\db under the specified location. Ensure that RRD files are not altered, as the Performance Manager server is actively writing into the rrd files.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1277494][bookmark: 29640][bookmark: 34082]Using Performance Thresholds[bookmark: marker-1277493]
 
     [bookmark: pgfId-1277495]The Performance Manager Configuration Wizard allows you to set up two thresholds that will trigger events when the monitored traffic exceeds the percent utilization configured. These [bookmark: marker-1277496]event triggers can be set as either Critical or Warning events that are reported on the DCNM-SAN web client Events browser page.
 
     [bookmark: pgfId-1277497]Absolute value thresholds apply directly to the statistics gathered. These statistics, as a percent of the total link capacity, are compared to the percent utilization configured for the threshold type. If the statistics exceed either configured threshold, an event is shown on the DCNM-SAN web client Events tab.
 
     [bookmark: pgfId-1277499]B[bookmark: marker-1277498]aseline thresholds create a threshold that adapts to the typical traffic pattern for each link for the same time window each day, week, or every two weeks. Baseline thresholds are set as a percent of the average (110% to 500%), where 100% equals the calculated weighted average. Figure 9-1 shows an example of setting a baseline threshold for a weekly or daily option. 
 
     [bookmark: pgfId-1286988]Figure 9-1 [bookmark: 88907]Baseline Threshold Example
 
     [bookmark: pgfId-1286992]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1286993]The threshold is set for Monday at 2 p.m. The baseline threshold is set at 130% of the average for that statistic. The average is calculated from the statistics value that occurred at 2 p.m. on Monday, for every prior Monday (for the weekly option) or the statistics value that occurred at 2 p.m. on each day, for every prior day (for the daily option).
 
    
 
   
 
    
     [bookmark: pgfId-1286014][bookmark: 89844]Flow [bookmark: marker-1286013]Statistics 
 
    [bookmark: pgfId-1286015]Flow statistics count the ingress traffic in the aggregated statistics table. You can collect two kinds of statistics:
 
     
     	 [bookmark: pgfId-1286017]Aggregated flow statistics to count the traffic for a [bookmark: marker-1286016]VSAN.
 
     	 [bookmark: pgfId-1286018]Flow statistics to count the traffic for a source and destination ID pair in a VSAN.
 
    
 
    [bookmark: pgfId-1286020][bookmark: 76160]If you enable flow counters, you can enable a maximum of 1 K entries for aggregate flow and flow statistics. Be sure to assign an unused flow index to a module for each new flow. Flow indexes can be repeated across modules. The number space for flow index is shared between the aggregate flow statistics and the flow statistics. 
 
    [bookmark: pgfId-1286021]Generation 1 modules allow a maximum of 1024 flow statements per module. Generation 2 modules allow a maximum of 2048-128 flow statements per module.
 
     
      
       
       [bookmark: pgfId-1286029]Table 9-1 [bookmark: 13921]Performance Manager Flow Types
 
       
       
        
        	 
          
          [bookmark: pgfId-1286033]Flow type 
         
  
        	 
          
          [bookmark: pgfId-1286035]Description 
         
  
       
 
        
        	[bookmark: pgfId-1286037]Host->Storage
  
        	[bookmark: pgfId-1286039]Unidirectional flow, monitoring data from the host to the storage element
  
       
 
        
        	[bookmark: pgfId-1286041]Storage->Host
  
        	[bookmark: pgfId-1286043]Unidirectional flow, monitoring data from the storage element to the host
  
       
 
        
        	[bookmark: pgfId-1286045]Both
  
        	[bookmark: pgfId-1286047]Bidirectional flow, monitoring data to and from the host and storage elements
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1277511][bookmark: 55827]Flow [bookmark: marker-1277510]Setup Wizards
 
    [bookmark: pgfId-1277512]The Performance Manager Flow and Performance Manager Setup wizards greatly simplify configuration. All you need to do is select the categories of statistics to capture and the wizards provide a list of flows and links to monitor. You can remove entries if desired, or just accept the provided list and start data collection. Statistics for host and storage links are not associated with a specific port on a switch, so you do not lose long term statistics if a connection is moved to a different port.
 
     
      [bookmark: pgfId-1282574][bookmark: 79550]Creating a Flow Using Performance Manager Flow Wizard
 
    
 
     
      [bookmark: pgfId-1282575]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1282576]Step 1 Choose Performance > Create Flows. 
 
     [bookmark: pgfId-1287484]Specify how you want to determine and add new flows as shown in Figure 9-2. For this, you have to define traffic counters between source and destination devices, via one of these options:
 
      
       
       	 [bookmark: pgfId-1287486]In a VSAN - For this option, click VSAN.
 
       	 [bookmark: pgfId-1282565]Based on high traffic devices - For this option, click Device Traffic. Note that PM collections must already be turned on in order to use this option. If PM collection is not turned on for the selected fabric, then an error message will appear and you cannot continue.
 
      
 
     
 
     [bookmark: pgfId-1287599]Step 2 If you have clicked VSAN, then:
 
     [bookmark: pgfId-1288374]Figure 9-2 [bookmark: 42574]Create Flows Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1282621] a. Click the drop-down menu in the VSAN field.
 
     [bookmark: pgfId-1282622] b. Choose the list of VSANs provided by the flow configuration wizard.
 
     [bookmark: pgfId-1284938] c. Click the drop-down menu in the Zone field.
 
     [bookmark: pgfId-1284969] d. Choose the list of zones provided by the flow configuration wizard.
 
     [bookmark: pgfId-1282626] e. Click Next to continue to the next windowas shown in Figure 9-3).
 
     [bookmark: pgfId-1288391]Figure 9-3 [bookmark: 59806]Review Traffic Flows Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1282661] f. Choose items in the Possible Flow Pairs area.
 
     [bookmark: pgfId-1282662] g. The Review Traffic Flows window displays all VSAN flow pairs in the Exisitng Flows for Vsan area.
 
     [bookmark: pgfId-1282663] h. Click Add to create the selected flow.
 
     [bookmark: pgfId-1282664] i. Choose items in the Existing Flows for Vsan area.
 
     [bookmark: pgfId-1282665] j. Click Remove to remove the selected flow.
 
     [bookmark: pgfId-1287643]Step 3 If you have clicked Device Traffic, then:
 
     [bookmark: pgfId-1287644] a. Click Next.
 
     [bookmark: pgfId-1287692]You see the Define Traffic Flows page.
 
     [bookmark: pgfId-1287645] b. Specify a traffic utilization percentage threshold vlaue in the Show device ports with traffic > text box.
 
     [bookmark: pgfId-1287646] c. Specify whether you want to look at the peak or average traffic values, over the last day or last week, for the traffic types:
 
     [bookmark: pgfId-1287647] – Host<->Storage
 
     [bookmark: pgfId-1287648] – Storage<->Storage
 
     [bookmark: pgfId-1287649] – Both
 
     [bookmark: pgfId-1287650] d. Click Next.
 
     [bookmark: pgfId-1287710]If new flow pairs are found, you will see the Review Traffic Flows page, where possible flow pairs are shown in a table, along with the traffic parameters used to identify them.
 
     [bookmark: pgfId-1287816] e. To see only rows having a specific source or destination device, specify the name of the device in the Filter text box.
 
     [bookmark: pgfId-1287817] f. To create a flow, click the corresponding row in the Possible Flow Pairs table, and then click Add.
 
     [bookmark: pgfId-1287818]To remove an existing flow, click the corresponding row in the Existing Flow Pairs table, and then click Remove.
 
     [bookmark: pgfId-1287676]Step 4 Click Finish to restart the Performance Manager collection.
 
     [bookmark: pgfId-1282670]You see the Confirmation dialog box as shown in Figure 9-4.
 
     [bookmark: pgfId-1288408]Figure 9-4 [bookmark: 13922]Confirmation Dialog Box
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1282728]To verify the newly created flow, choose Physical Attributes > End Devices > Flow Statistics. The newly created flows are displayed.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287384]Note Performance Manager Collection can be enabled for LAN devices and traffice counters are collected periodically.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1282726]
 
      
      
 
     
 
     
 
    
 
   
 
    
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1287412]Monitoring [bookmark: 47275]the Network 
      
      
 
     
 
 
    [bookmark: pgfId-1290634]This chapter describes how the DCNM-SAN manages the network. In particular, SAN discovery and network monitoring are two of its key network management capabilities.
 
    [bookmark: pgfId-1279945]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-1279953]Information About Network Monitoring
 
     	 [bookmark: pgfId-1291644]Device Discovery
 
     	 [bookmark: pgfId-1289967]Topology Mapping
 
    
 
   
 
    
     [bookmark: pgfId-1290013][bookmark: 15538]Information About Network Monitoring
 
    [bookmark: pgfId-1290113]DCNM-SAN provides extensive SAN discovery, topology mapping, and information viewing capabilities. DCNM-SAN collects information on the fabric topology through SNMP queries to the switches connected to it. DCNM-SAN recreates a fabric topology, presents it in a customizable map, and provides inventory and configuration information in multiple viewing options such as fabric view, device view, summary view, and operation view.
 
    [bookmark: pgfId-1290109]Once DCNM-SAN is invoked, a SAN discovery process begins. Using information polled from a seed Cisco MDS 9000 Family switch, including Name Server registrations, Fibre Channel Generic Services (FC-GS), Fabric Shortest Path First (FSPF), and SCSI-3, DCNM-SAN automatically discovers all devices and interconnects on one or more fabrics. All available switches, host bus adapters (HBAs), and storage devices are discovered. The Cisco MDS 9000 Family switches use Fabric-Device Management Interface (FMDI) to retrieve the HBA model, serial number and firmware version, and host operating-system type and version discovery without host agents. DCNM-SAN gathers this information through SNMP queries to each switch. The device information discovered includes device names, software revision levels, vendor, ISLs, PortChannels, and VSANs.
 
     
      [bookmark: pgfId-1290096]Monitoring Health and Events
 
     [bookmark: pgfId-1290014]DCNM-SAN works with the Cisco MDS 9000 Family switches to show the health and status of the fabric and switches. Information about the fabric and its components is gathered from multiple sources, including Online System Health Management, Call Home, system messages, and SNMP notifications. This information is then made available from multiple menus on DCNM-SAN or Device Manager.
 
    
 
     
      [bookmark: pgfId-1290015]DCNM-SAN Events Tab
 
     [bookmark: pgfId-1290017]The DCNM-SAN Events[bookmark: marker-1290016] tab, available from the topology window, displays the events DCNM-SAN received from sources within the fabric. These sources include SNMP events, RMON events, system messages, and system health messages. The Events tab shows a table of events, including the event name, the source and time of the event, a severity level, and a description of the event. The table is sortable by any of these column headings.
 
      
       
     
 
     
 
     [bookmark: pgfId-1293608]Note Cisco DCNM SAN client displays events that are created after the client session is started. Any event created before the current user login session will not be retrieved and displayed.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1290018]Event Information in DCNM-SAN Web Server Reports
 
     [bookmark: pgfId-1290019]The DCNM-SAN web server client displays collections of information gathered by the Performance Manager. This information includes events sent to the DCNM-SAN Server from the fabric. To open these reports, choose Performance Manager > Reports. This opens the web client in a web browser and displays a summary of all fabrics monitored by the DCNM-SAN Server. Choose a fabric and then click the Events[bookmark: marker-1290020] tab to see a summary or detailed report of the events that have occurred in the selected fabric. The summary view shows how many switches, ISLs, hosts, or storage elements are down on the fabric and how many warnings have been logged for that SAN entity. The detailed view shows a list of all events that have been logged from the fabric and can be filtered by severity, time period, or type.
 
    
 
     
      [bookmark: pgfId-1290021]Events in Device Manager
 
     [bookmark: pgfId-1290023]Device Manager displays the events when you choose Logs > Events.[bookmark: marker-1290022] Device Manager can display the current list of events or an older list of events that has been stored on the DCNM-SAN host. The event table shows details on each event, including time, source, severity, and a brief description of the event.
 
    
 
     
      [bookmark: pgfId-1279960][bookmark: 75846]SAN Discovery and Topology Mapping
 
     [bookmark: pgfId-1279962]DCNM-SAN provides extensive SAN discovery, topology mapping, and information viewing capabilities. DCNM-SAN collects information on the fabric topology through SNMP queries to the switches connected to it. DCNM-SAN recreates a fabric topology, presents it in a customizable map, and provides inventory and configuration information in multiple viewing options.
 
    
 
     
      [bookmark: pgfId-1279964][bookmark: 48122]Device [bookmark: marker-1279963]Discovery
 
     [bookmark: pgfId-1279965]Once DCNM-SAN is invoked, a SAN discovery process begins. Using information polled from a seed Cisco MDS 9000 Family switch, including Name Server registrations, Fibre Channel Generic Services (FC-GS), Fabric Shortest Path First (FSPF), and SCSI-3, DCNM-SAN automatically discovers all devices and interconnects on one or more fabrics. All available switches, host bus adapters (HBAs), and storage devices are discovered. The Cisco MDS 9000 Family switches use Fabric-Device Management Interface (FMDI) to retrieve HBA model, serial number and firmware version, and host operating-system type and version discovery without host agents. DCNM-SAN gathers this information through SNMP queries to each switch. The device information discovered includes device names, software revision levels, vendor, ISLs, PortChannels, and VSANs.
 
     [bookmark: pgfId-1287577]For a VSAN change involving a third-party switch, DCNM-SAN will need a second discovery to show the correct topology due to the discovery dependency when there is any change in a mixed VSAN. The first discovery finds the third-party switch and the subsequent discovery will show the information on which VSAN it is going to join and can discover the end devices connected to it. You can wait for the subsequent discovery or trigger a manual discovery.
 
    
 
     
      [bookmark: pgfId-1279967][bookmark: 42879]Topology [bookmark: marker-1279966]Mapping
 
     [bookmark: pgfId-1287504]DCNM-SAN is built upon a topology representation[bookmark: marker-1287503] of the fabric. DCNM-SAN provides an accurate view of multiple fabrics in a single window by displaying topology maps based on device discovery information. You can modify the topology map icon layout with an easy-to-use, drag-and-drop interface. The topology map visualizes device interconnections, highlights configuration information such as zones, VSANs, and ISLs exceeding utilization thresholds. The topology map also provides a visual context for launching command-line interface (CLI) sessions, configuring PortChannels, and opening device managers. 
 
    
 
     
      [bookmark: pgfId-1287506]Using the Topology Map
 
     [bookmark: pgfId-1279972]The DCNM-SAN topology map [bookmark: marker-1279971]can be customized to provide a view into the fabric that varies from showing all switches, end devices, and links, to showing only the core switches with single bold lines for any multiple links between switches. Use the icons along the left side of the topology map to control these views or right-click anywhere in the topology map to access the map controls.
 
     [bookmark: pgfId-1279973]You can zoom in or out on the topology map to see an overview of the SAN or focus on an area of importance. You can also open an overview window that shows the entire fabric. From this window, you can right-click and draw a box around the area you want to view in the main topology map view.
 
     [bookmark: pgfId-1279974]Another way to limit the scope of the topology display is to select a fabric or VSAN from the Logical Domains pane. The topology map displays only that fabric or VSAN.
 
     [bookmark: pgfId-1279975]Moving the mouse pointer over a link or switch provides a simple summary of that SAN component, along with a status indication. Right-clicking on the component brings up a pop-up menu. You can view the component in detail or access configuration or test features for that component.
 
     [bookmark: pgfId-1279976]Double-click a link to bring link status and configuration information to the information pane. Double-click a switch to bring up Device Manager for that switch.
 
    
 
     
      [bookmark: pgfId-1279977]Saving a Customized Topology Map Layout
 
     [bookmark: pgfId-1279982]Changes made to the topology map can be saved so that the customized view is available any time you open the DCNM-SAN Client for that fabric. 
 
    
 
     
      [bookmark: pgfId-1290266]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1279987]Step 1 Click File > Preferences to open the DCNM-SAN preferences dialog box.
 
     [bookmark: pgfId-1279988]Step 2 Click the Map tab and check the Automatically Save Layout check box to save any changes to the topology map as shown in Figure 10-1.
 
     [bookmark: pgfId-1293869]Figure 10-1 [bookmark: 33584]DCNM-SAN Preferences
 
     [bookmark: pgfId-1293873]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1279998]Step 3 Click Apply, and then click OK to save this change.
 
     [bookmark: pgfId-1279999]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1280001]Using Enclosures   [bookmark: marker-1280000]with DCNM-SAN Topology Maps
 
     [bookmark: pgfId-1289373]Because not all devices are capable of responding to FC-GS-3 requests, different ports of a single server or storage subsystem may be displayed as individual end devices on the topology map. See the “Modifying the Device Grouping” section to group these ports into a single enclosure for DCNM-SAN. 
 
     [bookmark: pgfId-1280006]Clicking Alias->Enclosure displays hosts and storage elements in the Information pane. This is a shortcut to naming enclosures. To use this shortcut, highlight each row in the host or storage table that you want grouped in an enclosure then click Alias -> Enclosure. This automatically sets the enclosure names of each selected row with the first token of the alias.
 
    
 
     
      [bookmark: pgfId-1280007]Mapping Multiple Fabrics
 
     [bookmark: pgfId-1289380]To log into[bookmark: marker-1280008] multiple fabrics, the same username and password must be used. The information for both fabrics is displayed, with no need to select a seed switch. To see details of a fabric, click the tab for that fabric at the bottom of the Fabric pane, or double-click the fabric’s cloud icon. To continuously manage a fabric using DCNM-SAN, follow the instructions in the “Managing a Cisco DCNM-SAN Server Fabric” section. 
 
    
 
     
      [bookmark: pgfId-1280014]Inventory Management
 
     [bookmark: pgfId-1289389]The Information pane in DCNM-SAN shows inventory[bookmark: marker-1280018], configuration, and status information for all switches, links, and hosts in the fabric. Inventory management includes vendor name and model, and software or firmware versions. Select a fabric or VSAN from the Logical Domains pane, and then select the Summary tab in the Information pane to get a count of the number of VSANS, switches, hosts, and storage elements in the fabric. See the “Cisco DCNM-SAN Client Quick Tour: Admin Perspective” section for more information on the DCNM-SANDCNM-SAN user interface. 
 
    
 
     
      [bookmark: pgfId-1280023]Using the Inventory Tab from DCNM-SAN Web Server
 
     [bookmark: pgfId-1289397]If you have configured DCNM-SAN Web Server, you can launch this application and access the Inventory tab to see a summary of the fabrics managed by the DCNM-SAN Server. The Inventory tab shows an inventory of the selected SAN, fabric, or switch. See Chapter 3, “Cisco Prime DCNM Web Client” for more information on how to configure and use DCNM-SAN Web Server. 
 
    
 
     
      [bookmark: pgfId-1290250]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1289405]Step 1 [bookmark: 16465][bookmark: 28619][bookmark: 48451][bookmark: 12684]Point your browser at the DCNM-SAN Web Server. 
 
     [bookmark: pgfId-1280039]Step 2 Click the Events tab and then the Details tab to view the system messages. The columns in the events table are sortable. In addition, you can use the Filter button to limit the scope of messages within the table.
 
     [bookmark: pgfId-1290589]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1280042][bookmark: 46162]Viewing Logs from Device Manager
 
     [bookmark: pgfId-1280043]You can view system messages from Device Manager if Device Manager is running from the same workstation as the DCNM-SAN Server. Choose[bookmark: marker-1280044] Logs > Events > current to view the system messages on Device Manager. The columns in the events table are sortable. In addition, you can use the Find button to locate text within the table.
 
     [bookmark: pgfId-1287160]You can view switch-resident logs even if you have not set up your local syslog server or your local PC is not in the switch's syslog server list. Due to memory constraints, these logs will wrap when they reach a certain size. The switch syslog has two logs: an NVRAM log that holds a limited number of critical and greater messages and a nonpersistent log that contains notice or greater severity messages. Hardware messages are part of these logs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287161]Note To view syslog local logs, you need to configure the IP address of the DCNM-SAN Server in the syslog host. 
 
      
      
 
     
 
     
 
    
 
   
 
    
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1300502]Monitoring [bookmark: 38215]Performance 
      
      
 
     
 
 
    [bookmark: pgfId-1305640]This chapter describes how to configure Performance Monitoring tools for Cisco DCNM-SAN and Device Manager. These tools provide real-time statistics as well as historical performance monitoring.
 
    [bookmark: pgfId-1300504]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-1300508]Information About Performance Monitoring
 
     	 [bookmark: pgfId-1300512]Configuring Performance Manager
 
     	 [bookmark: pgfId-1306868]Configuring the Summary View in Device Manager
 
     	 [bookmark: pgfId-1306881]Configuring Per Port Monitoring using Device Manager
 
     	 [bookmark: pgfId-1306909]Displaying DCNM-SAN Real-Time ISL Statistics
 
     	 [bookmark: pgfId-1308160]Displaying Performance Manager Reports
 
     	 [bookmark: pgfId-1308164]Generating Performance Manager Reports
 
     	 [bookmark: pgfId-1308169]Exporting Data Collections
 
     	 [bookmark: pgfId-1304323]Analyzing SAN Health
 
    
 
   
 
    
     [bookmark: pgfId-1300513][bookmark: 98858]Information About Performance Monitoring
 
    [bookmark: pgfId-1300515]Device Manager provides an easy tool for monitoring[bookmark: marker-1300514] ports on the Cisco MDS 9000 Family switches. This tool gathers statistics at a configurable interval and displays the results in tables or charts. Real-time performance statistics are useful for dynamic troubleshooting and fault isolation within the fabric. Real-time statistics gather data on parts of the fabric in user-configurable intervals and display these results in DCNM-SAN and Device Manager. For a selected port, you can monitor any of a number of statistics including traffic in and out, errors, class 2 traffic, and FICON data.
 
     
      [bookmark: pgfId-1287560]Real-Time Performance Monitoring
 
     [bookmark: pgfId-1301394]Device Manager provides an easy tool for monitoring ports on the Cisco MDS 9000 Family switches. This tool gathers statistics at a configurable interval and displays the results in tables or charts. These statistics show the performance of the selected port in real-time and can be used for performance monitoring and troubleshooting. For a selected port, you can monitor any of a number of statistics including traffic in and out, errors, class 2 traffic, and FICON data. You can set the polling interval from ten seconds to one hour, and display the results based on a number of selectable options including absolute value, value per second, and minimum or maximum value per second. 
 
     [bookmark: pgfId-1287561]Device Manager checking for oversubscription on the host-optimized four-port groups on relevant modules. Right-click the port group on a module and choose Check Oversubscription from the pop-up menu.
 
     [bookmark: pgfId-1287562]Device manager provides two performance views: the Summary View tab and the configurable monitor option per port. 
 
    
 
     
      [bookmark: pgfId-1305780]Historical Performance Monitoring
 
     [bookmark: pgfId-1305782]Performance Manager gathers network device statistics historically[bookmark: marker-1305781] and provides this information using DCNM-SAN client and web browser. It presents recent statistics in detail and older statistics in summary. Performance Manager also integrates with external tools such as Cisco Traffic Analyzer. See the “Information About Performance Manager” section for an overview of Performance Manager.
 
    
 
   
 
    
     [bookmark: pgfId-1306203][bookmark: 88843]Configuring Performance Manager
 
    [bookmark: pgfId-1306722]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1306740]Creating a Flow with Performance Manager
 
     	 [bookmark: pgfId-1306779]Creating a Collection with Performance Manager
 
     	 [bookmark: pgfId-1306783]Using Performance Thresholds
 
    
 
     
      [bookmark: pgfId-1306714][bookmark: 44572][bookmark: 29640]Creating a Flow with Performance Manager
 
     [bookmark: pgfId-1306205]With the Flow Configuration Wizard[bookmark: marker-1306204] you can create host-to-storage, storage-to-host, or bidirectional flows. Once defined, you can add these flows to a collection configuration file to monitor the traffic between a host/storage element pair. The flows created become part of the collection options in the Performance Manager Configuration Wizard. 
 
    
 
     
      [bookmark: pgfId-1306210][bookmark: 56913]Creating a Collection with Performance Manager
 
     [bookmark: pgfId-1306212]The Performance Manager Configuration Wizard steps you through the process of creating collections[bookmark: marker-1306211] using configuration files. Collections are defined for one or all VSANs in the fabric. Collections can include statistics from the SAN element types described in Table 11-1.
 
     [bookmark: pgfId-1306242]
 
      
       
        
        [bookmark: pgfId-1306219]Table 11-1 [bookmark: 89973]Performance Manager Collection Types
 
        
        
         
         	 
           
           [bookmark: pgfId-1306223]Collection Type 
          
  
         	 
           
           [bookmark: pgfId-1306225]Description 
          
  
        
 
         
         	[bookmark: pgfId-1306227]ISLs
  
         	[bookmark: pgfId-1306229]Collects link statistics for ISLs.
  
        
 
         
         	[bookmark: pgfId-1306231]Host
  
         	[bookmark: pgfId-1306233]Collects link statistics for SAN hosts.
  
        
 
         
         	[bookmark: pgfId-1306235]Storage
  
         	[bookmark: pgfId-1306237]Collects link statistics for a storage elements.
  
        
 
         
         	[bookmark: pgfId-1306239]Flows
  
         	[bookmark: pgfId-1306241]Collects flow statistics defined by the Flow Configuration Wizard.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1306243][bookmark: 37714]Using Performance Thresholds
 
     [bookmark: pgfId-1306244]The Performance Manager Configuration Wizard allows you to set up two thresholds that trigger events when the monitored traffic exceeds the percent utilization configured. These event triggers can be set as either Critical or Warning events that are reported on the DCNM-SAN web client Events browser page.
 
     [bookmark: pgfId-1306245]You must choose either absolute value thresholds or baseline thresholds that apply to all transmit or receive traffic defined in the collection. Click the Use absolute values radio button on the last screen of the Performance Manager Configuration Wizard to configure thresholds that apply directly to the statistics gathered. These statistics, as a percent of the total link capacity, are compared to the percent utilization configured for the threshold type. If the statistics exceed either configured threshold, an event is shown on the DCNM-SAN web client Events tab.
 
     [bookmark: pgfId-1306246]As an example, the collection has absolute value thresholds set for 60% utilization (for warning) and 80% utilization (for critical). If Performance Manager detects that the traffic on a 1-Gigabit link in its collection exceeds 600 Mbps, a warning event is triggered. If the traffic exceeds 800 Mbps, a critical event is triggered.
 
     [bookmark: pgfId-1306247]Baseline thresholds are defined for a configured time of day or week (1 day, 1 week, or 2 weeks). The baseline is created by calculating the average of the statistical results for the configured time each day, week, or every 2 weeks. Table 11-2 shows an example of the statistics used to create the baseline value for a collection defined at 4 pm on a Wednesday.
 
     [bookmark: pgfId-1306273]
 
      
       
        
        [bookmark: pgfId-1306254]Table 11-2 [bookmark: 84191]Baseline Time Periods for a Collection Started on Wednesday at 4pm
 
        
        
         
         	 
           
           [bookmark: pgfId-1306258]Baseline Time Window 
          
  
         	 
           
           [bookmark: pgfId-1306260]Statistics Used in Average Calculation 
          
  
        
 
         
         	[bookmark: pgfId-1306262]1 day
  
         	[bookmark: pgfId-1306264]Every prior day at 4 pm
  
        
 
         
         	[bookmark: pgfId-1306266]1 week
  
         	[bookmark: pgfId-1306268]Every prior Wednesday at 4 pm
  
        
 
         
         	[bookmark: pgfId-1306270]2 weeks
  
         	[bookmark: pgfId-1306272]Every other prior Wednesday at 4 pm
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1306274]Baseline thresholds create a threshold that adapts to the typical traffic pattern for each link for the same time window each day, week, or every 2 weeks. Baseline thresholds are set as a percent of the average (110% to 500%), where 100% equals the calculated average. 
 
     [bookmark: pgfId-1306275]As an example, a collection is created at 4 pm on Wednesday, with baseline thresholds set for 1 week, at 150% of the average (warning) and 200% of the average (critical). Performance Manager recalculates the average for each link at 4 pm every Wednesday by taking the statistics gathered at that time each Wednesday since the collection started. Using this as the new average, Performance Manager compares each received traffic statistic against this value and sends a warning or critical event if the traffic on a link exceeds this average by 150% or 200% respectively.
 
     [bookmark: pgfId-1306279]Table 11-3 shows two examples of 1-Gigabit links with different averages in our example collection and at what traffic measurements the Warning and Critical events are sent.
 
     [bookmark: pgfId-1306306]
 
      
       
        
        [bookmark: pgfId-1306283]Table 11-3 [bookmark: 49294]Example of Events Generated for 1-Gigabit Links
 
        
        
         
         	 
           
           [bookmark: pgfId-1306289]Average 
          
  
         	 
           
           [bookmark: pgfId-1306291]Warning Event Sent at 150% 
          
  
         	 
           
           [bookmark: pgfId-1306293]Critical Event Sent at 200% 
          
  
        
 
         
         	[bookmark: pgfId-1306295]400 Mbps
  
         	[bookmark: pgfId-1306297]600 Mbps
  
         	[bookmark: pgfId-1306299]800 Mbps
  
        
 
         
         	[bookmark: pgfId-1306301]200 Mbps
  
         	[bookmark: pgfId-1306303]300 Mbps
  
         	[bookmark: pgfId-1306305]400 Mbps
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1306307]Set these thresholds on the last screen of the Collections Configuration Wizard by checking the Send events if traffic exceeds threshold check box.
 
    
 
   
 
    
     [bookmark: pgfId-1300175][bookmark: 84499]Configuring the Summary View in Device Manager
 
     
      [bookmark: pgfId-1287565]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1287566]Step 1 Click the Summary tab on the main display. 
 
     [bookmark: pgfId-1287567]You see all of the active ports on the switch, as well as the configuration options available from the Summary view shown in Figure 11-1.
 
     [bookmark: pgfId-1287572]Figure 11-1 [bookmark: 36324]Device Manager Summary Tab
 
     [bookmark: pgfId-1287576]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1287577]Step 2 Choose a value from the Poll Interval drop-down list.
 
     [bookmark: pgfId-1287578]Step 3 Decide how you want your data to be interpreted by looking at the Show Rx/Tx drop-down menu. The table updates each polling interval to show an overview of the receive and transmit data for each active port on the switch.
 
     [bookmark: pgfId-1287579]Step 4 Select a value from the Show Rx/Tx drop-down list. If you select Util%, you need to also select values from the two Show Rx/Tx > %Util/sec drop-down lists. The first value is the warning level and the second value is the critical threshold level for event reporting.
 
     [bookmark: pgfId-1287580]Note that you can also display percent utilization for a single port by selecting the port and clicking the Monitor Selected Interface Traffic Util % icon.
 
     [bookmark: pgfId-1287582]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1306655][bookmark: 78834]Configuring Per Port Monitoring using Device Manager
 
    [bookmark: pgfId-1287583]The configurable monitor per port option gives statistics for in and out traffic on that port, errors, class 2 traffic and other data that can be graphed over a period of time to give a real-time view into the performance of the port.
 
     
      [bookmark: pgfId-1306683]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1287586]Step 1 Click the Device tab.
 
     [bookmark: pgfId-1287587]Step 2 Right-click the port you are interested in and choose Monitor from the drop-down menu. 
 
     [bookmark: pgfId-1287591]You see the port real-time monitor dialog box shown in Figure 11-2.
 
     [bookmark: pgfId-1316677]Figure 11-2 [bookmark: 97616]Device Manager Monitor Dialog Box
 
     [bookmark: pgfId-1316681]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1287598]Step 3 Select a value from the Interval drop-down list to determine how often data is updated in the table shown here.
 
     [bookmark: pgfId-1287599]Step 4 Click a statistical value in the table then click one of the graphing icons to display a running graph of that statistic over time. You see a graph window that contains options to change the graph type. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1287600]Tip You can open multiple graphs for statistics on any of the active ports on the switch.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287601]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1287604]Displaying [bookmark: 93888][bookmark: marker-1287603]DCNM-SAN Real-Time ISL Statistics
 
    [bookmark: pgfId-1287606]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1306930]“Using the Performance Manager Configuration Wizard” section
 
     	 [bookmark: pgfId-1306970]“Viewing Performance Statics Using DCNM-SAN” section
 
    
 
    [bookmark: pgfId-1306939]You can configure DCNM-SAN to gather [bookmark: marker-1287605]ISL statistics in real time. These ISL statistics include receive and transmit utilization, bytes per second, as well as errors and discards per ISL. 
 
     
      [bookmark: pgfId-1287607]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1287608]Step 1 Choose Performance > ISLs in Real-Time. 
 
     [bookmark: pgfId-1287612]You see any ISL statistics in the Information pane as shown in Figure 11-3.
 
     [bookmark: pgfId-1287614]Figure 11-3 [bookmark: 79703]ISL Performance in Real Time
 
     [bookmark: pgfId-1287618]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1287619]Step 2 Select a value from the Poll Interval drop-down list.
 
     [bookmark: pgfId-1287620]Step 3 Select two values from the Bandwidth utilization thresholds drop-down lists, one value for the minor threshold and one value for the major threshold.
 
     [bookmark: pgfId-1287621]The table shown updates each polling interval to show the statistics for all configured ISLs in the fabric.
 
     [bookmark: pgfId-1287622]Step 4 Select a row in the table to highlight that ISL in blue in the Topology map.
 
     [bookmark: pgfId-1287623]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1287709][bookmark: 89101]Using the [bookmark: marker-1287708]Performance Manager Configuration Wizard
 
     [bookmark: pgfId-1287713]See the “Viewing Performance Information” section.
 
    
 
     
      [bookmark: pgfId-1299365][bookmark: 71105]Viewing Performance Statics Using DCNM-SAN
 
     [bookmark: pgfId-1299385]You can configure DCNM-SAN to gather historic and real time statistics of ISLs or End devices. These statistics include receive and transmit utilization, bytes per second, as well as errors and discards per ISL or end device. 
 
    
 
     
      [bookmark: pgfId-1299366]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1299767]Step 1 Right-click the ISL or end device in the Fabric pane.
 
     [bookmark: pgfId-1299813]You see a context menu as shown in the Figure 11-4.
 
     [bookmark: pgfId-1299768]Step 2 Select Show Statics.
 
     [bookmark: pgfId-1316703]Figure 11-4 [bookmark: 16052]Show Statics Menu
 
     [bookmark: pgfId-1316707]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1307732]Note Show Statics menu will be enabled only if you add the fabric to the Performance Manager collection.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1307733]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1307736][bookmark: 18887]Displaying [bookmark: marker-1307735]Performance Manager Reports
 
    [bookmark: pgfId-1307763]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1307771]“Displaying Performance Summary” section
 
     	 [bookmark: pgfId-1307836]“Displaying Performance Tables and Details Graphs” section
 
     	 [bookmark: pgfId-1307873]“Displaying Performance of Host-Optimized Port Groups” section
 
     	 [bookmark: pgfId-1307910]“Displaying Performance Manager Events” section
 
    
 
    [bookmark: pgfId-1300904]
 
    [bookmark: pgfId-1308004]You can view Performance Manager statistical data using preconfigured reports[bookmark: marker-1300903] that are built on demand and displayed in a web browser. These reports provide summary information as well as detailed statistics that can be viewed for daily, weekly, monthly, or yearly results.
 
     
      [bookmark: pgfId-1287721]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1306448]Step 1 Choose Performance > Reports to access Performance Manager reports from DCNM-SAN. 
 
     [bookmark: pgfId-1306539]This opens a web browser window showing the default DCNM-SAN web client event summary report. 
 
     [bookmark: pgfId-1306540]Step 2 Click the Performance tab to view the Performance Manager reports. 
 
     [bookmark: pgfId-1306576]Performance Manager begins reporting data ten minutes after the collection is started.
 
     [bookmark: pgfId-1309317]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1309320]Note DCNM-SAN Web Server must be running for reports to work. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1309324][bookmark: 26419]Displaying Performance [bookmark: marker-1309323]Summary
 
     [bookmark: pgfId-1287728]The Performance Summary page presents a dashboard display of the throughput and link utilization for hosts, ISLs, storage, and flows for the last 24-hour period. The summary provides a quick overview of the fabric’s bandwidth consumption and highlights any hotspots.
 
     [bookmark: pgfId-1287729]The report includes network throughput pie charts and link utilization pie charts. Use the navigation tree on the left to show summary reports for monitored fabrics or VSANs. The summary displays charts for all hosts, storage elements, ISLs, and flows. Each pie chart shows the percent of entities (links, hosts, storage, ISLs, or flows) that measure throughput or link utilization on each of six predefined ranges. Move the mouse over a pie chart section to see how many entities exhibit that range of statistics. Double-click any pie chart to bring up a table of statistics for those hosts, storage elements, ISLs, or flows.
 
    
 
     
      [bookmark: pgfId-1287731][bookmark: 36417]Displaying Performance [bookmark: marker-1287730]Tables and Details Graphs
 
     [bookmark: pgfId-1287732]Click Host, Storage, ISL, or Flow to view traffic over the past day for all hosts, storage, ISLs, or flows respectively. A table lists all of the selected entities, showing transmit and receive traffic and errors and discards, if appropriate. The table can be sorted by any column heading. The table can also be filtered by day, week, month, or year. Tables for each category of statistics display average and peak throughput values and provide hot-links to more detailed information.
 
     [bookmark: pgfId-1287733]Clicking a link in any of the tables opens a details page that shows graphs for traffic by day, week, month, and year. If flows exist for that port, you can see which storage ports sent data. The details page also displays graphs for errors and discards if they are part of the statistics gathered and are not zero.
 
     [bookmark: pgfId-1287734]If you double-click a graph on a Detail report, it will launch the Cisco Traffic Analyzer for Fibre Channel, if configured. The aliases associated with hosts, storage devices, and VSANs in the fabric are passed to the Cisco Traffic Analyzer to provide consistent, easy identification.
 
    
 
     
      [bookmark: pgfId-1287736][bookmark: 91476]Displaying [bookmark: marker-1287735]Performance of Host-Optimized Port Groups
 
     [bookmark: pgfId-1287737]You can monitor the performance of host-optimized port groups by selecting Performance > End Devices and selecting Port Groups from the Type drop-down list.
 
    
 
     
      [bookmark: pgfId-1287738][bookmark: 20204]Displaying Performance Manager Events
 
     [bookmark: pgfId-1287739]Performance Manager events are viewed through DCNM-SAN Web Server. To view problems and events[bookmark: marker-1287740] in DCNM-SAN Web Server, choose a fabric and then click the Events tab to see a summary or detailed report of the problems and events that have occurred in the selected fabric.
 
    
 
   
 
    
     [bookmark: pgfId-1308017][bookmark: 60756]Generating Performance Manager Reports
 
     
     	 [bookmark: pgfId-1308026]“Generating Top10 Reports in Performance Manager” section
 
     	 [bookmark: pgfId-1308080]“Generating Top10 Reports Using Scripts” section
 
    
 
     
      [bookmark: pgfId-1287741][bookmark: 58671]Generating Top10 Reports in Performance Manager
 
     [bookmark: pgfId-1300910]You can generate historical Top10 reports[bookmark: marker-1301282] that can be saved for later review. These reports list the entities from the data collection, with the most active entities appearing first. This is a static, one-time only report that generates averages and graphs of the data collection as a snapshot at the time the report is generated. These Top10 reports differ from the other monitoring tables and graphs in Performance Manager in that the other data is continuously monitored and is sortable on any table column. The Top10 reports are a snapshot view at the time the report was generated and are static. These are one-time reports that generate averages and graphs of the data collection as a snapshot at the time the report is generated. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1287746]Tip Name the reports with a timestamp so that you can easily find the report for a given day or week.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287747]These Top10 reports differ from the other monitoring tables and graphs in Performance Manager in that the other data is continuously monitored and is sortable on any table column. The Top10 reports are a snapshot view at the time the report was generated.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287748]Note Top10 reports require analyzing the existing data over an extended period of time and can take hours or more to generate on large fabrics.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287752]See the “Creating SAN User Defined Reports” section for information on creating a Top10 report. 
 
    
 
     
      [bookmark: pgfId-1287753][bookmark: 18599]Generating Top10 Reports Using Scripts
 
     [bookmark: pgfId-1287754]You can generate Top10 reports manually by issuing the following commands:
 
      
      	 [bookmark: pgfId-1287755]On UNIX, run the script:
 
     
 
      
      [bookmark: pgfId-1287756]“/<user_directory>/.cisco_mds9000/bin/pm.sh display pm/pm.xml <output_directory>” 
     
 
      
      [bookmark: pgfId-1287757] 
     
 
      
      	 [bookmark: pgfId-1287758]On Windows, run the script:
 
     
 
      
      [bookmark: pgfId-1287759]“c:\Program Files\Cisco Systems\MDS 9000\bin\pm.bat display pm\pm.xml <output_directory>” 
     
 
      
      [bookmark: pgfId-1287760] 
     
 
     [bookmark: pgfId-1287761]On UNIX, you can automate the generation of the Top10 reports on your DCNM-SANDCNM-SAN Server host by adding the following cron entry to generate the reports once an hour:
 
      
      [bookmark: pgfId-1287762]0 * * * * /<user_directory>/.cisco_mds9000/bin/pm.sh display pm/pm.xml <output_directory> 
     
 
      
      [bookmark: pgfId-1287763] 
     
 
     [bookmark: pgfId-1287764]If your crontab does not run automatically or Java complains about an exception similar to Example 11-1, you need to add “-Djava.awt.headless=true” to the JVMARGS command in /<user_directory>/.cisco_mds9000/bin/pm.sh.
 
     [bookmark: pgfId-1287769]Example 11-1 [bookmark: 29318]Example Java Exception
 
      
      [bookmark: pgfId-1307330]in thread “main” java.lang.InternalError Can't connect to X11 window server using '0.0' as the value of the DISPLAY variable. 
     
 
    
 
     
      [bookmark: pgfId-1307374][bookmark: 1801][bookmark: 1704]Configuring Performance Manager for Use with Cisco Traffic Analyzer
 
     [bookmark: pgfId-1287821]Performance Manager works in conjunction with the [bookmark: marker-1287820]Cisco Traffic Analyzer to allow you to monitor and manage the traffic on your fabric. Using Cisco Traffic Analyzer with Performance Manager requires the following components:
 
      
      	 [bookmark: pgfId-1287822]A configured Fibre Channel Switched Port Analyzer (SPAN) destination (SD) port to forward Fibre Channel traffic.
 
      	 [bookmark: pgfId-1287823]A Port Analyzer Adapter 2 (PAA-2) to convert the Fibre Channel traffic to Ethernet traffic.
 
      	 [bookmark: pgfId-1287824]Cisco Traffic Analyzer software to analyze the traffic from the PAA-2.
 
     
 
    
 
     
      [bookmark: pgfId-1287825]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1287827]Step 1 [bookmark: 1715 ]Set up the Cisco Traffic Analyzer according to the instructions in the Cisco MDS 9000 Family Port Analyzer Adapter 2 Installation and Configuration Note.
 
     [bookmark: pgfId-1287829]Step 2 [bookmark: 1718 ]Get the following three items of information:
 
      
      	 [bookmark: pgfId-1287830]The IP address of the management workstation on which you are running Performance Manager and Cisco Traffic Analyzer.
 
      	 [bookmark: pgfId-1287831]The path to the directory where Cisco Traffic Analyzer is installed.
 
      	 [bookmark: pgfId-1287832]The port that is used by Cisco Traffic Analyzer (the default is 3000).
 
     
 
     [bookmark: pgfId-1287834]Step 3 [bookmark: 1727 ]Start the Cisco Traffic Analyzer.
 
     [bookmark: pgfId-1287835] a. Choose Performance > Traffic Analyzer > Open.
 
     [bookmark: pgfId-1287836] b. Enter the URL for the Cisco Traffic Analyzer, in the format:
 
      
      [bookmark: pgfId-1287837]http://<ip address>:<port number> 
     
 
      
      [bookmark: pgfId-1287838] 
     
 
     [bookmark: pgfId-1287840]ip address is the address of the management workstation on which you have installed the Cisco Traffic Analyzer
 
     [bookmark: pgfId-1287841]:port number is the port that is used by Cisco Traffic Analyzer (the default is :3000).
 
     [bookmark: pgfId-1287842] c. Click OK.
 
     [bookmark: pgfId-1287843] d. Choose Performance > Traffic Analyzer > Start.
 
     [bookmark: pgfId-1287844] e. Enter the location of the Cisco Traffic Analyzer, in the format:
 
      
      [bookmark: pgfId-1287845]D:\<directory>\ntop.bat 
     
 
      
      [bookmark: pgfId-1287846] 
     
 
     [bookmark: pgfId-1287848]D: is the drive letter for the disk drive where the Cisco Traffic Analyzer is installed.
 
     [bookmark: pgfId-1287849]directory is the directory containing the ntop.bat file.
 
     [bookmark: pgfId-1287850] f. Click OK.
 
     [bookmark: pgfId-1287852]Step 4 [bookmark: 1750 ]Create the flows you want Performance Manager to monitor, using the Flow Configuration Wizard. See the “Creating a Flow with Performance Manager” section
 
     [bookmark: pgfId-1287857]Step 5 [bookmark: 1752 ]Define the data collection you want Performance Manager to gather, using the Performance Manager Configuration Wizard. See the “Creating a Collection with Performance Manager” section.
 
     [bookmark: pgfId-1287861] a. Choose the VSAN you want to collect information for or choose All VSANs.
 
     [bookmark: pgfId-1287862] b. Check the types of items you want to collect information for (Hosts, ISLs, Storage Devices, and Flows).
 
     [bookmark: pgfId-1287863] c. Enter the URL for the Cisco Traffic Analyzer in the format:
 
      
      [bookmark: pgfId-1287864]http://<ip address>/<directory> 
     
 
      
      [bookmark: pgfId-1287865] 
     
 
     [bookmark: pgfId-1287866]where:
 
     [bookmark: pgfId-1287867]ip address is the address of the management workstation on which you have installed the Cisco Traffic Analyzer, and directory is the path to the directory where the Cisco Traffic Analyzer is installed.
 
     [bookmark: pgfId-1287868] d. Click Next.
 
     [bookmark: pgfId-1287869] e. Review the data collection on this and the next section to make sure this is the data you want to collect.
 
     [bookmark: pgfId-1287870] f. Click Finish to begin collecting data.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287871]Note Data is not collected for JBOD or for virtual ports. If you change the data collection configuration parameters during a data collection, you must stop and restart the collection process for your changes to take effect.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287873]Step 6 [bookmark: 1772 ]Choose Performance > Reports to generate a report. Performance Manager Web Server must be running. You see Web Services; click Custom then select a report template.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287877]Note It takes at least five minutes to start collecting data for a report. Do not attempt to generate a report in Performance Manager during the first five minutes of collection.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287879]Step 7 [bookmark: 1779 ]Click Cisco Traffic Analyzer at the top of the Host or Storage detail pages to view the Cisco Traffic Analyzer information, or choose Performance > Traffic Analyzer > Open. The Cisco Traffic Analyzer page will not open unless ntop has been started already.
 
      
       
     
 
     
 
     [bookmark: pgfId-1287880]Note For information on capturing a SPAN session and starting a Cisco Traffic Analyzer session to view it, refer to the Cisco MDS 9000 Family Port Analyzer Adapter 2 Installation and Configuration Note.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1287883]Note For information on viewing and interpreting your Performance Manager data, see the “Creating a Flow with Performance Manager” section.

For information on viewing and interpreting your Cisco Traffic Analyzer data, refer to the Cisco MDS 9000 Family Port Analyzer Adapter 2 Installation and Configuration Note.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1287885]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1307325]For performance drill-down, DCNM-SAN Server can launch the Cisco Traffic Analyzer in-context from the Performance Manager graphs. The aliases associated with hosts, storage devices, and VSANs are passed to the Cisco Traffic Analyzer to provide consistent, easy identification.
 
    
 
   
 
    
     [bookmark: pgfId-1308121][bookmark: 89189]Exporting Data Collections 
 
    [bookmark: pgfId-1308128]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1308143]“Exporting Data Collections to XML Files” section
 
     	 [bookmark: pgfId-1308153]“Exporting Data Collections in Readable Format” section
 
    
 
     
      [bookmark: pgfId-1307534][bookmark: 1796]Exporting Data Collections to XML Files
 
     [bookmark: pgfId-1307536]The RRD files used by Performance Manager can be exported[bookmark: marker-1307535] to a freeware tool called rrdtool. The rrd files are located in pm/db on the DCNM-SAN Server. To export the collection to an XML file, enter the following command at the operating system command-line prompt:
 
      
      [bookmark: pgfId-1307537]/bin/pm.bat xport xxx yyy 
     
 
      
      [bookmark: pgfId-1307538] 
     
 
     [bookmark: pgfId-1307539]In this command, xxx is the RRD file and yyy is the XML file that is generated. This XML file is in a format that rrdtool is capable of reading with the command:
 
      
      [bookmark: pgfId-1307540]rrdtool restore filename.xml filename.rrd 
     
 
      
      [bookmark: pgfId-1307541] 
     
 
     [bookmark: pgfId-1307542]You can import an XML file with the command:
 
      
      [bookmark: pgfId-1307543]bin/pm.bat pm restore <xmlFile> <rrdFile> 
     
 
      
      [bookmark: pgfId-1307544] 
     
 
     [bookmark: pgfId-1307545]This reads the XML export format that rrdtool is capable of writing with the command:
 
      
      [bookmark: pgfId-1307546]rrdtool xport filename.xml filename.rrd. 
     
 
      
      [bookmark: pgfId-1307547] 
     
 
     [bookmark: pgfId-1307548]The pm xport and pm restore commands can be found on your DCNM-SAN Server at bin\PM.bat for Windows platforms or bin/PM.sh on UNIX platforms. For more information on the rrdtool, refer to the following website: http://www.rrdtool.org.
 
    
 
     
      [bookmark: pgfId-1307550][bookmark: 68411]Exporting Data Collections in Readable Format
 
     [bookmark: pgfId-1307551]You can export the RRD files used by Performance Manager to a freeware tool called rrdtool and export the collection to an XML file. Cisco MDS SAN-OS Release 2.1(1a) introduces the inability to export data collection[bookmark: marker-1307552]s in comma-separated format (CSV). This format can be imported to various tools, including Microsoft Excel. You can export these readable data collections either from the DCNM-SAN Web Services menus or in batch mode from the command line on Windows or UNIX. Using DCNM-SAN Web Services, you can export one file. Using batch mode, you can export all collections in the pm.xml file.
 
      
       
     
 
     
 
     [bookmark: pgfId-1307555]Note DCNM-SAN Web Server must be running for this to work. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1308108]You can export data collections to Microsoft Excel using DCNM-SAN Web Server.
 
    
 
     
      [bookmark: pgfId-1312130]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1307558]Step 1 Click the Performance tab on the main page. 
 
     [bookmark: pgfId-1307559]You see the overview table.
 
     [bookmark: pgfId-1307560]Step 2 Click the Flows sub-tab.
 
     [bookmark: pgfId-1307561]Step 3 Right-click the name of the entity you want to export and select Export to Microsoft Excel. 
 
     [bookmark: pgfId-1307562]You see the Excel chart for that entity in a pop-up window.
 
     [bookmark: pgfId-1307563]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1307564]You can export data collections using command-line batch mode.
 
    
 
     
      [bookmark: pgfId-1312157]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1307565]Step 1 Go to the installation directory on your workstation and then go to the bin directory.
 
     [bookmark: pgfId-1307566]Step 2 On Windows, enter .\pm.bat export C:\Program Files\Cisco Systems\MDS 9000\pm\pm.xml <export directory>. This creates the csv file (export.csv) in the export directory on your workstation.
 
     [bookmark: pgfId-1307567]Step 3 On UNIX, enter ./pm.sh export /usr/local/cisco_mds9000/pm/pm.xml <export directory>. This creates the csv file (export.csv) in the export directory on your workstation.
 
     [bookmark: pgfId-1307568]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1307569]When you open this exported file in Microsoft Excel, the following information displays:
 
      
      	 [bookmark: pgfId-1307570]Title of the entity you exported and the address of the switch the information came from.
 
      	 [bookmark: pgfId-1307571]The maximum speed seen on the link to or from this entity.
 
      	 [bookmark: pgfId-1307572]The VSAN ID and maximum speed.
 
      	 [bookmark: pgfId-1307573]The timestamp, followed by the receive and transmit data rates in bytes per second.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1307327][bookmark: 15402]Analyzing SAN Health
 
    [bookmark: pgfId-1302212]The SAN Health Advisor tool is a utility that used to monitor the performance and collect the statistics. You can perform the following tasks with this tool:
 
     
     	 [bookmark: pgfId-1302213] Run Performance Monitor to collect I/O statistics
 
     	 [bookmark: pgfId-1302214] Collect fabric inventory (switches and other devices)
 
     	 [bookmark: pgfId-1302215] Create a graphical layout of fabric topology
 
     	 [bookmark: pgfId-1302216] Create reports of error conditions and statistical data
 
    
 
    [bookmark: pgfId-1302217]You can install this tool at any SAN environment to collect I/O statistics for the specified time (usually 24 hours), generate health reports and automatically send reports to the designated system administrator for review at regular intervals. 
 
    [bookmark: pgfId-1302218]When you start SAN Health Advisor tool, it runs in wizard mode, and prompts for inputs such as seed switch credentials, IP address of the server to which the data to be sent and all the necessary information for the software setup. As soon as the fabric is discovered, the tool starts capturing performance data, I/O statistics and error conditions. 
 
    [bookmark: pgfId-1304564]The reports generated from the collection is stored in the $INSTALLDIR/dcm/fm/reports directory. These reports are automatically sent to the designated SAN administrator for review. In a situation where the tool fails to collect the data, it generates a report with an error message or exception. After sending the reports the tool automatically uninstalls itself and terminates all the processes that it established on the host machine. 
 
    [bookmark: pgfId-1302219]The report that SAN Health Advisor tool generates will have the following details:
 
     
     	 [bookmark: pgfId-1302221] Events
 
     	 [bookmark: pgfId-1302222] System messages
 
     	 [bookmark: pgfId-1302223] Analysis of connectivity
 
     	 [bookmark: pgfId-1302224] Zone discrepancy
 
     	 [bookmark: pgfId-1302225] System configuration
 
     	 [bookmark: pgfId-1302226] Interface status
 
     	 [bookmark: pgfId-1302227] Domain information
 
     	 [bookmark: pgfId-1302228] Security settings
 
    
 
    [bookmark: pgfId-1302247]
 
     
      [bookmark: pgfId-1302248]Installing the SAN Health Advisor Tool
 
     [bookmark: pgfId-1302279]SAN Health Advisor tool can be installed and run on Windows, UNIX, and Solaris platforms. Install the package that contains the .jar file with JRE version 6.0. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1302316]Note The SAN Health tool is not installed by default when you install DCNM-SAN software. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1302315]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1302350]Step 1 Double-click the San Health Advisor tool installer.
 
     [bookmark: pgfId-1302351]You see the San Health Advisor tool Installer window as shown in Figure 11-5.
 
     [bookmark: pgfId-1316724]Figure 11-5 [bookmark: 51934]SAN Health Advisor: Installer
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1302367]Step 2 Select an installation folder on your workstation for SAN Health Advisor. 
 
     [bookmark: pgfId-1303343]On Windows, the default location is C:\Program Files\Cisco Systems\.
 
     [bookmark: pgfId-1302416]Step 3 Click Install to start the installation.
 
     [bookmark: pgfId-1302784]You see the installation progressing as shown in Figure 11-6.
 
     [bookmark: pgfId-1316741]Figure 11-6 [bookmark: 11173]SAN Health Advisor: Installation in Progress
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1302423]You see the Fabric Options dialog box as shown in Figure 11-7
 
     [bookmark: pgfId-1316758]Figure 11-7 [bookmark: 15218]SAN Health Advisor: Fabric Options
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1302929]Step 4 In the Seed Switch text box, enter the IP address of the seed switch.
 
     [bookmark: pgfId-1303403]Step 5 Enter the user name and password for the switch. 
 
     [bookmark: pgfId-1303410]Step 6 Select the authentication privacy option from the Auth-Privacy drop-down list box.
 
     [bookmark: pgfId-1302930]Step 7 Click the Performance Collection check box to enable the process to run for 24 hours.
 
     [bookmark: pgfId-1302931]Step 8 Click Collect to start gathering performance information.
 
     [bookmark: pgfId-1302361]You see the collecting dialog box as shown in Figure 11-8.
 
     [bookmark: pgfId-1316775]Figure 11-8 [bookmark: 81192]SAN Health Advisor: Collecting
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1303456]If you want to stop gathering information in the middle of the process, click Cancel. You see the message indicating performance collection is complete as shown in Figure 11-9. 
 
     [bookmark: pgfId-1316792]Figure 11-9 [bookmark: 85051]SAN Health Advisor: Performance Collection Complete
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1303683]Step 9 Click Uninstall to remove the SAN Health Advisor software.
 
     [bookmark: pgfId-1302295]
 
     [bookmark: pgfId-1316797]
 
     [bookmark: pgfId-1302088]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1072913][bookmark: 17492]Overview of DCNM-LAN 
      
      
 
     
 
 
    [bookmark: pgfId-1072914]This chapter provides a brief overview of Cisco Data Center Network Manager for LAN (DCNM-LAN).
 
    [bookmark: pgfId-1070659]For information about the specific Cisco Nexus products supported by DCNM-LAN, see the Cisco DCNM Release Notes, Release 7.1.x.
 
    [bookmark: pgfId-1070660]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1056497]DCNM-LAN Client and Server
 
     	 [bookmark: pgfId-1059927]Features in Cisco DCNM-LAN, Release 5.2
 
     	 [bookmark: pgfId-1056513]Documentation About DCNM-LAN
 
    
 
   
 
    
     [bookmark: pgfId-1056322][bookmark: 11201]DCNM-LAN Client and Server
 
    [bookmark: pgfId-1056389]DCNM-LAN is a Java-based client-server application. For Java requirements, server system requirements, and client system requirements, see the Cisco DCNM Release Notes, Release 7.1.x.
 
    [bookmark: pgfId-1056482]Figure 12-1 shows the DCNM-LAN client-server environment. The DCNM-LAN client communicates with the DCNM-LAN server only, never directly with managed Cisco NX-OS devices. The DCNM-LAN server uses the XML management interface of Cisco NX-OS devices to manage and monitor them. The XML management interface is a programmatic method based on the NETCONF protocol that complements the command-line interface (CLI) functionality. For more information, see the Cisco NX-OS XML Interface User Guide.
 
    [bookmark: pgfId-1057939]Figure 12-1 [bookmark: 59647]DCNM-LAN Client-Server Environment
 
    [bookmark: pgfId-1081130]
 
     
     [image: ] 
    
 
   
 
    
     [bookmark: pgfId-1081132][bookmark: 91012]Features in Cisco DCNM-LAN, Release 5.2
 
    [bookmark: pgfId-1081133]Cisco DCNM-LAN Release 7.1.x supports the configuration and monitoring of the following Cisco NX-OS features:
 
     
     	 [bookmark: pgfId-1056129]Ethernet switching
 
    
 
    [bookmark: pgfId-1056130] – Physical and virtual ports
 
    [bookmark: pgfId-1068057] – Port channels and virtual port channels (vPCs)
 
    [bookmark: pgfId-1056131] – Loopback and management interfaces
 
    [bookmark: pgfId-1066026] – VLAN network interfaces (sometimes referred to as switched virtual interfaces or SVIs)
 
    [bookmark: pgfId-1056132] – VLANs and private VLANs (PVLAN)
 
    [bookmark: pgfId-1056133] – Spanning Tree Protocol, including Rapid Spanning Tree (RST) and Multiple Spanning Tree Protocol (MST)
 
    [bookmark: pgfId-1078252] – Fabric Extender
 
    [bookmark: pgfId-1078174] – Link-state tracking
 
    [bookmark: pgfId-1078249] – Serial Over LAN
 
    [bookmark: pgfId-1078250] – Chassis Internal Network
 
    [bookmark: pgfId-1080045] – Fibre-Channel-over-Ethernet Initiation Protocol (FIP) snooping
 
    [bookmark: pgfId-1080037] – Port profiles
 
     
     	 [bookmark: pgfId-1056134]Ethernet routing
 
    
 
    [bookmark: pgfId-1078254] – Gateway Load Balancing Protocol (GLBP), object tracking, and keychain management
 
    [bookmark: pgfId-1067976] – Hot Standby Router Protocol (HSRP)
 
     
     	 [bookmark: pgfId-1067971]Network security
 
    
 
    [bookmark: pgfId-1056135] – Access control lists
 
    [bookmark: pgfId-1056136] – IEEE 802.1X
 
    [bookmark: pgfId-1056137] – Authentication, authorization, and accounting (AAA)
 
    [bookmark: pgfId-1056138] – Role-based access control
 
    [bookmark: pgfId-1056139] – Dynamic Host Configuration Protocol (DHCP) snooping
 
    [bookmark: pgfId-1056140] – Dynamic Address Resolution Protocol (ARP) inspection
 
    [bookmark: pgfId-1056141] – IP Source Guard
 
    [bookmark: pgfId-1056142] – Traffic storm control
 
    [bookmark: pgfId-1056143] – Port security
 
     
     	 [bookmark: pgfId-1056144]General
 
    
 
    [bookmark: pgfId-1056145] – Virtual Device Context
 
    [bookmark: pgfId-1056147] – Hardware resource utilization with Ternary Content Addressable Memory (TCAM) statistics
 
    [bookmark: pgfId-1056148] – Switched Port Analyzer (SPAN)
 
    [bookmark: pgfId-1056149]DCNM-LAN includes the following features for assistance with management of your network:
 
     
     	 [bookmark: pgfId-1056150]Topology viewer
 
     	 [bookmark: pgfId-1080041]Network servers
 
     	 [bookmark: pgfId-1080042]Device groups
 
     	 [bookmark: pgfId-1056151]Event browser
 
     	 [bookmark: pgfId-1080040]Configuration Delivery Management
 
     	 [bookmark: pgfId-1068068]Configuration Change Management
 
     	 [bookmark: pgfId-1068063]Device OS Management
 
     	 [bookmark: pgfId-1056152]Hardware and virtual switch inventory
 
    
 
    [bookmark: pgfId-1056153]DCNM-LAN includes the following administrative features:
 
     
     	 [bookmark: pgfId-1056154]DCNM-LAN server user accounts
 
     	 [bookmark: pgfId-1056155]Device discovery
 
     	 [bookmark: pgfId-1056156]Automatic synchronization with discovered devices
 
     	 [bookmark: pgfId-1056157]Statistical data collection management
 
     	 [bookmark: pgfId-1059556]DCNM-LAN server and client logging
 
    
 
   
 
    
     [bookmark: pgfId-1080342]Platform Support
 
    [bookmark: pgfId-1080343]DCNM-LAN supports the following platforms:
 
     
     	 [bookmark: pgfId-1081000]Cisco Nexus 1000V switches
 
     	 [bookmark: pgfId-1081001]Cisco Nexus 2000 Fabric Extenders
 
     	 [bookmark: pgfId-1081002]Cisco Nexus 3000 Series switches
 
     	 [bookmark: pgfId-1080520]Cisco Nexus 4000 Series switches
 
     	 [bookmark: pgfId-1081500]Cisco Nexus 5000 Series switches
 
     	 [bookmark: pgfId-1081501]Cisco Nexus 6000 Series switches
 
    
 
    [bookmark: pgfId-1081502] – DCNM-LAN supports both fixed and removable expansion modules.
 
    [bookmark: pgfId-1081503] – In DCNM-LAN, the interface breakout feature can be configured through configuring the delivery feature, and not as a part of configuring an Ethernet interface.
 
     
     	 [bookmark: pgfId-1080522]Catalyst 6500
 
    
 
    [bookmark: pgfId-1080534]DCNM-LAN provides limited support for the Catalyst 6500 Series switches that runs classic IOS version 12.2(33)SXI or higher.
 
    [bookmark: pgfId-1080544] – DCNM-LAN supports the viewing of the current configuration attributes of the device.
 
    [bookmark: pgfId-1080545] – DCNM-LAN does not support changing the configuration of the device. 
 
    [bookmark: pgfId-1080546] – DCNM-LAN supports the Firewall Service Module (FWSM) version 4.0 or higher for the Catalyst 6500 Series switches.
 
     
     	 [bookmark: pgfId-1080523]Cisco Nexus 7000 Series switches
 
    
 
   
 
    
     [bookmark: pgfId-1080345][bookmark: 37356]Documentation About DCNM-LAN
 
    [bookmark: pgfId-1059635]The documentation for DCNM-LAN includes several configuration guides and other documents. For more information about the DCNM-LAN documentation, see the “$paratext>” section.
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1051635][bookmark: 28199]Installing and Launching the Cisco DCNM-LAN Client 
      
      
 
     
 
 
    [bookmark: pgfId-1052681]This chapter describes how to install and launch the Cisco Data Center Network Manager for LAN (DCNM-LAN) client.
 
    [bookmark: pgfId-1055690]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1068694]Information About Installing and Launching the DCNM-LAN Client
 
     	 [bookmark: pgfId-1055717]Prerequisites for Installing and Launching the DCNM-LAN Client
 
     	 [bookmark: pgfId-1067904]Secure Client Communications
 
     	 [bookmark: pgfId-1062922]Default Administrator Credentials
 
     	 [bookmark: pgfId-1055741]Downloading and Launching the DCNM-LAN Client
 
     	 [bookmark: pgfId-1055761]Restarting the DCNM-LAN Client
 
     	 [bookmark: pgfId-1079945]Logging Into the DCNM-LAN Client
 
     	 [bookmark: pgfId-1079949]Uninstalling the DCNM-LAN Client
 
     	 [bookmark: pgfId-1079979]Modifying Cisco DCNM-LAN Server
 
     	 [bookmark: pgfId-1063176]Additional References
 
     	 [bookmark: pgfId-1068645]Feature History for Installing and Launching the DCNM-LAN Client
 
    
 
   
 
    
     [bookmark: pgfId-1068647][bookmark: 20417]Information About Installing and Launching the DCNM-LAN Client
 
    [bookmark: pgfId-1068675]The DCNM-LAN client is a Java application. When you finish installing the DCNM-LAN client on your system, the DCNM-LAN client automatically starts. After installing the DCNM-LAN client, whenever you need to restart the DCNM-LAN client, use the DCNM-LAN client software image on your system for the quickest start. If a more recent version of the DCNM-LAN client is available, the DCNM-LAN client automatically downloads that version to your system. 
 
   
 
    
     [bookmark: pgfId-1068666][bookmark: 25282]Prerequisites for Installing and Launching the DCNM-LAN Client
 
    [bookmark: pgfId-1062910]Installing and using the DCNM-LAN client have the following prerequisites:
 
     
     	 [bookmark: pgfId-1067809][bookmark: marker-1062911]Your system must be running a supported operating system to install and use the DCNM-LAN client software. For more information about client system requirements, see the  Cisco DCNM Release Notes, Release 7.1.x , which are available at the following site:
 
    
 
    [bookmark: pgfId-1071905]http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html
 
     
     	 [bookmark: pgfId-1071906]The installation process uses Java version 1.7.0_55 JRE. If your system does not have that version of Java, the installation process will install it to your system.
 
    
 
    [bookmark: pgfId-1065011]The DCNM-LAN client installer requires Internet access to download the Java version 1.7.0_55 JRE. If the system cannot access the Internet, use another system to download the Java installer and copy it to the system that you want to install the DCNM-LAN client on. You can download Java version JRE 1.7.0_55 from the Oracle Technology Network website.
 
    [bookmark: pgfId-1065100]If your network environment requires a proxy connection to permit the download of the Java installer, ensure that the proxy settings are configured in Internet Options, available from the Control Panel.
 
     
     	 [bookmark: pgfId-1065505]Some DCNM-LAN features require a license. Before you can use licensed features, install the DCNM-LAN license. For more information about licensed features or for more information about the license installation, see the  Cisco DCNM Installation and Licensing Guide, Release 7.1.x .
 
    
 
   
 
    
     [bookmark: pgfId-1059887][bookmark: 54832]Secure Client Communications
 
    [bookmark: pgfId-1067849]By default, communication between the DCNM-LAN client and server is unencrypted; however, you can enable Secure Sockets Layer (SSL) encryption to protect client-server communications. Enabling SSL encryption does not affect how users download, install, and log into the DCNM-LAN client.
 
    [bookmark: pgfId-1067868]For information about enabling secure client communication, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
 
   
 
    
     [bookmark: pgfId-1067833][bookmark: 15213]Default Administrator Credentials[bookmark: marker-1061763]
 
    [bookmark: pgfId-1061106]When you install DCNM-LAN, you specify the default administrator account, which is a DCNM-LAN local user. If you use RADIUS or TACACS+ authentication servers to control access to the DCNM-LAN client, the default administrator account provides you access if no authentication servers for the current authentication mode are reachable.
 
    [bookmark: pgfId-1064098]If no one has administrative access to DCNM-LAN, you can reset the local administrator account or change DCNM-LAN server authentication settings by reinstalling the DCNM-LAN server software. For more information, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
 
   
 
    
     [bookmark: pgfId-1061068][bookmark: 98882]Downloading and Launching the DCNM-LAN Client[bookmark: marker-1065759]
 
    [bookmark: pgfId-1065725]The DCNM-LAN client is available from the web server that is included on the DCNM-LAN server. You can download and launch the DCNM-LAN client either by using a web browser or by using a command prompt.
 
    [bookmark: pgfId-1065779]When you download and launch the DCNM-LAN client, it automatically saves an image of the software on your local system and starts the DCNM-LAN client. Later on, when you start the DCNM-LAN client, you can quickly start it by using the image on your local system.
 
    [bookmark: pgfId-1065777]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1065738]Using a Web Browser to Download and Launch the DCNM-LAN Client
 
     	 [bookmark: pgfId-1065742]Using a Command Prompt to Download and Launch the DCNM-LAN Client
 
     	 [bookmark: pgfId-1070865]Using a Command Prompt to Download and Launch the DCNM-LAN Client without using Java Web Start Launcher
 
    
 
     
      [bookmark: pgfId-1051352][bookmark: 89479]Using a Web Browser to Download and Launch the DCNM-LAN Client
 
     [bookmark: pgfId-1065704]You can use a web browser to download and launch the DCNM-LAN client.
 
    
 
     
      [bookmark: pgfId-1066138]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1068570]The Java version JRE 1.7.0_55 must be installed on the computer that you want to run the DCNM-LAN client on.
 
     [bookmark: pgfId-1068571]The computer that you want to run the DCNM-LAN client on must meet the client system requirements. For details about the client system requirements, see the Cisco DCNM Release Notes, Release 7.1.x, available at the following site:
 
     [bookmark: pgfId-1068576]http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html
 
    
 
     
      [bookmark: pgfId-1061952]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1051426]Step 1 On the computer that you want to use the DCNM-LAN client on, open a web browser and go to the following address:
 
     [bookmark: pgfId-1051427]http://server_IP_address_or_DNS_name:web_server_port/dcnm-client/index.html
 
     [bookmark: pgfId-1051436]For example, if the DCNM-LAN server IP address is 172.0.2.1 and the web server port is 8080, use the following address:
 
      
      [bookmark: pgfId-1054581]http://172.0.2.1:8080/dcnm-client/index.html
 
     
 
     [bookmark: pgfId-1054645]The browser shows the DCNM-LAN client page. 
 
     [bookmark: pgfId-1051453]Step 2 Click Launch DCNM Client.
 
     [bookmark: pgfId-1054688]The DCNM-LAN server sends the dcnm.jnlp file to the browser. This file should be opened with the Java Web Start Launcher.
 
     [bookmark: pgfId-1064532]Step 3 If the browser prompts you, choose to open the dcnm.jnlp file. You do not need to save the file.
 
     [bookmark: pgfId-1087363]The DCNM-LAN client installer verifies that Java is already installed on your system. If the installer does not find the supported version of Java on the computer, the installer prompts you to install Java version JRE 1.7.0_55.
 
      
       
     
 
     
 
     [bookmark: pgfId-1087364]Note The Cisco DCNM client installer requires Internet access to download the Java version JRE 1.7.0_55. If the system cannot access the Internet, use another system to download the Java installer, copy it to the system that you want to install the Cisco DCNM client on, install Java, and restart the Cisco DCNM client installation. You can download Java version JRE 1.7.0_55 from the Oracle Technology Network website.

If your network environment requires a proxy connection to permit the download of the Java installer, ensure that the proxy settings are configured in Internet Options, available from the Control Panel.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1064852]Step 4 If the installer prompts you to install Java version JRE 1.7.0_55, follow these steps:
 
     [bookmark: pgfId-1064597] a. Click OK to begin installing the supported version of Java.
 
     [bookmark: pgfId-1064617] b. If a security warning notifies you that the Java installer was digitally signed by an expired certificate, click Run to continue the installation.
 
     [bookmark: pgfId-1064666] c. Complete the Java installation wizard.
 
      
       
     
 
     
 
     [bookmark: pgfId-1064759]Tip To specify whether the supported version of Java is the default version used by browsers installed on the computer, choose Custom setup on the License Agreement dialog box. Later in the Java installation, on the Browser Registration dialog box, you can specify the browsers that should use the Java version that is supported by DCNM-LAN.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1064748]The DCNM-LAN client installs on the computer.
 
      
       
     
 
     
 
     [bookmark: pgfId-1061775]Note You might need to wait a minute or longer while the installer installs the software.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1055027]The DCNM-LAN client login window opens. 
 
     [bookmark: pgfId-1067529]For detailed login steps, see the “Logging Into the DCNM-LAN Client” section.
 
     [bookmark: pgfId-1062055]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1065915][bookmark: 52148]Using a Command Prompt to Download and Launch the DCNM-LAN Client
 
     [bookmark: pgfId-1065916]You can use a command prompt to download and launch the DCNM-LAN client.
 
    
 
     
      [bookmark: pgfId-1066242]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1066280]The Java version 1.7.0_55 JRE must be installed on the computer that you want to run the DCNM-LAN client on.
 
     [bookmark: pgfId-1066299]The computer that you want to run the DCNM-LAN client on must meet the client system requirements. For details about the client system requirements, see the Cisco DCNM Release Notes, Release 7.1.x, available at the following site:
 
     [bookmark: pgfId-1066248]http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html
 
    
 
     
      [bookmark: pgfId-1066265]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1087458]Step 1 On the computer that you want to use the DCNM-LAN client on, access a command prompt.
 
     [bookmark: pgfId-1087459]Step 2 Use the cd command to change the directory to the bin directory under the Java version 1.7.0_55 installation directory, as follows:
 
     [bookmark: pgfId-1066110]cd path
 
     [bookmark: pgfId-1066111]where path is the relative or absolute path to the bin directory. For example, on Microsoft Windows, the default path to the Java version 1.7.0_55 bin directory is C:\Program Files\dcm\Java\jre1.7.0_55\bin.
 
     [bookmark: pgfId-1066102]Step 3 Enter the applicable command as follows:
 
      
       
       	 [bookmark: pgfId-1065925]For Microsoft Windows:
  javaws.exe  server_IP_address_or_DNS_name  :  web_server_port  /dcnm-client/dcnm.jnlp 
 
       	 [bookmark: pgfId-1066476]For RHEL:
  ./javaws  server_IP_address_or_DNS_name  :  web_server_port  /dcnm-client/dcnm.jnlp 
 
      
 
     
 
     [bookmark: pgfId-1066470]The Java Web Start Launcher retrieves the dcnm.jnlp file from the DCNM-LAN server and installs the DCNM-LAN client on the computer.
 
      
       
     
 
     
 
     [bookmark: pgfId-1065938]Note You might need to wait a minute or longer while the installer installs the software.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1065939]The DCNM-LAN client login window opens.
 
     [bookmark: pgfId-1067441]For detailed login steps, see the “Logging Into the DCNM-LAN Client” section.
 
     [bookmark: pgfId-1065959]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1069998][bookmark: 62074]Using a Command Prompt to Download and Launch the DCNM-LAN Client without using Java Web Start Launcher
 
     [bookmark: pgfId-1069999]You can use a command prompt to download and launch the DCNM-LAN client in standalone mode without using the Java Web Start Launcher.
 
    
 
     
      [bookmark: pgfId-1070000]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1070262]The Java version 1.7.0_55 JRE must be installed on the computer that you want to run the DCNM-LAN client on.
 
     [bookmark: pgfId-1070002]The computer that you want to run the DCNM-LAN client on must meet the client system requirements. For details about the client system requirements, see the Cisco DCNM Release Notes, Release 7.1.x, available at the following site:
 
     [bookmark: pgfId-1070007]http://www.cisco.com/en/US/products/ps9369/tsd_products_support_series_home.html
 
      
       
     
 
     
 
     [bookmark: pgfId-1070889]Note The Cisco DCNM-SAN cross launch feature is not supported when the DCNM-LAN client is installed in standalone mode. (The DCNM-LAN client in standalone mode is not a Java Web Start application.)
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1070212]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1074059]Step 1 Access a command prompt on the computer where the DCNM-LAN server is installed and navigate to the directory where the DCNM-LAN server is installed.
 
      
      	 [bookmark: pgfId-1074087]On a Windows DCNM-LAN server, the DCNM-LAN server is installed in <DCNM_INSTALL_LOCATION>\dcm\dcnm\ui-client directory. 
 The default for <DCNM_INSTALL_LOCATION> is C:\Program Files\Cisco Systems.
 
      	 [bookmark: pgfId-1074277]On a RHEL DCNM-LAN server, the DCNM-LAN server is installed in <DCNM_INSTALL_LOCATION>/dcm/dcnm/ui-client directory. 
 The default for <DCNM_INSTALL_LOCATION> is /usr/cisco.
 
     
 
     [bookmark: pgfId-1074278]Step 2 In the ui-client directory, locate and run the construct_DCNM_LAN_SA_Client script. 
 
      
      	 [bookmark: pgfId-1074318]On a Windows DCNM-LAN server, run construct_DCNM_LAN_SA_Client.bat.
 
      	 [bookmark: pgfId-1074319]On a RHEL DCNM-LAN server, run construct_DCNM_LAN_SA_Client.sh.
 
     
 
     [bookmark: pgfId-1074309]Step 3 Copy the ui-client directory to the computer that you want to run the DCNM-LAN client on.
 
     [bookmark: pgfId-1074279]Step 4 On the computer that you are preparing for the DCNM-LAN client, access a command prompt and set JAVA_HOME to the location where the Java JRE is installed.
For example:
 
      
       
       	 [bookmark: pgfId-1071052]For Microsoft Windows:
 set JAVA_HOME=C:\Program Files\Java\jre1.7.0_55
 
       	 [bookmark: pgfId-1071053]For RHEL:
 export JAVA_HOME=/usr/java/jre1.7.0_55
 
      
 
     
 
     [bookmark: pgfId-1070241]Step 5 On the computer that you are preparing for the DCNM-LAN client, navigate to the ui-client directory that was copied from the DCNM-LAN server.
 
     [bookmark: pgfId-1074505]Step 6 In the ui-client directory, locate and run the dcnm-client-sa script to launch the DCNM-LAN client. 
 
      
      	 [bookmark: pgfId-1074506]On a Windows DCNM-LAN server, run dcnm-client-sa.bat.
 
      	 [bookmark: pgfId-1074507]On a RHEL DCNM-LAN server, run dcnm-client-sa.sh.
 
     
 
     [bookmark: pgfId-1074562]The DCNM-LAN client login window opens.
 
     [bookmark: pgfId-1074566]For detailed login steps, see the “Logging Into the DCNM-LAN Client” section.
 
     [bookmark: pgfId-1074567]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1061927][bookmark: 68786]Restarting the DCNM-LAN Client
 
    [bookmark: pgfId-1061928]If you have previously downloaded and launched the DCNM-LAN client on a computer, you can later start the DCNM-LAN client by using one of the shortcuts that the installer added to the computer.
 
    [bookmark: pgfId-1062129]When you start the DCNM-LAN client, it connects to the DCNM-LAN server and checks if the DCNM-LAN client that is available on the DCNM-LAN server is a newer version than the locally installed DCNM-LAN client. How the DCNM-LAN client starts varies depending upon the result of the version check, as follows:
 
     
     	 [bookmark: pgfId-1063055]If the locally installed DCNM-LAN client is the same version as the DCNM-LAN client that is available on the DCNM-LAN server, the DCNM-LAN client window opens quickly.
 
     	 [bookmark: pgfId-1063069]If the locally installed DCNM-LAN client is older than the version of the DCNM-LAN client that is available on the DCNM-LAN server, the DCNM-LAN client automatically downloads from the DCNM-LAN server and replaces the locally installed DCNM-LAN client before the DCNM-LAN client window opens.
 
    
 
    [bookmark: pgfId-1067505]For detailed login steps, see the “Logging Into the DCNM-LAN Client” section.
 
   
 
    
     [bookmark: pgfId-1067495][bookmark: 50471]Logging Into the DCNM-LAN Client
 
    [bookmark: pgfId-1066720]When you log into the DCNM-LAN client, you must specify a valid DCNM-LAN user account.
 
     
      [bookmark: pgfId-1066676]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1066748]You should know the following information before logging into the DCNM-LAN client:
 
      
      	 [bookmark: pgfId-1066772]A valid DCNM-LAN username and password.
 
      	 [bookmark: pgfId-1066892]The IP address or DNS name of the DCNM-LAN server. 
 
      	 [bookmark: pgfId-1066784]The DCNM-LAN server port number. By default, the server port number is 1099.
 
      	 [bookmark: pgfId-1066789]Proxy server address, HTTP port number, and Socks port number, if a proxy server is required by your network environment.
 
     
 
    
 
     
      [bookmark: pgfId-1066743]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1055315]Step 1 Start the DCNM-LAN client. If you have previously downloaded and launched the DCNM-LAN client on the computer, you can start the client by using one of the shortcuts added to the computer by the client installer. For more information about downloading and launching the client, see one of the following topics:
 
      
       
       	 [bookmark: pgfId-1066839]Using a Web Browser to Download and Launch the DCNM-LAN Client
 
       	 [bookmark: pgfId-1066843]Using a Command Prompt to Download and Launch the DCNM-LAN Client
 
      
 
     
 
     [bookmark: pgfId-1067392]The DCNM-LAN client login window opens.
 
     [bookmark: pgfId-1067396]Step 2 In the DCNM-LAN Server field, enter the DNS name or the IP address of the DCNM-LAN server. By default, this field lists the address or name specified the last time the client logged into a server. If you are logging into the client after downloading it, this field lists the address of the server that you downloaded the client from.
 
     [bookmark: pgfId-1067286]Step 3 In the Username field, enter your DCNM-LAN username. If you are logging into DCNM-LAN for the first time after installing the server, enter the local administrator name that you specified during the server installation. For more information, see the “Default Administrator Credentials” section.
 
     [bookmark: pgfId-1067290]Step 4 In the Password field, enter the password for the DCNM-LAN username that you specified.
 
     [bookmark: pgfId-1062308]Step 5 (Optional) If you need to change the DCNM-LAN server port, do the following:
 
     [bookmark: pgfId-1066932] a. If the Port field is not visible, click More >>.
 
     [bookmark: pgfId-1066953] b. Enter the port number in the Port field.
 
     [bookmark: pgfId-1066989]The default DCNM-LAN server port number is 1099; however, you can specify a different port number when you install or reinstall the DCNM-LAN server.
 
     [bookmark: pgfId-1066908]Step 6 (Optional) If you need to use a proxy server to connect to the DCNM-LAN server, do the following:
 
     [bookmark: pgfId-1066915] a. If the “Connect to the DCNM-LAN server with a proxy server” check box is not visible, click More >>.
 
     [bookmark: pgfId-1067020] b. Check Connect to the DCNM-LAN server with a proxy server.
 
     [bookmark: pgfId-1067044]The Proxy Server area appears below the check box.
 
     [bookmark: pgfId-1067039] c. In the Address field, enter the IP address of the proxy server.
 
     [bookmark: pgfId-1067114] d. In the HTTP Port and Socks Port fields, enter the port numbers on which the proxy server accepts HTTP and Socks connections.
 
     [bookmark: pgfId-1067056] e. (Optional) If the proxy server requires authentication, check Authentication and enter a valid username and password in the fields provided.
 
     [bookmark: pgfId-1062309]Step 7 Click Login.
 
     [bookmark: pgfId-1067262]The DCNM-LAN client opens. For information on how to use the DCNM-LAN client, see Chapter14, “Using the Cisco DCNM-LAN Client”
 
     [bookmark: pgfId-1067265]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1064495][bookmark: 94590]Uninstalling the DCNM-LAN Client
 
    [bookmark: pgfId-1064496]You can uninstall the DCNM-LAN client from a computer.
 
     
      [bookmark: pgfId-1051773]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1051793]Step 1 [bookmark: marker-1053764]Click Start > Control Panel > Java.
 
     [bookmark: pgfId-1051799]The Java Control Panel dialog box opens.
 
     [bookmark: pgfId-1051804]Step 2 In the General tab, under Temporary Internet Files, click Settings.
 
     [bookmark: pgfId-1062394]The Temporary File Settings dialog box appears.
 
     [bookmark: pgfId-1062385]Step 3 Click View Applications.
 
     [bookmark: pgfId-1051805]The Java Application Cache Viewer dialog box opens.
 
     [bookmark: pgfId-1051806]Step 4 Select the DCNM-LAN Client application and click Remove Selected Application.
 
     [bookmark: pgfId-1051807]Java uninstalls the DCNM-LAN client image from your computer.
 
     [bookmark: pgfId-1051808]Step 5 Close the Java Application Cache Viewer.
 
     [bookmark: pgfId-1051809]Step 6 On the Temporary File Settings dialog box, click OK.
 
     [bookmark: pgfId-1062451]Step 7 On the Java Control Panel dialog box, click OK.
 
     [bookmark: pgfId-1051810]Step 8 If you want to reinstall the DCNM-LAN client, see the “Downloading and Launching the DCNM-LAN Client” section.
 
     [bookmark: pgfId-1052045]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1079780][bookmark: 47558]Modifying Cisco DCNM-LAN Server
 
    [bookmark: pgfId-1079781]DCNM allows you to modify certain Cisco DCNM-LAN Server settings. Some changes require you to restart the DCNM services.
 
     
     	 [bookmark: pgfId-1079784]Changing the IP Address of the Cisco DCNM-LAN for WINDOWS OS
 
     	 [bookmark: pgfId-1080685]Changing the IP Address of the Cisco DCNM-LAN on Federated Windows OS
 
     	 [bookmark: pgfId-1079788]Changing the IP Address of the Cisco DCNM-LAN on Linux OS
 
    
 
     
      [bookmark: pgfId-1079791][bookmark: 46342]Changing the IP Address of the Cisco DCNM-LAN for WINDOWS OS
 
     [bookmark: pgfId-1079792]To change the IP address of a Cisco DCNM-LAN Windows Server, follow these steps:
 
      
       
     
 
     
 
     [bookmark: pgfId-1079795]Note To change the IP Address of a Cisco DCNM-SAN & DCNM-SMIS Server, see Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS WINDOWS Server.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1079797]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1079798]Step 1 Logon to the Cisco DCNM Web Client. 
 
     [bookmark: pgfId-1079799]Step 2 Select Admin > Server Properties. Edit the value for lan.server.bindaddrs to new IP address.
 
     [bookmark: pgfId-1079800]Step 3 Stop the Cisco DCNM-LAN Server using Windows Services.
 
     [bookmark: pgfId-1079801]Step 4 Change the old IP Address with the new IP Address in the following files:
 
     [bookmark: pgfId-1079802] a. $INSTALLDIR\jboss-as-7.2.0.Final\bin\service\lanservice.bat
 
     [bookmark: pgfId-1079803] b. $INSTALLDIR\jboss-as-7.2.0.Final\standalone\configuration\standalone-lan.xml
 
     [bookmark: pgfId-1079804] c. $INSTALLDIR\dcnm\bin\clean-dcnm-db.bat
 
     [bookmark: pgfId-1079805] d. $INSTALLDIR\dcnm\bin\dcnm-log-capture.bat
 
     [bookmark: pgfId-1079806] e. $INSTALLDIR\dcnm\bin\startLANSANServer.bat
 
     [bookmark: pgfId-1079807] f. $INSTALLDIR\dcnm\bin\status-dcnm.bat.
 
     [bookmark: pgfId-1079808] g. $INSTALLDIR\dcnm\bin\takeServerDump.bat.
 
     [bookmark: pgfId-1079809] h. $INSTALLDIR\jboss-as-7.2.0.Final\standalone\landeployments\dcnm-client.war\dcnm.jnlp
 
     [bookmark: pgfId-1079810] i. $INSTALLDIR\jbos-as-7.2.0.Final\standalone\landeployments\dcnm-client.war\dcnmLatest.jnlp
 
      
       
     
 
     
 
     [bookmark: pgfId-1079811]Note dcnm-client.war can be modified using 7-Zip/Winrar application.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1079812]Step 5 Start the Cisco DCNM-LAN Server using the Windows Services.
 
     [bookmark: pgfId-1079813]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1080692][bookmark: 38206]Changing the IP Address of the Cisco DCNM-LAN on Federated Windows OS
 
     [bookmark: pgfId-1080772]To change the IP address of a federated Cisco DCNM-LAN Server, follow these steps:
 
     
 
     [bookmark: pgfId-1080920]Step 1 Logon to the Cisco DCNM Web Client.
 
     [bookmark: pgfId-1081048]Step 2 Navigate to Admin > Server Properties. Edit lan.server.bindaddrs with the new IP address.
 
     [bookmark: pgfId-1080921]Step 3 Stop the Cisco DCNM-LAN Server using Windows Services.
 
     [bookmark: pgfId-1080922]Step 4 Change the old IP Address with the new IP Address in the file $INSTALLDIR\jboss-as-7.2.0.Final\bin\service\lanservice.bat 
 
     [bookmark: pgfId-1080923] a. $INSTALLDIR\jboss-as-7.2.0.Final\standalone\configuration\standalone-lan.xml
 
     [bookmark: pgfId-1081110] b. $INSTALLDIR\dcnm\bin\clean-dcnm-db.bat
 
     [bookmark: pgfId-1081111] c. $INSTALLDIR\dcnm\bin\dcnm-log-capture.bat
 
     [bookmark: pgfId-1081112] d. $INSTALLDIR\dcnm\bin\startLANSANServer.bat
 
     [bookmark: pgfId-1080927] e. $INSTALLDIR\dcnm\bin\status-dcnm.bat
 
     [bookmark: pgfId-1080928] f. $INSTALLDIR\dcnm\bin\takeServerDump.bat
 
     [bookmark: pgfId-1081174] g. $INSTALLDIR\jboss-as-7.2.0.Final\standalone\landeployments\dcnm-client.war\dcnm.jnlp
 
     [bookmark: pgfId-1081179] h. $INSTALLDIR\jboss-as-7.2.0.Final\standalone\landeployments\dcnm-client.war\dcnmLatest.jnlp
 
      
       
     
 
     
 
     [bookmark: pgfId-1081217]Note You can modify the dcnm-client.war file by using 7-Zip or Winrar application.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1080939]Step 5 Start the Cisco DCNM-LAN Server using Windows Services.
 
     [bookmark: pgfId-1080912]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1079815][bookmark: 82813]Changing the IP Address of the Cisco DCNM-LAN on Linux OS
 
     [bookmark: pgfId-1079816]To change the IP address of a Cisco DCNM-LAN Server, follow these steps:
 
      
       
     
 
     
 
     [bookmark: pgfId-1079819]Note To change the IP Address of a Cisco DCNM-SAN & DCNM-SMIS Server, see Changing the IP Address of the Cisco DCNM-SAN & DCNM-SMIS LINUX Server.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1079821]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1079822]Step 1 Logon to the Cisco DCNM Web Client.
 
     [bookmark: pgfId-1079823]Step 2 Select Admin > Server Properties. Edit the value for lan.server.bindaddrs to new IP address.
 
     [bookmark: pgfId-1079824]Step 3 Stop the Cisco DCNM-LAN Server. Run $INSTALLDIR\dcnm\bin\stopdcnm.sh.
 
     [bookmark: pgfId-1079825]Step 4 Change the old IP Address with the new IP Address in the following files:
 
     [bookmark: pgfId-1079826] a. $INSTALLDIR/jboss-as-7.2.0.Final/bin/init.d/lanservice.sh.
 
     [bookmark: pgfId-1079827] b. /etc/init.d/LANServer
 
     [bookmark: pgfId-1079828] c. $INSTALLDIR/jboss-as-7.2.0.Final/standalone/configuration/standalone-lan.xml
 
     [bookmark: pgfId-1079829] d. $INSTALLDIR\dcnm\bin\clean-dcnm-db.sh
 
     [bookmark: pgfId-1079830] e. $INSTALLDIR\dcnm\bin\dcnm-log-capture.sh
 
     [bookmark: pgfId-1079831] f. $INSTALLDIR\dcnm\bin\startLANSANServer.sh
 
     [bookmark: pgfId-1079832] g. $INSTALLDIR\dcnm\bin\takeServerDump.sh
 
     [bookmark: pgfId-1079833]Step 5 Start the Cisco DCNM-LAN Server (run $INSTALLDIR\dcnm\bin\startdcnm.sh).
 
     [bookmark: pgfId-1079877]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1063101][bookmark: 24180]Additional References
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1066632]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1066634]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1066636]How to use the DCNM-LAN client
  
        	[bookmark: pgfId-1066641]Chapter 14, “Using the Cisco DCNM-LAN Client”
  
       
 
        
        	[bookmark: pgfId-1066643]Starting or stopping a DCNM-LAN server
  
        	[bookmark: pgfId-1066648]Chapter 25, “Starting and Stopping Cisco DCNM-LAN Servers”
  
       
 
        
        	[bookmark: pgfId-1066660]The process of deploying DCNM-LAN in your organization
  
        	[bookmark: pgfId-1066665]Cisco DCNM Installation and Licensing Guide, Release 7.1.x
  
       
 
        
        	[bookmark: pgfId-1066653]Installing a DCNM-LAN server
  
        	[bookmark: pgfId-1066658]Cisco DCNM Installation and Licensing Guide, Release 7.1.x
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1063134][bookmark: 55398]Standards
 
    [bookmark: pgfId-1063144]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1063137]Standards 
         
  
        	 
          
          [bookmark: pgfId-1063139]Title 
         
  
       
 
        
        	[bookmark: pgfId-1063141]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
        	[bookmark: pgfId-1063143]—
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1060421][bookmark: 92503]Feature History for Installing and Launching the DCNM-LAN Client
 
     
      
       
       [bookmark: pgfId-1060432]Table 13-1 [bookmark: 50557]Feature History for Installing and Launching the DCNM-LAN Client 
 
       
       
        
        	 
          
          [bookmark: pgfId-1060438]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1060440]Releases 
         
  
        	 
          
          [bookmark: pgfId-1060442]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1060456]Using a command prompt to download the client.
  
        	[bookmark: pgfId-1060458]5.0(2)
  
        	[bookmark: pgfId-1063642]Support was added for this feature.
  
       
 
        
        	[bookmark: pgfId-1066569]Proxy support for the DCNM-LAN client.
  
        	[bookmark: pgfId-1066571]5.0(2)
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1075455][bookmark: 85688]Using the Cisco DCNM-LAN Client 
      
      
 
     
 
 
    [bookmark: pgfId-1075456]This chaptersection describes the user interface of the Cisco Data Center Network Manager for LAN (DCNM-LAN) client and how to use common features.
 
    [bookmark: pgfId-1172292]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1172296]Information About the DCNM-LAN Client
 
     	 [bookmark: pgfId-1172300]Opening the DCNM-LAN Client
 
     	 [bookmark: pgfId-1172304]Closing the DCNM-LAN Client
 
     	 [bookmark: pgfId-1172308]Deploying Changes
 
     	 [bookmark: pgfId-1172312]Working with Statistics and Charts
 
     	 [bookmark: pgfId-1172316]Configuring Global Preferences
 
     	 [bookmark: pgfId-1172320]Using Online Help
 
    
 
   
 
    
     [bookmark: pgfId-1172330][bookmark: 72509]Information About the DCNM-LAN Client
 
    [bookmark: pgfId-1172331]This section describes the DCNM-LAN client and its parts.
 
    [bookmark: pgfId-1172332]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1172336]User Interface
 
     	 [bookmark: pgfId-1172340]Feature Selector Pane
 
     	 [bookmark: pgfId-1172344]Contents Pane
 
     	 [bookmark: pgfId-1172348]Summary Pane
 
     	 [bookmark: pgfId-1172352]Details Pane
 
     	 [bookmark: pgfId-1172356]Association Pane
 
     	 [bookmark: pgfId-1172360]Menus
 
     	 [bookmark: pgfId-1172364]Toolbars
 
     	 [bookmark: pgfId-1172368]Keyboard Commands
 
     	 [bookmark: pgfId-1172372]Multiple Platform Support
 
    
 
     
      [bookmark: pgfId-1075519][bookmark: 30384]User Interface
 
     [bookmark: pgfId-1079831]The DCNM-LAN client user interface presents device status information and provides configuration tools that allow you to manage devices. It is divided into the panes. When you want to view information about a specific object in a managed device or want to perform a configuration task, you use the panes in the order shown in the figure below.
 
     [bookmark: pgfId-1172444]Figure 14-1 [bookmark: 11286]DCNM-LAN Client User Interface
 
     [bookmark: pgfId-1184251]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1189100]
 
     [bookmark: pgfId-1075550]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1079624]1 
          
  
         	[bookmark: pgfId-1079626]Feature Selector pane
  
         	 
           
           [bookmark: pgfId-1174617]3 
          
  
         	[bookmark: pgfId-1174619]Summary pane
  
        
 
         
         	 
           
           [bookmark: pgfId-1174613]2 
          
  
         	[bookmark: pgfId-1174615]Contents pane
  
         	 
           
           [bookmark: pgfId-1079636]4 
          
  
         	[bookmark: pgfId-1079638]Details pane
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1075555][bookmark: 43742]Feature Selector Pane
 
     [bookmark: pgfId-1075559]The Feature Selector pane, shown in Figure 14-1the figure in the “User Interface” section, allows you to see features grouped by categories and to choose the feature that you want to use or configure. The bottom section of the Feature Selector pane displays buttons for feature categories. When you choose a category, the top section of the Feature Selector pane displays a tree of features within the chosen category.
 
     [bookmark: pgfId-1075563]In Figure 14-1the figure in the “User Interface” section, the Interfaces category is chosen, so the tree shows features that allow you to configure the interfaces of managed devices.
 
     [bookmark: pgfId-1075564]The documentation and online help for DCNM-LAN includes many procedures that begin with choosing the applicable feature from the Feature Selector pane. For example, a procedure about configuring an Ethernet interface would start with the following step:
 
     [bookmark: pgfId-1075565]From the Feature Selector pane, choose Interfaces > Physical > Ethernet.
 
     [bookmark: pgfId-1075566]After you choose a feature on the tree, the Contents pane displays information about the feature.
 
    
 
     
      [bookmark: pgfId-1075568][bookmark: 94698]Contents Pane
 
     [bookmark: pgfId-1075572]The Contents pane, shown in Figure 14-1the figure in the “User Interface” section, displays information about the currently selected feature and provides fields for configuring that feature. The Contents pane contains two smaller panes: the Summary pane and the Details pane.
 
    
 
     
      [bookmark: pgfId-1075574][bookmark: 10367]Summary Pane
 
     [bookmark: pgfId-1075578]The Summary pane, shown in Figure 14-1the figure in the “User Interface” section, displays an organized set of objects that you can view information about or perform actions on. The type of objects that appear depends upon the currently selected feature.
 
     [bookmark: pgfId-1075579]For example, if you choose Interfaces > Physical > Ethernet from the Feature Selector pane, the Summary pane shows a table of devices. You can expand the managed devices to view the slots that contain network interface cards. You can expand the slots to view the interfaces they contain and key information about the status of the interfaces, such as the port mode, administrative status, and operational status. For most features, the title bar for the Summary pane shows what you have selected.
 
     [bookmark: pgfId-1075580]After you choose the object that you want to view or configure, the Details pane displays information about the selected object, such as an Ethernet interface.
 
     [bookmark: pgfId-1119748]Exporting the Summary Pane
 
     [bookmark: pgfId-1119757]You can export the data shown in the Summary pane to a spreadsheet in Microsoft Excel 97-2003 format. To do so, click the green arrow in the upper-right corner of the Summary pane and specify the filename and location for the spreadsheet.
 
     [bookmark: pgfId-1075581]Filtering the Summary Pane
 
     [bookmark: pgfId-1119744]For many features, you can filter the objects that appear in the Summary pane. If filtering is supported for the feature that you selected, you can enable filtering from the menu bar by choosing View > Filter. In the Summary pane, the columns that you can use to filter the objects become drop-down lists. To filter the Summary pane, use the drop-down column heading lists to limit the objects that appear.
 
    
 
     
      [bookmark: pgfId-1075583][bookmark: 61634]Details Pane
 
     [bookmark: pgfId-1075587]The Details pane, shown in Figure 14-1the figure in the “User Interface” section, shows information and configuration fields that are specific to the object that you selected in the Summary pane. The Details tab is often further divided into tabs. You can click on a tab to view its contents.
 
     [bookmark: pgfId-1172585]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1172589]Tabs
 
      	 [bookmark: pgfId-1172593]Sections
 
     
 
    
 
     
      [bookmark: pgfId-1075588][bookmark: 12139]Tabs
 
     [bookmark: pgfId-1075592]Tabs organize related fields and information. For example, as shown in Figure 14-1the figure in the “User Interface” section, when you select an Ethernet interface, four tabs appear in the Details pane, such as the Port Details tab.
 
     [bookmark: pgfId-1075593]The following two special tabs often appear in the Details pane for many of the types of objects that you can choose from the Summary pane:
 
      
      	 [bookmark: pgfId-1075594]Statistics—You can use this tab to work with statistics and charts related to the selected object. For more information, see the “Working with Statistics and Charts” section.
 
      	 [bookmark: pgfId-1075598]Events—You can use this tab to view feature-specific events about the selected object. For more information, see the  System Management Configuration Guide, Cisco DCNM for LAN .
 
     
 
    
 
     
      [bookmark: pgfId-1075602][bookmark: 25012]Sections
 
     [bookmark: pgfId-1075603]Sections provide further organization of related fields and information. The DCNM-LAN client allows you to expand and collapse sections so that you can show or hide fields and information as needed. For example, as shown in Figure 14-1the figure in the “User Interface” section, on the Port Details tab, the Basic Settings section is expanded but the Port Mode Settings section is collapsed.
 
    
 
     
      [bookmark: pgfId-1075608][bookmark: 14032]Association Pane
 
     [bookmark: pgfId-1075609]The DCNM-LAN client also includes the Association pane, which allows you to access objects that you have configured in features that are associated with the currently selected feature. Figure 14-2The following figure shows the Association pane.
 
     [bookmark: pgfId-1079961]When tabs appear on the right side of the DCNM-LAN client, you can click on them to access the Association pane. For example, as shown in Figure 14-2the following figure, if you are configuring an Ethernet interface, you can use the Association pane to access the IPv4 ACLs that you can apply to the interface. If you right-click on an IPv4 ACL in the Association pane, you can choose to apply the ACL to the interface or to go to the IPv4 ACLs feature and configure the ACL.
 
     [bookmark: pgfId-1172716]Figure 14-2 [bookmark: 68552]Association Pane
 
     [bookmark: pgfId-1184943]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1080739]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1080736]1 
          
  
         	[bookmark: pgfId-1080738]Association pane
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1075629][bookmark: 63051]Menus
 
     [bookmark: pgfId-1075630]The menu bar in the DCNM-LAN client includes the following standard menus that appear:
 
    
 
     
      [bookmark: pgfId-1109411]File Menu
 
      
      	 [bookmark: pgfId-1109566]New—Allows you to create new objects. The types of objects that you can create depends upon the currently selected feature. In some cases, the object selected in the Summary pane also affects what you can create.
 
      	 [bookmark: pgfId-1109415]Deploy—Saves your changes to the DCNM-LAN server and deploys configuration changes to managed devices.
 
      	 [bookmark: pgfId-1109419]Exit—Closes the DCNM-LAN client.
 
     
 
    
 
     
      [bookmark: pgfId-1109590]View Menu
 
      
      	 [bookmark: pgfId-1109594]Toolbars—Allows you to show or hide the toolbars that are available for the currently selected feature. For more information, see the “Toolbars” section.
 
      	 [bookmark: pgfId-1109601]Refresh—Forces the DCNM-LAN client to retrieve updated information from the DCNM-LAN server.
 
      	 [bookmark: pgfId-1109605]Filter—Enables or disables the filtering option for the Summary pane.
 
     
 
    
 
     
      [bookmark: pgfId-1109616]Tools Menu
 
      
      	 [bookmark: pgfId-1109620]Preferences—Opens the Global Preferences dialog box. For more information, see the “Configuring Global Preferences” section.
 
      	 [bookmark: pgfId-1109627]Debug—Opens the DCNM-LAN Client Logging dialog box, which allows you to configure the logging level for the DCNM-LAN client.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1109630]Note We recommend that you use the default client logging level unless you are troubleshooting a specific problem or are asked to change client logging levels by the Cisco technical support staff.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1109645]Go Menu
 
      
      	 [bookmark: pgfId-1109649]Topology—Selects the Topology button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109653]Inventory—Selects the Inventory button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109657]Virtual Devices—Selects the Virtual Devices button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109661]Interfaces—Selects the Interfaces button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1110182]Switching—Selects the Switching button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1155401]FCoE—Selects the FCoE button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1110184]Routing—Selects the Routing button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109673]Security—Selects the Security button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109681]Configuration Change Management—Selects the Configuration Change Management button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1109685]Device OS Management—Selects the Device OS Management button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1155437]Configuration Delivery Management—Selects the Configuration Delivery Management button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1155456]DCNM-LAN Server Administration—Selects the DCNM-LAN Server Administration button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1155465]Network Servers—Selects the Network Servers button on the Feature Selector pane.
 
      	 [bookmark: pgfId-1110694]Event Browser—Selects the Event Browser button on the Feature Selector pane.
 
     
 
    
 
     
      [bookmark: pgfId-1110695]Actions Menu
 
     [bookmark: pgfId-1110830]The items on the Actions menu reflect what you can do, depending upon the feature you are using and the object that is selected in the Summary pane. For some features, such as Inventory, the Actions menu does not appear in the menu bar.
 
    
 
     
      [bookmark: pgfId-1110791]Help Menu
 
      
      	 [bookmark: pgfId-1110696]Help Contents—Opens the online help system to the Welcome page.
 
      	 [bookmark: pgfId-1109746]Context Help—Opens the online help system to a page that applies to the feature currently selected in the Feature Selector pane.
 
      	 [bookmark: pgfId-1149295]Show DCNM-LAN Instance ID—Opens a dialog box that displays the license ID for your DCNM-LAN server. For more information, see the Cisco DCNM Installation Guide, Release 7.1.x.
 
      	 [bookmark: pgfId-1149299]View Licenses—Opens a dialog box that displays information about license files currently installed with your DCNM-LAN server.
 
      	 [bookmark: pgfId-1109758]About Data Center Network Manager—Opens a dialog box that displays information about your DCNM-LAN server, including the software version and implementation version.
 
     
 
    
 
     
      [bookmark: pgfId-1075813][bookmark: 41994]Toolbars
 
     [bookmark: pgfId-1075814]The DCNM-LAN client provides several standard toolbars plus additional, feature-specific toolbars that are available only when you have selected the applicable feature. The following table lists actions that you can take to configure toolbars.
 
     [bookmark: pgfId-1108667]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1108648]Action 
          
  
         	 
           
           [bookmark: pgfId-1108650]How To 
          
  
        
 
         
         	[bookmark: pgfId-1108652]Show or hide a toolbar
  
         	[bookmark: pgfId-1108654]Right-click on the toolbar area and then choose the toolbar that you want to show or hide.
  
        
 
         
         	[bookmark: pgfId-1108656]Rearrange toolbars
  
         	[bookmark: pgfId-1108658]On a toolbar that you want to move, click on the left end of the toolbar and drag it to where you want it.
  
        
 
         
         	[bookmark: pgfId-1108660]Float a toolbar
  
         	[bookmark: pgfId-1108662]On the toolbar that you want to float, click on the left end of the toolbar and drag it off of the toolbar area.
  
        
 
         
         	[bookmark: pgfId-1108664]Control whether a toolbar can be hidden, rearranged, or floated
  
         	[bookmark: pgfId-1108666]Right-click on the toolbar area and then choose the option that you want to control.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1075845][bookmark: 53794]Keyboard Commands
 
     [bookmark: pgfId-1075846]You can use the keyboard to perform many of the commands that you can perform with menu items or toolbars. The menus show the keyboard equivalent of most menu items. For example, the following list shows some common menu items and the matching keyboard command:
 
      
      	 [bookmark: pgfId-1075847]Deploy—Ctrl + S
 
      	 [bookmark: pgfId-1075848]Refresh—F5
 
      	 [bookmark: pgfId-1075849]Filter—Ctrl + F
 
      	 [bookmark: pgfId-1075850]Online help—F1
 
      	 [bookmark: pgfId-1075851]Exit—Ctrl + Q
 
     
 
    
 
     
      [bookmark: pgfId-1155214][bookmark: 23258]Multiple Platform Support
 
     [bookmark: pgfId-1155215]DCNM-LAN supports several types of Cisco Nexus platforms; however, some of the features supported in DCNM-LAN are not supported or applicable to all platforms. This section describes how DCNM-LAN handles unsupported features in the user interface.
 
      
      	 [bookmark: pgfId-1155216]Unsupported Features—If a platform does not support a particular feature, the platform is not displayed for that feature. 
 
     
 
     [bookmark: pgfId-1155217]For example, if you choose Security > Access Control > Time-range from the Feature Selector pane, the Summary pane displays only the platform types that support the Time-range feature. In this case, the Cisco Nexus 1000V does not support this feature, so any managed Cisco Nexus 1000V platforms are not displayed in the Summary pane. Similarly, the Time-range association pane does not include any Cisco Nexus 1000V platforms. 
 
      
      	 [bookmark: pgfId-1155218]Unsupported Attributes—Sometimes a platform supports a feature, but does not support a particular attribute in that feature. In this case, the attribute is grayed-out or a N/A (Not Applicable) value is displayed in the field or cell. 
 
     
 
     [bookmark: pgfId-1155219]If all attributes grouped in a particular section are not supported, N/A is added to the section title, and DCNM-LAN does not allow you to expand the section.
 
     [bookmark: pgfId-1155220]If all attributes in a tab are not supported for a particular platform, the tab is displayed, but if you click on it, a message appears stating that the attribute is not supported. 
 
      
      	 [bookmark: pgfId-1155221] Unsupported Charts—If a platform does not support some attributes in a chart, DCNM-LAN grays out those attributes. If a platform does not support any attributes in a chart, when you select the chart, DCNM-LAN displays a message stating that the chart is not supported.
 
      	 [bookmark: pgfId-1155222]Unsupported Options—If a platform does not support an option, the option is not displayed, for example, in drop-down lists.
 
      	 [bookmark: pgfId-1155223] Unsupported Operations— If a platform does not support an option for a specific operation on a context or toolbar menu, the option is grayed-out.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1067715][bookmark: 61376]Opening the DCNM-LAN Client
 
    [bookmark: pgfId-1058778]You can open the DCNM-LAN client after you have installed the DCNM-LAN client on the computer that you are using.
 
     
      [bookmark: pgfId-1060471]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1062361]Install the DCNM-LAN client on the computer that you are using. 
 
    
 
     
      [bookmark: pgfId-1060472]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1060533]Step 1 From the start menu, choose All Programs > Cisco DCNM Client > Cisco DCNM LAN.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060534]Note If the DCNM-LAN client is not available on the All Programs menu, you can launch the DCNM-LAN client from the DCNM-LAN server website. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1095996]A dialog box displays login fields.
 
     [bookmark: pgfId-1095997]Step 2 In the DCNM Server field, enter the IP address or hostname of the DCNM-LAN server. You can use the hostname only if your DNS server has an entry for the DCNM-LAN server hostname. If you have previously logged into the server with the current client installation, you may be able to choose the IP address or hostname from the drop-down list.
 
     [bookmark: pgfId-1058573]Step 3 In the Username field, enter the name of the DCNM-LAN server user account that you want to use to access the DCNM-LAN client.
 
     [bookmark: pgfId-1058581]Step 4 In the Password field, enter the password for the user account that you specified.
 
     [bookmark: pgfId-1155555]Step 5 (Optional) If you need to change the DCNM-LAN server port, do the following:
 
     [bookmark: pgfId-1155556] a. If the Port field is not visible, click More >>.
 
     [bookmark: pgfId-1155557] b. Enter the port number in the Port field.
 
     [bookmark: pgfId-1155558]The default DCNM-LAN server port number is 1099; however, you can specify a different port number when you install or reinstall the DCNM-LAN server.
 
     [bookmark: pgfId-1155559]Step 6 (Optional) If you need to use a proxy server to connect to the DCNM-LAN server, do the following:
 
     [bookmark: pgfId-1155560] a. If the “Connect to the DCNM-LAN server with a proxy server” check box is not visible, click More >>.
 
     [bookmark: pgfId-1155561] b. Check Connect to the DCNM server with a proxy server.
 
     [bookmark: pgfId-1155562]The Proxy Server area appears below the check box.
 
     [bookmark: pgfId-1155563] c. In the Address field, enter the IP address of the proxy server.
 
     [bookmark: pgfId-1155564] d. In the HTTP Port and Socks Port fields, enter the port numbers on which the proxy server accepts HTTP and Socks connections.
 
     [bookmark: pgfId-1155565] e. (Optional) If the proxy server requires authentication, check Authentication and enter a valid username and password in the fields provided.
 
     [bookmark: pgfId-1058594]Step 7 Click Login.
 
     [bookmark: pgfId-1058603]The DCNM-LAN client user interface appears.
 
     [bookmark: pgfId-1059205]If a dialog box displays a message about device credentials, you have not configured device credentials for the user account that you specified.
 
     [bookmark: pgfId-1059208]Step 8 If a dialog box shows a message that your device credentials are not set, do one of the following:
 
      
      	 [bookmark: pgfId-1059217]If you want to set device credentials now, click  Yes .
 
      	 [bookmark: pgfId-1059295]If you do not want to set device credentials now, click  No .
 
     
 
     [bookmark: pgfId-1059296]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189179]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189183]Closing the DCNM-LAN Client
 
      	 [bookmark: pgfId-1189187]Configuring Default Device Credentials
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1062229][bookmark: 72623]Closing the DCNM-LAN Client
 
    [bookmark: pgfId-1056229]You can close the DCNM-LAN client when you are done using it.
 
     
      [bookmark: pgfId-1060451]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1058880]Step 1 From the menu bar, choose File > Exit.
 
     [bookmark: pgfId-1058881]A dialog box displays a confirmation message.
 
     [bookmark: pgfId-1058882]Step 2 (Optional) If you have not deployed your changes, do one of the following:
 
      
       
       	 [bookmark: pgfId-1058910]If you want to save your changes, including deploying configuration changes to managed devices, check  Save pending changes .
 
       	 [bookmark: pgfId-1058943]If you want to discard your changes, uncheck  Save pending changes .
 
      
 
     
 
     [bookmark: pgfId-1058955]Step 3 Click Yes.
 
     [bookmark: pgfId-1058969]If you started any statistical data collection processes during the DCNM-LAN client session, a dialog box displays the collection processes.
 
     [bookmark: pgfId-1060233]Step 4 If a dialog box displays the statistical data collection processes that you started, do the following:
 
     [bookmark: pgfId-1060278] a. Decide which statistical collection processes that you want to stop.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060362]Note We recommend that you stop any unnecessary statistical collection processes when you log out of the DCNM-LAN client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1060300] b. Check the collection processes that you want to stop. If you want to stop all of your collection processes, click Select All.
 
     [bookmark: pgfId-1060395] c. Click Ok.
 
     [bookmark: pgfId-1062335]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189192]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189196]Opening the DCNM-LAN Client
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1062337][bookmark: 22215]Deploying Changes
 
    [bookmark: pgfId-1118477]When you use the DCNM-LAN client to make configuration changes to managed devices or to the DCNM-LAN server, you may need to deploy the changes or the DCNM-LAN client may deploy them automatically, depending upon what changes you have made.
 
     
     	 [bookmark: pgfId-1119400]Automatic deployment—If the DCNM-LAN client deploys a change automatically, the “Deploying configuration” message appears briefly. For example, if you delete an access rule from an ACL, the DCNM-LAN client immediately deploys this configuration change to the managed device that has the ACL.
 
     	 [bookmark: pgfId-1118449]Manual deployment—If the DCNM-LAN client is storing a configuration change, on the toolbar, the Deploy button is available. For example, if you change the sequence number of an access rule of an ACL, the DCNM-LAN client stores this configuration change until you manually deploy it to the managed device that has the ACL.
 
    
 
    [bookmark: pgfId-1119500]To remind you of the necessity to deploy changes that the DCNM-LAN client is storing, the procedures in the DCNM-LAN documentation set include a deployment step.
 
    [bookmark: pgfId-1067089]Deploying server changes saves your changes on the DCNM-LAN server. For example, if you add a DCNM-LAN server user account, deploying your changes adds the user account to the DCNM-LAN server and does not affect managed devices.
 
    [bookmark: pgfId-1067183]Deploying configuration changes to a managed device causes the DCNM-LAN server to update the running configuration of the device.
 
     
      
    
 
    
 
    [bookmark: pgfId-1067202]Note DCNM-LAN does not update the startup configuration of a managed device. When you want to replace the startup configuration of a managed device with the running configuration, you can log into the command-line interface of the device and copy the running configuration to the startup configuration.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1067098]When you close the DCNM-LAN client and you have not deployed your changes, you can deploy them without canceling the process of closing the DCNM-LAN client. For more information, see the “Closing the DCNM-LAN Client” section.
 
   
 
    
     [bookmark: pgfId-1067038][bookmark: 34593]Working with Statistics and Charts
 
    [bookmark: pgfId-1172791]This section describes how to use the statistical charts available on a Statistics tab.
 
    [bookmark: pgfId-1172792]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1172796]Information about Statistics and Charts
 
     	 [bookmark: pgfId-1172800]Licensing Requirements for Statistics and Charts
 
     	 [bookmark: pgfId-1172804]Accessing a Chart
 
     	 [bookmark: pgfId-1172808]Starting Statistical Monitoring for a Chart
 
     	 [bookmark: pgfId-1172812]Stopping Statistical Monitoring for a Chart
 
     	 [bookmark: pgfId-1172816]Using a Chart
 
     	 [bookmark: pgfId-1172820]Using an Overview Chart
 
     	 [bookmark: pgfId-1172824]Exporting a Chart
 
    
 
     
      [bookmark: pgfId-1172826][bookmark: 57802]Information about Statistics and Charts
 
     [bookmark: pgfId-1061114]You can use a Statistics tab to start and stop statistical monitoring for an object and to work with charts of statistical data about the selected object. For each chart, the DCNM-LAN client also provides overview charts, which allow you to see historical trends and to control the time scale of the standard chart.
 
     [bookmark: pgfId-1181447]When you start monitoring for a new chart, DCNM-LAN creates a new statistical collection process that appears in the Statistical Data Collection feature. 
 
    
 
     
      [bookmark: pgfId-1181452][bookmark: 91493]Licensing Requirements for Statistics and Charts
 
     [bookmark: pgfId-1172833]The following table shows the licensing requirements for this feature:
 
     [bookmark: pgfId-1172850]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1172836]Product 
          
  
         	 
           
           [bookmark: pgfId-1172838]License Requirement 
          
  
        
 
         
         	[bookmark: pgfId-1172840]Cisco DCNM-LAN
  
         	[bookmark: pgfId-1172842]Real-time monitoring requires no license.
 [bookmark: pgfId-1172843]Cisco DCNM-LAN requires a LAN Enterprise license for the following features:
 
           
           	 [bookmark: pgfId-1172844]Maintaining a history of statistical data
 
           	 [bookmark: pgfId-1172845]Using overview charts
 
          
 [bookmark: pgfId-1172848]For information about obtaining and installing a Cisco DCNM-LAN LAN Enterprise license, see the Cisco DCNM Installation Guide, Release 7.1.x.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1055435][bookmark: 27556]Accessing a Chart
 
     [bookmark: pgfId-1062747]You can access any chart. The charts that are available for a particular Statistics tab depend upon the feature and object selected.
 
    
 
     
      [bookmark: pgfId-1062721]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1062659]Step 1 From the Feature Selector pane, choose the feature for which you want to use a statistical chart.
 
     [bookmark: pgfId-1062524]For example, choose Interfaces > Physical > Ethernet.
 
     [bookmark: pgfId-1062525]Step 2 From the Summary pane, select an object.
 
     [bookmark: pgfId-1062526]The Statistics tab appears in the Details pane.
 
      
       
     
 
     
 
     [bookmark: pgfId-1156079]Note If no Statistics tab appears, DCNM-LAN does not provide a statistical chart for the object that you selected.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1155942]Step 3 Click the Statistics tab.
 
     [bookmark: pgfId-1155917]In the Statistics tab, one or more charts may appear.
 
      
       
     
 
     
 
     [bookmark: pgfId-1156111]Note A dialog box may appear to confirm if you want to view charts for statistical collections that DCNM-LAN is running for the object that you selected in the Summary pane. For more information, see the “Configuring Monitoring Preferences” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1062598]Step 4 If the chart for the data that you want to monitor does not appear, from the toolbar, choose New Chart and then choose the chart that you want.
 
     [bookmark: pgfId-1062528]Step 5 Click the title bar of the chart that you want to work with.
 
     [bookmark: pgfId-1063395]The chart status appears in the lower left corner of the chart pane. If the chart is not active, you must start statistical monitoring for the chart before you can use it. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     [bookmark: pgfId-1062512]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189201]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189205]Starting Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189209]Stopping Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189213]Using a Chart
 
      	 [bookmark: pgfId-1189217]Using an Overview Chart
 
      	 [bookmark: pgfId-1189221]Exporting a Chart
 
     
 
    
 
     
      [bookmark: pgfId-1062502][bookmark: 21265]Starting Statistical Monitoring for a Chart[bookmark: marker-1055278]
 
     [bookmark: pgfId-1055280]You can start statistical monitoring for a chart in the Statistics tab for any of the device configuration features that support statistical monitoring.
 
      
       
     
 
     
 
     [bookmark: pgfId-1055281]Note Each time that you start monitoring for a new chart, DCNM-LAN creates a new statistical collection process that appears in the Statistical Data Collection feature.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1055282]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1055284]Step 1 Access the chart for which you want to start statistical monitoring. For more information, see the “Accessing a Chart” section.
 
     [bookmark: pgfId-1055293]Step 2 From the chart pane, click Select Parameters, check at least one statistical parameter that you want to appear in the chart, and click Select Parameters again.
 icon to start the collection process. 
     
 
     [bookmark: pgfId-1055298]Step 4 The chart starts graphing the selected parameters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1055307]Note When you close the DCNM-LAN client without stopping the statistical collection processes that you started, a dialog box prompts you to decide whether to stop the statistical collections or let them continue. We recommend that you stop any unnecessary statistical collection processes when you log out of the DCNM-LAN client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1055308]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189226]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189230]Accessing a Chart
 
      	 [bookmark: pgfId-1189234]Stopping Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189238]Using a Chart
 
      	 [bookmark: pgfId-1189242]Using an Overview Chart
 
      	 [bookmark: pgfId-1189246]Exporting a Chart
 
     
 
    
 
     
      [bookmark: pgfId-1060004][bookmark: 80346]Stopping Statistical Monitoring for a Chart[bookmark: marker-1060003]
 
     [bookmark: pgfId-1060727]You can stop statistical monitoring for a chart in the Statistics tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060728]Note When you stop monitoring for a chart, DCNM-LAN stops the corresponding statistical collection process that appears in the Statistical Data Collection feature.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1060687]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1063142]Step 1 Access the chart for which you want to stop statistical monitoring. For more information, see the “Accessing a Chart” section.
 
     [bookmark: pgfId-1060025]Step 2 From the Monitor toolbar choose the Arrow icon.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060029]Note If the chart that you want to stop does not appear, use the Statistical Data Collection feature to stop the collection process. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1060034]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189251]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189255]Accessing a Chart
 
      	 [bookmark: pgfId-1189259]Starting Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189263]Using a Chart
 
      	 [bookmark: pgfId-1189267]Using an Overview Chart
 
      	 [bookmark: pgfId-1189271]Exporting a Chart
 
     
 
    
 
     
      [bookmark: pgfId-1055366][bookmark: 42626]Using a Chart
 
     [bookmark: pgfId-1059411]The DCNM-LAN client provides the following options for using a chart:
 
      
      	 [bookmark: pgfId-1060863]Changing parameters
 
      	 [bookmark: pgfId-1060880]Setting the charting frequency
 
      	 [bookmark: pgfId-1060889]Controlling the magnification of the chart data
 
      	 [bookmark: pgfId-1060894]Showing, moving, and hiding threshold lines
 
      	 [bookmark: pgfId-1061527]Tearing the chart away from the DCNM-LAN client window
 
     
 
     [bookmark: pgfId-1060904]This procedure provides basic instructions for using each of these options.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060943]Note For information about using an overview chart, see the “Using an Overview Chart” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059439]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1063226]Step 1 Access the chart that you want to use. For more information, see the “Accessing a Chart” section.
 
     [bookmark: pgfId-1063503]Step 2 If the chart is not active, you must start statistical monitoring for the chart before you can use it. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     [bookmark: pgfId-1061457]Step 3 (Optional) To change parameters, click Select Parameters, check the statistics parameters that you want to collect, and click Select Parameters again.
 
     [bookmark: pgfId-1061531]Step 4 (Optional) To set the frequency with which DCNM-LAN retrieves statistical data for the selected object, from the Select Frequency drop-down list on the Monitor toolbar, choose the new frequency.
 
     [bookmark: pgfId-1061650]Step 5 (Optional) To control the magnification, or zoom, of the chart, do one of the following:
 
      
       
       	 [bookmark: pgfId-1061731]To zoom in on a portion of the chart, position the mouse pointer at one end of the portion, click and hold the left mouse button, drag the mouse pointer to the other end of the portion, and release the mouse button.
 
       	 [bookmark: pgfId-1066974]To zoom in on a portion of the chart, position the mouse pointer at one end of the portion and then click and drag the mouse pointer to the other end of the portion.
 
       	 [bookmark: pgfId-1066978]To change to the previous zoom, click the 
 
      
 
      [image: ] icon. 
     
 
      
       
       	 [bookmark: pgfId-1066979]To change to the next zoom, click the 
 
      
 
      [image: ] icon. 
     
 
      
       
       	 [bookmark: pgfId-1061732]To reset the zoom to the default magnification, click the 
 
      
 
      [image: ] icon. 
     
 
     [bookmark: pgfId-1067002]Step 6 (Optional) To show, move, or hide threshold lines, do one of the following:
 
      
       
       	 [bookmark: pgfId-1067003]To show or hide threshold lines, on the Monitor toolbar, click the 
 
      
 
      [image: ] icon. 
     
 
      
       
       	 [bookmark: pgfId-1067007]To move the lower threshold line, click and drag the 
 
      
 
      [image: ] icon. 
     
 
      
       
       	 [bookmark: pgfId-1061781]To move the lower threshold line, click and drag the 
 
      
 
      [image: ] icon. 
     
 
     [bookmark: pgfId-1061782]Step 7 (Optional) To tear the chart away from the DCNM-LAN client window, click on the red line that appears below the chart title.
 
     [bookmark: pgfId-1059427]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189276]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189280]Accessing a Chart
 
      	 [bookmark: pgfId-1189284]Starting Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189288]Stopping Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189292]Using an Overview Chart
 
      	 [bookmark: pgfId-1189296]Exporting a Chart
 
     
 
    
 
     
      [bookmark: pgfId-1055515][bookmark: 79408]Using an Overview Chart
 
     [bookmark: pgfId-1059432]You can use an overview chart to view the historical trend of the statistical data of the current chart and to set the time scale of the standard chart.
 
    
 
     
      [bookmark: pgfId-1172987]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1172988]Ensure that any device with data that you want to view on an overview chart is included on the list of DCNM-LAN-licensed devices. For more information, see the “Licensing Requirements for Statistics and Charts” section.
 
    
 
     
      [bookmark: pgfId-1059501]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1063286]Step 1 Access the chart that contains the overview chart that you want to use. For more information, see the “Accessing a Chart” section.
 
     [bookmark: pgfId-1063517]Step 2 If the chart is not active, you must start statistical monitoring for the chart before you can use its overview chart. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     [bookmark: pgfId-1061922]Step 3 Click Show Overview Chart.
 
     [bookmark: pgfId-1059503]In a new window, the overview chart displays the historical trends of the charted data.
 
     [bookmark: pgfId-1061935]Step 4 To set the time scale of the chart, at the bottom of the overview chart window, click the desired time scale button. The time scale buttons are as follows:
 
      
       
       	 [bookmark: pgfId-1061943]RT—Real time
 
       	 [bookmark: pgfId-1061979]1d—One day
 
       	 [bookmark: pgfId-1062029]2d—Two days
 
       	 [bookmark: pgfId-1062030]5d—Five days
 
       	 [bookmark: pgfId-1062031]15d—Fifteen days
 
       	 [bookmark: pgfId-1061991]1m—One month
 
       	 [bookmark: pgfId-1061992]3m—Three months
 
      
 
     
 
     [bookmark: pgfId-1062095]Step 5 To close the overview chart, click Show Overview Chart again.
 
     [bookmark: pgfId-1059398]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189301]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189305]Accessing a Chart
 
      	 [bookmark: pgfId-1189309]Starting Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189313]Stopping Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189317]Using a Chart
 
      	 [bookmark: pgfId-1189321]Exporting a Chart
 
     
 
    
 
     
      [bookmark: pgfId-1059468][bookmark: 49875]Exporting a Chart
 
     [bookmark: pgfId-1059469]You can export a chart as a JPG image or as a comma-separated value (CSV) file.
 
     [bookmark: pgfId-1066948]When you export a chart as a JPG image, the image is of the chart as it appears when you export the image.
 
     [bookmark: pgfId-1066958]When you export a chart as a CSV file, the file contains all data from the statistical collection for the chart.
 
    
 
     
      [bookmark: pgfId-1059482]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1063321]Step 1 Access the chart that you want to use. For more information, see the “Accessing a Chart” section.
 
     [bookmark: pgfId-1063535]Step 2 If the chart is not active, you must start statistical monitoring for the chart before you can export an image of it. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     [bookmark: pgfId-1062135]Step 3 If you want to export an image, configure the chart to show the data that you want to appear in the image. For more information, see the “Using a Chart” section.
 
     [bookmark: pgfId-1062140]Step 4 Right-click on the chart.
 
     [bookmark: pgfId-1062142]Step 5 Choose one of the following:
 
      
       
       	 [bookmark: pgfId-1062183]Export as CSV
 
       	 [bookmark: pgfId-1062197]Export as JPG
 
      
 
     
 
     [bookmark: pgfId-1062178]Step 6 Specify the location and filename, and then click Save.
 
     [bookmark: pgfId-1062143]The DCNM-LAN client exports the chart in the file format that you specified.
 
     [bookmark: pgfId-1059407]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189326]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189330]Accessing a Chart
 
      	 [bookmark: pgfId-1189334]Starting Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189338]Stopping Statistical Monitoring for a Chart
 
      	 [bookmark: pgfId-1189342]Using a Chart
 
      	 [bookmark: pgfId-1189346]Using an Overview Chart
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1096340][bookmark: 67866]Configuring Global [bookmark: marker-1096338]Preferences
 
    [bookmark: pgfId-1096341]Using the Global Preferences dialog box, you can configure several preferences for how the DCNM-LAN client displays data and fields. The sections on the Global Preferences are as follows:
 
     
     	 [bookmark: pgfId-1096342]Monitoring—Controls the default frequency of statistical data retrieval from managed devices and whether statistical charts open automatically. For more information, see the “Configuring Monitoring Preferences” section.
 
     	 [bookmark: pgfId-1096346]Events—Controls the maximum age of events that the DCNM-LAN client fetches from the DCNM-LAN server when you start the DCNM-LAN client. For more information, see the “Configuring the Maximum Age of Events Fetched from the Server” section.
 
     	 [bookmark: pgfId-1096354]Pre Provision—Controls whether the DCNM-LAN client displays some settings only when other settings are made or whether the DCNM-LAN client always displays all settings. For more information, see the “Configuring Preprovisioning” section.
 
    
 
     
      [bookmark: pgfId-1096360][bookmark: 33821]Configuring Monitoring Preferences[bookmark: marker-1096359]
 
     [bookmark: pgfId-1096361]You can configure the default frequency for statistical data retrieval from monitored devices. The default frequency for statistical data retrieval is 30 seconds. This frequency determines the initial data retrieval frequency for a new chart. Users can override the default frequency by configuring the chart-specific setting.
 
     [bookmark: pgfId-1155912]You can also configure whether the DCNM-LAN client automatically opens statistical charts when you access the Statistics tab of an object for which DCNM-LAN is already collecting statistical data.
 
    
 
     
      [bookmark: pgfId-1096362]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1096363]Determine how often you want DCNM-LAN to retrieve statistical data by default. Consider how important it is to your organization that charts update frequently. If very current charting data is important to your organization, consider using a short data retrieval frequency.
 
    
 
     
      [bookmark: pgfId-1096364]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1096366]Step 1 From the menu bar, choose Tools > Preferences.
 
     [bookmark: pgfId-1096367]The Global Preferences dialog box appears. Under Monitoring, the Default Monitoring Frequency drop-down list displays the current frequency for statistical data retrieval.
 
     [bookmark: pgfId-1096368]The default polling frequency is 30 seconds.
 
     [bookmark: pgfId-1096369]Step 2 If you want to configure the default frequency of statistical data retrieval, from the Default Monitoring Frequency drop-down list, choose the new data retrieval frequency.
 
     [bookmark: pgfId-1096370]Step 3 If you want to configure the default behavior when you access the Statistics tab of an object for which DCNM-LAN is already collecting statistical data, do one of the following:
 
      
       
       	 [bookmark: pgfId-1156285]If you want the client to show charts without asking for confirmation, check the  Load history charts by default check box.
 
       	 [bookmark: pgfId-1156294]If you want the client to prompt you for confirmation before it opens statistical charts, uncheck the  Load history charts by default check box.
 
      
 
     
 
     [bookmark: pgfId-1156280]Step 4 Click Ok.
 
     [bookmark: pgfId-1096371]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189351]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189355]Accessing a Chart
 
      	 [bookmark: pgfId-1189359]Configuring the Maximum Age of Events Fetched from the Server
 
      	 [bookmark: pgfId-1189363]Configuring Preprovisioning
 
     
 
    
 
     
      [bookmark: pgfId-1096391][bookmark: 76706]Configuring the Maximum Age of Events Fetched from the Server[bookmark: marker-1096390]
 
     [bookmark: pgfId-1096392]You can configure the maximum age of events that the DCNM-LAN client fetches from the DCNM-LAN server when you start the DCNM-LAN client. This setting affects how old the events are that the DCNM-LAN client displays in the Event Browser and on feature-specific Events tabs. By default, the DCNM-LAN client fetches events that occurred up to 1 hour prior to the DCNM-LAN client startup. You can configure the DCNM-LAN client to fetch events that are up to 24 hours old.
 
    
 
     
      [bookmark: pgfId-1096393]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1096395]Step 1 From the menu bar, choose Tools > Preferences.
 
     [bookmark: pgfId-1096396]The Global Preferences dialog box appears. Under Events, the Fetch events before drop-down list displays the current maximum age of events.
 
     [bookmark: pgfId-1096397]Step 2 From the Fetch events before drop-down list, choose the new maximum age of events.
 
      
       
     
 
     
 
     [bookmark: pgfId-1096398]Note To prevent the DCNM-LAN client from fetching any old events, choose zero (0) hours as the maximum age of events. When you choose zero hours, the DCNM-LAN client shows only the events that the DCNM-LAN server receives after you start the DCNM-LAN client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1096399]Step 3 Click Ok.
 
     [bookmark: pgfId-1096400]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189368]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189376]Configuring Monitoring Preferences
 
      	 [bookmark: pgfId-1189380]Configuring Preprovisioning
 
     
 
    
 
     
      [bookmark: pgfId-1096449][bookmark: 59306]Configuring Preprovisioning[bookmark: marker-1096448]
 
     [bookmark: pgfId-1096450]Preprovisioning refers to configuring a managed device with settings for modes or protocols that are not enabled. The preprovisioning preference affects the following sections of the DCNM-LAN client interface:
 
      
      	 [bookmark: pgfId-1096451]Interfaces > Physical > Ethernet > Device > Slot > Interface, Port Details tab, Port Mode Settings section
 
     
 
     [bookmark: pgfId-1096452]When you enable preprovisioning, the DCNM-LAN client displays all port mode fields regardless of the setting in the Mode drop-down list. When you disable preprovisioning, the DCNM-LAN client displays only the port mode settings that are relevant to the currently selected port mode. For example, if preprovisioning is disabled and you choose Trunk from the Mode drop-down list, the DCNM-LAN client displays only the Trunk settings and hides the Access, PVLAN Host, and PVLAN Promiscuous fields.
 
     [bookmark: pgfId-1101274]Additionally, the dialog boxes for configuring the Access VLAN field and the Native VLAN field include the Create in the Device check box. When you enable preprovisioning, you can uncheck this check box if you want DCNM-LAN to configure the device to refer to a VLAN that is not currently configured. When you disable preprovisioning, this check box is always checked and DCNM-LAN creates the VLAN specified, if it does not already exist.
 
      
      	 [bookmark: pgfId-1096453]Switching > Spanning Tree > Device, Configuration tab, Global Settings section
 
     
 
     [bookmark: pgfId-1096454]When you enable preprovisioning, the DCNM-LAN client displays MST settings regardless of the settings in the Protocol drop-down list. When you disable preprovisioning, the DCNM-LAN client displays the MST Setting fields unless you choose MST from the Protocol drop-down list.
 
    
 
     
      [bookmark: pgfId-1096455]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1096457]Step 1 From the menu bar, choose Tools > Preferences.
 
     [bookmark: pgfId-1096458]The Global Preferences dialog box appears. Under Pre Provision, the Pre Provision check box appears.
 
     [bookmark: pgfId-1096459]Step 2 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1096460]If you want to enable preprovisioning, ensure that the  Pre Provisio n check box is checked.
 
       	 [bookmark: pgfId-1096461]If you want to disable preprovisioning, ensure that the  Pre Provision check box is unchecked.
 
      
 
     
 
     [bookmark: pgfId-1096462]Step 3 Click Ok.
 
     [bookmark: pgfId-1096463]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1189385]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1189397]Configuring Monitoring Preferences
 
      	 [bookmark: pgfId-1189401]Configuring the Maximum Age of Events Fetched from the Server
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1173113][bookmark: 28776]Using Online Help
 
    [bookmark: pgfId-1173114]Online help has the following features:
 
     
     	 [bookmark: pgfId-1173115]Contents—The organization of DCNM-LAN online help is shown in the Contents tab of the online help window. When a topic has subtopics, the book icon appears to the left of the topic in the contents.
 
    
 
    [bookmark: pgfId-1173116]You can expand and collapse individual topics in the contents. You can also collapse or expand all topics.
 
     
     	 [bookmark: pgfId-1173117]Index—DCNM-LAN online help includes an index, which allows you to look up subjects alphabetically and open related topics directly from the index.
 
     	 [bookmark: pgfId-1173118]Favorites—DCNM-LAN online help allows you to add specific topics to the Favorites tab. Favorites are stored locally on the computer that you use to access online help.
 
    
 
    [bookmark: pgfId-1173119]To access the welcome page in online help, from the menu bar, choose Help > Help Contents.
 
    [bookmark: pgfId-1173120]DCNM-LAN online help includes context-sensitive help. 
 
    [bookmark: pgfId-1173121]To access context-sensitive help for a feature, follow these steps:
 
    
 
    [bookmark: pgfId-1173122]Step 1 Select a specific feature from the Feature Selector pane in the DCNM-LAN client. For example, choose Security > Access Control > IPv4 ACL.
 
    [bookmark: pgfId-1173123]Step 2 Do one of the following:
 
     
     	 [bookmark: pgfId-1173124]Press  F1 .
 
     	 [bookmark: pgfId-1173125]From the toolbar, click the question mark icon.
 
    
 
    [bookmark: pgfId-1173126]Online help for the selected feature appears in a browser window. DCNM-LAN uses the default browser application on the computer that runs the DCNM-LAN client.
 
    [bookmark: pgfId-1173174]
 
     
     
 
    
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1415805][bookmark: 86468]Administering [bookmark: marker-1415804]DCNM-LAN Authentication Settings 
      
      
 
     
 
 
    [bookmark: pgfId-1424394]This chapter describes how to administer Cisco Data Center Network Manager for LAN (DCNM-LAN) authentication settings.
 
    [bookmark: pgfId-1435126]Cisco DCNM authentication settings determine how a Cisco DCNM server authenticates users who attempt to access the server with the Cisco DCNM client. They also determine the user role for the user, which affects what the user can configure in the Cisco DCNM client.
 
    [bookmark: pgfId-1435127]As described in the following table, Cisco DCNM supports two user roles.
 
    [bookmark: pgfId-1435145]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1435130]Cisco DCNM Role 
         
  
        	 
          
          [bookmark: pgfId-1435132]Description 
         
  
       
 
        
        	[bookmark: pgfId-1435134]User
  
        	 
          
          	 [bookmark: pgfId-1435136]Cannot change Cisco DCNM authentication mode
 
          	 [bookmark: pgfId-1435137]Cannot add or delete Cisco DCNM local user accounts
 
          	 [bookmark: pgfId-1435138]Can change the details of its own local user account
 
          	 [bookmark: pgfId-1435139]Can use all other features
 
         
  
       
 
        
        	[bookmark: pgfId-1435141]Administrator
  
        	 
          
          	 [bookmark: pgfId-1435143]Has full control of Cisco DCNM authentication settings
 
          	 [bookmark: pgfId-1435144]Can use all other features
 
         
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1424399]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1424403]Information About Administering DCNM-LAN Authentication Settings
 
     	 [bookmark: pgfId-1424407]Licensing Requirements for Administering DCNM-LAN Authentication Settings
 
     	 [bookmark: pgfId-1424411]Prerequisites for Administering DCNM-LAN Authentication Settings
 
     	 [bookmark: pgfId-1424415]Guidelines and Limitations for Administering DCNM-LAN Authentication Settings
 
     	 [bookmark: pgfId-1424419]Configuring DCNM-LAN Authentication Settings
 
     	 [bookmark: pgfId-1424423]Viewing DCNM-LAN Local Users
 
     	 [bookmark: pgfId-1428786]Verifying Authentication Server Settings
 
     	 [bookmark: pgfId-1424427]Field Descriptions for DCNM-LAN Authentication Settings
 
     	 [bookmark: pgfId-1424431]Additional References
 
     	 [bookmark: pgfId-1424435]Feature History for DCNM-LAN Authentication Settings
 
    
 
   
 
    
     [bookmark: pgfId-1424437][bookmark: 67389]Information About Administering DCNM-LAN Authentication Settings
 
    [bookmark: pgfId-1424438]DCNM-LAN authentication settings determine how a DCNM-LAN server authenticates users who attempt to access the server with the DCNM-LAN client. They also determine the user role for the user, which affects what the user can configure in the DCNM-LAN client.
 
    [bookmark: pgfId-1424439]This section contains the following topics:
 
     
     	 [bookmark: pgfId-1424443]Users and User Roles
 
     	 [bookmark: pgfId-1424447]Local Authentication and DCNM-LAN Local Users
 
     	 [bookmark: pgfId-1424451]RADIUS and TACACS+ Authentication
 
     	 [bookmark: pgfId-1424455]User Role Assignment by RADIUS and TACACS+
 
     	 [bookmark: pgfId-1424459]Fallback to Local Authentication
 
     	 [bookmark: pgfId-1424463]Password Recovery
 
     	 [bookmark: pgfId-1424467]Users and Device Credentials
 
     	 [bookmark: pgfId-1424471]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1424473][bookmark: 39346]Users and User Roles
 
     [bookmark: pgfId-1424474]DCNM-LAN implements user-based access to allow you to control who can access a DCNM-LAN server by using the DCNM-LAN client. User access is secured by a password. DCNM-LAN supports strong passwords.
 
     [bookmark: pgfId-1424475]When you ensure that each person who accesses DCNM-LAN has a unique user account, user-based access allows you to determine what actions are taken by each user.
 
     [bookmark: pgfId-1424476]In addition, DCNM-LAN allows you to assign a role to each user. Roles determine what actions a user can take in the DCNM-LAN client. As described in Table 15-1, DCNM-LAN supports two user roles.[bookmark: marker-1424480]
 
     [bookmark: pgfId-1424503]
 
      
       
        
        [bookmark: pgfId-1424484]Table 15-1 [bookmark: 88426]DCNM-LAN User Roles
 
        
        
         
         	 
           
           [bookmark: pgfId-1424488]DCNM-LAN Role 
          
  
         	 
           
           [bookmark: pgfId-1424490]Description 
          
  
        
 
         
         	[bookmark: pgfId-1424492]User
  
         	 
           
           	 [bookmark: pgfId-1424494]Cannot change DCNM-LAN authentication mode
 
           	 [bookmark: pgfId-1424495]Cannot add or delete DCNM-LAN local user accounts
 
           	 [bookmark: pgfId-1424496]Can change the details of its own local user account
 
           	 [bookmark: pgfId-1424497]Can use all other features
 
          
  
        
 
         
         	[bookmark: pgfId-1424499]Administrator
  
         	 
           
           	 [bookmark: pgfId-1424501]Has full control of DCNM-LAN authentication settings
 
           	 [bookmark: pgfId-1424502]Can use all other features
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1424505][bookmark: 59365]Local Authentication and DCNM-LAN Local Users
 
     [bookmark: pgfId-1424506]The DCNM-LAN database contains any DCNM-LAN local users that you create.
 
      
       
     
 
     
 
     [bookmark: pgfId-1424507]Note DCNM-LAN server users are local to the DCNM-LAN server. Creating, changing, and removing DCNM-LAN server users has no effect on user accounts on managed devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1424508]A DCNM-LAN server uses local users to grant access in the following cases:
 
      
      	 [bookmark: pgfId-1424509]When the authentication mode is local
 
      	 [bookmark: pgfId-1424510]When no authentication server for the current authentication mode is reachable.
 
     
 
     [bookmark: pgfId-1424511]You can use local authentication as the primary authentication mode. If you specify RADIUS or TACACS+ as the primary authentication mode, the DCNM-LAN server always falls back to local authentication if no authentication server for the current authentication mode is reachable.
 
    
 
     
      [bookmark: pgfId-1431601]Attribute Setup for External AAA using ACS 5.x
 
     [bookmark: pgfId-1431755]The steps for ACS 5.x TACACS+ are to essentially configure the following under Police Elements / Authorization and Permissions / Device Administration / Shell Profiles / shell profile name
 
      
      	 [bookmark: pgfId-1431759]Attribute: cisco-av-pair
 
      	 [bookmark: pgfId-1431762]Requirement: optional
 
      	 [bookmark: pgfId-1431765]Value: shell:roles="network-admin"
 
     
 
    
 
     
      [bookmark: pgfId-1424513][bookmark: 16546]RADIUS and TACACS+ Authentication
 
     [bookmark: pgfId-1424514]You can configure DCNM-LAN to authenticate users with either the RADIUS or TACACS+ AAA protocol.
 
     [bookmark: pgfId-1424515]DCNM-LAN supports primary, secondary, and tertiary authentication servers for RADIUS and TACACS+. Only a primary server is required. For each authentication server, you can specify the port number that the server listens to for authentication requests.
 
     [bookmark: pgfId-1424516]During authentication, if the primary server for the current authentication mode does not respond to the authentication request, the DCNM-LAN server sends the authentication request to the secondary server. If the secondary server does not respond, DCNM-LAN sends the authentication request to the tertiary server.
 
     [bookmark: pgfId-1424517]If none of the servers configured for the current authentication mode responds to an authentication request, the DCNM-LAN server falls back to local authentication.
 
    
 
     
      [bookmark: pgfId-1424519][bookmark: 68949]User Role Assignment by RADIUS and TACACS+
 
     [bookmark: pgfId-1424520]DCNM-LAN supports the assignment of a user role by the RADIUS or TACACS+ server that grants a user access to the DCNM-LAN client. The user role assigned to a user is in effect for the current session in the DCNM-LAN client only.
 
     [bookmark: pgfId-1424521]To assign a DCNM-LAN user role by RADIUS, configure the RADIUS server to return the RADIUS vendor-specific attribute 26/9/1, which is the Cisco-AV-Pair attribute. To assign a DCNM-LAN user role by TACACS+, the TACACS+ server must return a cisco-av-pair attribute-value pair. If an authentication response does not assign the user role, DCNM-LAN assigns the User role. Table 15-2 shows the supported attribute-value pair values for each DCNM-LAN user role.
 
     [bookmark: pgfId-1424554]
 
      
       
        
        [bookmark: pgfId-1424531]Table 15-2 [bookmark: 37552]DCNM-LAN User Role Assignment Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-1424537]DCNM-LAN Role 
          
  
         	 
           
           [bookmark: pgfId-1424539]RADIUS Cisco-AV-Pair Value 
          
  
         	 
           
           [bookmark: pgfId-1424541]TACACS+ Shell cisco-av-pair Value 
          
  
        
 
         
         	[bookmark: pgfId-1424543]User
  
         	 
           
           [bookmark: pgfId-1424545]shell:roles = "network-operator" 
          
  
         	 
           
           [bookmark: pgfId-1424547]cisco-av-pair:shell:roles="network-operator" 
          
  
        
 
         
         	[bookmark: pgfId-1424549]Administrator
  
         	 
           
           [bookmark: pgfId-1424551]shell:roles = "network-admin" 
          
  
         	 
           
           [bookmark: pgfId-1424553]cisco-av-pair:shell:roles="network-admin" 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1424556][bookmark: 70149]Fallback to Local Authentication
 
     [bookmark: pgfId-1424557]Local authentication always is the fallback method for RADIUS and TACACS+ authentication modes. If none of the servers configured for the current authentication mode is available, the DCNM-LAN server uses the local database to authenticate login requests. This behavior is designed to help you prevent accidental lockout from DCNM-LAN.
 
     [bookmark: pgfId-1424558]For users who need fallback support, the usernames of their local user accounts must be identical to their usernames on the authentication servers. Also, we recommend that their passwords in the local user accounts should be identical to their passwords on the authentication servers in order to provide transparent fallback support. Because the user cannot determine whether an authentication server or the local database is providing the authentication service, using usernames and passwords on authentication servers that are different than the usernames and passwords in the local database means that the user cannot be certain which username and password should be given.
 
    
 
     
      [bookmark: pgfId-1424560][bookmark: 45170]Password Recovery
 
     [bookmark: pgfId-1460558]If no one can log into the DCNM-LAN client as a user with a DCNM-LAN Administrator role, you can reset passwords by using one of the following scripts:
 
      
      	 [bookmark: pgfId-1460559]For Microsoft Windows, use /user/local/cisco/dcm/fm/bin/adduser.bat.
 
      	 [bookmark: pgfId-1426165]For Linux, use /user/local/cisco/dcm/fm/bin/adduser.sh.
 
     
 
     [bookmark: pgfId-1426166]To reset a password, run the script for the operating system that you are using, and then enter the user ID to be reset and the password to be used for it.
 
     [bookmark: pgfId-1424561]Alternatively, you can reinstall the DCNM-LAN server, which allows you to specify the username and password for a local user account that is assigned the Administrator role. For more information, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
 
    
 
     
      [bookmark: pgfId-1424566][bookmark: 69608]Users and Device Credentials
 
     [bookmark: pgfId-1424567]Each DCNM-LAN server user has unique device credentials, regardless of whether the user authenticates with a local user account or an account on a RADIUS or TACACS+ server. This feature allows you to maintain accounting logs on managed devices that reflect the actions of each DCNM-LAN server user. For more information, see the “Information About Devices and Credentials” section.
 
    
 
     
      [bookmark: pgfId-1424572][bookmark: 26517]Virtualization Support
 
     [bookmark: pgfId-1424573]Cisco NX-OS support for virtual device contexts has no effect on DCNM-LAN server users.
 
     [bookmark: pgfId-1424574]DCNM-LAN server users can configure any managed device.
 
    
 
   
 
    
     [bookmark: pgfId-1424576][bookmark: 62107]Licensing Requirements for Administering DCNM-LAN Authentication Settings
 
    [bookmark: pgfId-1424577]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1424590]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1424580]Product 
         
  
        	 
          
          [bookmark: pgfId-1424582]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1424584]Cisco DCNM-LAN
  
        	[bookmark: pgfId-1424586]Administering Cisco DCNM-LAN authentication settings requires no license. Any feature not included in a license package is bundled with the Cisco DCNM-LAN and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM-LAN LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1425057][bookmark: 54324]Prerequisites for Administering DCNM-LAN Authentication Settings
 
    [bookmark: pgfId-1425058]Administering DCNM-LAN authentication settings has the following prerequisites:
 
     
     	 [bookmark: pgfId-1425137]You must ensure that every authentication server that you want to use with DCNM-LAN is configured to accept authentication requests from the DCNM-LAN server.
 
     	 [bookmark: pgfId-1425064]To add, delete, or modify DCNM-LAN local users, you must be logged into the DCNM-LAN client with a user account that is assigned the Administrator DCNM-LAN role.
 
    
 
   
 
    
     [bookmark: pgfId-1424596][bookmark: 15741]Guidelines and Limitations for Administering DCNM-LAN Authentication Settings
 
    [bookmark: pgfId-1424597]Administering DCNM-LAN authentication settings has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1424598]Create a DCNM-LAN user account for each person who uses the DCNM-LAN client. Do not allow people to share a user account.
 
     	 [bookmark: pgfId-1424599]Delete unused DCNM-LAN user accounts.
 
     	 [bookmark: pgfId-1424600]Grant an administrator user account only to those who need to perform administrator tasks in the DCNM-LAN client.
 
     	 [bookmark: pgfId-1424601]We recommend that you use strong passwords. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
    
 
   
 
    
     [bookmark: pgfId-1424603][bookmark: 74505]Configuring DCNM-LAN Authentication Settings
 
    [bookmark: pgfId-1424604]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1424608]Configuring the Authentication Mode
 
     	 [bookmark: pgfId-1424612]Adding a DCNM-LAN Local User
 
     	 [bookmark: pgfId-1424616]Changing the Password of a DCNM-LAN Local User
 
     	 [bookmark: pgfId-1424620]Changing the Full Name, Role, or Description of a DCNM-LAN Local User
 
     	 [bookmark: pgfId-1424624]Deleting a DCNM-LAN Server User
 
     	 [bookmark: pgfId-1424628]Adding Authentication Servers
 
     	 [bookmark: pgfId-1424632]Changing Authentication Server Settings
 
     	 [bookmark: pgfId-1424636]Removing an Authentication Server
 
    
 
     
      [bookmark: pgfId-1054250][bookmark: 14302]Configuring the Authentication Mode
 
     [bookmark: pgfId-1435150]Does this apply to API sessions, too? Or just the DCNM client?
 
     [bookmark: pgfId-1382735]You can configure the mode that the DCNM-LAN server uses to authenticate DCNM-LAN client users.
 
    
 
     
      [bookmark: pgfId-1382772]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1382993]Log into the DCNM-LAN client with a user account that has the Administrator user role.
 
     [bookmark: pgfId-1382796]If you want to enable RADIUS or TACACS+ authentication mode, you must configure at least one authentication server for the desired authentication mode.
 
    
 
     
      [bookmark: pgfId-1427420]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1427421]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1382930]Step 2 If necessary, expand the Authentication Mode section.
 
     [bookmark: pgfId-1382897]Step 3 Choose the authentication mode.
 
     [bookmark: pgfId-1382963]Step 4 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1399523]Step 5 Restart the DCNM-LAN server. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.Chapter25, “Starting and Stopping Cisco DCNM-LAN Servers”
 
     [bookmark: pgfId-1399528]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1435163]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435167]Adding a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435171]Adding Authentication Servers
 
     
 
    
 
     
      [bookmark: pgfId-1382703][bookmark: 18497]Adding a DCNM-LAN Local User[bookmark: marker-1173972]
 
     [bookmark: pgfId-1054252]You can add a DCNM-LAN local user account.
 
      
       
     
 
     
 
     [bookmark: pgfId-1075484]Note Adding a DCNM-LAN local user account does not affect the user account configuration on any Cisco NX-OS device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1054253]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1054254]Log into the DCNM-LAN client with a user account that has the Administrator user role.
 
     [bookmark: pgfId-1221085]Determine the username and password for the new DCNM-LAN local user account.
 
      
       
     
 
     
 
     [bookmark: pgfId-1144188]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1076722]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1076267]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1076268]Step 2 If necessary, expand the DCNM Local Users section.
 
     [bookmark: pgfId-1381278]A table of users appears in the Cisco DCNM Local Users section.
 
     [bookmark: pgfId-1076269]Step 3 From the menu bar, choose Actions > Add User.
 
     [bookmark: pgfId-1076270]A new row appears at the bottom of the list of users. By default, all fields in the new row are blank.
 
     [bookmark: pgfId-1076691]Step 4 In the DCNM User Name column of the new row, enter the username. The username can be 1 to 198 characters. Entries can contain case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1422461]Step 5 (Optional) In the Full Name column, double-click the entry and add a name. For example, enter the real name of the person who will use the DCNM-LAN local user account. The maximum length is 255 case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1154691]Step 6 In the DCNM Role column, double-click the entry and choose the role. By default, the role is User.
 
     [bookmark: pgfId-1154353]Step 7 In the Password column, double-click the entry and then click the down-arrow button.
 
     [bookmark: pgfId-1154370]Step 8 In the New Password field and the Confirm Password field, enter the password. The password can be 1 to 255 characters. Entries can contain case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076551]Step 9 Click OK.
 
     [bookmark: pgfId-1076593]Step 10 (Optional) In the Description column, double-click the entry and add a description of the user account. For example, you could use this entry to provide e-mail and telephone contact details of the person who will be using this DCNM-LAN server user account. The maximum length is 255 case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076274]Step 11 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1076275]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1435176]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435180]Changing the Password of a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435184]Changing the Full Name, Role, or Description of a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435188]Deleting a DCNM-LAN Server User
 
     
 
    
 
     
      [bookmark: pgfId-1059019][bookmark: 99017]Changing the Password of a DCNM-LAN Local User[bookmark: marker-1173973]
 
     [bookmark: pgfId-1221327]You can change the password of a DCNM-LAN local user.
 
    
 
     
      [bookmark: pgfId-1221329]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1221094]An Administrator role is required if you want to change the password of a local user account other than the account that you use to log into the DCNM-LAN client. If your user account is a local user account and it has the User role, you can change the password of your account only.
 
     [bookmark: pgfId-1059022]Determine what the new password should be.
 
      
       
     
 
     
 
     [bookmark: pgfId-1144205]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059023]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1076846]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Server Authentication Settings. 
 
     [bookmark: pgfId-1381314]Step 2 If necessary, expand the DCNM Local Users section.
 
     [bookmark: pgfId-1381315]A table of users appears in the DCNM Local Users section.
 
     [bookmark: pgfId-1076922]Step 3 In the User Name column, click the username for the user account that you want to change.
 
     [bookmark: pgfId-1076923]The row of the username that you clicked is highlighted.
 
     [bookmark: pgfId-1076852]Step 4 In the Password column, double-click the entry and then click the down-arrow button.
 
     [bookmark: pgfId-1154424]Step 5 In the New Password field and the Confirm Password field, enter the new password. The password can be 1 to 255 characters. Entries can contain case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076855]Step 6 Click OK.
 
     [bookmark: pgfId-1076857]Step 7 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1076858]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1435193]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435197]Adding a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435201]Changing the Full Name, Role, or Description of a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435205]Deleting a DCNM-LAN Server User
 
     
 
    
 
     
      [bookmark: pgfId-1076937][bookmark: 18511]Changing the Full Name, Role, or Description of a DCNM-LAN Local User
 
     [bookmark: pgfId-1076938]You can change the full name, role, or description of a DCNM-LAN local user.
 
      
       
     
 
     
 
     [bookmark: pgfId-1076939]Note You cannot change the username. Instead, add a local user account with the desired username and remove the local user account with the unwanted username.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1076940]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1076941]Determine what the new full name or description should be.
 
     [bookmark: pgfId-1221386]An Administrator role is required if you want to change the full name, role, or description of a local user account other than the local user account that you use to log into the DCNM-LAN client. If your user account is a local user account and it has the User role, you can change the full name and description for your account only.
 
    
 
     
      [bookmark: pgfId-1076942]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1076945]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1381372]Step 2 If necessary, expand the DCNM Local Users section.
 
     [bookmark: pgfId-1381373]A table of users appears in the Cisco DCNM Local Users section.
 
     [bookmark: pgfId-1077385]Step 3 In the User Name column, click the username of the local user account that you want to change.
 
     [bookmark: pgfId-1077386]The row of the username that you clicked is highlighted.
 
     [bookmark: pgfId-1076949]Step 4 (Optional) In the Full Name column, double-click the entry and enter the new name. The maximum length is 255 case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076954]Step 5 (Optional) In the DCNM Role column, double-click the entry and choose the new role. You can choose Administrator or User.
 
     [bookmark: pgfId-1154669]Step 6 (Optional) In the Description column, double-click the entry and enter the new description of the user account. The maximum length is 255 case-sensitive letters, numbers, and symbols.
 
     [bookmark: pgfId-1076955]Step 7 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1076956]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1435215]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435219]Adding a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435223]Changing the Password of a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435227]Deleting a DCNM-LAN Server User
 
     
 
    
 
     
      [bookmark: pgfId-1059095][bookmark: 21840]Deleting a DCNM-LAN Server User[bookmark: marker-1173974]
 
     [bookmark: pgfId-1059096]You can remove a DCNM-LAN local user account.
 
    
 
     
      [bookmark: pgfId-1059097]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1381507]Log into the DCNM-LAN client with a user account that has the Administrator user role.
 
     [bookmark: pgfId-1381469]Ensure that you are removing the correct DCNM-LAN local user account.
 
    
 
     
      [bookmark: pgfId-1381471]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1381529]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1381544]Step 2 If necessary, expand the DCNM Local Users section.
 
     [bookmark: pgfId-1381545]A table of users appears in the DCNM Local Users section.
 
     [bookmark: pgfId-1381531]Step 3 In the User Name column, click the username of the user account that you want to remove.
 
     [bookmark: pgfId-1381532]The row of the username that you clicked is highlighted.
 
     [bookmark: pgfId-1077523]Step 4 From the menu bar, choose Actions > Delete User.
 
     [bookmark: pgfId-1077347]Step 5 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1077324]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1435232]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435236]Adding a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435240]Changing the Password of a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435244]Changing the Full Name, Role, or Description of a DCNM-LAN Local User
 
     
 
    
 
     
      [bookmark: pgfId-1378958][bookmark: 32778]Adding Authentication Servers
 
     [bookmark: pgfId-1383016]You can add RADIUS and TACACS+ servers to the DCNM-LAN authentication settings.
 
    
 
     
      [bookmark: pgfId-1383027]BEFORE YOU BEGIN
 
      
       
     
 
     
 
     [bookmark: pgfId-1383031]Note You must ensure that every authentication server that you want to use with DCNM-LAN is configured to accept authentication requests from the DCNM-LAN server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1425092]Ensure that you have the following information about each authentication server that you want to add:
 
      
      	 [bookmark: pgfId-1383050]AAA protocol: RADIUS or TACACS+
 
      	 [bookmark: pgfId-1383056]Server IPv4 address or DNS name that can be resolved by the DCNM-LAN server.
 
      	 [bookmark: pgfId-1383057]Secret key.
 
      	 [bookmark: pgfId-1383058]Port number on which the server accepts authentication requests.
 
      	 [bookmark: pgfId-1383067](RADIUS only) Port number on which the server accepts accounting messages.
 
      	 [bookmark: pgfId-1383073]Authentication protocol: PAP, CHAP, MSCHAP, or ASCII.
 
      	 [bookmark: pgfId-1383582](Optional) Username and password of a valid user account on the server for server verification.
 
     
 
     [bookmark: pgfId-1422330]Determine whether the server should be a primary, secondary, or tertiary server, which depends upon your authentication server failover strategy.
 
    
 
     
      [bookmark: pgfId-1422331]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1383083]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1383084]Step 2 If necessary, expand the Authentication Servers section.
 
     [bookmark: pgfId-1393155]The Authentication Server Settings table shows RADIUS and TACACS+ server settings.
 
     [bookmark: pgfId-1393156]Step 3 If necessary, expand the RADIUS or TACACS+ server rows.
 
     [bookmark: pgfId-1393157]Step 4 For each authentication server that you want to add, follow these steps:
 
     [bookmark: pgfId-1383205] a. Choose the row in which you want to add the server.
 
      
       
     
 
     
 
     [bookmark: pgfId-1383439]Note The DCNM-LAN client does not allow you to add a secondary server if you have not added a primary server. In addition, you cannot add a tertiary server if you have not added a secondary server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1383448] b. Double-click the Server Name field and enter the server IPv4 address or DNS hostname.
 
      
       
     
 
     
 
     [bookmark: pgfId-1383482]Note If you enter a hostname that the DCNM-LAN server cannot resolve, the Server Name field is highlighted in red.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1383487] c. Double-click the Secret Key field and enter the secret key (sometimes called a shared secret) of the authentication server.
 
     [bookmark: pgfId-1383505] d. (Optional) If you need to change the default Authentication Port or Accounting Port (RADIUS only), double-click the applicable port field and enter the new port number.
 
     [bookmark: pgfId-1403411] e. Double-click the Authentication Method field and choose the authentication protocol that DCNM-LAN must use when sending authentication requests to the authentication server.
 
     [bookmark: pgfId-1403412]Step 5 (Optional) If you want to verify that the DCNM-LAN server can authenticate a user with a new authentication server, follow these steps:
 
     [bookmark: pgfId-1383540] a. To the right of the row for the authentication server that you want to verify, click Verify.
 
     [bookmark: pgfId-1383567]A Verification dialog box appears.
 
     [bookmark: pgfId-1383572] b. Enter a username and password for a valid user account on the authentication server.
 
     [bookmark: pgfId-1383592] c. Click Verify.
 
     [bookmark: pgfId-1393187]The DCNM-LAN client displays a message indicating whether the verification attempt succeeded or failed. A verification failure may mean that the authentication server is unavailable or that the authentication settings are incorrect.
 
     [bookmark: pgfId-1383537]Step 6 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1383046]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1435249]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435253]Configuring the Authentication Mode
 
      	 [bookmark: pgfId-1435257]Changing Authentication Server Settings
 
      	 [bookmark: pgfId-1435261]Removing an Authentication Server
 
      	 [bookmark: pgfId-1435265]Verifying Authentication Server Settings
 
     
 
    
 
     
      [bookmark: pgfId-1383604][bookmark: 53507]Changing Authentication Server Settings
 
     [bookmark: pgfId-1383614]You can change the settings for authentication servers that you have already configured in the DCNM-LAN client. If you have more than one RADIUS or TACACS+ server, you can change which server is primary, secondary, or tertiary.
 
    
 
     
      [bookmark: pgfId-1383619]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1383660]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1383661]Step 2 If necessary, expand the Authentication Servers section.
 
     [bookmark: pgfId-1383662]The Authentication Server Settings table shows RADIUS and TACACS+ server settings.
 
     [bookmark: pgfId-1403395]Step 3 If necessary, expand the RADIUS or TACACS+ server rows.
 
     [bookmark: pgfId-1403396]Step 4 (Optional) If you want to change the settings of an authentication server, double-click each field that you need to change and enter the changes.
 
     [bookmark: pgfId-1383737]Step 5 (Optional) If you want to reorder RADIUS or TACACS+ servers, right-click a server and choose Move Up or Move Down, as needed.
 
     [bookmark: pgfId-1383672]Step 6 (Optional) If you want to verify that the DCNM-LAN server can authenticate a user with an authentication server, follow these steps:
 
     [bookmark: pgfId-1383673] a. To the right of the row for the authentication server that you want to verify, click Verify.
 
     [bookmark: pgfId-1383674]A Verification dialog box appears.
 
     [bookmark: pgfId-1383675] b. Enter a username and password for a valid user account on the authentication server.
 
     [bookmark: pgfId-1383676] c. Click Verify.
 
     [bookmark: pgfId-1393407]The DCNM-LAN client displays a message indicating whether the verification attempt succeeded or failed. A verification failure may mean that the authentication server is unavailable or that the authentication settings are incorrect.
 
     [bookmark: pgfId-1383678]Step 7 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1383637]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1435270]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435274]Configuring the Authentication Mode
 
      	 [bookmark: pgfId-1435278]Adding Authentication Servers
 
      	 [bookmark: pgfId-1435282]Removing an Authentication Server
 
      	 [bookmark: pgfId-1435286]Verifying Authentication Server Settings
 
     
 
    
 
     
      [bookmark: pgfId-1383805][bookmark: 22993]Removing an Authentication Server
 
     [bookmark: pgfId-1383806]You can remove a RADIUS or TACACS+ authentication server from the DCNM-LAN authentication settings.
 
    
 
     
      [bookmark: pgfId-1383927]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1383897]You cannot remove all authentication servers for the current authentication mode. Instead, change the authentication mode first and then remove all the authentication servers.
 
    
 
     
      [bookmark: pgfId-1383807]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1383809]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings. 
 
     [bookmark: pgfId-1383810]Step 2 If necessary, expand the Authentication Servers section.
 
     [bookmark: pgfId-1383811]The Authentication Server Settings table shows RADIUS and TACACS+ server settings.
 
     [bookmark: pgfId-1383812]Step 3 If necessary, expand the RADIUS or TACACS+ server rows.
 
     [bookmark: pgfId-1383814]Step 4 Right-click the authentication server that you want to remove and choose Remove Server.
 
     [bookmark: pgfId-1383821]Step 5 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1383822]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1435291]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435295]Configuring the Authentication Mode
 
      	 [bookmark: pgfId-1435299]Adding Authentication Servers
 
      	 [bookmark: pgfId-1435303]Changing Authentication Server Settings
 
      	 [bookmark: pgfId-1435307]Verifying Authentication Server Settings
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1383127][bookmark: 70905]Viewing DCNM-LAN Local Users
 
    [bookmark: pgfId-1383128]To view DCNM-LAN server user accounts, from the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings and then, if necessary, expand the Cisco DCNM Local Users section.
 
    [bookmark: pgfId-1383129]DCNM-LAN server user accounts, including usernames and descriptions, appear in the Contents pane. Passwords appear masked for security. For information about the fields that appear, see the “Field Descriptions for DCNM-LAN Authentication Settings” section.
 
     
      [bookmark: pgfId-1435312]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435316]Adding a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435320]Changing the Password of a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435324]Changing the Full Name, Role, or Description of a DCNM-LAN Local User
 
      	 [bookmark: pgfId-1435328]Deleting a DCNM-LAN Server User
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1384845][bookmark: 42441]Verifying Authentication Server Settings
 
    [bookmark: pgfId-1384041]You can verify that the DCNM-LAN server can authenticate a user with a particular authentication server that you have configured.
 
     
      [bookmark: pgfId-1384042]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1384044]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Authentication Settings.
 
     [bookmark: pgfId-1384045]Step 2 If necessary, expand the Authentication Servers section.
 
     [bookmark: pgfId-1384046]The Authentication Server Settings table shows RADIUS and TACACS+ server settings.
 
     [bookmark: pgfId-1384051]Step 3 Click Verify.
 
     [bookmark: pgfId-1384052]A Verification dialog box appears.
 
     [bookmark: pgfId-1384053]Step 4 Enter a username and password for a valid user account on the authentication server.
 
     [bookmark: pgfId-1384054]Step 5 To the right of the row for the authentication server that you want to verify, click Verify.
 
     [bookmark: pgfId-1393419]The DCNM-LAN client displays a message indicating whether the verification attempt succeeded or failed. A verification failure may mean that the authentication server is unavailable or that the authentication settings are incorrect.
 
     [bookmark: pgfId-1384057]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1435333]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1435337]Adding Authentication Servers
 
      	 [bookmark: pgfId-1435341]Removing an Authentication Server
 
      	 [bookmark: pgfId-1435345]Verifying Authentication Server Settings
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1424668][bookmark: 35236]Field Descriptions for DCNM-LAN Authentication Settings
 
    [bookmark: pgfId-1424669]This section includes the following field descriptions for the DCNM-LAN Authentication Settings feature:
 
     
     	 [bookmark: pgfId-1424673]Authentication Mode Section
 
     	 [bookmark: pgfId-1424677]DCNM-LAN Local Users Section
 
     	 [bookmark: pgfId-1424681]Authentication Servers Section
 
    
 
     
      [bookmark: pgfId-1424683][bookmark: 80668]Authentication Mode Section
 
     [bookmark: pgfId-1424708]
 
      
       
        
        [bookmark: pgfId-1424689]Table 15-3 Authentication Mode Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1424693]Field 
          
  
         	 
           
           [bookmark: pgfId-1424695]Description 
          
  
        
 
         
         	[bookmark: pgfId-1424697]Local
  
         	[bookmark: pgfId-1424699]Whether DCNM-LAN authenticates users with the local user database only.
  
        
 
         
         	[bookmark: pgfId-1424701]RADIUS
  
         	[bookmark: pgfId-1424703]Whether DCNM-LAN authenticates users with a RADIUS server. When no configured RADIUS server is reachable, DCNM-LAN falls back to using the local database for user authentication.
  
        
 
         
         	[bookmark: pgfId-1424705]TACACS+
  
         	[bookmark: pgfId-1424707]Whether DCNM-LAN authenticates users with a TACACS+ server. When no configured TACACS+ server is reachable, DCNM-LAN falls back to using the local database for user authentication.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1424710][bookmark: 48947]DCNM-LAN Local Users Section
 
     [bookmark: pgfId-1424746]
 
      
       
        
        [bookmark: pgfId-1424716]Table 15-4 DCNM-LAN Local Users Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1424720]Field 
          
  
         	 
           
           [bookmark: pgfId-1424722]Description 
          
  
        
 
         
         	[bookmark: pgfId-1424724]DCNM-LAN User Name
  
         	[bookmark: pgfId-1424726]Display only. Name of the DCNM-LAN server user account. This name can be used to log into the DCNM-LAN client when the authentication mode is local or when no authentication server for the current authentication mode is reachable. Entries are case sensitive. Valid characters are all letters, numbers, and symbols. The minimum length is 1 character. The maximum length is 198 characters.
  
        
 
         
         	[bookmark: pgfId-1424728]Full Name
  
         	[bookmark: pgfId-1424730]Other name for the user account, such as the name of the person who uses the DCNM-LAN server user account. This name cannot be used to log into the DCNM-LAN client. Valid characters are all letters, numbers, and symbols. The maximum length is 255 characters. This field is blank by default.
  
        
 
         
         	[bookmark: pgfId-1424732]DCNM-LAN Role
  
         	[bookmark: pgfId-1424734]Role of the user account. Valid values are User and Administrator. For more information, see Table 15-1. By default, a DCNM-LAN server user account is assigned the role of User.
  
        
 
         
         	[bookmark: pgfId-1424739]Password
  
         	[bookmark: pgfId-1424741]Password for the DCNM-LAN server user. This field is always masked for security. Entries are case sensitive. Valid characters are all letters, numbers, and symbols. The minimum length is 1 character. The maximum length is 255 characters.
  
        
 
         
         	[bookmark: pgfId-1424743]Description
  
         	[bookmark: pgfId-1424745]Description of the DCNM-LAN server user. Valid characters are all letters, numbers, and symbols. The maximum length is 255 characters. This field is blank by default.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1424748][bookmark: 11878]Authentication Servers Section
 
     [bookmark: pgfId-1424787]
 
      
       
        
        [bookmark: pgfId-1424754]Table 15-5 Authentication Servers Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1424758]Field 
          
  
         	 
           
           [bookmark: pgfId-1424760]Description 
          
  
        
 
         
         	[bookmark: pgfId-1424762]Server Name
  
         	[bookmark: pgfId-1424764]DNS name or IPv4 address of the authentication server. 
 
           
           	 [bookmark: pgfId-1424765]DNS name—If you specify a DNS name, the DCNM-LAN server must be able to resolve the IP address of the server. Valid DNS names characters are alphanumeric.
 
           	 [bookmark: pgfId-1424766]IPv4 address—If you specify an IP address, valid entries are in dotted decimal format.
 
          
  
        
 
         
         	[bookmark: pgfId-1424768]Secret Key
  
         	[bookmark: pgfId-1424770]Shared secret of the authentication server. Valid entries are case-sensitive letters, numbers, and symbols.
  
        
 
         
         	[bookmark: pgfId-1424772]Authentication Port
  
         	[bookmark: pgfId-1424774]TCP or UDP port number that the authentication server listens to for authentication requests. By default, the authentication port for a RADIUS server is UDP port 1812 and the authentication port for a TACACS+ server is TCP port 49.
  
        
 
         
         	[bookmark: pgfId-1424776]Accounting Port
  
         	[bookmark: pgfId-1424778]UDP port number that the RADIUS authentication server listens to for authentication requests. By default, the accounting port for a RADIUS server is UDP port 1813.
  
        
 
         
         	[bookmark: pgfId-1424780]Authentication Method
  
         	[bookmark: pgfId-1424782]Authentication protocol that the DCNM-LAN server uses in authentication requests to the authentication server. Supported authentication methods are as follows:
 
           
           	 [bookmark: pgfId-1424783]PAP
 
           	 [bookmark: pgfId-1424784]CHAP
 
           	 [bookmark: pgfId-1424785]MSCHAP
 
           	 [bookmark: pgfId-1424786]ASCII
 
          
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1424789][bookmark: 67961]Additional References
 
    [bookmark: pgfId-1424790]For additional information related to administering DCNM-LAN authentication settings, see the following sections:
 
     
     	 [bookmark: pgfId-1424794]Related Documents
 
     	 [bookmark: pgfId-1424798]Standards
 
    
 
     
      [bookmark: pgfId-1424800][bookmark: 23175]Related Documents
 
     [bookmark: pgfId-1424813]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1424803]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1424805]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1424807]Logging into the DCNM-LAN client
  
         	[bookmark: pgfId-1424812]Opening the DCNM-LAN Client
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1424815][bookmark: 97189]Standards
 
     [bookmark: pgfId-1424825]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1424818]Standards 
          
  
         	 
           
           [bookmark: pgfId-1424820]Title 
          
  
        
 
         
         	[bookmark: pgfId-1424822]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1424824]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1424827][bookmark: 92503]Feature History for DCNM-LAN Authentication Settings
 
    [bookmark: pgfId-1424831]Table 15-6 lists the release history for this feature.
 
    [bookmark: pgfId-1424852]
 
     
      
       
       [bookmark: pgfId-1424835]Table 15-6 [bookmark: 50557]Feature History for DCNM-LAN Server Users
 
       
       
        
        	 
          
          [bookmark: pgfId-1424841]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1424843]Releases 
         
  
        	 
          
          [bookmark: pgfId-1424845]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1424847]DCNM-LAN Authentication Settings
  
        	[bookmark: pgfId-1424849]5.0(2)
  
        	[bookmark: pgfId-1424851]No change from Release 4.2.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1240539][bookmark: 85688]Working with [bookmark: marker-1240537]Topology 
      
      
 
     
 
 
    [bookmark: pgfId-1398873]This chapter describes how to use the Topology feature in Cisco Data Center Network Manager for LAN (DCNM-LAN).
 
    [bookmark: pgfId-1415027]The Topology feature provides you with a topology map of supported Cisco NX-OS devices. The topology map also shows switches that run Cisco IOS software, such as the Catalyst 6500 series switches, that are linked by the Cisco Discovery Protocol (CDP). For Catalyst 6500 series switches, the physical topology view of the map displays these switches and their links to other devices. For Nexus 7000 Series devices, the map shows details about virtual device contexts (VDCs).
 
    [bookmark: pgfId-1415028]When Cisco Data Center Network Manager (DCNM) receives new information, the Cisco DCNM client updates the map dynamically. By default, updates occur once a minute. You can see changes occur to the status of links and devices, such as links going down or VDC creation, deletion, or modification. 
 
    [bookmark: pgfId-1415029]Because the map is always current, you can use it to troubleshoot ongoing network management issues.
 
    [bookmark: pgfId-1415031][bookmark: marker-1415030]Device states are shown on the map. The possible states are as follows:
 
     
     	 [bookmark: pgfId-1415032]Managed—You can configure and monitor the device with Cisco DCNM. For the device state to be Managed, device discovery must succeed.
 
     	 [bookmark: pgfId-1415033]Discovery—Cisco DCNM is currently discovering the device. You cannot configure or monitor the device with Cisco DCNM unless discovery succeeds and the device state changes to Managed. If discovery fails, the device state will change to Unmanaged.
 
     	 [bookmark: pgfId-1415034]Unmanaged—You cannot configure or monitor the device with Cisco DCNM because discovery failed or a Cisco DCNM user explicitly changed the device state to Unmanaged by using the Devices and Credentials feature.
 
     	 [bookmark: pgfId-1415035]Unreachable—You cannot configure or monitor the device because the Cisco DCNM server cannot connect to the device. Data shown in Cisco DCNM may be out of date. Common causes for this state are that a network issue is preventing the Cisco DCNM server from connecting to the device, the SSH feature is disabled on the device, or all terminal lines on the device are in use. When connectivity is restored, the state of the device will return to Managed.
 
    
 
    [bookmark: pgfId-1415039]For more information about device states, see the Understanding Device Icons and Links.
 
    [bookmark: pgfId-1415040]You can modify and save the layout of device icons. The map also provides you quick access to configuring features for a managed device.
 
    [bookmark: pgfId-1398878]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1398882]Information About Topology
 
     	 [bookmark: pgfId-1398886]Licensing Requirements for Topology
 
     	 [bookmark: pgfId-1398890]Prerequisites for Topology
 
     	 [bookmark: pgfId-1398894]Guidelines and Limitations
 
     	 [bookmark: pgfId-1398898]Using the Topology Feature
 
     	 [bookmark: pgfId-1398902]Related Documents
 
     	 [bookmark: pgfId-1398906]Feature History for Topology
 
    
 
   
 
    
     [bookmark: pgfId-1398908][bookmark: 69949]Information About Topology
 
    [bookmark: pgfId-1398909]The Topology feature provides you with a topology map of supported Cisco NX-OS devices. The topology map also shows switches that run Cisco IOS software, such as the Catalyst 6500 series switches. For Nexus 7000 Series devices, the map shows details about virtual device contexts (VDCs).
 
    [bookmark: pgfId-1398910]When Cisco Data Center Network Manager for LAN (DCNM-LAN) receives new information, the DCNM-LAN client updates the map dynamically. By default, updates occur once a minute. You can see changes occur to the status of links and devices, such as links going down or VDC creation, deletion, or modification. 
 
    [bookmark: pgfId-1398911]Because the map is always current, you can use it to troubleshoot ongoing network management issues.
 
    [bookmark: pgfId-1398912]You can modify and save the layout of device icons. The map also provides you quick access to configuring features for a managed device.
 
    [bookmark: pgfId-1398913]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1398917]Map Views
 
     	 [bookmark: pgfId-1398921]Layouts
 
     	 [bookmark: pgfId-1398925]vPC Support
 
     	 [bookmark: pgfId-1398929]DCNM-SAN Support
 
     	 [bookmark: pgfId-1398933]FabricPath Support
 
     	 [bookmark: pgfId-1398937]Device Groups
 
     	 [bookmark: pgfId-1398941]Network Servers
 
    
 
     
      [bookmark: pgfId-1398944][bookmark: 45093]Map Views[bookmark: marker-1398943]
 
     [bookmark: pgfId-1398945]The topology map includes four views of your topology as described in the following topics:
 
      
      	 [bookmark: pgfId-1398949]Physical View
 
      	 [bookmark: pgfId-1398953]PortChannel and vPC
 
      	 [bookmark: pgfId-1398957]Logical vPC View
 
      	 [bookmark: pgfId-1398961]L2 View
 
     
 
    
 
     
      [bookmark: pgfId-1398963][bookmark: 74938]Physical View
 
     [bookmark: pgfId-1398967]The Physical View (see Figure 16-1) shows the physical connections between discovered devices. This is the default topology view.
 
     [bookmark: pgfId-1401303]Figure 16-1 [bookmark: 19030]Physical View of the Topology Map
 
     [bookmark: pgfId-1401307]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1401309][bookmark: 83961]PortChannel and vPC
 
     [bookmark: pgfId-1398979]The PortChannel and vPC view (see Figure 16-2) shows all physical connections and all logical connections among discovered devices, including port channel links, virtual port channel (vPC) links, and vPC peer links. Physical links appear in gray in this view.
 
     [bookmark: pgfId-1398981]Figure 16-2 [bookmark: 50955]PortChannel and vPC View of the Topology Map
 
     [bookmark: pgfId-1398985]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1398987][bookmark: 77617]Logical vPC View
 
     [bookmark: pgfId-1398991]The Logical vPC View (see Figure 16-3) shows vPC links and vPC peer links among discovered devices, without showing the physical connections.
 
     [bookmark: pgfId-1398993]Figure 16-3 [bookmark: 62915]Logical vPC View of the Topology Map
 
     [bookmark: pgfId-1398997]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1398999][bookmark: 25613]L2 View 
 
     [bookmark: pgfId-1402084]The L2 view (see Figure 16-4) shows VLANs configured among discovered devices. Beginning with Cisco DCNM-LAN Release 5.1, the VSAN Overlay is a part of the L2 view. The VSAN Overlay feature enables you to view the Fibre Channel (FC) and Fibre Channel over Ethernet (FCoE) links that are active for a given VSAN or a range of VSANs. It also provides a visual representation of forwarding and non-forwarding links between Cisco Nexus devices in a data center network for configured VLANs.
 
     [bookmark: pgfId-1401391]Figure 16-4 [bookmark: 75039]L2 View of the Topology Map
 
     [bookmark: pgfId-1401395]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1401398][bookmark: 21578]Layouts[bookmark: marker-1401397]
 
     [bookmark: pgfId-1399043]The topology map enables you to move devices to where you want them. You can save the layout so that the next time you use the topology map, devices are where you placed them. The DCNM-LAN client saves topology layouts as local user data on the computer that runs the DCNM-LAN client. When you are using the DCNM-LAN client, you do not have access to topology layouts that you saved on other computers or that you saved while logged in to the computer under a different username.
 
     [bookmark: pgfId-1399044]In addition to saved layouts, when you are using the Physical View, you can load one of the following layouts:
 
      
      	 [bookmark: pgfId-1399045]Spring—Devices appear in locations determined by weighting the connections, which often produces a layout with minimal or no crossed connections.
 
      	 [bookmark: pgfId-1399046]Tree—Devices appear in a tree unless connections create loops among the devices, in which case devices appear in a spanning tree, that is, a grid in which most of the connections follow the grid layout.
 
     
 
    
 
     
      [bookmark: pgfId-1399048][bookmark: 59822]vPC Support
 
     [bookmark: pgfId-1399049]The topology map provides the following additional vPC-specific features:
 
      
      	 [bookmark: pgfId-1399050]vPC creation—You can launch the vPC Creation Wizard from the PortChannel and vPC view. See the “Launching the vPC Wizard” section.
 
      	 [bookmark: pgfId-1399054]Quick access to the vPC feature—You can access the configuration for a specific vPC from the PortChannel and vPC view or the Logical vPC View. See the “Managing a vPC” section.
 
      	 [bookmark: pgfId-1399058]vPC configuration inconsistency—You can see vPC links and vPC peer links that have configuration inconsistencies. You can open the Resolve Configuration Consistency dialog box from the topology map. See the “Finding and Resolving vPC Configuration Inconsistencies” section.
 
     
 
    
 
     
      [bookmark: pgfId-1399063][bookmark: 13747]DCNM-SAN Support
 
     [bookmark: pgfId-1399064]The DCNM-LAN topology map supports Cisco Data Center Network Manager for SAN (DCNM-SAN) by providing the features described in the following topics:
 
      
      	 [bookmark: pgfId-1399068]Common Topology
 
      	 [bookmark: pgfId-1399072]Access to DCNM-SAN Features
 
     
 
    
 
     
      [bookmark: pgfId-1399074][bookmark: 66954]Common Topology
 
     [bookmark: pgfId-1399075]The topology map can show storage area network (SAN) connections and devices in addition to Ethernet LAN connections and devices. You can use the DCNM-LAN topology map to view your entire data center network.
 
    
 
     
      [bookmark: pgfId-1399077][bookmark: 53873]Access to DCNM-SAN Features
 
     [bookmark: pgfId-1399078]When a SAN device, such as a Cisco MDS 9000 Family Multilayer Switch, appears in the topology map in the DCNM-LAN client, you can use the topology map to launch the Cisco DCNM-SAN client and configure the SAN device.
 
     [bookmark: pgfId-1399079]The Cisco DCNM-SAN cross launch feature is only supported by the DCNM-LAN client when the Cisco DCNM-SAN is installed in Server mode. Cross launch is not supported by the DCNM-LAN client when the Cisco DCNM-SAN is installed in Standalone mode. In addition, cross launch is not supported when the DCNM-LAN client is in standalone mode.
 
     [bookmark: pgfId-1399082]For information about installing the DCNM-LAN client in standalone mode, see Chapter13, “Installing and Launching the Cisco DCNM-LAN Client”
 
     [bookmark: pgfId-1399084]For information about installing Cisco DCNM-SAN and DCNM-LAN on the same server system, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
 
    
 
     
      [bookmark: pgfId-1399089][bookmark: 37097]FabricPath Support
 
     [bookmark: pgfId-1399090]FabricPath support for L2MP capable devices, running the L2MP-ISIS protocol, is available in the L2 View of the Topology drawer. The L2 View contains a dialog box that allows you to select the type of graph to display. When you select the Fabricpath view in the dialog box, you can display the following types of graphs:
 
      
      	 [bookmark: pgfId-1399091]Multi-destination
 
     
 
     [bookmark: pgfId-1399092]A multi-destination or broadcast graph represents broadcast traffic and unknown unicast traffic in the topology.
 
      
      	 [bookmark: pgfId-1399093]Reachability
 
     
 
     [bookmark: pgfId-1399094]L2MP-ISIS automatically computes the switch ID reachability for each node in the network.
 
      
      	 [bookmark: pgfId-1399095]Unicast
 
     
 
     [bookmark: pgfId-1399096]A unicast graph displays equal cost routes between nodes in a network.
 
      
      	 [bookmark: pgfId-1399097]Multicast
 
     
 
     [bookmark: pgfId-1399098]A multicast graph displays the multicast traffic from a specified device to all hosts that are listening to a particular IGMP group.
 
     [bookmark: pgfId-1399099]In addition, the FabricPath Topology Wizard can be launched from the L2 View. The FabricPath Topology Wizard allows you to do many operations, such as add to the FabricPath topology, display inventory, and display end devices.
 
      
       
     
 
     
 
     [bookmark: pgfId-1404779]Note The FabricPath Topology Wizard is not supported in Cisco NX-OS Release 5.1(1).
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1404780]Note • Starting from Cisco DCNM Release 6.1(1) the fabric path suppport feature will be available for the Cisco Nexus 55xx series switches.
 
      
      	 [bookmark: pgfId-1404781]Starting from Cisco DCNM Release 6.1(1) the fabric path suppport feature will be licensed.
 
     
 
     [bookmark: pgfId-1404788]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1399101]To launch the wizard, you need to select more than one device and right-click to display a context menu that lists the available operations. You can select multiple devices by holding down the shift key and clicking on the appropriate devices displayed on the graph. Alternatively, you may hold down the left mouse key and drag over the appropriate devices.
 
    
 
     
      [bookmark: pgfId-1399107][bookmark: 13676][bookmark: 29269]Device Groups
 
     [bookmark: pgfId-1399108]Device groups allow you to simplify the visualization of interconnections between groups of devices in the topology map. You can categorize devices into device groups that you define, which allows you to focus on a limited number of devices when you view the topology.
 
     [bookmark: pgfId-1399109]You can manage device groups using the topology map, which allows you to create groups, delete groups, and move devices among groups; however, the Device Groups feature is especially useful for assigning multiple devices to groups easily.
 
    
 
     
      [bookmark: pgfId-1399115][bookmark: 84890]Network Servers
 
     [bookmark: pgfId-1399116]The topology map can show network servers. You can use the Network Servers feature to associate host bus adapters (HBAs) and Ethernet network adapters that DCNM-LAN discovered with the Link Layer Discovery Protocol (LLDP) to network servers.
 
    
 
   
 
    
     [bookmark: pgfId-1399122][bookmark: 29596]Licensing Requirements for Topology
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1399126]Product 
         
  
        	 
          
          [bookmark: pgfId-1399128]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1399130]Cisco DCNM-LAN
  
        	[bookmark: pgfId-1399132]The Topology feature requires no license; however, the Logical vPC View of the topology map requires a LAN Enterprise license. Any feature not included in a license package is bundled with the Cisco DCNM-LAN and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1399138][bookmark: 16098]Prerequisites for Topology
 
    [bookmark: pgfId-1399139]Topology has the following prerequisites:
 
     
     	 [bookmark: pgfId-1399140]The topology map shows only devices that DCNM-LAN has discovered.
 
     	 [bookmark: pgfId-1399141]For full support on the topology map, discovered devices should have the applicable discovery protocols enabled, both globally and on active interfaces. For more information about the discovery protocols used by DCNM-LAN, see Chapter27, “Administering Device Discovery”
 
    
 
   
 
    
     [bookmark: pgfId-1399146][bookmark: 58316]Guidelines and Limitations
 
    [bookmark: pgfId-1399147]Topology has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1399148]While the Topology feature is an unlicensed feature, you must have a LAN Enterprise license to manage the nondefault VDCs of Cisco Nexus 7000 Series switches that appear in the topology.
 
     	 [bookmark: pgfId-1399149]The Topology feature displays changes to the topology periodically as determined by the polling frequency for accounting and system logs. By default, the polling frequency is one minute. For more information, see the “Information About Auto-Synchronization with Devices” section.
 
    
 
   
 
    
     [bookmark: pgfId-1399155][bookmark: 24305][bookmark: 71793]Using the Topology Feature
 
    [bookmark: pgfId-1399156]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1399160]Opening the Topology Map
 
     	 [bookmark: pgfId-1399164]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1399168]Using the Viewing Tools
 
     	 [bookmark: pgfId-1399172]Showing, Hiding, and Using the Details Pane
 
     	 [bookmark: pgfId-1399176]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1399180]Loading a Layout
 
     	 [bookmark: pgfId-1399184]Reloading the Previously Saved Layout
 
     	 [bookmark: pgfId-1399188]Showing a Virtual or Physical Chassis
 
     	 [bookmark: pgfId-1399192]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1399196]Managing a Network Server
 
     	 [bookmark: pgfId-1399200]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1399204]Expanding or Collapsing Device Groups
 
     	 [bookmark: pgfId-1399208]Creating a Device Group
 
     	 [bookmark: pgfId-1399212]Moving a Device Between Device Groups
 
     	 [bookmark: pgfId-1399216]Removing a Device from a Device Group
 
     	 [bookmark: pgfId-1399220]Copy Run to Start
 
     	 [bookmark: pgfId-1399224]Deleting a Device Group
 
     	 [bookmark: pgfId-1399228]Exporting the Topology as a JPG Image
 
     	 [bookmark: pgfId-1399232]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1399236]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1399240]Accessing Cisco FabricPath Features from the Topology Map
 
     	 [bookmark: pgfId-1399244]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1399248]Managing a vPC
 
     	 [bookmark: pgfId-1399252]Finding and Resolving vPC Configuration Inconsistencies
 
     	 [bookmark: pgfId-1399256]Accessing Remotely Connected CNAs from the Topology Map
 
     	 [bookmark: pgfId-1399260]Using VSAN Overlay
 
    
 
     
      [bookmark: pgfId-1203117][bookmark: 13513]Opening the Topology Map[bookmark: marker-1231458]
 
     [bookmark: pgfId-1203118]You can open the topology map to view the topology of discovered devices.
 
     [bookmark: pgfId-1415045]When you open the topology map, you can choose one of the following topology views:
 
      
       
       	 [bookmark: pgfId-1415046]Physical View—Shows the physical connections between discovered devices. This is the default topology view.
 
       	 [bookmark: pgfId-1415047]PortChannel and vPC—Shows all physical connections and all logical connections among discovered devices, including port channels, vPCs, and vPC peer links. Physical links appear in gray in this view.
 
       	 [bookmark: pgfId-1415048]Logical vPC View—Shows vPC and vPC peer links among discovered devices, without showing the physical connections. 
 
       	 [bookmark: pgfId-1415049]L2 View—Shows VLANs configured among discovered devices.
 
      
 
     
 
     [bookmark: pgfId-1415050]All views show the discovered devices in your network.
 
      
       
     
 
     
 
     [bookmark: pgfId-1350101]Note Before discovery, if you are working with Fabric[bookmark: marker-1350100]Path, you must use the Command-Line-Interface (CLI) to accomplish the following: 
 
      
      	 [bookmark: pgfId-1350104]Install the Enhanced Layer 2 license on the device. See the  Cisco NX-OS Licensing Guide for complete information on installing this license. 
 
      	 [bookmark: pgfId-1350108]Install the FabricPath feature set on the device. See the  Cisco Configuring Feature Set for FabricPath Guide for complete information on installing the feature set.
 
      	 [bookmark: pgfId-1371427]Configure the FabricPath feature set so that it can be enabled in a custom VDC. See the  Cisco Configuring Feature Set for FabricPath Guide  for complete information on configuring the feature set.
 
     
 
     [bookmark: pgfId-1350110]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1203125]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1203127]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
     [bookmark: pgfId-1203128]The topology map appears in the Contents pane. Buttons for each of the available topology views appear above the topology map.
 
     [bookmark: pgfId-1203129]Step 2 (Optional) If you want to change topology views, click the topology view name.
 
     [bookmark: pgfId-1203130]The topology map shows the view of the topology that you selected.
 
     [bookmark: pgfId-1203131]Step 3 (Optional) If you want to use a view-specific option, see the following table:
 
     [bookmark: pgfId-1203169]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1203134]View Feature 
          
  
         	 
           
           [bookmark: pgfId-1203136]Available In View 
          
  
         	 
           
           [bookmark: pgfId-1203138]How to Use 
          
  
        
 
         
         	[bookmark: pgfId-1203140]Show/Hide all VDCs
  
         	 
           
           	 [bookmark: pgfId-1203142]Physical View
 
          
  
         	[bookmark: pgfId-1203145]Right-click in the map and choose Show All VDCs or Hide All VDCs.
 [bookmark: pgfId-1203146]When you view all VDCs, Cisco Nexus 7000 Series devices appear as gray boxes that contain device icons for each VDC configured on the Cisco Nexus 7000 Series device.
  
        
 
         
         	[bookmark: pgfId-1363186]Show/Hide End Devices
  
         	 
           
           	 [bookmark: pgfId-1363188]Physical View
 
           	 [bookmark: pgfId-1363189]L2 View 
 
          
  
         	[bookmark: pgfId-1363191]Right-click in the map and choose Show End Devices or Hide End Devices.
  
        
 
         
         	[bookmark: pgfId-1203148]Filter VLANs
  
         	 
           
           	 [bookmark: pgfId-1203150]L2 View 
 
          
  
         	[bookmark: pgfId-1280363] 1. If the VLANs box does not appear on the map, click the Filter icon on the topology toolbar.
 [bookmark: pgfId-1280364] 2. Enter a list of VLAN IDs. You can specify a single VLAN ID, a range of VLAN IDs, or comma-separated IDs and ranges.
 [bookmark: pgfId-1203154] 3. Click Filter.
  
        
 
         
         	[bookmark: pgfId-1203156]Show/Hide non-forwarding links
  
         	 
           
           	 [bookmark: pgfId-1203158]L2 View 
 
          
  
         	[bookmark: pgfId-1203160] 1. On the map, find the VLANs box.
 [bookmark: pgfId-1203161] 2. Check or uncheck the Show Non-Forwarding Link (Blocking & Disabled) as needed.
  
        
 
         
         	[bookmark: pgfId-1203163]Show/Hide vPCs or port channels
  
         	 
           
           	 [bookmark: pgfId-1203165]PortChannel and vPC
 
          
  
         	[bookmark: pgfId-1203167] 1. On the map, find the gray box that contains the Show vPC check box and the Show Port Channel check box. You may need to scroll the map or zoom out to find the gray box.
 [bookmark: pgfId-1203168] 2. Check or uncheck the check boxes as needed.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1203170]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1415055]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1415059]Understanding Device Icons and Links
 
      	 [bookmark: pgfId-1415063]Using the Viewing Tools
 
      	 [bookmark: pgfId-1415067]Showing, Hiding, and Using the Details Pane
 
      	 [bookmark: pgfId-1415071]Showing or Hiding Network Servers
 
      	 [bookmark: pgfId-1415075]Showing or Hiding Device Groups
 
      	 [bookmark: pgfId-1415079]Accessing DCNM-LAN Features from the Topology Map
 
      	 [bookmark: pgfId-1415083]Accessing Cisco DCNM-SAN Features from the Topology Map
 
      	 [bookmark: pgfId-1415087]Accessing Cisco FabricPath Features from the Topology Map
 
      	 [bookmark: pgfId-1415091]Moving Devices in the Topology Map
 
      	 [bookmark: pgfId-1415095]Loading a Layout
 
      	 [bookmark: pgfId-1415099]Exporting the Topology as a JPG Image
 
      	 [bookmark: pgfId-1415103]Launching the vPC Wizard
 
      	 [bookmark: pgfId-1415107]Managing a vPC
 
      	 [bookmark: pgfId-1415111]Copy Run to Start
 
     
 
    
 
     
      [bookmark: pgfId-1209900][bookmark: 16219]Understanding Device Icons and Links[bookmark: marker-1231469]
 
     [bookmark: pgfId-1209901]To understand the device icons and links shown in the topology map, you can open the legend. The legend presents information about the device icons and links shown in the currently selected topology view.
 
    
 
     
      [bookmark: pgfId-1209945]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1209968]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
     [bookmark: pgfId-1209969]The topology map appears in the Contents pane. Buttons for each of the available topology views appear above the topology map.
 
     [bookmark: pgfId-1209970]Step 2 (Optional) If you want to change topology views, click the topology view name.
 
     [bookmark: pgfId-1273930]The topology map shows the view of the topology that you selected. The topology toolbar appears on the left side of the topology map.
 icon. 
     
 
     [bookmark: pgfId-1273935]The Legend dialog box displays information about the device icons and links that may appear in the currently selected topology view.
 
     [bookmark: pgfId-1210032]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1415116]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1415120]Opening the Topology Map
 
      	 [bookmark: pgfId-1415124]Using the Viewing Tools
 
      	 [bookmark: pgfId-1415128]Showing, Hiding, and Using the Details Pane
 
      	 [bookmark: pgfId-1415132]Launching the vPC Wizard
 
      	 [bookmark: pgfId-1415136]Managing a vPC
 
      	 [bookmark: pgfId-1415140]Showing or Hiding Network Servers
 
      	 [bookmark: pgfId-1415144]Showing or Hiding Device Groups
 
      	 [bookmark: pgfId-1415148]Accessing DCNM-LAN Features from the Topology Map
 
      	 [bookmark: pgfId-1415152]Accessing Cisco DCNM-SAN Features from the Topology Map
 
      	 [bookmark: pgfId-1415156]Accessing Cisco FabricPath Features from the Topology Map
 
      	 [bookmark: pgfId-1415160]Moving Devices in the Topology Map
 
      	 [bookmark: pgfId-1415164]Loading a Layout
 
      	 [bookmark: pgfId-1415168]Exporting the Topology as a JPG Image
 
      	 [bookmark: pgfId-1415172]Copy Run to Start
 
     
 
    
 
     
      [bookmark: pgfId-1209904][bookmark: 88222]Using the Viewing Tools[bookmark: marker-1209903]
 
     [bookmark: pgfId-1195696]You can use the pan, select, zoom, and search tools to view the topology map.
 
     [bookmark: pgfId-1415177]The map shows Nexus 7000 Series devices, switches that run Cisco IOS software, and CDP links between devices. The link colors have the following meanings:
 
      
      	 [bookmark: pgfId-1415178]Dark gray—The link between the two devices is active.
 
      	 [bookmark: pgfId-1415179]Light gray—In the Physical view, this color means that one of the devices is not reachable. In the PortChannel and vPC view, all physical links appear light gray.
 
      	 [bookmark: pgfId-1415180]Red—The physical link between the two devices are down.
 
     
 
     [bookmark: pgfId-1415181]The map also indicates whether a link is a single port link or a multiple port link, as follows:
 
      
      	 [bookmark: pgfId-1415182]Single port link—When one link connects two devices, the map connects the two devices with a thin line. The port icon at either end of the line shows a single port.
 
      	 [bookmark: pgfId-1415183]Multiple port link—When more than one link connect two devices, the map connects the two devices with a thick line. The port icon at either end of the line shows two ports.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1415184]Tip To view an explanation of some of icons and links show in the topology map, from the topology tool bar, click Legend. The Legend dialog box provides information for icons and links shown in the current topology view.
 
      
      
 
     
 
     
 
      
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
       
        
         
         	 
           
           [bookmark: pgfId-1293058]Viewing Tool 
           
 Icon and Name 
          
  
         	 
           
           [bookmark: pgfId-1293060]How to Use 
          
  
        
 
        
          Pan 
         	[bookmark: pgfId-1293067]Moves, or pans, the map.
 icon.
 [bookmark: pgfId-1293072] 2. Click anywhere on the topology map, and hold down the mouse button.
 [bookmark: pgfId-1293073] 3. Drag the map in any direction.
 [bookmark: pgfId-1293074] 4. Release the mouse button.
  
        
 
        
          Select 
         	[bookmark: pgfId-1293081]Allows you to select a device, link, or port icon.
 icon.
 [bookmark: pgfId-1293086] 2. Click the device, link, or port icon that you want to work with.
 [bookmark: pgfId-1293087]A balloon displays information about the icon that you clicked.
  
        
 
        
          Zoom in Rect 
         	[bookmark: pgfId-1293094]Zooms to a specific portion of the map.
 icon.
 [bookmark: pgfId-1293099] 2. Click on the map and drag a rectangle over the area that you want to see, and release the mouse button.
  
        
 
        
          Zoom In icon. 
        
 
        
          Zoom Out icon. 
        
 
        
          Fit to View icon. 
        
 
        
          Reset Zoom icon. 
        
 
        
          Load Layout 
         	[bookmark: pgfId-1311065]Loads a layout.
  
        
 
        
          Reload Layout 
         	[bookmark: pgfId-1293148]Loads the most recently saved layout. See the “Reloading the Previously Saved Layout” section.
  
        
 
        
          Show Device Groups 
         	[bookmark: pgfId-1293158]Shows or hides device groups. See the “Showing or Hiding Device Groups” section.
  
        
 
        
          Search 
         	[bookmark: pgfId-1293166]Allows you to use the device search tool, so that you can search for a device by its name.
 icon.
 icon.
 icon again.
 [bookmark: pgfId-1293179]Tip You can move the Search tool on the topology map by clicking and dragging it when you have the Select tool enabled.  
        
 
        
          Save Layout 
         	[bookmark: pgfId-1293188]Saves changes that you have made to the device icon layout. See the “Moving Devices in the Topology Map” section.
  
        
 
        
          Hide/Show Details 
         	[bookmark: pgfId-1293198]Shows and hides the details pane. See the “Showing, Hiding, and Using the Details Pane” section.
  
        
 
        
          Legend 
         	[bookmark: pgfId-1293208]Opens the Legend dialog box. See the “Understanding Device Icons and Links” section.
  
        
 
        
          Export as JPG 
         	[bookmark: pgfId-1293221]Saves the topology map as a JPG image file. See the “Exporting the Topology as a JPG Image” section.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1415189]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1415193]Opening the Topology Map
 
      	 [bookmark: pgfId-1415197]Understanding Device Icons and Links
 
      	 [bookmark: pgfId-1415201]Showing, Hiding, and Using the Details Pane
 
      	 [bookmark: pgfId-1415205]Launching the vPC Wizard
 
      	 [bookmark: pgfId-1415209]Managing a vPC
 
      	 [bookmark: pgfId-1415213]Finding and Resolving vPC Configuration Inconsistencies
 
      	 [bookmark: pgfId-1415217]Accessing DCNM-LAN Features from the Topology Map
 
      	 [bookmark: pgfId-1415221]Accessing Cisco FabricPath Features from the Topology Map
 
      	 [bookmark: pgfId-1415225]Moving Devices in the Topology Map
 
      	 [bookmark: pgfId-1415229]Loading a Layout
 
      	 [bookmark: pgfId-1415233]Copy Run to Start
 
     
 
    
 
     
      [bookmark: pgfId-1172562][bookmark: 45344]Showing, Hiding, and Using the Details Pane
 
     [bookmark: pgfId-1190323]You can show or hide the Details pane within the topology map. When you are showing the Details pane, you can use the sections within the Details pane to learn about the devices and connections in the topology.
 
    
 
     
      [bookmark: pgfId-1174624]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1218065]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
     [bookmark: pgfId-1218066]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
      
       
     
 
     
 
     [bookmark: pgfId-1273715]Tip To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
      
      
 
     
 
     
 icon. 
     
 
     [bookmark: pgfId-1292902]When you choose to show details, the Details pane appears between the topology toolbar and the topology map.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-1292907]Step 3 To use the sections within the Details pane, see the following table:
 
    [bookmark: pgfId-1199369]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1199330]Section 
         
  
        	 
          
          [bookmark: pgfId-1199332]Available In 
         
  
        	 
          
          [bookmark: pgfId-1199334]How to Use 
         
  
       
 
        
        	[bookmark: pgfId-1199336]VDC View
  
        	 
          
          	 [bookmark: pgfId-1199338]Physical View
 
          	 [bookmark: pgfId-1199339]L2 View 
 
         
  
        	[bookmark: pgfId-1199341]Explore the VDC View tree to see which Cisco Nexus 7000 Series devices contain VDCs. To see details about a device, click on it and see the Properties section.
  
       
 
        
        	[bookmark: pgfId-1199343]vPC
  
        	 
          
          	 [bookmark: pgfId-1199345]Port Channel and vPC
 
          	 [bookmark: pgfId-1199346]Logical vPC
 
         
  
        	[bookmark: pgfId-1199348]Explore the vPC tree to see a categorized listing of all logical connections in the topology map. To see details about a vPC, vPC peer link, or a port channel, click on it and see the Properties section.
  
       
 
        
        	[bookmark: pgfId-1199350]Overview
  
        	 
          
          	 [bookmark: pgfId-1199352]All views
 
         
  
        	[bookmark: pgfId-1199354]Tip To view the Overview section, you may need to click the Overview tab in the Properties section. The Overview and Properties sections share the same section title bar. [bookmark: pgfId-1199355]The Overview section shows a thumbnail view of the whole topology. A blue rectangle indicates the portion of the topology that is currently shown in the map.
 
          
          	 [bookmark: pgfId-1199356]To change which portion of the topology is shown in the map, in the overview, click where you want the map to show.
 
          	 [bookmark: pgfId-1199357]To zoom in or out, click a corner of the blue rectangle and drag it until the map is enlarged or shrunk as you want.
 
         
  
       
 
        
        	[bookmark: pgfId-1199359]Properties
  
        	 
          
          	 [bookmark: pgfId-1199361]All views
 
         
  
        	[bookmark: pgfId-1199363]Tip To view the Properties section, you may need to click the Properties tab in the Overview section. The Overview and Properties sections share the same section title bar. [bookmark: pgfId-1199364] 1. Do one of the following:
 [bookmark: pgfId-1199365] – In the VDC View section, click on a physical or virtual device.
 [bookmark: pgfId-1199366] – In the vPC section, click on a logical connection.
 [bookmark: pgfId-1199367] – In the topology map, click on a device, link, or port.
 [bookmark: pgfId-1199368] 2. In the Properties section, view the properties of the object that you selected.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1173344]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415238]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415242]Opening the Topology Map
 
     	 [bookmark: pgfId-1415246]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415250]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415254]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1415258]Managing a vPC
 
     	 [bookmark: pgfId-1415262]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415266]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415270]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1415274]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1415278]Accessing Cisco FabricPath Features from the Topology Map
 
     	 [bookmark: pgfId-1415282]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415286]Loading a Layout
 
    
 
   
 
    
     [bookmark: pgfId-1172822][bookmark: 57614]Moving Devices in the Topology Map[bookmark: marker-1176354]
 
    [bookmark: pgfId-1171502]You can move device icons that are shown in the topology map. The position of devices is shared by all the topology views, that is, if you move a device and then change to another topology view, the device remains where you moved it to.
 
    [bookmark: pgfId-1172214]You can also save the layout, which you can reload later if you make additional changes and want to revert to your last save. 
 
    [bookmark: pgfId-1399542]For more information, see the “Reloading the Previously Saved Layout” section.
 
    [bookmark: pgfId-1415294]For more information, see Reloading the Previously Saved Layout.
 
    [bookmark: pgfId-1172399]The saved layout becomes the default layout that you see in the topology map when you start the DCNM-LAN client.
 
     
      
    
 
    
 
    [bookmark: pgfId-1172218]Note The DCNM-LAN client saves topology layouts as local user data on the computer that runs the DCNM-LAN client. When you are using the DCNM-LAN client, you do not have access to topology layouts that you saved on other computers or that you saved while logged in to the computer under a different username.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1172219]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1174280]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1174281]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1273687]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1310220]Step 3 Find and move device icons as needed. To move an icon, click on the device icon, hold down the mouse button, drag the icon to the new location, and release the mouse button.
 
    [bookmark: pgfId-1310223]You can zoom and pan as needed to find icons. 
 
    [bookmark: pgfId-1399566]For more information, see the “Using the Viewing Tools” section.
 
    [bookmark: pgfId-1415302]For more information, see Using the Viewing Tools.
 icon. 
    
 
    [bookmark: pgfId-1273672]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415307]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415311]Opening the Topology Map
 
     	 [bookmark: pgfId-1415315]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415319]Loading a Layout
 
     	 [bookmark: pgfId-1415323]Reloading the Previously Saved Layout
 
     	 [bookmark: pgfId-1415327]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415331]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415335]Exporting the Topology as a JPG Image
 
    
 
   
 
    
     [bookmark: pgfId-1171875][bookmark: 71895]Loading a Layout[bookmark: marker-1231491]
 
    [bookmark: pgfId-1415340]When you are using the Physical View, you can choose to load a layout. one of the following layouts:
 
     
     	 [bookmark: pgfId-1415341]Saved—Devices appear in the layout that you most recently saved on the workstation that is running the Cisco DCNM client.
 
     	 [bookmark: pgfId-1415342]Spring—Devices appear in locations determined by weighting the connections, which often produces a layout with minimal or no crossed connections.
 
     	 [bookmark: pgfId-1415343]Tree—Devices appear in a tree unless connections create loops among the devices, in which case devices appear in a spanning tree, that is, a grid in which most of the connections follow the grid layout.
 
    
 
    [bookmark: pgfId-1273644]The position of devices is shared by all the topology views. This behavior allows you to use any of the layouts in all views by loading the layout in the Physical View and then choosing another view.
 
     
      
    
 
    
 
   
 
   
 
    
     [bookmark: pgfId-1199788]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1204251]Determine which physical devices, if any, that you want to specify as core switches. When you load a layout other than a saved layout, core switches appear at the top of the topology map, and devices that are one CDP hop from the core switches appear just below them.
 
   
 
    
     [bookmark: pgfId-1376960]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1199970]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1199971]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1200002]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1273603]Step 2 (Optional) For each physical device that you want to appear at the top of the layout, right-click on the device icon and choose Make as Core Switch.
 icon. 
    
 
    [bookmark: pgfId-1273608]The Layout drop-down list appears.
 
    [bookmark: pgfId-1200039]Step 4 From the Layout drop-down list, choose the layout that you want to load.
 
    [bookmark: pgfId-1200038]The Physical View of the topology map changes to the layout that you selected. Any devices that you specified as core switches appear at the top of the map, with devices that are one CDP hop away from the core switches appearing just below them.
 
    [bookmark: pgfId-1199978]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415348]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415352]Opening the Topology Map
 
     	 [bookmark: pgfId-1415356]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415360]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415364]Reloading the Previously Saved Layout
 
     	 [bookmark: pgfId-1415368]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415372]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415376]Exporting the Topology as a JPG Image
 
    
 
   
 
    
     [bookmark: pgfId-1199943][bookmark: 55331]Reloading the Previously Saved Layout[bookmark: marker-1231492]
 
    [bookmark: pgfId-1171876]You can load the most recently saved layout. This feature allows you to undo changes to device placement that you have made since you last saved the layout.
 
     
      
    
 
    
 
    [bookmark: pgfId-1172310]Note The DCNM-LAN client saves topology layouts as local user data on the computer that runs the DCNM-LAN client. When you are using the DCNM-LAN client, you do not have access to topology layouts that you saved on other computers or that you saved while logged in to the computer under a different username.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1171391]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1174294]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1174295]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1273595]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1273600]The topology map changes to the most recent layout that you saved.
 
    [bookmark: pgfId-1171430]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415381]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415385]Opening the Topology Map
 
     	 [bookmark: pgfId-1415389]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415393]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415397]Showing, Hiding, and Using the Details Pane
 
     	 [bookmark: pgfId-1415401]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415405]Loading a Layout
 
     	 [bookmark: pgfId-1415409]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415413]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415417]Exporting the Topology as a JPG Image
 
    
 
   
 
    
     [bookmark: pgfId-1294251][bookmark: 79865]Showing a Virtual or Physical Chassis
 
    [bookmark: pgfId-1294252]For a Cisco Nexus 1000V device, you can specify whether the topology map shows the virtual chassis or the physical chassis of the device. By default, the topology map shows the virtual chassis.
 
   
 
    
     [bookmark: pgfId-1294969]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1294445]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1294446]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
    [bookmark: pgfId-1294447]Step 2 Find the Cisco Nexus 1000V device icon.
 
    [bookmark: pgfId-1294867]The topology map displays either the virtual chassis or the physical chassis.
 
    [bookmark: pgfId-1294936]Step 3 Right-click on the device icon and choose the applicable option:
 
     
      
      	 [bookmark: pgfId-1294937] Show Virtual Chassis 
 
      	 [bookmark: pgfId-1294938] Show Physical Chassis 
 
     
 
    
 
    [bookmark: pgfId-1294451]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415422]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415426]Opening the Topology Map
 
     	 [bookmark: pgfId-1415430]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415434]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415438]Showing, Hiding, and Using the Details Pane
 
     	 [bookmark: pgfId-1415442]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415446]Loading a Layout
 
     	 [bookmark: pgfId-1415450]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415454]Showing or Hiding Device Groups
 
    
 
   
 
    
     [bookmark: pgfId-1294640][bookmark: 39847]Showing or Hiding Network Servers[bookmark: marker-1294639]
 
    [bookmark: pgfId-1276019]You can show or hide the network servers that are connected to a specific device. By default, the topology map hides network servers.
 
   
 
    
     [bookmark: pgfId-1276020]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1276022]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1276023]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
    [bookmark: pgfId-1276822]Step 2 Find the device that is connected to network servers that you want to show or hide.
 
    [bookmark: pgfId-1276824]Step 3 Right-click on the device and choose one of the following:
 
     
      
      	 [bookmark: pgfId-1277080]To show connected network servers, choose  Show End Devices .
 
      	 [bookmark: pgfId-1277155]To hide connected network servers, choose  Hide End Devices .
 
     
 
    
 
    [bookmark: pgfId-1281243]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415459]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415463]Opening the Topology Map
 
     	 [bookmark: pgfId-1415467]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415471]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415475]Showing, Hiding, and Using the Details Pane
 
     	 [bookmark: pgfId-1415479]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415483]Loading a Layout
 
     	 [bookmark: pgfId-1415487]Managing a Network Server
 
     	 [bookmark: pgfId-1415491]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415495]Copy Run to Start
 
    
 
   
 
    
     [bookmark: pgfId-1281282][bookmark: 95785]Managing a Network Server
 
    [bookmark: pgfId-1277240]You can use the topology map to access the Network Servers feature for a network server that appears on the map.
 
   
 
    
     [bookmark: pgfId-1277277]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1277316]The network server must be showing in the topology map.
 
   
 
    
     [bookmark: pgfId-1277241]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1277243]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1277244]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1277359]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1277360]Step 2 Find the network server that you want to manage with the Network Servers feature.
 
     
      
    
 
    
 
    [bookmark: pgfId-1277366]Tip If the network server does not appear on the map, right-click a device that it is connected to and choose Show End Devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1277361]Step 3 Right-click on the server and choose Manage Server.
 
    [bookmark: pgfId-1277398]The DCNM-LAN client opens to the Network Servers feature. If the server that you chose represents a managed server or an Ethernet adapter on a discovered server, the client opens to the Servers contents pane. If the server that you chose represents a host bus adapter (HBA) that is not correlated or bound to a server, the client opens to the Static Server-Adapter Mapping contents pane.
 
    [bookmark: pgfId-1277250]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415500]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415516]Showing or Hiding Network Servers
 
    
 
   
 
    
     [bookmark: pgfId-1277184][bookmark: 57337]Showing or Hiding Device Groups[bookmark: marker-1275953]
 
    [bookmark: pgfId-1275357]You can show or hide device groups. When device groups are hidden, the topology map shows all discovered devices and connections. When your device groups are shown, you can expand and collapse device groups individually or all at once.
 
   
 
    
     [bookmark: pgfId-1275358]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1275360]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1275361]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1275362]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon on the topology toolbar controls whether device groups appear on the topology map. When the icon appears to be pushed in, the topology map shows device groups. When the icon does not appear to be pushed in, the topology map hides device groups. 
    
 icon to change between hiding and showing device groups, as needed. 
    
 
    [bookmark: pgfId-1275370]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415521]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415525]Opening the Topology Map
 
     	 [bookmark: pgfId-1415529]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415533]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415537]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415541]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415545]Expanding or Collapsing Device Groups
 
     	 [bookmark: pgfId-1415549]Creating a Device Group
 
     	 [bookmark: pgfId-1415553]Moving a Device Between Device Groups
 
     	 [bookmark: pgfId-1415557]Removing a Device from a Device Group
 
     	 [bookmark: pgfId-1415561]Deleting a Device Group
 
     	 [bookmark: pgfId-1415565]Copy Run to Start
 
    
 
   
 
    
     [bookmark: pgfId-1268886][bookmark: 38819]Expanding or Collapsing Device Groups[bookmark: marker-1269286]
 
    [bookmark: pgfId-1274682]You can expand and collapse individual device groups or all device groups.
 
   
 
    
     [bookmark: pgfId-1274725]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1275168]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1275169]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1275170]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1275173]Step 3 Do one of the following:
 
     
      
      	 [bookmark: pgfId-1275174]If you want to expand a single device group, right-click on the device group icon and choose  Expand Device Group .
 
      	 [bookmark: pgfId-1275249]If you want to expand all device groups, right-click on a blank area of the map and choose  Expand all Device Groups .
 
      	 [bookmark: pgfId-1275271]If you want to collapse a single device group, right-click on the title of the device group and choose  Collapse Device Group .
 
      	 [bookmark: pgfId-1275308]If you want to collapse all device groups, right-click on a blank area of the map and choose  Collapse all Device Groups .
 
     
 
    
 
    [bookmark: pgfId-1274734]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415570]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415574]Opening the Topology Map
 
     	 [bookmark: pgfId-1415578]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415582]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415586]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415590]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415594]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415598]Creating a Device Group
 
     	 [bookmark: pgfId-1415602]Moving a Device Between Device Groups
 
     	 [bookmark: pgfId-1415606]Removing a Device from a Device Group
 
     	 [bookmark: pgfId-1415610]Deleting a Device Group
 
     	 [bookmark: pgfId-1415614]Copy Run to Start
 
    
 
   
 
    
     [bookmark: pgfId-1268887][bookmark: 34936]Creating a Device Group[bookmark: marker-1269281]
 
    [bookmark: pgfId-1270807]You can create a custom device group on the topology map.
 
   
 
    
     [bookmark: pgfId-1270809]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1275141]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1275142]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1274954]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1274955]Step 2 Right-click on a blank area of the map and choose New Device Group.
 
    [bookmark: pgfId-1274956]A dialog box appears, with a field for specifying a name for the new device group.
 
    [bookmark: pgfId-1274957]Step 3 Type a name for the device group and click OK.
 
    [bookmark: pgfId-1274958]The new device group appears on the topology map.
 
    [bookmark: pgfId-1275203]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415619]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415623]Opening the Topology Map
 
     	 [bookmark: pgfId-1415627]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415631]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415635]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415639]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415643]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415647]Expanding or Collapsing Device Groups
 
     	 [bookmark: pgfId-1415651]Moving a Device Between Device Groups
 
     	 [bookmark: pgfId-1415655]Removing a Device from a Device Group
 
     	 [bookmark: pgfId-1415659]Deleting a Device Group
 
     	 [bookmark: pgfId-1415663]Copy Run to Start
 
    
 
   
 
    
     [bookmark: pgfId-1268888][bookmark: 77788]Moving a Device Between Device Groups[bookmark: marker-1269276]
 
    [bookmark: pgfId-1270203]You can move devices from one device group to another device group on the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1270657]Note If a device group is empty after you move a device out of the group, DCNM-LAN deletes the device group.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1270384]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1270386]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1270387]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1270388]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1270391]Step 3 Find the device group that you want to move the device out of.
 
    [bookmark: pgfId-1270392]Step 4 If the device group is collapsed, double-click the device group to expand it.
 
    [bookmark: pgfId-1270393]Step 5 Right-click on the device that you want to move out of the group and choose Cut.
 
    [bookmark: pgfId-1270490]Step 6 Find the device group that you want to move the device into.
 
     
      
    
 
    
 
    [bookmark: pgfId-1270533]Tip You do not need to expand the device group before moving the device into the group.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1270511]Step 7 Right-click the device group and choose Paste.
 
     
      
    
 
    
 
    [bookmark: pgfId-1270575]Tip If the device group is expanded, you must click on the title of the device group.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1270394]A warning dialog box confirms that you want to move the device group.
 
    [bookmark: pgfId-1270395]Step 8 Click Yes.
 
    [bookmark: pgfId-1270396]DCNM-LAN adds the device to the second device group and removes it from the first device group. If the first device group is empty after moving the device, DCNM-LAN deletes the first device group.
 
    [bookmark: pgfId-1270397]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415668]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415672]Opening the Topology Map
 
     	 [bookmark: pgfId-1415676]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415680]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415684]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415688]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415692]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415696]Expanding or Collapsing Device Groups
 
     	 [bookmark: pgfId-1415700]Creating a Device Group
 
     	 [bookmark: pgfId-1415704]Removing a Device from a Device Group
 
     	 [bookmark: pgfId-1415708]Deleting a Device Group
 
     	 [bookmark: pgfId-1415712]Copy Run to Start
 
    
 
   
 
    
     [bookmark: pgfId-1268889][bookmark: 72114]Removing a Device from a Device Group[bookmark: marker-1269271]
 
    [bookmark: pgfId-1269639]You can remove devices from a custom device group. All devices that you remove from a custom group are added to the default device group.
 
   
 
    
     [bookmark: pgfId-1269692]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1269694]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1269695]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1269696]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1269699]Step 3 Find the device group that you want to remove a device from.
 
    [bookmark: pgfId-1269753]Step 4 If the device group is collapsed, double-click the device group to expand it.
 
    [bookmark: pgfId-1269700]Step 5 Right-click on the device that you want to remove from the group and choose Remove from Group.
 
    [bookmark: pgfId-1269701]If you are removing the only device from the group, a warning dialog box confirms that you want to remove the device group.
 
    [bookmark: pgfId-1270006]Step 6 If the warning appears, click Yes.
 
    [bookmark: pgfId-1269800]DCNM-LAN removes the device from the custom device group and adds the device to the default device group.
 
    [bookmark: pgfId-1269802]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415717]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415721]Opening the Topology Map
 
     	 [bookmark: pgfId-1415725]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415729]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415733]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415737]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415741]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415745]Expanding or Collapsing Device Groups
 
     	 [bookmark: pgfId-1415749]Creating a Device Group
 
     	 [bookmark: pgfId-1415753]Moving a Device Between Device Groups
 
     	 [bookmark: pgfId-1415757]Deleting a Device Group
 
     	 [bookmark: pgfId-1415761]Copy Run to Start
 
    
 
   
 
    
     [bookmark: pgfId-1328560][bookmark: 63124]Copy Run to Sta[bookmark: marker-1329187]rt
 
    [bookmark: pgfId-1328561]In the Physical View, you can copy the running configuration to the startup configuration on one or more selected devices. 
 
   
 
    
     [bookmark: pgfId-1328562]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1328563]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1328564]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1328565]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1328666]Step 3 Above the topology map, select Physical View.
 
    [bookmark: pgfId-1328570]Step 4 Select the devices that you want to copy the running configuratiion from.
 
    [bookmark: pgfId-1328571]Step 5 If the device group is collapsed, double-click the device group to expand it.
 
    [bookmark: pgfId-1328572]Step 6 Right-click the device that you want to copy the running configuration from.
 
     
      
      	 [bookmark: pgfId-1329364]If you want to copy the running configuration to the startup configuration, choose  Copy Run to Start .
 
     
 
    
 
    [bookmark: pgfId-1329365]DCNM-LAN copies the running configuration to the startup configuration.
 
     
      
      	 [bookmark: pgfId-1329350]If you want to copy the running configuration to a file in the bootflash directory, choose  Copy Run to File in Bootflash . In the dialog box that appears, enter the name of the file to copy to and click  OK to complete the operation.
 
     
 
    
 
    [bookmark: pgfId-1329404]DCNM-LAN copies the running configuration to the specified file.
 
    [bookmark: pgfId-1328576]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415766]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415770]Opening the Topology Map
 
     	 [bookmark: pgfId-1415774]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415778]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415782]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415786]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415790]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415794]Expanding or Collapsing Device Groups
 
     	 [bookmark: pgfId-1415798]Creating a Device Group
 
     	 [bookmark: pgfId-1415802]Moving a Device Between Device Groups
 
     	 [bookmark: pgfId-1415806]Removing a Device from a Device Group
 
     	 [bookmark: pgfId-1415810]Deleting a Device Group
 
    
 
   
 
    
     [bookmark: pgfId-1269805][bookmark: 46032]Deleting a Device Group[bookmark: marker-1269804]
 
    [bookmark: pgfId-1269320]You can delete a custom device group from the topology map.
 
    [bookmark: pgfId-1269321]Devices that belong to a custom device group that you delete automatically become members of the default device group.
 
   
 
    
     [bookmark: pgfId-1269323]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1269325]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1269406]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1269527]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1269439]Step 3 Find the device group that you want to delete.
 
    [bookmark: pgfId-1269329]Step 4 Right-click on the device group and choose Delete Group.
 
    [bookmark: pgfId-1269330]DCNM-LAN removes the device group from the topology map. The devices that were in the deleted device group are now members of the default device group.
 
     
      
    
 
    
 
    [bookmark: pgfId-1269564]Note If there are no custom device groups after you delete the device group, the topology map automatically hides devices groups because all devices are in the default device group.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1269333]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415815]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415819]Opening the Topology Map
 
     	 [bookmark: pgfId-1415823]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415827]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415831]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415835]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415839]Showing or Hiding Device Groups
 
     	 [bookmark: pgfId-1415843]Expanding or Collapsing Device Groups
 
     	 [bookmark: pgfId-1415847]Creating a Device Group
 
     	 [bookmark: pgfId-1415851]Moving a Device Between Device Groups
 
     	 [bookmark: pgfId-1415855]Removing a Device from a Device Group
 
     	 [bookmark: pgfId-1415859]Copy Run to Start
 
    
 
   
 
    
     [bookmark: pgfId-1268843][bookmark: 55986]Exporting the Topology as a JPG Image[bookmark: marker-1268754]
 
    [bookmark: pgfId-1268756]You can export, or save, a JPG image of the topology map. You can export either the entire topology map or only the visible portion of the topology map.
 
   
 
    
     [bookmark: pgfId-1268757]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1268759]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1268760]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1268761]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1268764]Step 2 View the portion of the topology map that you want to save. 
 
    [bookmark: pgfId-1400264]For more information, see the “Using the Viewing Tools” section.
 
    [bookmark: pgfId-1415867]For more information, see the Using the Viewing Tools.
 
    [bookmark: pgfId-1321013]Step 3 Arrange the device icons as desired. 
 
    [bookmark: pgfId-1400288]For more information, see the “Moving Devices in the Topology Map” section.
 
    [bookmark: pgfId-1415875]For more information, see the Moving Devices in the Topology Map.
 icon. 
    
 
    [bookmark: pgfId-1320972]A dialog box prompts you to choose whether you want to export the entire topology map or only the visible portion of the map.
 
    [bookmark: pgfId-1268775]Step 5 Do one of the following:
 
     
      
      	 [bookmark: pgfId-1293305]To export the entire topology map as a JPG image, click  Yes .
 
      	 [bookmark: pgfId-1293324]To export only the visible portion of the topology map, click  No .
 
     
 
    
 
    [bookmark: pgfId-1293288]Step 6 Specify the location and filename of the JPG image and click Save.
 
    [bookmark: pgfId-1268776]The JPG image of the visible portion of the topology map is saved.
 
    [bookmark: pgfId-1268777]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415880]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415884]Opening the Topology Map
 
     	 [bookmark: pgfId-1415888]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415892]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415896]Showing, Hiding, and Using the Details Pane
 
     	 [bookmark: pgfId-1415900]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415904]Loading a Layout
 
     	 [bookmark: pgfId-1415908]Reloading the Previously Saved Layout
 
     	 [bookmark: pgfId-1415912]Showing or Hiding Network Servers
 
     	 [bookmark: pgfId-1415916]Showing or Hiding Device Groups
 
    
 
   
 
    
     [bookmark: pgfId-1268210][bookmark: 23733]Accessing DCNM-LAN Features from the Topology Map[bookmark: marker-1268209]
 
    [bookmark: pgfId-1268211]You can use the topology map to access other DCNM-LAN features for managed devices. From the topology map, you can access features that are found in the following Feature Selector drawers:
 
     
     	 [bookmark: pgfId-1268212]Inventory
 
     	 [bookmark: pgfId-1268213]Virtual Devices
 
     	 [bookmark: pgfId-1268214]Interfaces
 
     	 [bookmark: pgfId-1268215]Routing
 
     	 [bookmark: pgfId-1268216]Switching
 
     	 [bookmark: pgfId-1268217]Security
 
    
 
    [bookmark: pgfId-1268218]You can also use the topology map to access the Device Discovery feature.
 
   
 
    
     [bookmark: pgfId-1268219]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1268221]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1268222]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1268223]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1268224]Step 2 If you want to access a DCNM-LAN feature for a specific managed device, do the following:
 
    [bookmark: pgfId-1268225] a. Find the device in the topology map.
 
    [bookmark: pgfId-1268226] b. Right-click the device and choose the feature that you want to configure.
 
    [bookmark: pgfId-1268227]The feature that you selected appears in the Contents pane. The device that you selected on the topology map is selected in the Summary table for the feature.
 
    [bookmark: pgfId-1268228]Step 3 If you want to access the Device Discovery feature, right-click a blank area on the map and choose Discover Devices.
 
    [bookmark: pgfId-1268229]The Device Discovery feature appears in the Contents pane.
 
    [bookmark: pgfId-1268230]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415921]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415925]Opening the Topology Map
 
     	 [bookmark: pgfId-1415929]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415933]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415937]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1415941]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1415945]Accessing Cisco FabricPath Features from the Topology Map
 
     	 [bookmark: pgfId-1415949]Managing a vPC
 
     	 [bookmark: pgfId-1415953]Finding and Resolving vPC Configuration Inconsistencies
 
     	 [bookmark: pgfId-1415957]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415961]Loading a Layout
 
    
 
   
 
    
     [bookmark: pgfId-1268567][bookmark: 68484]Accessing Cisco DCNM-SAN Features from the Topology Map[bookmark: marker-1268566]
 
    [bookmark: pgfId-1277725]You can use the topology map to access features in the Cisco DCNM-SAN client for a managed SAN device. If Cisco DCNM-SAN has not discovered the device, accessing the Cisco DCNM-SAN client through the topology map will cause Cisco DCNM-SAN to discover the SAN device.
 
    [bookmark: pgfId-1278247]The Cisco DCNM-SAN features that you can access include the following:
 
     
     	 [bookmark: pgfId-1278276]Zones, zone sets, and zone set membership
 
     	 [bookmark: pgfId-1278377]Port channel interfaces
 
     	 [bookmark: pgfId-1278483]Fibre Channel physical and logical interfaces
 
     	 [bookmark: pgfId-1278623]Fibre Channel over IP tunnels
 
     	 [bookmark: pgfId-1278663]Events
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1371044]Note The Cisco DCNM-SAN cross launch feature is only supported by the DCNM-LAN client when the Cisco DCNM-SAN is installed in Server mode. Cross launch is not supported by the DCNM-LAN client when the Cisco DCNM-SAN is installed in Standalone mode. In addition, cross launch is not supported when the DCNM-LAN client is in standalone mode.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1277733]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1280550]The Cisco DCNM-SAN client must be installed on the computer that is running the DCNM-LAN client.
 
   
 
    
     [bookmark: pgfId-1280534]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1277735]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1277736]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1277737]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1277739]Step 2 Find the SAN device in the topology map.
 
    [bookmark: pgfId-1277740]Step 3 Right-click the device and choose the feature that you want to configure.
 
    [bookmark: pgfId-1277743]The Cisco DCNM-SAN client opens to the feature that you selected.
 
    [bookmark: pgfId-1277744]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415966]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1415970]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1415974]Accessing Cisco FabricPath Features from the Topology Map
 
     	 [bookmark: pgfId-1415978]Opening the Topology Map
 
     	 [bookmark: pgfId-1415982]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1415986]Using the Viewing Tools
 
     	 [bookmark: pgfId-1415990]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1415994]Loading a Layout
 
    
 
   
 
    
     [bookmark: pgfId-1337569][bookmark: 13545]Accessing Cisco FabricPath Features from the Topology Ma[bookmark: marker-1340774]p
 
    [bookmark: pgfId-1337986]You can use the topology map to access features of the Cisco FabricPath.
 
    [bookmark: pgfId-1337987]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1337571]Multi-destination
 
     	 [bookmark: pgfId-1337572]Device Reachability
 
     	 [bookmark: pgfId-1337573]Unicast
 
     	 [bookmark: pgfId-1401619]Multicast
 
    
 
   
 
    
     [bookmark: pgfId-1401621][bookmark: 10915]Multi-destination
 
    [bookmark: pgfId-1401622]A multi-destination or broadcast graph represents broadcast traffic and unknown unicast traffic in the topolgy. You can view the multi-destination information for a specific topology.
 
   
 
    
     [bookmark: pgfId-1401600]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1340547]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1340548]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1340549]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1401590]Step 2 Above the map, click L2 View.
 
    [bookmark: pgfId-1401591]The dialog box appears in the Contents pane.
 
    [bookmark: pgfId-1401592]Step 3 In the dialog box, choose the Fabricpath view.
 
    [bookmark: pgfId-1401572]Step 4 Enter the Topology ID and click Fetch. The graph that is displayed is filtered based upon the Topology ID.
 
    [bookmark: pgfId-1401573]Step 5 Check Select type of graph to enable the selection for the Multi-destination graph.
 
    [bookmark: pgfId-1401574]Step 6 Check the Multi-destination option.
 
    [bookmark: pgfId-1337581]Step 7 From the Anchor drop-down list, choose a device. The selected device is the entry point for the graph.
 
    [bookmark: pgfId-1337582]Step 8 From the Graph ID drop-down list, choose an ID. The Graph ID is a forwarding tag for the graph.
 
    [bookmark: pgfId-1337583]Step 9 Click Fetch to view the graph.
 
    [bookmark: pgfId-1337584]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1415999]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1416003]Opening the Topology Map
 
     	 [bookmark: pgfId-1416007]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1416011]Using the Viewing Tools
 
     	 [bookmark: pgfId-1416015]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1416019]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416023]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416027]Managing a vPC
 
     	 [bookmark: pgfId-1416031]Finding and Resolving vPC Configuration Inconsistencies
 
     	 [bookmark: pgfId-1416035]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1416039]Loading a Layout
 
    
 
   
 
    
     [bookmark: pgfId-1337585][bookmark: 36032]Device Reachability
 
    [bookmark: pgfId-1337586]L2MP-ISIS automatically computes the switch ID reachability for each node in the network. You can view the reachability information for a specific topology.
 
   
 
    
     [bookmark: pgfId-1377270]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1340705]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1340706]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1340707]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1340708]Step 2 Above the map, click L2 View.
 
    [bookmark: pgfId-1340709]The dialog box appears in the Contents pane.
 
    [bookmark: pgfId-1340710]Step 3 In the dialog box, choose the Fabricpath view.
 
    [bookmark: pgfId-1337588]Step 4 Enter the Topology ID. The graph that is displayed is filtered based upon the Topology ID.
 
    [bookmark: pgfId-1337589]Step 5 Check Select type of graph to enable the selection for the Reachability graph.
 
    [bookmark: pgfId-1337590]Step 6 Check the Reachability option.
 
    [bookmark: pgfId-1337591]Step 7 From the Anchor drop-down list, choose a device. The selected device is the entry point for the graph.
 
    [bookmark: pgfId-1337592]Step 8 Click Fetch to view the graph.
 
    [bookmark: pgfId-1337593]
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1337594]Note Devices in the graph that appear as red colored icons indicate that the device is not reachable for the selected topology.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1416044]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1416048]Opening the Topology Map
 
     	 [bookmark: pgfId-1416052]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1416056]Using the Viewing Tools
 
     	 [bookmark: pgfId-1416060]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1416064]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416068]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416072]Managing a vPC
 
     	 [bookmark: pgfId-1416076]Finding and Resolving vPC Configuration Inconsistencies
 
     	 [bookmark: pgfId-1416080]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1416084]Loading a Layout
 
    
 
   
 
    
     [bookmark: pgfId-1337595][bookmark: 62908]Unicast
 
    [bookmark: pgfId-1337596]A unicast graph displays equal cost routes between nodes in a network. You can view the unicast information for a specific topology.
 
   
 
    
     [bookmark: pgfId-1337758]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1340714]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1340715]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1340716]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1340717]Step 2 Above the map, click L2 View.
 
    [bookmark: pgfId-1340718]The dialog box appears in the Contents pane.
 
    [bookmark: pgfId-1340719]Step 3 In the dialog box, choose the Fabricpath view.
 
    [bookmark: pgfId-1337598]Step 4 Enter the Topology ID. The graph that is displayed is filtered based upon the Topology ID.
 
    [bookmark: pgfId-1337599]Step 5 Check Select type of graph to enable the selection for the Unicast graph.
 
    [bookmark: pgfId-1337600]Step 6 Check the Unicast option.
 
    [bookmark: pgfId-1337601]Step 7 From the Anchor drop-down list, select a device. The selected device is the entry point for the graph.
 
    [bookmark: pgfId-1337602]Step 8 From the Destination drop-down list, select a device. The selected device is the destination for the graph.
 
    [bookmark: pgfId-1337603]Step 9 Click Fetch to view the graph.
 
    [bookmark: pgfId-1337604]
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1337605]Note If the resulting graph does not trace the path from the source to the destination, then one of the following may be the cause:
 
     
     	 [bookmark: pgfId-1337606]Islands in the L2MP cloud.
 
     	 [bookmark: pgfId-1337805]DCNM-LAN might not manage intermediate devices.
 
    
 
    [bookmark: pgfId-1337806]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1416089]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1416093]Opening the Topology Map
 
     	 [bookmark: pgfId-1416097]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1416101]Using the Viewing Tools
 
     	 [bookmark: pgfId-1416105]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1416109]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416113]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416117]Managing a vPC
 
     	 [bookmark: pgfId-1416121]Finding and Resolving vPC Configuration Inconsistencies
 
     	 [bookmark: pgfId-1416125]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1416129]Loading a Layout
 
    
 
   
 
    
     [bookmark: pgfId-1337807][bookmark: 65128]Multicast
 
    [bookmark: pgfId-1337610]A multicast graph displays the multicast traffic from a specified device to all hosts that are listening to a particular IGMP group. You can view the multicast information for a specific topology.
 
   
 
    
     [bookmark: pgfId-1337860]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1340747]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1340748]The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
     
      
    
 
    
 
    [bookmark: pgfId-1340749]Note To see the names of topology toolbar icons, move the mouse pointer to the icon and wait briefly for the name of the icon to appear.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1340750]Step 2 Above the map, click L2 View.
 
    [bookmark: pgfId-1340751]The dialog box appears in the Contents pane.
 
    [bookmark: pgfId-1340752]Step 3 In the dialog box, choose the Fabricpath view.
 
    [bookmark: pgfId-1337612]Step 4 Enter the Topology ID. The graph that is displayed is filtered based upon the Topology ID.
 
    [bookmark: pgfId-1337613]Step 5 Check Select type of graph to enable the selection for the Multicast graph.
 
    [bookmark: pgfId-1337614]Step 6 Check the Multicast option.
 
    [bookmark: pgfId-1337615]Step 7 From the Anchor drop-down list, choose a device. The selected device is the entry point for the graph.
 
    [bookmark: pgfId-1337616]Step 8 From the Graph ID drop-down list, choose an ID. The Graph ID is a forwarding tag for the graph.
 
    [bookmark: pgfId-1337617]Step 9 In the Source field, enter the multicast originating device. The multicast originating device is specified as an IP address or as “*” (wildcard).
 
    [bookmark: pgfId-1337618]Step 10 In the IGMP field, enter the IGMP group address.
 
    [bookmark: pgfId-1337619]Step 11 In the VLAN field, enter multicast-associated VLAN information.
 
    [bookmark: pgfId-1337620]Step 12 Click Fetch to view the graph.
 
    [bookmark: pgfId-1337621]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1416134]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1416138]Opening the Topology Map
 
     	 [bookmark: pgfId-1416142]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1416146]Using the Viewing Tools
 
     	 [bookmark: pgfId-1416150]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1416154]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416158]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416162]Managing a vPC
 
     	 [bookmark: pgfId-1416166]Finding and Resolving vPC Configuration Inconsistencies
 
     	 [bookmark: pgfId-1416170]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1416174]Loading a Layout
 
    
 
   
 
    
     [bookmark: pgfId-1337512][bookmark: 50266]Launching the vPC Wizard
 
    [bookmark: pgfId-1337513]From the topology map, you can launch the vPC wizard to create a vPC.
 
   
 
    
     [bookmark: pgfId-1267190]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1267191]Determine which two devices you want to use as the vPC peer switches.
 
   
 
    
     [bookmark: pgfId-1267192]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1267194]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1267195]The topology map appears in the Contents pane.
 
    [bookmark: pgfId-1267196]Step 2 Above the map, click PortChannel and vPC.
 
    [bookmark: pgfId-1273560]The map shows the PortChannel and vPC view of the topology.
 icon. 
    
 
    [bookmark: pgfId-1273565]Step 4 Click one device that you want to use as a vPC peer switch.
 
    [bookmark: pgfId-1267203]Step 5 Press and hold the Shift key.
 
    [bookmark: pgfId-1267204]Step 6 Click the device that you want to use as a vPC peer switch.
 
    [bookmark: pgfId-1267205]Step 7 Right-click either device and choose Launch vPC Wizard.
 
    [bookmark: pgfId-1267206]The vPC Creation Wizard dialog box appears.
 
    [bookmark: pgfId-1267209]For more information about using this wizard, see the Interfaces Configuration Guide, Cisco DCNM for LAN.
 
    [bookmark: pgfId-1267214]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1416187]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1416191]Opening the Topology Map
 
     	 [bookmark: pgfId-1416195]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1416199]Using the Viewing Tools
 
     	 [bookmark: pgfId-1416203]Managing a vPC
 
     	 [bookmark: pgfId-1416207]Finding and Resolving vPC Configuration Inconsistencies
 
     	 [bookmark: pgfId-1416211]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416215]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416219]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1416223]Loading a Layout
 
     	 [bookmark: pgfId-1416227]Exporting the Topology as a JPG Image
 
    
 
   
 
    
     [bookmark: pgfId-1267254][bookmark: 55325]Managing a vPC[bookmark: marker-1267253]
 
    [bookmark: pgfId-1267255]From the topology map, you can access the vPC feature for a specific vPC link.
 
   
 
    
     [bookmark: pgfId-1267256]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1267258]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1267259]The topology map appears in the Contents pane.
 
    [bookmark: pgfId-1267260]Step 2 Above the map, click one of the following views:
 
     
      
      	 [bookmark: pgfId-1267261] PortChannel and vPC 
 
      	 [bookmark: pgfId-1267262] Logical vPC View 
 
     
 
    
 
    [bookmark: pgfId-1267263]Step 3 Find the vPC link for the vPC that you want to manage.
 
    [bookmark: pgfId-1377365]Step 4 Use the step that applies to the view that you selected:
 
     
      
      	 [bookmark: pgfId-1267265]PortChannel and vPC—Right-click the ellipse on the vPC link and choose  Manage vPC .
 
      	 [bookmark: pgfId-1267266]Logical vPC View—Right-click the vPC link and choose  Manage vPC .
 
     
 
    
 
    [bookmark: pgfId-1299046]The vPC feature appears. The vPC that you want to manage is selected in the summary table.
 
    [bookmark: pgfId-1299051]For more information about the vPC feature, see the Interfaces Configuration Guide, Cisco DCNM for LAN.
 
    [bookmark: pgfId-1299052]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1416240]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1416244]Opening the Topology Map
 
     	 [bookmark: pgfId-1416248]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1416252]Using the Viewing Tools
 
     	 [bookmark: pgfId-1416256]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1416260]Finding and Resolving vPC Configuration Inconsistencies
 
     	 [bookmark: pgfId-1416264]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416268]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416272]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1416276]Loading a Layout
 
     	 [bookmark: pgfId-1416280]Exporting the Topology as a JPG Image
 
    
 
   
 
    
     [bookmark: pgfId-1267315][bookmark: 32228]Finding and Resolving vPC Configuration Inconsistencies[bookmark: marker-1267314]
 
    [bookmark: pgfId-1267316]You can use the topology map to find vPCs that have configuration inconsistencies and open the Resolve Configuration Inconsistency dialog box.
 
   
 
    
     [bookmark: pgfId-1267317]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1267319]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1267320]The topology map appears in the Contents pane.
 
    [bookmark: pgfId-1267321]Step 2 Above the map, click one of the following views:
 
     
      
      	 [bookmark: pgfId-1267322] PortChannel and vPC 
 
      	 [bookmark: pgfId-1267323] Logical vPC View 
 
     
 
    
 
    [bookmark: pgfId-1267324]Step 3 Find the vPC for which you want to resolve configuration inconsistencies.
 
    [bookmark: pgfId-1267325]If a vPC link has configuration inconsistencies, a red ellipse appears over the link. If you use the PortChannel and vPC view, vPC peer links with configuration inconsistencies also show a red ellipse.
 
    [bookmark: pgfId-1267326]Step 4 (Optional) If you want to resolve configuration inconsistencies now, do one of the following:
 
     
      
      	 [bookmark: pgfId-1267327]To resolve configuration inconsistencies for the vPC link  and the vPC peer link, right-click the red ellipse on the vPC link and choose  Launch Configuration Consistency .
 
      	 [bookmark: pgfId-1267328]To resolve configuration inconsistencies for the vPC peer link only, right-click the red ellipse on the vPC link and choose  Launch Configuration Consistency .
 
     
 
    
 
    [bookmark: pgfId-1267329]The Resolve Configuration Inconsistency dialog box opens.
 
    [bookmark: pgfId-1267337]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1303651][bookmark: 33616]Accessing Remotely Connected CNAs from the Topology Map
 
    [bookmark: pgfId-1377425]You can use the topology map to access servers connected to Cisco Nexus 4000 Series switches.
 
   
 
    
     [bookmark: pgfId-1377446]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1377427]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1377398] The topology map appears in the Contents pane. The topology toolbar appears on the left side of the topology map.
 
    [bookmark: pgfId-1303880]Step 2 Right-click on the switch and then choose Show End Devices.
 
    [bookmark: pgfId-1303902] The Contents pane displays all the servers that are connected to the switch. It displays only the pWWN of the servers because the IP address is not available as a part of the enode information in FIP snooping.
 
    [bookmark: pgfId-1303940]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1304065][bookmark: 86904]Using VSAN Overlay
 
   
 
    
     [bookmark: pgfId-1304066]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1304068]Step 1 From the Feature Selector pane, choose Topology > Topology View.
 
    [bookmark: pgfId-1304126]The topology map appears in the Contents pane.
 
    [bookmark: pgfId-1304155]Step 2 Above the map, click L2 View.
 
    [bookmark: pgfId-1304170]The dialog box appears in the Contents pane.
 
    [bookmark: pgfId-1304187]Step 3 In the dialog box, click VSAN.
 
    [bookmark: pgfId-1304190]Step 4 Enter the range to search (valid values are between 1 and 4094). 
 
    [bookmark: pgfId-1304195]Step 5 Check View mapped VLANs to view the VLANs.
 
    [bookmark: pgfId-1365359]Step 6 Click Fetch.
 
    [bookmark: pgfId-1304201]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1416293]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1416297]Opening the Topology Map
 
     	 [bookmark: pgfId-1416301]Understanding Device Icons and Links
 
     	 [bookmark: pgfId-1416305]Using the Viewing Tools
 
     	 [bookmark: pgfId-1416309]Launching the vPC Wizard
 
     	 [bookmark: pgfId-1416313]Managing a vPC
 
     	 [bookmark: pgfId-1416317]Accessing DCNM-LAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416321]Accessing Cisco DCNM-SAN Features from the Topology Map
 
     	 [bookmark: pgfId-1416325]Moving Devices in the Topology Map
 
     	 [bookmark: pgfId-1416329]Loading a Layout
 
     	 [bookmark: pgfId-1416333]Exporting the Topology as a JPG Image
 
    
 
   
 
    
     [bookmark: pgfId-1400843][bookmark: 12973]Related Documents
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1400847]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1400849]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1400851]VDCs
  
        	[bookmark: pgfId-1400855]Virtual Device Context Configuration Guide, Cisco DCNM for LAN, Release 7.1.x
  
       
 
        
        	[bookmark: pgfId-1400858]vPCs
  
        	[bookmark: pgfId-1400863]Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.1.x
  
       
 
        
        	[bookmark: pgfId-1400865]Configuring LLDP on managed devices
  
        	[bookmark: pgfId-1400869]System Management Configuration Guide, Cisco DCNM for LAN, Release 7.1.x
  
       
 
        
        	[bookmark: pgfId-1400872]Device discovery
  
        	[bookmark: pgfId-1400877]Chapter 27, “Administering Device Discovery”
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1400894][bookmark: 92503]Feature History for Topology
 
     
      
       
       [bookmark: pgfId-1400905]Table 16-1 [bookmark: 50557]Feature History for Topology 
 
       
       
        
        	 
          
          [bookmark: pgfId-1400911]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1400913]Releases 
         
  
        	 
          
          [bookmark: pgfId-1400915]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1400917]Common topology
  
        	[bookmark: pgfId-1400919]5.0(2)
  
        	[bookmark: pgfId-1400921]Support for SAN devices and connections was added.
  
       
 
        
        	[bookmark: pgfId-1400923]Network servers
  
        	[bookmark: pgfId-1400925]5.0(2)
  
        	[bookmark: pgfId-1400927]Support for showing network servers was added.
  
       
 
        
        	[bookmark: pgfId-1400929]DCNM-SAN support
  
        	[bookmark: pgfId-1400931]5.0(2)
  
        	[bookmark: pgfId-1400933]Support for launching the Cisco DCNM-SAN client was added.
  
       
 
        
        	[bookmark: pgfId-1400935]Device groups
  
        	[bookmark: pgfId-1400937]5.0(2)
  
        	[bookmark: pgfId-1400939]Support for device groups was added.
  
       
 
        
        	[bookmark: pgfId-1400941]VSAN Overlay
  
        	[bookmark: pgfId-1400943]5.1(0)
  
        	[bookmark: pgfId-1400945]Support for VSAN overlay was added as a part of the L2 view.
  
       
 
        
        	[bookmark: pgfId-1400947]Discovery of servers connected to Cisco Nexus 5000 series switches via CNAs
  
        	[bookmark: pgfId-1400949]5.1(0)
  
        	[bookmark: pgfId-1400951]Support for discovering servers that are either directly connected to Cisco Nexus 5000 Series switches or CNAs.
  
       
 
        
        	[bookmark: pgfId-1400953]FabricPath support
  
        	[bookmark: pgfId-1400955]5.1(0)
  
        	[bookmark: pgfId-1400957]Support for FabricPath was added.
  
       
 
        
        	[bookmark: pgfId-1405081]Datacenter Grouping
  
        	[bookmark: pgfId-1405083]6.0
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1050709][bookmark: 28199]Working with Inventory 
      
      
 
     
 
 
    [bookmark: pgfId-1170273]This chapter describes how to use the Inventory feature in Cisco Data Center Network Manager for LAN(DCNM-LAN).
 
    [bookmark: pgfId-1170274]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1170278]Information About Inventory
 
     	 [bookmark: pgfId-1170282]Licensing Requirements for Inventory
 
     	 [bookmark: pgfId-1170286]Prerequisites
 
     	 [bookmark: pgfId-1170290]Platform Support
 
     	 [bookmark: pgfId-1170294]Configuring Module Pre-Provisioning
 
     	 [bookmark: pgfId-1163201]Reloading a Line Card
 
     	 [bookmark: pgfId-1161216]Displaying Inventory Information
 
     	 [bookmark: pgfId-1170310]Displaying Power Usage Information
 
     	 [bookmark: pgfId-1170314]Field Descriptions
 
     	 [bookmark: pgfId-1170318]Feature History for Inventory
 
    
 
   
 
    
     [bookmark: pgfId-1170320][bookmark: 33584]Information About Inventory
 
    [bookmark: pgfId-1147206]The Inventory feature displays information about the components that comprise a selected managed device and power usage information for managed Cisco Nexus 7000 Series switches. In addition, it allows you to configure fundamental system parameters on virtual switches, such as the Cisco Nexus 1000V Series switch. For information about configuring virtual switches, see Chapter18, “Managing Virtual Devices”
 
    [bookmark: pgfId-1164255]System-message logging levels for the Inventory feature must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Cisco DCNM Fundamentals Configuration Guide, Release 5.x.
 
    [bookmark: pgfId-1170325]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1170329]Understanding Inventory
 
     	 [bookmark: pgfId-1170333]Understanding Power Usage
 
     	 [bookmark: pgfId-1159964]Module Pre-Provisioning
 
    
 
     
      [bookmark: pgfId-1170344][bookmark: 63754]Understanding Inventory[bookmark: marker-1170343]
 
     [bookmark: pgfId-1170345]The Inventory feature displays summary and detailed information about the chassis, modules, fan trays, and power supplies for managed devices.
 
    
 
     
      [bookmark: pgfId-1170348][bookmark: 20656]Understanding Power Usage[bookmark: marker-1170347]
 
     [bookmark: pgfId-1170349]Cisco DCNM displays information about the power usage of managed Cisco Nexus 7000 Series switches, including an aggregation of the power usage for all managed Cisco Nexus 7000 Series switches, summary information for a specific device, and graphical information for a selected device.
 
     [bookmark: pgfId-1170350]You can configure Cisco DCNM to collect power usage statistics for up to six managed devices.
 
    
 
     
      [bookmark: pgfId-1159800][bookmark: 46325]Module Pre-Provisioning
 
      
       
     
 
     
 
     [bookmark: pgfId-1160311]Note This feature is supported only on the Cisco Nexus 5000 Series switches.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1159802]The pre-provisioning feature allows you to preconfigure interfaces before inserting or attaching a module to a Cisco Nexus 5000 Series switch. If a module goes offline, you can use pre-provisioning to make changes to the interface configurations for the offline module. When a pre-provisioned module comes online, the pre-provisioning configurations are applied. If any configurations were not applied, a syslog is generated. The syslog lists the configurations that were not accepted.
 
     [bookmark: pgfId-1159804]In some Virtual Port Channel (vPC) topologies, pre-provisioning is required for the configuration synchronization feature. Pre-provisioning allows you to synchronize the configuration for an interface that is online with one peer but offline with another peer.
 
    
 
     
      [bookmark: pgfId-1159806]Supported Hardware
 
     [bookmark: pgfId-1159807]The pre-provisioning feature supports the following hardware:
 
      
      	 [bookmark: pgfId-1159811]N2K-C2148T Fabric Extender 48x1G 4x10G Module
 
      	 [bookmark: pgfId-1159813]N2K-C2232P Fabric Extender 32x10G Module
 
      	 [bookmark: pgfId-1159815]N2K-C2248T Fabric Extender 48x1G 4x10G Module
 
      	 [bookmark: pgfId-1159817]N51-M16EP Cisco 16x10-Gigabit Ethernet Expansion Module
 
      	 [bookmark: pgfId-1159819]N51-M8E8FP Cisco 8-port 1/2/4/8G FC and 8 Port 10-Gigabit Ethernet Expansion Module
 
      	 [bookmark: pgfId-1159821]N5K-M1008 Cisco 8-port Fiber Channel Expansion Module 8 x SFP
 
      	 [bookmark: pgfId-1159823]N5K-M1060 Cisco 6-port Fiber Channel Expansion Module 6 x SFP
 
      	 [bookmark: pgfId-1159825]N5K-M1404 Expansion Module 4 x 10GBase-T LAN, 4 x Fiber Channel
 
      	 [bookmark: pgfId-1159827]N5K-M1600 Cisco 6-port 10-Gigabit Ethernet SFP Module 6 x SFP
 
     
 
    
 
     
      [bookmark: pgfId-1159829]Upgrades and Downgrades
 
     [bookmark: pgfId-1159830]When upgrading from Cisco NX-OS Release 4.2(1)N2(1) and earlier releases to Cisco NX-OS Release 5.0(2)N1(1), there are no configuration implications. When upgrading from a release that supports pre-provisioning to another release that supports the feature including in-service software upgrades (ISSUs), pre-provisioned configurations are retained across the upgrade. 
 
     [bookmark: pgfId-1159832]When downgrading from an image that supports pre-provisioning to an image that does not support pre-provisioning, you are prompted to remove pre-provisioning configurations.
 
     [bookmark: pgfId-1161270]
 
    
 
   
 
    
     [bookmark: pgfId-1170357][bookmark: 88940]Licensing Requirements for Inventory[bookmark: marker-1170356]
 
    [bookmark: pgfId-1170358]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1170375]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1170361]Product 
         
  
        	 
          
          [bookmark: pgfId-1170363]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1170365]Cisco DCNM
  
        	[bookmark: pgfId-1170367]Inventory requires no license. Any feature not included in a license package is bundled with Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
        
        	[bookmark: pgfId-1170372]Cisco NX-OS
  
        	[bookmark: pgfId-1170374]Inventory requires no license. Any feature not included in a license package is bundled with the Cisco NX-OS system images and is provided at no extra charge to you. For an explanation of the Cisco NX-OS licensing scheme for your platform, see the licensing guide for your platform. 
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1170377][bookmark: 70508]Prerequisites
 
    [bookmark: pgfId-1170378]The Inventory feature has the following prerequisite (for a full list of feature-specific prerequisites, see the platform-specific documentation):
 
     
     	 [bookmark: pgfId-1170379]System-message logging levels for the Inventory feature must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 5.x .
 
    
 
   
 
    
     [bookmark: pgfId-1170381][bookmark: 29649]Platform Support
 
    [bookmark: pgfId-1170382]The following platforms support this feature but may implement it differently. For platform-specific information, including guidelines and limitations, system defaults, and configuration limits, see the corresponding documentation. 
 
    [bookmark: pgfId-1170415]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1170385]Platform 
         
  
        	 
          
          [bookmark: pgfId-1170387]Documentation 
         
  
       
 
        
        	[bookmark: pgfId-1170393]Cisco Nexus 1000V Series switches1
  
        	[bookmark: pgfId-1170396]Cisco Nexus 1000V Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1170398]Cisco Nexus 3000 Series switches
  
        	[bookmark: pgfId-1170401]Cisco Nexus 3000 Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1170406]Cisco Nexus 4000 Series switches1
  
        	[bookmark: pgfId-1170409]Cisco Nexus 4000 Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1170411]Cisco Nexus 7000 Series switches
  
        	[bookmark: pgfId-1170414]Cisco Nexus 7000 Series Switch Documentation
  
       
 
       
     
 
    
 
     
      
       
       	 1.[bookmark: pgfId-1170392][bookmark: 54604]The power usage feature is supported only on the Cisco Nexus 7000 Series switch.
  
      
 
      
    
 
   
 
    
     [bookmark: pgfId-1162381][bookmark: 57532]Configuring [bookmark: marker-1163094]Module Pre-Provisioning
 
     
      
    
 
    
 
    [bookmark: pgfId-1162773]Note This feature is supported only on the Cisco Nexus 5000 Series switches.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1162382]The module pre-provisioning feature allows you to pre-provision a new module or a module that is present on the switch but is in a offline state.
 
    [bookmark: pgfId-1162383]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1162387]Pre-Provisioning Offline Modules
 
     	 [bookmark: pgfId-1162391]Pre-Provisioning Online Modules
 
     	 [bookmark: pgfId-1162395]Pre-Provisioning FEX Modules
 
    
 
     
      [bookmark: pgfId-1162397][bookmark: 68147]Pre-Provisioning [bookmark: marker-1163095]Offline Modules
 
      
       
     
 
     
 
     [bookmark: pgfId-1162809]Note This feature is supported only on the Cisco Nexus 5000 Series switches.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1162398]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1162399]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1162400]The summary chassis information for each of the managed device is displayed in the Summary pane.
 
     [bookmark: pgfId-1162401]You can view the list of offline modules already configured for pre-provisioning.
 
     [bookmark: pgfId-1162402]Step 2 (Optional) From the Summary pane, in the Module Type drop-down list, choose the module type of the pre-provisioned slot you want to edit edit in the Details tab.
 
     [bookmark: pgfId-1162403]Step 3 Choose a chassis.
 
     [bookmark: pgfId-1162404]Step 4 Expand the chassis and click Add New Provisioned Slot.
 
     [bookmark: pgfId-1162405]Step 5 (Optional) In the pre-provisioned slot, expand the chassis and click Delete Slot. 
 
     [bookmark: pgfId-1162406]The offline module is disabled. 
 
     [bookmark: pgfId-1162407]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1162409][bookmark: 21981]Pre-Provisioning [bookmark: marker-1163096]Online Modules
 
      
       
     
 
     
 
     [bookmark: pgfId-1162956]Note This feature is supported only on the Cisco Nexus 5000 Series switches.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1162410]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1162411]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1162412]The summary chassis information for each of the managed device is displayed in the Summary pane.
 
     [bookmark: pgfId-1162413]Step 2 From the Summary pane, choose a chassis.
 
     [bookmark: pgfId-1162414]Step 3 Expand the chassis and choose a card type that corresponds to the online module.
 
     [bookmark: pgfId-1162415]Step 4 From the Details pane, click on the pre-provisioning drop-down list.
 
     [bookmark: pgfId-1162416]You can enable or disable the pre-provisioning.
 
     [bookmark: pgfId-1162417]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1162419][bookmark: 28500]Pre-Provisioning [bookmark: marker-1163097]FEX Modules
 
      
       
     
 
     
 
     [bookmark: pgfId-1162990]Note This feature is supported only on the Cisco Nexus 5000 Series switches.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1162420]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1162421]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1162422]The summary chassis information for each of the managed device is displayed in the Summary pane.
 
     [bookmark: pgfId-1162423]Step 2 From the Summary pane, choose a FEX module.
 
     [bookmark: pgfId-1162424]Step 3 Expand the FEX chassis and choose a card type that corresponds to the online module.
 
     [bookmark: pgfId-1162425]Step 4 From the Details pane, click on the pre-provisioning drop-down list.
 
     [bookmark: pgfId-1162426]You can enable or disable the pre-provisioning.
 
     [bookmark: pgfId-1162427]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1162428][bookmark: marker-1163098][bookmark: 68455]Reloading a Line Card
 
     
      
    
 
    
 
    [bookmark: pgfId-1162714]Note This feature is supported only on the Cisco Nexus 7000 Series device. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1162429]Beginning with Cisco DCNM Release 5.2(1), you can individually restart any line card in the device without affecting the operational state of other components in the switch. 
 
     
      [bookmark: pgfId-1162431]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1162432]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1162433]The summary chassis information for each of the managed device is displayed in the Summary pane.
 
     [bookmark: pgfId-1162434]Step 2 From the Summary pane, choose a chassis.
 
     [bookmark: pgfId-1162435]Step 3 Expand the chassis and choose a card type.
 
     [bookmark: pgfId-1162436]Step 4 Right-click the card type that you want and choose Reload.
 
     [bookmark: pgfId-1162437]A dialog box appears warning you that after the line card reload, the device will be rediscovered.
 
     [bookmark: pgfId-1162438]Step 5 Click Yes or No to confirm your decision.
 
     [bookmark: pgfId-1162439]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1162357][bookmark: 48666][bookmark: 90833]Displaying Inventory Information
 
    [bookmark: pgfId-1147340]The Inventory feature displays summary and detailed information about the chassis, modules, fan trays, and power supplies for managed devices.
 
    [bookmark: pgfId-1170426]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1170430]Displaying the Chassis Information
 
     	 [bookmark: pgfId-1170434]Displaying the Module Information
 
     	 [bookmark: pgfId-1170438]Displaying the Power Supply Information
 
     	 [bookmark: pgfId-1170442]Displaying the Fan Tray Information
 
    
 
     
      [bookmark: pgfId-1139822][bookmark: 73749]Displaying the Chassis Information[bookmark: marker-1140578]
 
     [bookmark: pgfId-1065854]Cisco DCNM displays summary, detail, environmental, and event information for the chassis. 
 
    
 
     
      [bookmark: pgfId-1069100]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1065869]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1065870]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1065871]Step 2 To display additional information about a chassis, click the device.
 
     [bookmark: pgfId-1124435]Tabs appear in the Details pane with the Details tab selected.
 
     [bookmark: pgfId-1124445]Step 3 Click one of the following tabs:
 
      
       
       	 [bookmark: pgfId-1140668] Details —Displays detailed hardware and software information.[bookmark: marker-1140667]
 
       	 [bookmark: pgfId-1140669] Environmental Status —Displays power usage and redundancy information[bookmark: marker-1140691].
 
       	 [bookmark: pgfId-1140670] CPU Utilization —Displays collected statistics showing the percentage of utilization devoted to user or kernel functions. For more information on collecting statistics for this feature, see the “Working with Statistics and Charts” section.[bookmark: marker-1140692]
 
       	 [bookmark: pgfId-1124521] Memory Utilization —Displays collected statistics showing the memory utilization within specific thresholds. For more information on collecting statistics for this feature, see the “Working with Statistics and Charts” section.[bookmark: marker-1140693]
 
       	 [bookmark: pgfId-1125516] Events —Displays the chassis events, which includes the source, time, severity, message, and status of the event. To see details for the event, select the event in the Details pane and click the up arrow at the bottom of the details pane.[bookmark: marker-1140694]
 
      
 
     
 
     [bookmark: pgfId-1065875]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1164276]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1164280]Displaying the Module Information
 
      	 [bookmark: pgfId-1164284]Displaying the Power Supply Information
 
      	 [bookmark: pgfId-1164288]Displaying the Fan Tray Information
 
     
 
    
 
     
      [bookmark: pgfId-1058875][bookmark: 16074]Displaying the Module Information[bookmark: marker-1140579]
 
     [bookmark: pgfId-1126579]Cisco DCNM displays summary, detail, environmental, and event information for the supervisor modules, I/O modules, and fabric modules.
 
    
 
     
      [bookmark: pgfId-1069186]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1065995]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1065996]Summary chassis information, including module description, product ID, serial number, hardware version, software version, status, temperature, and events, for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1065997]Step 2 From the Summary pane, expand the device.
 
     [bookmark: pgfId-1066060]The device listing expands to include a summary of each module, power supply, and fan tray in the chassis.
 
     [bookmark: pgfId-1066099]Step 3 Click the module.
 
     [bookmark: pgfId-1066116]Tabs appear in the Details pane with the Details tab selected. 
 
     [bookmark: pgfId-1126524]Step 4 Click one of the following tabs:
 
      
       
       	 [bookmark: pgfId-1126502] Details —Displays general identification information and special information for the selected module type.[bookmark: marker-1140695]
 
       	 [bookmark: pgfId-1127277] Environmental Status —Displays environmental status information for the selected supervisor module, I/O module, or fabric module. To see textual temperature information, expand the Temperature Status Table section. To see graphical temperature information, expand the Temperature Status Thermometer section.[bookmark: marker-1140696]
 
       	 [bookmark: pgfId-1127758] TCAM Statistics —Displays collected information about TCAM usage on the module. For more information on collecting statistics for this feature, see the “Working with Statistics and Charts” section.[bookmark: marker-1140697]
 
       	 [bookmark: pgfId-1126569] Events —Displays event information for the selected supervisor module, I/O module, or fabric module. To see details for an event, click on the event and click the up arrow button at the bottom of the pane.[bookmark: marker-1140698]
 
      
 
     
 
     [bookmark: pgfId-1065999]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1164301][bookmark: 83629]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1164305]Displaying the Chassis Information
 
      	 [bookmark: pgfId-1164309]Displaying the Power Supply Information
 
      	 [bookmark: pgfId-1164313]Displaying the Fan Tray Information
 
     
 
    
 
     
      [bookmark: pgfId-1059166][bookmark: 59844]Displaying the Power Supply Information[bookmark: marker-1140580]
 
     [bookmark: pgfId-1128464]Cisco DCNM displays summary information, general details, and events for power supplies.
 
    
 
     
      [bookmark: pgfId-1069354]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1069355]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1069356]Summary chassis information for each managed device appears in the Summary pane.
 
     [bookmark: pgfId-1069357]Step 2 From the Summary pane, expand the device.
 
     [bookmark: pgfId-1069359]The device listing expands to include a summary of each module, power supply, and fan tray in the chassis.
 
     [bookmark: pgfId-1069360]Step 3 Click the power supply.
 
     [bookmark: pgfId-1069361]Tabs appear in the Details pane with the Details tab selected. 
 
     [bookmark: pgfId-1128513]Step 4 Click one of the following tabs:
 
      
       
       	 [bookmark: pgfId-1128523] Details —Displays information including general identification information, power (watts), and current (Amps)[bookmark: marker-1128548].
 
       	 [bookmark: pgfId-1128747] Events —Displays event information, including source, time, severity, message, and status information for the events. To see details for an event, click on the event and click the up arrow button at the bottom of the pane. A field opens to display detailed event information.[bookmark: marker-1140702]
 
      
 
     
 
     [bookmark: pgfId-1069362]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1164318]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1164322]Displaying the Chassis Information
 
      	 [bookmark: pgfId-1164326]Displaying the Module Information
 
      	 [bookmark: pgfId-1164330]Displaying the Fan Tray Information
 
     
 
    
 
     
      [bookmark: pgfId-1129469][bookmark: 40502]Displaying the Fan Tray Information[bookmark: marker-1140581]
 
     [bookmark: pgfId-1129492]Cisco DCNM displays summary information, general details, and events for fan trays.
 
    
 
     
      [bookmark: pgfId-1070268]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1070270]Step 1 From the Feature Selector pane, choose Inventory. 
 
     [bookmark: pgfId-1070271]Chassis summary information for the device appears in the Summary pane.
 
     [bookmark: pgfId-1070272]Step 2 From the Summary pane, expand the device.
 
     [bookmark: pgfId-1070273]A list of modules, power supplies, and fan trays appears under the device in the Summary pane. Each row includes summary information for the component.
 
     [bookmark: pgfId-1129698]Step 3 Click a fan tray.
 
     [bookmark: pgfId-1129718]Tabs appear in the Details pane with the Details tab selected.
 
     [bookmark: pgfId-1129776]Step 4 Click one of the following tabs:
 
      
       
       	 [bookmark: pgfId-1129777] Details —Displays descriptive information and status for the fan tray[bookmark: marker-1129826].
 
       	 [bookmark: pgfId-1129840] Events —Displays event information including the source, time, severity, message, and status of the event. You can display details for each event[bookmark: marker-1129886].
 
      
 
     
 
     [bookmark: pgfId-1129700]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1164335]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1164339]Displaying the Chassis Information
 
      	 [bookmark: pgfId-1164343]Displaying the Module Information
 
      	 [bookmark: pgfId-1164347]Displaying the Power Supply Information
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1120314][bookmark: 61323]Displaying Power Usage Information
 
    [bookmark: pgfId-1131679]Cisco DCNM displays summary and detailed information about the power usage for one or more managed devices in your network. It also displays the aggregated power usage information of all the managed Cisco Nexus 7000 Series switches. You can configure Cisco DCNM to collect power usage statistics for up to six managed devices.
 
    [bookmark: pgfId-1170447]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1170451]Displaying Power Usage Summary Information
 
     	 [bookmark: pgfId-1170455]Displaying Power Usage Details
 
     	 [bookmark: pgfId-1170459]Displaying Power Usage Statistics
 
    
 
     
      [bookmark: pgfId-1146176][bookmark: 87731]Displaying Power Usage Summary Information[bookmark: marker-1146175]
 
     [bookmark: pgfId-1146177]Cisco DCNM displays summary information about the total power capacity and the power drawn, allocated, and available for aggregated power usage information of all the managed Cisco Nexus 7000 Series devices and for each managed device.
 
    
 
     
      [bookmark: pgfId-1131504]DETAILED STEPS
 
     [bookmark: pgfId-1131505]To display power usage summary information, from the Feature Selector pane, choose Inventory > Power Usage. Aggregated power usage information for all managed Cisco Nexus 7000 Series switches and power usage information for each managed device displays in the Summary pane.
 
    
 
     
      [bookmark: pgfId-1164352]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1164356]Displaying Power Usage Details
 
      	 [bookmark: pgfId-1164360]Displaying Power Usage Statistics
 
     
 
    
 
     
      [bookmark: pgfId-1120591][bookmark: 68050]Displaying Power Usage Details[bookmark: marker-1140583]
 
     [bookmark: pgfId-1133823]You can display graphical details about the power usage for one or more managed devices in your network. The graphical information includes bar and pie charts. The bar chart shows the total capacity (watts), total allocated (watts), and total drawn/usage (watts) for the top or bottom five devices based on the power consumed by the devices. The top five starts with the device that consumes the maximum power. The pie chart shows the total drawn/used power and unused power for the selected devices.
 
    
 
     
      [bookmark: pgfId-1120382]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1120572]Step 1 From the Feature Selector pane, choose Inventory > Power Usage.
 
     [bookmark: pgfId-1131251]Summary power usage information for the entire network and each managed device displays in the Summary pane.
 
     [bookmark: pgfId-1131252]Step 2 From the Summary pane, click the entire network or one or more devices.
 
     [bookmark: pgfId-1131253]The Details tab displays graphical details about the power usage for selected devices.
 
     [bookmark: pgfId-1131012]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1164365]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1164369]Displaying Power Usage Summary Information
 
      	 [bookmark: pgfId-1164373]Displaying Power Usage Statistics
 
     
 
    
 
     
      [bookmark: pgfId-1140181][bookmark: 75239]Displaying Power Usage Statistics[bookmark: marker-1140584]
 
     [bookmark: pgfId-1140200]The following window appears in the Statistics tab: 
 
      
      	 [bookmark: pgfId-1140203]Power Usage Statistics Chart—Displays statistics on the total capacity (watts), total drawn (watts), total allocated (watts), and total available (watts) for up to six managed devices.
 
     
 
    
 
     
      [bookmark: pgfId-1164386]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1164390]Displaying Power Usage Summary Information
 
      	 [bookmark: pgfId-1164394]Displaying Power Usage Details
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1170465][bookmark: 72505]Field Descriptions
 
    [bookmark: pgfId-1170466]This section includes the following field descriptions for the Inventory and Power Usage features:
 
     
     	 [bookmark: pgfId-1170470]Inventory: Details: Hardware Section
 
     	 [bookmark: pgfId-1170474]Inventory: Details: Software Section
 
     	 [bookmark: pgfId-1170478]Inventory: Power Usage
 
    
 
     
      [bookmark: pgfId-1170480][bookmark: 78770]Inventory: Details: Hardware Section
 
     [bookmark: pgfId-1170506]
 
      
       
        
        [bookmark: pgfId-1170483]Table 17-1 Inventory: Details: Hardware Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1170487]Field 
          
  
         	 
           
           [bookmark: pgfId-1170489]Description 
          
  
        
 
         
         	[bookmark: pgfId-1170491]Switch Name
  
         	[bookmark: pgfId-1170493]Hostname assigned to the device.
  
        
 
         
         	[bookmark: pgfId-1170495]Description
  
         	[bookmark: pgfId-1170497]Word or phrase that describes the device.
  
        
 
         
         	[bookmark: pgfId-1170499]Product ID
  
         	[bookmark: pgfId-1170501]ID number for the device.
  
        
 
         
         	[bookmark: pgfId-1170503]Serial Number
  
         	[bookmark: pgfId-1170505]Serial number of the device.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1170508][bookmark: 79277]Inventory: Details: Software Section
 
     [bookmark: pgfId-1170554]
 
      
       
        
        [bookmark: pgfId-1170511]Table 17-2 Inventory: Details: Software Section
 
        
        
         
         	 
           
           [bookmark: pgfId-1170515]Field 
          
  
         	 
           
           [bookmark: pgfId-1170517]Description 
          
  
        
 
         
         	[bookmark: pgfId-1170519]System Uptime
  
         	[bookmark: pgfId-1170521]Date and time when the device was last uploaded.
  
        
 
         
         	 
           
           [bookmark: pgfId-1170523]System Image 
          
  
        
 
         
         	[bookmark: pgfId-1170527]Image Name
  
         	[bookmark: pgfId-1170529]Name of the image running on the device.
  
        
 
         
         	[bookmark: pgfId-1170531]Location
  
         	[bookmark: pgfId-1170533]Directory where the system image resides.
  
        
 
         
         	[bookmark: pgfId-1170535]Version
  
         	[bookmark: pgfId-1170537]Version number of the image running on the device.
  
        
 
         
         	 
           
           [bookmark: pgfId-1170539]Kickstart Image 
          
  
        
 
         
         	[bookmark: pgfId-1170543]Image Name
  
         	[bookmark: pgfId-1170545]Name of the kickstart image file.
  
        
 
         
         	[bookmark: pgfId-1170547]Location
  
         	[bookmark: pgfId-1170549]Directory where the kickstart image resides.
  
        
 
         
         	[bookmark: pgfId-1170551]Version
  
         	[bookmark: pgfId-1170553]Version number of the kickstart image file.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1170556][bookmark: 31096]Inventory: Power Usage
 
     [bookmark: pgfId-1170597]
 
      
       
        
        [bookmark: pgfId-1170562]Table 17-3 Inventory: Power Usage 
 
        
        
         
         	 
           
           [bookmark: pgfId-1170566]Field 
          
  
         	 
           
           [bookmark: pgfId-1170568]Description 
          
  
        
 
         
         	[bookmark: pgfId-1170570]Name
  
         	[bookmark: pgfId-1170572]Name of the device group or device.
  
        
 
         
         	[bookmark: pgfId-1170574]Total Capacity (Watts)
  
         	[bookmark: pgfId-1170576]Total power capacity for all devices in the group or total power capacity of a device. 
  
        
 
         
         	[bookmark: pgfId-1170578]Total Drawn/Usage (Watts)
  
         	[bookmark: pgfId-1170580]Total power used by all devices in the group or total power used by all the modules in a device.
  
        
 
         
         	[bookmark: pgfId-1170582]Total Drawn/Usage (%)
  
         	[bookmark: pgfId-1170584]Percentage of power used by all devices in the group or percentage of power used by all modules in a device.
  
        
 
         
         	[bookmark: pgfId-1170586]Total Allocated (Watts)
  
         	[bookmark: pgfId-1170588]Total power allocated for all devices in the group or total power allocated for all the modules in a device.
  
        
 
         
         	[bookmark: pgfId-1170590]Total Available (Watts) 
  
         	[bookmark: pgfId-1170592]Total power available for all devices in the group or total power available for additional modules in a device.
  
        
 
         
         	[bookmark: pgfId-1170594]Last Refresh Time
  
         	[bookmark: pgfId-1170596]Time when the power usage information was last updated in Cisco DCNM.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1170600][bookmark: 33575]Feature History for Inventory[bookmark: marker-1170599]
 
    [bookmark: pgfId-1170604]Table 17-4 lists the release history for this feature.
 
    [bookmark: pgfId-1170649]
 
     
      
       
       [bookmark: pgfId-1170608]Table 17-4 [bookmark: 50557]Feature History for Inventory 
 
       
       
        
        	 
          
          [bookmark: pgfId-1170614]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1170616]Releases 
         
  
        	 
          
          [bookmark: pgfId-1170618]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1170620]Module Pre-provisioning
  
        	[bookmark: pgfId-1170622]5.2(1)
  
        	[bookmark: pgfId-1170624]Support was added only for the Cisco Nexus 5000 Series switches.
  
       
 
        
        	[bookmark: pgfId-1170626]Inventory
  
        	[bookmark: pgfId-1170628]5.2(1)
  
        	[bookmark: pgfId-1170630]Support was added for Cisco Nexus 3000 Series switches.
  
       
 
        
        	[bookmark: pgfId-1170632]Inventory
  
        	[bookmark: pgfId-1170634]5.1(1)
  
        	[bookmark: pgfId-1170636]No change from Release 5.0.
  
       
 
        
        	[bookmark: pgfId-1170638]Power Usage
  
        	[bookmark: pgfId-1170640]5.0(2)
  
        	[bookmark: pgfId-1170642]This feature was introduced.
  
       
 
        
        	[bookmark: pgfId-1170644]Inventory
  
        	[bookmark: pgfId-1170646]4.2(1)
  
        	[bookmark: pgfId-1170648]Support was added for Cisco Nexus 5000 Series switches and Nexus 2000 Series Fabric Extenders.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1091586]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1225488][bookmark: 28199]Managing Virtual Devices 
      
      
 
     
 
 
    [bookmark: pgfId-1235648]This chapter describes virtual device contexts (VDCs) supported on Cisco NX-OS devices.
 
    [bookmark: pgfId-1225543]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1225489]Managing Virtual Switches
 
     	 [bookmark: pgfId-1225500]Creating VDCs with the VDC Setup Wizard
 
     	 [bookmark: pgfId-1225528]Creating VDCs with the VDC Setup Wizard
 
    
 
    [bookmark: pgfId-1235674]For detailed configuration guide, please refer to Virtual Device Context Configuration Guide, Cisco DCNM for LAN, Release 7.x.
 
   
 
    
     [bookmark: pgfId-1225492][bookmark: 62177]Managing Virtual Switches
 
    [bookmark: pgfId-1202519]The Cisco Nexus 1000V is a virtual access software switch that works with VMware vSphere 4.0 and has the following components: 
 
     
     	 [bookmark: pgfId-1202520]Virtual Supervisor Module (VSM)—Control plane of the switch and a virtual machine that runs Cisco NX-OS. 
 
     	 [bookmark: pgfId-1202521]Virtual Ethernet Module (VEM) —Virtual line card embedded in each VMware vSphere (ESX) host. 
 
    
 
    [bookmark: pgfId-1202522]Managing a virtual switch involves configuring its domain and server connections. 
 
    [bookmark: pgfId-1202526]A domain is an instance of a Cisco Nexus 1000V Series switch device, including dual redundant VSMs and managed VEMs, within a VMware vCenter server. Each domain is distinguished by a unique integer called the domain identifier. 
 
    [bookmark: pgfId-1233522]In order for the Cisco Nexus 1000V to connect to a vCenter Server or an ESX server, you must first define the connection parameters. All communication with the vCenter Server is secured by the Transport Layer Security (TLS) protocol.
 
    [bookmark: pgfId-1233523]This chapter in Virtual Device Context Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to manage virtual switches using Cisco Data Center Network Manager (DCNM).
 
   
 
    
     [bookmark: pgfId-1217651][bookmark: 47637]Creating VDCs with the VDC Setup Wizard
 
    [bookmark: pgfId-1235564]This chapter in Virtual Device Context Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to create virtual device contexts (VDCs) on Cisco NX-OS devices.
 
    [bookmark: pgfId-1235585]This chapter in Virtual Device Context Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to create virtual device contexts (VDCs) on Cisco Data Center Network Manager (DCNM). In Cisco NX-OS, only a user with the network-admin role can create VDCs. You can create up to three VDCs. Beginning with the Cisco NX-OS Release 5.2(1), you can run FCoE on the Cisco Nexus 7000 Series devices. You must create a storage VDC to run FCoE. The storage VDC cannot be the default VDC and you can have one storage VDC on the device. 
 
   
 
    
     [bookmark: pgfId-1235636]Managing VDCs
 
    [bookmark: pgfId-1217652]This chapter in Virtual Device Context Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to manage virtual device contexts (VDCs) on Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1217653]This chapter describes how to manage virtual device contexts (VDCs) on Cisco NX-OS devices. 
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1450444][bookmark: 73876][bookmark: 72806]Configuring Interfaces on DCNM-LAN Client 
      
      
 
     
 
 
    [bookmark: pgfId-1751356]Cisco NX-OS supports multiple configuration parameters for each of the interface types supported. Most of these parameters are covered in this guide but some are described in other documents. 
 
    [bookmark: pgfId-1751360]Table 19-1 shows where to get further information on the parameters you can configure for an interface.
 
    [bookmark: pgfId-1751521]
 
     
      
       
       [bookmark: pgfId-1751367]Table 19-1 Interface Parameters[bookmark: 50775] 
 
       
       
        
        	 
          
          [bookmark: pgfId-1751373]Feature 
         
  
        	 
          
          [bookmark: pgfId-1751375]Parameters 
         
  
        	 
          
          [bookmark: pgfId-1751377]Further Information 
         
  
       
 
        
        	[bookmark: pgfId-1751379]Basic parameters
  
        	[bookmark: pgfId-1751381]description, duplex, error disable, flow control, MTU, beacon
  
        	[bookmark: pgfId-1751385]Configuring Basic Interface Parameters of this document
  
       
 
        
        	 [bookmark: pgfId-1751388]Layer 2
  
        	[bookmark: pgfId-1751390]Layer 2 access and trunk port settings 
  
        	[bookmark: pgfId-1751395]Configuring Layer 2 Interfaces of this document
  
       
 
        
        	[bookmark: pgfId-1751399]Layer 2 MAC, VLANs, private VLANs, Rapid PVST+, Multiple Spanning Tree, Spanning Tree Extensions
  
        	[bookmark: pgfId-1751403]Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.1.xCisco Nexus 7000 Series NX-OS Layer 2 Switching Configuration Guide, Release 5.x
  
       
 
        
        	[bookmark: pgfId-1751411]Port security
  
        	[bookmark: pgfId-1751415]Security Configuration Guide, Cisco DCNM for LAN, Release 7.1.xCisco Nexus 7000 Series NX-OS Security Configuration Guide, Release 5.x
  
       
 
        
        	 [bookmark: pgfId-1751421]Layer 3
  
        	[bookmark: pgfId-1751423]medium, IPv4 and IPv6 addresses
  
        	[bookmark: pgfId-1751428]Configuring Layer 3 Interfaces of this document
  
       
 
        
        	[bookmark: pgfId-1751432]bandwidth, delay, IP routing, VRFs
  
        	[bookmark: pgfId-1751436]Cisco Nexus 7000 Series NX-OS Unicast Routing Configuration Guide, Release 5.x 
 [bookmark: pgfId-1751440]Cisco Nexus 7000 Series NX-OS Multicast Routing Configuration Guide, Release 5.x 
  
       
 
        
        	[bookmark: pgfId-1751443]Port Channels
  
        	[bookmark: pgfId-1751445]channel group, LACP
  
        	[bookmark: pgfId-1751450]Configuring Port Channels of this document
  
       
 
        
        	[bookmark: pgfId-1751452]vPCs
  
        	[bookmark: pgfId-1751454]Virtual port channels
  
        	[bookmark: pgfId-1751459]Configuring vPCs of this document
  
       
 
        
        	[bookmark: pgfId-1751461]Tunnels
  
        	[bookmark: pgfId-1751463]GRE Tunneling
  
        	[bookmark: pgfId-1751468]Configuring IP Tunnels of this document
  
       
 
        
        	[bookmark: pgfId-1751470]Security
  
        	[bookmark: pgfId-1751472]Dot1X, NAC, EOU, port security
  
        	[bookmark: pgfId-1751476]Security Configuration Guide, Cisco DCNM for LAN, Release 7.1.xCisco Nexus 7000 Series NX-OS Security Configuration Guide, Release 5.x
  
       
 
        
        	[bookmark: pgfId-1751483][bookmark: marker-1751482]FCoE
  
        	[bookmark: pgfId-1751485]Beginning with Cisco NX-OS Release 5.2(1), you can run Fibre Channel over Ethernet (FCoE) on the Cisco Nexus 7000 Series switch
  
        	[bookmark: pgfId-1751492]Cisco NX-OS FCoE Configuration Guide for Cisco Nexus 7000 and Cisco MDS 9500
  
       
 
        
        	[bookmark: pgfId-1751495]Virtual Ethernet Interfaces
  
        	[bookmark: pgfId-1751497]Logical interfaces that correspond to a switch interface connected to a virtual port
  
        	[bookmark: pgfId-1751501] Configuring Virtual Ethernet Interfacesof this document
  
       
 
        
        	[bookmark: pgfId-1751504]Fabric Extenders
  
        	[bookmark: pgfId-1751506]High-density, low-cost connectivity for server aggregation
  
        	[bookmark: pgfId-1751511]Configuring Fabric Extenders of this document
  
       
 
        
        	[bookmark: pgfId-1751513]Port Profiles
  
        	[bookmark: pgfId-1751515]A mechanism for simplifying the configuration of interfaces.
  
        	[bookmark: pgfId-1751520]Configuring Port Profiles of this document
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1751522]This chapter includes the following topics:
 
     
     	 [bookmark: pgfId-1608312]Configuring Basic Interface Parameters
 
     	 [bookmark: pgfId-1753164]Configuring Layer 2 Interfaces
 
     	 [bookmark: pgfId-1749026]Configuring Layer 3 Interfaces
 
     	 [bookmark: pgfId-1751067]Configuring Port Channels
 
     	 [bookmark: pgfId-1751116]Configuring vPCs
 
     	 [bookmark: pgfId-1751145]Configuring IP Tunnels
 
     	 [bookmark: pgfId-1751166]Configuring Virtual Ethernet Interfaces
 
     	 [bookmark: pgfId-1751181]Configuring Fabric Extenders
 
     	 [bookmark: pgfId-1755910]Configuring Port Profiles
 
    
 
    [bookmark: pgfId-1755922]For detailed information about the configuration of the interface on DCNM-LAN client, see the Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x.
 
   
 
    
     [bookmark: pgfId-1755915][bookmark: 81959]Configuring Basic Interface Parameters
 
    [bookmark: pgfId-1754344]This chapter in Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure the basic interface parameters for interfaces managed by Cisco Data Center Network Manager (DCNM) on Cisco NX-OS devices.
 
     
      
    
 
    
 
    [bookmark: pgfId-1754345]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this chapter. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1555822]Many Layer 2 and Layer 3 interfaces are configured with the same parameters. When you configure these parameters, your settings affect the other interfaces that use those parameters. 
 
   
 
    
     [bookmark: pgfId-1754294][bookmark: 14437]Configuring Layer 2 Interfaces
 
     
      
    
 
    
 
    [bookmark: pgfId-1550143]Note Beginning with Cisco Release 5.2, the Cisco Nexus 7000 Series devices support [bookmark: marker-1550144]FabricPath Layer 2 interfaces. See the Cisco Nexus 7000 Series NX-OS FabricPath Command Reference for complete information about the FabricPath feature and interfaces.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1550148]This chapter in Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure Layer 2 switching ports as access or trunk ports on Cisco NX-OS devices using Cisco Data Center Network Manager (DCNM).
 
     
      
    
 
    
 
    [bookmark: pgfId-1535382]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this chapter. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1535384]Layer 2 interfaces [bookmark: marker-1535383]are used for switching packets. You can configure a Layer 2 port as an access port, which carries only one VLAN, or a trunk port, which carries many VLANs. By default, a trunk port carries all VLANs that are configured on the device, and you configure the trunk port to carry only those VLANs that you want on that port. The device uses IEEE 802.1Q to tag packets. All trunk ports must be in the same device, and trunk ports cannot carry VLANs from different devices.
 
    [bookmark: pgfId-1535385]You identify a native VLAN for each trunk port. The trunk port carries the traffic for that specific VLAN as untagged packets. If you do not configure a native VLAN, the device uses the default VLAN to carry untagged traffic for that trunk port. You can also configure the device to drop all untagged traffic on trunk ports and to retain the tag for the native VLAN.
 
     
      
    
 
    
 
    [bookmark: pgfId-1454552]Note Beginning with Cisco NX-OS Release 5.1, a Layer 2 port can function as either one of the following:
 
     
     	 [bookmark: pgfId-1454553]A trunk port
 
     	 [bookmark: pgfId-1454561]An access port
 
     	 [bookmark: pgfId-1454628]A private VLAN port (see the Cisco DCNM Layer 2 Switching Configuration Guide, Release 5.x, for more information on private VLANs)
 
     	 [bookmark: pgfId-1454683]A FabricPath port (see the Cisco Nexus 7000 Series NX-OS FabricPath Configuration Guide, Release 5.x, and the Cisco DCNM FabricPath Configuration Guide, Release 5.x, for information on [bookmark: marker-1454684]FabricPath)
 
    
 
    [bookmark: pgfId-1529714]Beginning with Cisco NX-OS Release 5.2(1), a Layer 2 port can also function as a shared interface. You cannot configure an access interface as a shared interface. See the Cisco NX-OS FCoE Configuration Guide for Cisco Nexus 7000 and Cisco MDS 9500 for information on shared interfaces.
 
    [bookmark: pgfId-1454685]
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1491088]Note See the Cisco DCNM FabricPath Configuration Guide, Release 5.x, for more information on configuring the FabricPath feature.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1491089]Note A Layer 2 port can function as either a trunk port, an access port, or a private VLAN port.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1550208]Note See the Cisco Nexus 7000 Series NX-OS System Management Configuration Guide, Release 5.x, for information on configuring a SPAN destination interface.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1806874][bookmark: 84293]Configuring Layer 3 Interfaces
 
    [bookmark: pgfId-1807749]This chapter in Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure Layer 3 interfaces for Cisco NX-OS devices using Cisco Data Center Network Manager (DCNM).
 
     
      
    
 
    
 
    [bookmark: pgfId-1806931]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this chapter. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1806932]Layer 3 interfaces forward IPv4 and IPv6 packets to another device using static or dynamic routing protocols. You can use Layer 3 interfaces for IP routing and inter-VLAN routing of Layer 2 traffic. A layer 3 logical interface (VLAN network interface, loopback, tunnel) configured in one VDC is isolated from a layer 3 logical interface with the same number configured in another VDC. For example, loopback 0 in VDC 1 is independent of loopback 0 in VDC 2. 
 
    [bookmark: pgfId-1806936]You cannot configure a shared [bookmark: marker-1806933]interface as a Layer 3 interface. See the Cisco NX-OS FCoE Configuration Guide for Cisco Nexus 7000 and Cisco MDS 9500 for information on shared interfaces.
 
    [bookmark: pgfId-1806939]Beginning with Cisco Release 5.2(1), you can configure a [bookmark: marker-1806938]Fabric Extender (FEX) port as a Layer 3 interface for host connectivity, but not for routing. See the Configuring the Cisco Nexus 2000 Series Fabric Extender for more information on fabric extenders.
 
   
 
    
     [bookmark: pgfId-1807006][bookmark: 34025]Configuring Port Channels
 
    [bookmark: pgfId-1807007]This chapter in Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure port channels and to apply and configure the Link Aggregation Control Protocol (LACP) for more efficient use of port channels using Cisco Data Center Network Manager (DCNM) in the Cisco NX-OS devices.
 
    [bookmark: pgfId-1807008]Beginning with Cisco Release NX-OS 5.1(1), you can use any of the F1 series modules or M1 series modules for the port channel, but you cannot combine member ports on an F1 module with ports on an M1 module in a single port channel. On a single switch, the port-channel compatibility parameters must be the same among all the port-channel members on the physical switch.
 
    [bookmark: pgfId-1807009]For more information about the Data Center Network Manager features and using the Topology tab with port channels, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
      
    
 
    
 
    [bookmark: pgfId-1807013]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this chapter. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1807014]Note System-message logging levels for the port channels feature must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them the minimum requirements. Cisco Nexus 7000 Series Switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Cisco Nexus 7000 Series NX-OS System Management Configuration Guide, Release 5.x.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1807064][bookmark: 68778]Configuring vPCs
 
    [bookmark: pgfId-1807065]This chapter in Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure virtual port channels (vPCs) using Cisco Data Center Network Manager (DCNM) on Cisco NX-OS devices.
 
     
      
    
 
    
 
    [bookmark: pgfId-1807066]Note Beginning with Cisco NX-OS Release 5.1(1), vPCs have been enhanced to interoperate with FabricPath. To configure vPCs with FabricPath networks, see the Cisco Nexus 7000 Series NX-OS FabricPath Configuration Guide, Release 5.x.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1807067]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this chapter. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.[bookmark: marker-1807068]
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1807069]Note System-message logging levels for the vPC feature must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them the minimum requirements. Cisco Nexus 7000 Series Switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Cisco Nexus 7000 Series NX-OS System Management Configuration Guide, Release 5.x.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1807073]Beginning with Cisco NX-OS Release 5.1(1), you can use any of the 10-Gbps Ethernet (10GE) interfaces on the F series modules or the 10GE interfaces on the M series modules for the vPC peer link on an individual switch, but you cannot combine member ports on an F module with ports on an M module into a single port channel on a single switch. The port channel compatibility parameters must be the same for all the port channel members on the physical switch.
 
    [bookmark: pgfId-1807077]You [bookmark: marker-1807074]cannot configure shared interfaces to be part of a vPC. See the Cisco NX-OS FCoE Configuration Guide for Cisco Nexus 7000 and Cisco MDS 9500 for more information on shared interfaces.
 
     
      
    
 
    
 
    [bookmark: pgfId-1807079]Note The port channel compatibility parameters must also be the same for all vPC member ports on both peers and therefore you must use the same type of module in each chassis. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1807148]Virtual port channels (vPCs) allow links that are physically connected to two different Cisco Nexus 7000 series devices to appear as a single port channel by a third device.
 
   
 
    
     [bookmark: pgfId-1807163][bookmark: 76351]Configuring IP Tunnels
 
     
      
    
 
    
 
    [bookmark: pgfId-1807164]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this chapter. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1807165]This chapter in Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure IP tunnels using Generic Route Encapsulation (GRE) using the Cisco Data Center Network Manager (DCNM)on Cisco NX-OS devices.
 
   
 
    
     [bookmark: pgfId-1807189][bookmark: 10723]Configuring Virtual Ethernet Interfaces
 
    [bookmark: pgfId-1807190]This chapter in Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure virtual Ethernet (vEthernet or vEth) interfaces using Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1807252][bookmark: marker-1807250][bookmark: marker-1807251]Virtual Ethernet (vEthernet or vEth) interfaces are logical interfaces. Each vEthernet interface corresponds to a switch interface that is connected to a virtual port. The interface types are as follows:
 
     
     	 [bookmark: pgfId-1807253]Virtual Machine (VM) (interfaces connected to VM NICs)
 
     	 [bookmark: pgfId-1807254]Service console 
 
     	 [bookmark: pgfId-1807256][bookmark: marker-1807255]VM-Fabric Extender (FEX)
 
     	 [bookmark: pgfId-1807258][bookmark: marker-1807257]FEX-Adapter
 
     	 [bookmark: pgfId-1807259]vmkernel 
 
    
 
    [bookmark: pgfId-1807263]vEthernet interfaces are created on the Cisco MDS 9000 Series to represent virtual ports in use on the distributed virtual switch.
 
     
      
    
 
    
 
    [bookmark: pgfId-1807264]Note System-message logging levels for the Virtual Ethernet interfaces feature must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series Switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1807317][bookmark: 76846]Configuring Fabric Extenders
 
     
      
    
 
    
 
    [bookmark: pgfId-1807319]Note Beginning with Cisco DCNM for LAN, Release 5.2, you can configure a Fabric Extend[bookmark: marker-1807318]er host interface port as a routed or Laye[bookmark: marker-1807320]r 3 port. However, no routing protocols can be tied to this routed interface.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1807324]The Fabric Extender feature allows you to manage a Cisco Nexus 2000 Series Fabric Extender and its association with the Cisco NX-OS switch that it is attached to. A Fabric Extender is connected to the switch through physical Ethernet interfaces or a Port Channel. By default, the switch does not allow the attached Fabric Extender to connect until it has been assigned a chassis ID and is associated with the connected interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-1807334]Note The Fabric Extender may connect to the switch through a number of separate physical Ethernet interfaces or at most one port channel interface.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1807335]This chapter in Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure a Fabric Extender using Cisco Data Center Network Manager (DCNM) on a Cisco NX-OS device.
 
   
 
    
     [bookmark: pgfId-1807383][bookmark: 37151]Configuring Port Profiles
 
    [bookmark: pgfId-1807384]This chapter in Interfaces Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure port profiles using Cisco Data Center Network Manager (DCNM). 
 
    [bookmark: pgfId-1807417]A port profile is a mechanism for simplifying the configuration of interfaces. You can configure a port profile and then assign it to multiple interfaces to give them all the same configuration. Changes to the port profile are propagated to the configuration of any interface that is assigned to it.
 
    [bookmark: pgfId-1807418]You can configure Ethernet or vEthernet port profiles to which you can assign Ethernet or vEthernet interfaces, respectively.
 
     
      
    
 
    
 
    [bookmark: pgfId-1807419]Note We do not recommend that you override port profile configurations by making changes to the assigned interface configurations. Only make configuration changes to interfaces to quickly test a change or to disable a port.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1807420]Note System-message logging levels for the Port Profiles feature must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series Switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1807108]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1086359][bookmark: 30073]Configuring Switching on DCNM-LAN Client 
      
      
 
     
 
 
    [bookmark: pgfId-1321243]This chapter briefly introduces the following features:
 
     
     	 [bookmark: pgfId-1320296]Configuring VLANs
 
     	 [bookmark: pgfId-1320742]Configuring Private VLANs
 
     	 [bookmark: pgfId-1320763]Configuring STP Extensions
 
     	 [bookmark: pgfId-1320785]Configuring Rapid PVST+
 
     	 [bookmark: pgfId-1320806]Configuring MST
 
     	 [bookmark: pgfId-1321184]Configuring Link-State Tracking
 
     	 [bookmark: pgfId-1321188]Configuring FabricPath Switching
 
     	 [bookmark: pgfId-1321192]FabricPath Forwarding
 
     	 [bookmark: pgfId-1321196]Configuring Advanced FabricPath Features
 
     	 [bookmark: pgfId-1321200]Using the Layer 2 Security Audit Wizard
 
     	 [bookmark: pgfId-1321204]Configuring Dynamic ARP Inspection
 
     	 [bookmark: pgfId-1321208]Configuring Port Security
 
     	 [bookmark: pgfId-1321212]Configuring DHCP Snooping
 
     	 [bookmark: pgfId-1321216]Configuring IP Source Guard
 
     	 [bookmark: pgfId-1321220]Configuring Traffic Storm Control
 
     	 [bookmark: pgfId-1321224]Configuring IGMP Snooping
 
     	 [bookmark: pgfId-1321088]Configuring FCoE Initialization Protocol Snooping
 
    
 
    [bookmark: pgfId-1321827]For detailed configuration guide, please refer to Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x.
 
   
 
    
     [bookmark: pgfId-1321028][bookmark: 29894]Configuring VLANs
 
    [bookmark: pgfId-1309152]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure virtual LANs (VLANs) on NX-OS devices.
 
    [bookmark: pgfId-1321444]A VLAN is a switched network that is logically segmented by function, project team, or application, without regard to the physical locations of the users. VLANs have the same attributes as physical LANs, but you can group end stations even if they are not physically located on the same LAN segment.
 
    [bookmark: pgfId-1321445]Any switch port can belong to a VLAN, and unicast, broadcast, and multicast packets are forwarded and flooded only to end stations in that VLAN. Each VLAN is considered as a logical network, and packets destined for stations that do not belong to the VLAN must be forwarded through a bridge or a router.
 
    [bookmark: pgfId-1321446]All ports are assigned to the default VLAN (VLAN1) when the device first comes up. A VLAN interface, or switched virtual interface (SVI), is a Layer 3 interface that is created to provide communication between VLANs.
 
    [bookmark: pgfId-1321447]The devices support 4094 VLANs in accordance with the IEEE 802.1Q standard. These VLANs are organized into several ranges, and you use each range slightly differently. Some of these VLANs are reserved for internal use by the device and are not available for configuration.
 
     
      
    
 
    
 
    [bookmark: pgfId-1309153]Note Inter-Switch Link (ISL) trunking is not supported on the Cisco NX-OS.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1318871][bookmark: 83662]Configuring Private VLANs
 
    [bookmark: pgfId-1318895]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure private VLANs. Private VLANs provide additional protection at the Layer 2 level.[bookmark: marker-1318933]
 
    [bookmark: pgfId-1321570]Private VLANs provide traffic separation and security at the Layer 2 level.
 
    [bookmark: pgfId-1321571]A private VLAN is one or more pairs of a primary VLAN and a secondary VLAN, all with the same primary VLAN. The two types of secondary VLANs are isolated and community VLANs. Hosts on isolated VLANs communicate only with hosts in the primary VLAN. Hosts in a community VLAN can communicate only among themselves and with hosts in the primary VLAN but not with hosts in isolated VLANs or in other community VLANs.
 
    [bookmark: pgfId-1321555]Regardless of the combination of isolated and community secondary VLANs, all interfaces within the primary VLAN comprise one Layer 2 domain, and therefore, require only one IP subnet.
 
   
 
    
     [bookmark: pgfId-1318954][bookmark: 86825]Configuring STP Extensions
 
    [bookmark: pgfId-1318983]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure Spanning Tree Protocol (STP) extensions on Cisco Nexus 7000 Series NX-OS devices.
 
    [bookmark: pgfId-1321598]The software supports the following Cisco proprietary features:
 
     
     	 [bookmark: pgfId-1321599] Spanning tree port types—The default spanning tree port type is normal. You can configure interfaces connected to Layer 2 hosts as edge ports and interfaces connected to Layer 2 switches or bridges as network ports. 
 
     	 [bookmark: pgfId-1321600] Bridge Assurance—Once you configure a port as a network port, Bridge Assurance sends BPDUs on all ports and moves a port into the blocking state if it no longer receives BPDUs. This enhancement is available only when you are running Rapid PVST+ or MST. 
 
     	 [bookmark: pgfId-1321601] BPDU Guard—BPDU Guard shuts down the port if that port receives a BPDU. 
 
     	 [bookmark: pgfId-1321602] BPDU Filter—BPDU Filter suppresses sending and receiving BPDUs on the port. 
 
     	 [bookmark: pgfId-1321603] Loop Guard—Loop guard helps prevent bridging loops that could occur because of a unidirectional link failure on a point-to-point link. 
 
     	 [bookmark: pgfId-1318984] Root Guard—The root guard feature prevents a port from becoming root port or blocked port. If a port configured for root guard receives a superior BPDU, the port immediately goes to the root-inconsistent (blocked) state. 
 
    
 
   
 
    
     [bookmark: pgfId-1318978][bookmark: 77930]Configuring Rapid PVST+
 
    [bookmark: pgfId-1319031]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure the Rapid per VLAN Spanning Tree (Rapid PVST+) protocol on NX-OS devices.
 
   
 
    
     [bookmark: pgfId-1319096][bookmark: 27742]Configuring MST
 
    [bookmark: pgfId-1319200]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure Multiple Spanning Tree (MST) on NX-OS devices.
 
    [bookmark: pgfId-1319202]For more information about the Data Center Network Manager features, see the Cisco DCNM Fundamentals Configuration Guide.
 
   
 
    
     [bookmark: pgfId-1319205][bookmark: 77520]Configuring Link-State Tracking
 
     
      
    
 
    
 
    [bookmark: pgfId-1319195]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this chapter. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1319196]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure link-state tracking on the Cisco Nexus 4000 Series device.
 
    [bookmark: pgfId-1319210]The link-state tracking feature binds the link state of multiple interfaces and provides redundancy in the network. In link-state tracking, you configure the server network adapters in a primary or secondary relationship known as teaming. The interfaces are grouped into link-state groups and if the link is lost on a primary interface, connectivity transparently moves to the secondary interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-1319147]Note Link-state tracking is applicable only for the Cisco Nexus 4000 Series platform, beginning with the DCNM 4.2(3) release.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1321153][bookmark: 62303]Configuring FabricPath Switching
 
     
      
    
 
    
 
    [bookmark: pgfId-1321155]Note You must have an F Series module installed in your Cisco Nexus [bookmark: marker-1321154]7000 Series chassis in order to run FabricPath and conversational learning.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1319279]FabricPath switching allows multipath networking at the Layer 2 level. The FabricPath network still delivers packets on a best-effort basis (which is similar to the Classical Ethernet [CE] network), but the FabricPath network can use multiple paths for Layer 2 traffic.
 
    [bookmark: pgfId-1319281]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure FabricPath switching on the Cisco Nexus 7000 Series NX-OS devices. [bookmark: marker-1319280]
 
   
 
    
     [bookmark: pgfId-1319226][bookmark: 21879]FabricPath Forwarding
 
    [bookmark: pgfId-1319334]Beginning with Cisco Release 5.1(2) for the Nexus 700 Series devices, you can create additional, nondefault FabricPath topologies. Each additional topology also has two forwarding trees. Additionally, you can display information about the interfaces and reachability status of the FabricPath network.
 
     
      
    
 
    
 
    [bookmark: pgfId-1319338]Note See the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x for more information on displaying the FabricPath topologies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1319329]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes the forwarding behavior of FabricPath on the Cisco Nexus 7000 Series NX-OS devices.
 
   
 
    
     [bookmark: pgfId-1319445][bookmark: 79019]Configuring Advanced FabricPath Features
 
    [bookmark: pgfId-1320567]You can do advanced configurations using FabricPath for the FabricPath Intermediate System-to-Intermediate System (IS-IS) proto[bookmark: marker-1320568]col. 
 
    [bookmark: pgfId-1320570]For more information about the Data Center Network Manager features, see the Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x.
 
   
 
    
     [bookmark: pgfId-1320572][bookmark: 61868]Using the Layer 2 Security Audit Wizard
 
    [bookmark: pgfId-1320573]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to use the Layer 2 Security Audit Wizard.
 
    [bookmark: pgfId-1319496]The Security Audit Wizard allows you to examine the existing Layer 2 security features such as port security, dynamic ARP inspection (DAI), DHCP snooping, IP Source Guard, and traffic storm control configured on different devices. It also allows you to report and apply configurations that are missing on the device.
 
    [bookmark: pgfId-1319517]For more information about the Data Center Network Manager features, see the Cisco DCNM Fundamentals Configuration Guide.
 
   
 
    
     [bookmark: pgfId-1319533][bookmark: 24900]Configuring Dynamic ARP [bookmark: marker-1319558]Inspection
 
    [bookmark: pgfId-1319580]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure dynamic Address Resolution Protocol (ARP) inspection (DAI) on an NX-OS device.
 
    [bookmark: pgfId-1319581]Dynamic ARP inspection (DAI) ensures that only valid ARP requests and responses are relayed. When DAI is enabled and properly configured, a device performs these activities:
 
     
     	 [bookmark: pgfId-1319582]Intercepts all ARP requests and responses on untrusted ports
 
     	 [bookmark: pgfId-1319583]Verifies that each of these intercepted packets has a valid IP-to-MAC address binding before updating the local ARP cache or before forwarding the packet to the appropriate destination
 
     	 [bookmark: pgfId-1319584]Drops invalid ARP packets
 
    
 
    [bookmark: pgfId-1319585]DAI can determine the validity of an ARP packet based on valid IP-to-MAC address bindings stored in a DHCP snooping binding database. This database is built by DHCP snooping if DHCP snooping is enabled on the VLANs and on the device. It can also contain static entries that you create. If the ARP packet is received on a trusted interface, the device forwards the packet without any checks. On untrusted interfaces, the device forwards the packet only if it is valid. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1319586]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this section. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1319587]Note System-message logging levels for DAI must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1319553]For more information about the Data Center Network Manager features, see the Cisco DCNM Fundamentals Configuration Guide.
 
   
 
    
     [bookmark: pgfId-1319610][bookmark: 75056]Configuring [bookmark: marker-1319618]Port Security
 
    [bookmark: pgfId-1319644]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure port security on NX-OS devices.
 
    [bookmark: pgfId-1319645]You can use port security to configure Layer 2 Ethernet interfaces and Layer 2 port-channel interfaces that allow inbound traffic from only a restricted set of MAC addresses. The MAC addresses in the restricted set are called secure MAC addresses. In addition, the device does not allow traffic from these MAC addresses on another interface within the same VLAN. The number of MAC addresses that the device can secure is configurable per interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-1319646]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this section. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.This chapter includes the following sections:
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1319647]Note System-message logging levels for port security must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1319639]For more information about the Data Center Network Manager features, see the Cisco DCNM Fundamentals Configuration Guide.
 
   
 
    
     [bookmark: pgfId-1319719][bookmark: 50625]Configuring [bookmark: marker-1319717]DHCP Snooping
 
    [bookmark: pgfId-1319726]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure Dynamic Host Configuration Protocol (DHCP) snooping on an NX-OS device.
 
    [bookmark: pgfId-1319727]DHCP snooping is a security feature that acts like a firewall between untrusted hosts and trusted DHCP servers. DHCP snooping performs the following activities: 
 
     
     	 [bookmark: pgfId-1319728]Validates DHCP messages received from untrusted sources and filters out invalid messages. 
 
     	 [bookmark: pgfId-1319729](Not in 4.0) Rate-limits DHCP traffic from trusted and untrusted sources.
 
     	 [bookmark: pgfId-1319730]Builds and maintains the DHCP snooping binding database, which contains information about untrusted hosts with leased IP addresses.
 
     	 [bookmark: pgfId-1319731]Utilizes the DHCP snooping binding database to validate subsequent requests from untrusted hosts.
 
    
 
    [bookmark: pgfId-1319732]Dynamic ARP inspection (DAI) and IP Source Guard also use information stored in the DHCP snooping binding database.
 
     
      
    
 
    
 
    [bookmark: pgfId-1319733]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this section. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1319734]Note System-message logging levels for DHCP snooping must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1319701][bookmark: 30914]Configuring [bookmark: marker-1319760]IP Source Guard
 
    [bookmark: pgfId-1319782]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure IP Source Guard on NX-OS devices.
 
    [bookmark: pgfId-1319783]IP Source Guard is a per-interface traffic filter that permits IP traffic only when the IP address and MAC address of each packet matches one of two sources of IP and MAC address bindings:
 
     
     	 [bookmark: pgfId-1319784]Entries in the DHCP snooping binding table.
 
     	 [bookmark: pgfId-1319785]Static IP source entries that you configure.
 
    
 
    [bookmark: pgfId-1319786]Filtering on trusted IP and MAC address bindings helps prevent attacks that rely on spoofing the IP address of a valid host. To circumvent IP Source Guard, an attacker would have to spoof both the IP address and the MAC address of a valid host.
 
     
      
    
 
    
 
    [bookmark: pgfId-1319787]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this section. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1319788]Note System-message logging levels for IP Source Guard must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1319806][bookmark: 94465]Configuring Traffic Storm Control
 
    [bookmark: pgfId-1319807]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure traffic storm control on the NX-OS device.
 
    [bookmark: pgfId-1319777]Traffic storm control (also called traffic suppression) allows you to monitor the levels of the incoming traffic over a 1-second interval. During this interval, the traffic level, which is a percentage of the total available bandwidth of the port, is compared with the traffic storm control level that you configured. When the ingress traffic reaches the traffic storm control level that is configured on the port, traffic storm control drops the traffic until the interval ends. 
 
   
 
    
     [bookmark: pgfId-1319827][bookmark: 66584]Configuring IGMP Snooping
 
     
      
    
 
    
 
    [bookmark: pgfId-1319828]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this chapter. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1319832]Note Cisco recommends that you do not disable IGPM snooping on the device.[bookmark: marker-1319831] If you disable IGMP snooping, you may see reduced multicast performance because of excessive false flooding within the device.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1319834]The Internet Group Management Protocol (IGMP) [bookmark: marker-1319833]snooping software examines Layer 2 IP multicast traffic within a VLAN to discover the ports where interested receivers reside. Using the port information, IGMP snooping can reduce bandwidth consumption in a multi-access LAN environment to avoid flooding the entire VLAN. The IGMP snooping feature tracks which ports are attached to multicast-capable routers to help the routers forward IGMP membership reports. The IGMP snooping software responds to topology change notifications. By default, IGMP snooping is enabled on the device.
 
   
 
    
     [bookmark: pgfId-1319865][bookmark: 44446]Configuring FCoE Initialization Protocol Snooping
 
    [bookmark: pgfId-1319868]The Fiber Channel over Ethernet (FCoE) Initialization Protocol (FIP) is a Layer 2 protocol for end point discovery and fabric association. FIP has its own EtherType and uses its own frame formats. 
 
    [bookmark: pgfId-1319869]FIP has two phases: discovery and login. Once the discovery of end nodes and login is complete, FCoE traffic can start flowing between the endpoints. 
 
    [bookmark: pgfId-1319870]By snooping on FIP packets during the discovery and login phases, intermediary bridges can implement dynamic data integrity mechanisms using access control lists (ACLs) that permit only valid FCoE traffic between the ENode and the FCoE forwarder (FCF). 
 
    [bookmark: pgfId-1319872]A bridge implementing the above functionality is what we refer to as the FIP Snooping Bridge. The process implementing this feature is called FIP Snooping Manager (FIPSM). FIPSM is capable of supporting both Fabric Provided MAC Addresses (FPMAs) and Server Provided MAC Addresses (SPMAs). 
 
    [bookmark: pgfId-1319873]This chapter in Layer 2 Switching Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure the Fibre Channel over Ethernet (FCoE) Initialization Protocol (FIP) snooping feature using the Cisco Data Center Network Manager (DCNM) [bookmark: marker-1319874]
 
    [bookmark: pgfId-1320235]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1397809][bookmark: 76351][bookmark: 30073]Configuring Routinging on DCNM-LAN Client 
      
      
 
     
 
 
    [bookmark: pgfId-1397855]The Cisco Data Center Network Manager (DCNM) supports IP addressing, object tracking, and Gateway Load Balancing Protocol (GLBP).
 
    [bookmark: pgfId-1398049]This chapter includes following sections:
 
     
     	 [bookmark: pgfId-1397972]Configuring GLBP
 
     	 [bookmark: pgfId-1398006]Configuring HSRP
 
     	 [bookmark: pgfId-1398020]Configuring Keychain Management
 
     	 [bookmark: pgfId-1398034]Configuring Object Tracking
 
    
 
    [bookmark: pgfId-1397910]For more information about the Data Center Network Manager features, see the Unicast Routing Configuration Guide, Cisco DCNM for LAN, Release 7.x.
 
   
 
    
     [bookmark: pgfId-1397747][bookmark: 56801]Configuring GLBP
 
    [bookmark: pgfId-1397749]This chapter in Unicast Routing Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure the [bookmark: marker-1397748]Gateway Load Balancing Protocol (GLBP) on the Cisco Data Center Network Manager (DCNM)NX-OS device.
 
    [bookmark: pgfId-1397750]This chapter includes the following sections:
 
    [bookmark: pgfId-1397752]GLBP[bookmark: marker-1397751] provides path redundancy for IP by sharing protocol and Media Access Control (MAC) addresses between redundant gateways. Additionally, GLBP allows a group of Layer 3 routers to share the load of the default gateway on a LAN. A GLBP router can automatically assume the forwarding function of another router in the group if the other router fails.
 
   
 
    
     [bookmark: pgfId-1397754][bookmark: 10464]Configuring HSRP
 
    [bookmark: pgfId-1397756]This chapter in Unicast Routing Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure the Hot [bookmark: marker-1397755]Standby Router Protocol (HSRP) on the Cisco Data Center Network Manager (DCNM)NX-OS device. 
 
    [bookmark: pgfId-1397757]This chapter includes the following sections:
 
    [bookmark: pgfId-1397759]HSRP is [bookmark: HSRP]a first-hop redundancy protocol (FHRP) that allows a transparent failover of the first-hop IP router. HSRP provides first-hop routing redundancy for IP hosts on Ethernet networks configured with a default router IP address. You use HSRP in a group of routers for selecting an active router and a standby router. In a group of routers, the active router is the router that routes packets; the standby router is the router that takes over when the active router fails or when preset conditions are met.
 
    [bookmark: pgfId-1397760]Many host implementations do not support any dynamic router discovery mechanisms but can be configured with a default router. Running a dynamic router discovery mechanism on every host is not feasible for a number of reasons, including administrative overhead, processing overhead, and security issues. HSRP provides failover services to these hosts.
 
   
 
    
     [bookmark: pgfId-1397763][bookmark: 67271]Configuring [bookmark: marker-1397761]Keychain Management
 
    [bookmark: pgfId-1397764]This chapter in Unicast Routing Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure keychain management on an NX-OS device.
 
    [bookmark: pgfId-1397765]Keychain management allows you to create and maintain keychains, which are sequences of keys (sometimes called shared secrets). You can use keychains with features that secure communications with other devices by using key-based authentication. The device allows you to configure multiple keychains.
 
    [bookmark: pgfId-1397766]Some routing protocols that support key-based authentication can use a keychain to implement a hitless key rollover for authentication.
 
     
      
    
 
    
 
    [bookmark: pgfId-1397767]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this section. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.This chapter includes the following sections:
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1397769][bookmark: 35617]Configuring Object Tracking
 
    [bookmark: pgfId-1397773]This chapter in Unicast Routing Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure object tracking on the Cisco NX-OS Cisco NX-OS device.
 
    [bookmark: pgfId-1397774]This chapter includes the following sections:
 
    [bookmark: pgfId-1397776]Object tracking[bookmark: marker-1397775] allows you to track specific objects on the device, such as the interface line protocol state, IP routing, and route reachability, and to take action when the tracked object’s state changes. This feature allows you to increase the availability of the network and shorten recovery time if an object state goes down. 
 
    [bookmark: pgfId-1397777]System-message logging levels for the Object Tracking feature must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. 
 
    [bookmark: pgfId-1397742]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1409679]Security Configurations on DCNM-LAN Client 
      
      
 
     
 
 
    [bookmark: pgfId-1647187]The Cisco NX-OS software supports security features that can protect your network against degradation or failure and also against data loss or compromise resulting from intentional attacks and from unintended but damaging mistakes by well-meaning network users.
 
    [bookmark: pgfId-1646840]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1646876]Configuring IP ACLs
 
     	 [bookmark: pgfId-1646889]Configuring MAC ACLs
 
     	 [bookmark: pgfId-1646929]Configuring VLAN ACLs
 
     	 [bookmark: pgfId-1646933]Configuring ARP ACLs
 
     	 [bookmark: pgfId-1646946]Configuring Object Groups
 
     	 [bookmark: pgfId-1646959]Configuring AAA
 
     	 [bookmark: pgfId-1646973]Configuring Time Ranges
 
     	 [bookmark: pgfId-1646987]Configuring RADIUS
 
     	 [bookmark: pgfId-1647008]Configuring TACACS+
 
     	 [bookmark: pgfId-1647014]Configuring 802.1X
 
     	 [bookmark: pgfId-1647036]Configuring User Accounts and RBAC
 
    
 
    [bookmark: pgfId-1647077]For detailed information about the security configuration on DCNM-LAn client, see Security Configuration Guide, Cisco DCNM for LAN, Release 7.x.
 
   
 
    
     [bookmark: pgfId-1646937][bookmark: 89025]Configuring IP ACLs
 
    [bookmark: pgfId-1646475]You can configure an IP ACL on the device. An IP ACL is an ordered set of rules that you can use to filter traffic based on IPv4 or IPv6 information in the Layer 3 header of packets. Each rule specifies a set of conditions that a packet must satisfy to match the rule. When a device determines that an IP ACL applies to a packet, it tests the packet against the conditions of all rules. The first match determines whether a packet is permitted or denied, or if there is no match, the device applies the applicable default rule. The device continues processing packets that are permitted and drops packets that are denied.
 
    [bookmark: pgfId-1646476]Unless otherwise specified, the term IP ACL refers to IPv4 and IPv6 ACLs.
 
     
      
    
 
    
 
    [bookmark: pgfId-1646477]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this section. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1646545][bookmark: 88016]Configuring [bookmark: marker-1646543]MAC ACLs
 
    [bookmark: pgfId-1646546]You can configure a MAC ACL on the device. MAC ACLs are ACLs that filter traffic using the information in the Layer 2 header of each packet. Each rule specifies a set of conditions that a packet must satisfy to match the rule. When a device determines that a MAC ACL applies to a packet, it tests the packet against the conditions of all rules. The first match determines whether a packet is permitted or denied, or if there is no match, the device applies the applicable default rule. The device continues processing packets that are permitted and drops packets that are denied.
 
     
      
    
 
    
 
    [bookmark: pgfId-1646547]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this section. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1646570][bookmark: 13677]Configuring [bookmark: marker-1646568]VLAN ACLs
 
    [bookmark: pgfId-1646571]A VLAN ACL (VACL) is one application of a MAC ACL or IP ACL. You can configure VACLs to apply to all packets that are routed into or out of a VLAN or are bridged within a VLAN. VACLs are strictly for security packet filtering and for redirecting traffic to specific physical interfaces. VACLs are not defined by direction (ingress or egress).
 
     
      
    
 
    
 
    [bookmark: pgfId-1646572]Note The Cisco NX-OS release that is running on a managed device may not support all the features or settings described in this section. For the latest feature information and caveats, see the documentation and release notes for your platform and software release.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1646603][bookmark: 90799]Configuring [bookmark: marker-1646601]ARP ACLs
 
    [bookmark: pgfId-1646604]You can configure an ARP ACL on the device. An ARP ACL is an ordered set of rules that you can use to filter ARP traffic for dynamic ARP inspection (DAI). Each rule specifies a set of conditions that a packet must satisfy to match the rule. When a device determines that an ARP ACL applies to an ARP packet, it tests the packet against the conditions of all rules. The first match determines whether a packet is permitted or denied, or if there is no match, the device applies the applicable default rule. The device continues processing packets that are permitted and drops packets that are denied.
 
    [bookmark: pgfId-1646605]When you configure the device to apply an ARP ACL to traffic, the ACL take precedence over entries in the DHCP snooping binding database. The switch first compares ARP packets to user-configured ARP ACLs. If the ARP ACL denies the ARP packet, the switch also denies the packet even if a valid binding exists in the database populated by DHCP snooping.
 
   
 
    
     [bookmark: pgfId-1646623][bookmark: 47922]Configuring [bookmark: marker-1646620]Object Groups
 
    [bookmark: pgfId-1646624]An object group is a group of IP addresses or a group of TCP or UDP ports. When you create an access control list (ACL) rule, you can specify the object groups rather than specifying IP addresses or ports. Using object groups when you configure IPv4 or IPv6 ACLs can help reduce the complexity of updating ACLs when you need to add or remove addresses or ports from the source or destination of rules. For example, if three rules reference the same IP address group object, you can add an IP address to the object instead of changing all three rules. 
 
   
 
    
     [bookmark: pgfId-1646647][bookmark: 20312]Configuring AAA
 
    [bookmark: pgfId-1646649]This chapter in Security Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure authentication, authorization, and accounting (AAA) on Cisco NX-OS devices.[bookmark: marker-1646648]
 
    [bookmark: pgfId-1646651][bookmark: marker-1646650]You can configure authentication, authorization, and accounting (AAA) network security services to provide the primary framework through which you set up access control on your router or access server. Based on the user ID and password combination that you provide, the Cisco NX-OS device performs local authentication or authorization using the local database or remote authentication or authorization using one or more AAA servers.
 
     
      
    
 
    
 
    [bookmark: pgfId-1646652]Note System-message logging levels for AAA must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1646702][bookmark: 35618]Configuring [bookmark: marker-1646699]Time [bookmark: marker-1646700]Ranges
 
    [bookmark: pgfId-1646703]You can use time ranges to control when an ACL rule is in effect. For example, if the device determines that a particular ACL applies to traffic arriving on an interface, if a rule in the ACL uses a time range that is not in effect, the device does not compare the traffic to that rule.
 
    [bookmark: pgfId-1646704]IPv4, IPv6, and MAC ACLs support time ranges. When the device applies an ACL to traffic, the rules that are in effect are as follows:
 
     
     	 [bookmark: pgfId-1646705]All rules that are not configured with a time range.
 
     	 [bookmark: pgfId-1646706]Rules that are configured with a time range which is active at the second that the device applies the ACL to traffic.
 
    
 
    [bookmark: pgfId-1646707]The device supports named, reusable time ranges. This allows you to configure a time range once and specify it by name when configure many ACL rules.
 
   
 
    
     [bookmark: pgfId-1646731][bookmark: 45257]Configuring RADIUS
 
    [bookmark: pgfId-1646732]This chapter in Security Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure the Remote Access Dial-In User Service (RADIUS) protocol on NX-OS devices.
 
    [bookmark: pgfId-1646733]You can configure RADIUS on a device. The RADIUS distributed client/server system allows you to secure networks against unauthorized access. In the Cisco implementation, RADIUS clients run on Cisco NX-OS devices and send authentication and accounting requests to a central RADIUS server that contains all user authentication and network service access information.
 
     
      
    
 
    
 
    [bookmark: pgfId-1646734]Note System-message logging levels for RADIUS must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1646760][bookmark: 18619]Configuring TACACS+
 
    [bookmark: pgfId-1646761]This chapter in Security Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure the Terminal Access Controller Access Control System Plus (TACACS+) protocol on Cisco NX-OS devices.
 
    [bookmark: pgfId-1646762]You can use TACACS+ to provide centralized validation of users attempting to gain access to a device. TACACS+ services are maintained in a database on a TACACS+ daemon running, typically, on a UNIX or Windows NT workstation. You must have access to and must configure a TACACS+ server before the configured TACACS+ features on your device are available.
 
     
      
    
 
    
 
    [bookmark: pgfId-1646763]Note System-message logging levels for TACACS+ must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1646788][bookmark: 53289]Configuring 802.1X
 
    [bookmark: pgfId-1646789]This chapter in Security Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure IEEE 802.1X port-based authentication on Cisco NX-OS devices. 
 
    [bookmark: pgfId-1646790]802.1X defines a client-server-based access control and authentication protocol that restricts unauthorized clients from connecting to a LAN through publicly accessible ports. The authentication server authenticates each client connected to a device port. 
 
    [bookmark: pgfId-1646791]Until the client is authenticated, 802.1X access control allows only Extensible Authentication Protocol over LAN (EAPOL) traffic through the port to which the client is connected. After authentication is successful, normal traffic can pass through the port.
 
     
      
    
 
    
 
    [bookmark: pgfId-1646792]Note System-message logging levels for 802.1X must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1646818][bookmark: 65598]Configuring User Accounts and RBAC
 
    [bookmark: pgfId-1646820]This chapter in Security Configuration Guide, Cisco DCNM for LAN, Release 7.x describes how to configure user accounts and role-based access control (RBAC) on NX-OS devices.[bookmark: marker-1646819]
 
    [bookmark: pgfId-1646821]You can create and manage users accounts and assign roles that limit access to operations on the NX-OS device. Role-based access control ([bookmark: marker-1646822]RBAC) allows you to define the rules for an assign role that restrict the authorization that the user must have to access management operations.
 
    [bookmark: pgfId-1626945]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1425063][bookmark: 33088]Working [bookmark: marker-1425060]with Configuration Change Management 
      
      
 
     
 
 
    [bookmark: pgfId-1510638]This chapter describes how to use the Configuration Change Management feature on Cisco NX-OS devices.
 
    [bookmark: pgfId-1498752]The Configuration Change Management feature allows you to keep an archive of configurations from managed devices. You can view and compare configurations. You can roll back the configuration on a managed device to any archived configuration that Cisco DCNM has for the device.
 
    [bookmark: pgfId-1510643]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1510647]Information About Configuration Change Management
 
     	 [bookmark: pgfId-1510651]Licensing Requirements for Configuration Change Management
 
     	 [bookmark: pgfId-1510655]Prerequisites
 
     	 [bookmark: pgfId-1510659]Guidelines and Limitations for Configuration Change Management
 
     	 [bookmark: pgfId-1510663]Platform Support
 
     	 [bookmark: pgfId-1510667]Working with the Version Browser
 
     	 [bookmark: pgfId-1510671]Configuring Archival Jobs
 
     	 [bookmark: pgfId-1510675]Configuring Archival Settings
 
     	 [bookmark: pgfId-1492801]Configuring Switch Profiles
 
     	 [bookmark: pgfId-1510687]Field Descriptions for Configuration Change Management
 
     	 [bookmark: pgfId-1510691]Additional References
 
     	 [bookmark: pgfId-1510695]Feature History for Configuration Change Management
 
    
 
   
 
    
     [bookmark: pgfId-1510697][bookmark: 14255]Information About Configuration Change Management
 
    [bookmark: pgfId-1510698]The Configuration Change Management feature allows you to keep an archive of configurations from managed devices. You can view and compare archived configurations. You can roll back the running configuration of a managed device to any archived configuration version available for the device in Cisco Data Center Network Manager (DCNM).
 
     
      
    
 
    
 
    [bookmark: pgfId-1492906]Note Beginning with Cisco Release 5.2(1), Cisco DCNM supports the Cisco IOS platform.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1492976]Note Beginning with Cisco DCNM Release 5.2(1), this feature supports Cisco Nexus 5000 Series, Cisco Catalyst 6500 Series, Cisco Nexus 3000 Series, and Cisco Nexus 7000 Series devices, Cisco Nexus 1000 Series, Cisco Nexus 1010 Series, and Cisco Nexus 4000 Series devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1510708]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1510712]Version Browser
 
     	 [bookmark: pgfId-1510716]Archival Jobs
 
     	 [bookmark: pgfId-1510720]Archival Settings
 
     	 [bookmark: pgfId-1510724]VDC Support
 
    
 
     
      [bookmark: pgfId-1510726][bookmark: 18833]Version Browser
 
     [bookmark: pgfId-1510727]The Version Browser feature allows you to see information about archived configurations, view and compare specific configuration versions, and merge changes from one configuration version to another version. After you modify a configuration by merging changes, you can save the modified configuration as a text file on a file system that is available to the computer that you are using to run the Cisco DCNM client.
 
     [bookmark: pgfId-1510728]From the Version Browser, you can initiate a configuration rollback for a managed Cisco Nexus 7000 Series device, using any of the archived configurations available in Cisco DCNM for the device. Cisco DCNM uses the rollback feature available in Cisco IOS and Cisco NX-OS. For more information about the Cisco NX-OS rollback feature, see the Cisco Nexus 7000 Series NX-OS System Management Configuration Guide, Release 5.x.
 
    
 
     
      [bookmark: pgfId-1510733][bookmark: 23414]Archival Jobs
 
     [bookmark: pgfId-1510734]The Archival Jobs feature allows you to control the automated archival of the running configuration on managed devices. You can add, edit, and delete custom archival jobs. A job consists of settings that determine when the job runs and a list of managed devices included in the job. You can choose to archive configurations at a regular interval, at a scheduled time on selected days, or whenever Cisco DCNM detects configuration changes on a device. You can also comment on a job.
 
     [bookmark: pgfId-1510735]The Default archival job always exists. You cannot delete it. By default, it is disabled.
 
     [bookmark: pgfId-1510736]Devices can be assigned to one archival job only. If you assign a device to an archival job, Cisco DCNM removes the device from the job that it was previously assigned to.
 
     [bookmark: pgfId-1510737]If a managed device is not assigned to a custom archival job, Cisco DCNM automatically assigns it to the Default archival job.
 
    
 
     
      [bookmark: pgfId-1510739][bookmark: 22919]Archival Settings
 
     [bookmark: pgfId-1510740]The Archival Settings feature allows you to configure settings related to configuration change management, including the number of configuration versions that Cisco DCNM stores for each managed device, how many rollback and archival history entries Cisco DCNM stores for each managed device, and which file server Cisco DCNM uses during a configuration rollback.
 
    
 
     
      [bookmark: pgfId-1484271]Switch Profiles
 
      
       
     
 
     
 
     [bookmark: pgfId-1486745]Note The Switch Profiles feature is supported only on the Cisco Nexus 5000 series switches.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1484372]Several applications require consistent configuration across Cisco Nexus 5000 Series switches in the network. For example, with a virtual port channel (vPC), you must have identical configurations. Mismatched configurations can cause errors or misconfigurations that can result in service disruptions. The configuration synchronization (config-sync) feature in Cisco NX-OS Release 5.0(2)N1(1) allows you to configure one switch profile and have the configuration be automatically synchronized to the peer switch. 
 
     [bookmark: pgfId-1484374]A switch profile provides the following benefits:
 
      
      	 [bookmark: pgfId-1484378]Allows configurations to be synchronized between switches.
 
      	 [bookmark: pgfId-1484380]Merges configurations when connectivity is established between two switches.
 
      	 [bookmark: pgfId-1484382]Provides control of exactly which configuration gets synchronized.
 
      	 [bookmark: pgfId-1484384]Ensures configuration consistency across peers through merge and mutual-exclusion checks.
 
      	 [bookmark: pgfId-1484386]Provides verify and commit semantics.
 
      	 [bookmark: pgfId-1484388]Supports configuring and synchronizing port profile configurations.
 
      	 [bookmark: pgfId-1484390]Provides an import command to migrate existing vPC configurations to a switch profile.
 
     
 
    
 
     
      [bookmark: pgfId-1484392]Switch Profile Configuration Modes
 
     [bookmark: pgfId-1484394]The Cisco NX-OS Release 5.0(2)N1(1) switch profile feature includes the following configuration modes:
 
      
      	 [bookmark: pgfId-1484908]Configuration synchronization mode
 
      	 [bookmark: pgfId-1484400]Switch profile mode
 
      	 [bookmark: pgfId-1484402]Switch profile import mode
 
     
 
     [bookmark: pgfId-1484404]Configuration Synchronization Mode
 
     [bookmark: pgfId-1484405]Beginning with Cisco NX-OS Release 5.0(2)N1(1), the configuration synchronization mode (config-sync) allows you to create switch profiles. After entering the config sync command, you can create and name the switch profile that displays the switch profile mode. You must enter the config sync command on the local switch and the peer switch that you want to synchronize. 
 
     [bookmark: pgfId-1484407]Switch Profile Mode
 
     [bookmark: pgfId-1484408]The switch profile mode allows you to add supported configuration commands to a switch profile that is later synchronized with a peer switch. Commands that you enter in the switch profile mode are buffered until you enter the commit command. 
 
     [bookmark: pgfId-1484410]Switch Profile Import Mode
 
     [bookmark: pgfId-1494074]When you upgrade from an earlier release to Cisco NX-OS Release 5.0(2)N1(1), you have the option to enter the import command to copy supported running-configuration commands to a switch profile. After entering the import command, the switch profile mode (config-sync-sp) changes to the switch profile import mode (config-sync-sp-import). The switch profile import mode allows you to import existing switch configurations from the running configuration and specify which commands you want to include in the switch profile.
 
     [bookmark: pgfId-1484413]Because different topologies require different commands that are included in a switch profile, the import command mode allows you to modify the imported set of commands to suit a specific topology. For example, a dual homed Fabric Extender (FEX) topology requires that most of the configuration is synchronized. In other vPC topologies, the configuration that needs to be synchronized might be a much smaller set of commands.
 
     [bookmark: pgfId-1484415]You need to enter the commit command to complete the import process and move the configuration into the switch profile. Because configuration changes are not supported during the import process, if you added new commands before entering the commit command, the switch profile remains unsaved and the switch remains in the switch profile import mode. You can remove the added commands or abort the import. Unsaved configurations are lost if the process is aborted. You can add new commands to the switch profile after the import is complete. 
 
    
 
     
      [bookmark: pgfId-1484417]Configuration Validation
 
     [bookmark: pgfId-1485763]Two types of configuration validation checks can identify two types of switch profile failures:
 
      
      	 [bookmark: pgfId-1485765]Mutual exclusion checks
 
      	 [bookmark: pgfId-1484425]Merge checks
 
     
 
     [bookmark: pgfId-1484427]Mutual Exclusion Checks
 
     [bookmark: pgfId-1484428]To reduce the possibility of overriding configuration settings that are included in a switch profile, mutual exclusion (mutex) checks the switch profile commands against the commands that exist on the local switch and the commands on the peer switch. A command that is included in a switch profile cannot be configured outside of the switch profile or on a peer switch. This requirement reduces the possibility that an existing command is unintentionally overwritten. 
 
     [bookmark: pgfId-1484430]As a part of the commit process, the mutex-check occurs on both switches if the peer switch is reachable; otherwise, the mutex-check is performed locally. Configuration changes made from the configuration terminal occur only on the local switch.
 
     [bookmark: pgfId-1484432]If a mutex-check identifies errors, these errors are reported as a mutex failure and must be manually corrected.
 
     [bookmark: pgfId-1484434]The following exceptions apply to the mutual exclusion policy:
 
      
      	 [bookmark: pgfId-1484438]Interface configuration—An interface configuration can be partially present in a switch profile and partially present in the running configuration as long as there are no conflicts.
 
      	 [bookmark: pgfId-1484440]Shutdown/no shutdown
 
      	 [bookmark: pgfId-1484442]System QoS
 
     
 
     [bookmark: pgfId-1484444]Merge Checks
 
     [bookmark: pgfId-1484445]Merge checks are done on the peer switch that is receiving a configuration. The merge checks ensure that the received configuration does not conflict with the switch profile configuration that already exists on the receiving switch. The merge check occurs during the merge or commit process. Errors are reported as merge failures and must be manually corrected.
 
     [bookmark: pgfId-1484447]When one or both switches are reloaded and the configurations are synchronized for the first time, the merge check verifies that the switch profile configurations are identical on both switches. Differences in the switch profiles are reported as merge errors and must be manually corrected.
 
    
 
     
      [bookmark: pgfId-1484449]Software Upgrades and Downgrades with Switch Profiles
 
     [bookmark: pgfId-1484451]When you downgrade from Cisco NX-OS Release 5.0(2)N1(1) to an earlier release, you are prompted to remove an existing switch profile that is not supported on earlier releases. 
 
     [bookmark: pgfId-1484453]When you upgrade from an earlier release to Cisco NX-OS Release 5.0(2)N1(1), you have the option to move some of the running-configuration commands to a switch profile. The import command allows you to import relevant switch profile commands. An upgrade can occur if there are buffered configurations (uncommitted); however, the uncommitted configurations are lost.
 
     [bookmark: pgfId-1484455]When you perform an In Service Software Upgrade (ISSU) on one of the switches included in a switch profile, a configuration synchronization cannot occur because the peer is unreachable.
 
    
 
     
      [bookmark: pgfId-1510746][bookmark: 72624]VDC Support
 
     [bookmark: pgfId-1510747]Cisco DCNM treats each virtual device context (VDC) on a Cisco IOS and Cisco NX-OS device as a separate device; therefore, Cisco DCNM archives the running configurations of each VDC if that Cisco DCNM has successfully discovered the VDC and views it as a managed device.
 
    
 
   
 
    
     [bookmark: pgfId-1510749][bookmark: 51127]Licensing Requirements for Configuration Change Management
 
    [bookmark: pgfId-1510750]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1510767]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1510753]Product 
         
  
        	 
          
          [bookmark: pgfId-1510755]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1510757]Cisco DCNM
  
        	[bookmark: pgfId-1510759]Configuration Change Management requires a LAN Enterprise license. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
        
        	[bookmark: pgfId-1510764]Cisco NX-OS
  
        	[bookmark: pgfId-1510766]Configuration Change Management requires no license. Any feature not included in a license package is bundled with the Cisco NX-OS system images and is provided at no extra charge to you. For an explanation of the Cisco NX-OS licensing scheme for your platform, see the licensing guide for your platform. 
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1510769][bookmark: 78783]Prerequisites
 
    [bookmark: pgfId-1510770]The Configuration Change Management feature has the following prerequisites (for a full list of feature-specific prerequisites, see the platform-specific documentation): 
 
     
     	 [bookmark: pgfId-1510771]The Configuration Change Management feature supports only devices that are managed by Cisco DCNM, which means that Cisco DCNM must have successfully discovered the device.
 
     	 [bookmark: pgfId-1510772]The Configuration Change Management feature supports only devices that you have added to the list of Cisco DCNM-licensed devices.
 
     	 [bookmark: pgfId-1510773]Devices must be reachable by Cisco DCNM when Cisco DCNM attempts to archive the configuration or to perform a configuration rollback. An archival job or configuration rollback fails if the device is unreachable by Cisco DCNM.
 
    
 
   
 
    
     [bookmark: pgfId-1510775][bookmark: 87804]Guidelines and Limitations for Configuration Change Management
 
    [bookmark: pgfId-1510776]Configuration Change Management has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1510777]You can archive a maximum of 50 configuration versions per managed device.
 
     	 [bookmark: pgfId-1510778]Configure archival jobs and archival settings based upon the needs of your organization.
 
     	 [bookmark: pgfId-1510779]We recommend enabling the Default archival job and configuring the job to run at the lowest frequency that your backup policy tolerates.
 
     	 [bookmark: pgfId-1510780]A configuration rollback can be performed on managed Cisco Nexus 7000 Series devices only.
 
     	 [bookmark: pgfId-1510781]Access to archived configurations is supported through the Cisco DCNM client only. The client provides features for viewing, comparing, and deleting archived configurations. Each archived configuration is marked with the date and time that Cisco DCNM archived the configuration. For more information, see the “Working with the Version Browser” section.
 
    
 
   
 
    
     [bookmark: pgfId-1510786][bookmark: 64651]Platform Support
 
    [bookmark: pgfId-1510787]The following platforms support this feature but may implement it differently. For platform-specific information, including guidelines and limitations, system defaults, and configuration limits, see the corresponding documentation. 
 
    [bookmark: pgfId-1510823]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1510790]Platform 
         
  
        	 
          
          [bookmark: pgfId-1510792]Documentation 
         
  
       
 
        
        	[bookmark: pgfId-1510794]Cisco Nexus 1000V Series switches
  
        	[bookmark: pgfId-1510797]Cisco Nexus 1000V Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1510799]Cisco Nexus 3000 Series switches
  
        	[bookmark: pgfId-1510802]Cisco Nexus 3000 Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1510804]Cisco Nexus 4000 Series switches
  
        	[bookmark: pgfId-1510807]Cisco Nexus 4000 Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1510809]Cisco Nexus 5000 Series switches
  
        	[bookmark: pgfId-1510812]Cisco Nexus 5000 Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1510814]Cisco Nexus 7000 Series switches
  
        	[bookmark: pgfId-1510817]Cisco Nexus 7000 Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1510819]Cisco Catalyst 6500 Series switches
  
        	[bookmark: pgfId-1510822]Cisco Catalyst 6500 Series Switches Documentation
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1472724][bookmark: 54640]Working with the Version Browser
 
    [bookmark: pgfId-1498757][bookmark: marker-1435996]The version browser allows you to see information about archived configurations, view and compare specific configuration versions, merge changes from one configuration version to another, and roll back the running configuration on a managed device to a configuration version that you specify.
 
    [bookmark: pgfId-1510828]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1510832]Viewing the Archival Status of a Device
 
     	 [bookmark: pgfId-1510836]Viewing the Archival History of a Device
 
     	 [bookmark: pgfId-1510840]Browsing and Commenting on Configuration Versions
 
     	 [bookmark: pgfId-1494133]Using Copy Run to Start
 
     	 [bookmark: pgfId-1510852]Archiving the Current Running Configuration of a Device
 
     	 [bookmark: pgfId-1510856]Viewing an Archived Configuration Version
 
     	 [bookmark: pgfId-1510860]Comparing Configuration Versions
 
     	 [bookmark: pgfId-1510864]Using the Version Comparison Tools
 
     	 [bookmark: pgfId-1510868]Merging Configuration Differences
 
     	 [bookmark: pgfId-1510872]Performing a Configuration Rollback
 
     	 [bookmark: pgfId-1510876]Viewing the Rollback History of a Device
 
     	 [bookmark: pgfId-1510880]Deleting All Archived Configurations for a Device
 
    
 
     
      [bookmark: pgfId-1388646][bookmark: 59028]Viewing the Archival Status of a Device[bookmark: marker-1388645]
 
     [bookmark: pgfId-1388647]You can view the archival status of a device. The archival status for a device includes the following information:
 
      
      	 [bookmark: pgfId-1388898]Whether the archival job that includes the device is enabled or disabled.
 
      	 [bookmark: pgfId-1388950]The schedule for the archival job that includes the device.
 
      	 [bookmark: pgfId-1388971]The job ID of the archival job that includes the device.
 
     
 
    
 
     
      [bookmark: pgfId-1388648]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1403905]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
    
 
     
      [bookmark: pgfId-1388463]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1388465]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1388466]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1388467]Step 2 Click the device that has the archival status that you want to view.
 
     [bookmark: pgfId-1388468]The Details pane displays archive-related information about the device, including an Archival Status section.
 
     [bookmark: pgfId-1414669]If the archival job that includes the device is enabled, the View Schedule link appears.
 
     [bookmark: pgfId-1415228]If the archival job that includes the device is disabled, the Enable Archival Schedule link appears.
 
     [bookmark: pgfId-1389155]Step 3 (Optional) If you want to view the details of the archival job that includes the device, click the View Schedule link or the Enable Archival Schedule link. For more information, see the “Viewing Details of an Archival Job” section.
 
     [bookmark: pgfId-1389156]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1498762]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1498766]Viewing the Archival History of a Device
 
      	 [bookmark: pgfId-1498770]Browsing and Commenting on Configuration Versions
 
      	 [bookmark: pgfId-1498774]Archiving the Current Running Configuration of a Device
 
      	 [bookmark: pgfId-1498778]Viewing an Archived Configuration Version
 
     
 
    
 
     
      [bookmark: pgfId-1383801][bookmark: 32571]Viewing the Archival History of a Device[bookmark: marker-1383800]
 
     [bookmark: pgfId-1388254]You can view the archival history of a device. The archival history records each attempt to create a new archival configuration version from the current running configuration of a device.
 
    
 
     
      [bookmark: pgfId-1383803]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1403889]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
    
 
     
      [bookmark: pgfId-1383804]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1383806]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1388329]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1383808]Step 2 Click the device that has archival history that you want to view.
 
     [bookmark: pgfId-1388338]The Details pane displays archive-related information about the device, including an Archival History section.
 
     [bookmark: pgfId-1383809]Step 3 (Optional) If necessary, click the Archival History section to expand it.
 
     [bookmark: pgfId-1383812]The Archival History section displays a table that lists every attempt made to create a new archival configuration version for the device.
 
     [bookmark: pgfId-1383813]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1498783]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1498787]Viewing the Archival Status of a Device
 
      	 [bookmark: pgfId-1498791]Browsing and Commenting on Configuration Versions
 
      	 [bookmark: pgfId-1498795]Archiving the Current Running Configuration of a Device
 
      	 [bookmark: pgfId-1498799]Viewing an Archived Configuration Version
 
     
 
    
 
     
      [bookmark: pgfId-1383829][bookmark: 23271]Browsing and Commenting on Configuration Versions[bookmark: marker-1383828]
 
     [bookmark: pgfId-1383830]You can browse the archived configuration versions for managed devices. Browsing allows you to see information about all versions of an archived configuration.
 
     [bookmark: pgfId-1387829]You can also add, change, or delete comments on any version of an archived configuration.
 
    
 
     
      [bookmark: pgfId-1404163]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1404164]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
     [bookmark: pgfId-1404165]The archived configuration versions that you want to browse or comment on must exist in Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1404166]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1387959]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1387960]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1387961]Step 2 Double-click the device that has archived configuration versions that you want to browse.
 
     [bookmark: pgfId-1387979]A list of archived configuration versions appears below the device that you double-clicked. For each version, the Summary pane shows the version ID, the date and time that Cisco DCNM created the version, the Cisco DCNM user who created the version, and comments about the version.
 
     [bookmark: pgfId-1383836]Step 3 (Optional) If you want to comment on a version, follow these steps:
 
     [bookmark: pgfId-1388120] a. Click the version that you want to update with comments.
 
     [bookmark: pgfId-1388160]The Details pane shows the Version Details tab, which contains the same information about the version that appears in the Summary pane, except that the Comments field is available for you to use.
 
     [bookmark: pgfId-1388200] b. Click in the Comments field and enter your comments.
 
     [bookmark: pgfId-1388231] c. From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1383841]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1498804]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1498808]Configuring Version and History Settings
 
      	 [bookmark: pgfId-1498812]Viewing the Archival Status of a Device
 
      	 [bookmark: pgfId-1498816]Viewing the Archival History of a Device
 
      	 [bookmark: pgfId-1498820]Archiving the Current Running Configuration of a Device
 
      	 [bookmark: pgfId-1498824]Viewing an Archived Configuration Version
 
      	 [bookmark: pgfId-1498828]Comparing Configuration Versions
 
      	 [bookmark: pgfId-1498832]Deleting All Archived Configurations for a Device
 
     
 
    
 
     
      [bookmark: pgfId-1481062][bookmark: 99634]Using Copy Run to Start
 
     [bookmark: pgfId-1481063]You can use the Copy Run to Start feature to copy the running configuration to the startup configuration.
 
    
 
     
      [bookmark: pgfId-1481064]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1481065]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1481066]The available devices appear in the Summary pane.
 
     [bookmark: pgfId-1481067]Step 2 Right-click the appropriate device and from the drop-down list, choose Copy Run to Start. You can also press the F7 key to start the Copy Run to Start feature.
 
     [bookmark: pgfId-1481068]A flag appears at the end of the row to indicate that the copy process is in progress. The flag remains when the process is finished to indicate that a configuration change has been made to the device.
 
     [bookmark: pgfId-1481069]The running configuration is copied to the startup configuration.
 
     [bookmark: pgfId-1481070]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383857][bookmark: 12298]Archiving the Current Running Configuration of a Device[bookmark: marker-1383856]
 
     [bookmark: pgfId-1383858]You can archive the current running configuration of a managed device.
 
     [bookmark: pgfId-1387311]Archiving the current running configuration succeeds only if the most recent archived version in Cisco DCNM is different from the current running configuration.
 
    
 
     
      [bookmark: pgfId-1383859]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1387129]The device must be managed and reachable.
 
     [bookmark: pgfId-1403958]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
    
 
     
      [bookmark: pgfId-1383860]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1387214]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1387215]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1387216]Step 2 Click the device that has a running configuration that you want to archive now.
 
     [bookmark: pgfId-1387281]Step 3 From the menu bar, choose Actions > Archive Configuration.
 
     [bookmark: pgfId-1383868]Step 4 To confirm that Cisco DCNM successfully archived the configuration, view the list of archived configuration versions for the device. If necessary, double-click the device to open the list. The new version should appear at the top of the list.
 
      
       
     
 
     
 
     [bookmark: pgfId-1387367]Note If a dialog box notifies you that archiving the configuration was skipped, that means that Cisco DCNM did not detect differences between the current running configuration and the most recent archived configuration version for the device. To close the dialog box, click OK.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1383869]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1498837]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1498841]Browsing and Commenting on Configuration Versions
 
      	 [bookmark: pgfId-1498845]Viewing an Archived Configuration Version
 
      	 [bookmark: pgfId-1498849]Comparing Configuration Versions
 
      	 [bookmark: pgfId-1498853]Deleting All Archived Configurations for a Device
 
     
 
    
 
     
      [bookmark: pgfId-1383885][bookmark: 16430]Viewing an Archived Configuration Version[bookmark: marker-1383884]
 
     [bookmark: pgfId-1383886]You can view a version of an archived configuration.
 
    
 
     
      [bookmark: pgfId-1383887]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1403832]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
     [bookmark: pgfId-1386865]The archived configuration version that you want to view must exist in Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1383888]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1386748]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1386749]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1386750]Step 2 Click the device that has an archived configuration version that you want to view.
 
     [bookmark: pgfId-1386913]Step 3 (Optional) If necessary, to view the list of archived configuration versions for the device, double-click the device.
 
     [bookmark: pgfId-1386914]Step 4 Click the version of the archived configuration that you want to view.
 
     [bookmark: pgfId-1383892]Step 5 From the menu bar, choose Actions > View Configuration.
 
     [bookmark: pgfId-1386989]In the Details pane, the Configuration tab displays the configuration version that you selected.
 
      
       
     
 
     
 
     [bookmark: pgfId-1392802]Tip You can search the text of the configuration by pressing Ctrl + F.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1383897]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1498858]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1498862]Browsing and Commenting on Configuration Versions
 
      	 [bookmark: pgfId-1498866]Archiving the Current Running Configuration of a Device
 
      	 [bookmark: pgfId-1498870]Comparing Configuration Versions
 
      	 [bookmark: pgfId-1498874]Deleting All Archived Configurations for a Device
 
     
 
    
 
     
      [bookmark: pgfId-1383913][bookmark: 51408]Comparing Configuration Versions[bookmark: marker-1405467]
 
     [bookmark: pgfId-1383914]You can compare two configuration versions. The configurations that you can compare can be any two archived configuration version in Cisco DCNM, including archived configurations from different managed devices. You can also compare an archived configuration versions to the running configuration or the startup configuration of a managed device.
 
    
 
     
      [bookmark: pgfId-1383915]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1404170]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
     [bookmark: pgfId-1386605]If you are comparing archived configuration versions, the two versions must exist in Cisco DCNM.
 
     [bookmark: pgfId-1392237]If you are comparing an archived configuration version to a running configuration or startup configuration on a managed device, the device must be reachable by Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1386588]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1383918]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
     [bookmark: pgfId-1385626]The Summary pane displays a table of devices.
 
     [bookmark: pgfId-1385627]Step 2 Double-click the device that has an archived configuration version that you want to compare to another configuration version.
 
     [bookmark: pgfId-1394094]Step 3 (Optional) If necessary, to view the list of archived configurations for the device, double-click the device.
 
     [bookmark: pgfId-1394140]Step 4 Click the archived configuration version that you want to compare to another configuration version.
 
     [bookmark: pgfId-1497899]Step 5 Use Table 23-1 to compare the selected version to the configuration version that you want.
 
     [bookmark: pgfId-1497996]Table 23-1 [bookmark: 29892]Comparing Configuration Versions
 
     [bookmark: pgfId-1498043]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1498000]To Compare With 
          
  
         	 
           
           [bookmark: pgfId-1498002]Follow These Steps 
          
  
        
 
         
         	[bookmark: pgfId-1498004]Most recent configuration version from the current device
  
         	[bookmark: pgfId-1498006]Right-click the version and choose Compare with > Latest.
  
        
 
         
         	[bookmark: pgfId-1498008]Next configuration version from the current device
  
         	[bookmark: pgfId-1498010]Right-click the version and choose Compare with > Next.
  
        
 
         
         	[bookmark: pgfId-1498012]Previous configuration version from the current device
  
         	[bookmark: pgfId-1498014]Right-click the version and choose Compare with > Previous.
  
        
 
         
         	[bookmark: pgfId-1498016]Another configuration version that you select
  
         	[bookmark: pgfId-1498018] 1. Press and hold the Ctrl key.
 [bookmark: pgfId-1498019] 2. Click the archived configuration version that you want to compare the first selected version to, and then release the Ctrl key.
 [bookmark: pgfId-1498020] 3. Right-click either selected configuration version and choose Compare with > Selected Versions.
 [bookmark: pgfId-1498021]The selected configuration versions appear in the two configuration panes on the Compare tab. The configuration version that is listed highest in the Summary pane appears in the left configuration pane.
 [bookmark: pgfId-1498022]Tip You can select archived configuration versions from different devices.  
        
 
         
         	[bookmark: pgfId-1498024]Current running configuration from the current device
  
         	[bookmark: pgfId-1498026]Right-click the version and choose Compare with > Current Running Configuration.
  
        
 
         
         	[bookmark: pgfId-1498028]Current startup configuration from the current device
  
         	[bookmark: pgfId-1498030]Right-click the version and choose Compare with > Current Startup Configuration.
  
        
 
         
         	[bookmark: pgfId-1498032]A configuration version from another device
  
         	[bookmark: pgfId-1498034] 1. Right-click the version and choose Compare with > Another Device Configuration Version.
 [bookmark: pgfId-1498035]In the Details pane, the Compare tab shows the selected configuration version in the left configuration pane.
 [bookmark: pgfId-1498036] 2. From the Device list above the right configuration pane, choose the device that has the configuration version that you want to compare with the configuration in the left pane.
 [bookmark: pgfId-1498037] 3. From the Version list, pick the configuration version that you want to compare. You can use any version archived by Cisco DCNM or you can use the running configuration or the startup configuration currently on the device.
 icon.
 [bookmark: pgfId-1498042]The right configuration pane displays the configuration version that you specified.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1396204]In the Details pane, the Compare tab displays the two configuration versions in side-by-side panes.
 
     [bookmark: pgfId-1403974]Step 6 Use the version comparison tools as needed. For more information, see the “Using the Version Comparison Tools” section.
 
     [bookmark: pgfId-1396205]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1498879]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1498883]Viewing an Archived Configuration Version
 
      	 [bookmark: pgfId-1498887]Using the Version Comparison Tools
 
      	 [bookmark: pgfId-1498891]Merging Configuration Differences
 
     
 
    
 
     
      [bookmark: pgfId-1405483][bookmark: 21914]Using the Version Comparison Tools[bookmark: marker-1405487]
 
     [bookmark: pgfId-1405484]When you use the Version Browser to compare configuration versions, use the Compare tab in the Details pane to assist you with the comparison.
 
      
       
     
 
     
 
     [bookmark: pgfId-1389617]Note You must be comparing two configurations to use the version comparison tools. For more information, see the “Comparing Configuration Versions” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1397547]Use the options described Table 23-1 to compare two configuration versions.
 
     [bookmark: pgfId-1494281]Table 23-2 [bookmark: 24316]Using the Comparision Version Tool
 
     [bookmark: pgfId-1389745]
 
      
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
       
       	 [bookmark: pgfId-1391218]Undo all configuration merges.
 
       	 [bookmark: pgfId-1391373]Remove all bookmarks.
 
       	 [bookmark: pgfId-1391238]Jump to the first line in both configuration panes.
 
       	 [bookmark: pgfId-1391255]Use the Full Configuration view.
 
      
 
      
 
      
 
      
 
       
        
         
         	 
           
           [bookmark: pgfId-1389978]Option Icon and Name 
          
  
         	 
           
           [bookmark: pgfId-1389980]How to Use the Option 
          
  
        
 
        
          Full vs. Delta View 
         	[bookmark: pgfId-1389984]From the list, choose the desired viewing option, as follows:
 
           
           	 [bookmark: pgfId-1389985]
 
           [image: ] —Shows all of both configuration versions. 
          
 
           
           	 [bookmark: pgfId-1389986]
 
           [image: ] —Shows only the sections of each configuration that differ. 
          
  
        
 
        
          Next Diff icon to jump to the next difference between the two configurations shown. 
        
 
        
          Prev Diff icon to jump to the previous difference between the two configurations shown. 
        
 
        
          Bookmark 
         	[bookmark: pgfId-1390137] 1. Click a line in one of the configuration panes.
 icon.
 [bookmark: pgfId-1390174]A bookmark icon appears beside the line number.
  
        
 
        
          Next Bookmark 
         	[bookmark: pgfId-1390192] 1. Click the configuration pane that has the bookmarked line that you want to view.
 icon.
 [bookmark: pgfId-1390113]The configurations in both panes jump to the next bookmarked line.
  
        
 
        
          Prev Bookmark 
         	[bookmark: pgfId-1391010] 1. Click the configuration pane that has the bookmarked line that you want to view.
 icon.
 [bookmark: pgfId-1391012]The configurations in both panes jump to the previous bookmarked line.
  
        
 
        
          Compare 
         	[bookmark: pgfId-1390010]Use this option to choose the archived configuration version shown in the right configuration pane.
 [bookmark: pgfId-1391087] 1. From the Device list, choose the device that has the configuration version that you want to compare with the configuration in the left pane.
 [bookmark: pgfId-1416725] 2. From the Version list, pick the configuration version that you want to compare. You can use any version archived by Cisco DCNM or you can use the running configuration or the startup configuration currently on the device.
 icon.
 [bookmark: pgfId-1391365]The right configuration pane displays the configuration version that you specified.
  
        
 
        
          Reset icon when you want to do the following: 
        
 
        
          Merge 
         	[bookmark: pgfId-1390018]Use this option to copy a difference from the configuration in the left configuration pane into the configuration in the right pane.
 [bookmark: pgfId-1391884]For detailed steps, see the “Merging Configuration Differences” section.
  
        
 
        
          Save As icon to save the configuration in the right pane to a filename and location that you specify in the Save dialog box that appears. 
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1498896]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1498900]Viewing an Archived Configuration Version
 
      	 [bookmark: pgfId-1498904]Comparing Configuration Versions
 
      	 [bookmark: pgfId-1498908]Merging Configuration Differences
 
     
 
    
 
     
      [bookmark: pgfId-1398855][bookmark: 44207]Merging Configuration Differences[bookmark: marker-1405612]
 
     [bookmark: pgfId-1392034]While you are comparing two configuration versions, you can merge lines that contain differences. The merge feature allows you to merge a whole line shown in the left configuration pane into the configuration that is shown in the right configuration pane.
 
    
 
     
      [bookmark: pgfId-1396756]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1396830]You must be comparing two configuration versions that have differences.
 
     [bookmark: pgfId-1397101]Ensure that the configuration version that you want to want to merge the changes into appears in the right configuration pane.
 
    
 
     
      [bookmark: pgfId-1397189]DETAILED STEPS
 
     
 icon as needed to jump to the line that you want to merge from the left configuration pane into the right configuration pane. 
     
 
      
       
     
 
     
 
    
 
    
 icon. 
    
 
    [bookmark: pgfId-1417017]The selected configuration line in the left pane replaces the selected line in the right pane.
 
    [bookmark: pgfId-1404029]Step 3 Repeat Step 1 and Step 2 as often as needed.
 
     
      
    
 
    
 
   
 
   
 icon and use the Save dialog box to save the configuration to a filename and location that you specify. 
   
 
   [bookmark: pgfId-1397260]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1498913]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1498917]Viewing an Archived Configuration Version
 
     	 [bookmark: pgfId-1498921]Comparing Configuration Versions
 
     	 [bookmark: pgfId-1498925]Using the Version Comparison Tools
 
    
 
   
 
    
     [bookmark: pgfId-1386614][bookmark: 63250]Performing a Configuration Rollback[bookmark: marker-1383940]
 
    [bookmark: pgfId-1383942]You can roll back the configuration of a managed Cisco Nexus 7000 Series device to any previous version that is archived by Cisco DCNM. A rollback replaces the running configuration of the managed device with an archived configuration version that you specify.
 
   
 
    
     [bookmark: pgfId-1383943]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1404271]A managed Cisco Nexus 7000 Series device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
    [bookmark: pgfId-1385506]The archived configuration version that you want to use in the rollback must exist in Cisco DCNM.
 
   
 
    
     [bookmark: pgfId-1383944]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1383946]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
    [bookmark: pgfId-1386507]The Summary pane displays a table of devices.
 
    [bookmark: pgfId-1386508]Step 2 Click the Cisco Nexus 7000 Series device for which you want to perform a configuration rollback.
 
    [bookmark: pgfId-1386509]The Details pane displays archival information about the device, including a Rollback History section.
 
    [bookmark: pgfId-1386510]Step 3 (Optional) If necessary, to view the list of archived configurations for the device, double-click the device.
 
    [bookmark: pgfId-1386511]Step 4 Click the version of the archived configuration that you want to use as the running configuration on the device.
 
    [bookmark: pgfId-1386512]Step 5 Do one of the following:
 
     
      
      	 [bookmark: pgfId-1386513]If you want to save the configuration version that you selected as the startup configuration on the device, choose one of the following rollback options:
 
     
 
    
 
    [bookmark: pgfId-1386514] – If you want Cisco DCNM to restore the original running configuration of the device if any configuration command fails during the rollback, from the menu bar, choose Actions > Rollback and Save as Start-up > Restore Original Config on Error (Atomic).
 
    [bookmark: pgfId-1386515] – If you want Cisco DCNM to ignore configuration errors during a rollback, from the menu bar, choose Actions > Rollback and Save as Start-up > Skip Errors and Rollback (Best Effort).
 
    [bookmark: pgfId-1386516] – If you want Cisco DCNM to stop the rollback at the first configuration error, from the menu bar, choose Actions > Rollback and Save as Start-up > Stop Rollback at First Error.
 
     
      
      	 [bookmark: pgfId-1386517]If you want the rollback to proceed without affecting the startup configuration currently on the device, choose one of the following rollback options:
 
     
 
    
 
    [bookmark: pgfId-1386518] – If you want Cisco DCNM to restore the original running configuration of the device if any configuration command fails during the rollback, from the menu bar, choose Actions > Rollback > Restore Original Config on Error (Atomic).
 
    [bookmark: pgfId-1386519] – If you want Cisco DCNM to ignore configuration errors during a rollback, from the menu bar, choose Actions > Rollback > Skip Errors and Rollback (Best Effort).
 
    [bookmark: pgfId-1386520] – If you want Cisco DCNM to stop the rollback at the first configuration error, from the menu bar, choose Actions > Rollback > Stop Rollback at First Error.
 
    [bookmark: pgfId-1386521]Cisco DCNM begins the rollback operation.
 
    [bookmark: pgfId-1383953]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1498930]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1498934]Browsing and Commenting on Configuration Versions
 
     	 [bookmark: pgfId-1498938]Archiving the Current Running Configuration of a Device
 
     	 [bookmark: pgfId-1498942]Viewing an Archived Configuration Version
 
     	 [bookmark: pgfId-1498946]Comparing Configuration Versions
 
     	 [bookmark: pgfId-1498950]Viewing the Rollback History of a Device
 
    
 
   
 
    
     [bookmark: pgfId-1404325][bookmark: 74633]Viewing the Rollback History of a Device[bookmark: marker-1404324]
 
    [bookmark: pgfId-1404326]You can view the rollback history of a Cisco Nexus 7000 Series device.
 
   
 
    
     [bookmark: pgfId-1404327]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1404434]A managed Cisco Nexus 7000 Series device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. Only licensed devices appear in the Version Browser.
 
   
 
    
     [bookmark: pgfId-1404348]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1385332]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
    [bookmark: pgfId-1385333]The Summary pane displays a table of devices.
 
    [bookmark: pgfId-1385334]Step 2 Click the device for which you want to view the rollback history.
 
    [bookmark: pgfId-1383980]The Details pane displays archival information about the device, including a Rollback History section.
 
    [bookmark: pgfId-1385444]Step 3 (Optional) If necessary, double-click the Rollback History section to expand it.
 
    [bookmark: pgfId-1385468]In the Rollback History section, a table of rollback history events appears. If no configuration rollbacks have occurred on the device, the table is empty.
 
    [bookmark: pgfId-1383981]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1498955]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1498959]Browsing and Commenting on Configuration Versions
 
     	 [bookmark: pgfId-1498963]Archiving the Current Running Configuration of a Device
 
     	 [bookmark: pgfId-1498967]Viewing an Archived Configuration Version
 
     	 [bookmark: pgfId-1498971]Comparing Configuration Versions
 
     	 [bookmark: pgfId-1498975]Performing a Configuration Rollback
 
    
 
   
 
    
     [bookmark: pgfId-1383997][bookmark: 82761]Deleting All Archived Configurations for a Device[bookmark: marker-1383996]
 
    [bookmark: pgfId-1383998]You can delete all the archived configuration versions of a device.
 
     
      
    
 
    
 
    [bookmark: pgfId-1385001]Note You cannot delete a specific version of an archived configuration.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1383999]BEFORE YOU BEGIN
 
    [bookmark: pgfId-1385161]Be certain that you do not want any of the archived configuration versions for the device. You cannot undo the deletion and the Cisco DCNM client does not confirm your choice to delete the archived configuration versions.
 
   
 
    
     [bookmark: pgfId-1385157]DETAILED STEPS
 
    
 
    [bookmark: pgfId-1384001]Step 1 From the Feature Selector pane, choose Configuration Change Management > Version Browser.
 
    [bookmark: pgfId-1384002]The Summary pane displays a table of devices.
 
    [bookmark: pgfId-1384003]Step 2 Click the device that has archived configurations that you want to delete.
 
    [bookmark: pgfId-1385187]Step 3 Verify that you clicked the correct device.
 
     
      
    
 
    
 
    [bookmark: pgfId-1385218]Note The next step deletes the archived configuration versions without confirming your choice.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1384004]Step 4 From the menu bar, choose Actions > Delete All Versions.
 
    [bookmark: pgfId-1385249]The archived configurations for the selected device disappear from the Summary pane.
 
    [bookmark: pgfId-1384008]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1498980]RELATED TOPICS
 
     
     	 [bookmark: pgfId-1498984]Browsing and Commenting on Configuration Versions
 
     	 [bookmark: pgfId-1498988]Archiving the Current Running Configuration of a Device
 
     	 [bookmark: pgfId-1498992]Viewing an Archived Configuration Version
 
     	 [bookmark: pgfId-1498996]Comparing Configuration Versions
 
    
 
   
 
    
     [bookmark: pgfId-1399578][bookmark: 21980]Configuring Archival Jobs[bookmark: marker-1405613]
 
    [bookmark: pgfId-1499001]The Archival Jobs feature allows you to control the automated archival of the running configuration on managed devices.
 
    [bookmark: pgfId-1510885]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1510889]Configuring an Archival Job
 
     	 [bookmark: pgfId-1510893]Enabling and Disabling an Archival Job
 
     	 [bookmark: pgfId-1510897]Deleting an Archival Job
 
     	 [bookmark: pgfId-1510901]Viewing Details of an Archival Job
 
     	 [bookmark: pgfId-1510905]Viewing the History of an Archival Job
 
    
 
     
      [bookmark: pgfId-1384057][bookmark: 20691]Configuring an Archival Job[bookmark: marker-1384056]
 
     [bookmark: pgfId-1384058]You can create an archival job or make changes to an existing archival job.
 
      
       
     
 
     
 
     [bookmark: pgfId-1384691]Note By default, a new archival job is enabled.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1404460]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1404537]A managed device must be on the list of Cisco DCNM-licensed devices before you can use it with Configuration Change Management. You can include only licensed devices in an archival job.
 
    
 
     
      [bookmark: pgfId-1404538]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1384061]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384062]The Summary pane displays a table of archival jobs.
 
     [bookmark: pgfId-1384063]Step 2 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1384064]If you want to create an archival job, from the menu bar, choose  File > New Job .
 
       	 [bookmark: pgfId-1384065]If you want to make changes to an existing archival job, in the Summary pane, click the job that you want to change.
 
      
 
     
 
     [bookmark: pgfId-1384066]The Details pane shows the Details tab and Archival History tab for the job.
 
     [bookmark: pgfId-1384067]Step 3 (Optional) If necessary, in the Details pane, click the Details tab.
 
     [bookmark: pgfId-1384068]Step 4 (Optional) In the Comments field, enter your comments about the job.
 
     [bookmark: pgfId-1384069]Step 5 (Optional) If you want the job to archive configurations at a specific time, follow these steps:
 
     [bookmark: pgfId-1384070] a. Click the Archive at Specified Time radio button.
 
     [bookmark: pgfId-1384071] b. In the row of Days check boxes, check the check box for each day that you want the archival job to be active.
 
     [bookmark: pgfId-1384072] c. Do one of the following:
 
     [bookmark: pgfId-1384073] – If you want the job to archive configurations at a regular interval, click the Archive Interval radio button and use the adjacent box and list to specify the interval. You can specify an interval in minutes or hours. The maximum interval is either 59 minutes or 23 hours.
 
     [bookmark: pgfId-1384074] – If you want the job to archive configurations once on each day that the job is active, click the Archive at radio button and use the adjacent box to specify the time that you want the job to start.
 
     [bookmark: pgfId-1384075]Step 6 (Optional) If you want the job to archive configurations at any time that Cisco DCNM detects a change to the configuration of a device included in the job, click the Archive whenever a Configuration Change is Detected radio button.
 
     [bookmark: pgfId-1384076]Step 7 (Optional) If you want to add one or more devices to the archival job, follow these steps:
 
     [bookmark: pgfId-1384077] a. Under Device, right-click in a blank area and choose Add New Device.
 
     [bookmark: pgfId-1415381]A dialog box shows available and selected devices.
 
     [bookmark: pgfId-1415365] a. For each device that you want to add, under Available Devices, click the device and click Add.
 
      
       
     
 
     
 
     [bookmark: pgfId-1384079]Tip To add all devices to the job, click Add All.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1384080] b. Click OK.
 
     [bookmark: pgfId-1384783]The devices that you added appear under Devices.
 
     [bookmark: pgfId-1384081]Step 8 (Optional) If you want to remove a device from an archival job, follow these steps:
 
     [bookmark: pgfId-1384082] a. Under Devices, click the device that you want to remove from the job.
 
     [bookmark: pgfId-1384083] b. Right-click the device and choose Remove Device.
 
     [bookmark: pgfId-1384814]The device that you removed no longer appears under Devices.
 
     [bookmark: pgfId-1384085]Step 9 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1384844]If you created an archival job, it is enabled by default. If you changed an existing archival job, whether it is enabled or disabled, the archival job information does not change.
 
     [bookmark: pgfId-1384086]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1499006]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1499010]Enabling and Disabling an Archival Job
 
      	 [bookmark: pgfId-1499014]Deleting an Archival Job
 
      	 [bookmark: pgfId-1499018]Viewing Details of an Archival Job
 
      	 [bookmark: pgfId-1499022]Viewing the History of an Archival Job
 
     
 
    
 
     
      [bookmark: pgfId-1384102][bookmark: 87932]Enabling and Disabling an Archival Job[bookmark: marker-1384101]
 
     [bookmark: pgfId-1384103]You can enable or disable any archival job.
 
    
 
     
      [bookmark: pgfId-1404543]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1384106]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384107]The Summary pane displays a table of archival jobs. In the Job ID column, enabled jobs show a green triangle and disabled jobs show a red square.
 
     [bookmark: pgfId-1384108]Step 2 In the Summary pane, click the archival job that you want to enable or disable.
 
     [bookmark: pgfId-1384109]Step 3 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1384110]To enable the job, from the menu bar, choose  Actions > Enable . The icon in the Job ID column changes to show a green triangle.
 
       	 [bookmark: pgfId-1384111]To disable the job, from the menu bar, choose  Actions > Disable . The icon in the Job ID column changes to show a red square.
 
      
 
     
 
     [bookmark: pgfId-1384112]You do not need to save your changes.
 
     [bookmark: pgfId-1384113]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1499027]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1499031]Configuring an Archival Job
 
      	 [bookmark: pgfId-1499035]Deleting an Archival Job
 
      	 [bookmark: pgfId-1499039]Viewing Details of an Archival Job
 
      	 [bookmark: pgfId-1499043]Viewing the History of an Archival Job
 
     
 
    
 
     
      [bookmark: pgfId-1384129][bookmark: 49488]Deleting an Archival Job[bookmark: marker-1384128]
 
     [bookmark: pgfId-1384130]You can delete an archival job but not the Default archival job. When you delete an archival job, any devices included in the deleted job are automatically added to the Default archival job.
 
    
 
     
      [bookmark: pgfId-1384131]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1384132]At least one custom archival job must exist in Cisco DCNM. You cannot delete the Default archival job.
 
    
 
     
      [bookmark: pgfId-1384133]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1384135]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384136]The Summary pane displays a table of archival jobs.
 
     [bookmark: pgfId-1384137]Step 2 In the Summary pane, click the archival job that you want to delete.
 
     [bookmark: pgfId-1384138]Step 3 From the menu bar, choose Actions > Delete.
 
     [bookmark: pgfId-1384139]The archival job disappears from the Summary pane.
 
     [bookmark: pgfId-1384140]Devices that were included in the deleted job are automatically added to the Default archival job.
 
     [bookmark: pgfId-1384141]You do not need to save your changes.
 
     [bookmark: pgfId-1384142]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1499048]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1499052]Configuring an Archival Job
 
      	 [bookmark: pgfId-1499056]Enabling and Disabling an Archival Job
 
      	 [bookmark: pgfId-1499060]Viewing Details of an Archival Job
 
      	 [bookmark: pgfId-1499064]Viewing the History of an Archival Job
 
     
 
    
 
     
      [bookmark: pgfId-1384158][bookmark: 20709]Viewing Details of an Archival Job[bookmark: marker-1384157]
 
     [bookmark: pgfId-1384159]You can view the details of an archival job, which include the job ID, the owner of the job, comments about the job, the job schedule, and the devices included in the job.
 
    
 
     
      [bookmark: pgfId-1384160]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1384162]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384163]The Summary pane displays a table of archival jobs.
 
     [bookmark: pgfId-1384164]Step 2 In the Summary pane, click the archival job that has details that you want to view.
 
     [bookmark: pgfId-1384165]The Details pane displays information about the archival job, including a Details tab.
 
     [bookmark: pgfId-1384166]Step 3 (Optional) If necessary, in the Details pane, click the Details tab.
 
     [bookmark: pgfId-1384167]The Details pane displays information and settings for the archival job that you selected.
 
     [bookmark: pgfId-1384168]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1499069]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1499073]Configuring an Archival Job
 
      	 [bookmark: pgfId-1499077]Enabling and Disabling an Archival Job
 
      	 [bookmark: pgfId-1499081]Deleting an Archival Job
 
      	 [bookmark: pgfId-1499085]Viewing the History of an Archival Job
 
     
 
    
 
     
      [bookmark: pgfId-1384184][bookmark: 94750]Viewing the History of an Archival Job[bookmark: marker-1384183]
 
     [bookmark: pgfId-1384185]You can view the history of an archival job.
 
    
 
     
      [bookmark: pgfId-1384186]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1384187]The archival job must have occurred at least once; otherwise, there are no archival history entries to view.
 
    
 
     
      [bookmark: pgfId-1384188]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1384190]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Jobs.
 
     [bookmark: pgfId-1384191]The Summary pane displays a table of archival jobs.
 
     [bookmark: pgfId-1384192]Step 2 In the Summary pane, click the archival job that has archival history that you want to view.
 
     [bookmark: pgfId-1384193]The Details pane displays information about the archival job, including an Archival History tab.
 
     [bookmark: pgfId-1384194]Step 3 In the Details pane, click the Archival History tab.
 
     [bookmark: pgfId-1384195]The Details pane displays a list of archival history entries, ordered by the date and time when the entry occurred.
 
     [bookmark: pgfId-1384196]Step 4 (Optional) To see additional details about an archival history entry, in the Status column, click the plus symbol (+) to expand the entry.
 
     [bookmark: pgfId-1384197]The expanded entry lists information for each device included in the entry.
 
     [bookmark: pgfId-1384198]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1499090]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1499094]Configuring an Archival Job
 
      	 [bookmark: pgfId-1499098]Enabling and Disabling an Archival Job
 
      	 [bookmark: pgfId-1499102]Deleting an Archival Job
 
      	 [bookmark: pgfId-1499106]Viewing Details of an Archival Job
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1396396][bookmark: 27537]Configuring Archival Settings[bookmark: marker-1405614]
 
    [bookmark: pgfId-1499111]The Archival Settings feature allows you to configure settings related to configuration change management, including the number of configuration versions that Cisco DCNM stores for each managed device, how many rollback and archival history entries Cisco DCNM stores for each managed device, and which file server Cisco DCNM uses during a configuration rollback.
 
    [bookmark: pgfId-1510910]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1510914]Configuring Version and History Settings
 
     	 [bookmark: pgfId-1510918]Configuring the Rollback File Server Setting
 
    
 
     
      [bookmark: pgfId-1384231][bookmark: 88623]Configuring Version and History Settings[bookmark: marker-1384230]
 
     [bookmark: pgfId-1384232]You can configure the following settings about configuration versions and history:
 
      
      	 [bookmark: pgfId-1384233]Maximum number of configuration versions that Cisco DCNM archives per managed device.
 
      	 [bookmark: pgfId-1384234]Maximum number of rollback history and archival history status entries that Cisco DCNM retains per managed device.
 
     
 
    
 
     
      [bookmark: pgfId-1384235]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1384237]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Settings.
 
     [bookmark: pgfId-1384238]The Contents pane displays the Archival Settings fields.
 
     [bookmark: pgfId-1384239]Step 2 (Optional) Enter a value from 0 to 50 in the Maximum Version for a Device [0 - 50] field to configure the maximum number of configuration versions that Cisco DCNM should archive for each managed device.
 
     [bookmark: pgfId-1384240]Step 3 (Optional) Enter a value from 0 to 100 in the Max Rollback and Archival History Status [0 - 100] field to configure the maximum number of rollback history and archival history status entries that Cisco DCNM retains for each managed device.
 
     [bookmark: pgfId-1384241]Step 4 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1384242]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1499116]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1499120]Browsing and Commenting on Configuration Versions
 
      	 [bookmark: pgfId-1499124]Configuring the Rollback File Server Setting
 
     
 
    
 
     
      [bookmark: pgfId-1384257][bookmark: 78807]Configuring the Rollback File Server Setting[bookmark: marker-1384256]
 
     [bookmark: pgfId-1384258]You can configure whether Cisco DCNM uses a specific file server during a configuration rollback or whether it uses any available file server that you have configured.
 
    
 
     
      [bookmark: pgfId-1384259]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1384262]You must configure at least one file server in Cisco DCNM. For more information, see the “Adding a File Server” section.
 
    
 
     
      [bookmark: pgfId-1384264]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1384266]Step 1 From the Feature Selector pane, choose Configuration Change Management > Archival Settings.
 
     [bookmark: pgfId-1384267]The Contents pane displays the Archival Settings fields.
 
     [bookmark: pgfId-1384268]Step 2 (Optional) If you want Cisco DCNM to use any available file server during a configuration rollback, under File Server for Configuration Rollback, click the Any File Server radio button.
 
     [bookmark: pgfId-1384269]Step 3 (Optional) If you want to specify a file server that Cisco DCNM should use during a configuration rollback, follow these steps:
 
     [bookmark: pgfId-1384270] a. Under File Server for Configuration Rollback, click the Use the following File Server radio button.
 
     [bookmark: pgfId-1384271] b. From the File Server drop-down list, choose the file server.
 
     [bookmark: pgfId-1384272]Step 4 From the menu bar, choose File > Deploy to save your changes to the Cisco DCNM server.
 
     [bookmark: pgfId-1384273]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1484245][bookmark: 50478][bookmark: marker-1495480]Configuring Switch Profiles
 
    [bookmark: pgfId-1510923]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1487277]Configuring a Switch Profile
 
     	 [bookmark: pgfId-1487783]Configuring the Switch Profile Wizard Between Two vPCs
 
     	 [bookmark: pgfId-1487804]Configuring the Switch Profile Wizard Between Two Switches
 
     	 [bookmark: pgfId-1488568]Configuring the Sync Network View
 
     	 [bookmark: pgfId-1488589]Configuring the Switch Profile Migration Wizard for Dual Homed FEXes
 
    
 
     
      [bookmark: pgfId-1487279][bookmark: 22303]Configuring a Switch Profile
 
     [bookmark: pgfId-1494353]You can configure a switch profile using Cisco DCNM.
 
      
       
     
 
     
 
     [bookmark: pgfId-1494360]Note This feature is supported only on Cisco Nexus 5000 Series switches.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1486822]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1486842]You must create the switch profile with the same name on each switch and the switches must configure each other as a peer. When connectivity is established between switches with the same active switch profile, the switch profiles are synchronized.
 
    
 
     
      [bookmark: pgfId-1486827]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1486828]Step 1 From the Feature Selector pane, choose Configuration Change Management > Switch-Profile.
 
     [bookmark: pgfId-1486890]All Cisco Nexus 5000 Series switches that are managed by Cisco DCNM are displayed in the Summary pane.
 
     [bookmark: pgfId-1486885]Step 2 Expand the Cisco Nexus 5000 switches to view the switch-profile information.
 
     [bookmark: pgfId-1484266]Step 3 Choose a specific switch-profile for the Cisco Nexus 5000 Series switch. The profile details is displayed in the detailed pane.
 
     [bookmark: pgfId-1486939]You can choose one of the following four options:
 
      
       
       	 [bookmark: pgfId-1486956]Sync Status—Displays the last session operation status on the switch profile.
 
       	 [bookmark: pgfId-1486958]Effective Configuration—Displays the most effective switch-profile configurations on the switch.
 
       	 [bookmark: pgfId-1486960]Buffered Configuration—Displays the non committed switch-profile configurations on the switch.
 
       	 [bookmark: pgfId-1486994]Events—Displays any events that are specific to the switch-profile.
 
      
 
     
 
     [bookmark: pgfId-1494386]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1487302][bookmark: 90582][bookmark: Configuration Change Management]Configuring the Switch Profile Wizard Between Two vPCs
 
      
       
     
 
     
 
     [bookmark: pgfId-1487371]Note This feature is supported only on the Cisco Nexus 5000 Series switches.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1487306]Switch profiles address the configuration conflicts between vPC peers in the network. By using Cisco DCNM, you can configure switch profiles between the vPC peers by selecting any one of the switches. Cisco DCNM configures the switch profiles on both the selected switch and its vPC peer switch with sync-peer IP addresses.
 
    
 
     
      [bookmark: pgfId-1487340]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1487384]Step 1 From the Feature Selector pane, choose Configuration Change Management > Switch-Profile.
 
     [bookmark: pgfId-1487385]All Cisco Nexus 5000 Series switches that are managed by Cisco DCNM are displayed in the Summary pane.
 
     [bookmark: pgfId-1487334]Step 2 In the Summary pane, choose one of the vPC peer switches by right-clicking the vPC peer that you want.
 
     [bookmark: pgfId-1487402]Step 3 From the Context menu, click the New switch-profile with vPC peer tab.
 
     [bookmark: pgfId-1487406]Cisco DCNM checks if there is any vPC configuration available in the selected switch and if the vPC is active. 
 
     [bookmark: pgfId-1487433]A dialog box is appears if the vPC is active.
 
     [bookmark: pgfId-1487453]Step 4 Click Yes to create the switch profile.
 
     [bookmark: pgfId-1487478]Step 5 (Optional) Edit the switch-profile name, and click Ok to proceed with the configuration.
 
      
       
     
 
     
 
     [bookmark: pgfId-1487546]Note If there is no active vPC in the selected switch, Cisco DCNM displays an error message and does not create the switch profile.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1487763]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1487577][bookmark: 95814]Configuring the Switch Profile Wizard Between Two Switches
 
      
       
     
 
     
 
     [bookmark: pgfId-1487639]Note This feature is supported only on the Cisco Nexus 5000 Series switches.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1487649]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1487650]Step 1 From the Feature Selector pane, choose Configuration Change Management > Switch-Profile.
 
     [bookmark: pgfId-1487651]All Cisco Nexus 5000 Series switches that are managed by Cisco DCNM are displayed in the Summary pane.
 
     [bookmark: pgfId-1487618]Step 2 From the Summary pane, choose one of the switches.
 
     [bookmark: pgfId-1487684]Step 3 From the Context menu, choose the New switch-profile with any other switch tab.
 
     [bookmark: pgfId-1487704]Cisco DCNM launches the switch profile configuration wizard.
 
      
       
     
 
     
 
     [bookmark: pgfId-1487710]Note By default, the wizard displays the switch profile name and the source switch IP address. You can edit the preferred name and also choose the destination switch IP from the drop-down list. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1487731]Step 4 From the drop-down list, choose the destination switch IP address.
 
     [bookmark: pgfId-1487742]Step 5 Click Next.
 
     [bookmark: pgfId-1487746]The wizard configuration summary details appear.
 
     [bookmark: pgfId-1487845]Step 6 Click Finish to create the switch-profile configuration.
 
     [bookmark: pgfId-1487846]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1487883][bookmark: 17917]Configuring the Sync Network View
 
      
       
     
 
     
 
     [bookmark: pgfId-1488052]Note This feature is supported only on the Cisco Nexus 5000 Series switches.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1488053]The switch-profile network view captures all the Cisco Nexus 5000 Series vPC peers in the network. If a switch profile already exists in the peers, the corresponding switch profile sync status information displays in the configuration sync network view. 
 
     [bookmark: pgfId-1488076]If no switch profile exists between the vPC peers, Cisco DCNM provides an option that allows you to configure the switch profile between the peers. If there are any dual-homed Fabric Extenders (FEXs) between the vPC peers, you can import the FEX host interfaces (HIF) configurations inside the switch profile.
 
    
 
     
      [bookmark: pgfId-1488250]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1488251]Step 1 From the Feature Selector pane, choose Configuration Change Management > Switch-Profile.
 
     [bookmark: pgfId-1488252]All Cisco Nexus 5000 Series switches that are managed by Cisco DCNM are displayed in the Summary pane.
 
     [bookmark: pgfId-1488262]Step 2 From the Summary pane, choose a switch by right-clicking the switch that you want. You can choose one of the following options:
 
      
       
       	 [bookmark: pgfId-1488280]Migration—This option is displayed only if there is no switch profile between the vPC Peers. Choose this option to launch the migration wizard using Cisco DCNM.
 
       	 [bookmark: pgfId-1492841]Manage Switch profile—Choose this option to go to the switch profile screen and choose the switch profile on the primary switch.
 
      
 
     
 
     [bookmark: pgfId-1492843]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1487999][bookmark: 67289]Configuring the Switch Profile Migration Wizard for Dual Homed FEXes
 
      
       
     
 
     
 
     [bookmark: pgfId-1494665]Note This feature is supported only on the Cisco Nexus 5000 Series switches.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1494658]You can launch the migration wizard using any one of the following options:
 
      
      	 [bookmark: pgfId-1487928]Migration Context menu
 
      	 [bookmark: pgfId-1487929]Migration link provided in the switch-profile Name column.
 
     
 
     [bookmark: pgfId-1487913]Both options are active only when no switch profile is configured on both vPC peers.
 
    
 
     
      [bookmark: pgfId-1487885]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1487886]Step 1 From the Feature Selector pane, choose Configuration Change Management > Switch-Profile.
 
     [bookmark: pgfId-1494739]All the vPCs in the Cisco Nexus 5000 Series switch peers that are managed by Cisco DCNM are displayed in the Summary pane.
 
     [bookmark: pgfId-1494740]Step 2 From the Summary pane, choose a row.
 
     [bookmark: pgfId-1494741]Step 3 Right-click the selected row.
 
     [bookmark: pgfId-1488401]Step 4 Choose the Migration option.
 
     [bookmark: pgfId-1490730]The Migration wizard appears with the vPC peers switches as primary and secondary with the default swith-profile name. 
 
     [bookmark: pgfId-1490758]Step 5 A dual selector option with the FEXes that are present in the primary vPC switch is displayed in the Migration wizard. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1490783]Note If the FEXes are online, they are automatically selected for the host interfaces (HIF) import. Any pre-provisioned FEXes will not be automatically selected.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1488435]Step 6 Click Next.
 
     [bookmark: pgfId-1488521]Step 7 Click Finish. 
 
     [bookmark: pgfId-1490855]The wizard creates a switch profile on both the vPC peer switches with appropriate sync-peer IP addresses and also import all the FEX-HIF ports into the switch profile. 
 
     [bookmark: pgfId-1490856]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1499129]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1499133]Performing a Configuration Rollback
 
      	 [bookmark: pgfId-1499137]Configuring Version and History Settings
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1510929][bookmark: 59585]Field Descriptions for Configuration Change Management
 
    [bookmark: pgfId-1510930]This section includes the field descriptions for the three features available in the Feature Selector drawer for [bookmark: marker-1510931]Configuration Change Management:
 
     
     	 [bookmark: pgfId-1510935]Field Descriptions for the Version Browser
 
     	 [bookmark: pgfId-1510939]Field Descriptions for Archival Jobs
 
     	 [bookmark: pgfId-1510943]Field Descriptions for the Archival Settings Contents Pane
 
     	 [bookmark: pgfId-1510947]Field Descriptions for the Switch Profiles Pane
 
     	 [bookmark: pgfId-1488235]Field Descriptions for the Switch Profiles Network View Pane
 
    
 
     
      [bookmark: pgfId-1510957][bookmark: 49384]Field Descriptions for the Version Browser
 
     [bookmark: pgfId-1510958]This section includes the following field descriptions for the Configuration Change Management feature:
 
      
      	 [bookmark: pgfId-1510962]Device: Details: Archival Status Section
 
      	 [bookmark: pgfId-1510966]Device: Details: Rollback History Section
 
      	 [bookmark: pgfId-1510970]Device: Details: Archival History Section
 
      	 [bookmark: pgfId-1510974]Version: Version Details Tab
 
      	 [bookmark: pgfId-1510978]Version: Compare Tab
 
     
 
    
 
     
      [bookmark: pgfId-1510980][bookmark: 47587]Device: Details: Archival Status Section
 
     [bookmark: pgfId-1511005]
 
      
       
        
        [bookmark: pgfId-1510986]Table 23-3 Device: Details: Archival Status Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1510990]Field 
          
  
         	 
           
           [bookmark: pgfId-1510992]Description 
          
  
        
 
         
         	[bookmark: pgfId-1510994]Status
  
         	[bookmark: pgfId-1510996]Display only. Whether the archival job that the device is assigned to is enabled or disabled.
  
        
 
         
         	[bookmark: pgfId-1510998]Schedule
  
         	[bookmark: pgfId-1511000]Display only. When the archival job that the device is assigned to is scheduled to occur.
  
        
 
         
         	[bookmark: pgfId-1511002]Job ID
  
         	[bookmark: pgfId-1511004]Display only. Identification number of the archival job that the device is assigned to.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511007][bookmark: 54044]Device: Details: Rollback History Section
 
     [bookmark: pgfId-1511036]
 
      
       
        
        [bookmark: pgfId-1511013]Table 23-4 Device: Details: Rollback History Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1511017]Field 
          
  
         	 
           
           [bookmark: pgfId-1511019]Description 
          
  
        
 
         
         	[bookmark: pgfId-1511021]Time
  
         	[bookmark: pgfId-1511023]Display only. Date and time that the rollback occurred.
  
        
 
         
         	[bookmark: pgfId-1511025]Version
  
         	[bookmark: pgfId-1511027]Display only. Configuration version that became the running configuration as a result of the rollback.
  
        
 
         
         	[bookmark: pgfId-1511029]User
  
         	[bookmark: pgfId-1511031]Display only. Username of the Cisco DCNM user who initiated the rollback.
  
        
 
         
         	[bookmark: pgfId-1511033]Status
  
         	[bookmark: pgfId-1511035]Display only. Whether the rollback succeeded or failed.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511038][bookmark: 25623]Device: Details: Archival History Section
 
     [bookmark: pgfId-1511067]
 
      
       
        
        [bookmark: pgfId-1511044]Table 23-5 Device: Details: Archival History Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1511048]Field 
          
  
         	 
           
           [bookmark: pgfId-1511050]Description 
          
  
        
 
         
         	[bookmark: pgfId-1511052]Time Stamp
  
         	[bookmark: pgfId-1511054]Display only. Date and time that the archival event occurred.
  
        
 
         
         	[bookmark: pgfId-1511056]Job Id
  
         	[bookmark: pgfId-1511058]Display only. Identification number of the archival job that created the archival event.
  
        
 
         
         	[bookmark: pgfId-1511060]Status
  
         	[bookmark: pgfId-1511062]Display only. Whether the archival event succeeded, failed, or was skipped.
  
        
 
         
         	[bookmark: pgfId-1511064]Reason
  
         	[bookmark: pgfId-1511066]Display only. Cause of a skipped or failed archival event.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511069][bookmark: 59437]Version: Version Details Tab
 
     [bookmark: pgfId-1511098]
 
      
       
        
        [bookmark: pgfId-1511075]Table 23-6 Version: Version Details Tab 
 
        
        
         
         	 
           
           [bookmark: pgfId-1511079]Field 
          
  
         	 
           
           [bookmark: pgfId-1511081]Description 
          
  
        
 
         
         	[bookmark: pgfId-1511083]Config Version ID
  
         	[bookmark: pgfId-1511085]Display only. Version identification number for the archived configuration version. Each archived configuration for a device receives a unique version ID.
  
        
 
         
         	[bookmark: pgfId-1511087]Creation Time
  
         	[bookmark: pgfId-1511089]Display only. Date and time that an archival job created the configuration version.
  
        
 
         
         	[bookmark: pgfId-1511091]Created By
  
         	[bookmark: pgfId-1511093]Display only. Username of the Cisco DCNM user who created the archival job that created the configuration version or the Cisco DCNM user who manually initiated the archival event that created the configuration version.
  
        
 
         
         	[bookmark: pgfId-1511095]Comments
  
         	[bookmark: pgfId-1511097]Text entered by a Cisco DCNM user.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511100][bookmark: 29903]Version: Compare Tab
 
     [bookmark: pgfId-1511124]
 
      
       
        
        [bookmark: pgfId-1511106]Table 23-7 Version: Compare Tab 
 
        
        
         
         	 
           
           [bookmark: pgfId-1511110]Field 
          
  
         	 
           
           [bookmark: pgfId-1511112]Description 
          
  
        
 
         
         	[bookmark: pgfId-1511114]Device
  
         	[bookmark: pgfId-1511116]Name of the managed device that the configuration version came from. In the left configuration pane, this field is display only. In the right configuration pane on the Compare tab, this field is configurable and you can select any managed device that you have added to the Cisco DCNM license.
  
        
 
         
         	[bookmark: pgfId-1511118]Version
  
         	[bookmark: pgfId-1511120]Configuration version ID of the archived configuration. In the left configuration pane, this field is display only. In the right configuration pane on the Compare tab, this field is a drop-down list with the following options:
 
           
           	 [bookmark: pgfId-1511121]Configuration version IDs—The numbers of the archived configuration versions currently available in Cisco DCNM.
 
           	 [bookmark: pgfId-1511122]Running-Configuration—The running configuration currently on the managed device selected in the Device field.
 
           	 [bookmark: pgfId-1511123]Start-up Config—The startup configuration currently on the managed device selected in the Device field.
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511126][bookmark: 57584]Field Descriptions for Archival Jobs
 
     [bookmark: pgfId-1511127]This section includes the following field descriptions for the Archival Jobs feature:
 
      
      	 [bookmark: pgfId-1511131]Archival Job: Details Tab
 
      	 [bookmark: pgfId-1511135]Archival Job: Archival History Tab
 
     
 
    
 
     
      [bookmark: pgfId-1511137][bookmark: 33753]Archival Job: Details Tab
 
     [bookmark: pgfId-1511206]
 
      
       
        
        [bookmark: pgfId-1511143]Table 23-8 Archival Job: Details Tab 
 
        
        
         
         	 
           
           [bookmark: pgfId-1511147]Field 
          
  
         	 
           
           [bookmark: pgfId-1511149]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1511151]General 
          
  
        
 
         
         	[bookmark: pgfId-1511155]Job ID
  
         	[bookmark: pgfId-1511157]Display only. Identification number of the archival job.
  
        
 
         
         	[bookmark: pgfId-1511159]Owner
  
         	[bookmark: pgfId-1511161]Display only. Username of the Cisco DCNM user who created the archival job.
  
        
 
         
         	[bookmark: pgfId-1511163]Comments
  
         	[bookmark: pgfId-1511165]Text entered by Cisco DCNM users.
  
        
 
         
         	 
           
           [bookmark: pgfId-1511167]Settings 
          
  
        
 
         
         	[bookmark: pgfId-1511171]Enable Archival
  
         	[bookmark: pgfId-1511173]Whether the archival job is enabled. By default, this check box is unchecked.
  
        
 
         
         	[bookmark: pgfId-1511175]Archive at Specified Time
  
         	[bookmark: pgfId-1511177]Archival job that occurs at the time specified by the Days and Archival Interval or Archive at fields.
  
        
 
         
         	[bookmark: pgfId-1511179]Days
  
         	[bookmark: pgfId-1511181]Days of the week that the archival job occurs. By default, the All check box is checked, which makes the individual day check boxes unavailable.
  
        
 
         
         	[bookmark: pgfId-1511183]Archive Interval
  
         	[bookmark: pgfId-1511185]Archival job that occurs at a regular interval, specified by the interval value box and the unit drop-down list, to the right of this radio button.
  
        
 
         
         	[bookmark: pgfId-1511187]Archive at
  
         	[bookmark: pgfId-1511189]Archival job that occurs once on each active day at the time specified in the box to the right of this radio button.
  
        
 
         
         	[bookmark: pgfId-1511191]Archive whenever a Configuration Change is Detected
  
         	[bookmark: pgfId-1511193]Archival job that occurs when Cisco DCNM detects that the running configuration of a device has changed.
  
        
 
         
         	 
           
           [bookmark: pgfId-1511195]Devices 
          
  
        
 
         
         	[bookmark: pgfId-1511199]Name
  
         	[bookmark: pgfId-1511201]Name of devices that are assigned to the archival job.
  
        
 
         
         	[bookmark: pgfId-1511203]IP Address
  
         	[bookmark: pgfId-1511205]IP address that Cisco DCNM uses to connect to the device.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511208][bookmark: 65138]Archival Job: Archival History Tab
 
     [bookmark: pgfId-1511246]
 
      
       
        
        [bookmark: pgfId-1511214]Table 23-9 Installation Job: Details: General Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1511218]Field 
          
  
         	 
           
           [bookmark: pgfId-1511220]Description 
          
  
        
 
         
         	[bookmark: pgfId-1511222]Time
  
         	[bookmark: pgfId-1511224]Display only. Date and time that the archival job ran.
  
        
 
         
         	[bookmark: pgfId-1511226]Status
  
         	[bookmark: pgfId-1511228]Display only. Number of devices in the job for which the archival job run succeeded, failed, or was skipped. The numbers are shown after each status, in parentheses.
  
        
 
         
         	[bookmark: pgfId-1511230]Device Name
  
         	[bookmark: pgfId-1511232]Display only. Name of a device assigned to the job. This field is shown when you expand the status of an archival history entry.
  
        
 
         
         	[bookmark: pgfId-1511234]IP Address
  
         	[bookmark: pgfId-1511236]Display only. IP address that Cisco DCNM used to attempt to connect to the device. This field is shown when you expand the status of an archival history entry.
  
        
 
         
         	[bookmark: pgfId-1511238]Status (per Device)
  
         	[bookmark: pgfId-1511240]Display only. Whether the archival job run succeeded, failed, or was skipped for the device.
  
        
 
         
         	[bookmark: pgfId-1511242]Reason
  
         	[bookmark: pgfId-1511244]Display only. Explanation for the status. For example, if the device was skipped because the running configuration had not changed since the previous archival job run, the following text appears in the Reason field:
 
           
           [bookmark: pgfId-1511245]Archival skipped as there are no changes from the previous version 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511248][bookmark: 98329]Field Descriptions for the Archival Settings Contents Pane
 
     [bookmark: pgfId-1511285]
 
      
       
        
        [bookmark: pgfId-1511254]Table 23-10 Archival Settings Contents Pane 
 
        
        
         
         	 
           
           [bookmark: pgfId-1511258]Field 
          
  
         	 
           
           [bookmark: pgfId-1511260]Description 
          
  
        
 
         
         	[bookmark: pgfId-1511262]Maximum Versions for a Device
  
         	[bookmark: pgfId-1511264]Largest number of archived configuration versions that Cisco DCNM retains for each device included in an archival job. Valid values are from 0 to 50, where 50 is the default value.
  
        
 
         
         	[bookmark: pgfId-1511266]Max Rollback and Archival History Status
  
         	[bookmark: pgfId-1511268]Largest number of rollback history and archival history status entries Cisco DCNM retains for each device.
  
        
 
         
         	 
           
           [bookmark: pgfId-1511270]File Server for Configuration Rollback 
          
  
        
 
         
         	[bookmark: pgfId-1511274]Any File Server
  
         	[bookmark: pgfId-1511276]File server that Cisco DCNM selects to upload configurations to during a configuration rollback. Any file server that you have configured in Cisco DCNM may be used.
  
        
 
         
         	[bookmark: pgfId-1511278]Use the following File Server
  
         	[bookmark: pgfId-1511280]File server that Cisco DCNM uploads configurations to during a configuration rollback to the File Server drop-down list.
  
        
 
         
         	[bookmark: pgfId-1511282]File Server
  
         	[bookmark: pgfId-1511284]IP address or DNS name of the file server that Cisco DCNM uploads configurations to during a rollback. This field is available only when you select the Use the following File Server radio button.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511287][bookmark: 60465]Field Descriptions for the Switch Profiles Pane
 
     [bookmark: pgfId-1495097]Table 23-11 Switch Profiles Pane

 
      
       
        
        [bookmark: pgfId-1502282]
 
        
        
         
         	 
           
           [bookmark: pgfId-1495210]Field 
          
  
         	 
           
           [bookmark: pgfId-1495212]Description 
          
  
        
 
         
         	[bookmark: pgfId-1495214]Name
  
         	[bookmark: pgfId-1495216]Name of the switch-profile.
  
        
 
         
         	[bookmark: pgfId-1495218]Revision ID 
  
         	[bookmark: pgfId-1495220]Current revision number of the switch profile.
  
        
 
         
         	[bookmark: pgfId-1495222]Peer IP Address
  
         	[bookmark: pgfId-1495224]IP address of the peer switch for the selected profile.
  
        
 
         
         	[bookmark: pgfId-1495226]Last Session Time
  
         	[bookmark: pgfId-1495228]Start time of the last configuration session.
  
        
 
         
         	[bookmark: pgfId-1495230]Last Session Status
  
         	[bookmark: pgfId-1495232]Status of the last session action that was performed.
  
        
 
         
         	[bookmark: pgfId-1495234]Sync Status
  
         	[bookmark: pgfId-1495236]Overall sync status of that profile with the peer.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511293][bookmark: 47072]Field Descriptions for the Switch Profiles Network View Pane
 
     [bookmark: pgfId-1495285]Table 23-12 Switch Profiles Network View Pane

 
      
       
        
        [bookmark: pgfId-1502286]
 
        
        
         
         	 
           
           [bookmark: pgfId-1495331]Field 
          
  
         	 
           
           [bookmark: pgfId-1495333]Description 
          
  
        
 
         
         	[bookmark: pgfId-1495335]vPC
  
         	[bookmark: pgfId-1495337]Hostname of the vPC primary and secondary switch.
  
        
 
         
         	[bookmark: pgfId-1495339]Name
  
         	[bookmark: pgfId-1495341]Name of the switch profile.
  
        
 
         
         	[bookmark: pgfId-1495343]Revision ID 
  
         	[bookmark: pgfId-1495345]Current revision number of the switch profile.
  
        
 
         
         	[bookmark: pgfId-1495347]Overall Sync Status
  
         	[bookmark: pgfId-1495349]Switch profile status on the primary vPC switch.
  
        
 
         
         	[bookmark: pgfId-1495351]Last Session Time
  
         	[bookmark: pgfId-1495353]Start time of the last configuration session.
  
        
 
         
         	[bookmark: pgfId-1495355]Last Session Status
  
         	[bookmark: pgfId-1495357]Status of the last session action that was performed.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1511299][bookmark: 53004]Additional References
 
    [bookmark: pgfId-1511300]For additional information related to configuration change management, see the following sections:
 
     
     	 [bookmark: pgfId-1511304]Related Documents
 
     	 [bookmark: pgfId-1511308]Standards
 
    
 
     
      [bookmark: pgfId-1511310][bookmark: 16521]Related Documents
 
     [bookmark: pgfId-1511330]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1511313]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1511315]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1511317]File servers in Cisco DCNM
  
         	[bookmark: pgfId-1511322]File Servers
  
        
 
         
         	[bookmark: pgfId-1511324]Configuration rollbacks in Cisco NX-OS
  
         	[bookmark: pgfId-1511328]Cisco Nexus 7000 Series NX-OS System Management Configuration Guide, Release 5.x
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1511332][bookmark: 55398]Standards
 
     [bookmark: pgfId-1511342]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1511335]Standards 
          
  
         	 
           
           [bookmark: pgfId-1511337]Title 
          
  
        
 
         
         	[bookmark: pgfId-1511339]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1511341]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1511344][bookmark: 92503]Feature History for Configuration Change Management
 
    [bookmark: pgfId-1511348]Table 23-13 lists the release history for this feature.
 
    [bookmark: pgfId-1511385]
 
     
      
       
       [bookmark: pgfId-1511355]Table 23-13 [bookmark: 50557]Feature History for Configuration Change Management 
 
       
       
        
        	 
          
          [bookmark: pgfId-1511361]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1511363]Releases 
         
  
        	 
          
          [bookmark: pgfId-1511365]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1511367]Configuration Change Management
  
        	[bookmark: pgfId-1511369]5.2(1)
  
        	[bookmark: pgfId-1511371]Support was added to the Cisco Nexus 3000 Series switches (except the Switch Profile feature).
  
       
 
        
        	[bookmark: pgfId-1511373]Configuration Change Management
  
        	[bookmark: pgfId-1511375]5.1(1)
  
        	[bookmark: pgfId-1511377]You can use the Copy Run to Start feature to copy the running configuration to the startup configuration.
  
       
 
        
        	[bookmark: pgfId-1511380][bookmark: marker-1511379]Configuration Change Management
  
        	[bookmark: pgfId-1511382]5.0(2)
  
        	[bookmark: pgfId-1511384]Support was extended to all managed Cisco Nexus Series switches.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1374373][bookmark: 33088]Managing [bookmark: marker-1374371]Device Operating Systems 
      
      
 
     
 
 
    [bookmark: pgfId-1476630]This chapter describes how to use the Device OS Management feature in Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1467972]The Device OS Management feature allows you to control the operating system installed on Nexus 7000 Series devices that are managed by DCNM. You can create software installation jobs that affect one or more managed devices. DCNM can transfer the software images of operating systems to managed devices using one of several supported protocols. Installation jobs can also use software images already present on managed devices.
 
    [bookmark: pgfId-1476635]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1476639]Information About Device OS Management
 
     	 [bookmark: pgfId-1476643]Licensing Requirements for Device OS Management
 
     	 [bookmark: pgfId-1476647]Prerequisites
 
     	 [bookmark: pgfId-1476651]Guidelines and Limitations for Device OS Management
 
     	 [bookmark: pgfId-1476655]Platform Support
 
     	 [bookmark: pgfId-1476659]Using the Device OS Management Window
 
     	 [bookmark: pgfId-1476663]Configuring Software Installation Jobs
 
     	 [bookmark: pgfId-1476667]Configuring File Servers
 
     	 [bookmark: pgfId-1476671]Field Descriptions for Device OS Management
 
     	 [bookmark: pgfId-1476675]Additional References
 
     	 [bookmark: pgfId-1476679]Feature History for Device OS Management
 
    
 
   
 
    
     [bookmark: pgfId-1476682][bookmark: 14255]Information About Device OS Management[bookmark: marker-1476681]
 
    [bookmark: pgfId-1476683]The Device OS Management feature allows you to control the software images installed on certain devices that are managed by Cisco DCNM.
 
    [bookmark: pgfId-1476684]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1476688]Device OS Management Screen
 
     	 [bookmark: pgfId-1476692]Software Installation Jobs
 
     	 [bookmark: pgfId-1476696]File Servers
 
     	 [bookmark: pgfId-1476700]VDC Support
 
    
 
     
      [bookmark: pgfId-1476702][bookmark: 66262]Device OS Management Screen
 
     [bookmark: pgfId-1476703]The Device OS Management screen allows you to view information about the software images used by a managed device. You can also start the Software Installation wizard from the Device OS Management Summary pane.
 
    
 
     
      [bookmark: pgfId-1476705][bookmark: 31416]Software Installation Jobs
 
     [bookmark: pgfId-1476706]The Software Installation Jobs feature allows you to create and monitor software installation jobs. Cisco DCNM provides the Software Installation wizard, which you use to specify all the necessary information for configuring a software installation job.
 
     [bookmark: pgfId-1476707]You can create software installation jobs that affect one or more managed devices. You can use software images that are already in the local file system of the devices or Cisco DCNM can instruct each managed device included in a job to transfer software images to the local file system on the managed device. Your options are as follows:
 
      
      	 [bookmark: pgfId-1476708]Device file system—You can use software images that are in the local file system of the devices. You must ensure that the images exist on the devices prior to configuring the installation job.
 
     
 
     [bookmark: pgfId-1476709]You can specify a software image for a device type category rather than for a single device; however, the image that you specify must exist on each device in the category in the same location and with the same filename. For example, if you specify bootflash:/images/n7000-s1-dk9.4.1.2.upg.bin, the n7000-s1-dk9.4.1.2.upg.bin image file must exist in bootflash:/images on each device in the device category.
 
      
      	 [bookmark: pgfId-1476710]File server—You can use a file server that you have configured in Cisco DCNM. If you use a file server, Cisco DCNM uses the information that you provide when you configure the file server and when you configure the software installation job to assemble a URL that the managed devices in the job can use to retrieve the software images.
 
     
 
     [bookmark: pgfId-1476711]Before configuring a software installation job, you should ensure that the software images are on the file server. You must also configure the file server in Cisco DCNM. For more information, see the “File Servers” section.
 
      
      	 [bookmark: pgfId-1476715]URL—You can use a URL to specify the image files. The verification that Cisco DCNM performs for a URL varies depending upon the transfer protocol that you use, as follows:
 
     
 
     [bookmark: pgfId-1476716] – FTP—Cisco DCNM verifies the URL format, that the FTP server in the URL is reachable, and that the specified image file exists on the FTP server. The FTP URL format is as follows:
 
     [bookmark: pgfId-1476717]ftp://username@servername/path/filename 
 
     [bookmark: pgfId-1476718] – SFTP—Cisco DCNM verifies the URL format, that the SFTP server in the URL is reachable, and that the image file specified exists on the SFTP server. The SFTP URL format is as follows:
 
     [bookmark: pgfId-1476719]sftp://username@servername/path/filename 
 
     [bookmark: pgfId-1476720] – TFTP—You must ensure that the path and image filename are correct. Cisco DCNM verifies the URL format and that the TFTP server in the URL is reachable. The TFTP URL format is as follows:
 
     [bookmark: pgfId-1476721]tftp://servername/path/filename 
 
     [bookmark: pgfId-1476722] – SCP—You must ensure that the SCP server is reachable and that the path and image filename are correct. Cisco DCNM verifies the URL format. The SCP URL format is as follows:
 
     [bookmark: pgfId-1476723]scp://username@servername/path/filename 
 
     [bookmark: pgfId-1476724]The Software Installation wizard includes an optional step for verifying the version compatibility of software images with the managed devices. During this step, if a software image was specified by a URL or file server, Cisco DCNM instructs managed devices to copy the software image from the URL or file server to the bootflash file system on the device. If you skip the version compatibility step, Cisco DCNM does not instruct devices to copy software images from URLs or file servers until the installation job begins.
 
    
 
     
      [bookmark: pgfId-1476726][bookmark: 46483]File Servers
 
     [bookmark: pgfId-1476727]The File Servers feature allows you to configure file servers, which you can use for the following purposes:
 
      
      	 [bookmark: pgfId-1476728]Software installation jobs—Cisco DCNM can get software image files from a file server and transfer them to devices included in a software installation job.
 
      	 [bookmark: pgfId-1476729]Configuration rollbacks—Cisco DCNM can back up device configurations to a file server when you roll back a device configuration.
 
     
 
     [bookmark: pgfId-1476730]Cisco DCNM supports file servers that use the following protocols:
 
      
      	 [bookmark: pgfId-1476731]FTP
 
      	 [bookmark: pgfId-1476732]SFTP
 
      	 [bookmark: pgfId-1476733]TFTP
 
     
 
     [bookmark: pgfId-1476734]If you use a file server in a software installation job, consider the following items:
 
      
      	 [bookmark: pgfId-1476735]The managed devices included in the job must be able to connect to the file server directly.
 
      	 [bookmark: pgfId-1476736]To ensure that software image files transfer as quickly as possible, use a file server that is on the same LAN as the devices included in the software installation job. If the available file servers transfer software image files too slowly, before you create the software installation job, manually copy the files to the devices that you will include in the job and configure the job to use the manually copied files rather than a file server.
 
     
 
    
 
     
      [bookmark: pgfId-1476738][bookmark: 79174]VDC Support
 
     [bookmark: pgfId-1476739]Device software images apply to physical devices rather than virtual device contexts (VDCs). When you change the software image on a managed device, all VDCs on the device use the new software image.
 
    
 
   
 
    
     [bookmark: pgfId-1476741][bookmark: 51127]Licensing Requirements for Device OS Management
 
    [bookmark: pgfId-1476742]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1476759]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1476745]Product 
         
  
        	 
          
          [bookmark: pgfId-1476747]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1476749]Cisco DCNM
  
        	[bookmark: pgfId-1476751]Device OS Management requires a LAN Enterprise license. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
        
        	[bookmark: pgfId-1476756]Cisco NX-OS
  
        	[bookmark: pgfId-1476758]Device OS Management requires no license. Any feature not included in a license package is bundled with the Cisco NX-OS system images and is provided at no extra charge to you. For an explanation of the Cisco NX-OS licensing scheme for your platform, see the licensing guide for your platform. 
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1476761][bookmark: 78783]Prerequisites
 
    [bookmark: pgfId-1476762]The Device OS Management feature has the following prerequisites (for a full list of feature-specific prerequisites, see the platform-specific documentation):
 
     
     	 [bookmark: pgfId-1476763]The Device OS Management feature supports only devices that are managed by Cisco DCNM, which means that Cisco DCNM must have successfully discovered the device.
 
     	 [bookmark: pgfId-1476764]The Device OS Management feature supports only devices that you have added to the list of Cisco DCNM-licensed devices.
 
     	 [bookmark: pgfId-1476765]Devices included in a software installation job must be reachable by Cisco DCNM when a software installation job occurs. Software installation jobs fail for unreachable devices.
 
    
 
   
 
    
     [bookmark: pgfId-1476767][bookmark: 87804]Guidelines and Limitations for Device OS Management
 
    [bookmark: pgfId-1476768]The Device OS Management feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1476769]URLs and file servers used in a software installation job must be reachable by the managed devices included in the job.
 
     	 [bookmark: pgfId-1476770]If you use a DNS name in a URL or when you configure a file server, ensure that managed devices using the URL or file server can resolve the DNS name.
 
     	 [bookmark: pgfId-1476771]Software installation jobs do not reload connectivity management processors (CMPs). You must manually reload CMPs as needed when a software installation job completes. The status for a completed software installation job includes messages about CMPs that must be reloaded manually. For more information, see the  Cisco Nexus 7000 Series NX-OS Software Upgrade and Downgrade Guide, Release 5.x .
 
     	 [bookmark: pgfId-1476775]For Cisco Nexus 7000 series devices that have a single supervisor module, a software installation job does not reload the device. After the installation job completes, to run the newly installed software image on a single-supervisor Cisco Nexus 7000 series device, you must manually reload the device. For more information, see the  Cisco Nexus 7000 Series NX-OS Software Upgrade and Downgrade Guide, Release 5.x .
 
    
 
   
 
    
     [bookmark: pgfId-1476780][bookmark: 16384]Platform Support
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1476784]Platform 
         
  
        	 
          
          [bookmark: pgfId-1476786]Documentation 
         
  
       
 
        
        	[bookmark: pgfId-1476788]Cisco Nexus 4000 Series switches
  
        	[bookmark: pgfId-1476791]Cisco Nexus 4000 Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1476793]Cisco Nexus 5000 Series switches
  
        	[bookmark: pgfId-1476796]Cisco Nexus 5000 Series Switch Documentation
  
       
 
        
        	[bookmark: pgfId-1476798]Cisco Nexus 7000 Series switches
  
        	[bookmark: pgfId-1476801]Cisco Nexus 7000 Series Switch Documentation
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1389483][bookmark: 54640]Using the Device OS Management Window[bookmark: marker-1400968]
 
    [bookmark: pgfId-1467977]The Device OS Management window allows you to view information about the software images used by a managed device. You can also start the Software Installation Wizard from the Device OS Management Summary pane.
 
    [bookmark: pgfId-1476807]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1476811]Viewing Device Image Details
 
     	 [bookmark: pgfId-1476815]Installing Software on a Device
 
    
 
     
      [bookmark: pgfId-1388447][bookmark: 91967]Viewing Device Image Details[bookmark: marker-1388446]
 
     [bookmark: pgfId-1388448]You can view details about the software image on a managed device.
 
    
 
     
      [bookmark: pgfId-1388449]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1388451]Step 1 From the Feature Selector pane, choose Device OS Management.
 
     [bookmark: pgfId-1388452]A table of managed devices appears in the Summary pane. Each row displays software image information about a device. Devices are listed alphabetically.
 
     [bookmark: pgfId-1388453]Step 2 Click the device for which you want to see software image details.
 
     [bookmark: pgfId-1388454]The Details pane displays two sections of information. In addition to displaying the information also shown in the Summary pane, if an installation job is scheduled, the System section displays a message about any scheduled installation job, including a link to the installation job.
 
     [bookmark: pgfId-1388455]The Software Installation Jobs section displays information about future, ongoing, and past installation jobs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1388456]Tip To expand or collapse the System or the Software Installation Jobs sections, double-click the section title.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1388457]Step 3 (Optional) To open a scheduled software installation job, in the System section, click the link to the installation job.
 
     [bookmark: pgfId-1388458]The Feature Selector pane changes to the Software Installation Jobs feature. For more information, see the “Viewing Software Installation Job Details” section.
 
     [bookmark: pgfId-1388462]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1467982]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1467986]Installing Software on a Device
 
     
 
    
 
     
      [bookmark: pgfId-1389801][bookmark: 45634]Installing Software on a Device[bookmark: marker-1400969]
 
     [bookmark: pgfId-1394020]You can install software on a device listed on the Device OS Management Summary pane. Installing software from the Device OS Management Summary pane starts the Software Installation wizard, which allows you to create or modify a software installation job.
 
    
 
     
      [bookmark: pgfId-1397634]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1397635]Ensure that the software images that you want to install are available by one of the options that the Software Installation wizard supports. For more information, see the “Software Installation Jobs” section. The supported options are the following:
 
      
      	 [bookmark: pgfId-1467996]File server—If you want to use a file server, ensure that the software images are available on the server. You must also configure the file server in DCNM. For more information, see the “Adding a File Server” section.
 
      	 [bookmark: pgfId-1468000]Device file system—If you want to use software images that are in the local file system of the devices, you must ensure that the images exist on the devices prior to configuring the installation job.
 
     
 
     [bookmark: pgfId-1468001]You can specify a software image for a device type category rather than for a single device; however, the image that you specify must exist on each device in the category in the same location and with the same filename. For example, if you specify bootflash:/images/n7000-s1-dk9.4.1.2.upg.bin, the n7000-s1-dk9.4.1.2.upg.bin image file must exist in bootflash:/images on each device in the device category.
 
      
      	 [bookmark: pgfId-1468002]URL—If you want to use a URL to specify the image files, what DCNM verifies for you and what you need to ensure vary depending upon the transfer protocol that you use, as follows:
 
     
 
     [bookmark: pgfId-1468003] – FTP—DCNM verifies the URL format, that the FTP server in the URL is reachable, and that the specified image file exists on the FTP server. The FTP URL format is as follows:
 
     [bookmark: pgfId-1468004]ftp://username@servername/path/filename 
 
     [bookmark: pgfId-1468005] – SFTP—DCNM verifies the URL format, that the SFTP server in the URL is reachable, and that the image file specified exists on the SFTP server. The SFTP URL format is as follows:
 
     [bookmark: pgfId-1468006]sftp://username@servername/path/filename 
 
     [bookmark: pgfId-1468007] – TFTP—You must ensure that the path and image filename are correct. DCNM verifies the URL format and that the TFTP server in the URL is reachable. The TFTP URL format is as follows:
 
     [bookmark: pgfId-1468008]tftp://servername/path/filename 
 
     [bookmark: pgfId-1468009] – SCP—You must ensure that the SCP server is reachable and that the path and image filename are correct. DCNM verifies the URL format. The SCP URL format is as follows:
 
     [bookmark: pgfId-1468010]scp://username@servername/path/filename 
 
    
 
     
      [bookmark: pgfId-1394075]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1394472]Step 1 From the Feature Selector pane, choose Device OS Management >Device OS Management.
 
     [bookmark: pgfId-1394473]A table of managed devices appears in the Summary pane.
 
     [bookmark: pgfId-1394363]Step 2 Click a device that you want to include in a new software installation job.
 
     [bookmark: pgfId-1394538]Step 3 From the menu bar, choose Actions > Install Software.
 
     [bookmark: pgfId-1396608]The Software Installation wizard dialog box displays the Select Switches step. The device that you selected is listed under Selected Switches.
 
     [bookmark: pgfId-1394786]Step 4 To use the wizard, see the “Using the Software Installation Wizard” section.
 
     [bookmark: pgfId-1394364]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468015]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468019]Viewing Device Image Details
 
      	 [bookmark: pgfId-1468023]Using the Software Installation Wizard
 
      	 [bookmark: pgfId-1468027]Adding a File Server
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1397762][bookmark: 81912]Configuring Software Installation Jobs[bookmark: marker-1400971]
 
    [bookmark: pgfId-1468032]The Software Installation Jobs feature allows you to create and monitor software installation jobs.
 
    [bookmark: pgfId-1476828]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1476832]Viewing Software Installation Job Details
 
     	 [bookmark: pgfId-1476836]Creating or Editing a Software Installation Job
 
     	 [bookmark: pgfId-1476840]Using the Software Installation Wizard
 
     	 [bookmark: pgfId-1476844]Rescheduling a Software Installation Job
 
     	 [bookmark: pgfId-1476848]Deleting a Software Installation Job
 
     	 [bookmark: pgfId-1476852]Adding or Changing Comments for a Software Installation Job
 
     	 [bookmark: pgfId-1467471]Changing Installation Options for a Software Installation Job
 
    
 
     
      [bookmark: pgfId-1386708][bookmark: 72635]Viewing Software Installation Job Details[bookmark: marker-1386707]
 
     [bookmark: pgfId-1386709]You can view the details of a software installation job, including its status.
 
    
 
     
      [bookmark: pgfId-1386710]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1386711]You must have configured a software installation job before you can view its details.
 
    
 
     
      [bookmark: pgfId-1386712]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1386714]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs. 
 
     [bookmark: pgfId-1386715]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1386716]Step 2 Click the software installation job for which you want to view details.
 
     [bookmark: pgfId-1386717]The Details pane displays two sections of information. The General section displays the job ID, the job owner, scheduling information, comments, and installation options.
 
     [bookmark: pgfId-1386718]The Device and Software Images section displays a table of devices included in the job, the software images to be installed on each device, and the status of the installation for the device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1386719]Tip To expand or collapse the General or the Device and Software Images sections, double-click the section title.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1386720]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468037]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468041]Viewing Device Image Details
 
      	 [bookmark: pgfId-1468045]Creating or Editing a Software Installation Job
 
      	 [bookmark: pgfId-1468049]Rescheduling a Software Installation Job
 
      	 [bookmark: pgfId-1468053]Deleting a Software Installation Job
 
      	 [bookmark: pgfId-1468057]Adding or Changing Comments for a Software Installation Job
 
      	 [bookmark: pgfId-1468061]Changing Installation Options for a Software Installation Job
 
     
 
    
 
     
      [bookmark: pgfId-1396876][bookmark: 38169]Creating or Editing a Software Installation Job[bookmark: marker-1400975]
 
     [bookmark: pgfId-1397572]From the Software Installation Jobs content pane, you can create a software installation job or edit an existing job. Creating or editing a job from the Software Installation Jobs content pane starts the Software Installation wizard, which allows you to create or modify a job.
 
    
 
     
      [bookmark: pgfId-1397573]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1418702]Ensure that the software images that you want to install are available by one of the options that the Software Installation wizard supports. For more information, see the “Software Installation Jobs” section.The supported options are the following:
 
     [bookmark: pgfId-1452232]To ensure that software image files transfer as quickly as possible, use a file server that is on the same LAN as the devices included in the software installation job. If the available file servers transfer software image files too slowly, before you create the software installation job, manually copy the files to the devices that you will include in the job and configure the job to use the manually copied files rather than a file server.
 
      
      	 [bookmark: pgfId-1468071]File server—If you want to use a file server, ensure that the software images are available on the server. You must also configure the file server in DCNM. For more information, see the “Adding a File Server” section.
 
      	 [bookmark: pgfId-1468075]Device file system—If you want to use software images that are in the local file system of the devices, you must ensure that the images exist on the devices prior to configuring the installation job.
 
     
 
     [bookmark: pgfId-1468076]You can specify a software image for a device type category rather than for a single device; however, the image that you specify must exist on each device in the category in the same location and with the same filename. For example, if you specify bootflash:/images/n7000-s1-dk9.4.1.2.upg.bin, the n7000-s1-dk9.4.1.2.upg.bin image file must exist in bootflash:/images on each device in the device category.
 
      
      	 [bookmark: pgfId-1468077]URL—If you want to use a URL to specify the image files, what DCNM verifies for you and what you need to ensure vary depending upon the transfer protocol that you use, as follows:
 
     
 
     [bookmark: pgfId-1468078] – FTP—DCNM verifies the URL format, that the FTP server in the URL is reachable, and that the specified image file exists on the FTP server. The FTP URL format is as follows:
 
     [bookmark: pgfId-1468079]ftp://username@servername/path/filename 
 
     [bookmark: pgfId-1468080] – SFTP—DCNM verifies the URL format, that the SFTP server in the URL is reachable, and that the image file specified exists on the SFTP server. The SFTP URL format is as follows:
 
     [bookmark: pgfId-1468081]sftp://username@servername/path/filename 
 
     [bookmark: pgfId-1468082] – TFTP—You must ensure that the path and image filename are correct. DCNM verifies the URL format and that the TFTP server in the URL is reachable. The TFTP URL format is as follows:
 
     [bookmark: pgfId-1468083]tftp://servername/path/filename 
 
     [bookmark: pgfId-1468084] – SCP—You must ensure that the SCP server is reachable and that the path and image filename are correct. DCNM verifies the URL format. The SCP URL format is as follows:
 
     [bookmark: pgfId-1468085]scp://username@servername/path/filename 
 
    
 
     
      [bookmark: pgfId-1417233]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1396236]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1396237]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1396238]Step 2 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1396239]If you want to create a job, from the menu bar, choose  Actions > New .
 
       	 [bookmark: pgfId-1396241]If you want to edit a job, in the Summary pane, click the job, and then, from the menu bar, choose  Actions > Edit .
 
      
 
     
 
     [bookmark: pgfId-1396495]The Software Installation wizard dialog box displays the Select Switches step.
 
     [bookmark: pgfId-1396530]Step 3 To use the wizard, see the “Using the Software Installation Wizard” section.
 
     [bookmark: pgfId-1396148]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468090]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468094]Using the Software Installation Wizard
 
      	 [bookmark: pgfId-1468098]Rescheduling a Software Installation Job
 
      	 [bookmark: pgfId-1468102]Deleting a Software Installation Job
 
      	 [bookmark: pgfId-1468106]Adding or Changing Comments for a Software Installation Job
 
      	 [bookmark: pgfId-1468110]Changing Installation Options for a Software Installation Job
 
      	 [bookmark: pgfId-1468114]Adding a File Server
 
     
 
    
 
     
      [bookmark: pgfId-1397910][bookmark: 63326]Using the Software Installation Wizard[bookmark: marker-1397909]
 
     [bookmark: pgfId-1394919]You can use the Software Installation wizard to configure a new software installation job or make changes to an existing software installation job.
 
    
 
     
      [bookmark: pgfId-1120750]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1396275]Start the Software Installation wizard, from one of the following places:
 
      
      	 [bookmark: pgfId-1396374]Device OS Management—See the “Installing Software on a Device” section.
 
      	 [bookmark: pgfId-1396378]Software Installation Jobs—See the “Creating or Editing a Software Installation Job” section.
 
     
 
    
 
     
      [bookmark: pgfId-1396271]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1377590]Step 1 In the Software Installation wizard dialog box, follow these steps for each device that you want to include in the installation job:
 
     [bookmark: pgfId-1377620] a. Under Available Switches, click the device.
 
     [bookmark: pgfId-1377702] b. Click Add.
 
      
       
     
 
     
 
     [bookmark: pgfId-1379628]Tip To remove a device from the job, under Selected Switches, click the device and then click Remove.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1377703]Step 2 Click Next.
 
     [bookmark: pgfId-1377771]The Software Installation wizard dialog box displays the Specify Software Images step. Devices are categorized by the physical device type. You can specify software images for each device individually or for an entire category of devices of the same physical type.
 
     [bookmark: pgfId-1377704]Step 3 [bookmark: 68317]For each device or physical device category, specify a kickstart image and a system image. To do so, follow these steps once for the Kickstart Image field and again for the System Image field:
 
     [bookmark: pgfId-1377809] a. In the applicable image field, click to activate the field and then click the more button.
 
     [bookmark: pgfId-1377933]The Software Image Browser dialog box appears.
 
     [bookmark: pgfId-1378003] b. Specify the location of the file for the software image to be installed. To do so, choose one of the following options:
 
      
      	 [bookmark: pgfId-1378004]File Server—If you choose this option, you must pick a file server from the Repository list, navigate to the folders on the file server, and select the software image file.
 
      	 [bookmark: pgfId-1378069]Switch File System—If you choose this option, you must navigate to the file system on a device and select the software image file.
 
     
 
     [bookmark: pgfId-1380717]If you are specifying a software image for a device type category, the image specified must exist on each device in the category in the same location and with the same filename.
 
      
      	 [bookmark: pgfId-1378089]URL—If you choose this option, enter the URL in the URL field. If the transfer protocol that you use includes a username in the URL, in the Password field type the password for the username in the URL.
 
     
 
     [bookmark: pgfId-1378441] c. Click OK.
 
     [bookmark: pgfId-1378590]If you specified a URL, Cisco DCNM verifies the URL.
 
     [bookmark: pgfId-1418237]The Software Image Browser dialog box closes. The applicable image field displays the software image that you chose.
 
     [bookmark: pgfId-1378259]Step 4 (Optional) If you do not want the Software Installation wizard to verify that the selected kickstart and system software images are compatible with a device, check the Skip Version Compatibility check box in the row of the device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1407337]Tip The Next button remains unavailable until you have specified a kickstart image and a system image for each device included in the software installation job.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1378576]Step 5 Click Next.
 
     [bookmark: pgfId-1379977]If you specified a URL or a software image repository for the location of software images, Cisco DCNM instructs the devices in the job to retrieve the images from the specified locations.
 
     [bookmark: pgfId-1407359]If any device does not have enough space in its local file system to receive the software image files, a dialog box provides you the option to free up space on the device.
 
     [bookmark: pgfId-1380039]Step 6 If you receive a warning about insufficient space on the device, do one of the following:
 
      
       
       	 [bookmark: pgfId-1380040]If you want to delete files from devices, click  Yes . Use the Delete Files dialog box to explore the local file system of devices and delete unwanted files. When you are done, click  OK and then click  Next .
 
       	 [bookmark: pgfId-1380164]If you want to remove the device from the job, click  No , click  Back , and return to Step 3.
 
       	 [bookmark: pgfId-1380132]If you want to exit the Software Installation wizard, click  No and then click  Cancel .
 
      
 
     
 
     [bookmark: pgfId-1380041]Unless you chose to skip the version compatibility check for every device in the installation job, the Software Installation wizard dialog box displays the Pre-installation Checks step. The Version Compatibility Check column indicates whether a device passed or failed the check.
 
     [bookmark: pgfId-1379101]Step 7 If the Software Install wizard dialog box displays the Pre-installation Checks step, follow these steps:
 
     [bookmark: pgfId-1378815] a. If any device failed the version compatibility check, do one of the following:
 
     [bookmark: pgfId-1378816] – If you want to change the software image files specified for a device, click Back and return to Step 3.
 
     [bookmark: pgfId-1378844] – If you want the job to proceed by not installing software on devices that failed the version compatibility check, check the Skip devices with version compatibility failure check box.
 
     [bookmark: pgfId-1378817] b. Click Next.
 
     [bookmark: pgfId-1379159]The Software Installation wizard dialog box displays the Installation Options and Schedule step.
 
     [bookmark: pgfId-1379141]Step 8 (Optional) If you want the job to save the current configuration or delete the current configuration on each device, follow these steps:
 
     [bookmark: pgfId-1379358] a. Check the Installation Options check box.
 
     [bookmark: pgfId-1379367] b. If you want the job to copy the running configuration to the startup configuration on each device, click the Save Running Configuration to Startup before Installation radio button. After the installation job, devices in the job will have the same configuration that they did prior to the job, unless the installation is an upgrade or downgrade that modifies the running configuration.
 
     [bookmark: pgfId-1379411] c. If you want the job to delete the startup configuration on each device, click the Erase Startup Configuration before Installation radio button. After the installation job completes, devices in the job will have only the default running configuration.
 
     [bookmark: pgfId-1379331]Step 9 Under Schedule, do one of the following:
 
      
       
       	 [bookmark: pgfId-1379231]If you want the software installation job to start immediately after you complete the wizard, click the  Install Now radio button.
 
       	 [bookmark: pgfId-1379296]If you want to specify a date and time for the start of the software installation job, click the  Schedule Installation radio button and then use the  Date and Time field to specify when the job should begin.
 
      
 
     
 
     [bookmark: pgfId-1379180]Step 10 (Optional) In the Comments field, enter a comment about the installation job.
 
     [bookmark: pgfId-1379224]Step 11 Under Execution Mode, do one of the following:
 
      
       
       	 [bookmark: pgfId-1442754]If you want the installation job to run on one device at a time before it begins on the next device included in the job, click the  Sequential  radio button.
 
       	 [bookmark: pgfId-1442643]If you want the installation job to start at the same time on all the devices included in the job, click the  Concurrent radio button.
 
      
 
     
 
     [bookmark: pgfId-1442626]Step 12 (Optional) If you want the software installation job to save the log data for failed installations, check the Archive logs from switches on DCNM server upon installation failure check box.
 
     [bookmark: pgfId-1379193]Step 13 Click Finish.
 
     [bookmark: pgfId-1380306]If you specified a date and time for the job under Schedule, the wizard closes and the job appears in the Summary pane.
 
     [bookmark: pgfId-1380348]If you clicked the Install Now radio button under Schedule, the Software Installation Status dialog box displays information about each device in the job and the job status.
 
     [bookmark: pgfId-1380442]Step 14 If the Software Installation Status dialog box appears, do one of the following:
 
      
       
       	 [bookmark: pgfId-1380510]If you want to close the dialog box and allow the job to run, click  Run in Background .
 
       	 [bookmark: pgfId-1380577]If you want to abort software installation on one or more devices, for each device, click the device and click  Abort Selected .
 
       	 [bookmark: pgfId-1380633]If you want to abort software installation for all devices, click  Abort All .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1380668]Tip If you abort software installation on all devices, click Close to close the dialog box.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1120935]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468119]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468123]Installing Software on a Device
 
      	 [bookmark: pgfId-1468127]Creating or Editing a Software Installation Job
 
      	 [bookmark: pgfId-1468131]Rescheduling a Software Installation Job
 
      	 [bookmark: pgfId-1468135]Deleting a Software Installation Job
 
      	 [bookmark: pgfId-1468139]Adding or Changing Comments for a Software Installation Job
 
      	 [bookmark: pgfId-1468143]Changing Installation Options for a Software Installation Job
 
     
 
    
 
     
      [bookmark: pgfId-1118637][bookmark: 69928]Rescheduling a Software Installation Job[bookmark: marker-1173979]
 
     [bookmark: pgfId-1118662]You can change the scheduled date and time of a software installation job.
 
    
 
     
      [bookmark: pgfId-1118677]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1118944]The software installation job that you want to reschedule must have a status of Scheduled. You cannot reschedule aborted or completed jobs.
 
    
 
     
      [bookmark: pgfId-1118932]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1118867]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1381680]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1118720]Step 2 In the Summary pane, click the job that you want to reschedule.
 
     [bookmark: pgfId-1381693]The Details pane displays information about the job.
 
     [bookmark: pgfId-1381725]Step 3 (Optional) From the Details tab, expand the General section, if necessary.
 
     [bookmark: pgfId-1381862]Step 4 Use the Scheduled At field to specify when the job should begin.
 
     [bookmark: pgfId-1381798]Step 5 From the menu bar, choose File > Deploy to save the change to the job schedule.
 
     [bookmark: pgfId-1118732]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468148]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468152]Viewing Software Installation Job Details
 
      	 [bookmark: pgfId-1468156]Creating or Editing a Software Installation Job
 
      	 [bookmark: pgfId-1468160]Rescheduling a Software Installation Job
 
      	 [bookmark: pgfId-1468164]Deleting a Software Installation Job
 
      	 [bookmark: pgfId-1468168]Adding or Changing Comments for a Software Installation Job
 
      	 [bookmark: pgfId-1468172]Changing Installation Options for a Software Installation Job
 
     
 
    
 
     
      [bookmark: pgfId-1375223][bookmark: 48260]Deleting a Software Installation Job[bookmark: marker-1375222]
 
     [bookmark: pgfId-1375224]You can delete a software installation job, regardless of its state. In the Summary pane for Software Installation Jobs, completed and aborted jobs remain until you delete them.
 
    
 
     
      [bookmark: pgfId-1375228]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1381871]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1381872]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1381873]Step 2 In the Summary pane, click the job that you want to delete.
 
     [bookmark: pgfId-1381874]The Details pane displays information about the job.
 
     [bookmark: pgfId-1381875]Step 3 From the menu bar, choose Actions > Delete.
 
     [bookmark: pgfId-1381876]A Warning dialog box displays a confirmation message.
 
     [bookmark: pgfId-1382007]Step 4 Click Yes.
 
     [bookmark: pgfId-1381877]The job is removed from the summary pane. You do not need to save your changes.
 
     [bookmark: pgfId-1421414]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468177]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468181]Viewing Software Installation Job Details
 
      	 [bookmark: pgfId-1468185]Creating or Editing a Software Installation Job
 
      	 [bookmark: pgfId-1468189]Rescheduling a Software Installation Job
 
      	 [bookmark: pgfId-1468193]Adding or Changing Comments for a Software Installation Job
 
      	 [bookmark: pgfId-1468197]Changing Installation Options for a Software Installation Job
 
     
 
    
 
     
      [bookmark: pgfId-1375271][bookmark: 58804]Adding or Changing Comments for a Software Installation Job[bookmark: marker-1375270]
 
     [bookmark: pgfId-1375272]You can add or change the comments associated with a software installation job.
 
    
 
     
      [bookmark: pgfId-1375276]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1382107]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1382108]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1382109]Step 2 In the Summary pane, click the job for which you want to add or change comments.
 
     [bookmark: pgfId-1382110]The Details pane displays information about the job.
 
     [bookmark: pgfId-1382111]Step 3 (Optional) From the Details tab, expand the General section, if necessary.
 
     [bookmark: pgfId-1382112]Step 4 In the Comments field, enter your comments.
 
     [bookmark: pgfId-1382113]Step 5 From the menu bar, choose File > Deploy to save the change to the job schedule.
 
     [bookmark: pgfId-1382114]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468202]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468206]Viewing Software Installation Job Details
 
      	 [bookmark: pgfId-1468210]Creating or Editing a Software Installation Job
 
      	 [bookmark: pgfId-1468214]Rescheduling a Software Installation Job
 
      	 [bookmark: pgfId-1468218]Deleting a Software Installation Job
 
      	 [bookmark: pgfId-1468222]Changing Installation Options for a Software Installation Job
 
     
 
    
 
     
      [bookmark: pgfId-1382170][bookmark: 65161]Changing Installation Options for a Software Installation Job[bookmark: marker-1382169]
 
     [bookmark: pgfId-1382171]You can change the installation options associated with a software installation job. Installation options allow you to specify whether Cisco DCNM should save the running configuration of devices, delete the startup configuration, or take no action on the configuration of devices prior to installing the software.
 
    
 
     
      [bookmark: pgfId-1382173]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1382175]Step 1 From the Feature Selector pane, choose Device OS Management > Software Installation Jobs.
 
     [bookmark: pgfId-1382176]The Summary pane displays a table of software installation jobs.
 
     [bookmark: pgfId-1382177]Step 2 In the Summary pane, click the job for which you want to add or change comments.
 
     [bookmark: pgfId-1382178]The Details pane displays information about the job.
 
     [bookmark: pgfId-1382179]Step 3 (Optional) From the Details tab, expand the General section, if necessary.
 
     [bookmark: pgfId-1382443]Step 4 If you want devices in the software installation job to have only the default device configuration after the installation job completes, follow these steps:
 
     [bookmark: pgfId-1382511] a. Check the Installation Options check box.
 
     [bookmark: pgfId-1382513] b. If you want the job to delete the startup configuration on each device, click the Erase Startup Configuration before Installation radio button.
 
     [bookmark: pgfId-1382493]Step 5 If you want devices in the software installation job to have the same running configuration after the installation job completes, follow these steps:
 
     [bookmark: pgfId-1382586] a. Check the Installation Options check box.
 
     [bookmark: pgfId-1382688] b. If you want the job to copy the running configuration to the startup configuration on each device, click the Save Running Configuration to Startup before Installation radio button.
 
     [bookmark: pgfId-1382689]Step 6 If you want the devices in the software installation job to use their current startup configuration as their running configuration after the software installation job completes, uncheck the Installation Options check box.
 
     [bookmark: pgfId-1382690]Step 7 From the menu bar, choose File > Deploy to save the change to the job schedule.
 
     [bookmark: pgfId-1382182]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468227]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468231]Viewing Software Installation Job Details
 
      	 [bookmark: pgfId-1468235]Creating or Editing a Software Installation Job
 
      	 [bookmark: pgfId-1468239]Rescheduling a Software Installation Job
 
      	 [bookmark: pgfId-1468243]Deleting a Software Installation Job
 
      	 [bookmark: pgfId-1468247]Adding or Changing Comments for a Software Installation Job
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1390009][bookmark: 84558]Configuring File Servers[bookmark: marker-1400977]
 
    [bookmark: pgfId-1468252]The File Servers feature allows you to configure files servers, which you can use for the following purposes:
 
     
     	 [bookmark: pgfId-1468253]Software installation jobs—DCNM can get software image files from a file server and transfer them to devices included in a software installation job.
 
     	 [bookmark: pgfId-1468254]Configuration rollbacks—DCNM can back up device configurations to a file server when you roll back a device configuration.
 
    
 
    [bookmark: pgfId-1476865]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1476869]Adding a File Server
 
     	 [bookmark: pgfId-1476873]Changing a File Server
 
     	 [bookmark: pgfId-1476877]Deleting a File Server
 
    
 
     
      [bookmark: pgfId-1375329][bookmark: 13500]Adding a File Server[bookmark: marker-1375328]
 
     [bookmark: pgfId-1375330]You can add a file server to Cisco DCNM.
 
    
 
     
      [bookmark: pgfId-1375332]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375333]Gather the following information about the file server:
 
      
      	 [bookmark: pgfId-1382817]Server IP address or hostname
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1382837]Note If you use the hostname, it must be registered with the DNS server that the Cisco DCNM server is configured to use.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1382933]Transfer protocol that the server provides. Cisco DCNM supports the following transfer protocols:
 
     
 
     [bookmark: pgfId-1382954] – FTP
 
     [bookmark: pgfId-1382966] – SFTP
 
     [bookmark: pgfId-1382971] – TFTP
 
      
      	 [bookmark: pgfId-1382982]Username and password that Cisco DCNM should use to access the server.
 
      	 [bookmark: pgfId-1383005]The base directory on the server. All files and directories that Cisco DCNM needs to access must be available under this directory.
 
     
 
    
 
     
      [bookmark: pgfId-1375334]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1383028]Step 1 From the Feature Selector pane, choose Device OS Management > File Servers.
 
     [bookmark: pgfId-1383029]The Contents pane displays a table of file servers.
 
     [bookmark: pgfId-1383030]Step 2 From the menu bar, choose Actions > New File Server.
 
     [bookmark: pgfId-1383031]A new row appears in the Contents pane, with the cursor in the Server Name/IP Address field.
 
     [bookmark: pgfId-1383032]Step 3 In the Server Name/IP Address field, enter the IP address or hostname of the file server.
 
     [bookmark: pgfId-1383143]Step 4 Double-click the Protocol field and choose the protocol from the list that appears. Supported protocols are as follows:
 
      
       
       	 [bookmark: pgfId-1383146]FTP
 
       	 [bookmark: pgfId-1383157]SFTP
 
       	 [bookmark: pgfId-1383162]TFTP
 
      
 
     
 
     [bookmark: pgfId-1383040]Step 5 If the file server requires authentication, double-click the User Credentials field and enter the username and password for the server. If you want Cisco DCNM to remember the password, check the Save Password check box.
 
     [bookmark: pgfId-1383219]Step 6 Double-click the Base Directory field.
 
     [bookmark: pgfId-1383234]The Software Image Browser dialog box appears.
 
     [bookmark: pgfId-1383228]Step 7 Explore the server file system and choose the directory that Cisco DCNM should use as the base directory. All files and directories that Cisco DCNM needs to access must be located under this directory. By default, the root directory of the server is the base directory.
 
     [bookmark: pgfId-1383250]Step 8 (Optional) Double-click the Comment field and enter your comments.
 
     [bookmark: pgfId-1383167]Step 9 From the menu bar, choose File > Deploy to save the change to the job schedule.
 
     [bookmark: pgfId-1375341]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468259]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468263]Changing a File Server
 
      	 [bookmark: pgfId-1468267]Deleting a File Server
 
     
 
    
 
     
      [bookmark: pgfId-1375388][bookmark: 52847]Changing a File Server[bookmark: marker-1383530]
 
     [bookmark: pgfId-1383258]You can change the user credentials, base directory, and comments of a file server.
 
      
       
     
 
     
 
     [bookmark: pgfId-1383265]Note You cannot change the values in the Server Name/IP Address or Protocol fields. If you need to change these values, delete the file server and create a file server with the new values.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1383314]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1383344]If you are changing the user credentials or base directory, determine what the new user credentials or base directory should be.
 
    
 
     
      [bookmark: pgfId-1383362]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1383543]Step 1 From the Feature Selector pane, choose Device OS Management > File Servers.
 
     [bookmark: pgfId-1383544]The Contents pane displays a table of file servers.
 
     [bookmark: pgfId-1383684]Step 2 In the table, locate the row for the file server that you want to change.
 
     [bookmark: pgfId-1383738]Step 3 Perform the following items to change the file server entry as needed:
 
      
       
       	 [bookmark: pgfId-1383608]If you want to change the user credentials, double-click the User Credentials field for the file server and enter or clear the username and password for the server. If you want Cisco DCNM to remember the password, check the  Save Password check box.
 
       	 [bookmark: pgfId-1383630]If you want to change the base directory, double-click the Base Directory field and use the Software Image Browser dialog box to choose the directory that Cisco DCNM should use as the base directory.
 
       	 [bookmark: pgfId-1383652]If you want to change the comments, double-click the Comments field and enter your comments.
 
      
 
     
 
     [bookmark: pgfId-1383578]Step 4 From the menu bar, choose File > Deploy to save the file server changes.
 
     [bookmark: pgfId-1383467]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468272]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468276]Adding a File Server
 
      	 [bookmark: pgfId-1468280]Deleting a File Server
 
     
 
    
 
     
      [bookmark: pgfId-1383470][bookmark: 88466]Deleting a File Server[bookmark: marker-1383469]
 
     [bookmark: pgfId-1375389]You can delete a file server.
 
    
 
     
      [bookmark: pgfId-1375391]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375392]Ensure that the file server is specified in the Archival Settings feature as the file server for configuration rollback. For more information, see the “Configuring the Rollback File Server Setting” section.
 
    
 
     
      [bookmark: pgfId-1375393]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1383766]Step 1 From the Feature Selector pane, choose Device OS Management > File Servers.
 
     [bookmark: pgfId-1383767]The Contents pane displays a table of file servers.
 
     [bookmark: pgfId-1383768]Step 2 In the table, click the row for the file server that you want to delete.
 
     [bookmark: pgfId-1375397]Step 3 From the menu bar, choose Actions > Delete.
 
      
       
     
 
     
 
     [bookmark: pgfId-1383826]Note If the file server is specified in the Archival Settings feature as the file server for a configuration rollback, a dialog box informs you that the file server cannot be deleted. For more information, see the “Configuring the Rollback File Server Setting” section.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1417196]The file server is removed from the summary pane. You do not need to save your changes.
 
     [bookmark: pgfId-1375400]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1468285]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1468289]Adding a File Server
 
      	 [bookmark: pgfId-1468293]Changing a File Server
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1476883][bookmark: 59585]Field Descriptions for Device OS Management
 
    [bookmark: pgfId-1476884]This section includes field descriptions for the three features available in the Feature Selector drawer for [bookmark: marker-1476885]Device OS Management:
 
     
     	 [bookmark: pgfId-1476889]Field Descriptions for Device OS Management
 
     	 [bookmark: pgfId-1476893]Field Descriptions for Software Installation Jobs
 
     	 [bookmark: pgfId-1476897]Field Descriptions for the File Servers Contents Pane
 
    
 
     
      [bookmark: pgfId-1476899][bookmark: 49384]Field Descriptions for Device OS Management
 
     [bookmark: pgfId-1476900]This section includes the following field descriptions for the Device OS Management feature:
 
      
      	 [bookmark: pgfId-1476904]Device: Details: System Section
 
      	 [bookmark: pgfId-1476908]Device: Details: Software Installation Jobs Section
 
     
 
    
 
     
      [bookmark: pgfId-1476910][bookmark: 59437]Device: Details: System Section
 
     [bookmark: pgfId-1476959]
 
      
       
        
        [bookmark: pgfId-1476916]Table 24-1 Device: Details: System Section 
 
        
        
         
         	 
           
           [bookmark: pgfId-1476920]Field 
          
  
         	 
           
           [bookmark: pgfId-1476922]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1476924]System 
          
  
        
 
         
         	[bookmark: pgfId-1476928]Device Name
  
         	[bookmark: pgfId-1476930]Display only. Name of the managed device.
  
        
 
         
         	[bookmark: pgfId-1476932]IP Address
  
         	[bookmark: pgfId-1476934]Display only. IP address that Cisco DCNM uses to connect to the managed device.
  
        
 
         
         	[bookmark: pgfId-1476936]Model
  
         	[bookmark: pgfId-1476938]Display only. Hardware model name of the managed device.
  
        
 
         
         	[bookmark: pgfId-1476940]Redundancy Supervisor
  
         	[bookmark: pgfId-1476942]Display only. Whether the device has a secondary supervisor module.
  
        
 
         
         	 
           
           [bookmark: pgfId-1476944]Software 
          
  
        
 
         
         	[bookmark: pgfId-1476948]System Version
  
         	[bookmark: pgfId-1476950]Display only. Release number of the system image currently installed on the managed device.
  
        
 
         
         	[bookmark: pgfId-1476952]System Image
  
         	[bookmark: pgfId-1476954]Display only. Filename of the system image currently installed on the managed device.
  
        
 
         
         	[bookmark: pgfId-1476956]Kickstart Image
  
         	 
           
            
             
             [bookmark: pgfId-1476967]Table 24-2 Device: Details: Software Installation Jobs Section 
 
             
             
              
              	 
                
                [bookmark: pgfId-1476971]Field 
               
  
              	 
                
                [bookmark: pgfId-1476973]Description 
               
  
             
 
              
              	[bookmark: pgfId-1476975]Job ID
  
              	[bookmark: pgfId-1476977]Display only. Identification number of the job.
  
             
 
              
              	[bookmark: pgfId-1476979]Owner
  
              	[bookmark: pgfId-1476981]Display only. Cisco DCNM user who created the installation job.
  
             
 
              
              	[bookmark: pgfId-1476983]Software Image and Version
  
              	[bookmark: pgfId-1476985]Display only. Name of the system image specified in the job.
  
             
 
              
              	[bookmark: pgfId-1476987]Scheduled At
  
              	[bookmark: pgfId-1476989]Display only. Date and time that the installation job is scheduled to occur.
  
             
 
              
              	[bookmark: pgfId-1476991]Completed At
  
              	[bookmark: pgfId-1476993]Display only. Date and time that the installation job occurred. If the job has not completed, this field is blank.
  
             
 
              
              	[bookmark: pgfId-1476995]Status
  
              	[bookmark: pgfId-1476997]Display only. Status of the installation job. If the job is ongoing, failed, or successful, you can expand the status and see more information about the job.
  
             
 
              
              	[bookmark: pgfId-1476999]Comment
  
              	[bookmark: pgfId-1477001]Display only. Text of any comments added to the installation job.
  
             
 
             
           
 
          
 
           
            [bookmark: pgfId-1477004][bookmark: 57584]Field Descriptions for Software Installation Jobs
 
           [bookmark: pgfId-1477005]This section includes the following field descriptions for the Software Installation Jobs feature:
 
            
            	 [bookmark: pgfId-1477009]Installation Job: Details: General Section
 
            	 [bookmark: pgfId-1477013]Installation Job: Details: Devices and Software Images Section
 
           
 
          
 
           
            [bookmark: pgfId-1477015][bookmark: 33753]Installation Job: Details: General Section
 
           [bookmark: pgfId-1477072]
 
            
             
              
              [bookmark: pgfId-1477021]Table 24-3 Installation Job: Details: General Section 
 
              
              
               
               	 
                 
                 [bookmark: pgfId-1477025]Field 
                
  
               	 
                 
                 [bookmark: pgfId-1477027]Description 
                
  
              
 
               
               	 
                 
                 [bookmark: pgfId-1477029]General 
                
  
              
 
               
               	[bookmark: pgfId-1477033]Job ID
  
               	[bookmark: pgfId-1477035]Display only. Identification number of the job.
  
              
 
               
               	[bookmark: pgfId-1477037]Owner
  
               	[bookmark: pgfId-1477039]Display only. Cisco DCNM user who created the installation job.
  
              
 
               
               	[bookmark: pgfId-1477041]Scheduled At
  
               	[bookmark: pgfId-1477043]Date and time that the installation job is scheduled to occur. If the job has not yet occurred, this field is configurable.
  
              
 
               
               	[bookmark: pgfId-1477045]Completed At
  
               	[bookmark: pgfId-1477047]Display only. Date and time that the installation job occurred. If the job has not completed, this field is blank.
  
              
 
               
               	[bookmark: pgfId-1477049]Status
  
               	[bookmark: pgfId-1477051]Display only. Status of the installation job.
  
              
 
               
               	[bookmark: pgfId-1477053]Comment
  
               	[bookmark: pgfId-1477055]Text entered by Cisco DCNM users.
  
              
 
               
               	 
                 
                 [bookmark: pgfId-1477057]Installation Options 
                
  
              
 
               
               	[bookmark: pgfId-1477061]Installation Options
  
               	[bookmark: pgfId-1477063]Whether the installation job affects the startup configuration. By default, this check box is unchecked.
  
              
 
               
               	[bookmark: pgfId-1477065]Save Running Configuration to Startup before Installation
  
               	[bookmark: pgfId-1477067]Specifies that the installation job copies the running configuration of each device in the job to its startup configuration prior to installing the software image.
  
              
 
               
               	[bookmark: pgfId-1477069]Erase Startup Configuration before Installation
  
               	 
                 
                  
                   
                   [bookmark: pgfId-1477080]Table 24-4 Installation Job: Details: General Section 
 
                   
                   
                    
                    	 
                      
                      [bookmark: pgfId-1477084]Field 
                     
  
                    	 
                      
                      [bookmark: pgfId-1477086]Description 
                     
  
                   
 
                    
                    	[bookmark: pgfId-1477088]Device
  
                    	[bookmark: pgfId-1477090]Display only. Name of the managed device.
  
                   
 
                    
                    	[bookmark: pgfId-1477092]Platform
  
                    	[bookmark: pgfId-1477094]Display only. Hardware model name of the managed device.
  
                   
 
                    
                    	[bookmark: pgfId-1477096]Kickstart Image
  
                    	[bookmark: pgfId-1477098]Display only. Filename of the kickstart image currently installed on the managed device.
  
                   
 
                    
                    	[bookmark: pgfId-1477100]System Image
  
                    	 
                      
                       
                        
                        [bookmark: pgfId-1477111]Table 24-5 File Servers Contents Pane 
 
                        
                        
                         
                         	 
                           
                           [bookmark: pgfId-1477115]Field 
                          
  
                         	 
                           
                           [bookmark: pgfId-1477117]Description 
                          
  
                        
 
                         
                         	[bookmark: pgfId-1477119]Server Name/IP Address
  
                         	[bookmark: pgfId-1477121]DNS name or IP address of the file server. If you use the file server in a software installation job, ensure that devices in the job can connect to the name or address that you specify. This field is editable only when you create the file server entry. You cannot edit it after saving your changes to the Cisco DCNM server.
  
                        
 
                         
                         	[bookmark: pgfId-1477123]Protocol
  
                         	[bookmark: pgfId-1477125]Transfer protocol supported by the server. Valid values are as follows:
 
                           
                           	 [bookmark: pgfId-1477126]FTP
 
                           	 [bookmark: pgfId-1477127]SFTP
 
                           	 [bookmark: pgfId-1477128]TFTP
 
                          
 [bookmark: pgfId-1477129]This field is editable only when you create the file server entry. You cannot edit it after saving your changes to the Cisco DCNM server.
  
                        
 
                         
                         	[bookmark: pgfId-1477131]User Credentials
  
                         	[bookmark: pgfId-1477133]Username and password required to access the file server.
  
                        
 
                         
                         	[bookmark: pgfId-1477135]Base Directory
  
                         	[bookmark: pgfId-1477137]Directory that Cisco DCNM should consider as the root directory on the server. Directories specified for software installation jobs using this server will be relative to this directory.
  
                        
 
                         
                         	[bookmark: pgfId-1477139]Comment
  
                         	[bookmark: pgfId-1477141]Text entered by Cisco DCNM users.
  
                        
 
                        
                      
 
                     
 
                      
                       [bookmark: pgfId-1477144][bookmark: 53004]Additional References
 
                      [bookmark: pgfId-1477145]For additional information related to the Device OS Management feature, see the following sections:
 
                       
                       	 [bookmark: pgfId-1477149]Related Documents
 
                       	 [bookmark: pgfId-1477153]Standards
 
                      
 
                       
                        [bookmark: pgfId-1477167][bookmark: 16521]Related Documents
 
                        
                         
                          
                           
                           	 
                             
                             [bookmark: pgfId-1477157]Related Topic 
                            
  
                           	 
                             
                             [bookmark: pgfId-1477159]Document Title 
                            
  
                          
 
                           
                           	[bookmark: pgfId-1477161]Upgrading and downgrading Cisco NX-OS software using the command-line interface on Nexus 7000 series switches.
  
                           	[bookmark: pgfId-1477165]Cisco Nexus 7000 Series NX-OS Software Upgrade and Downgrade Guide, Release 5.x
  
                          
 
                          
                        
 
                       
 
                      
 
                       
                        [bookmark: pgfId-1477178][bookmark: 55398]Standards
 
                        
                         
                          
                           
                           	 
                             
                             [bookmark: pgfId-1477171]Standards 
                            
  
                           	 
                             
                             [bookmark: pgfId-1477173]Title 
                            
  
                          
 
                           
                           	[bookmark: pgfId-1477175]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
                           	[bookmark: pgfId-1477177]—
  
                          
 
                          
                        
 
                       
 
                      
 
                     
 
                      
                       [bookmark: pgfId-1477180][bookmark: 92503]Feature History for Device OS Management
 
                      [bookmark: pgfId-1477184]Table 24-6 lists the release history for this feature.
 
                      [bookmark: pgfId-1477215]
 
                       
                        
                         
                         [bookmark: pgfId-1477191]Table 24-6 [bookmark: 50557]Feature History for Device OS Management 
 
                         
                         
                          
                          	 
                            
                            [bookmark: pgfId-1477197]Feature Name 
                           
  
                          	 
                            
                            [bookmark: pgfId-1477199]Releases 
                           
  
                          	 
                            
                            [bookmark: pgfId-1477201]Feature Information 
                           
  
                         
 
                          
                          	[bookmark: pgfId-1477203]Device OS Management
  
                          	[bookmark: pgfId-1477205]5.1(1)
  
                          	[bookmark: pgfId-1477207]No change from Release 5.0.
  
                         
 
                          
                          	[bookmark: pgfId-1477210][bookmark: marker-1477209]Device OS Management
  
                          	[bookmark: pgfId-1477212]5.0(2)
  
                          	 
                           
  
                         
 
                         
                       
 
                      
 
                     
 
                   
 
                   
                 
 
                
 
              
 
              
            
 
           
 
          
 
        
 
        
      
 
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1050709][bookmark: 50487]Starting and Stopping Cisco DCNM-LAN Servers 
      
      
 
     
 
 
    [bookmark: pgfId-1110411]This chapter describes how to start or stop Cisco Data Center Network Manager for LAN (DCNM-LAN) servers.
 
    [bookmark: pgfId-1051419]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1113979]Information About Starting and Stopping DCNM-LAN Servers
 
     	 [bookmark: pgfId-1113995]Licensing Requirements for Starting and Stopping Cisco DCNM-LAN Servers
 
     	 [bookmark: pgfId-1051433]Starting DCNM-LAN Servers
 
     	 [bookmark: pgfId-1078689]Stopping DCNM-LAN Servers
 
     	 [bookmark: pgfId-1089636]Related Documents
 
     	 [bookmark: pgfId-1051439]Feature History for Starting and Stopping a DCNM-LAN Server
 
    
 
   
 
    
     [bookmark: pgfId-1112565][bookmark: 22386]Information About Starting and Stopping DCNM-LAN Servers
 
    [bookmark: pgfId-1119599]Starting and stopping DCNM-LAN servers is a necessary part of server maintenance, such as during database backup, cleaning, or restoration. In a clustered server deployment, the order in which you start DCNM-LAN servers determines which server is the master server. This chapter provides detailed steps for starting and stopping DCNM-LAN servers for both single-server deployments and clustered-server deployments.
 
   
 
    
     [bookmark: pgfId-1119601][bookmark: 51127]Licensing Requirements for Starting and Stopping Cisco DCNM-LAN Servers
 
    [bookmark: pgfId-1119602]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1113416]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1113406]Product 
         
  
        	 
          
          [bookmark: pgfId-1113408]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1113410]Cisco DCNM-LAN
  
        	[bookmark: pgfId-1113412]Starting and stopping Cisco DCNM-LAN servers requires no license. Any feature not included in a license package is bundled with the Cisco DCNM-LAN and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1113636][bookmark: 12261]Starting DCNM-LAN Servers
 
    [bookmark: pgfId-1110563]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1110567]Starting a Single DCNM-LAN Server
 
     	 [bookmark: pgfId-1114863]Starting a Cluster of DCNM-LAN Servers
 
    
 
     
      [bookmark: pgfId-1110479][bookmark: 86941]Starting a Single DCNM-LAN Server[bookmark: marker-1088402]
 
     [bookmark: pgfId-1061985]You can start a single DCNM-LAN server. The procedures for starting a single DCNM-LAN server differ for systems using the supported Microsoft Windows Server and Red Hat Enterprise Linux (RHEL) operating systems, as described in the following topics:
 
      
      	 [bookmark: pgfId-1067326]Starting a Single DCNM-LAN Server (Microsoft Windows Server)
 
      	 [bookmark: pgfId-1067338]Starting a Single DCNM-LAN Server (RHEL)
 
     
 
    
 
     
      [bookmark: pgfId-1067343][bookmark: 87974]Starting a Single DCNM-LAN Server (Microsoft Windows Server)
 
     [bookmark: pgfId-1067447]On a server system running Microsoft Windows Server, you can start a DCNM-LAN server through the Windows services or by clicking the Start DCNM-LAN Server icon.
 
    
 
     
      [bookmark: pgfId-1066730]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1066734]You must have installed the DCNM-LAN server.
 
     [bookmark: pgfId-1111205]If you are starting a server cluster, ensure that you are starting the server in the correct order. For more information, see the “Starting a Cluster of DCNM-LAN Servers” section.
 
    
 
     
      [bookmark: pgfId-1053835]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1053424]Step 1 Open the Control Panel window and choose Administrative Tools > Services.
 
     [bookmark: pgfId-1068638]The Services window opens.
 
     [bookmark: pgfId-1068647]Step 2 Right-click Cisco DCNM Server and choose Start.
 
      
       
     
 
     
 
     [bookmark: pgfId-1078536]Note Alternatively, you can choose Start > All Programs > Cisco DCNM Server > Start DCNM Server; however, the location of shortcuts depends upon the choices you made when you installed the DCNM-LAN server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1068956]A splash screen opens while the DCNM-LAN server starts. This screen closes once the DCNM-LAN server is running.
 
     [bookmark: pgfId-1068942]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1067270][bookmark: 11170]Starting a Single DCNM-LAN Server (RHEL)
 
     [bookmark: pgfId-1119916]On a server system that runs RHEL, you can start a DCNM-LAN server with the Start_DCNM_LAN_Server script. The script is located in your home folder or the folder that was specified when setting up the link folder during the installation of Cisco DCNM-LAN.
 
      
       
     
 
     
 
     [bookmark: pgfId-1120209]Note Start_DCNM_LAN_Server launches /usr/local/Cisco/dcm/dcnm/bin/startdcnm.sh.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1067391]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1067395]The DCNM-LAN server must be installed.
 
     [bookmark: pgfId-1114377]If you are starting a server cluster, ensure that you are starting the server in the correct order. For more information, see the “Starting a Cluster of DCNM-LAN Servers” section.
 
    
 
     
      [bookmark: pgfId-1067396]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1067271]Step 1 Use the Start_DCNM_LAN_Server script to start the server on a RHEL operating system.
 
     [bookmark: pgfId-1067277]The DCNM-LAN server opens a server console window and displays the processes it runs to start the server. The server is running when you see a “Started in Xm:XXs:XXXms” message.
 
     [bookmark: pgfId-1067278]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1114781][bookmark: 62724]Starting a Cluster of DCNM-LAN Servers
 
     [bookmark: pgfId-1117229]Depending on the operating system of the secondary server, the DCNM-LAN server can be started using the Windows GUI, the CLI, or the DCNM Install Manager tool. You can use the CLI or the DCNM Install Manager tool for a secondary server running RHEL. For a secondary server running Microsoft Windows, the DCNM-LAN server is started with the Windows GUI.
 
    
 
     
      [bookmark: pgfId-1117145]Starting with Windows GUI or RHEL CLI
 
     [bookmark: pgfId-1117135]Starting a cluster of DCNM-LAN servers requires starting each server individually; however, the order of server startup is important. The server with the oldest start time performs the master server role in the server cluster.
 
    
 
     
      [bookmark: pgfId-1114783]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1114784]We recommend that you use the primary installation server as the master server. For information about deploying a clustered-server environment, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
 
     [bookmark: pgfId-1114788]If any server in the cluster is running, stop it prior to starting the cluster. The only way that you can control which server is the master server is by ensuring that the master server is started before the other servers start. For more information, see the “Stopping DCNM-LAN Servers” section.
 
    
 
     
      [bookmark: pgfId-1114792]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1114794]Step 1 Start the server that you want to be the master server of the cluster. To do so, follow the steps for starting a single DCNM-LAN server for the applicable operating system:
 
      
       
       	 [bookmark: pgfId-1114798]Starting a Single DCNM-LAN Server (Microsoft Windows Server)
 
       	 [bookmark: pgfId-1114802]Starting a Single DCNM-LAN Server (RHEL)
 
      
 
     
 
     [bookmark: pgfId-1114803]Step 2 Wait for the master server to finish starting.
 
     [bookmark: pgfId-1114804]Step 3 One at a time, start the other servers in the cluster. After starting a server, wait at least one minute before starting the next server. This delay helps ensure faster stabilization of the server cluster.
 
     [bookmark: pgfId-1114805]For each server, follow the steps for starting a single DCNM-LAN server for the applicable operating system:
 
      
       
       	 [bookmark: pgfId-1114809]Starting a Single DCNM-LAN Server (Microsoft Windows Server)
 
       	 [bookmark: pgfId-1114813]Starting a Single DCNM-LAN Server (RHEL)
 
      
 
     
 
     [bookmark: pgfId-1114814]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1116984]Starting with Install Manager
 
     [bookmark: pgfId-1116986]DCNM Install Manager is a GUI tool for servers that run Linux. It is designed to assist in performing silent mode operations on secondary servers (remote nodes). 
 
      
       
     
 
     
 
     [bookmark: pgfId-1116987]Note DCNM Install Manager does not support Windows servers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1116988]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1116989]Step 1 To access Install Manager, navigate to the dcnm-install-manager.sh file that is located in the bin folder where the DCNM-LAN server was installed.
 
     [bookmark: pgfId-1116990]The default bin folder location for servers running Linux is /usr/local/Cisco/dcm/dcnm/bin.
 
     [bookmark: pgfId-1116991]Step 2 Double click the dcnm-install-manager.sh file to launch Install Manager.
 
     [bookmark: pgfId-1116992]Step 3 In the tool bar, click the New icon near the top of the Install Manager GUI for every secondary server.
 
     [bookmark: pgfId-1116993]A new row in the list of Server Nodes is created every time the New icon is clicked.
 
      
       
     
 
     
 
     [bookmark: pgfId-1116994]Note In the toolbar, click the Delete icon to delete a selected row in the list of Server Nodes. This step does not delete a secondary server from the clustered-server environment.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1116995]Step 4 For each secondary server represented by a row in the list of Server Nodes, enter the following:
 
      
       
       	 [bookmark: pgfId-1116996]Server name or IP address in the Server Name/IP Address field.
 
       	 [bookmark: pgfId-1116997]Protocol used for connectivity in the Protocol field.
 
      
 
     
 
     [bookmark: pgfId-1116998]The protocol is either Telnet or SSH.
 
      
       
       	 [bookmark: pgfId-1116999]User credentials (user ID and password) used for connecting to the secondary server in the User Credentials field.
 
      
 
     
 
     [bookmark: pgfId-1117000]The user credentials are used for SSH connectivity to the server. Telnet connectivity to the server does not require user credentials.
 
     [bookmark: pgfId-1117001]Alternatively, default user credentials may be set by entering the credentials in the Default Credentials section of the GUI. The default credentials are used when the User Credential field is blank.
 
      
       
       	 [bookmark: pgfId-1117002](Optional) Comments that may be useful to identify the secondary server in the Comments field.
 
      
 
     
 
     [bookmark: pgfId-1117003]The Last Action Status column in the list of Server Nodes includes the success or failure status of the last performed action. Clicking the “+” icon for the Last Action Status expands the display to show the entire log of actions performed on the server.
 
     [bookmark: pgfId-1117004]Step 5 In the list of Server Nodes, select the secondary servers to start.
 
     [bookmark: pgfId-1117005]Step 6 In the toolbar, click the Verify icon to verify the connectivity to the selected secondary servers.
 
     [bookmark: pgfId-1117006]Correct any connectivity issues before continuing.
 
     [bookmark: pgfId-1117007]Step 7 In the toolbar, click the Start icon to start the selected secondary servers.
 
      
       
     
 
     
 
     [bookmark: pgfId-1117008]Note The Install Manager is a standalone application. The settings specified are not saved and are not persistent. The settings are lost when the Install Manager GUI is closed.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1119519]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1060174][bookmark: 43098]Stopping DCNM-LAN Servers[bookmark: marker-1088378]
 
    [bookmark: pgfId-1111410]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1111418]Stopping Single DCNM-LAN Servers
 
     	 [bookmark: pgfId-1115057]Stopping a Cluster of DCNM-LAN Servers
 
    
 
     
      [bookmark: pgfId-1111911][bookmark: 12034]Stopping Single DCNM-LAN Servers
 
     [bookmark: pgfId-1111266]You can stop a single DCNM-LAN server.
 
     [bookmark: pgfId-1115102]The steps for stopping a single DCNM-LAN server differ for systems using the supported Microsoft Windows Server and RHEL operating systems, as described in the following topics:
 
      
      	 [bookmark: pgfId-1067949]Stopping a Single DCNM-LAN Server (Microsoft Windows Server)
 
      	 [bookmark: pgfId-1111548]Stopping a Single DCNM-LAN Server (RHEL)
 
     
 
    
 
     
      [bookmark: pgfId-1115072][bookmark: 62300]Stopping a Single DCNM-LAN Server (Microsoft Windows Server)
 
     [bookmark: pgfId-1111551]On a server system that runs Microsoft Windows Server, you can stop a DCNM-LAN server through the Windows services or by clicking the Stop DCNM Server icon.
 
    
 
     
      [bookmark: pgfId-1067962]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1087071]Step 1 Open the Control Panel window and choose Administrative Tools > Services. 
 
     [bookmark: pgfId-1087072]A window opens listing the Windows services.
 
     [bookmark: pgfId-1086925]Step 2 Right-click Cisco DCNM Server and choose Stop.
 
      
       
     
 
     
 
     [bookmark: pgfId-1087102]Note Alternatively, you can choose Start > All Programs > Cisco DCNM Server > Stop DCNM Server; however, the location of shortcuts depends upon the choices you made when you installed the DCNM-LAN server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1086926]A splash screen opens while the DCNM-LAN server begins to shut down. When the DCNM-LAN server has stopped, the splash screen closes.
 
     [bookmark: pgfId-1074007]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1067980][bookmark: 11662]Stopping a Single DCNM-LAN Server (RHEL)
 
     [bookmark: pgfId-1120055]On a server system that runs RHEL, you can stop a DCNM-LAN server with the Stop_DCNM_LAN_Server script. The script is located in your home folder or the folder that was specified when setting up the link folder during the installation of Cisco DCNM-LAN.
 
      
       
     
 
     
 
     [bookmark: pgfId-1120185]Note Stop_DCNM_LAN_Server launches /usr/local/Cisco/dcm/dcnm/bin/stopdcnm.sh.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1067986]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1071879]Step 1 Use the Stop_DCNM_LAN_Server script to stop the server on a RHEL operating system.
 
     [bookmark: pgfId-1068129]The DCNM-LAN server opens a server console window and displays the processes that it runs to stop the server. The server is stopped when you see a “Stopped at Xm:XXs:XXXms” message.
 
     [bookmark: pgfId-1093447]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1114993][bookmark: 71272]Stopping a Cluster of DCNM-LAN Servers
 
     [bookmark: pgfId-1116726]Depending on the operating system of the secondary server, the DCNM-LAN server can be stopped using the CLI or the DCNM Install Manager tool. You can use the CLI or the DCNM Install Manager tool for a secondary server running RHEL. For a secondary server running Microsoft Windows, the DCNM-LAN server is stopped with the CLI.
 
    
 
     
      [bookmark: pgfId-1116703]Stopping with CLI
 
     [bookmark: pgfId-1116693]If you have a clustered-server DCNM-LAN deployment, you can use the stop-dcnm-cluster script to stop all the servers in the cluster.
 
    
 
     
      [bookmark: pgfId-1114995]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1114996]Ensure that you know which server is currently the master server in the DCNM-LAN server cluster. You can use the Cluster Administration feature to do so.
 
    
 
     
      [bookmark: pgfId-1115000]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1115002]Step 1 On the master server, access a command prompt.
 
     [bookmark: pgfId-1115003]Step 2 Use the cd command to change the directory to the bin directory under the Cisco DCNM installation directory, as follows:
 
     [bookmark: pgfId-1115004]cd path
 
     [bookmark: pgfId-1115005]where path is the relative or absolute path to the bin directory. For Microsoft Windows, the default path to the Cisco DCNM bin directory is C:\Program Files\Cisco Systems\dcm\dcnm\bin. For RHEL, the default path to the bin directory is /usr/local/cisco/dcm/dcnm/bin.
 
     [bookmark: pgfId-1115006]Step 3 Run the stop-dcnm-cluster script. The script name depends upon the server operating system, as shown in the following table:
 
     [bookmark: pgfId-1115020]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1115009]Server Operating System 
          
  
         	 
           
           [bookmark: pgfId-1115011]Stop DCNM Cluster Script 
          
  
        
 
         
         	[bookmark: pgfId-1115013]Microsoft Windows
  
         	[bookmark: pgfId-1115015]stop-dcnm-cluster.bat
  
        
 
         
         	[bookmark: pgfId-1115017]Linux
  
         	[bookmark: pgfId-1115019]stop-dcnm-cluster.sh
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1115021]The script instructs each DCNM-LAN server in the cluster to stop.
 
     [bookmark: pgfId-1115022]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1115023]Example
 
     [bookmark: pgfId-1115024]The following example from a Microsoft Windows server shows how to stop a cluster of DCNM-LAN servers, with DCNM-LAN installed in the default directory:
 
      
      [bookmark: pgfId-1115025]C:\Documents and Settings\Administrator>cd "C:\Program Files\Cisco Systems\dcm\dcnm\bin" 
     
 
      
      [bookmark: pgfId-1115027] 
     
 
      
      [bookmark: pgfId-1115028]C:\Program Files\Cisco Systems\dcm\dcnm\bin>stop-dcnm-cluster.bat 
     
 
      
      [bookmark: pgfId-1115029] 
     
 
      
      [bookmark: pgfId-1115030]C:\Program Files\Cisco Systems\dcm\dcnm\bin>set JAVA_HOME=C:\Program Files\Cisco Systems\ 
     
 
      
      [bookmark: pgfId-1115031]dcm\java\jre1.5 
     
 
      
      [bookmark: pgfId-1115032] 
     
 
      
      [bookmark: pgfId-1115033]C:\Program Files\Cisco Systems\dcm\dcnm\bin>"C:\Program Files\Cisco Systems\dcm\ jboss-4.2.2.GA\bin\twiddle.bat" -s 172.28.254.254:1099 invoke "com.cisco.dcbu.dcm:service=ClusterServerInfo" stopServerInstancesInCluster 10 
     
 
      
      [bookmark: pgfId-1115034]Shutdown Triggered for all Servers Successfully 
     
 
      
      [bookmark: pgfId-1115035]C:\Program Files\Cisco Systems\dcm\dcnm\bin> 
     
 
      
      [bookmark: pgfId-1116409] 
     
 
    
 
     
      [bookmark: pgfId-1116485]Stopping with Install Manager
 
     [bookmark: pgfId-1116487]Cisco DCNM Install Manager is a GUI tool for servers that runs Linux. It is designed to assist in performing silent mode operations on secondary servers (remote nodes). 
 
      
       
     
 
     
 
     [bookmark: pgfId-1116488]Note Cisco DCNM Install Manager does not support Windows servers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1116489]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1116490]Step 1 To access Install Manager, navigate to the dcnm-install-manager.sh file that is located in the bin folder where the DCNM-LAN server was installed.
 
     [bookmark: pgfId-1116491]The default bin folder location for servers running Linux is /usr/local/Cisco/dcm/dcnm/bin.
 
     [bookmark: pgfId-1116492]Step 2 Double click the dcnm-install-manager.sh file to launch Install Manager.
 
     [bookmark: pgfId-1116493]Step 3 In the toolbar, click the New icon near the top of the Install Manager GUI for every secondary server.
 
     [bookmark: pgfId-1116494]A new row in the list of Server Nodes is created every time that the New icon is clicked.
 
      
       
     
 
     
 
     [bookmark: pgfId-1116495]Note In the toolbar, click the Delete icon to delete a selected row in the list of Server Nodes. This step does not delete a secondary server from the clustered-server environment.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1116496]Step 4 For each secondary server represented by a row in the list of Server Nodes, enter the following:
 
      
       
       	 [bookmark: pgfId-1116497]Server name or IP address in the Server Name/IP Address field.
 
       	 [bookmark: pgfId-1116498]Protocol used for connectivity in the Protocol field.
 
      
 
     
 
     [bookmark: pgfId-1116499]The protocol is either Telnet or SSH.
 
      
       
       	 [bookmark: pgfId-1116500]User credentials (user ID and password) used for connecting to the secondary server in the User Credentials field.
 
      
 
     
 
     [bookmark: pgfId-1116501]The user credentials are used for SSH connectivity to the server. Telnet connectivity to the server does not require user credentials.
 
     [bookmark: pgfId-1116502]Alternatively, default user credentials can be set by entering the credentials in the Default Credentials section of the GUI. The default credentials are used when the User Credential field is blank.
 
      
       
       	 [bookmark: pgfId-1116503](Optional) Comments that might be useful to identify the secondary server in the Comments field.
 
      
 
     
 
     [bookmark: pgfId-1116504]The Last Action Status column in the list of Server Nodes includes the success or failure status of the last performed action. Clicking the “+” icon for the Last Action Status expands the display to show the entire log of actions performed on the server.
 
     [bookmark: pgfId-1116505]Step 5 In the list of Server Nodes, choose the secondary servers to stop.
 
     [bookmark: pgfId-1116506]Step 6 In the toolbar, click the Verify icon to verify the connectivity to the selected secondary servers.
 
     [bookmark: pgfId-1116507]Correct any connectivity issues before continuing.
 
     [bookmark: pgfId-1116508]Step 7 In the toolbar, click the Stop icon to stop the selected secondary servers.
 
      
       
     
 
     
 
     [bookmark: pgfId-1116509]Note The Install Manager is a standalone application. The settings specified are not saved and are not persistent. The settings are lost when you exit the Install Manager GUI.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1119560]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1089541][bookmark: 16521]Related Documents
 
    [bookmark: pgfId-1089561]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1089544]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1089546]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1089555]Deploying single DCNM-LAN servers and deploying DCNM-LAN server clusters
  
        	[bookmark: pgfId-1089560]Cisco DCNM Installation and Licensing Guide, Release 7.1.x
  
       
 
        
        	[bookmark: pgfId-1114039]Backing up, cleaning, and restoring DCNM-LAN databases
  
        	[bookmark: pgfId-1114044]Chapter 35, “Maintaining the Cisco DCNM-LAN Database”
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1089529][bookmark: 92503]Feature History for Starting and Stopping a DCNM-LAN Server
 
    [bookmark: pgfId-1078557]Table 25-1 lists the release history for this feature.
 
    [bookmark: pgfId-1078593]
 
     
      
       
       [bookmark: pgfId-1078564]Table 25-1 [bookmark: 50557]Feature History for Starting and Stopping a DCNM-LAN Server 
 
       
       
        
        	 
          
          [bookmark: pgfId-1078570]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1078572]Releases 
         
  
        	 
          
          [bookmark: pgfId-1078574]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1078576]Starting and stopping a cluster of servers
  
        	[bookmark: pgfId-1078578]5.0(2)
  
        	[bookmark: pgfId-1078580]Support for starting and stopping a cluster of servers was introduced.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1078549]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-241178][bookmark: 15697]Data Center Network Manager (DCNM) - Vacuum and Autovacuum Postgres Databases 
      
      
 
     
 
 
    [bookmark: pgfId-241179]This chapter describes how to vacuum the postgres database in Microsoft Windows and Linux.
 
    [bookmark: pgfId-241285]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-181128]Background Information
 
     	 [bookmark: pgfId-243036]Vacuum DCNM's Postgresql Database in Windows
 
     	 [bookmark: pgfId-243046]Vacuum DCNM's Postgresql Database in Linux
 
    
 
   
 
    
     [bookmark: pgfId-164254][bookmark: 98296]Background Information
 
    [bookmark: pgfId-186328]It is absolutely critical to vacuum postgres databases in order for the databases to properly function. Through the life of the database, new entries are added and current entries are updated. By design, postgres does not immediately remove the iterations of a record as it gets updated. Therefore, postgres databases can contain a large number of stale, unused records. These old records should be removed at least every two weeks with the vacuum function in order to reduce disk usage and improve the speed of database queries. It is even more effective if you configure postgres to automatically vacuum the database without the need to stop the Data Center Network Manager (DCNM) services.
 
     
      
    
 
    
 
    [bookmark: pgfId-241935]Note $INSTALLDIR throughout this article refers to "C:\Program Files\Cisco Systems\" or "/usr/local/cisco/" based on the operating system, Microsoft Windows or Linux respectively. The install path could be changed from these defaults during installation.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-241958][bookmark: 11509]Vacuum DCNM's Postgresql Database in Windows
 
    
 
    [bookmark: pgfId-241982]Step 1 Stop the DCNM services by clicking Stop DCNM Servers button, or enter the command as below:
 
    [bookmark: pgfId-242075]$INSTALLDIR/dcm/dcnm/bin/stopLANSANserver.bat
 
    [bookmark: pgfId-242129]Step 2 Obtain the database name, username, and password. Locate the postgresql.cfg.xml file on the DCNM server.
 
     
     	 [bookmark: pgfId-242121]In DCNM Version 6.2.x, enter:
 
    
 
    [bookmark: pgfId-242183]$INSTALLDIR/dcm/jboss-4.2.2.GA/server/dcnm/conf/database/postgresql.cfg.xml
 
     
     	 [bookmark: pgfId-242202]In DCNM Version 6.3.x, enter:
 
    
 
    [bookmark: pgfId-242195]$INSTALLDIR/dcm/Jboss-as-7.2.0.Final/standalone/conf/postgresql.cfg.xml
 
    [bookmark: pgfId-242236]Step 3 Open PgAdmin III.exe, which is a helpful GUI for the postgres database. Then, right-click the object in the list and connect to the database. Enter the password from Step 2 here.
 
    [bookmark: pgfId-242271]Step 4 Navigate through the drop-down menus to the dcmdb database.
 
    [bookmark: pgfId-242290]Step 5 Right-click dcmdb and select Maintenance. Select the Vacuum, Full, Analyze, and Verbose options in the Maintain Database dcmdb dialog box.
 
     
      
    
 
    
 
    [bookmark: pgfId-242306]Note The vacuum operation usually completes within an hour, but can take much longer for larger databases. Remember to restart the DCNM services.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-243009]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-242391][bookmark: 51146]Vacuum DCNM's Postgresql Database in Linux
 
    
 
    [bookmark: pgfId-242402]Step 1 Stop dcnm by using the appmgr stop dcnm command.
 
    [bookmark: pgfId-242471]Step 2 Open the psql prompt:
 
    [bookmark: pgfId-242454]./usr/local/cisco/dcm/db/bin/psql -U <dbUsername> dcmdb
 
    [bookmark: pgfId-242508]Step 3 Run the database vacuum and quit:
 
    [bookmark: pgfId-242510]dcmdb=> VACUUM FULL ANALYZE VERBOSE;
 
    [bookmark: pgfId-242514]Many pages of output pass on the screen. The vacuum is finished when you see a message similar to this one:
 
    [bookmark: pgfId-242516]Current limits are: 532000 page slots, 1000 relations, using 3182 kB.
 
    [bookmark: pgfId-242517]VACUUM
 
    [bookmark: pgfId-242518]dcmdb=>
 
    [bookmark: pgfId-242519]dcmdb=> \q
 
    [bookmark: pgfId-243223]The previous command exits the sql prompt.
 
    [bookmark: pgfId-243224]Step 4 Start DCNM services by using the appmgr start dcnm command.
 
    [bookmark: pgfId-243225]
 
     
     
 
    
 
    
 
   
 
    
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1443337][bookmark: 32110]Administering [bookmark: marker-1443335]Device Discovery 
      
      
 
     
 
 
    [bookmark: pgfId-1456044]The Device Discovery feature creates devices in Cisco DCNM by connecting to a Cisco NX-OS device and retrieving the running configuration of the device. Cisco DCNM can also discover Cisco NX-OS devices that are neighbors of the first device, which is known as the seed device.
 
    [bookmark: pgfId-1479934]If the device supports virtual device contexts (VDCs), Cisco DCNM retrieves the running configuration of each virtual device context (VDC) that is configured on the physical device. Cisco DCNM displays each VDC as a device, including the default VDC. If the Cisco NX-OS device has only the default VDC, then device discovery creates only one device in Cisco DCNM.
 
    [bookmark: pgfId-1443339]This chapter describes how to administer the Device Discovery feature in the Cisco Data Center Network Manager for LAN (DCNM-LAN).
 
    [bookmark: pgfId-1437073]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1437077]Information About Device Discovery
 
     	 [bookmark: pgfId-1437081]Licensing Requirements for Device Discovery
 
     	 [bookmark: pgfId-1437085]Prerequisites for Device Discovery
 
     	 [bookmark: pgfId-1437089]Guidelines and Limitations for Device Discovery
 
     	 [bookmark: pgfId-1437093]Performing Device Discovery
 
     	 [bookmark: pgfId-1437097]Viewing the Status of Device Discovery Tasks
 
     	 [bookmark: pgfId-1437101]Where to Go Next
 
     	 [bookmark: pgfId-1437105]Field Descriptions for Device Discovery
 
     	 [bookmark: pgfId-1437109]Device System-Message Logging Level Reference
 
     	 [bookmark: pgfId-1437113]Additional References for Device Discovery
 
     	 [bookmark: pgfId-1437117]Feature History for Device Discovery
 
    
 
   
 
    
     [bookmark: pgfId-1437119][bookmark: 75135]Information About Device Discovery
 
    [bookmark: pgfId-1437120]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1437124]Device Discovery
 
     	 [bookmark: pgfId-1437128]Discovery Protocols
 
     	 [bookmark: pgfId-1437132]Credentials and Discovery
 
     	 [bookmark: pgfId-1437136]Discovery Process
 
     	 [bookmark: pgfId-1437140]Cisco NX-OS System-Message Logging Requirements
 
     	 [bookmark: pgfId-1437144]Automatic Logging-Level Configuration Support
 
     	 [bookmark: pgfId-1437148]VDC Support
 
    
 
     
      [bookmark: pgfId-1437150][bookmark: 38393]Device Discovery
 
     [bookmark: pgfId-1448171]The Device Discovery feature creates devices in DCNM-LAN by connecting to a Cisco NX-OS device and retrieving data from the device, including its running configuration. DCNM-LAN can also discover Cisco NX-OS devices and network servers that are neighbors of the first device, which is known as the seed device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1448299]Note Staring from Cisco NX-OS Release 5.2.2(a) the Cisco DCNM-LAN supports the discovery of the following modules: 
 
      
      	 [bookmark: pgfId-1449317]N7K-F248XP-25 Line Card
 
      	 [bookmark: pgfId-1449389]N55-M16FP 16-Port FC GEM
 
      	 [bookmark: pgfId-1449508]N7K-C7010-FAB2 Fabric 2 module
 
      	 [bookmark: pgfId-1449521]N7K-C7018-FAB2 Fabric 2 module
 
      	 [bookmark: pgfId-1449399]N55-D160L3-V2 Daughter Card
 
      	 [bookmark: pgfId-1449406]N55-M160L3-V2 Line Card
 
      	 [bookmark: pgfId-1449429]N3K-C3048TP-1GE Layer 3 switch
 
      	 [bookmark: pgfId-1449469]N3K-C3016Q- 40GE Layer 3 switch
 
     
 
     [bookmark: pgfId-1449305]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1448300]If the device supports virtual device contexts (VDCs), DCNM-LAN retrieves the running configuration of each VDC that is configured on the physical device. DCNM-LAN displays each VDC as a device, including the default VDC. If the Cisco NX-OS device has only the default VDC, then device discovery creates only one device in DCNM-LAN.
 
     [bookmark: pgfId-1437153]When DCNM-LAN connects to a device to retrieve its configuration, it uses the XML management interface, which uses the XML-based Network Configuration Protocol (NETCONF) over Secure Shell (SSH). For more information, see the Cisco NX-OS XML Interface User Guide.
 
    
 
     
      [bookmark: pgfId-1437158][bookmark: 71708]Discovery Protocols
 
     [bookmark: pgfId-1437159]DCNM-LAN uses a variety of protocols to discover devices and servers in your data center network. This section includes the following topics:
 
      
      	 [bookmark: pgfId-1437163]Cisco Discovery Protocol
 
      	 [bookmark: pgfId-1437167]Link Layer Discovery Protocol
 
      	 [bookmark: pgfId-1437171]Fibre Channel
 
     
 
    
 
     
      [bookmark: pgfId-1437173][bookmark: 10339]Cisco Discovery Protocol
 
     [bookmark: pgfId-1437174]Device discovery uses the Cisco Discovery Protocol (CDP) to find devices that are connected to the initial device in the discovery process. CDP exchanges information between adjacent devices over the data link layer. The exchanged information is helpful in determining the network topology and physical configuration outside of the logical or IP layer.
 
     [bookmark: pgfId-1437175]CDP allows DCNM-LAN to discover devices that are one or more hops beyond the seed device in the discovery process. When you start the discovery process using the Device Discovery feature, you can limit the number of hops that the discovery process can make.
 
     [bookmark: pgfId-1437176]After DCNM-LAN discovers a Cisco NX-OS device using CDP, it connects to the device and retrieves information, such as the running configuration of the device. The information collected allows DCNM-LAN to manage the device.
 
     [bookmark: pgfId-1437177]DCNM-LAN supports CDP hops on some Cisco switches that run Cisco IOS software. Although DCNM-LAN cannot manage these devices, the Topology feature allows you to see unmanaged devices and the CDP links between unmanaged devices and managed devices.
 
    
 
     
      [bookmark: pgfId-1437179][bookmark: 34992]Link Layer Discovery Protocol
 
     [bookmark: pgfId-1437180]Device discovery uses Link Layer Discovery Protocol (LLDP) to discover the network adapters of servers that are connected to Cisco NX-OS devices. 
 
    
 
     
      [bookmark: pgfId-1437185][bookmark: 40156]Fibre Channel
 
     [bookmark: pgfId-1437186]To discover network elements in a storage area network (SAN), DCNM-LAN uses Fibre Channel. DCNM-LAN can discover SAN switches, servers, and storage arrays.
 
    
 
     
      [bookmark: pgfId-1437188][bookmark: 37122]Credentials and Discovery
 
     [bookmark: pgfId-1437189]Device discovery requires that you provide a username and password for a user account on the seed device. To successfully complete the discovery of a Cisco NX-OS device, the user account that you specify must be assigned to either the network-admin or the vdc-admin role.
 
     [bookmark: pgfId-1437190]If you want to discover devices that are one or more hops from the seed device, all devices in the chain of hops must be configured with a user account of the same username and password. All Cisco NX-OS devices in the chain of hops must assign the user account to the network-admin or the vdc-admin role.
 
    
 
     
      [bookmark: pgfId-1437192][bookmark: 90889]Discovery Process
 
     [bookmark: pgfId-1437193]DCNM-LAN discovers devices in several phases, as follows:
 
     [bookmark: pgfId-1437194] 1. CDP neighbor discovery—Discovers the topology of the interconnected devices, beginning with the seed device and preceding for the number of CDP hops specified when you initiate discovery.
 
     [bookmark: pgfId-1437195] 2. Supported device selection—Determines which of the discovered devices are supported by DCNM-LAN. Discovery continues for the supported devices only.
 
     [bookmark: pgfId-1437196] 3. Inventory discovery—Discovers the inventory of the devices selected in the previous phase. For example, if the device is a Cisco Nexus 7000 Series switch, inventory discovery determines the supervisor modules, I/O modules, power supplies, and fans. If the device is a Cisco Nexus 1000V switch, inventory discovery finds the Virtual Supervisor Module and Virtual Ethernet Modules.
 
     [bookmark: pgfId-1437197] 4. Device configuration discovery—Discovers the details of feature configuration on each device, such as interfaces, access control lists, and VLANs.
 
     [bookmark: pgfId-1437198] 5. Network discovery—Associates network features with the device configuration details discovered in the previous phase.
 
    
 
     
      [bookmark: pgfId-1437201][bookmark: 90242]Cisco NX-OS System-Message Logging Requirements[bookmark: marker-1437200]
 
     [bookmark: pgfId-1437202]To monitor and manage devices, DCNM-LAN depends partly on system messages that it retrieves from managed devices. This section describes the system-message requirements that all Cisco NX-OS devices must meet before they can be managed and monitored by DCNM-LAN.
 
     [bookmark: pgfId-1437203]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1437207]Interface Link-Status Events Logging Requirement
 
      	 [bookmark: pgfId-1437211]Logfile Requirements
 
      	 [bookmark: pgfId-1437215]Logging Severity-Level Requirements
 
     
 
    
 
     
      [bookmark: pgfId-1437217][bookmark: 38785]Interface Link-Status Events Logging Requirement
 
     [bookmark: pgfId-1437218]Devices must be configured to log system messages about interface link-status change events. This requirement ensures that DCNM-LAN receives information about interface link-status changes. The following two commands must be present in the running configuration on the device:
 
      
      	 [bookmark: pgfId-1437219] logging event link-status enable 
 
      	 [bookmark: pgfId-1437220] logging event link status default 
 
     
 
     [bookmark: pgfId-1437223]To ensure that these commands are configured on the device, perform the steps in the “Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
    
 
     
      [bookmark: pgfId-1437226][bookmark: 26916]Logfile Requirements
 
     [bookmark: pgfId-1437227]Devices must be configured to store system messages that are severity level 6 or lower in the log file.
 
     [bookmark: pgfId-1437228]Although you can specify any name for the log file, we recommend that you do not change the name of the log file. When you change the name of the log file, the device clears previous system messages. The default name of the log file is “messages.”
 
     [bookmark: pgfId-1437229]If you use the default name for the log file, the following command must be present in the running configuration on the device:
 
     [bookmark: pgfId-1437230]logging logfile messages 6
 
     [bookmark: pgfId-1437233]To ensure that this command is configured on the device, perform the steps in the “Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
    
 
     
      [bookmark: pgfId-1437236][bookmark: 10581]Logging Severity-Level Requirements
 
     [bookmark: pgfId-1437237]DCNM-LAN has minimum severity level requirements for some Cisco NX-OS logging facilities. All enabled features on a Cisco NX-OS have a default logging level. The logging level required by DCNM-LAN varies per logging facility but is often higher than the default logging level in Cisco NX-OS. For more information, see the “Automatic Logging-Level Configuration Support” section.
 
    
 
     
      [bookmark: pgfId-1437242][bookmark: 66240]Automatic Logging-Level Configuration Support
 
     [bookmark: pgfId-1437243]DCNM-LAN provides support for automatic logging level configuration for all supported Cisco NX-OS releases with the exception of Cisco NX-OS Release 4.0, which is available on Cisco Nexus 7000 Series switches only. This section describes how DCNM-LAN supports automatic logging-level configuration. For information about manually configuring logging levels for Cisco NX-OS Release 4.0, see the “Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
    
 
     
      [bookmark: pgfId-1437247]During Device Discovery
 
     [bookmark: pgfId-1437248]During device discovery, if DCNM-LAN finds that a logging level on a discovered device is below the minimum logging-level requirement for that logging facility, DCNM-LAN raises the logging level to meet the minimum requirement. If logging levels meet or exceed the requirements, DCNM-LAN does not change the logging levels during discovery.
 
    
 
     
      [bookmark: pgfId-1437249]At Feature Enablement in the DCNM-LAN Client
 
     [bookmark: pgfId-1437250]If you use the DCNM-LAN client to enable a feature on a device and the default logging level for the feature does not meet the minimum requirement, the DCNM-LAN client warns you that it will configure the logging level on the device to meet the requirement. If you reject the logging level change, DCNM-LAN does not enable the feature.
 
    
 
     
      [bookmark: pgfId-1437251]During Auto-Synchronization with Managed Devices
 
     [bookmark: pgfId-1437252]If you use another means, such as the command-line interface (CLI), to enable a feature on a managed device and the default logging level for the feature does not meet the minimum requirement, DCNM-LAN automatically configures the logging level to meet the requirement after DCNM-LAN detects that the feature is enabled.
 
     [bookmark: pgfId-1437253]If you use the CLI or any other method to lower a logging level below the minimum requirement of DCNM-LAN, after DCNM-LAN detects the logging level change, it changes the state of that device to unmanaged. When this occurs, the Devices and Credentials feature shows that logging levels are the reason that the device is unmanaged. You can use the Devices and Credentials feature to discover the device again. During rediscovery, DCNM-LAN sets logging levels that do not meet the minimum requirements.
 
    
 
     
      [bookmark: pgfId-1437255][bookmark: 55359]VDC Support
 
     [bookmark: pgfId-1437256]When DCNM-LAN discovers a Cisco NX-OS device that supports VDCs, it determines how many VDCs are on the Cisco NX-OS device. In DCNM-LAN, each VDC is treated as a separate device. The status of each VDC is tracked separately and you can configure each VDC independently of other VDCs on a Cisco NX-OS device.
 
     [bookmark: pgfId-1437257]Before discovering a Cisco Nexus 7000 Series device that has nondefault VDCs, ensure that each VDC meets the prerequisites for discovery. For more information, see the “Prerequisites for Device Discovery” section.
 
    
 
   
 
    
     [bookmark: pgfId-1437262][bookmark: 45990]Licensing Requirements for Device Discovery
 
    [bookmark: pgfId-1437263]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1437276]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1437266]Product 
         
  
        	 
          
          [bookmark: pgfId-1437268]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1437270]DCNM-LAN
  
        	[bookmark: pgfId-1437272]The Device Discovery feature requires no license. Any feature not included in a license package is bundled with the DCNM-LAN and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1437278][bookmark: 47313]Prerequisites for Device Discovery
 
    [bookmark: pgfId-1437279]Prior to performing device discovery, you should be familiar with the following:
 
     
     	 [bookmark: pgfId-1437280]VDCs, if you are discovering Cisco Nexus 7000 Series devices.
 
     	 [bookmark: pgfId-1437281]CDP
 
    
 
    [bookmark: pgfId-1437282]The Device Discovery feature has the following prerequisites:
 
     
     	 [bookmark: pgfId-1437283]The DCNM-LAN server must be able to connect to devices that it discovers.
 
     	 [bookmark: pgfId-1437284]Cisco NX-OS devices must be running a supported release of Cisco NX-OS. For information about supported releases of Cisco NX-OS, see the  Cisco DCNM Release Notes, Release 7.1.x .
 
     	 [bookmark: pgfId-1437288]The Cisco NX-OS device must have the minimal configuration that is required to enable device discovery to succeed. For more information, see the “Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
     	 [bookmark: pgfId-1437292]For a Cisco Nexus 7000 Series device, each VDC that you want to discover must have a management interface configured. DCNM-LAN supports discovery of VDCs that are configured with a management interface that is the mgmt0 interface, which is an out-of-band virtual interface, or with an in-band Ethernet interface that is allocated to the VDC.
 
     	 [bookmark: pgfId-1437293]To allow DCNM-LAN to discover devices that are CDP neighbors, CDP must be enabled both globally on each device and specifically on the device interfaces used for device discovery. For a Cisco Nexus 7000 Series device, CDP must be enabled globally in each VDC and on the management interface that each VDC is configured to use.
 
     	 [bookmark: pgfId-1437294]Discovery of network servers requires that LLDP is enabled globally on devices connected to network servers and specifically on the device interfaces connected to the network adapters on network servers.
 
    
 
   
 
    
     [bookmark: pgfId-1437296][bookmark: 40902]Guidelines and Limitations for Device Discovery
 
    [bookmark: pgfId-1437297]The Device Discovery feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1437298]Ensure that Cisco NX-OS devices that you want to discover have been prepared for discovery. For more information, see the “Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
     	 [bookmark: pgfId-1437302]DCNM-LAN can manage only devices that run Cisco NX-OS. For more information about supported device operating systems and supported device hardware, see the  Cisco DCNM Release Notes, Release 7.1.x .
 
     	 [bookmark: pgfId-1437306]CDP-based discovery of devices requires that all devices in the chain of CDP hops use the same username and password specified for the seed device. If your security practices do not allow the same username and password to be used on each device, you can perform device discovery for each device individually.
 
     	 [bookmark: pgfId-1437307]Devices that are CDP hops but which are not running Cisco IOS software appear in the Topology feature but cannot be managed by DCNM-LAN.
 
    
 
   
 
    
     [bookmark: pgfId-1437309][bookmark: 81498]Performing Device Discovery
 
    [bookmark: pgfId-1437310]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1437314]Verifying the Discovery Readiness of a Cisco NX-OS Device
 
     	 [bookmark: pgfId-1470261]Device Discovery
 
     	 [bookmark: pgfId-1450901]Viewing the Status of Device Discovery Tasks
 
    
 
     
      [bookmark: pgfId-1450903][bookmark: 19871][bookmark: ]Verifying the Discovery Readiness of a Cisco NX-OS Device
 
     [bookmark: pgfId-1450904]Before you perform device discovery with DCNM-LAN, you should perform the following procedure on each Cisco NX-OS device that you want to manage and monitor with DCNM-LAN. This procedure helps to ensure that device discovery succeeds and that DCNM-LAN can effectively manage and monitor the device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1437326]Note If you are preparing a physical device that supports virtual device contexts (VDCs), remember that DCNM-LAN considers each VDC to be a device. You must verify discovery readiness for each VDC that you want to manage and monitor with DCNM-LAN.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1437327]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1437328]Step 1 Log into the CLI of the Cisco NX-OS device.
 
     [bookmark: pgfId-1437329]Step 2 Use the configure terminal command to access global configuration mode.
 
     [bookmark: pgfId-1437330]Step 3 Ensure that an RSA or DSA key exists so that secure shell (SSH) connections can succeed. To do so, use the show ssh key rsa or show ssh key dsa command.
 
     [bookmark: pgfId-1437331]If you need to generate a key, use the ssh key command.
 
      
       
     
 
     
 
     [bookmark: pgfId-1437332]Note You must disable the SSH server before you can generate a key. To do so, use the no feature ssh command.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1437333]Step 4 Ensure that the SSH server is enabled. To do so, use the show ssh server command.
 
     [bookmark: pgfId-1437334]If the SSH server is not enabled, use the feature ssh command to enable it.
 
     [bookmark: pgfId-1437335]Step 5 Ensure that CDP is enabled globally and on the interface that DCNM-LAN uses to connect to the device. Use the show run cdp all command to see whether CDP is enabled.
 
     [bookmark: pgfId-1437336]Step 6 Verify that the logging event link-status default and logging event link-status enable commands are configured.
 
      
      [bookmark: pgfId-1437337]switch(config)# show running-config all | include "logging event link-status" 
     
 
      
      [bookmark: pgfId-1437338]logging event link-status default 
     
 
      
      [bookmark: pgfId-1437339]logging event link-status enable 
     
 
      
      [bookmark: pgfId-1437340] 
     
 
     [bookmark: pgfId-1437341]If either command is missing, enter it to add it to the running configuration.
 
      
       
     
 
     
 
     [bookmark: pgfId-1437342]Note The logging event link-status enable command is included in the default Cisco NX-OS configuration. The show running-config command displays the default configuration only if you use the all keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1437343]Step 7 Verify that the device is configured to log system messages that are severity 6 or lower.
 
      
       
     
 
     
 
     [bookmark: pgfId-1437344]Note The default name of the log file is “messages”; however, we recommend that you use the log-file name currently configured on the device. If you change the name of the log file, the device clears previous system messages.
 
      
      
 
     
 
     
 
      
      [bookmark: pgfId-1437345]switch(config)# show running-config all | include logfile 
     
 
      
      [bookmark: pgfId-1437346]logging logfile logfile-name 6 
     
 
      
      [bookmark: pgfId-1437347] 
     
 
     [bookmark: pgfId-1437348]If the logging logfile command does not appear or if the severity level is less than 6, configure the logging logfile command.
 
      
      [bookmark: pgfId-1437349]switch(config)# logging logfile logfile-name 6 
     
 
      
      [bookmark: pgfId-1437350] 
     
 
     [bookmark: pgfId-1437351]Step 8 If the device is a Cisco Nexus 7000 Series switch that is running Cisco NX-OS Release 4.0, you must manually verify that the logging level configuration of the device meets the DCNM-LAN logging level requirements. To do so, follow these steps:
 
     [bookmark: pgfId-1437352] a. Determine which nondefault features are enabled on the device.
 
      
      [bookmark: pgfId-1437353]switch(config)# show running-config | include feature 
     
 
      
      [bookmark: pgfId-1437354]feature feature1 
     
 
      
      [bookmark: pgfId-1437355]feature feature2 
     
 
      
      [bookmark: pgfId-1437356]feature feature3 
     
 
      
      [bookmark: pgfId-1437357]. 
     
 
      
      [bookmark: pgfId-1437358]. 
     
 
      
      [bookmark: pgfId-1437359]. 
     
 
      
      [bookmark: pgfId-1437360] 
     
 
     [bookmark: pgfId-1437362] b. [bookmark: 26062]View the logging levels currently configured on the device. The show logging level command displays logging levels only for features that are enabled. The Current Session Severity column lists the current logging level.
 
      
      [bookmark: pgfId-1437363]switch(config)# show logging level 
     
 
      
      [bookmark: pgfId-1437364]Facility Default Severity Current Session Severity 
     
 
      
      [bookmark: pgfId-1437365]-------- ---------------- ------------------------ 
     
 
      
      [bookmark: pgfId-1437366]aaa 3 5 
     
 
      
      [bookmark: pgfId-1437367]aclmgr 3 3 
     
 
      
      [bookmark: pgfId-1437368]. 
     
 
      
      [bookmark: pgfId-1437369]. 
     
 
      
      [bookmark: pgfId-1437370]. 
     
 
      
      [bookmark: pgfId-1437371] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1437372]Note You can use the show logging level command with the facility name when you want to see the logging level of a single logging facility, such as show logging level aaa.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1437373] c. Determine which logging levels on the device are below the minimum DCNM-LAN required logging levels. To do so, compare the logging levels displayed on page 27-8 to the minimum DCNM-LAN required logging levels that are listed in Table 27-3.
 
     [bookmark: pgfId-1437380] d. For each logging facility with a logging level that is below the minimum DCNM-LAN required logging level, configure the device with a logging level that meets or exceeds the DCNM-LAN requirement.
 
      
      [bookmark: pgfId-1437381]switch(config)# logging level facility severity-level 
     
 
      
      [bookmark: pgfId-1437382] 
     
 
     [bookmark: pgfId-1437386]The facility argument is the applicable logging-facility keyword from Table 27-3, and severity-level is the applicable minimum DCNM-LAN required logging level or higher (up to 7).
 
     [bookmark: pgfId-1437387] e. Use the show logging level command to verify your changes to the configuration.
 
     [bookmark: pgfId-1437388]Step 9 Copy the running configuration to the startup configuration to save your changes.
 
      
      [bookmark: pgfId-1437389]switch(config)# copy running-config startup-config 
     
 
      
      [bookmark: pgfId-1437390][########################################] 100% 
     
 
      
      [bookmark: pgfId-1437391]switch(config)# 
     
 
      
      [bookmark: pgfId-1437392] 
     
 
     [bookmark: pgfId-1437393]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1479116]Discovering Devices[bookmark: marker-1479115]
 
     [bookmark: pgfId-1479117]You can discover one or more devices. When a discovery task succeeds, DCNM-LAN retrieves the running configuration and status information of discovered Cisco NX-OS devices.
 
     [bookmark: pgfId-1479118]You can perform Deep Discovery by selecting one task at a time. You can also select all or multiple devices in a single task at a time. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1479119]Note You cannot select multiple tasks or multiple devices across tasks at one instance.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1479120]Use this procedure for the following purposes:
 
      
      	 [bookmark: pgfId-1479121]To discover devices that are not currently managed by DCNM-LAN. For example, you should use this procedure when DCNM-LAN has not yet discovered any devices, such as after a new installation.
 
      	 [bookmark: pgfId-1479122]To discover devices that you have added to your network without rediscovering devices that DCNM-LAN already has discovered.
 
      	 [bookmark: pgfId-1479123]To rediscover the topology when CDP links have changed without rediscovering devices that DCNM-LAN has already discovered.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1479124]Note You must successfully discover a Cisco NX-OS device before you can use DCNM-LAN to configure the device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1479125]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1479126]Ensure that you have configured the Cisco NX-OS device so that the DCNM-LAN server can connect to it and successfully discover it. For more information, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x“Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
     [bookmark: pgfId-1479133]Determine the IPv4 address of the device that you want DCNM-LAN to connect to when it starts the discovery task. This is the seed device for the discovery.
 
     [bookmark: pgfId-1479134]Determine whether you want to discover devices that are CDP neighbors of the seed device. If so, determine the maximum number of hops from the seed device that the discovery process can make.
 
      
       
     
 
     
 
     [bookmark: pgfId-1479135]Note The discovery process can perform complete discovery of neighbors only if the neighboring devices are configured with the same credentials as the seed device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1479136]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1479137]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Device Discovery. 
 
     [bookmark: pgfId-1479138]The discovery tasks appear in the Discovery Tasks area of the Contents pane.
 
     [bookmark: pgfId-1479139]Step 2 Click Here in the Device Discovery pane to perform Shallow Discovery of the devices in the Cisco DCNM Web Client. The shallow discovery result web page pops out.
 
     [bookmark: pgfId-1479140]There are four types of discovery, they are Fabric, LAN, VMWare, and SMI-S Storage.
 
     [bookmark: pgfId-1479141]Step 3 In the first table of Fabric, you can Edit, Remove, Add, Re-discover, Refresh and Purge unreachable devices or dead link in selected fabric. 
 
     [bookmark: pgfId-1479142] – To edit the fabric— Check the box before the fabric you want to select, and click the edit icon as a pencil. You can edit the Fabric Name, check/uncheck to use/disuse SNMPv3/SSH and select the Auth-Privacy from the drop-down list. Enter the User Name and Password and select the Status as managed, unmanaged, or managedContinuously. (Optional)You can click the options button to input the UCS User Name and the UCS Password.
 
     [bookmark: pgfId-1479143] – To remove the fabric— Select the fabric that you want to remove, and click the remove icon. Click yes to remove the selected fabric.
 
     [bookmark: pgfId-1479144] – To add a fabric— Click the add icon to add a fabric. Enter the information about Fabric Seed Switch, SNMP, User Name and Password. If you check Limit Discovery by VSAN, select which you want to limit by, Included VSAN List or Excluded VSAN List, and provide the VSAN List. Check/uncheck to enable/disable NPV Discovery in All Fabrics. (Optional)Click options buttion to input the UCS User Name and the UCS Password.
 
     [bookmark: pgfId-1479145] – To re-discover a fabric— Select the fabric that you want to be re-discovered, and click the Re-discover Fabric icon. Click yes to perform re-discovery of the fabric.
 
     [bookmark: pgfId-1479146] – To refresh the fabric discovery table— Click the refresh icon to manually refresh the discovery table.
 
     [bookmark: pgfId-1479147] – To purge down elements in the fabric— Select the fabric and click the Purge icon to purge unreachable devices or dead links in selected Fabric and click yes.
 
     [bookmark: pgfId-1479148] – To maximize the fabric table— Click the Maximize icon to maximize the fabric table and click Normalize to return the former view.
 
     [bookmark: pgfId-1479149]Step 4 In the second table of LAN discovery, you can Add, Refresh, Purge unreachable devices or dead links in selected LAN and Toggle between Task and Device View. You can Edit LAN Task, Re-discover LAN and Remove LAN Task/Switch by clicking the icons before the tasks/switches.
 
     [bookmark: pgfId-1479150] – To Edit LAN Task— Click the Edit icon, enter the username of a user account on the device in the User Name field. The user account must have a network-admin or vdc-admin role. In the Password field, enter the password for the user account. Choose the Status of the LAN task. For Catalyst 6500 devices, enter the enable password in the Enable Password field to allow for IOS privileged EXEC mode commands.
 
     [bookmark: pgfId-1479151] – To Re-discover LAN— A warning message pops out, click on yes to proceed rediscovery.
 
     [bookmark: pgfId-1479152] – To Remove LAN Task— Click on the remove icon and click yes to remove the LAN task.
 
     [bookmark: pgfId-1479153] – To Add LAN Task— Choose the Discovery Type from Hops from Seed Switch/Switch List/FWSM. 
 
     [bookmark: pgfId-1479154]If you choose the discovery type as Hops from Seed Switch, input the IP address or IP range string in Seed Switch. Drag the triangle to the number which represents the Max Hops from Seed. Choose the Protocol of the LAN. If you choose SNMPv1, select the Scan Timeout from the drop-down list and enter the Community. If you choose SNMPv3/CLI, select the auth-privacy and Scan Timeout from the drop-down list. Enter the User Name and Password. Select the group that you want to add the switch to and click Next. Shallow LAN Discovery window shows up. Select the switches and click Add to add the LAN task.
 
     [bookmark: pgfId-1479155]It’s quite similar with the other discovery type as Switch List or FWSM, only that you don’t need to provide the max hops from seed.
 
     [bookmark: pgfId-1479156]Step 5 If there are VMWare and SMI-S storage devices discovered, you can perform similar function in the VMWare and SMI-S Storage discovery table.
 
     [bookmark: pgfId-1479159]Step 6 You can only perform deep discovery in the DCNM LAN client, please follow the steps in Deep Discovery.
 
     [bookmark: pgfId-1479161]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1491622]Note When DCNM shallow discovery is done, DCNM server registers its address as trap address in each switch with the user’s community. When discovery takes place for the first time, a server property called trapaddr.register.community which has the default value 'public' is overwritten with the user's community.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1479163][bookmark: deep_discovery_steps]Deep Discovery
 
     [bookmark: pgfId-1479164]Deep discovery is an ssh based discovery initiated from the DCNM-LAN client and allows DCNM to actually log in via ssh and configure the LAN devices.
 
     [bookmark: pgfId-1479165]To perform Deep Discovery of the devices so that you can configure LAN devices via DCNM, please follow below steps:
 
     
 
     [bookmark: pgfId-1479166]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Device Discovery.
 
     [bookmark: pgfId-1479167]Step 2 Click the plus icon to expand the task under Task based Discovery pane, a list of devices under the single task shows up. 
 
     [bookmark: pgfId-1479168]Step 3 You can either select one device or multiple devices under one task. Right click on the single device or multiple devices under one task and select Deep Discovery.
 
      
       
     
 
     
 
     [bookmark: pgfId-1479169]Note Deep Discovery is a requirement for any of the features found in the DCNM LAN client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1479170]Step 4 Click Refresh button or press F5, the successfully deep discovered device will show MANAGED under SSH/Telnet of Status.
 
     [bookmark: pgfId-1479171]Step 5 You can also right click the discovered devices and select Re-do deep discovery. 
 
     [bookmark: pgfId-1479172]Step 6 In the Device Discovery pane, click the History button to open the History of Discovery window. You can see Task ID, Owner, Seed Device IP Address, Discovered Time, Reason and Status history from the window.
 
     [bookmark: pgfId-1053795]
 
      
      
 
     
 
     [bookmark: 24305] 
     [bookmark: 71793] 
     
 
    
 
   
 
    
     [bookmark: pgfId-1053375][bookmark: 15491][bookmark: 84654]Viewing the Status of Device Discovery Tasks
 
    [bookmark: pgfId-1378583]To view the status of device discovery tasks, from the Feature Selector pane, choose DCNM Server Administration > Device Discovery.
 
    [bookmark: pgfId-1378584]The tasks, including the task status, appear in the Discovery Tasks area in the Contents pane. For information about the fields that appear, see the “Field Descriptions for Device Discovery” section.
 
   
 
    
     [bookmark: pgfId-1437511][bookmark: 42401]Where to Go Next
 
    [bookmark: pgfId-1437512]View the discovered devices and configure unique device credentials, as needed. For more information, see the “Administering Devices and Credentials” section.
 
   
 
    
     [bookmark: pgfId-1437517][bookmark: 58163]Field Descriptions for Device Discovery
 
    [bookmark: pgfId-1437518]This section includes the following field descriptions for the Device Discovery feature:
 
     
     	 [bookmark: pgfId-1437522]Device Discovery Content Pane
 
     	 [bookmark: pgfId-1437526]Related Fields
 
    
 
     
      [bookmark: pgfId-1437528][bookmark: 50779]Device Discovery Content Pane
 
     [bookmark: pgfId-1479759]
 
      
       
        
        [bookmark: pgfId-1479585]Table 27-1 Shallow Discovery Content Pane
 
        
        
         
         	 
           
           [bookmark: pgfId-1479589]Field 
          
  
         	 
           
           [bookmark: pgfId-1479591]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1479593]Admin> Data Sources >Fabric 
          
  
        
 
         
         	[bookmark: pgfId-1479597]Fabric Name
  
         	[bookmark: pgfId-1479599]Name of the Fabric.
  
        
 
         
         	[bookmark: pgfId-1479601]Seed Switch
  
         	[bookmark: pgfId-1479603]The IP address of the fabric’s seed switch. IPv4 address of the first device that you want to discover. Valid entries are in dotted decimal format. 
  
        
 
         
         	[bookmark: pgfId-1479605]Status
  
         	 
           
           	 [bookmark: pgfId-1479607]managed
 
           	 [bookmark: pgfId-1479608]unmanaged
 
           	 [bookmark: pgfId-1479609]managedContinuouly
 
          
  
        
 
         
         	[bookmark: pgfId-1479611]SNMPv3/SSH
  
         	[bookmark: pgfId-1479613]True if the fabric is using SNMPv3/SSH.
  
        
 
         
         	[bookmark: pgfId-1479615]User/Cmnty
  
         	[bookmark: pgfId-1479617]Name of the device user account/community that the DCNM-LAN server uses to access the device. The user account must have network-admin or vdc-admin privileges on the device. 
  
        
 
         
         	[bookmark: pgfId-1479619]Auth/Privacy
  
         	[bookmark: pgfId-1479621]The authorization method used by the fabric.
  
        
 
         
         	[bookmark: pgfId-1479623]Included VSAN List
  
         	[bookmark: pgfId-1479625]The IP address of the included VSAN list that the fabric is limited by.
  
        
 
         
         	[bookmark: pgfId-1479627]Excluded VSAN List
  
         	[bookmark: pgfId-1479629]The IP address of the excluded VSAN list that the fabric is limited by.
  
        
 
         
         	[bookmark: pgfId-1479631]Licensed
  
         	[bookmark: pgfId-1479633]If the fabric is licensed or not.
  
        
 
         
         	[bookmark: pgfId-1479635]Last Updated Time
  
         	[bookmark: pgfId-1479637]The last updated time of the fabric.
  
        
 
         
         	 
           
           [bookmark: pgfId-1479639]Admin> Data Sources> LAN 
          
  
        
 
         
         	[bookmark: pgfId-1479643]Discovery Task
  
         	[bookmark: pgfId-1479645]The discovery task name of LAN.
  
        
 
         
         	[bookmark: pgfId-1479647]Max Hops from Seed
  
         	[bookmark: pgfId-1479649]The max hops from seed switch to be discovered.
  
        
 
         
         	[bookmark: pgfId-1479651]Switch List
  
         	[bookmark: pgfId-1479653]The IP address or string of the switch list.
  
        
 
         
         	[bookmark: pgfId-1479655]FWSM IP Address
  
         	[bookmark: pgfId-1479657]The FWSM IP address discovered.
  
        
 
         
         	[bookmark: pgfId-1479659]Switch
  
         	[bookmark: pgfId-1479661]The seed switch of the task.
  
        
 
         
         	[bookmark: pgfId-1479663]Managed
  
         	[bookmark: pgfId-1479665]True if the LAN discovery task is managed.
  
        
 
         
         	[bookmark: pgfId-1479667]SNMP Status
  
         	[bookmark: pgfId-1479669]Whether or not the SNMP is enabled.
  
        
 
         
         	[bookmark: pgfId-1479671]Last Updated Time
  
         	[bookmark: pgfId-1479673]The last updated time of the LAN.
  
        
 
         
         	[bookmark: pgfId-1479675]Group
  
         	[bookmark: pgfId-1479677]Which of the LAN group does the switches belong to.
  
        
 
         
         	[bookmark: pgfId-1479679]SNMPv3/SSH
  
         	[bookmark: pgfId-1479681]True if SNMPv3/SSH is used.
  
        
 
         
         	[bookmark: pgfId-1479683]User/Cmnty
  
         	[bookmark: pgfId-1479685]Name of the device user account that the DCNM-LAN server uses to access the device. The user account must have network-admin or vdc-admin privileges on the device. By default, this field is blank.
  
         	[bookmark: pgfId-1479690]The authorization method used by the LAN.
  
        
 
         
         	 [bookmark: pgfId-1479692]Admin> Data Sources> VMWare
  
        
 
         
         	[bookmark: pgfId-1479696]Server
  
         	[bookmark: pgfId-1479698]The server name of the VMWare.
  
        
 
         
         	[bookmark: pgfId-1479700]Managed
  
         	[bookmark: pgfId-1479702]True if the remote device is managed.
  
        
 
         
         	[bookmark: pgfId-1479704]Status
  
         	[bookmark: pgfId-1479706]The status of the server.
  
        
 
         
         	[bookmark: pgfId-1479708]User
  
         	[bookmark: pgfId-1479710]Name of the device user account that the DCNM-LAN server uses to access the device. The user account must have network-admin or vdc-admin privileges on the device. 
  
        
 
         
         	[bookmark: pgfId-1479712]Last Updated Time
  
         	[bookmark: pgfId-1479714]The last updated time of the virtual machine.
  
        
 
         
         	 [bookmark: pgfId-1479716]Admin> Data Sources> SMI-S Storage
  
        
 
         
         	[bookmark: pgfId-1479720]Vendor
  
         	[bookmark: pgfId-1479722]The vendor of the storage device.
  
        
 
         
         	[bookmark: pgfId-1479724]Version
  
         	[bookmark: pgfId-1479726]The version information of the storage device.
  
        
 
         
         	[bookmark: pgfId-1479728]Provider URL
  
         	[bookmark: pgfId-1479730]The URL of the provider.
  
        
 
         
         	[bookmark: pgfId-1479732]Name Space
  
         	[bookmark: pgfId-1479734]The name space of the storage.
  
        
 
         
         	[bookmark: pgfId-1479736]Interop Name Space
  
         	[bookmark: pgfId-1479738]The iinterop name space of the storage.
  
        
 
         
         	[bookmark: pgfId-1479740]Port
  
         	[bookmark: pgfId-1479742]The port used to access the storage.
  
        
 
         
         	[bookmark: pgfId-1479744]Secure
  
         	[bookmark: pgfId-1479746]The secure information of the storage.
  
        
 
         
         	[bookmark: pgfId-1479748]Status
  
         	[bookmark: pgfId-1479750]The status of the storage.
  
        
 
         
         	[bookmark: pgfId-1479752]Discovery Status
  
         	[bookmark: pgfId-1479754]The discovery status of the storage.
  
        
 
         
         	[bookmark: pgfId-1479756]Last Updated Time
  
         	 
           
            
             
             [bookmark: pgfId-1479788]Table 27-2 Deep Discovery Content Pane
 
             
             
              
              	 
                
                [bookmark: pgfId-1479792]History of Discovery 
               
  
             
 
              
              	[bookmark: pgfId-1479796]Task ID
  
              	[bookmark: pgfId-1479798]Display only. Number assigned to the discovery task. The task ID indicates the order in which discovery tasks occurred.
  
             
 
              
              	[bookmark: pgfId-1479800]Owner
  
              	[bookmark: pgfId-1479802]Display only. DCNM-LAN server user account used to start the discovery task.
  
             
 
              
              	[bookmark: pgfId-1479804]Seed Device IP Address
  
              	[bookmark: pgfId-1479806]Display only. IPv4 address of the seed device.
  
             
 
              
              	[bookmark: pgfId-1479808]Discovered Time
  
              	[bookmark: pgfId-1479810]Display only. Date and time of the most recent update to the Status field.
  
             
 
              
              	[bookmark: pgfId-1479812]Reason
  
              	[bookmark: pgfId-1479814]Display only. Why the discovery task was created.
  
             
 
              
              	[bookmark: pgfId-1479816]Status
  
              	[bookmark: pgfId-1479818]Display only. State of the discovery task. Valid values are as follows:
 
                
                	 [bookmark: pgfId-1479819]In progress—The discovery tasks are ongoing.
 
                	 [bookmark: pgfId-1479820]Successful—The discovery task completed without errors.
 
                	 [bookmark: pgfId-1479821]Failed—The discovery task completed with errors.
 
               
  
             
 
              
              	 
                
                [bookmark: pgfId-1479823]Task Based Discovery 
               
  
             
 
              
              	[bookmark: pgfId-1479827]Name
  
              	[bookmark: pgfId-1479829]Display only. The name of the task.
  
             
 
              
              	[bookmark: pgfId-1479831]Switches
  
              	[bookmark: pgfId-1479833]Display only. The devices under the single task.
  
             
 
              
              	[bookmark: pgfId-1479835]Managed
  
              	[bookmark: pgfId-1479837]Display only. Show if the task is managed by DCNM.
  
             
 
              
              	[bookmark: pgfId-1479839]SNMP
  
              	[bookmark: pgfId-1479841]Display only. SNMP status can be different as below:
 
                
                	 [bookmark: pgfId-1479951]ok—The device is accessible/reachable at current time.
 
                	 [bookmark: pgfId-1480595]Last Seen—The time when the device was last reachable. Last Seen will be in that state for few minutes, after which it will show up as Discovery Timeout.
 
                	 [bookmark: pgfId-1480154]Discovery Timeout—The device is not accessible/reachable because of discovery timeout.
 
               
  
             
 
              
              	[bookmark: pgfId-1479843]SSH/Telnet
  
              	[bookmark: pgfId-1480901]Display only. Status of the discovery task.
 
                
                	 [bookmark: pgfId-1480902]ENABLE DEEP DISCOVERY— Deep discovery is not enabled.
 
                	 [bookmark: pgfId-1480903]UNMANAGED (Connection Failure)—Connection to the device by SSH/Telnet failed.
 
                	 [bookmark: pgfId-1480904]UNMANAGED (Auth Failure)—Authentication of the device failed.
 
                	 [bookmark: pgfId-1480905]DISCOVERING—The device is in the process of discovering.
 
               
 [bookmark: pgfId-1479845]MANAGED—The device is managed by DCNM.
  
             
 
             
           
 
          
 [bookmark: pgfId-1437596]
 
           
            [bookmark: pgfId-1437598][bookmark: 56721]Related Fields
 
           [bookmark: pgfId-1437601]For information about fields that configure devices, see the “Administering Devices and Credentials” section.
 
          
 
           
            [bookmark: pgfId-1437604][bookmark: 22043]Device System-Message Logging Level Reference
 
           [bookmark: pgfId-1437605]This section provides information about the minimum device logging-level requirements of DCNM-LAN. DCNM-LAN has logging-level requirements for only a subset of the logging facilities of supported devices. If a Cisco NX-OS logging facility is not specified in this section, DCNM-LAN does not have a requirement for that logging facility.
 
            
             
           
 
           
 
           [bookmark: pgfId-1437606]Note DCNM-LAN provides automatic device logging-level support. For more information, see the Automatic Logging-Level Configuration Support.
 
            
            
 
           
 
           
 
            
             
              
              [bookmark: pgfId-1437635]Table 27-3 [bookmark: 29915]Cisco Nexus 7000 NX-OS Logging Levels per Cisco DCNM-LAN Feature 
 
              
              
               
               	 
                 
                 [bookmark: pgfId-1437647]Cisco DCNM-LAN Feature 
                
  
               	 
                 
                 [bookmark: pgfId-1437649]Cisco Nexus 7000 NX-OS Logging Facility 
                
  
               	 
                 
                 [bookmark: pgfId-1437651]Enabled by Default? 
                
  
               	 
                 
                 [bookmark: pgfId-1437653]Logging Facility Keyword 
                
  
               	 
                 
                 [bookmark: pgfId-1437655]Cisco NX-OS Default Logging Level 
                
  
               	 
                 
                 [bookmark: pgfId-1437657]Minimum Cisco DCNM-LAN- 
                
 
                 
                 [bookmark: pgfId-1437658]Required Logging Level 
                 1 
                
  
              
 
               
               	 [bookmark: pgfId-1437663]AAA
  
               	[bookmark: pgfId-1437665]AAA
  
               	[bookmark: pgfId-1437667]Yes
  
               	[bookmark: pgfId-1437669]aaa
  
               	[bookmark: pgfId-1437671]3
  
               	[bookmark: pgfId-1437673]5
  
              
 
               
               	[bookmark: pgfId-1437677]RADIUS
  
               	[bookmark: pgfId-1437679]Yes
  
               	[bookmark: pgfId-1437681]radius
  
               	[bookmark: pgfId-1437683]3
  
               	[bookmark: pgfId-1437685]5
  
              
 
               
               	[bookmark: pgfId-1437689]TACACS+
  
               	[bookmark: pgfId-1437691]No
  
               	[bookmark: pgfId-1437693]tacacs+
  
               	[bookmark: pgfId-1437695]3
  
               	[bookmark: pgfId-1437697]5
  
              
 
               
               	 [bookmark: pgfId-1437699]Device Discovery
 [bookmark: pgfId-1437700]Topology
  
               	[bookmark: pgfId-1437702]CDP
  
               	[bookmark: pgfId-1437704]Yes
  
               	[bookmark: pgfId-1437706]cdp
  
               	[bookmark: pgfId-1437708]2
  
               	[bookmark: pgfId-1437710]6
  
              
 
               
               	[bookmark: pgfId-1437714]LLDP
  
               	[bookmark: pgfId-1437716]No
  
               	[bookmark: pgfId-1437718]lldp
  
               	[bookmark: pgfId-1437720]2
  
               	[bookmark: pgfId-1437722]5
  
              
 
               
               	[bookmark: pgfId-1437724]DHCP snooping
  
               	 [bookmark: pgfId-1437726]DHCP snooping
  
               	 [bookmark: pgfId-1437728]No
  
               	 [bookmark: pgfId-1437730]dhcp
  
               	 [bookmark: pgfId-1437732]2
  
               	 [bookmark: pgfId-1437734]6
  
              
 
               
               	[bookmark: pgfId-1437736]Dynamic ARP Inspection
  
              
 
               
               	[bookmark: pgfId-1437748]IP Source Guard
  
              
 
               
               	[bookmark: pgfId-1437760]Dot1X
  
               	[bookmark: pgfId-1437762]802.1X
  
               	[bookmark: pgfId-1437764]No
  
               	[bookmark: pgfId-1437766]dot1x
  
               	[bookmark: pgfId-1437768]2
  
               	[bookmark: pgfId-1437770]5
  
              
 
               
               	[bookmark: pgfId-1437772]Ethernet Interfaces
  
               	 [bookmark: pgfId-1437774]Ethernet port manager
  
               	 [bookmark: pgfId-1437776]Yes
  
               	 [bookmark: pgfId-1437778]ethpm
  
               	 [bookmark: pgfId-1437780]5
  
               	 [bookmark: pgfId-1437782]5
  
              
 
               
               	[bookmark: pgfId-1437784]Traffic Storm Control
  
              
 
               
               	[bookmark: pgfId-1437796]Gateway Load Balancing Protocol (GLBP)
  
               	[bookmark: pgfId-1437798]GLBP
  
               	[bookmark: pgfId-1437800]No
  
               	[bookmark: pgfId-1437802]glbp
  
               	[bookmark: pgfId-1437804]3
  
               	[bookmark: pgfId-1437806]6
  
              
 
               
               	[bookmark: pgfId-1437808]Hot Standby Router Protocol (HSRP)
  
               	[bookmark: pgfId-1437810]HSRP engine
  
               	[bookmark: pgfId-1437812]No
  
               	[bookmark: pgfId-1437814]hsrp
  
               	[bookmark: pgfId-1437816]3
  
               	[bookmark: pgfId-1437818]6
  
              
 
               
               	 [bookmark: pgfId-1437820]Inventory
  
               	[bookmark: pgfId-1437822]Module
  
               	[bookmark: pgfId-1437824]Yes
  
               	[bookmark: pgfId-1437826]module
  
               	[bookmark: pgfId-1437828]5
  
               	[bookmark: pgfId-1437830]5
  
              
 
               
               	[bookmark: pgfId-1437834]Platform
  
               	[bookmark: pgfId-1437836]Yes
  
               	[bookmark: pgfId-1437838]platform
  
               	[bookmark: pgfId-1437840]5
  
               	[bookmark: pgfId-1437842]5
  
              
 
               
               	[bookmark: pgfId-1437846]System manager
  
               	[bookmark: pgfId-1437848]Yes
  
               	[bookmark: pgfId-1437850]sysmgr
  
               	[bookmark: pgfId-1437852]3
  
               	[bookmark: pgfId-1437854]3
  
              
 
               
               	[bookmark: pgfId-1437856]Object Tracking
  
               	[bookmark: pgfId-1437858]Object tracking
  
               	[bookmark: pgfId-1437860]Yes
  
               	[bookmark: pgfId-1437862]track
  
               	[bookmark: pgfId-1437864]3
  
               	[bookmark: pgfId-1437866]6
  
              
 
               
               	[bookmark: pgfId-1437868]Port-Channel Interfaces
  
               	[bookmark: pgfId-1437870]Port-channel interfaces
  
               	[bookmark: pgfId-1437872]Yes
  
               	[bookmark: pgfId-1437874]port-channel
  
               	[bookmark: pgfId-1437876]5
  
               	[bookmark: pgfId-1437878]6
  
              
 
               
               	[bookmark: pgfId-1437880]Port security
  
               	[bookmark: pgfId-1437882]Port security
  
               	[bookmark: pgfId-1437884]No
  
               	[bookmark: pgfId-1437886]port-security
  
               	[bookmark: pgfId-1437888]2
  
               	[bookmark: pgfId-1437890]5
  
              
 
               
               	[bookmark: pgfId-1437892]SPAN
  
               	[bookmark: pgfId-1437894]SPAN
  
               	[bookmark: pgfId-1437896]Yes
  
               	[bookmark: pgfId-1437898]monitor
  
               	[bookmark: pgfId-1437900]3
  
               	[bookmark: pgfId-1437902]6
  
              
 
               
               	[bookmark: pgfId-1437904]Spanning Tree
  
               	[bookmark: pgfId-1437906]Spanning tree
  
               	[bookmark: pgfId-1437908]Yes
  
               	[bookmark: pgfId-1437910]spanning-tree
  
               	[bookmark: pgfId-1437912]3
  
               	[bookmark: pgfId-1437914]6
  
              
 
               
               	[bookmark: pgfId-1437916]Unidirectional Link Detection (UDLD)
  
               	[bookmark: pgfId-1437918]UDLD
  
               	[bookmark: pgfId-1437920]No
  
               	[bookmark: pgfId-1437922]udld
  
               	[bookmark: pgfId-1437924]5
  
               	[bookmark: pgfId-1437926]5
  
              
 
               
               	[bookmark: pgfId-1437928]Virtual Device Contexts (VDCs)
  
               	[bookmark: pgfId-1437930]VDC manager
  
               	[bookmark: pgfId-1437932]Yes
  
               	[bookmark: pgfId-1437934]vdc_mgr
  
               	[bookmark: pgfId-1437936]6
  
               	[bookmark: pgfId-1437938]6
  
              
 
               
               	[bookmark: pgfId-1437940]Virtual Port Channel (vPC)
  
               	[bookmark: pgfId-1437942]VPC
  
               	[bookmark: pgfId-1437944]No
  
               	[bookmark: pgfId-1437946]vpc
  
               	[bookmark: pgfId-1437948]2
  
               	[bookmark: pgfId-1437950]6
  
              
 
               
               	[bookmark: pgfId-1437952]VLAN Network Interfaces
  
               	[bookmark: pgfId-1437954]Interface VLAN
  
               	[bookmark: pgfId-1437956]No
  
               	[bookmark: pgfId-1437958]interface-vlan
  
               	[bookmark: pgfId-1437960]2
  
               	[bookmark: pgfId-1437962]5
  
              
 
              
            
 
           
 
            
             
              
              	 1.[bookmark: pgfId-1437661]Minimum Cisco DCNM-LAN logging levels appear in bold text for Cisco Nexus 7000 NX-OS logging facilities that have a default logging level that is too low.
  
             
 
             
           
 
          
 
           
            [bookmark: pgfId-1437965][bookmark: 32965]Cisco Nexus 5000 NX-OS Logging Levels per DCNM-LAN Feature 
 
           [bookmark: pgfId-1438204]
 
            
             
              
              [bookmark: pgfId-1437972]Table 27-4 [bookmark: 54017]Cisco Nexus 5000 NX-OS Logging Levels per Cisco DCNM-LAN Feature 
 
              
              
               
               	 
                 
                 [bookmark: pgfId-1437984]Cisco DCNM-LAN Feature 
                
  
               	 
                 
                 [bookmark: pgfId-1437986]Cisco Nexus 5000 NX-OS Logging Facility 
                
  
               	 
                 
                 [bookmark: pgfId-1437988]Enabled by Default? 
                
  
               	 
                 
                 [bookmark: pgfId-1437990]Logging Facility Keyword 
                
  
               	 
                 
                 [bookmark: pgfId-1437992]Cisco NX-OS Default Logging Level 
                
  
               	 
                 
                 [bookmark: pgfId-1437994]Minimum Cisco DCNM-LAN- 
                
 
                 
                 [bookmark: pgfId-1437995]Required Logging Level 
                 2 
                
  
              
 
               
               	 [bookmark: pgfId-1438000]AAA
  
               	[bookmark: pgfId-1438002]AAA
  
               	[bookmark: pgfId-1438004]Yes
  
               	[bookmark: pgfId-1438006]aaa
  
               	[bookmark: pgfId-1438008]3
  
               	[bookmark: pgfId-1438010]5
  
              
 
               
               	[bookmark: pgfId-1438014]RADIUS
  
               	[bookmark: pgfId-1438016]Yes
  
               	[bookmark: pgfId-1438018]radius
  
               	[bookmark: pgfId-1438020]3
  
               	[bookmark: pgfId-1438022]5
  
              
 
               
               	[bookmark: pgfId-1438026]TACACS+
  
               	[bookmark: pgfId-1438028]No
  
               	[bookmark: pgfId-1438030]tacacs+
  
               	[bookmark: pgfId-1438032]3
  
               	[bookmark: pgfId-1438034]5
  
              
 
               
               	 [bookmark: pgfId-1438036]Device Discovery
 [bookmark: pgfId-1438037]Topology
  
               	[bookmark: pgfId-1438039]CDP
  
               	[bookmark: pgfId-1438041]Yes
  
               	[bookmark: pgfId-1438043]cdp
  
               	[bookmark: pgfId-1438045]2
  
               	[bookmark: pgfId-1438047]6
  
              
 
               
               	[bookmark: pgfId-1438051]LLDP
  
               	[bookmark: pgfId-1438053]No
  
               	[bookmark: pgfId-1438055]lldp
  
               	[bookmark: pgfId-1438057]2
  
               	[bookmark: pgfId-1438059]5
  
              
 
               
               	[bookmark: pgfId-1438061]Ethernet Interfaces
  
               	 [bookmark: pgfId-1438063]Ethernet port manager
  
               	 [bookmark: pgfId-1438065]Yes
  
               	 [bookmark: pgfId-1438067]ethpm
  
               	 [bookmark: pgfId-1438069]5
  
               	 [bookmark: pgfId-1438071]5
  
              
 
               
               	[bookmark: pgfId-1438073]Traffic Storm Control
  
              
 
               
               	[bookmark: pgfId-1438085]Fabric Extender
  
               	[bookmark: pgfId-1438087]FEX
  
               	[bookmark: pgfId-1438089]Yes
  
               	[bookmark: pgfId-1438091]fex
  
               	[bookmark: pgfId-1438093]5
  
               	[bookmark: pgfId-1438095]5
  
              
 
               
               	 [bookmark: pgfId-1438097]Inventory
  
               	[bookmark: pgfId-1438099]System manager
  
               	[bookmark: pgfId-1438101]Yes
  
               	[bookmark: pgfId-1438103]sysmgr
  
               	[bookmark: pgfId-1438105]3
  
               	[bookmark: pgfId-1438107]3
  
              
 
               
               	[bookmark: pgfId-1438111]Platform
  
               	[bookmark: pgfId-1438113]Yes
  
               	[bookmark: pgfId-1438115]pfm
  
               	[bookmark: pgfId-1438117]5
  
               	[bookmark: pgfId-1438119]5
  
              
 
               
               	[bookmark: pgfId-1438123]NOHMS
  
               	[bookmark: pgfId-1438125]Yes
  
               	[bookmark: pgfId-1438127]nohms
  
               	[bookmark: pgfId-1438129]2
  
               	[bookmark: pgfId-1438131]2
  
              
 
               
               	[bookmark: pgfId-1438133]Port-Channel Interfaces
  
               	[bookmark: pgfId-1438135]Port-channel interfaces
  
               	[bookmark: pgfId-1438137]Yes
  
               	[bookmark: pgfId-1438139]port-channel
  
               	[bookmark: pgfId-1438141]5
  
               	[bookmark: pgfId-1438143]6
  
              
 
               
               	[bookmark: pgfId-1438145]SPAN
  
               	[bookmark: pgfId-1438147]SPAN
  
               	[bookmark: pgfId-1438149]Yes
  
               	[bookmark: pgfId-1438151]monitor
  
               	[bookmark: pgfId-1438153]3
  
               	[bookmark: pgfId-1438155]6
  
              
 
               
               	[bookmark: pgfId-1438157]Spanning Tree
  
               	[bookmark: pgfId-1438159]Spanning tree
  
               	[bookmark: pgfId-1438161]Yes
  
               	[bookmark: pgfId-1438163]spanning-tree
  
               	[bookmark: pgfId-1438165]3
  
               	[bookmark: pgfId-1438167]6
  
              
 
               
               	[bookmark: pgfId-1438169]Unidirectional Link Detection (UDLD)
  
               	[bookmark: pgfId-1438171]UDLD
  
               	[bookmark: pgfId-1438173]No
  
               	[bookmark: pgfId-1438175]udld
  
               	[bookmark: pgfId-1438177]5
  
               	[bookmark: pgfId-1438179]5
  
              
 
               
               	[bookmark: pgfId-1438181]Virtual Port Channel
  
               	[bookmark: pgfId-1438183]VPC
  
               	[bookmark: pgfId-1438185]No
  
               	[bookmark: pgfId-1438187]vpc
  
               	[bookmark: pgfId-1438189]2
  
               	[bookmark: pgfId-1438191]6
  
              
 
               
               	[bookmark: pgfId-1438193]VLAN Network Interfaces
  
               	[bookmark: pgfId-1438195]Interface VLAN
  
               	[bookmark: pgfId-1438197]No
  
               	[bookmark: pgfId-1438199]interface-vlan
  
               	[bookmark: pgfId-1438201]2
  
               	[bookmark: pgfId-1438203]5
  
              
 
              
            
 
           
 
            
             
              
              	 2.[bookmark: pgfId-1437998]Minimum Cisco DCNM-LAN logging levels appear in bold text for Cisco Nexus 5000 NX-OS logging facilities that have a default logging level that is too low.
  
             
 
             
           
 
          
 
           
            [bookmark: pgfId-1438206][bookmark: 59472]Cisco Nexus 4000 NX-OS Logging Levels per DCNM-LAN Feature 
 
           [bookmark: pgfId-1438420]
 
            
             
              
              [bookmark: pgfId-1438213]Table 27-5 [bookmark: 58169]Cisco Nexus 4000 NX-OS Logging Levels per Cisco DCNM-LAN Feature 
 
              
              
               
               	 
                 
                 [bookmark: pgfId-1438225]Cisco DCNM-LAN Feature 
                
  
               	 
                 
                 [bookmark: pgfId-1438227]Cisco Nexus 4000 NX-OS Logging Facility 
                
  
               	 
                 
                 [bookmark: pgfId-1438229]Enabled by Default? 
                
  
               	 
                 
                 [bookmark: pgfId-1438231]Logging Facility Keyword 
                
  
               	 
                 
                 [bookmark: pgfId-1438233]Cisco NX-OS Default Logging Level 
                
  
               	 
                 
                 [bookmark: pgfId-1438235]Minimum Cisco DCNM-LAN- 
                
 
                 
                 [bookmark: pgfId-1438236]Required Logging Level 
                 3 
                
  
              
 
               
               	 [bookmark: pgfId-1438241]AAA
  
               	[bookmark: pgfId-1438243]AAA
  
               	[bookmark: pgfId-1438245]Yes
  
               	[bookmark: pgfId-1438247]aaa
  
               	[bookmark: pgfId-1438249]3
  
               	[bookmark: pgfId-1438251]5
  
              
 
               
               	[bookmark: pgfId-1438255]RADIUS
  
               	[bookmark: pgfId-1438257]Yes
  
               	[bookmark: pgfId-1438259]radius
  
               	[bookmark: pgfId-1438261]3
  
               	[bookmark: pgfId-1438263]5
  
              
 
               
               	[bookmark: pgfId-1438267]TACACS+
  
               	[bookmark: pgfId-1438269]No
  
               	[bookmark: pgfId-1438271]tacacs+
  
               	[bookmark: pgfId-1438273]3
  
               	[bookmark: pgfId-1438275]5
  
              
 
               
               	[bookmark: pgfId-1438277]Device Discovery
  
               	 [bookmark: pgfId-1438279]CDP
  
               	 [bookmark: pgfId-1438281]Yes
  
               	 [bookmark: pgfId-1438283]cdp
  
               	 [bookmark: pgfId-1438285]2
  
               	 [bookmark: pgfId-1438287]6
  
              
 
               
               	[bookmark: pgfId-1438289]Topology
  
              
 
               
               	[bookmark: pgfId-1438301]Ethernet Interfaces
  
               	 [bookmark: pgfId-1438303]Ethernet port manager
  
               	 [bookmark: pgfId-1438305]Yes
  
               	 [bookmark: pgfId-1438307]ethpm
  
               	 [bookmark: pgfId-1438309]5
  
               	 [bookmark: pgfId-1438311]5
  
              
 
               
               	[bookmark: pgfId-1438313]Traffic Storm Control
  
              
 
               
               	[bookmark: pgfId-1438325]FIP Snooping
  
               	[bookmark: pgfId-1438327]FIPSM
  
               	[bookmark: pgfId-1438329]Yes
  
               	[bookmark: pgfId-1438331]fip-snooping
  
               	[bookmark: pgfId-1438333]2
  
               	[bookmark: pgfId-1438335]5
  
              
 
               
               	[bookmark: pgfId-1438337]Inventory
  
               	[bookmark: pgfId-1438339]System manager
  
               	[bookmark: pgfId-1438341]Yes
  
               	[bookmark: pgfId-1438343]sysmgr
  
               	[bookmark: pgfId-1438345]3
  
               	[bookmark: pgfId-1438347]3
  
              
 
               
               	[bookmark: pgfId-1438349]Link State Tracking
  
               	[bookmark: pgfId-1438351]LST
  
               	[bookmark: pgfId-1438353]No
  
               	[bookmark: pgfId-1438355]lstsvc
  
               	[bookmark: pgfId-1438357]2
  
               	[bookmark: pgfId-1438359]4
  
              
 
               
               	[bookmark: pgfId-1438361]Port-Channel Interfaces
  
               	[bookmark: pgfId-1438363]Port-channel interfaces
  
               	[bookmark: pgfId-1438365]Yes
  
               	[bookmark: pgfId-1438367]port-channel
  
               	[bookmark: pgfId-1438369]5
  
               	[bookmark: pgfId-1438371]6
  
              
 
               
               	[bookmark: pgfId-1438373]SPAN
  
               	[bookmark: pgfId-1438375]SPAN
  
               	[bookmark: pgfId-1438377]Yes
  
               	[bookmark: pgfId-1438379]monitor
  
               	[bookmark: pgfId-1438381]3
  
               	[bookmark: pgfId-1438383]6
  
              
 
               
               	[bookmark: pgfId-1438385]Spanning Tree
  
               	[bookmark: pgfId-1438387]Spanning tree
  
               	[bookmark: pgfId-1438389]Yes
  
               	[bookmark: pgfId-1438391]spanning-tree
  
               	[bookmark: pgfId-1438393]3
  
               	[bookmark: pgfId-1438395]6
  
              
 
               
               	[bookmark: pgfId-1438397]Unidirectional Link Detection (UDLD)
  
               	[bookmark: pgfId-1438399]UDLD
  
               	[bookmark: pgfId-1438401]No
  
               	[bookmark: pgfId-1438403]udld
  
               	[bookmark: pgfId-1438405]5
  
               	[bookmark: pgfId-1438407]5
  
              
 
               
               	[bookmark: pgfId-1438409]VLAN Network Interfaces
  
               	[bookmark: pgfId-1438411]Interface VLAN
  
               	[bookmark: pgfId-1438413]No
  
               	[bookmark: pgfId-1438415]interface-vlan
  
               	[bookmark: pgfId-1438417]2
  
               	[bookmark: pgfId-1438419]5
  
              
 
              
            
 
           
 
            
             
              
              	 3.[bookmark: pgfId-1438239]Minimum Cisco DCNM-LAN logging levels appear in bold text for Cisco Nexus 4000 NX-OS logging facilities that have a default logging level that is too low.
  
             
 
             
           
 
          
 
           
            [bookmark: pgfId-1438422][bookmark: 28874]Cisco Nexus 1000V NX-OS Logging Levels per DCNM-LAN Feature
 
           [bookmark: pgfId-1438648]
 
            
             
              
              [bookmark: pgfId-1438428]Table 27-6 Cisco Nexus 1000V NX-OS Logging Levels per Cisco DCNM-LAN Feature 
 
              
              
               
               	 
                 
                 [bookmark: pgfId-1438440]Cisco DCNM-LAN Feature 
                
  
               	 
                 
                 [bookmark: pgfId-1438442]Cisco Nexus 1000V NX-OS Logging Facility 
                
  
               	 
                 
                 [bookmark: pgfId-1438444]Enabled by Default? 
                
  
               	 
                 
                 [bookmark: pgfId-1438446]Logging Facility Keyword 
                
  
               	 
                 
                 [bookmark: pgfId-1438448]Cisco NX-OS Default Logging Level 
                
  
               	 
                 
                 [bookmark: pgfId-1438450]Minimum Cisco DCNM-LAN- 
                
 
                 
                 [bookmark: pgfId-1438451]Required Logging Level 
                 4 
                
  
              
 
               
               	 [bookmark: pgfId-1438456]AAA
  
               	[bookmark: pgfId-1438458]AAA
  
               	[bookmark: pgfId-1438460]Yes
  
               	[bookmark: pgfId-1438462]aaa
  
               	[bookmark: pgfId-1438464]3
  
               	[bookmark: pgfId-1438466]5
  
              
 
               
               	[bookmark: pgfId-1438470]RADIUS
  
               	[bookmark: pgfId-1438472]Yes
  
               	[bookmark: pgfId-1438474]radius
  
               	[bookmark: pgfId-1438476]3
  
               	[bookmark: pgfId-1438478]5
  
              
 
               
               	[bookmark: pgfId-1438482]TACACS+
  
               	[bookmark: pgfId-1438484]No
  
               	[bookmark: pgfId-1438486]tacacs+
  
               	[bookmark: pgfId-1438488]3
  
               	[bookmark: pgfId-1438490]5
  
              
 
               
               	 [bookmark: pgfId-1438492]Device Discovery
 [bookmark: pgfId-1438493]Topology
  
               	 [bookmark: pgfId-1438495]CDP
  
               	 [bookmark: pgfId-1438497]Yes
  
               	 [bookmark: pgfId-1438499]cdp
  
               	 [bookmark: pgfId-1438501]2
  
               	 [bookmark: pgfId-1438503]6
  
              
 
               
              
 
               
               	[bookmark: pgfId-1438517]Ethernet Interfaces
  
               	[bookmark: pgfId-1438519]Ethernet port manager
  
               	[bookmark: pgfId-1438521]Yes
  
               	[bookmark: pgfId-1438523]ethpm
  
               	[bookmark: pgfId-1438525]5
  
               	[bookmark: pgfId-1438527]5
  
              
 
               
               	 [bookmark: pgfId-1438529]Virtual Ethernet Interfaces
  
               	[bookmark: pgfId-1438531]Ifmgr
  
               	[bookmark: pgfId-1438533]Yes
  
               	[bookmark: pgfId-1438535]ifmgr
  
               	[bookmark: pgfId-1438537]5
  
               	[bookmark: pgfId-1438539]5
  
              
 
               
               	[bookmark: pgfId-1438543]VIM
  
               	[bookmark: pgfId-1438545]Yes
  
               	[bookmark: pgfId-1438547]vim
  
               	[bookmark: pgfId-1438549]5
  
               	[bookmark: pgfId-1438551]5
  
              
 
               
               	 [bookmark: pgfId-1438553]Inventory
  
               	[bookmark: pgfId-1438555]Module
  
               	[bookmark: pgfId-1438557]Yes
  
               	[bookmark: pgfId-1438559]module
  
               	[bookmark: pgfId-1438561]5
  
               	[bookmark: pgfId-1438563]5
  
              
 
               
               	[bookmark: pgfId-1438567]Platform
  
               	[bookmark: pgfId-1438569]Yes
  
               	[bookmark: pgfId-1438571]platform
  
               	[bookmark: pgfId-1438573]5
  
               	[bookmark: pgfId-1438575]5
  
              
 
               
               	[bookmark: pgfId-1438579]System manager
  
               	[bookmark: pgfId-1438581]Yes
  
               	[bookmark: pgfId-1438583]sysmgr
  
               	[bookmark: pgfId-1438585]3
  
               	[bookmark: pgfId-1438587]3
  
              
 
               
               	[bookmark: pgfId-1438589]Virtual Switches
  
               	[bookmark: pgfId-1438591]MSP
  
               	[bookmark: pgfId-1438593]Yes
  
               	[bookmark: pgfId-1438595]msp
  
               	[bookmark: pgfId-1438597]5
  
               	[bookmark: pgfId-1438599]5
  
              
 
               
               	[bookmark: pgfId-1438601]Port-Channel Interfaces
  
               	[bookmark: pgfId-1438603]Port-channel interfaces
  
               	[bookmark: pgfId-1438605]Yes
  
               	[bookmark: pgfId-1438607]port-channel
  
               	[bookmark: pgfId-1438609]5
  
               	[bookmark: pgfId-1438611]6
  
              
 
               
               	 [bookmark: pgfId-1438613]Port Profiles
  
               	[bookmark: pgfId-1438615]Port profile
  
               	[bookmark: pgfId-1438617]Yes
  
               	[bookmark: pgfId-1438619]port-profile
  
               	[bookmark: pgfId-1438621]5
  
               	[bookmark: pgfId-1438623]5
  
              
 
               
               	[bookmark: pgfId-1438627]VMS
  
               	[bookmark: pgfId-1438629]Yes
  
               	[bookmark: pgfId-1438631]vms
  
               	[bookmark: pgfId-1438633]5
  
               	[bookmark: pgfId-1438635]5
  
              
 
               
               	[bookmark: pgfId-1438637]SPAN
  
               	[bookmark: pgfId-1438639]SPAN
  
               	[bookmark: pgfId-1438641]Yes
  
               	[bookmark: pgfId-1438643]monitor
  
               	[bookmark: pgfId-1438645]3
  
               	[bookmark: pgfId-1438647]6
  
              
 
              
            
 
           
 
            
             
              
              	 4.[bookmark: pgfId-1438454]Minimum Cisco DCNM-LAN logging levels appear in bold text for Cisco Nexus 1000V NX-OS logging facilities that have a default logging level that is too low.
  
             
 
             
           
 
          
 
           
            [bookmark: pgfId-1438650][bookmark: 96108]Additional References for Device Discovery
 
            
             
              
               
               	 
                 
                 [bookmark: pgfId-1438664]Related Topic 
                
  
               	 
                 
                 [bookmark: pgfId-1438666]Document Title 
                
  
              
 
               
               	[bookmark: pgfId-1438668]Device and Credentials
  
               	[bookmark: pgfId-1438673]Chapter 28, “Administering Devices and Credentials”
  
              
 
               
               	[bookmark: pgfId-1438682]Cisco NX-OS XML management interface
  
               	[bookmark: pgfId-1438687]Cisco NX-OS XML Interface User Guide
  
              
 
              
            
 
           
 
          
 
           
            [bookmark: pgfId-1438690][bookmark: 35448]Standards
 
           [bookmark: pgfId-1438701]
 
            
             
              
               
               	 
                 
                 [bookmark: pgfId-1438693]Standards 
                
  
               	 
                 
                 [bookmark: pgfId-1438695]Title 
                
  
              
 
               
               	[bookmark: pgfId-1438697]NETCONF protocol over the Secure Shell (SSH)
  
               	[bookmark: pgfId-1438700] RFC 4742
  
              
 
              
            
 
           
 
          
 
           
            [bookmark: pgfId-1438703][bookmark: 92503]Feature History for Device Discovery
 
            
             
              
              [bookmark: pgfId-1438711]Table 27-7 [bookmark: 50557]Feature History for Device Discovery
 
              
              
               
               	 
                 
                 [bookmark: pgfId-1438717]Feature Name 
                
  
               	 
                 
                 [bookmark: pgfId-1438719]Releases 
                
  
               	 
                 
                 [bookmark: pgfId-1438721]Feature Information 
                
  
              
 
               
               	[bookmark: pgfId-1438723]Discovery of various supported devices
  
               	[bookmark: pgfId-1438725]5.2(2a)
  
               	[bookmark: pgfId-1438727]Support was added for this feature.
  
              
 
               
               	[bookmark: pgfId-1450038]LLDP discovery
  
               	[bookmark: pgfId-1450040]5.0(2)
  
               	[bookmark: pgfId-1450042]Support was added for this feature.
  
              
 
               
               	[bookmark: pgfId-1438729]Fibre Channel discovery
  
               	[bookmark: pgfId-1438731]5.0(2)
  
               	[bookmark: pgfId-1438733]Support was added for this feature.
  
              
 
               
               	[bookmark: pgfId-1438735]Automatic logging-level configuration support
  
               	[bookmark: pgfId-1438737]5.0(2)
  
               	 
                
  
              
 
              
            
 
           
 
          
 
        
 
        
      
 
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1110711][bookmark: 47491]Administering [bookmark: marker-1173944]Devices and Credentials 
      
      
 
     
 
 
    [bookmark: pgfId-1412837]This chapter describes how to administer Cisco NX-OS devices and the credentials that are used by the Cisco Data Center Network Manager for LAN (DCNM-LAN) server to authenticate itself to the devices.
 
    [bookmark: pgfId-1423716]The Devices and Credentials feature allows you to administer the management state of devices. If the managed physical device supports virtual device contexts (VDCs), Cisco DCNM represents each VDC as a device. If you need to retrieve the running configuration and status information of a single VDC on a physical device with multiple VDCs, rather than performing device discovery for all the VDCs on the physical device, you can use the Devices and Credentials feature to rediscover the single device that represents the changed VDC.
 
    [bookmark: pgfId-1423717]Cisco DCNM also supports the ability to secure each VDC with different credentials. Cisco DCNM allows you to configure unique credentials for each discovered device or to use default credentials when you do not configure unique credentials for a device.
 
    [bookmark: pgfId-1412842]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1412846]Information About Devices and Credentials
 
     	 [bookmark: pgfId-1412850]Licensing Requirements for Devices and Credentials
 
     	 [bookmark: pgfId-1412854]Prerequisites for Administering Devices and Credentials
 
     	 [bookmark: pgfId-1412858]Guidelines and Limitations for Devices and Credentials
 
     	 [bookmark: pgfId-1412862]Configuring Devices and Credentials
 
     	 [bookmark: pgfId-1412866]Viewing Device Credentials and Status
 
     	 [bookmark: pgfId-1412870]Field Descriptions for Devices and Credentials
 
     	 [bookmark: pgfId-1412874]Additional References for Devices and Credentials
 
     	 [bookmark: pgfId-1412878]Feature History for Devices and Credentials
 
    
 
   
 
    
     [bookmark: pgfId-1412880][bookmark: 99822]Information About Devices and Credentials
 
    [bookmark: pgfId-1412881]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1412885]Devices
 
     	 [bookmark: pgfId-1412889]Credentials
 
     	 [bookmark: pgfId-1412893]Device Status
 
     	 [bookmark: pgfId-1412897]VDC Support
 
    
 
     
      [bookmark: pgfId-1412899][bookmark: 13452]Devices
 
     [bookmark: pgfId-1412900]The Devices and Credentials feature allows you to administer the management state of devices. If the managed physical device supports virtual device contexts (VDCs), DCNM-LAN represents each VDC as a device. If you need to retrieve the running configuration and status information of a single VDC on a physical device with multiple VDCs, rather than performing device discovery for all the VDCs on the physical device, you can use the Devices and Credentials feature to rediscover the single device that represents the changed VDC.
 
    
 
     
      [bookmark: pgfId-1412902][bookmark: 55200]Credentials
 
     [bookmark: pgfId-1412903]Devices and Credentials supports the ability to secure each managed device with different credentials. DCNM-LAN allows you to configure unique credentials for each discovered device or use default credentials when you do not configure unique credentials for a device. If some managed devices share the same credentials but others do not, you can configure unique credentials for some devices and configure the default credentials with the credentials that are shared by some of the managed devices.
 
     [bookmark: pgfId-1412904]Devices and Credentials associates a unique set of device credentials with each DCNM-LAN server user which means that the accounting logs on managed devices reflect the actions of each DCNM-LAN server user. If you log into the DCNM-LAN client as a user who does not have device credentials configured, the DCNM-LAN client prompts you to configure device credentials for the user account.
 
     [bookmark: pgfId-1412905]If support for accounting is not important to your organization, you must still configure each DCNM-LAN server user with device credentials, even if the credentials specified for each user are the same.
 
    
 
     
      [bookmark: pgfId-1412907][bookmark: 45389]Device Status
 
     [bookmark: pgfId-1412908]The Devices and Credentials feature shows the status each device. The possible status are as follows:
 
      
      	 [bookmark: pgfId-1412909]Managed—DCNM-LAN can connect to the device using Secure Shell (SSH), configure the running configuration of the device, and retrieve logs and other data from it. This status is possible only for devices that run a supported release of Cisco NX-OS and that are configured properly to support discovery by DCNM-LAN. For more information, see the “Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
      	 [bookmark: pgfId-1412913]Unmanaged—DCNM-LAN does not manage the device or monitor the status of the device. 
 
      	 [bookmark: pgfId-1412914]Unreachable—DCNM-LAN cannot connect to the device, which was a managed device prior to becoming unreachable. Common causes for this status are as follows:
 
     
 
     [bookmark: pgfId-1412915] – A network issue is preventing the DCNM-LAN server from contacting the device.
 
     [bookmark: pgfId-1412916] – SSH is disabled on the device.
 
     [bookmark: pgfId-1412917] – All terminal lines on the device are in use.
 
    
 
     
      [bookmark: pgfId-1412919][bookmark: 55842]VDC Support
 
     [bookmark: pgfId-1412920]For devices that support VDCs, DCNM-LAN treats each VDC on a physical device as a separate device; therefore, DCNM-LAN can maintain unique credentials for each VDC on a device. DCNM-LAN tracks the status of each VDC separately, as well.
 
    
 
   
 
    
     [bookmark: pgfId-1412922][bookmark: 64029]Licensing Requirements for Devices and Credentials
 
    [bookmark: pgfId-1412923]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1412936]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1412926]Product 
         
  
        	 
          
          [bookmark: pgfId-1412928]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1412930]Cisco DCNM-LAN
  
        	[bookmark: pgfId-1412932]Device and Credentials requires no license. Any feature not included in a license package is bundled with the Cisco DCNM-LAN and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1412938][bookmark: 57296]Prerequisites for Administering Devices and Credentials
 
    [bookmark: pgfId-1412939]Performing device discovery with the Devices and Credentials feature has the following prerequisites:
 
     
     	 [bookmark: pgfId-1412940]The DCNM-LAN server must be able to connect to a device that you want to discover.
 
     	 [bookmark: pgfId-1412941]Cisco NX-OS devices must be running a supported release of Cisco NX-OS. For information about supported releases of Cisco NX-OS, see the  Cisco DCNM Release Notes, Release 7.1.x .
 
     	 [bookmark: pgfId-1412945]The Cisco NX-OS device must have the minimal configuration that is required to enable device discovery to succeed. For more information, see the “Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
    
 
   
 
    
     [bookmark: pgfId-1412950][bookmark: 76033]Guidelines and Limitations for Devices and Credentials
 
    [bookmark: pgfId-1412951]The Devices and Credentials feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1412952]Discovering a device by using the Devices and Credentials feature does not support CDP-based discovery of neighboring devices. To use CDP-based discovery, see the “Administering Device Discovery” section.
 
     	 [bookmark: pgfId-1412956]Be careful when you change the default credentials or device-specific credentials. Incorrect credentials prevent DCNM-LAN from managing devices.
 
    
 
   
 
    
     [bookmark: pgfId-1412958][bookmark: 98789]Configuring Devices and Credentials
 
    [bookmark: pgfId-1412959]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1412979]Configuring Default Device Credentials
 
     	 [bookmark: pgfId-1412983]Clearing Default Device Credentials
 
     	 [bookmark: pgfId-1412987]Configuring Unique Credentials for a Device
 
     	 [bookmark: pgfId-1421385]Clearing Unique Credentials for a Device
 
    
 
     
      [bookmark: pgfId-1069130][bookmark: 83658]Configuring Default Device Credentials[bookmark: marker-1173949]
 
     [bookmark: pgfId-1054023]You can configure the default credentials, which DCNM-LAN uses to authenticate itself when it connects to discovered Cisco NX-OS devices. DCNM-LAN uses the default device credentials to communicate with each discovered device that you have not configured with unique device credentials.
 
      
       
     
 
     
 
     [bookmark: pgfId-1232931]Note Device credentials are unique for each DCNM-LAN server user.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1054024]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1232918]Determine what the default device credentials should be. All Cisco NX-OS devices that DCNM-LAN uses the default credentials to communicate with must have a network administrator account configured with a username and password that are identical to the default credentials that you configure in DCNM-LAN.
 
      
       
     
 
     
 
     [bookmark: pgfId-1065628]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1054026]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1064943]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1064944]The Default Credentials area appears in the Contents pane, above the Devices area, which lists the discovered devices.
 
     [bookmark: pgfId-1054030]Step 2 In the User Name field, enter the username for the default credentials. A valid username can be 1 to 32 characters. Valid characters are numbers, symbols, and case-sensitive letters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1054032]Note Cisco NX-OS supports usernames that are a maximum of 28 characters.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1065870]Step 3 To the right of the Password field, click the down-arrow button.
 
     [bookmark: pgfId-1066832]Step 4 In the Password field and the Confirm Password field, enter the password for the default credentials. Valid passwords are numbers, symbols, and case-sensitive letters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1065941]Note Cisco NX-OS supports passwords that are a maximum of 64 characters.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1068889]Step 5 Click OK.
 
     [bookmark: pgfId-1065478]Step 6 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1054037]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1423751]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1423755]Clearing Default Device Credentials
 
      	 [bookmark: pgfId-1423759]Configuring Unique Credentials for a Device
 
      	 [bookmark: pgfId-1423763]Clearing Unique Credentials for a Device
 
     
 
    
 
     
      [bookmark: pgfId-1066254][bookmark: 50593]Clearing Default Device Credentials
 
     [bookmark: pgfId-1066255]You can clear the default device credentials.
 
      
       
     
 
     
 
     [bookmark: pgfId-1066293]Note If you clear the default device credentials, DCNM-LAN can connect to discovered devices only if you have configured unique credentials for each managed device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1066256]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1066257]If you intend to use DCNM-LAN without default device credentials, you should ensure that DCNM-LAN is configured with unique device credentials for each discovered device before you perform this procedure. For more information, see the “Configuring Unique Credentials for a Device” section.
 
    
 
     
      [bookmark: pgfId-1057877]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1066010]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1066011]The Default Credentials area appears in the Contents pane, above the Devices area, which lists the discovered devices.
 
     [bookmark: pgfId-1066012]Step 2 In the Default Credentials area, click Clear.
 
     [bookmark: pgfId-1066014]The User Name field and the Password field clear.
 
     [bookmark: pgfId-1066016]Step 3 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1079171]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1423788]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1423792]Configuring Default Device Credentials
 
      	 [bookmark: pgfId-1423796]Configuring Unique Credentials for a Device
 
      	 [bookmark: pgfId-1423800]Clearing Unique Credentials for a Device
 
      	 [bookmark: pgfId-1423820]Administering Device Discovery
 
     
 
    
 
     
      [bookmark: pgfId-1173963][bookmark: 49561]Configuring Unique Credentials for a Device
 
     [bookmark: pgfId-1173964]You can configure credentials that are unique to a discovered device. When unique credentials exist for a discovered device, DCNM-LAN uses them when it connects to the device rather than using the default device credentials.
 
      
       
     
 
     
 
     [bookmark: pgfId-1232942]Note Device credentials are unique for each DCNM-LAN server user.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058483]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1058484]Determine the username and password for a network administrator user account on the discovered device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1144179]Note We recommend that you use a strong password. Common guidelines for strong passwords include a minimum password length of eight characters and at least one letter, one number, and one symbol. For example, the password Re1Ax@h0m3 has ten characters and contains uppercase and lowercase letters in addition to one symbol and three numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058485]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1066622]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1066623]The discovered devices appear in the Devices area of the Contents pane.
 
     [bookmark: pgfId-1067211]Step 2 In the User Credentials column for the device, double-click the entry and then click the down-arrow button.
 
     [bookmark: pgfId-1067212]Step 3 In the User Name field, enter the username. Valid usernames are between 1 and 32 characters. Valid characters are numbers, symbols, and case-sensitive letters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1067338]Note Cisco NX-OS supports usernames that are a maximum of 28 characters.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1067213]Step 4 In the Password field and the Confirm Password field, enter the password. Valid passwords are numbers, symbols, and case-sensitive letters.
 
      
       
     
 
     
 
     [bookmark: pgfId-1067049]Note Cisco NX-OS supports passwords that are a maximum of 64 characters.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1067050]Step 5 Click OK.
 
     [bookmark: pgfId-1068884]Step 6 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1066629]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1423825]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1423829]Configuring Default Device Credentials
 
      	 [bookmark: pgfId-1423833]Clearing Default Device Credentials
 
      	 [bookmark: pgfId-1423837]Clearing Unique Credentials for a Device
 
      	 [bookmark: pgfId-1423857]Administering Device Discovery
 
     
 
    
 
     
      [bookmark: pgfId-1058530][bookmark: 77234]Clearing Unique Credentials for a Device
 
     [bookmark: pgfId-1058531]You can clear unique credentials for a discovered device.
 
      
       
     
 
     
 
     [bookmark: pgfId-1068215]Note If you clear the unique credentials for a discovered device, DCNM-LAN uses the default credentials to connect to the device.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1058532]BEFORE YOU BEGIN 
 
     [bookmark: pgfId-1068411]If you intend to operate DCNM-LAN without unique credentials for the device, you should ensure that DCNM-LAN is configured with default device credentials before you perform this procedure. For more information, see the “Configuring Default Device Credentials” section.
 
    
 
     
      [bookmark: pgfId-1058534]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1068681]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials. 
 
     [bookmark: pgfId-1068682]Discovered devices appear in the Devices area of the Contents pane.
 
     [bookmark: pgfId-1068683]Step 2 In the User Credentials column for the device, double-click the entry and then click the down-arrow button.
 
     [bookmark: pgfId-1068684]Step 3 In the User Name field, delete all text.
 
     [bookmark: pgfId-1068830]Step 4 In the Password field, delete all text.
 
     [bookmark: pgfId-1068834]Step 5 In the Confirm Password field, delete all text.
 
     [bookmark: pgfId-1068688]Step 6 Click OK.
 
     [bookmark: pgfId-1068877]Step 7 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1068689]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1423862]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1423866]Configuring Default Device Credentials
 
      	 [bookmark: pgfId-1423870]Clearing Default Device Credentials
 
      	 [bookmark: pgfId-1423874]Configuring Unique Credentials for a Device
 
      	 [bookmark: pgfId-1423894]Administering Device Discovery
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1054039][bookmark: 86594]Viewing Device Credentials and Status
 
    [bookmark: pgfId-1061133]To view the status for devices and whether credentials are configured for the device, from the Feature Selector pane, choose DCNM Server Administration > Devices and Credentials.
 
    [bookmark: pgfId-1061729]The default credentials appears in the Default Credentials area in the Contents pane. Information about devices, including credentials and status, appear in the Devices area in the Contents pane.
 
    [bookmark: pgfId-1410289]The Reason field provides a brief message that explains the device status. The following table provides information about how to resolve the issue indicated by the message.
 
    [bookmark: pgfId-1409160]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1409188]Reason 
         
  
        	 
          
          [bookmark: pgfId-1409190]Resolution 
         
  
       
 
        
        	[bookmark: pgfId-1410295]Success
  
        	[bookmark: pgfId-1410297]Not applicable. DCNM-LAN is managing the device.
  
       
 
        
        	[bookmark: pgfId-1409397]Authentication failure
  
        	[bookmark: pgfId-1409194]Ensure that the credentials are correct for the device. Ensure that DCNM-LAN can reach the device.
  
       
 
        
        	[bookmark: pgfId-1409793]Unsupported platform
  
        	[bookmark: pgfId-1409198]Verify that the device is a supported platform and that it is running a supported release of Cisco NX-OS. For information about supported platforms and Cisco NX-OS releases, see the Cisco DCNM Release Notes, Release 7.1.x.
  
       
 
        
        	[bookmark: pgfId-1409737]Device sync up failure
  
        	[bookmark: pgfId-1409281]Cisco Nexus 7000 Series devices only. The sequence numbers of accounting and system message log messages are not in a proper format. Clear the log files on the device and discover the device again.
  
       
 
        
        	[bookmark: pgfId-1409691]Unmanaged manually
  
        	[bookmark: pgfId-1409277]A DCNM-LAN user changed the device status to Unmanaged. Discover the device again.
  
       
 
        
        	[bookmark: pgfId-1409656]Error when executing database query
  
        	[bookmark: pgfId-1409273]Discover the device again. If the error reoccurs, clean the DCNM-LAN database. For more information about cleaning the database, see Chapter35, “Maintaining the Cisco DCNM-LAN Database”
  
       
 
        
        	[bookmark: pgfId-1409627]Auto synchronization for device is disabled by user
  
        	[bookmark: pgfId-1409269]Discover the device again.
  
       
 
        
        	[bookmark: pgfId-1409601]Logging levels required by DCNM-LAN are not configured on the device
  
        	[bookmark: pgfId-1410041]Discover the device again. For more information, see the “Automatic Logging-Level Configuration Support” section.
  
       
 
        
        	[bookmark: pgfId-1409572]Error in SSH connection
  
        	[bookmark: pgfId-1409261]Ensure that SSH is enabled on the device and that it is functioning properly. Discover the device again.
  
       
 
        
        	[bookmark: pgfId-1409552]Unreachable
  
        	[bookmark: pgfId-1409257]Ensure that you specify the correct IP address for the device. Ensure that DCNM-LAN can contact the device. Discover the device again.
  
       
 
        
        	[bookmark: pgfId-1409532]Discovery failed because server node stopped/crashed
  
        	[bookmark: pgfId-1409253]Discover the device again.
  
       
 
        
        	[bookmark: pgfId-1409486]Syslog messages logging disabled on device
  
        	[bookmark: pgfId-1409249]Discover the device again.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1413003]For information about the fields that appear, see the “Field Descriptions for Devices and Credentials” section.
 
   
 
    
     [bookmark: pgfId-1413006][bookmark: 22611]Field Descriptions for Devices and Credentials
 
    [bookmark: pgfId-1413007]This section includes the following field descriptions for Devices and Credentials:
 
     
     	 [bookmark: pgfId-1413011]Device and Credentials Content Pane
 
    
 
     
      [bookmark: pgfId-1413013][bookmark: 67303]Device and Credentials Content Pane
 
     [bookmark: pgfId-1413070]
 
      
       
        
        [bookmark: pgfId-1413019]Table 28-1 Device and Credentials Content Pane 
 
        
        
         
         	 
           
           [bookmark: pgfId-1413023]Field 
          
  
         	 
           
           [bookmark: pgfId-1413025]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1413027]Default Credentials 
          
  
        
 
         
         	[bookmark: pgfId-1413031]User Name
  
         	[bookmark: pgfId-1413033]Name of the Cisco NX-OS device user account that the DCNM-LAN server uses to access any device that it is discovering or that it is managing. On the device, the user account must be assigned to the network-admin or vdc-admin role. By default, this field is blank.
 [bookmark: pgfId-1413034]Note The information in the User Credentials field in the Devices area overrides the information in the Default Credentials section.
  
        
 
         
         	[bookmark: pgfId-1413036]Password
  
         	[bookmark: pgfId-1413038]Password for the Cisco NX-OS device user account specified in the User Name field. By default, this field is blank.
  
        
 
         
         	 
           
           [bookmark: pgfId-1413040]Devices 
          
  
        
 
         
         	[bookmark: pgfId-1413044]IP Address
  
         	[bookmark: pgfId-1413046]Display only. IPv4 address of the Cisco NX-OS device.
  
        
 
         
         	[bookmark: pgfId-1413048]Name
  
         	[bookmark: pgfId-1413050]Display only. Name of the Cisco NX-OS device.
  
        
 
         
         	[bookmark: pgfId-1413052]User Credentials
  
         	[bookmark: pgfId-1413054]The Cisco NX-OS user account that DCNM-LAN uses to connect to the Cisco NX-OS device. 
 [bookmark: pgfId-1413055]Note If you configure this field, DCNM-LAN uses the user account that you configure when it connects to the device. If this field is blank, DCNM-LAN uses the user account specified in the Default Credentials area. By default, this field is blank.
  
        
 
         
         	[bookmark: pgfId-1413057]Status
  
         	[bookmark: pgfId-1413059]Display only. Whether the DCNM-LAN server can connect to and configure the device. Valid values are as follows:
 
           
           	 [bookmark: pgfId-1413060]Managed—The DCNM-LAN server can configure the device.
 
           	 [bookmark: pgfId-1413061]Unmanaged—The DCNM-LAN server cannot configure the device.
 
           	 [bookmark: pgfId-1413062]Unreachable—The DCNM-LAN server cannot reach the device.
 
          
  
        
 
         
         	[bookmark: pgfId-1413064]Reason
  
         	[bookmark: pgfId-1413066]Display only. Provides a brief explanation for the device status. For more information, see the “Viewing Device Credentials and Status” section.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1413072][bookmark: 59150]Additional References for Devices and Credentials
 
    [bookmark: pgfId-1413073]For additional information related to the Devices and Credentials feature, see the following sections:
 
     
     	 [bookmark: pgfId-1413077]Related Documents
 
     	 [bookmark: pgfId-1413081]Standards
 
    
 
     
      [bookmark: pgfId-1413083][bookmark: 88459]Related Documents
 
     [bookmark: pgfId-1413096]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1413086]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1413088]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1413090]Cisco NX-OS XML management interface
  
         	[bookmark: pgfId-1413094]Cisco NX-OS XML Interface User GuideTitle may change
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1413098][bookmark: 70458]Standards
 
     [bookmark: pgfId-1413109]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1413101]Standards 
          
  
         	 
           
           [bookmark: pgfId-1413103]Title 
          
  
        
 
         
         	[bookmark: pgfId-1413105]NETCONF protocol over the Secure Shell (SSH)
  
         	[bookmark: pgfId-1413108] RFC 4742
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1413111][bookmark: 92503]Feature History for Devices and Credentials
 
    [bookmark: pgfId-1413115]Table 28-2 lists the release history for this feature.
 
    [bookmark: pgfId-1413136]
 
     
      
       
       [bookmark: pgfId-1413119]Table 28-2 [bookmark: 50557]Feature History for Devices and Credentials
 
       
       
        
        	 
          
          [bookmark: pgfId-1413125]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1413127]Releases 
         
  
        	 
          
          [bookmark: pgfId-1413129]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1413131]Reason field
  
        	[bookmark: pgfId-1413133]5.0(2)
  
        	[bookmark: pgfId-1413135]The Reason field was added to the Devices and Credentials feature.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1222406][bookmark: 33088]Administering [bookmark: marker-1222404]Auto-Synchronization with Devices 
      
      
 
     
 
 
    [bookmark: pgfId-1398574]This chapter describes how to administer the Auto-Synchronization with Devices feature in Cisco Data Center Network Manager for LAN (DCNM-LAN).
 
    [bookmark: pgfId-1403882]Auto-synchronization allows the Cisco DCNM server to ensure that configuration and status information about managed devices is current. The Cisco DCNM server creates a poller process for each managed device. A poller process periodically retrieves system and accounting logs from a device. Cisco DCNM uses the information retrieved by poller processes to update its configuration and status information about polled devices. When you choose Auto Synchronization with Devices on the Feature Selector, the Contents pane displays all the poller instances that are running for different devices and allows you to control each.
 
    [bookmark: pgfId-1403883]You can also use the Auto-Synchronization with Devices feature to delete unwanted event data on demand or automatically.
 
    [bookmark: pgfId-1398579]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1398583]Information About Auto-Synchronization with Devices
 
     	 [bookmark: pgfId-1398587]Licensing Requirements for Auto-Synchronization with Devices
 
     	 [bookmark: pgfId-1398591]Prerequisites for Auto-Synchronization with Devices
 
     	 [bookmark: pgfId-1398595]Guidelines and Limitations for Auto-Synchronization with Devices
 
     	 [bookmark: pgfId-1398599]Configuring Device Auto-Synchronization
 
     	 [bookmark: pgfId-1398603]Viewing the Status of Auto-Synchronization Pollers
 
     	 [bookmark: pgfId-1398607]Field Descriptions for Auto Synchronization with Devices
 
     	 [bookmark: pgfId-1398611]Additional References
 
     	 [bookmark: pgfId-1398615]Feature History for Auto-Synchronization with Devices
 
    
 
   
 
    
     [bookmark: pgfId-1398617][bookmark: 14255]Information About Auto-Synchronization with Devices
 
    [bookmark: pgfId-1398618]The Auto Synchronizing with Devices feature ensures that the Cisco Data Center Network Manager for LAN (DCNM-LAN) server has current configuration and status information about managed devices. The DCNM-LAN server creates one poller process for each device to retrieve the system and accounting logs that this feature requires.
 
    [bookmark: pgfId-1398619]When you choose Auto Synchronization with Devices on the Feature Selector pane, the Contents pane shows information about each poller process and allows you to control them.
 
    [bookmark: pgfId-1398620]You can configure the length of time that DCNM-LAN waits before polling a device again. DCNM-LAN sets a default polling interval for each managed device. The default value varies by the type of device. The range of polling interval values is displayed when you begin editing the polling interval field for the device. For more information, see the “Configuring the Polling Interval” section.
 
    [bookmark: pgfId-1398624]DCNM-LAN polls devices concurrently; however, to avoid polling all devices simultaneously, DCNM-LAN begins polling devices in alphabetical device-name order and delays each polling process by a short, random amount of time.
 
    [bookmark: pgfId-1398625]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1398629]Automatic and Manual Purging of Event Data
 
     	 [bookmark: pgfId-1398633]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1398635][bookmark: 99322]Automatic and Manual Purging of Event Data
 
     [bookmark: pgfId-1398636]You can use the Auto-Synchronization with Devices feature to delete unwanted event data. DCNM-LAN supports automatic purging of event data. You can configure the following aspects of automatic event data purging:
 
      
      	 [bookmark: pgfId-1398637]Days of the week and time of day that automatic purging occurs.
 
      	 [bookmark: pgfId-1398638]Whether DCNM-LAN determines which event data to purge by the age of the data or by a maximum number of database entries.
 
      	 [bookmark: pgfId-1398639]Severity level of events.
 
     
 
     [bookmark: pgfId-1398640]You can also manually purge event data.
 
    
 
     
      [bookmark: pgfId-1398642][bookmark: 49358]Virtualization Support
 
     [bookmark: pgfId-1398643]DCNM-LAN treats each virtual device context (VDC) on a Cisco NX-OS device as a separate device. DCNM-LAN creates one poller process per device.
 
    
 
   
 
    
     [bookmark: pgfId-1398645][bookmark: 51127]Licensing Requirements for Auto-Synchronization with Devices
 
    [bookmark: pgfId-1398646]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1398659]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1398649]Product 
         
  
        	 
          
          [bookmark: pgfId-1398651]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1398653]DCNM-LAN
  
        	[bookmark: pgfId-1398655]Auto-Synchronization with Devices requires no license. Any feature not included in a license package is bundled with the DCNM-LAN and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1398661][bookmark: 78783]Prerequisites for Auto-Synchronization with Devices
 
    [bookmark: pgfId-1398662]The Auto-Synchronization with Devices feature has the following prerequisites:
 
     
     	 [bookmark: pgfId-1398663]The DCNM-LAN server must be able to connect to the devices.
 
     	 [bookmark: pgfId-1398664]The Cisco NX-OS device must be running a supported version of Cisco NX-OS.
 
     	 [bookmark: pgfId-1398665]The Cisco NX-OS device must have the minimal configuration that is required to enable device discovery to succeed. For more information, see the “Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
    
 
   
 
    
     [bookmark: pgfId-1398670][bookmark: 87804]Guidelines and Limitations for Auto-Synchronization with Devices
 
    [bookmark: pgfId-1398671]The Auto-Synchronization with Devices feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1398672]We recommend that you use the default device polling interval unless you encounter issues with synchronization due to slow responses from devices or to managing many devices. For more information, see the “Configuring the Polling Interval” section.
 
     	 [bookmark: pgfId-1398676]For the Auto-Synchronization with Devices feature, the DCNM-LAN client does not automatically update the information shown in the Summary pane. To ensure that you are viewing current information, from the menu bar, choose  View > Refresh .
 
     	 [bookmark: pgfId-1398677]We recommend that you configure automatic purging of event data to ensure that the DCNM-LAN database size does not grow too large.
 
    
 
   
 
    
     [bookmark: pgfId-1398679][bookmark: 54640]Configuring Device Auto-Synchronization
 
    [bookmark: pgfId-1398680]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1398684]Starting and Stopping a Poller
 
     	 [bookmark: pgfId-1398688]Configuring the Polling Interval
 
     	 [bookmark: pgfId-1398692]Synchronizing with a Device
 
     	 [bookmark: pgfId-1398696]Deleting Data from the Events Database
 
     	 [bookmark: pgfId-1398700]Enabling and Disabling Automatic Event Purging
 
     	 [bookmark: pgfId-1398704]Configuring Automatic Event Purge Settings
 
     	 [bookmark: pgfId-1398708]Purging Events Now
 
    
 
     
      [bookmark: pgfId-1118467][bookmark: 91967]Starting and Stopping a Poller[bookmark: marker-1173976]
 
     [bookmark: pgfId-1118500]You can start and stop a poller for a device. When a poller is stopped, auto-synchronization for the device does not occur.
 
    
 
     
      [bookmark: pgfId-1231951]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1121417]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1121418]A table of pollers appears in the Contents pane. Each row corresponds to a poller for a particular device. Devices are listed alphabetically. The Poller Status field displays messages about whether the poller is running or is stopped.
 
     [bookmark: pgfId-1121419]Step 2 Click to select the poller that you want to start or stop.
 
     [bookmark: pgfId-1121510]Step 3 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1121519]To start a poller, from the menu bar, choose  Actions > Start Poller . The Poller Status field changes to Running.
 
       	 [bookmark: pgfId-1121583]To stop a poller, from the menu bar, choose  Actions > Stop Poller . The Poller Status field changes to Stopped.
 
      
 
     
 
     [bookmark: pgfId-1121423]You do not need to save your changes.
 
     [bookmark: pgfId-1121424]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1403888]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1403892]Configuring the Polling Interval
 
      	 [bookmark: pgfId-1403896]Synchronizing with a Device
 
     
 
    
 
     
      [bookmark: pgfId-1121355][bookmark: 63326]Configuring the Polling Interval[bookmark: marker-1173977]
 
     [bookmark: pgfId-1378730]You can configure how often the DCNM-LAN server synchronizes with managed devices. While synchronizing, the DCNM-LAN server fetches accounting and system logs from managed devices. This setting affects how frequently features in the DCNM-LAN client receive updated information about managed devices.
 
    
 
     
      [bookmark: pgfId-1378731]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1120779]Determine how often you want DCNM-LAN to perform auto-synchronization with managed devices. Consider the following:
 
      
      	 [bookmark: pgfId-1120655]How often device configurations are changed by means other than DCNM-LAN, such as using the command-line interface of a device. If changes by means other than DCNM-LAN are common, consider using a short polling interval.
 
      	 [bookmark: pgfId-1120682]How important it is to your organization that DCNM-LAN be up to date with managed device configurations. If up-to-date configuration information is important to your organization, consider using a short polling interval.
 
     
 
    
 
     
      [bookmark: pgfId-1120750]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1120806]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1120807]The polling intervals for all devices appear below the table of pollers in the Poller Setting tab.
 
     [bookmark: pgfId-1120837]Step 2 Select the device in the Platform column that you want to work with.
 
     [bookmark: pgfId-1401140]Step 3 In the Polling Interval field, enter the number of seconds between auto-synchronizations for the selected device. The range of polling interval values is displayed when you begin editing the Polling Interval field for the device.
 
     [bookmark: pgfId-1120989]Step 4 From the menu bar, choose File > Deploy to save the polling interval.
 
     [bookmark: pgfId-1120935]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1403901]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1403905]Starting and Stopping a Poller
 
      	 [bookmark: pgfId-1403909]Synchronizing with a Device
 
     
 
    
 
     
      [bookmark: pgfId-1118604][bookmark: 31973]Synchronizing with a Device[bookmark: marker-1173978]
 
     [bookmark: pgfId-1119030]You can make DCNM-LAN synchronize with a device manually when you do not want to wait for the next auto-synchronization to occur.
 
      
       
     
 
     
 
     [bookmark: pgfId-1119842]Note If many configuration changes have occurred on the device since the last successful synchronization, consider performing device discovery instead of synchronization. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1119843]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1119844]Ensure that you have either configured the device entry with unique device credentials or that DCNM-LAN can use the default device credentials to connect to the device. For more information, see the “Configuring Default Device Credentials” section.
 
    
 
     
      [bookmark: pgfId-1119848]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1119850]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices. 
 
     [bookmark: pgfId-1119851]A table of pollers appears in the Contents pane. Each row corresponds to a poller for a particular device. Devices are listed alphabetically. 
 
     [bookmark: pgfId-1119852]Step 2 Click to select the device that you want DCNM-LAN to synchronize with.
 
     [bookmark: pgfId-1119853]Step 3 From the menu bar, choose Actions > Synchronize with Device.
 
     [bookmark: pgfId-1120440]Synchronization begins.
 
     [bookmark: pgfId-1119856]To determine when the synchronization has finished, watch the Last Sync Status column. Typically, synchronization with a device occurs in less than 5 minutes.
 
     [bookmark: pgfId-1119857]You do not need to save your changes.
 
     [bookmark: pgfId-1119858]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1403914]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1403918]Starting and Stopping a Poller
 
      	 [bookmark: pgfId-1403922]Configuring the Polling Interval
 
     
 
    
 
     
      [bookmark: pgfId-1118637][bookmark: 69928]Deleting Data from the Events Database[bookmark: marker-1173979]
 
     [bookmark: pgfId-1375865]You can delete data from the events database based on the exact age of the events. Events that you delete can no longer appear in the Event Browser or on a feature-specific Events tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-1375866]Tip If you want to delete events based on the number of events in the database, see the “Purging Events Now” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375867]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1118944]Determine the date and time of the newest events data that you want to delete. When you follow the steps in this procedure, DCNM-LAN deletes all events that are older than the date and time that you select.
 
    
 
     
      [bookmark: pgfId-1118932]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1118867]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1118868]The Events Database Administration tab appears in the Details pane, below the table of pollers.
 
     [bookmark: pgfId-1118720]Step 2 From the Delete events older than drop-down list, choose the date and time of the newest event that you want to delete and click OK.
 
     [bookmark: pgfId-1119017]Step 3 Click Delete.
 
     [bookmark: pgfId-1119021]DCNM-LAN deletes all events older than the date and time that you specified.
 
     [bookmark: pgfId-1118732]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1403927]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1403931]Enabling and Disabling Automatic Event Purging
 
      	 [bookmark: pgfId-1403935]Configuring Automatic Event Purge Settings
 
      	 [bookmark: pgfId-1403939]Purging Events Now
 
     
 
    
 
     
      [bookmark: pgfId-1133658][bookmark: 23698]Enabling and Disabling Automatic Event Purging[bookmark: marker-1382195]
 
     [bookmark: pgfId-1375624]You can enable or disable the automatic purging of events from the DCNM-LAN events database.
 
    
 
     
      [bookmark: pgfId-1375634]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1375666]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1375667]The Events Database Administration tab appears in the Details pane, below the table of pollers.
 
     [bookmark: pgfId-1375687]Step 2 Under Auto Purge Settings, do one of the following:
 
      
       
       	 [bookmark: pgfId-1375688]To enable automatic event purging, check  Enable Auto Purge .
 
       	 [bookmark: pgfId-1375689]To disable automatic event purging, uncheck  Enable Auto Purge .
 
      
 
     
 
     [bookmark: pgfId-1375690]Step 3 From the menu bar, choose File > Deploy to save your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1375671]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1403944]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1403948]Deleting Data from the Events Database
 
      	 [bookmark: pgfId-1403952]Configuring Automatic Event Purge Settings
 
      	 [bookmark: pgfId-1403956]Purging Events Now
 
     
 
    
 
     
      [bookmark: pgfId-1375601][bookmark: 56301]Configuring Automatic Event Purge Settings
 
     [bookmark: pgfId-1375735]You can configure when automatic event purging occurs and the criteria that DCNM-LAN uses to determine which events to purge.
 
    
 
     
      [bookmark: pgfId-1376641]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1376751]Determine when you want automatic event purging to occur. We recommend that automatic event purging occur when DCNM-LAN usage is low.
 
     [bookmark: pgfId-1376762]If you perform backups of your DCNM-LAN databases, consider scheduling automatic event purging after database backups have occurred, to ensure that you retain a record of all events.
 
     [bookmark: pgfId-1376793]Determine what criteria you want DCNM-LAN to use to determine which events to purge. The criteria available are as follows:
 
      
      	 [bookmark: pgfId-1376794]Age of event—DCNM-LAN can purge all events that are older than a specific number of days, weeks, or months.
 
      	 [bookmark: pgfId-1376819]Number of events in the database—When the number of events in the database exceeds the maximum number that you specify, DCNM-LAN can purge the oldest events first until the maximum number is not exceeded.
 
      	 [bookmark: pgfId-1383152]Severity of event—DCNM-LAN can purge events based on the severity level of the event.
 
     
 
     [bookmark: pgfId-1376830]If you enable both criteria, DCNM-LAN applies them independently of each other.
 
    
 
     
      [bookmark: pgfId-1376752]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1376143]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1376144]The Events Database Administration tab appears in the Details pane, below the table of pollers.
 
     [bookmark: pgfId-1376134]Step 2 Under Purge Threshold, configure the criteria that DCNM-LAN uses to determine which events to purge. You can configure any of the criteria in the following table:
 
     [bookmark: pgfId-1376286]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1376299]Purge Criteria 
          
  
         	 
           
           [bookmark: pgfId-1376301]How to Configure 
          
  
        
 
         
         	[bookmark: pgfId-1376303]Age of events
  
         	[bookmark: pgfId-1376339] 1. Check Data older than.
 [bookmark: pgfId-1376340] 2. From the first drop-down list, choose the number of days, weeks, or months.
 [bookmark: pgfId-1376341] 3. From the second drop-down list, choose Days, Weeks, or Months, as needed.
  
        
 
         
         	[bookmark: pgfId-1377207]Number of events in the database
  
         	[bookmark: pgfId-1376395] 1. Check Total Entries Exceed(0-2147483647).
 [bookmark: pgfId-1376396] 2. In the box, enter the maximum number of entries that you want to allow in the events database.
  
        
 
         
         	[bookmark: pgfId-1383095]Severity of event
  
         	[bookmark: pgfId-1383097] 1. Check Severity. The list of eight severity levels becomes available.
 [bookmark: pgfId-1383115] 2. For each severity level that you want DCNM-LAN to use to determine whether to purge events, check the severity level.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1376260]Step 3 Under Auto Purge Settings, follow these steps to configure when you want automatic purging to occur:
 
     [bookmark: pgfId-1376272] a. Check the days-of-the-week check boxes to specify which days of the week that you want automatic purging to occur.
 
     [bookmark: pgfId-1376532] b. Use the Run at box to configure the exact time on the specified days that you want automatic event purging to occur.
 
     [bookmark: pgfId-1376570]Step 4 (Optional) If you want to enable automatic event purging, check Enable Auto Purge.
 
     [bookmark: pgfId-1376681]Step 5 From the menu bar, choose File > Deploy to save your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1376603]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1403961]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1403965]Deleting Data from the Events Database
 
      	 [bookmark: pgfId-1403969]Enabling and Disabling Automatic Event Purging
 
      	 [bookmark: pgfId-1403973]Purging Events Now
 
     
 
    
 
     
      [bookmark: pgfId-1376572][bookmark: 39920]Purging Events Now[bookmark: marker-1382204]
 
     [bookmark: pgfId-1376573]You can purge event data on demand, using the automatic event purge settings to determine which events are purged. Events that you delete can no longer appear in the Event Browser or on a feature-specific Events tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-1375886]Tip If you want to delete events on demand, based on the exact age of the events, see the “Deleting Data from the Events Database” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375888]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375776]Ensure that the automatic event purge settings are configured as needed. For more information, see the “Configuring Automatic Event Purge Settings” section.
 
    
 
     
      [bookmark: pgfId-1375975]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1376041]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
     [bookmark: pgfId-1376042]The Events Database Administration tab appears in the Details pane, below the table of pollers.
 
     [bookmark: pgfId-1376044]Step 2 Under Purge, click Purge Now.
 
     [bookmark: pgfId-1376045]DCNM-LAN deletes events, using the automatic event purge settings to determine which events to purge.
 
     [bookmark: pgfId-1376046]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1403978]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1403982]Deleting Data from the Events Database
 
      	 [bookmark: pgfId-1403986]Enabling and Disabling Automatic Event Purging
 
      	 [bookmark: pgfId-1403990]Configuring Automatic Event Purge Settings
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1375723][bookmark: 72635]Viewing the Status of Auto-Synchronization Pollers
 
    [bookmark: pgfId-1133659]To view the status of an auto-synchronization poller, from the Feature Selector pane, choose DCNM Server Administration > Auto Synchronization with Devices.
 
    [bookmark: pgfId-1133660]Poller status and information about the synchronization time and status appear in the Pollers area in the Contents pane. 
 
    [bookmark: pgfId-1401261]
 
     
      
       
       [bookmark: pgfId-1401226]Table 29-1 Auto Synchronization Pollers Information 
 
       
       
        
        	 
          
          [bookmark: pgfId-1401230]Field 
         
  
        	 
          
          [bookmark: pgfId-1401232]Description 
         
  
       
 
        
        	 
          
          [bookmark: pgfId-1401234]Pollers 
         
  
       
 
        
        	[bookmark: pgfId-1401242]Last Refresh Time
  
        	[bookmark: pgfId-1401244]Display only. Date and time that the DCNM-LAN client updated information shown on the Contents pane.
  
       
 
        
        	[bookmark: pgfId-1401246]Device
  
        	[bookmark: pgfId-1401248]Display only. Name and IP address of the device for the corresponding poller.
  
       
 
        
        	[bookmark: pgfId-1401250]Poller Status
  
        	[bookmark: pgfId-1401252]Display only. Whether the poller is running or stopped. A running poller attempts to synchronize with the configuration and status information from its device at the frequency specified by the Device Polling Interval field.
  
       
 
        
        	[bookmark: pgfId-1401254]Last Sync Time
  
        	[bookmark: pgfId-1401256]Display only. Date and time that the poller last retrieved system and accounting log data from the device.
  
       
 
        
        	[bookmark: pgfId-1401258]Last Sync Status
  
        	[bookmark: pgfId-1401260]Display only. Whether the most recent synchronization attempt succeeded or failed. If synchronization failed, determine why DCNM-LAN failed to connect to the device. If necessary, rediscover the device.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1398722][bookmark: 59585]Field Descriptions for Auto Synchronization with Devices
 
    [bookmark: pgfId-1398723]This section includes the following field descriptions for the Auto Synchronization with Devices feature:
 
     
     	 [bookmark: pgfId-1398727]Poller Setting Tab
 
     	 [bookmark: pgfId-1398731]Events Database Administration Tab
 
    
 
     
      [bookmark: pgfId-1398733][bookmark: 77901]Poller Setting Tab
 
     [bookmark: pgfId-1398774]
 
      
       
        
        [bookmark: pgfId-1398739]Table 29-2 Auto Synchronization with Devices Poller Setting Tab 
 
        
        
         
         	 
           
           [bookmark: pgfId-1398743]Field 
          
  
         	 
           
           [bookmark: pgfId-1398745]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1398747]Pollers 
          
  
        
 
         
         	[bookmark: pgfId-1398751]Polling Interval
  
         	[bookmark: pgfId-1398753]Number of seconds that all pollers wait before the next attempt to synchronize with a device. The range of polling interval values is displayed when you begin editing the Polling Interval field for the device.
  
        
 
         
         	[bookmark: pgfId-1398759]Device
  
         	[bookmark: pgfId-1398761]Display only. Name and IP address of the device for the corresponding poller.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1398776][bookmark: 16609]Events Database Administration Tab
 
     [bookmark: pgfId-1398837]
 
      
       
        
        [bookmark: pgfId-1398782]Table 29-3 Events Database Administration Tab 
 
        
        
         
         	 
           
           [bookmark: pgfId-1398786]Field 
          
  
         	 
           
           [bookmark: pgfId-1398788]Description 
          
  
        
 
         
         	[bookmark: pgfId-1398790]Delete events older than
  
         	[bookmark: pgfId-1398792]Date and time of the newest event to be deleted from the events database. There is no default value for this field.
  
        
 
         
         	 
           
           [bookmark: pgfId-1398794]Purge Threshold 
          
  
        
 
         
         	[bookmark: pgfId-1398798]Data older than
  
         	[bookmark: pgfId-1398800]Whether, during automatic event purging, DCNM-LAN deletes events that are older than the age specified in the drop-down lists located to the right of this check box. By default, this check box is unchecked. If you check the check box, the default age is 1 day.
  
        
 
         
         	[bookmark: pgfId-1398802]Total Entries Exceed
  
         	[bookmark: pgfId-1398804]Whether, during automatic event purging, DCNM-LAN deletes the oldest events until the number of events equals the number in the box located to the right of this check box. By default, this check box is unchecked. If you check the check box, the default number of event is 25,000.
  
        
 
         
         	[bookmark: pgfId-1398806]Severity
  
         	[bookmark: pgfId-1398808]Whether, during automatic event purging, DCNM-LAN deletes events with severity levels that are selected from the list of severity levels. By default, this check box is disabled.
  
        
 
         
         	[bookmark: pgfId-1398810]Severity Levels
  
         	[bookmark: pgfId-1398812]Severity levels of events that DCNM-LAN deletes during automatic event purging. The severity levels are available only if the Severity check box is checked. By default, all severity levels are disabled. The severity levels are as follows:
 
           
           	 [bookmark: pgfId-1398813]Emergency
 
           	 [bookmark: pgfId-1398814]Alert
 
           	 [bookmark: pgfId-1398815]Critical
 
           	 [bookmark: pgfId-1398816]Error
 
           	 [bookmark: pgfId-1398817]Warning
 
           	 [bookmark: pgfId-1398818]Notification
 
           	 [bookmark: pgfId-1398819]Informational
 
           	 [bookmark: pgfId-1398820]Debugging
 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1398822]Auto Purge Settings 
          
  
        
 
         
         	[bookmark: pgfId-1398826]Enable Auto Purge
  
         	[bookmark: pgfId-1398828]Whether automatic purging of event data is enabled. By default, this check box is disabled.
  
        
 
         
         	[bookmark: pgfId-1398830]Run on
  
         	[bookmark: pgfId-1398832]Days of the week that the automatic purging of events data occurs. By default, none of the check boxes are checked. If you check the Daily check box, the check boxes for the individual days of the week become unavailable.
  
        
 
         
         	[bookmark: pgfId-1398834]Run at
  
         	[bookmark: pgfId-1398836]Time of day that automatic purging of event data occurs, on the days of the week that automatic purging is enabled.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1398839][bookmark: 53004]Additional References
 
    [bookmark: pgfId-1398840]For additional information related to administering Auto-Synchronization with Devices, see the following sections:
 
     
     	 [bookmark: pgfId-1398844]Related Documents
 
     	 [bookmark: pgfId-1398848]Standards
 
    
 
     
      [bookmark: pgfId-1398850][bookmark: 16521]Related Documents
 
     [bookmark: pgfId-1398870]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1398853]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1398855]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1398857]Events
  
         	[bookmark: pgfId-1398862]System Management Configuration Guide, Cisco DCNM for LAN, Release 7.1.x
  
        
 
         
         	[bookmark: pgfId-1398864]Device discovery
  
         	[bookmark: pgfId-1398869]Chapter 27, “Administering Device Discovery”
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1398872][bookmark: 55398]Standards
 
     [bookmark: pgfId-1398882]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1398875]Standards 
          
  
         	 
           
           [bookmark: pgfId-1398877]Title 
          
  
        
 
         
         	[bookmark: pgfId-1398879]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1398881]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1398884][bookmark: 92503]Feature History for Auto-Synchronization with Devices
 
    [bookmark: pgfId-1398888]Table 29-4 lists the release history for this feature.
 
    [bookmark: pgfId-1398912]
 
     
      
       
       [bookmark: pgfId-1398895]Table 29-4 [bookmark: 50557]Feature History for Auto-Synchronization with Devices 
 
       
       
        
        	 
          
          [bookmark: pgfId-1398901]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1398903]Releases 
         
  
        	 
          
          [bookmark: pgfId-1398905]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1398907]Auto-Synchronization with Devices
  
        	[bookmark: pgfId-1398909]5.0(2)
  
        	[bookmark: pgfId-1399032]No change from Release 4.2.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1380104][bookmark: 85166]Administering [bookmark: marker-1380102]Statistical Data Collection 
      
      
 
     
 
 
    [bookmark: pgfId-1400835]This chapter describes how to administer Statistical Data Collection in the Cisco Data Center Network Manager for LAN (DCNM-LAN).
 
    [bookmark: pgfId-1411858]You can use the Statistical Data Collection feature to control the statistics monitoring processes that you have created for one of the many device configuration features that support statistics. You can also use the Statistical Data Collection feature to delete unwanted statistical data on demand or automatically.
 
    [bookmark: pgfId-1400840]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1400844]Information About Statistical Data Collection
 
     	 [bookmark: pgfId-1400848]Licensing Requirements for Statistical Data Collection
 
     	 [bookmark: pgfId-1400852]Prerequisites for Statistical Data Collection
 
     	 [bookmark: pgfId-1400856]Guidelines and Limitations for Statistical Data Collection
 
     	 [bookmark: pgfId-1400860]Configuring Statistical Data Collection
 
     	 [bookmark: pgfId-1400864]Viewing the Status of Statistical Data Collectors
 
     	 [bookmark: pgfId-1400868]Field Descriptions for Statistical Data Collection
 
     	 [bookmark: pgfId-1400872]Additional References
 
     	 [bookmark: pgfId-1400876]Feature History for Statistical Data Collection
 
    
 
   
 
    
     [bookmark: pgfId-1400878][bookmark: 68337]Information About Statistical Data Collection
 
    [bookmark: pgfId-1400879]You can use the Statistical Data Collection feature to control the statistics monitoring processes that you have created for one of the many device configuration features that support statistics.
 
    [bookmark: pgfId-1400880]When you choose Statistical Data Collection on the Feature Selector pane, the Contents pane shows information about each statistical collection and allows you to control them. You can also use this feature to purge old data from the statistical database.
 
    [bookmark: pgfId-1400881]You can configure the length of time that Cisco Data Center Network Manager for LAN (DCNM-LAN) waits before retrieving statistical data from devices that it is monitoring. By default, DCNM-LAN retrieves statistical data from monitored devices every 30 seconds. You can increase the length of time to a maximum of 4 minutes. For more information, see the “Configuring Monitoring Preferences” section.
 
    [bookmark: pgfId-1400885]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1400889]Automatic and Manual Purging of Statistical Data
 
     	 [bookmark: pgfId-1400893]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1400895][bookmark: 26781]Automatic and Manual Purging of Statistical Data
 
     [bookmark: pgfId-1400896]You can use the Statistical Data Collection feature to delete unwanted statistical data. DCNM-LAN supports automatic purging of statistical data. You can configure the following aspects of automatic statistical data purging:
 
      
      	 [bookmark: pgfId-1400897]Days of the week and time of day that automatic purging occurs.
 
      	 [bookmark: pgfId-1400898]Whether DCNM-LAN determines which statistical data to purge by the age of the data or by a maximum number of database entries.
 
      	 [bookmark: pgfId-1400899]Whether DCNM-LAN deletes the statistical data entries that it purges or consolidates them into one entry.
 
     
 
     [bookmark: pgfId-1400900]You can also manually purge statistical data.
 
    
 
     
      [bookmark: pgfId-1400902][bookmark: 81615]Virtualization Support
 
     [bookmark: pgfId-1400903]DCNM-LAN treats each virtual device context (VDC) on a Cisco NX-OS device as a separate device. Statistical data collections contain statistics from objects within devices.
 
    
 
   
 
    
     [bookmark: pgfId-1400905][bookmark: 91493]Licensing Requirements for Statistical Data Collection
 
    [bookmark: pgfId-1400906]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1400923]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1400909]Product 
         
  
        	 
          
          [bookmark: pgfId-1400911]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1400913]Cisco DCNM-LAN
  
        	[bookmark: pgfId-1400915]Real-time monitoring requires no license.
 [bookmark: pgfId-1400916]Cisco DCNM-LAN requires a LAN Enterprise license for the following features:
 
          
          	 [bookmark: pgfId-1400917]Maintaining a history of statistical data
 
          	 [bookmark: pgfId-1400918]Using overview charts
 
         
 [bookmark: pgfId-1400921]For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1400925][bookmark: 46908]Prerequisites for Statistical Data Collection
 
    [bookmark: pgfId-1400926]Statistical data collection has the following prerequisites:
 
     
     	 [bookmark: pgfId-1403736]The DCNM-LAN server must be able to connect to the devices.
 
     	 [bookmark: pgfId-1403738]The system clocks for the DCNM-LAN server and DCNM-LAN client must be synchronized.
 If the system clocks are not synchronized, scheduling tasks for data collection may start or end at incorrect times.
 
     	 [bookmark: pgfId-1403715]The Cisco NX-OS device must be running a supported version of Cisco NX-OS.
 
     	 [bookmark: pgfId-1400929]The Cisco NX-OS device must have the minimal configuration that is required to enable device discovery to succeed. For more information, see the “Verifying the Discovery Readiness of a Cisco NX-OS Device” section.
 
    
 
   
 
    
     [bookmark: pgfId-1400934][bookmark: 98630]Guidelines and Limitations for Statistical Data Collection
 
    [bookmark: pgfId-1400935]The Statistical Data Collection feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1400936]Collections are created by starting monitoring for a new chart. For more information, see the “Starting Statistical Monitoring for a Chart” section.
 
     	 [bookmark: pgfId-1400940]For the Statistical Data Collection feature, the DCNM-LAN client does not automatically update the information shown in the Summary pane. To ensure that you are viewing current information, from the menu bar, choose  View > Refresh .
 
     	 [bookmark: pgfId-1400941]When you start statistical monitoring for one or more charts and then close the DCNM-LAN client, a dialog box prompts you to decide whether to stop the collections or let them run. We recommend that you stop any unnecessary collections when you log out of the DCNM-LAN client. This practice conserves database space and decreases the server load.
 
     	 [bookmark: pgfId-1400942]We recommend that you configure automatic purging of statistical data to ensure that the DCNM-LAN database size does not grow too large.
 
     	 [bookmark: pgfId-1410569]You cannot always map the statistics data with the data collectors scheduler. However, a single scheduler can collect data for multiple graphs, and therefore, the statistics chart name need not match the data collector scheduler.
 
    
 
   
 
    
     [bookmark: pgfId-1400944][bookmark: 93527]Configuring Statistical Data Collection
 
    [bookmark: pgfId-1400945]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1400949]Starting and Stopping Statistical Data Collection
 
     	 [bookmark: pgfId-1402458]Using Modes in Statistics Charts
 
     	 [bookmark: pgfId-1400953]Deleting Statistical Data from a Collection
 
     	 [bookmark: pgfId-1400957]Deleting a Collection
 
     	 [bookmark: pgfId-1400961]Deleting Data from the Statistics Database
 
     	 [bookmark: pgfId-1400965]Enabling and Disabling Automatic Statistical Data Purging
 
     	 [bookmark: pgfId-1400969]Configuring Automatic Statistical Data Purge Settings
 
     	 [bookmark: pgfId-1400973]Purging Statistical Data Now
 
    
 
     
      [bookmark: pgfId-1373519][bookmark: 19915]Starting and Stopping Statistical Data Collection[bookmark: marker-1373518]
 
     [bookmark: pgfId-1373520]You can use the Statistical Data Collection feature to start and stop a statistical data collection process. Each collection process represents a statistical monitoring process that you created by starting monitoring for a device configuration feature.
 
    
 
     
      [bookmark: pgfId-1373521]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1373523]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection. 
 
     [bookmark: pgfId-1373524]A table of statistical data collectors appears in the Contents pane. Each row corresponds to a collector for a particular device. The Status field displays whether the collector is running or is stopped.
 
     [bookmark: pgfId-1373525]Step 2 Click the collector that you want to start or stop.
 
     [bookmark: pgfId-1373526]Step 3 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1373527]To start a collector, from the menu bar, choose  Actions > Start Collection . The Status field changes to Running.
 
       	 [bookmark: pgfId-1373528]To stop a collector, from the menu bar, choose  Actions > Stop Collection . The Status field changes to Stopped.
 
      
 
     
 
     [bookmark: pgfId-1403294]You do not need to save your changes.
 
     [bookmark: pgfId-1403295]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1403297][bookmark: 80516]Using Modes in Statistics Charts
 
     [bookmark: pgfId-1402220]You use statistics charts to toggle between the delta mode and the rate mode. The below table lists the features that contain statistics charts and delta mode/rate mode toggle button.
 
     [bookmark: pgfId-1402165]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1403317]Path 
          
  
         	 
           
           [bookmark: pgfId-1403319]Feature 
          
  
        
 
         
         	[bookmark: pgfId-1403321]Interfaces > Physical
  
         	[bookmark: pgfId-1403323]Ethernet Interface
  
        
 
         
         	[bookmark: pgfId-1403325]Interfaces > Physical
  
         	[bookmark: pgfId-1403327]Management Interface
  
        
 
         
         	[bookmark: pgfId-1403417]Interfaces > Logical
  
         	[bookmark: pgfId-1403419]Loopback Interface
  
        
 
         
         	[bookmark: pgfId-1403329]Interfaces > Logical
  
         	[bookmark: pgfId-1403331]Port Channel
  
        
 
         
         	[bookmark: pgfId-1403333]Interfaces > Logical
  
         	[bookmark: pgfId-1403335]vPC
  
        
 
         
         	[bookmark: pgfId-1403337]Switching
  
         	[bookmark: pgfId-1403339]VLAN
  
        
 
         
         	[bookmark: pgfId-1403341]Switching > Spanning Tree
  
         	[bookmark: pgfId-1403343]Rapid PVST+
  
        
 
         
         	[bookmark: pgfId-1403345]Switching > Spanning Tree
  
         	[bookmark: pgfId-1403347]MST
  
        
 
         
         	[bookmark: pgfId-1403349]Switching > Fabricpath
  
         	[bookmark: pgfId-1403351]ISIS Process
  
        
 
         
         	[bookmark: pgfId-1403431]Switching > Layer 2 Security
  
         	[bookmark: pgfId-1403433]Port Security
  
        
 
         
         	[bookmark: pgfId-1403353]Switching > Layer 2 Security
  
         	[bookmark: pgfId-1403355]ARP Inspection
  
        
 
         
         	[bookmark: pgfId-1403357]Switching > Layer 2 Security
  
         	[bookmark: pgfId-1403359]DHCP Snooping
  
        
 
         
         	[bookmark: pgfId-1403361]Switching > Layer 2 Security
  
         	[bookmark: pgfId-1403363]Traffic Storm Control
  
        
 
         
         	[bookmark: pgfId-1403365]Switching > Layer 2 Security
  
         	[bookmark: pgfId-1403367]IGMP Snooping
  
        
 
         
         	[bookmark: pgfId-1403498]Security
  
         	[bookmark: pgfId-1403500]DOT1x
  
        
 
         
         	[bookmark: pgfId-1403369]Security > Access Control
  
         	[bookmark: pgfId-1403371]IPv4 ACL
  
        
 
         
         	[bookmark: pgfId-1403373]Security > Access Control
  
         	[bookmark: pgfId-1403375]IPv6 ACL
  
        
 
         
         	[bookmark: pgfId-1403377]Security > Access Control
  
         	[bookmark: pgfId-1403379]MAC ACL
  
        
 
         
         	[bookmark: pgfId-1403470]Security > AAA
  
         	[bookmark: pgfId-1403472]Server Groups
  
        
 
         
         	[bookmark: pgfId-1403381]Inventory
  
         	[bookmark: pgfId-1403383]Virtual Switch
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1402354]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1402355]Step 1 From the Feature Selector pane, choose the appropriate feature. For example, if you wanted to see statistics for the Ethernet feature, choose Interfaces > Physical > Ethernet.
 
     [bookmark: pgfId-1402356]The available devices appear in the Summary pane.
 
     [bookmark: pgfId-1402357]Step 2 From the Summary pane, double-click the device.
 
     [bookmark: pgfId-1402358]Step 3 From the Summary pane, double-click Slots.
 
     [bookmark: pgfId-1402359]Step 4 Click the interface.
 
     [bookmark: pgfId-1402360]Step 5 From the Details pane, choose the Statistics tab.
 
     [bookmark: pgfId-1402361]Step 6 In the toolbar, click New Chart and then from the menu bar drop-down list, choose the chart that you want to view. For example, if you wanted to see statistics for traffic, choose Traffic Statistics Chart.
 
     [bookmark: pgfId-1402362]Step 7 (Optional) To toggle between the statistics mode and the rate mode, click the button to the right of the Select Frequency drop-down list.
 
     [bookmark: pgfId-1402363]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1411863]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1411867]Deleting Statistical Data from a Collection
 
      	 [bookmark: pgfId-1411871]Deleting a Collection
 
     
 
    
 
     
      [bookmark: pgfId-1373546][bookmark: 29958]Deleting Statistical Data from a Collection[bookmark: marker-1373545]
 
     [bookmark: pgfId-1373547]You can delete statistical data from a collection. This feature allows you to delete all the data from a collection without affecting data from other collections and without deleting the collection itself. Each collection process represents a statistical monitoring process that you created by starting monitoring for a device configuration feature.
 
    
 
     
      [bookmark: pgfId-1373548]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1373550]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection. 
 
     [bookmark: pgfId-1373551]A table of statistical data collectors appears in the Contents pane. Each row corresponds to a collector for a particular device. Devices are listed alphabetically. The Status field displays whether the collector is running or is stopped.
 
     [bookmark: pgfId-1373552]Step 2 Right-click the collection.
 
     [bookmark: pgfId-1373553]Step 3 From the menu bar, choose Actions > Delete Statistical Data.
 
     [bookmark: pgfId-1373554]DCNM-LAN deletes all statistical data from the collection.
 
     [bookmark: pgfId-1373555]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1411876]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1411880]Starting and Stopping Statistical Data Collection
 
      	 [bookmark: pgfId-1411884]Deleting a Collection
 
      	 [bookmark: pgfId-1411888]Deleting Data from the Statistics Database
 
      	 [bookmark: pgfId-1411892]Starting Statistical Monitoring for a Chart
 
     
 
    
 
     
      [bookmark: pgfId-1373575][bookmark: 45685]Deleting a Collection[bookmark: marker-1373574]
 
     [bookmark: pgfId-1373576]You can delete a collection of statistical data from a specific device. Each collection process represents a statistical monitoring process that you created by starting monitoring for a device configuration feature.
 
      
       
     
 
     
 
     [bookmark: pgfId-1373577]Note If you want to delete all data from a collections rather than deleting the collection itself, perform the steps in the “Deleting Statistical Data from a Collection” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1373581]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1373582]Determine which collection of data you want to delete.
 
    
 
     
      [bookmark: pgfId-1373583]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1373585]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection. 
 
     [bookmark: pgfId-1373586]A table of statistical data collectors appears in the Contents pane. Devices are listed alphabetically. Each row corresponds to a collection of statistical data for a particular device.
 
     [bookmark: pgfId-1373587]Step 2 Click the collection of data that you want to delete.
 
     [bookmark: pgfId-1373588]Step 3 From the menu bar, choose Actions > Delete Collection.
 
     [bookmark: pgfId-1373589]The collection is deleted.
 
     [bookmark: pgfId-1373590]You do not need to save your changes.
 
     [bookmark: pgfId-1373591]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1411897]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1411901]Starting and Stopping Statistical Data Collection
 
      	 [bookmark: pgfId-1411905]Deleting Statistical Data from a Collection
 
      	 [bookmark: pgfId-1411909]Deleting Data from the Statistics Database
 
      	 [bookmark: pgfId-1411913]Starting Statistical Monitoring for a Chart
 
     
 
    
 
     
      [bookmark: pgfId-1377034][bookmark: 73792]Deleting Data from the Statistics Database[bookmark: marker-1377033]
 
     [bookmark: pgfId-1377035]You can delete statistical data from the statistics database.
 
      
       
     
 
     
 
     [bookmark: pgfId-1373613]Note If you want to delete all data from a specific collection rather than deleting old data from all collections, perform the steps in the “Deleting a Collection” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1373617]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1373618]Determine the date and time of the newest statistical data that you want to delete. When you follow the steps in this procedure, DCNM-LAN deletes all statistics that are older than the date and time that you select.
 
    
 
     
      [bookmark: pgfId-1373619]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1373621]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
     [bookmark: pgfId-1373622]The Statistics Database area appears in the Contents pane, below the table of statistical data collectors.
 
     [bookmark: pgfId-1373623]Step 2 From the Delete statistical data older than drop-down list, select the date and time of the newest statistics that you want to delete and click OK.
 
     [bookmark: pgfId-1373624]Step 3 Click Delete.
 
     [bookmark: pgfId-1373625]DCNM-LAN deletes all statistics older than the date and time that you specified.
 
     [bookmark: pgfId-1373626]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1411918]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1411922]Deleting Statistical Data from a Collection
 
      	 [bookmark: pgfId-1411926]Deleting a Collection
 
      	 [bookmark: pgfId-1411930]Enabling and Disabling Automatic Statistical Data Purging
 
      	 [bookmark: pgfId-1411934]Configuring Automatic Statistical Data Purge Settings
 
      	 [bookmark: pgfId-1411938]Purging Statistical Data Now
 
     
 
    
 
     
      [bookmark: pgfId-1375724][bookmark: 23698]Enabling and Disabling Automatic Statistical Data Purging[bookmark: marker-1382074]
 
     [bookmark: pgfId-1375725]You can enable or disable the automatic purging of statistical data from the DCNM-LAN statistics database.
 
    
 
     
      [bookmark: pgfId-1375726]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1375728]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
     [bookmark: pgfId-1375729]The Statistical Database Administration tab appears in the Details pane, below the table of statistical data collectors.
 
     [bookmark: pgfId-1375730]Step 2 Under Auto Purge Settings, do one of the following:
 
      
       
       	 [bookmark: pgfId-1375731]To enable automatic statistical data purging, check  Enable Auto Purge .
 
       	 [bookmark: pgfId-1375732]To disable automatic statistical data purging, uncheck  Enable Auto Purge .
 
      
 
     
 
     [bookmark: pgfId-1375733]Step 3 From the menu bar, choose File > Deploy to save your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1375734]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1411943]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1411947]Deleting Data from the Statistics Database
 
      	 [bookmark: pgfId-1411951]Configuring Automatic Statistical Data Purge Settings
 
      	 [bookmark: pgfId-1411955]Purging Statistical Data Now
 
     
 
    
 
     
      [bookmark: pgfId-1375749][bookmark: 56301]Configuring Automatic Statistical Data Purge Settings
 
     [bookmark: pgfId-1375750]You can configure when automatic statistical data purging occurs and the criteria that DCNM-LAN uses to determine which statistical data to purge.
 
    
 
     
      [bookmark: pgfId-1375751]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375752]Determine when you want automatic statistical data purging to occur. A good recommendation is that you configure automatic statistical data purging to occur when DCNM-LAN usage is low.
 
     [bookmark: pgfId-1375753]If you perform backups of your DCNM-LAN databases, consider scheduling automatic statistical data purging after database backups have occurred, to ensure that you retain a record of all statistical data.
 
     [bookmark: pgfId-1375754]Determine what criteria you want DCNM-LAN to use to determine which statistical data to purge. The two criteria available are as follows:
 
      
      	 [bookmark: pgfId-1375755]Age of statistical data—DCNM-LAN can purge all statistical data entries that are older than a specific number of days, weeks, or months.
 
      	 [bookmark: pgfId-1375756]Number of statistical data entries in the database—When the number of statistical data entries in the database exceeds the maximum number that you specify, DCNM-LAN can purge the oldest statistical data entries first until the maximum number is not exceeded.
 
     
 
     [bookmark: pgfId-1375757]If you enable both criteria, DCNM-LAN applies them independently of each other.
 
    
 
     
      [bookmark: pgfId-1375758]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1375760]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
     [bookmark: pgfId-1375761]The Statistical Database Administration tab appears in the Details pane, below the table of statistical data collectors.
 
     [bookmark: pgfId-1405906]Step 2 Under Purge Threshold, configure the criteria that DCNM-LAN uses to determine which statistical data to purge. You can configure either or both of the criteria using the information in Table 30-1.
 
     [bookmark: pgfId-1405893]
 
     [bookmark: pgfId-1405715]Table 30-1 [bookmark: 41800]Purge Criteria
 
     [bookmark: pgfId-1405736]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1405760]Purge Criteria 
          
  
         	 
           
           [bookmark: pgfId-1405762]How to Configure 
          
  
        
 
         
         	[bookmark: pgfId-1405764]Age of statistical data
  
         	[bookmark: pgfId-1405766] 1. Check Data older than.
 [bookmark: pgfId-1405767] 2. From the first drop-down list, choose the number of days, weeks, or months.
 [bookmark: pgfId-1405768] 3. From the second drop-down list, choose Days, Weeks, or Months, as needed.
  
        
 
         
         	[bookmark: pgfId-1405770]Number of statistical data entries in the database
  
         	[bookmark: pgfId-1405772] 1. Check Stats. Entries Exceed(0-2147483647).
 [bookmark: pgfId-1405773] 2. In the box, enter the maximum number of entries that you want to allow in the statistical database.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1405694]Step 3 Configure the action that you want DCNM-LAN to take on statistical database entries that meet the purge criteria. You can choose one of the following:
 
      
       
       	 [bookmark: pgfId-1378626] Delete —DCNM-LAN deletes the database entries that meet the purge criteria.
 
       	 [bookmark: pgfId-1378650] Consolidate —DCNM-LAN merges all statistical data entries that meet the purge criteria into one entry
 
      
 
     
 
     [bookmark: pgfId-1378618]Step 4 Under Auto Purge Settings, follow these steps to configure when you want automatic purging to occur:
 
     [bookmark: pgfId-1375781] a. Check the days-of-the-week check boxes to specify which days of the week that you want automatic purging to occur.
 
     [bookmark: pgfId-1375782] b. Use the Run at box to configure the exact time on the specified days that you want automatic statistical data purging to occur.
 
     [bookmark: pgfId-1375783]Step 5 (Optional) If you want to enable automatic statistical data purging, check Enable Auto Purge.
 
     [bookmark: pgfId-1375784]Step 6 From the menu bar, choose File > Deploy to save your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1375785]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1411960]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1411964]Deleting Data from the Statistics Database
 
      	 [bookmark: pgfId-1411968]Enabling and Disabling Automatic Statistical Data Purging
 
      	 [bookmark: pgfId-1411972]Purging Statistical Data Now
 
     
 
    
 
     
      [bookmark: pgfId-1375800][bookmark: 39920]Purging Statistical Data Now[bookmark: marker-1382087]
 
     [bookmark: pgfId-1375801]You can purge statistical data on demand, using the automatic statistical data purge settings to determine which statistical data are purged.
 
      
       
     
 
     
 
     [bookmark: pgfId-1375804]Tip If you want to delete statistical data on demand, based on the exact age of the statistical data entries, see the “Deleting Data from the Statistics Database” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1375806]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1375807]Ensure that the automatic statistical data purge settings are configured as needed. For more information, see the “Configuring Automatic Statistical Data Purge Settings” section.
 
    
 
     
      [bookmark: pgfId-1375811]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1375813]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
     [bookmark: pgfId-1375814]The Statistical Database Administration tab appears in the Details pane, below the table of statistical data collectors.
 
     [bookmark: pgfId-1375815]Step 2 Under Purge, click Purge Now.
 
     [bookmark: pgfId-1375816]DCNM-LAN deletes statistical data, using the automatic statistical data purge settings to determine which statistical data entries to purge.
 
     [bookmark: pgfId-1375817]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1411977]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1411981]Deleting Data from the Statistics Database
 
      	 [bookmark: pgfId-1411985]Enabling and Disabling Automatic Statistical Data Purging
 
      	 [bookmark: pgfId-1411989]Configuring Automatic Statistical Data Purge Settings
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1375706][bookmark: 25460]Viewing the Status of Statistical Data Collectors
 
    [bookmark: pgfId-1373646]To view the status of statistical data collectors, from the Feature Selector pane, choose DCNM Server Administration > Statistical Data Collection.
 
    [bookmark: pgfId-1373647]Collector status and other information appear in the Statistical Data Collectors area in the Contents pane. For information about the fields that appear, see the “Field Descriptions for Statistical Data Collection” section.
 
   
 
    
     [bookmark: pgfId-1400987][bookmark: 73958]Field Descriptions for Statistical Data Collection
 
    [bookmark: pgfId-1400988]This section includes the following field descriptions for the Statistical Data Collection feature:
 
     
     	 [bookmark: pgfId-1400992]Summary Pane
 
     	 [bookmark: pgfId-1400996]Statistical Database Administration Tab
 
    
 
     
      [bookmark: pgfId-1400998][bookmark: 76150]Summary Pane
 
     [bookmark: pgfId-1401053]
 
      
       
        
        [bookmark: pgfId-1401004]Table 30-2 Summary Pane 
 
        
        
         
         	 
           
           [bookmark: pgfId-1401008]Field 
          
  
         	 
           
           [bookmark: pgfId-1401010]Description 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1401012]Statistical Data Collectors 
          
  
        
 
         
         	[bookmark: pgfId-1401016]Last Refresh Time
  
         	[bookmark: pgfId-1401018]Display only. Date and time that the DCNM-LAN client updated information shown on the Content pane.
  
        
 
         
         	[bookmark: pgfId-1401020]Collector ID
  
         	[bookmark: pgfId-1401022]Display only. Name and IP address of the device for the corresponding poller.
  
        
 
         
         	[bookmark: pgfId-1401024]Owner
  
         	[bookmark: pgfId-1401026]Display only. Username of the DCNM-LAN user who started monitoring for the chart that corresponds to the collection.
  
        
 
         
         	[bookmark: pgfId-1401028]Device
  
         	[bookmark: pgfId-1401030]Display only. Name and IP address of the device that is providing the statistical data in the collection.
  
        
 
         
         	[bookmark: pgfId-1401032]Objects
  
         	[bookmark: pgfId-1401034]Display only. Description of the entity on the device that is providing the statistical data in the collection.
 [bookmark: pgfId-1401035]For example, if the collection has statistical data for a rule that is assigned the sequence number 10 and is in an IPv4 ACL named acl-01, this field displays acl-01,seqNo=10. 
 [bookmark: pgfId-1401036]If the collection has data for the Ethernet 1/5 port, this field displays Ethernet1/5.
  
        
 
         
         	[bookmark: pgfId-1401038]Collected Statistics
  
         	[bookmark: pgfId-1401040]Display only. Type of statistical data in the collection. For example, if the collection has statistical data for a rule in an IPv4 ACL, this field displays IpAclAceMatchStatistics.
  
        
 
         
         	[bookmark: pgfId-1401042]Status
  
         	[bookmark: pgfId-1401044]Display only. Whether the collector is started or stopped.
  
        
 
         
         	 
           
           [bookmark: pgfId-1401046]Statistics Database 
          
  
        
 
         
         	[bookmark: pgfId-1401050]Delete statistical data older than
  
         	[bookmark: pgfId-1401052]Date and time of the newest statistical data to be deleted from the statistics database. There is no default value for this field.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1401055][bookmark: 16609]Statistical Database Administration Tab
 
     [bookmark: pgfId-1401108]
 
      
       
        
        [bookmark: pgfId-1401061]Table 30-3 Statistical Database Administration Tab 
 
        
        
         
         	 
           
           [bookmark: pgfId-1401065]Field 
          
  
         	 
           
           [bookmark: pgfId-1401067]Description 
          
  
        
 
         
         	[bookmark: pgfId-1401069]Delete statistical data older than
  
         	[bookmark: pgfId-1401071]Date and time of the newest statistical data to be deleted from the statistics database. There is no default value for this field.
  
        
 
         
         	 
           
           [bookmark: pgfId-1401073]Purge 
          
  
        
 
         
         	[bookmark: pgfId-1401077]Action
  
         	[bookmark: pgfId-1401079]Whether automatic statistical data purging deletes or consolidates statistical data entries that trigger the purge threshold. Consolidation merges all statistical data entries that trigger the purge threshold into one entry.
  
        
 
         
         	 
           
           [bookmark: pgfId-1401081]Purge Threshold 
          
  
        
 
         
         	[bookmark: pgfId-1401085]Data older than
  
         	[bookmark: pgfId-1401087]Whether, during automatic statistical data purging, DCNM-LAN deletes statistics entries that are older than the age specified in the drop-down lists located to the right of this check box. By default, this check box is unchecked. If you check the check box, the default age is 1 day.
  
        
 
         
         	[bookmark: pgfId-1401089]Stat. Entries Exceed
  
         	[bookmark: pgfId-1401091]Whether, during automatic statistical data purging, DCNM-LAN deletes the oldest statistics entries until the number of entries equals the number in the box located to the right of this check box. By default, this check box is unchecked. If you check the check box, the default number of event is 25,000.
  
        
 
         
         	 
           
           [bookmark: pgfId-1401093]Auto Purge Settings 
          
  
        
 
         
         	[bookmark: pgfId-1401097]Enable Auto Purge
  
         	[bookmark: pgfId-1401099]Whether automatic purging of statistical data is enabled. By default, this check box is disabled.
  
        
 
         
         	[bookmark: pgfId-1401101]Run on
  
         	[bookmark: pgfId-1401103]Days of the week that automatic purging of statistical data occurs. By default, none of the check boxes are checked. If you check the Daily check box, the check boxes for the individual days of the week become unavailable.
  
        
 
         
         	[bookmark: pgfId-1401105]Run at
  
         	[bookmark: pgfId-1401107]Time of day that automatic purging of statistical data occurs, on the days of the week that automatic purging is enabled.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1401110][bookmark: 44962]Additional References
 
    [bookmark: pgfId-1401111]For additional information related to administering statistical data collection, see the following sections:
 
     
     	 [bookmark: pgfId-1401115]Related Documents
 
     	 [bookmark: pgfId-1401119]Standards
 
    
 
     
      [bookmark: pgfId-1401121][bookmark: 18088]Related Documents
 
     [bookmark: pgfId-1401134]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1401124]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1401126]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1401128]Device discovery
  
         	[bookmark: pgfId-1401133]Chapter 27, “Administering Device Discovery”
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1401136][bookmark: 86472]Standards
 
     [bookmark: pgfId-1401146]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1401139]Standards 
          
  
         	 
           
           [bookmark: pgfId-1401141]Title 
          
  
        
 
         
         	[bookmark: pgfId-1401143]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1401145]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1401148][bookmark: 92503]Feature History for Statistical Data Collection
 
    [bookmark: pgfId-1401152]Table 30-4 lists the release history for this feature.
 
    [bookmark: pgfId-1401176]
 
     
      
       
       [bookmark: pgfId-1401159]Table 30-4 [bookmark: 50557]Feature History for Statistical Data Collection 
 
       
       
        
        	 
          
          [bookmark: pgfId-1401165]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1401167]Releases 
         
  
        	 
          
          [bookmark: pgfId-1401169]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1401171]Statistical Data Collection
  
        	[bookmark: pgfId-1401173]5.0(2)
  
        	[bookmark: pgfId-1401327]No change from Release 4.2.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1261750][bookmark: 69237]Working With Threshold Rules 
      
      
 
     
 
 
    [bookmark: pgfId-1310510]This chapter describes how to configure threshold rules using Cisco Data Center Network Manager for LAN (DCNM-LAN).
 
    [bookmark: pgfId-1313892]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1313896]Information About Threshold Rules
 
     	 [bookmark: pgfId-1314556]Licensing Requirements for Threshold Rules
 
     	 [bookmark: pgfId-1313900]Configuring Threshold Rules
 
     	 [bookmark: pgfId-1314423]Additional References
 
     	 [bookmark: pgfId-1314440]Feature History for Threshold Rules
 
    
 
   
 
    
     [bookmark: pgfId-1313902][bookmark: 90862]Information About Threshold Rules
 
    [bookmark: pgfId-1313903]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1313907]Threshold Rules Overview
 
     	 [bookmark: pgfId-1313911]Threshold Rule Examples
 
    
 
     
      [bookmark: pgfId-1313913][bookmark: 22366]Threshold Rules Overview
 
     [bookmark: pgfId-1313914]DCNM-LAN provides a feature that you use to specify rising or falling threshold rules for sample variables in collected statistical data. Depending on the rule definition, a set of actions are performed by DCNM-LAN. You define the threshold rule on the Threshold Rules page, and you apply the threshold rule to the existing chart.
 
     [bookmark: pgfId-1313915]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1313919]Rising Threshold
 
      	 [bookmark: pgfId-1313923]Falling Threshold
 
      	 [bookmark: pgfId-1313927]Threshold Rule Properties
 
      	 [bookmark: pgfId-1313931]Threshold Rule Actions
 
     
 
    
 
     
      [bookmark: pgfId-1313936][bookmark: 27456]Rising Threshold
 
     [bookmark: pgfId-1313937]The rising threshold is the upper threshold for a sample variable. When the current sampled variable is greater than or equal to the specified threshold, a set of actions is performed.
 
    
 
     
      [bookmark: pgfId-1313939][bookmark: 39178]Falling Threshold
 
     [bookmark: pgfId-1313940]The falling threshold is the lower threshold for a sample variable. When the current sampled variable is lower than or equal to the specified threshold a set of actions is performed.
 
      
       
     
 
     
 
     [bookmark: pgfId-1313941]Note You can specify only one rising threshold and one falling threshold for a single sampled variable.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1313943][bookmark: 44043]Threshold Rule Properties
 
     [bookmark: pgfId-1313944]Threshold rule properties are as follows:
 
      
      	 [bookmark: pgfId-1313945]Name—Specifies the threshold rule name.
 
      	 [bookmark: pgfId-1313946]Frequency—Specifies the number of times the sampled variable must cross a threshold before triggering any actions.
 
      	 [bookmark: pgfId-1313947]Period—Specifies the interval of time the frequency is monitored.
 
      	 [bookmark: pgfId-1313948]Repeat—Prevents the timer from resetting after triggering an action within the period.
 
      	 [bookmark: pgfId-1313949]Trend—Specifies the rising or falling threshold.
 
     
 
    
 
     
      [bookmark: pgfId-1313951][bookmark: 78682]Threshold Rule Actions
 
     [bookmark: pgfId-1313952]Threshold rule actions are as follows:
 
      
      	 [bookmark: pgfId-1313953]Send an email or SMS to a mail server or mail to SMS gateway.
 
      	 [bookmark: pgfId-1313954]Run a script on the server.
 
      	 [bookmark: pgfId-1313955]Send an event to the current DCNM JMS channel.
 
     
 
    
 
     
      [bookmark: pgfId-1313957][bookmark: 86701]Threshold Rule Examples
 
      
       
     
 
     
 
     [bookmark: pgfId-1313958]Note The granularity of a period is driven by the minimal interval of the collected data. Consequently, the period must be higher than that interval.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1313959]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1313963]Triggering an Action Each Time a Threshold is Crossed
 
      	 [bookmark: pgfId-1313967]Triggering an Action Only Once in a Period When a Threshold is Crossed
 
      	 [bookmark: pgfId-1313971]Triggering an Action Every Fourth Period When a Threshold is Crossed
 
     
 
    
 
     
      [bookmark: pgfId-1313973][bookmark: 78503]Triggering an Action Each Time a Threshold is Crossed
 
     [bookmark: pgfId-1313974]To trigger an action each time a threshold is crossed, set properties as follows:
 
      
      	 [bookmark: pgfId-1313975]Frequency— 1 
 
      	 [bookmark: pgfId-1313976]Repeat— Yes 
 
     
 
     [bookmark: pgfId-1313980]Figure 31-1 shows the trigger action when you set rule properties to the preceding values.
 
     [bookmark: pgfId-1313982]Figure 31-1 [bookmark: 18959]Trigger an Action Each Time a Threshold is Crossed
 
     [bookmark: pgfId-1313986]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1313987]If the sampled variable crosses the threshold, an action is taken the first time it crosses the threshold. As a result, an action is performed each time the threshold is crossed.
 
    
 
     
      [bookmark: pgfId-1313989][bookmark: 49587]Triggering an Action Only Once in a Period When a Threshold is Crossed
 
     [bookmark: pgfId-1313990]To trigger an action only once in a period when a threshold is crossed, set properties as follows:
 
      
      	 [bookmark: pgfId-1313991]Frequency— 1 
 
      	 [bookmark: pgfId-1313992]Period— 300 
 
      	 [bookmark: pgfId-1313993]Repeat— No 
 
     
 
     [bookmark: pgfId-1313997]Figure 31-2 shows the trigger action when you set rule properties to the preceding values.
 
     [bookmark: pgfId-1313999]Figure 31-2 [bookmark: 42359]Trigger an Action Only Once When a Threshold is Crossed Within a Period
 
     [bookmark: pgfId-1314003]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1314004]If the sampled variable crosses the threshold, an action is taken the first time it crosses the threshold. For the remaining 5 minutes, an action will not be taken. As a result, an action is performed only once during the specified period.
 
    
 
     
      [bookmark: pgfId-1314006][bookmark: 74853]Triggering an Action Every Fourth Period When a Threshold is Crossed
 
     [bookmark: pgfId-1314007]To trigger an action every fourth period when a threshold is crossed, set properties as follows:
 
      
      	 [bookmark: pgfId-1314008]Frequency— 4 
 
      	 [bookmark: pgfId-1314009]Period— 300 
 
      	 [bookmark: pgfId-1314010]Repeat— No 
 
     
 
     [bookmark: pgfId-1314014]Figure 31-3 shows the trigger action when you set rule properties to the preceding values.
 
     [bookmark: pgfId-1314016]Figure 31-3 [bookmark: 26830]Trigger an Action Every Fourth Period When a Threshold is Crossed
 
     [bookmark: pgfId-1314020]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1314021]If the sampled variable crosses the threshold, an action is taken the fourth time it crosses the threshold. For the remaining 5 minutes, an action is not taken. As a result, an action is performed only once during the specified period.
 
    
 
   
 
    
     [bookmark: pgfId-1314474][bookmark: 30587]Licensing Requirements for Threshold Rules
 
    [bookmark: pgfId-1314475]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1314492]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1314478]Product 
         
  
        	 
          
          [bookmark: pgfId-1314480]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1314482]Cisco DCNM-LAN
  
        	[bookmark: pgfId-1314484]Threshold rules require no license.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1313490][bookmark: 73151]Configuring Threshold Rules
 
    [bookmark: pgfId-1313491]You can create and apply threshold rules using the Threshold Rules feature. With this feature, you can create, delete, edit, view, and apply a rule to a chart.
 
    [bookmark: pgfId-1313548]The following sections provide more details about the feature.
 
     
     	 [bookmark: pgfId-1318384]Creating Threshold Rules
 
     	 [bookmark: pgfId-1318385]Deleting Threshold Rules
 
     	 [bookmark: pgfId-1318386]Editing Threshold Rules
 
     	 [bookmark: pgfId-1318387]Viewing Threshold Rules
 
     	 [bookmark: pgfId-1318388]Applying a Threshold Rule to a Chart
 
    
 
    [bookmark: pgfId-1314039]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1314043]Creating Threshold Rules
 
     	 [bookmark: pgfId-1314047]Deleting Threshold Rules
 
     	 [bookmark: pgfId-1314051]Editing Threshold Rules
 
     	 [bookmark: pgfId-1314055]Viewing Threshold Rules
 
     	 [bookmark: pgfId-1314059]Applying a Threshold Rule to a Chart
 
    
 
     
      [bookmark: pgfId-1303890][bookmark: 34837]Creating Threshold Rules
 
     [bookmark: pgfId-1310935]You can create threshold rules using DCNM-LAN.
 
    
 
     
      [bookmark: pgfId-1305862]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1309635]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Threshold Rules.
 
     [bookmark: pgfId-1303304]Step 2 From the toolbar, choose New, and then choose New Threshold Rule.
 
     [bookmark: pgfId-1305843]The Details and Threshold Bindings tabs appear in the Details pane, with the Details tab open.
 
     [bookmark: pgfId-1303672]Step 3 Create a threshold rule as follows:
 
     [bookmark: pgfId-1309640] a. In the Name field, enter a name.
 
     [bookmark: pgfId-1305976] b. In the Description field, enter a description of the threshold rule.
 
     [bookmark: pgfId-1305987]After you have enter a description, the Rising Threshold check box is automatically checked and the Threshold field in the Settings area is outlined in red.
 
      
       
     
 
     
 
     [bookmark: pgfId-1306028]Note A field outlined in red indicates that an entry is required. A field outlined in yellow indicates that the entry is satisfactory.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1305977] c. In the Settings area, enter a value in the Threshold field.
 
     [bookmark: pgfId-1306049]Once you have entered a value, the three options in the Action area are outlined in red. 
 
     [bookmark: pgfId-1311184] d. In the Action area, provide one of the following:
 
     [bookmark: pgfId-1311288] – Enter email addresses (delimited with commas)
 
     [bookmark: pgfId-1311306] – Select Sent Event to forward events to the DCNM-LAN Event Browser
 
     [bookmark: pgfId-1311328] – Enter a script name
 
     [bookmark: pgfId-1311216]The script receives all data regarding the crossed threshold. The script can be written in any programming language and saved in one of the directories of the system PATH.
 
     [bookmark: pgfId-1314744]Table 31-1 describes the available parameters.
 
     [bookmark: pgfId-1314753]
 
      
       
        
        [bookmark: pgfId-1314781]Table 31-1 [bookmark: 61150]Parameters Passed to Script
 
        
        
         
         	 
           
           [bookmark: pgfId-1314785]Parameter 
          
  
         	 
           
           [bookmark: pgfId-1314787]Description 
          
  
        
 
         
         	[bookmark: pgfId-1314861]$1
  
         	[bookmark: pgfId-1314791]Device name
  
        
 
         
         	[bookmark: pgfId-1314885]$2
  
         	[bookmark: pgfId-1314795]Threshold name
  
        
 
         
         	[bookmark: pgfId-1314892]$3
  
         	[bookmark: pgfId-1314799]Timestamp
  
        
 
         
         	[bookmark: pgfId-1314896]$4
  
         	[bookmark: pgfId-1314803]Severity
  
        
 
         
         	[bookmark: pgfId-1315410]$5
  
         	[bookmark: pgfId-1315412]Monitored metric that is a counter or a non-counter.
 
           
           	 [bookmark: pgfId-1315413]When used as a counter, it represents a rate in metric units /second.
 
           	 [bookmark: pgfId-1315414]When used as a non-counter, it represents an absolute in metric units.
 
          
  
        
 
         
         	[bookmark: pgfId-1314904]$6
  
         	[bookmark: pgfId-1314811]Threshold for the monitored metric that is a counter or a non-counter.
 
           
           	 [bookmark: pgfId-1315547]When used as a counter, it represents a rate in metric units /second.
 
           	 [bookmark: pgfId-1315548]When used as a non-counter, it represents an absolute in metric units.
 
          
  
        
 
         
         	[bookmark: pgfId-1314914]$7
  
         	[bookmark: pgfId-1314815]Trend type 
 [bookmark: pgfId-1315482]The possible values are:
 
           
           	 [bookmark: pgfId-1315599] rate 
 
          
 [bookmark: pgfId-1315622]which is a counter. 
 
           
           	 [bookmark: pgfId-1315605] absolute 
 
          
 [bookmark: pgfId-1315630]which is a non-counter
  
        
 
         
         	[bookmark: pgfId-1314927]$8
  
         	[bookmark: pgfId-1314819]Threshold type
 [bookmark: pgfId-1315486]The possible values are:
 
           
           	 [bookmark: pgfId-1315634] rising 
 
           	 [bookmark: pgfId-1315639] falling 
 
          
  
        
 
         
         	[bookmark: pgfId-1314943]$9
  
         	[bookmark: pgfId-1314823]Statistic class
  
        
 
         
         	[bookmark: pgfId-1314957]$10
  
         	[bookmark: pgfId-1314827]Statistic variable
  
        
 
         
         	[bookmark: pgfId-1314969]$11
  
         	[bookmark: pgfId-1314831]Source object
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1311185]Note Ensure that the DCNM-LAN server is configured for an SMTP server. For more information about configuring the DCNM-LAN server, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1311186] e. (Optional) In the corresponding Settings and Action areas, configure a Falling Threshold.
 
     [bookmark: pgfId-1306220] f. (Optional) Click the Threshold Bindings tab to view bindings.
 
     [bookmark: pgfId-1306054] g. Click Deploy.
 
     [bookmark: pgfId-1306316]The rule is deployed.
 
     [bookmark: pgfId-1306288]When you exit DCNM-LAN and Save Pending Changes is checked in the Warning dialog box, click Yes to save the rule.
 
     [bookmark: pgfId-1310675]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1303015][bookmark: 33168]Deleting Threshold Rules
 
     [bookmark: pgfId-1310948]You can delete rules using DCNM-LAN.
 
    
 
     
      [bookmark: pgfId-1304633]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1309650]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Threshold Rules.
 
     [bookmark: pgfId-1306299]The rules appear in the Summary pane.
 
     [bookmark: pgfId-1303979]Step 2 From the Summary pane, right-click the appropriate rule.
 
     [bookmark: pgfId-1306309]Step 3 From the drop-down list, choose Delete Threshold Rule.
 
     [bookmark: pgfId-1305942]A warning dialog box appears and displays “Are you sure you want to delete?”
 
     [bookmark: pgfId-1304330]Step 4 Click Yes.
 
     [bookmark: pgfId-1305950]The rule is deleted.
 
     [bookmark: pgfId-1303984]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1303030][bookmark: 23608]Editing Threshold Rules
 
     [bookmark: pgfId-1310959]You can view threshold rules using DCNM-LAN.
 
    
 
     
      [bookmark: pgfId-1304691]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1309655]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Threshold Rules.
 
     [bookmark: pgfId-1306322]The rules appear in the Summary pane.
 
     [bookmark: pgfId-1306072]Step 2 Edit any appropriate areas.
 
      
       
     
 
     
 
     [bookmark: pgfId-1306069]Note You cannot edit the Name field.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1304734]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1303032][bookmark: 36438]Viewing Threshold Rules
 
     [bookmark: pgfId-1310971]You can view threshold rules using DCNM-LAN.
 
    
 
     
      [bookmark: pgfId-1304749]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1309660]Step 1 From the Feature Selector pane, choose DCNM Server Administration > Threshold Rules.
 
     [bookmark: pgfId-1306331]The rules appear in the Summary pane.
 
     [bookmark: pgfId-1306086]Step 2 Click on a rule to view it.
 
     [bookmark: pgfId-1304754]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1308556][bookmark: 61883]Applying a Threshold Rule to a Chart
 
     [bookmark: pgfId-1310978]You can apply threshold rules using DCNM-LAN.
 
    
 
     
      [bookmark: pgfId-1308564]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1308565]Step 1 From the Feature Selector pane, choose the appropriate feature. For example, if you wanted to see statistics for an Ethernet port, choose Interfaces > Physical > Ethernet.
 
     [bookmark: pgfId-1308566]The available devices appear in the Summary pane.
 
     [bookmark: pgfId-1308567]Step 2 From the Summary pane, choose the appropriate device.
 
     [bookmark: pgfId-1308568]Step 3 Click the Statistics tab.
 
     [bookmark: pgfId-1308569]Step 4 In the toolbar, click New Chart and then from the drop-down list choose the chart that you want to view. For example, if you wanted to see statistics for traffic, choose Traffic Statistics Chart.
 
     [bookmark: pgfId-1308613]Step 5 In the chart toolbar, click Launch Threshold Setting.
 
     [bookmark: pgfId-1308614]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1314263][bookmark: 18066]Additional References
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1314277]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1314279]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1314281]Events
  
        	[bookmark: pgfId-1314285]System Management Configuration Guide, Cisco DCNM for LAN, Release 7.1.x
  
       
 
        
        	[bookmark: pgfId-1314288]Statistical Data Collection
  
        	[bookmark: pgfId-1314293]Chapter 30, “Administering Statistical Data Collection”
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1314296][bookmark: 55398]Standards
 
    [bookmark: pgfId-1314306]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1314299]Standards 
         
  
        	 
          
          [bookmark: pgfId-1314301]Title 
         
  
       
 
        
        	[bookmark: pgfId-1314303]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
        	[bookmark: pgfId-1314305]—
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1314308][bookmark: 92503]Feature History for Threshold Rules
 
     
      
       
       [bookmark: pgfId-1314319]Table 31-2 [bookmark: 50557]Feature History for Threshold Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1314325]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1314327]Releases 
         
  
        	 
          
          [bookmark: pgfId-1314329]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1314331]Threshold Rules
  
        	[bookmark: pgfId-1314333]5.2(0)
  
        	[bookmark: pgfId-1314402]—
  
       
 
       
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1208646][bookmark: 29032]Administering [bookmark: marker-1173986]DCNM-LAN Server Log Settings 
      
      
 
     
 
 
    [bookmark: pgfId-1390745]This chapter describes how to administer the DCNM-LAN Server Log Settings feature in Cisco Data Center Network Manager for LAN (DCNM-LAN).
 
    [bookmark: pgfId-1398301]The Cisco DCNM server maintains a log file of its operations. The log file contains information from Cisco DCNM features and server components.
 
     
      
    
 
    
 
    [bookmark: pgfId-1398302]Note The DCNM Server Log Settings feature does not affect logging levels of Cisco NX-OS devices. Cisco DCNM does not support the configuration of device logging levels.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1390750]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1390754]Information About Administering DCNM-LAN Server Log Settings
 
     	 [bookmark: pgfId-1390758]Licensing Requirements for Administering DCNM-LAN Server Log Settings
 
     	 [bookmark: pgfId-1390762]Prerequisites for Administering DCNM-LAN Server Log Settings
 
     	 [bookmark: pgfId-1390766]Guidelines and Limitations for Administering DCNM-LAN Server Log Settings
 
     	 [bookmark: pgfId-1390770]Configuring DCNM-LAN Server Log Settings
 
     	 [bookmark: pgfId-1390774]Viewing DCNM-LAN Server Log Settings
 
     	 [bookmark: pgfId-1390778]Field Descriptions for DCNM-LAN Server Log Settings
 
     	 [bookmark: pgfId-1390782]Additional References
 
     	 [bookmark: pgfId-1390786]Feature History for DCNM-LAN Server Log Settings
 
    
 
   
 
    
     [bookmark: pgfId-1390788][bookmark: 44768]Information About Administering DCNM-LAN Server Log Settings
 
    [bookmark: pgfId-1390789]The DCNM-LAN server maintains a log file of its operations. The log file contains information from DCNM-LAN features and server components.
 
     
      
    
 
    
 
    [bookmark: pgfId-1390790]Note The DCNM-LAN Server Log Settings feature does not affect logging levels of Cisco NX-OS devices. DCNM-LAN does not support the configuration of device logging levels.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1390791]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1390795]Logging Levels
 
     	 [bookmark: pgfId-1390799]Log File and Location
 
     	 [bookmark: pgfId-1390803]Virtualization Support
 
    
 
     
      [bookmark: pgfId-1390805][bookmark: 54944]Logging Levels
 
     [bookmark: pgfId-1390806]The DCNM-LAN server supports a hierarchy of logging levels, ordered by the severity of log messages. Each level includes messages for that level in addition to all log messages from levels of higher severity. The logging levels, in order from the highest to the lowest severity, are as follows:
 
      
      	 [bookmark: pgfId-1390807]Fatal Errors
 
      	 [bookmark: pgfId-1390808]Errors
 
      	 [bookmark: pgfId-1390809]Warnings
 
      	 [bookmark: pgfId-1390810]Information
 
      	 [bookmark: pgfId-1390811]Debugging
 
      	 [bookmark: pgfId-1390812]Verbose
 
     
 
    
 
     
      [bookmark: pgfId-1390814][bookmark: 64946]Log File and Location
 
     [bookmark: pgfId-1390815]The DCNM-LAN server writes server log messages to the sys.pipe file at the following location:
 
      
      [bookmark: pgfId-1390816]INSTALL_DIR\log 
     
 
      
      [bookmark: pgfId-1390817] 
     
 
     [bookmark: pgfId-1390818]By default, when you install the DCNM-LAN server on Microsoft Windows Server, INSTALL_DIR is C:\Program Files\Cisco Systems\dcnm.
 
     [bookmark: pgfId-1398307]What would the default installation directory be for a Linux installation?
 
    
 
     
      [bookmark: pgfId-1390821][bookmark: 31297]Virtualization Support
 
     [bookmark: pgfId-1390822]DCNM-LAN server logs do not contain log messages from Cisco NX-OS devices; therefore, this feature has no effect on virtualization support.
 
    
 
   
 
    
     [bookmark: pgfId-1390824][bookmark: 91360]Licensing Requirements for Administering DCNM-LAN Server Log Settings
 
    [bookmark: pgfId-1390825]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1390838]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1390828]Product 
         
  
        	 
          
          [bookmark: pgfId-1390830]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1390832]Cisco DCNM-LAN
  
        	[bookmark: pgfId-1390834]DCNM-LAN Server Log Settings requires no license. Any feature not included in a license package is bundled with the Cisco DCNM-LAN and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1390840][bookmark: 78364]Prerequisites for Administering DCNM-LAN Server Log Settings
 
    [bookmark: pgfId-1390841]Administering DCNM-LAN server log settings has the following prerequisites:
 
     
     	 [bookmark: pgfId-1390842]You should be familiar with a DCNM-LAN feature before you configure server log settings for it.
 
    
 
   
 
    
     [bookmark: pgfId-1390844][bookmark: 48799]Guidelines and Limitations for Administering DCNM-LAN Server Log Settings
 
    [bookmark: pgfId-1390845]The Administering DCNM-LAN server log settings feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1390846]Setting a logging level to a lower severity results in more messages in the log file.
 
     	 [bookmark: pgfId-1390847]We recommend using the default logging settings unless you are troubleshooting an issue.
 
     	 [bookmark: pgfId-1390848]When you are troubleshooting an issue, consider lowering the logging level severity of the affected feature or server component.
 
     	 [bookmark: pgfId-1390849]After you resolve an issue, consider restoring the logging level of the affected feature or server component to a higher severity.
 
    
 
   
 
    
     [bookmark: pgfId-1390851][bookmark: 47388]Configuring DCNM-LAN Server Log Settings
 
    [bookmark: pgfId-1390852]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1390856]Configuring the Default Logging Level
 
     	 [bookmark: pgfId-1390860]Configuring a Unique Logging Level for a Feature or Server Component
 
     	 [bookmark: pgfId-1390864]Configuring a Feature or Server Component to Use the Default Logging Level
 
    
 
     
      [bookmark: pgfId-1054494][bookmark: 69103]Configuring the Default Logging Level[bookmark: marker-1173987]
 
     [bookmark: pgfId-1054496]You can configure the default logging level for all DCNM-LAN features and server components.
 
    
 
     
      [bookmark: pgfId-1054497]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1054498]Determine what the default logging level should be. For more information, see the “Logging Levels” section.
 
    
 
     
      [bookmark: pgfId-1054499]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1076344]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Server Log Settings. 
 
     [bookmark: pgfId-1076345]The log settings appear in the Contents pane.
 
     [bookmark: pgfId-1076346]Step 2 From the Default Logging Level drop-down list, choose the logging level.
 
     [bookmark: pgfId-1076351]Step 3 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1076352]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1398312]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1398316]Configuring a Unique Logging Level for a Feature or Server Component
 
      	 [bookmark: pgfId-1398320]Configuring a Feature or Server Component to Use the Default Logging Level
 
     
 
    
 
     
      [bookmark: pgfId-1174001][bookmark: 90966]Configuring a Unique Logging Level for a Feature or Server Component
 
     [bookmark: pgfId-1174002]You can configure a logging level of a feature or server component that is independent of the default logging level.
 
    
 
     
      [bookmark: pgfId-1059732]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1077713]Determine what the logging level of the feature or service should be. For more information, see the “Logging Levels” section.
 
    
 
     
      [bookmark: pgfId-1059734]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1077753]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Server Log Settings. 
 
     [bookmark: pgfId-1077754]The log settings appear in the Contents pane.
 
     [bookmark: pgfId-1079964]Step 2 Find the feature or server component that you want to configure with a unique logging level.
 
     [bookmark: pgfId-1079965]Step 3 Uncheck Default to the right of the feature or server component.
 
     [bookmark: pgfId-1079966]The logging level drop-down list for the feature or server component becomes available.
 
     [bookmark: pgfId-1077790]Step 4 From the logging level drop-down list, choose the logging level. For more information, see the “Logging Levels” section.
 
     [bookmark: pgfId-1077756]Step 5 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1077757]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1398325]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1398329]Configuring the Default Logging Level
 
      	 [bookmark: pgfId-1398333]Configuring a Feature or Server Component to Use the Default Logging Level
 
     
 
    
 
     
      [bookmark: pgfId-1054512][bookmark: 33111]Configuring a Feature or Server Component to Use the Default Logging Level
 
     [bookmark: pgfId-1077818]You can configure a feature or server component to use the default logging level.
 
    
 
     
      [bookmark: pgfId-1077819]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1077820]Ensure that the default logging level is appropriate for the feature or service. For more information, see the “Logging Levels” section.
 
    
 
     
      [bookmark: pgfId-1077824]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1077826]Step 1 From the Feature Selector pane, choose DCNM Server Administration > DCNM Server Log Settings. 
 
     [bookmark: pgfId-1077827]The log settings appear in the Contents pane.
 
     [bookmark: pgfId-1077828]Step 2 Find the feature or server component that you want to use the default logging level.
 
     [bookmark: pgfId-1077829]Step 3 Check Default to the right of the feature or service.
 
     [bookmark: pgfId-1077830]The logging level drop-down list for the feature or server component becomes unavailable.
 
     [bookmark: pgfId-1077835]Step 4 From the menu bar, choose File > Deploy to apply your changes to the DCNM-LAN server.
 
     [bookmark: pgfId-1077836]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1398338]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1398342]Configuring the Default Logging Level
 
      	 [bookmark: pgfId-1398346]Configuring a Unique Logging Level for a Feature or Server Component
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1077740][bookmark: 24650]Viewing DCNM-LAN Server Log Settings
 
    [bookmark: pgfId-1062401]To view DCNM-LAN server user accounts, from the Feature Selector pane, choose DCNM Server Administration > DCNM Server Log Settings.
 
    [bookmark: pgfId-1062402]The default logging level, feature logging settings, and server component logging settings appear in the Contents pane. For information about the fields that appear, see the “Field Descriptions for DCNM-LAN Server Log Settings” section.
 
   
 
    
     [bookmark: pgfId-1390910][bookmark: 44408]Field Descriptions for DCNM-LAN Server Log Settings
 
    [bookmark: pgfId-1390911]This section includes the following field descriptions for DCNM-LAN server log settings:
 
     
     	 [bookmark: pgfId-1390915]DCNM-LAN Server Log Settings Contents Pane
 
    
 
     
      [bookmark: pgfId-1390917][bookmark: 73863]DCNM-LAN Server Log Settings Contents Pane
 
     [bookmark: pgfId-1391050]
 
      
       
        
        [bookmark: pgfId-1390923]Table 32-1 DCNM-LAN Server Log Settings Contents Pane 
 
        
        
         
         	 
           
           [bookmark: pgfId-1390927]Field 
          
  
         	 
           
           [bookmark: pgfId-1390929]Description 
          
  
        
 
         
         	[bookmark: pgfId-1390931]Default Logging Level
  
         	[bookmark: pgfId-1390933]Logging level for the features or server components whose Default check box is checked. The default value for this list is Informational. For more information about logging levels, see the “Logging Levels” section. 
  
        
 
         
         	 
           
           [bookmark: pgfId-1390938]DCNM-LAN Features 
          
  
        
 
         
         	[bookmark: pgfId-1390942]Default
  
         	[bookmark: pgfId-1390944]Whether logging for the corresponding feature uses the default logging level or the logging level specified for the feature. When a Default check box is checked, the logging level list for the corresponding feature is unavailable. By default, these check boxes are unchecked.
  
        
 
         
         	[bookmark: pgfId-1390946]AAA
  
         	[bookmark: pgfId-1390948]Logging level for the AAA feature.
  
        
 
         
         	[bookmark: pgfId-1390950]ACL
  
         	[bookmark: pgfId-1390952]Logging level for the access control list feature.
  
        
 
         
         	[bookmark: pgfId-1390954]Dot1X
  
         	[bookmark: pgfId-1390956]Logging level for the 802.1X feature.
  
        
 
         
         	[bookmark: pgfId-1390958]GLBP
  
         	[bookmark: pgfId-1390960]Logging level for the Gateway Load-Balancing Protocol feature.
  
        
 
         
         	[bookmark: pgfId-1390962]Interfaces
  
         	[bookmark: pgfId-1390964]Logging level for the Interfaces feature.
  
        
 
         
         	[bookmark: pgfId-1390966]Key Chain
  
         	[bookmark: pgfId-1390968]Logging level for the keychain management feature.
  
        
 
         
         	[bookmark: pgfId-1390970]Layer 2 Security
  
         	[bookmark: pgfId-1390972]Logging level for the layer 2 security feature, which are as follows:
 
           
           	 [bookmark: pgfId-1390973]Dynamic ARP inspection
 
           	 [bookmark: pgfId-1390974]Port security
 
           	 [bookmark: pgfId-1390975]DHCP snooping
 
           	 [bookmark: pgfId-1390976]IP Source Guard
 
           	 [bookmark: pgfId-1390977]Traffic storm control
 
          
  
        
 
         
         	[bookmark: pgfId-1390979]Object Tracking
  
         	[bookmark: pgfId-1390981]Logging level for the object tracking feature.
  
        
 
         
         	[bookmark: pgfId-1390983]Port Channel
  
         	[bookmark: pgfId-1390985]Logging level for the port security feature.
  
        
 
         
         	[bookmark: pgfId-1390987]SPAN
  
         	[bookmark: pgfId-1390989]Logging level for the SPAN feature.
  
        
 
         
         	[bookmark: pgfId-1390991]Spanning Tree
  
         	[bookmark: pgfId-1390993]Logging level for the STP feature.
  
        
 
         
         	[bookmark: pgfId-1390995]Tunnel
  
         	[bookmark: pgfId-1390997]Logging level for the tunnel interface management feature.
  
        
 
         
         	[bookmark: pgfId-1390999]Virtual Devices
  
         	[bookmark: pgfId-1391001]Logging level for the virtual device context feature.
  
        
 
         
         	[bookmark: pgfId-1391003]VLAN
  
         	[bookmark: pgfId-1391005]Logging level for the VLAN feature.
  
        
 
         
         	[bookmark: pgfId-1391007]FabricExtender
  
         	[bookmark: pgfId-1391009]Logging level for the Fabric Extender feature.
  
        
 
         
         	[bookmark: pgfId-1391011]VPC
  
         	[bookmark: pgfId-1391013]Logging level for the vPC feature.
  
        
 
         
         	[bookmark: pgfId-1391015]HSRP
  
         	[bookmark: pgfId-1391017]Logging level for the HSRP feature.
  
        
 
         
         	[bookmark: pgfId-1391019]DEVICE GROUP
  
         	[bookmark: pgfId-1391021]Logging level for the Device Groups feature.
  
        
 
         
         	 
           
           [bookmark: pgfId-1391023]DCNM-LAN Server Components 
          
  
        
 
         
         	[bookmark: pgfId-1391027]Default
  
         	[bookmark: pgfId-1391029]Whether logging for the corresponding server component uses the default logging level or the logging level specified for the component. When a Default check box is checked, the logging level list for the corresponding component is unavailable. By default, these check boxes are unchecked.
  
        
 
         
         	[bookmark: pgfId-1391031]Event
  
         	[bookmark: pgfId-1391033]Logging level for the event component, which includes messages about how DCNM-LAN processes the system and accounting logs it retrieves from devices and also events generated by DCNM-LAN.
  
        
 
         
         	[bookmark: pgfId-1391035]Statistics Collection
  
         	[bookmark: pgfId-1391037]Logging level for the statistical data collection component.
  
        
 
         
         	[bookmark: pgfId-1391039]Config Archive
  
         	[bookmark: pgfId-1391041]Logging level for the configuration archive component, used by the Configuration Change Management feature.
  
        
 
         
         	[bookmark: pgfId-1391043]Device Connections
  
         	[bookmark: pgfId-1391045]Logging level for the component that connects the DCNM-LAN server to devices.
  
        
 
         
         	[bookmark: pgfId-1391047]Device Discovery
  
         	[bookmark: pgfId-1391049]Logging level for the component that performs device discovery.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1391052][bookmark: 92345]Additional References
 
    [bookmark: pgfId-1391053]For additional information related to administering DCNM-LAN server log settings, see the following sections:
 
     
     	 [bookmark: pgfId-1391057]Standards
 
     	 [bookmark: pgfId-1391061]Standards
 
    
 
     
      [bookmark: pgfId-1391078][bookmark: 26697][bookmark: 16184]Standards
 
     [bookmark: pgfId-1391088]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1391081]Standards 
          
  
         	 
           
           [bookmark: pgfId-1391083]Title 
          
  
        
 
         
         	[bookmark: pgfId-1391085]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1391087]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1391090][bookmark: 92503]Feature History for DCNM-LAN Server Log Settings
 
    [bookmark: pgfId-1391094]Table 32-2 lists the release history for this feature.
 
    [bookmark: pgfId-1391118]
 
     
      
       
       [bookmark: pgfId-1391101]Table 32-2 [bookmark: 50557]Feature History for DCNM-LAN Server Log Settings 
 
       
       
        
        	 
          
          [bookmark: pgfId-1391107]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1391109]Releases 
         
  
        	 
          
          [bookmark: pgfId-1391111]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1391113]Device Groups logging
  
        	[bookmark: pgfId-1391115]5.0(2)
  
        	[bookmark: pgfId-1391117]Support was added for configuring the logging level for the Device Groups feature.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1068256][bookmark: 29826]Managing [bookmark: marker-1068254]Events 
      
      
 
     
 
 
    [bookmark: pgfId-1126300]DCNM allows you to view and manage events that the DCNM server recently received from managed devices or that the DCNM server generated itself. The Event Browser allows you to view recent status events. In addition to listing events, the Event Browser provides a pie chart and a bar chart of events separated by the event severity.
 
    [bookmark: pgfId-1126301]DCNM also displays feature-specific status events on the Events tab that appears in the Details pane for features that can have events.
 
    [bookmark: pgfId-1131787]This chapter describes how to use the Event Browser and feature-specific Events tabs in Cisco Data Center Network Manager (DCNM).
 
    [bookmark: pgfId-1131788]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1131792]Information About Events
 
     	 [bookmark: pgfId-1131796]Licensing Requirements for the Event Browser
 
     	 [bookmark: pgfId-1131800]Prerequisites
 
     	 [bookmark: pgfId-1131804]Guidelines and Limitations for the Event Browser
 
     	 [bookmark: pgfId-1131808]Platform Support
 
     	 [bookmark: pgfId-1131812]Using the Event Browser and Events Tabs
 
     	 [bookmark: pgfId-1131816]Field Descriptions for Events
 
     	 [bookmark: pgfId-1131820]Related Documents
 
     	 [bookmark: pgfId-1131824]Feature History for the Event Browser and Events Tabs
 
    
 
   
 
    
     [bookmark: pgfId-1131826][bookmark: 69949]Information About Events
 
    [bookmark: pgfId-1131827]Cisco DCNM allows you to view and manage recent status events. An event can be either of the following:
 
     
     	 [bookmark: pgfId-1131828]A status-related system message that Cisco DCNM retrieves from managed devices. For more information, see the  Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x .
 
     	 [bookmark: pgfId-1131832]A message generated by the Cisco DCNM server.
 
    
 
    [bookmark: pgfId-1131833]The Cisco DCNM client includes the Event Browser and feature-specific Events tabs that appears in the Details pane for features that can have events. The Event Browser shows all recent status events while a feature-specific Events tab shows recent status events that pertain to the feature. The Cisco DCNM client updates the Event Browser and Events tabs dynamically when it receives new events from the server.
 
    [bookmark: pgfId-1131834]In the Event Browser and on Events tabs, you can change the status of an event, add notes to an event, or delete an event.
 
    [bookmark: pgfId-1131835]In addition, the Event Browser provides a pie chart and a bar chart of events separated by the event severity. You can also delete individual events from the events database.
 
     
      
    
 
    
 
    [bookmark: pgfId-1131836]Note Configuring Cisco DCNM server log settings does not affect logging levels on managed Cisco NX-OS devices.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1131838][bookmark: 29596]Licensing Requirements for the Event Browser
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1131842]Product 
         
  
        	 
          
          [bookmark: pgfId-1131844]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1131846]Cisco DCNM
  
        	[bookmark: pgfId-1131848]The Event Browser requires no license. Any feature not included in a license package is bundled with Cisco DCNM and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
        
        	[bookmark: pgfId-1131853]Cisco NX-OS
  
        	[bookmark: pgfId-1131855]The Event Browser requires no license. Any feature not included in a license package is bundled with the Cisco NX-OS system images and is provided at no extra charge to you. For an explanation of the Cisco NX-OS licensing scheme for your platform, see the licensing guide for your platform.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1131858][bookmark: 16098]Prerequisites
 
    [bookmark: pgfId-1131862]The following prerequisites are required for using the Events feature on Cisco DCNM. For a full list of feature-specific prerequisites, see the platform-specific documentation:
 
     
     	 [bookmark: pgfId-1131863]System-message logging levels for the Events feature must meet or exceed Cisco DCNM requirements. During device discovery, Cisco DCNM detects inadequate logging levels and raises them to the minimum requirements. Cisco Nexus 7000 Series switches that run Cisco NX-OS Release 4.0 are an exception. For Cisco NX-OS Release 4.0, prior to device discovery, use the command-line interface to configure logging levels to meet or exceed Cisco DCNM requirements. For more information, see the  Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x 
 
     	 [bookmark: pgfId-1131867]Managed Cisco NX-OS devices must be configured to send system messages to the Cisco DCNM server.
 
    
 
   
 
    
     [bookmark: pgfId-1131869][bookmark: 58316]Guidelines and Limitations for the Event Browser
 
    [bookmark: pgfId-1131870]The Event Browser feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1131871]The Event Browser and feature-specific Events tabs display only status events, which are events generated when the status of a feature or object changes. For example, configuration events do not appear in the Event Browser or on an Events tab.
 
     	 [bookmark: pgfId-1131872]The Event Browser can display event messages that are no older than 24 hours when you start the Cisco DCNM client. By default, the Cisco DCNM client fetches from the server messages that are no older than 1 hour.
 
     	 [bookmark: pgfId-1131873]The Event Browser can display up to 2000 events. The events database is limited by the amount of space available to the database.
 
     	 [bookmark: pgfId-1131874]You cannot use Cisco DCNM to control the logging levels of managed Cisco NX-OS devices. For more information, see the  Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x .
 
     	 [bookmark: pgfId-1131878]We recommend that you delete events that you no longer need or that you have resolved. For information about deleting old events from the events database, see the  Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x .
 
    
 
   
 
    
     [bookmark: pgfId-1131883][bookmark: 85430]Platform Support
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1131887]Platform 
         
  
        	 
          
          [bookmark: pgfId-1131889]Documentation 
         
  
       
 
        
        	[bookmark: pgfId-1131891]Cisco Nexus 1000V Series switches
  
        	[bookmark: pgfId-1131894]Cisco Nexus 1000V Series Switches Documentation
  
       
 
        
        	[bookmark: pgfId-1131899]Cisco Nexus 2000 Series Fabric Extender
  
        	[bookmark: pgfId-1131905]Cisco Nexus 2000 Series Fabric Extender Documentation
  
       
 
        
        	[bookmark: pgfId-1131907]Cisco Nexus 4000 Series switches
  
        	[bookmark: pgfId-1131910]Cisco Nexus 4000 Series Switches Documentation
  
       
 
        
        	[bookmark: pgfId-1131912]Cisco Nexus 5000 Series switches
  
        	[bookmark: pgfId-1131915]Cisco Nexus 5000 Series Switches Documentation
  
       
 
        
        	[bookmark: pgfId-1131917]Cisco Nexus 7000 Series switches
  
        	[bookmark: pgfId-1131920]Cisco Nexus 7000 Series Switches Documentation
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1131924][bookmark: 24305][bookmark: 71793]Using the Event Browser and Events Tabs
 
    [bookmark: pgfId-1131925]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1131929]Viewing the Event Browser
 
     	 [bookmark: pgfId-1131933]Applying and Removing an Event Filter
 
     	 [bookmark: pgfId-1131937]Viewing Events on an Events Tab
 
     	 [bookmark: pgfId-1131941]Changing the Status of an Event
 
     	 [bookmark: pgfId-1131945]Adding a Note to One or More Events
 
     	 [bookmark: pgfId-1131949]Deleting an Event
 
    
 
     
      [bookmark: pgfId-1053641][bookmark: 62663]Viewing the Event Browser[bookmark: marker-1056103]
 
     [bookmark: pgfId-1053642]You can use the Event Browser to view recent events and a summary chart of those events. By default, the Event Browser shows events that occurred up to 1 hour prior to starting the Cisco DCNM client.
 
    
 
     
      [bookmark: pgfId-1053646]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1052110]Step 1 From the Feature Selector pane, choose Event Browser.
 
     [bookmark: pgfId-1052131]The event table appears in the Contents pane. A summary chart appears above the Feature Selector pane.
 
     [bookmark: pgfId-1083133]Step 2 (Optional) If you want to change the summary chart that appears above the Feature Selector, choose one of the following Chart Type options, as needed:
 
      
       
       	 [bookmark: pgfId-1083143]Bar Chart
 
       	 [bookmark: pgfId-1083179]Pie Chart
 
      
 
     
 
     [bookmark: pgfId-1082159]The colors of the chart correspond to event severity levels, as indicated in the legend that appears above the chart.
 
     [bookmark: pgfId-1083598]Step 3 (Optional) If you want to sort or filter events, you can use one or more of the filtering features as described in the following table:
 
     [bookmark: pgfId-1082176]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1082191]Event Sorting and Filtering Feature 
          
  
         	 
           
           [bookmark: pgfId-1082193]How to Use 
          
  
        
 
         
         	[bookmark: pgfId-1082195]Alphabetical sorting by column
  
         	[bookmark: pgfId-1082197]Click the column heading to cycle through the sorting options, as follows:
 
           
           	 [bookmark: pgfId-1082254]First click—Events are sorted by ascending alphabetical order for the values in the column.
 
           	 [bookmark: pgfId-1082299]Second click—Events are sorted by descending alphabetical order for the values in the column.
 
           	 [bookmark: pgfId-1082346]Third click—Events are not sorted by the values in the column.
 
          
  
        
 
         
         	[bookmark: pgfId-1082199]Event Filter
  
         	[bookmark: pgfId-1082201]See the “Applying and Removing an Event Filter” section.
  
        
 
         
         	[bookmark: pgfId-1082203]Filter by Column Values
  
         	[bookmark: pgfId-1082205] 1. From the menu bar, choose View > Filter.
 [bookmark: pgfId-1082453]The column headings become drop-down lists.
 [bookmark: pgfId-1082432] 2. From each column heading list that you want to use to filter events, choose the value that events appearing in the Event Browser must include.
  
        
 
         
         	[bookmark: pgfId-1082207]Filter by text
  
         	[bookmark: pgfId-1082536]In the Event Browser toolbar, enter the text that you want to use to filter the events.
 [bookmark: pgfId-1082209]The Event Browser shows only the events that contain the text that you enter.
 [bookmark: pgfId-1082550]Tip To configure quick filtering options, use the drop-down list of the Event Browser toolbar.  
        
 
        
      
 
     
 
     [bookmark: pgfId-1052119]Step 4 (Optional) If you want to view details about a specific event, follow these steps:
 
     [bookmark: pgfId-1052141] a. Find the event in the event list.
 
     [bookmark: pgfId-1052146] b. Click the event.
 
     [bookmark: pgfId-1052147] c. Expand the Details pane, if necessary.
 
     [bookmark: pgfId-1052150]Details about the selected event appear in the Details pane.
 
     [bookmark: pgfId-1052687] d. (Optional) To read notes and messages about status changes to the event, read the information in the Action Log field.
 
     [bookmark: pgfId-1052154]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1126306]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1126310]Applying and Removing an Event Filter
 
      	 [bookmark: pgfId-1126314]Viewing Events on an Events Tab
 
      	 [bookmark: pgfId-1126318]Changing the Status of an Event
 
      	 [bookmark: pgfId-1126322]Adding a Note to One or More Events
 
      	 [bookmark: pgfId-1126326]Deleting an Event
 
      	 [bookmark: pgfId-1126330]Configuring the Maximum Age of Events Fetched from the Server
 
     
 
    
 
     
      [bookmark: pgfId-1065483][bookmark: 11851]Applying and Removing an Event Filter[bookmark: marker-1065482]
 
     [bookmark: pgfId-1065484]You can filter events in the Event Browser by the following criteria:
 
      
      	 [bookmark: pgfId-1115170]Event date and time—By default, the Cisco DCNM client displays all events received after you started the Cisco DCNM client and for a configurable number of hours prior to starting the Cisco DCNM client (for more information, see the Configuring the Maximum Age of Events Fetched from the Server).
 
      	 [bookmark: pgfId-1115175]Event severity—By default, the Cisco DCNM client displays events of all severities.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1085065]Note When you apply an event filter, the Events tab continues to display events when the Cisco DCNM server receives them. The filter criteria that you select only affect the Filtered Events tab.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1067857]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1067893]If the message “Filter Applied” appears at the top of the Contents pane, the Cisco DCNM client is applying an event filter to the Event Browser.
 
    
 
     
      [bookmark: pgfId-1065494]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1082807]Step 1 View events in the Event Browser (see the “Viewing the Event Browser” section).
 
     [bookmark: pgfId-1082809]Step 2 If you want to apply an event filter, follow these steps:
 
     [bookmark: pgfId-1082810] a. From the menu bar, choose View > Event Filter.
 
     [bookmark: pgfId-1066132] b. Check the Apply Filter check box.
 
     [bookmark: pgfId-1066149] c. Configure the filter criteria.
 
     [bookmark: pgfId-1066133] d. Click OK.
 
     [bookmark: pgfId-1066134]A Filtered Events tab appears in the Event Browser. The tab displays the events that match the filtering criteria that you specified. The message “Filter Applied” appears at the top of the Contents pane.
 
     [bookmark: pgfId-1065835]Step 3 If you want to remove an event filter, follow these steps:
 
     [bookmark: pgfId-1068386] a. From the menu bar, choose View > Event Filter.
 
     [bookmark: pgfId-1066035] b. Uncheck the Apply Filter check box.
 
     [bookmark: pgfId-1066073] c. Click OK.
 
     [bookmark: pgfId-1066107]The Filtered Events tab disappears. No message appears at the top of the Contents pane.
 
     [bookmark: pgfId-1065509]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1126343]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1126347]Viewing the Event Browser
 
      	 [bookmark: pgfId-1126351]Viewing Events on an Events Tab
 
      	 [bookmark: pgfId-1126355]Changing the Status of an Event
 
      	 [bookmark: pgfId-1126359]Adding a Note to One or More Events
 
      	 [bookmark: pgfId-1126363]Deleting an Event
 
      	 [bookmark: pgfId-1126367]Configuring the Maximum Age of Events Fetched from the Server
 
     
 
    
 
     
      [bookmark: pgfId-1052604][bookmark: 40404]Viewing Events on an Events Tab[bookmark: marker-1056104]
 
     [bookmark: pgfId-1073297]You can view feature-specific events on the Events tab that appears in the Details pane for a feature. By default, an Events tab shows events received up to 1 hour prior to starting the Cisco DCNM client.
 
    
 
     
      [bookmark: pgfId-1073368]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1073369]Typically, the Events tab appears when, in the Summary pane, you select an object that can have events associated with it. For example, if you select Interfaces > Physical > Ethernet from the Feature Selector pane, the Summary pane displays devices. Devices contain slots, and slots contain Ethernet ports. When you select a device, slot, or port, the Details pane displays an Events tab. 
 
     [bookmark: pgfId-1073308]What you select in the Summary pane affects which events are shown in the tab. Continuing the Ethernet interface example, the scope of the events in the Events tab depends on what you select, as follows:
 
      
      	 [bookmark: pgfId-1052509]Device—Events that pertain to the selected device, any slot within the device, and any Ethernet interface within the slot.
 
      	 [bookmark: pgfId-1052512]Slot—Events that pertain to the selected slot and to any Ethernet interface within the slot.
 
      	 [bookmark: pgfId-1052513]Port—Events that pertain to the selected Ethernet interface.
 
     
 
    
 
     
      [bookmark: pgfId-1052487]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1052482]Step 1 From the Feature Selector pane, choose the feature for which you want to view events.
 
     [bookmark: pgfId-1052465]For example, choose Interfaces > Physical > Ethernet.
 
     [bookmark: pgfId-1052473]Step 2 From the Summary pane, select an object.
 
     [bookmark: pgfId-1052522]The Events tab appears in the Details pane. In the Events tab, the events table appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-1052527]Note If no Events tab appears, Cisco DCNM cannot display events for the object that you selected.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1082629]Step 3 (Optional) If you want to sort or filter events, you can use one or more of the filtering features as described in the following table:
 
     [bookmark: pgfId-1082661]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1082632]Event Sorting and Filtering Feature 
          
  
         	 
           
           [bookmark: pgfId-1082634]How to Use 
          
  
        
 
         
         	[bookmark: pgfId-1082636]Alphabetical sorting by column
  
         	[bookmark: pgfId-1082638]Click the column heading to cycle through the sorting options, as follows:
 
           
           	 [bookmark: pgfId-1082639]First click—Events are sorted by ascending alphabetical order for the values in the column.
 
           	 [bookmark: pgfId-1082640]Second click—Events are sorted by descending alphabetical order for the values in the column.
 
           	 [bookmark: pgfId-1082641]Third click—Events are not sorted by the values in the column.
 
          
  
        
 
         
         	[bookmark: pgfId-1082650]Filter by Column Values
  
         	[bookmark: pgfId-1082652] 1. From the menu bar, choose View > Filter.
 [bookmark: pgfId-1082653]The column headings become drop-down lists.
 [bookmark: pgfId-1082654] 2. From each column heading list that you want to use to filter events, choose the value that events appearing in the Events tab must include.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1067050]Step 4 (Optional) If you want to view details about a specific event, follow these steps:
 
     [bookmark: pgfId-1052547] a. Find the event in the event list.
 
     [bookmark: pgfId-1052549] b. Click the event.
 
     [bookmark: pgfId-1052550] c. Expand the Details pane, if necessary.
 
     [bookmark: pgfId-1052653]Details about the selected event appear in the Details pane.
 
     [bookmark: pgfId-1052682] d. (Optional) To read notes and messages about status changes to the event, read the information in the Action Log field.
 
     [bookmark: pgfId-1052540]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1126372]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1126376]Viewing the Event Browser
 
      	 [bookmark: pgfId-1126380]Applying and Removing an Event Filter
 
      	 [bookmark: pgfId-1126384]Changing the Status of an Event
 
      	 [bookmark: pgfId-1126388]Adding a Note to One or More Events
 
      	 [bookmark: pgfId-1126392]Deleting an Event
 
      	 [bookmark: pgfId-1126396]Configuring the Maximum Age of Events Fetched from the Server
 
     
 
    
 
     
      [bookmark: pgfId-1052975][bookmark: 63537]Changing the Status of an Event[bookmark: marker-1056105]
 
     [bookmark: pgfId-1052977]You can change the status of an event to one of the following statuses:
 
      
      	 [bookmark: pgfId-1082125]Acknowledged—Shown as a green check mark.
 
      	 [bookmark: pgfId-1053330]Closed—Shown as a yellow folder.
 
     
 
     [bookmark: pgfId-1053008]By default, the status of new event is Open, which is indicated in the Annotation column by a green check mark with a red slash across it.
 
    
 
     
      [bookmark: pgfId-1052978]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1052979]Select an event in the Event Browser or on an Events tab for a specific feature. For more information, see the “Viewing the Event Browser” section or the “Viewing Events on an Events Tab” section.
 
    
 
     
      [bookmark: pgfId-1052895]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1052896]Step 1 In the event table, right-click the selected event.
 
     [bookmark: pgfId-1052897]Step 2 Choose Acknowledge or Open, as needed.
 
     [bookmark: pgfId-1053412]The new status appears in the Annotation column for the selected event.
 
     [bookmark: pgfId-1053443]In the Details pane, the message about the status change appears in the Action Log field.
 
     [bookmark: pgfId-1052898]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1126401]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1126405]Viewing the Event Browser
 
      	 [bookmark: pgfId-1126409]Applying and Removing an Event Filter
 
      	 [bookmark: pgfId-1126413]Viewing Events on an Events Tab
 
      	 [bookmark: pgfId-1126417]Adding a Note to One or More Events
 
      	 [bookmark: pgfId-1126421]Deleting an Event
 
     
 
    
 
     
      [bookmark: pgfId-1056122][bookmark: 64608]Adding a Note to One or More Events[bookmark: marker-1056135]
 
     [bookmark: pgfId-1056123]You can add a note to one or more events. Notes can contain 1 to 1000 characters.
 
    
 
     
      [bookmark: pgfId-1052923]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1052924]Find the events to which you want to add a note. For more information, see the “Viewing the Event Browser” section or the “Viewing Events on an Events Tab” section.
 
    
 
     
      [bookmark: pgfId-1053458]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1053459]Step 1 Select one or more events. Do one of the following:
 
      
       
       	 [bookmark: pgfId-1068031]To select one event, click the one event that you want to select.
 
       	 [bookmark: pgfId-1068114]To select two or more adjacent events, click and drag across the events.
 
       	 [bookmark: pgfId-1068091]To select two more events, press and hold  Ctrl and click each event.
 
      
 
     
 
     [bookmark: pgfId-1067997]Step 2 On one of the selected events, right-click and then choose Add Notes.
 
     [bookmark: pgfId-1068005]The Notes dialog box appears.
 
     [bookmark: pgfId-1053460]Step 3 Enter the note. You can enter up to 1000 case-sensitive, alphanumeric characters.
 
     [bookmark: pgfId-1053480]Step 4 Click OK.
 
     [bookmark: pgfId-1053488]The note appears in the Action Log field for each selected event.
 
     [bookmark: pgfId-1052934]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1126426]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1126430]Viewing the Event Browser
 
      	 [bookmark: pgfId-1126434]Applying and Removing an Event Filter
 
      	 [bookmark: pgfId-1126438]Viewing Events on an Events Tab
 
      	 [bookmark: pgfId-1126442]Changing the Status of an Event
 
      	 [bookmark: pgfId-1126446]Deleting an Event
 
     
 
    
 
     
      [bookmark: pgfId-1053057][bookmark: 92871]Deleting an Event[bookmark: marker-1056136]
 
     [bookmark: pgfId-1053059]You can delete one or more events from the Event Browser or a feature-specific Events tab. A deleted event no longer appears in the Event Browser or on a feature-specific Events tab; however, the event remains in the events database.
 
     [bookmark: pgfId-1062631]For information about deleting old events from the events database, see the Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x.
 
    
 
     
      [bookmark: pgfId-1053060]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1052762]Select an event in the Event Browser or on an Events tab for a specific feature. For more information, see the “Viewing the Event Browser” section or the “Viewing Events on an Events Tab” section.
 
    
 
     
      [bookmark: pgfId-1052769]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1052778]Step 1 In the event table, select one or more events that you want to delete.
 
      
       
     
 
     
 
     [bookmark: pgfId-1053124]Note To select more than one event, you can click and drag across the events or you can press and hold Ctrl and click each event.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1053092]Step 2 Right-click a selected event.
 
     [bookmark: pgfId-1052784]Step 3 Choose Remove Event.
 
     [bookmark: pgfId-1053131]The selected events disappear from the Event Browser.
 
     [bookmark: pgfId-1052785]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1126451]RELATED TOPICS
 
      
      	 [bookmark: pgfId-1126455]Viewing the Event Browser
 
      	 [bookmark: pgfId-1126459]Applying and Removing an Event Filter
 
      	 [bookmark: pgfId-1126463]Viewing Events on an Events Tab
 
      	 [bookmark: pgfId-1126467]Changing the Status of an Event
 
      	 [bookmark: pgfId-1126471]Adding a Note to One or More Events
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1131960][bookmark: 58163]Field Descriptions for Events
 
    [bookmark: pgfId-1131961]This section includes the following field descriptions for Events:
 
     
     	 [bookmark: pgfId-1131965]Events Table
 
     	 [bookmark: pgfId-1131969]Event Details
 
    
 
     
      [bookmark: pgfId-1131971][bookmark: 50779]Events Table
 
     [bookmark: pgfId-1131972]The events table appears in the Event Browser and on feature-specific Events tabs.
 
     [bookmark: pgfId-1132024]
 
      
       
        
        [bookmark: pgfId-1131978]Table 33-1 Events Table 
 
        
        
         
         	 
           
           [bookmark: pgfId-1131982]Field 
          
  
         	 
           
           [bookmark: pgfId-1131984]Description 
          
  
        
 
         
         	[bookmark: pgfId-1131986]Device
  
         	[bookmark: pgfId-1131988]Display only. Name and IP address of the device that the event is related to.
  
        
 
         
         	[bookmark: pgfId-1131990]Source
  
         	[bookmark: pgfId-1131992]Display only. Where the event message originated. Sources are either a feature on a managed Cisco NX-OS device or the Cisco DCNM server.
  
        
 
         
         	[bookmark: pgfId-1131994]Feature
  
         	[bookmark: pgfId-1131996]Display only. Name of the Cisco NX-OS or Cisco DCNM server feature that the event pertains to.
  
        
 
         
         	[bookmark: pgfId-1131998]Time
  
         	[bookmark: pgfId-1132000]Display only. Date and time that the event occurred.
  
        
 
         
         	[bookmark: pgfId-1132002]Severity
  
         	[bookmark: pgfId-1132004]Display only. Severity of the event. Possible severities are as follows:
 
           
           	 [bookmark: pgfId-1132005]Emergency
 
           	 [bookmark: pgfId-1132006]Alert
 
           	 [bookmark: pgfId-1132007]Critical
 
           	 [bookmark: pgfId-1132008]Error
 
           	 [bookmark: pgfId-1132009]Warning
 
           	 [bookmark: pgfId-1132010]Notification
 
           	 [bookmark: pgfId-1132011]Informational
 
           	 [bookmark: pgfId-1132012]Debug
 
          
  
        
 
         
         	[bookmark: pgfId-1132014]Message
  
         	[bookmark: pgfId-1132016]Display only. Text of the event.
  
        
 
         
         	[bookmark: pgfId-1132018]Annotation
  
         	[bookmark: pgfId-1132020]Status of the event. Possible statuses are as follows:
 
           
           	 [bookmark: pgfId-1132021]Open—The default status of an event. You cannot assign an event the status of Open.
 
           	 [bookmark: pgfId-1132022]Acknowledged
 
           	 [bookmark: pgfId-1132023]Closed
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1132026][bookmark: 91295]Event Details
 
     [bookmark: pgfId-1132027]Event details appear below the events table in the Event Browser and on feature-specific Events tabs.
 
     [bookmark: pgfId-1132064]
 
      
       
        
        [bookmark: pgfId-1132033]Table 33-2 Event Details 
 
        
        
         
         	 
           
           [bookmark: pgfId-1132037]Field 
          
  
         	 
           
           [bookmark: pgfId-1132039]Description 
          
  
        
 
         
         	[bookmark: pgfId-1132041]Event Type
  
         	[bookmark: pgfId-1132043]Display only. Type of the event. Event types are categories that describe the general nature of the event. Possible event types are as follows:
 
           
           	 [bookmark: pgfId-1132044]Communication
 
           	 [bookmark: pgfId-1132045]Environmental
 
           	 [bookmark: pgfId-1132046]Equipment
 
           	 [bookmark: pgfId-1132047]Processing Error
 
           	 [bookmark: pgfId-1132048]Quality of Service
 
           	 [bookmark: pgfId-1132049]Security
 
           	 [bookmark: pgfId-1132050]Unknown
 
          
  
        
 
         
         	[bookmark: pgfId-1132052]Action Log
  
         	[bookmark: pgfId-1132054]Shows all actions taken on the event and all notes added to the event.
  
        
 
         
         	[bookmark: pgfId-1132056]Life Cycle Type
  
         	 
           
            
             
              
              	 
                
                [bookmark: pgfId-1132069]Related Topic 
               
  
              	 
                
                [bookmark: pgfId-1132071]Document Title 
               
  
             
 
              
              	[bookmark: pgfId-1132073]Minimum required Cisco NX-OS logging levels
  
              	[bookmark: pgfId-1132077]Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x
  
             
 
              
              	[bookmark: pgfId-1132080]Cisco DCNM server log settings
  
              	[bookmark: pgfId-1132084]Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x
  
             
 
              
              	[bookmark: pgfId-1132087]Deleting events from the events database
  
              	[bookmark: pgfId-1132091]Fundamentals Configuration Guide, Cisco DCNM for LAN, Release 7.1.x
  
             
 
              
              	[bookmark: pgfId-1132094]Cisco NX-OS system messages
  
              	[bookmark: pgfId-1132096]Cisco NX-OS System Messages Reference
  
             
 
             
           
 
          
 
           
            [bookmark: pgfId-1132099][bookmark: 92503]Feature History for the Event Browser and Events Tabs
 
            
             
              
              [bookmark: pgfId-1132107]Table 33-3 [bookmark: 50557]Feature History for the Event Browser and Events Tabs
 
              
              
               
               	 
                 
                 [bookmark: pgfId-1132113]Feature Name 
                
  
               	 
                 
                 [bookmark: pgfId-1132115]Releases 
                
  
               	 
                 
                 [bookmark: pgfId-1132117]Feature Information 
                
  
              
 
               
               	[bookmark: pgfId-1132119]Event Browser and Events tabs
  
               	[bookmark: pgfId-1132121]5.1(1)
  
               	[bookmark: pgfId-1132123]No change from Release 5.0.
  
              
 
               
               	[bookmark: pgfId-1132125]Event Browser and Events tabs
  
               	[bookmark: pgfId-1132127]5.0(2)
  
               	 
                
  
              
 
              
            
 
           
 
          
 
        
 
        
      
 
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1389446][bookmark: 43575]Working with Network Analysis 
      
      
 
     
 
 
    [bookmark: pgfId-1398466]This chapter describes how to use the Network Analysis (PONG) feature in Cisco Data Center Network Manager for LAN (DCNM-LAN).
 
    [bookmark: pgfId-1399827]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1399831]Information About Network Analysis
 
     	 [bookmark: pgfId-1399835]Licensing Requirements for Network Analysis
 
     	 [bookmark: pgfId-1399839]Prerequisites for Network Analysis
 
     	 [bookmark: pgfId-1399843]Guidelines and Limitations for Network Analysis
 
     	 [bookmark: pgfId-1399847]Using the Network Analysis Feature
 
     	 [bookmark: pgfId-1399851]Related Documents
 
     	 [bookmark: pgfId-1399855]Feature History for Network Analysis
 
    
 
   
 
    
     [bookmark: pgfId-1399857][bookmark: 69949]Information About Network Analysis
 
    [bookmark: pgfId-1399858]The Network Analysis feature provides you with information to track and monitor the latency between two specified switches in a specified time interval. With Network Analysis, you can determine the health of the network by examining the delay between the two specified points in the network.
 
    [bookmark: pgfId-1400271]The Network Analysis feature:
 
     
     	 [bookmark: pgfId-1400274]Supports real time and historical network analysis between two user specified devices or ports. The user specifies the required monitoring intervals.
 
     	 [bookmark: pgfId-1400275]Supports an archive of historical Network Analysis measurements for the following: 
 
    
 
    [bookmark: pgfId-1400276] – End to end round trip time. 
 
    [bookmark: pgfId-1400277] – Switching delay at each hop.
 
    [bookmark: pgfId-1400278] – Link delay between hops per path.
 
     
     	 [bookmark: pgfId-1400280]Provides reports that contain the resulting statistical information as a chart or summary table.
 
    
 
   
 
    
     [bookmark: pgfId-1399861][bookmark: 45093][bookmark: 29596]Licensing Requirements for Network Analysis
 
    [bookmark: pgfId-1399862]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1399875]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1399865]Product 
         
  
        	 
          
          [bookmark: pgfId-1399867]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1399869]Cisco DCNM-LAN
  
        	[bookmark: pgfId-1399871]The Network Analysis feature requires no license. Any feature not included in a license package is bundled with the Cisco DCNM-LAN and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1399877][bookmark: 16098]Prerequisites for Network Analysis
 
    [bookmark: pgfId-1399878]Network Analysis has the following prerequisite:
 
     
     	 [bookmark: pgfId-1399879]Network Analysis only pertains to the devices that DCNM-LAN has discovered.
 
    
 
   
 
    
     [bookmark: pgfId-1399881][bookmark: 58316]Guidelines and Limitations for Network Analysis
 
    [bookmark: pgfId-1399882]The Network Analysis feature has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1399883]Specify the IP addresses for devices to monitor the network path between two end hosts or between a host and a server. This allows monitoring of the ingress port of the source connected switch to the egress port of the target switch connected to the end host or server.
 
     	 [bookmark: pgfId-1399884]Specify the IP addresses for switches, VLAN, and optional interface information to monitor the path between them.
 
     	 [bookmark: pgfId-1399890]Specify the threshold level for the round trip time to help evaluate the path latency results.
 
    
 
   
 
    
     [bookmark: pgfId-1399894][bookmark: 24305][bookmark: 71793]Usin[bookmark: marker-1400198]g the Network Analysis Feature
 
    [bookmark: pgfId-1399895]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1399899]Using Network Analysis
 
     	 [bookmark: pgfId-1399903]Using the New Path Latency Session Wizard
 
     	 [bookmark: pgfId-1399907]Viewing Session Statistics
 
    
 
     
      [bookmark: pgfId-1203117][bookmark: 13513]Using Network Analysis
 
     [bookmark: pgfId-1203118]You can use Network Analysis to specify the scope of the analysis and to view the information about the analysis.
 
    
 
     
      [bookmark: pgfId-1203125]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1203127]Step 1 From the Feature Selector pane, choose Network Analysis > Path Latency Monitoring (PONG).
 
     [bookmark: pgfId-1203128]The Summary pane appears in the Contents pane. Each row in the table is a path latency session. You are able to view the sessions that you have created as well as the sessions created by other users. See Table 34-1.
 
     [bookmark: pgfId-1394431]Users with administrator privileges are allowed to modify other users’ sessions.
 
     [bookmark: pgfId-1402034]
 
      
       
        
        [bookmark: pgfId-1402054]Table 34-1 [bookmark: 98907]Information in Summary Pane
 
        
        
         
         	 
           
           [bookmark: pgfId-1402160]Column 
          
  
         	 
           
           [bookmark: pgfId-1402162]Description 
          
  
        
 
         
         	[bookmark: pgfId-1402168]Session ID
  
         	[bookmark: pgfId-1402170]Unique ID of the session created by the user. The ID is updated after the user deploys the session.
  
        
 
         
         	[bookmark: pgfId-1402172]Session Name 
  
         	[bookmark: pgfId-1402174]Unique name entered by user for the path latency session. 
  
        
 
         
         	[bookmark: pgfId-1402176]Source Switch 
  
         	[bookmark: pgfId-1402178]IP address of the source switch from which path latency is monitored.
  
        
 
         
         	[bookmark: pgfId-1402180]Destination Switch 
  
         	[bookmark: pgfId-1402182]IP address of the destination switch to which the path latency is monitored.
  
        
 
         
         	[bookmark: pgfId-1402184]VLAN
  
         	[bookmark: pgfId-1402186]VLAN ID through which the actual traffic flows (1 to 4094).
  
        
 
         
         	[bookmark: pgfId-1402188]Class of Service (CoS)
  
         	[bookmark: pgfId-1402190]Optional value used to filter the traffic monitoring based on class of service value (0 to 7). CoS values are shown in Table 34-2.
  
        
 
         
         	[bookmark: pgfId-1402199]Round Trip Time (microseconds)
  
         	[bookmark: pgfId-1402201]Minimum, maximum, average and latest value of the round trip time (two way path: source <-> destination) of all the RTT latencies calculated up until current time.
  
        
 
         
         	[bookmark: pgfId-1402203]Forward Delay (microseconds)
  
         	[bookmark: pgfId-1402205]Minimum, maximum, average and latest value of the forward delay (forward path: source -> destination) of all the forward delay latencies calculated to the current time.
  
        
 
         
         	[bookmark: pgfId-1402207]Reverse Delay (microseconds)
  
         	[bookmark: pgfId-1402209]Minimum, maximum, average and latest value of the reverse delay (reverse path: destination -> source) of all the reverse delay latencies calculated to the current time.
  
        
 
         
         	[bookmark: pgfId-1402211]Owner
  
         	[bookmark: pgfId-1402213]Creator of the session.
  
        
 
         
         	[bookmark: pgfId-1402215]Success Percentage
  
         	[bookmark: pgfId-1402217]Success percentage of the packets traversed from source to destination during the specified time interval.
  
        
 
         
         	[bookmark: pgfId-1402219]Scheduled At
  
         	[bookmark: pgfId-1402221]Date and time when the monitoring was started.
  
        
 
         
         	[bookmark: pgfId-1402223]Status
  
         	[bookmark: pgfId-1402225]Column that specifies:
 
           
           	 [bookmark: pgfId-1402226]Session created 
 
           	 [bookmark: pgfId-1402227]Monitoring started
 
           	 [bookmark: pgfId-1402228]Monitoring stopped
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1401863]
 
      
       
        
        [bookmark: pgfId-1401824]Table 34-2 [bookmark: 91117]CoS Values and Corresponding Traffic Types
 
        
        
         
         	 
           
           [bookmark: pgfId-1401828]User Priority 
          
  
         	 
           
           [bookmark: pgfId-1401830]Traffic Type 
          
  
        
 
         
         	[bookmark: pgfId-1401832]0
  
         	[bookmark: pgfId-1401834]Background
  
        
 
         
         	[bookmark: pgfId-1401836]1
  
         	[bookmark: pgfId-1401838]Best Effort
  
        
 
         
         	[bookmark: pgfId-1401840]2
  
         	[bookmark: pgfId-1401842]Excellent Effort
  
        
 
         
         	[bookmark: pgfId-1401844]3
  
         	[bookmark: pgfId-1401846]Critical Applications
  
        
 
         
         	[bookmark: pgfId-1401848]4
  
         	[bookmark: pgfId-1401850]Video, < 100 ms latency
  
        
 
         
         	[bookmark: pgfId-1401852]5
  
         	[bookmark: pgfId-1401854]Voice, < 10 ms latency
  
        
 
         
         	[bookmark: pgfId-1401856]6
  
         	[bookmark: pgfId-1401858]Internetwork Control
  
        
 
         
         	[bookmark: pgfId-1401860]7
  
         	[bookmark: pgfId-1401862]Network Control
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1396011]Step 2 Above the Summary pane, click the Configure New Rule link to set a threshold rule for one of the following parameters.
 
      
      	 [bookmark: pgfId-1396068]Round trip time
 
      	 [bookmark: pgfId-1396069]Forward delay
 
      	 [bookmark: pgfId-1396070]Reverse delay
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1396062]Note Clicking Configure New Rule links you to Theshold Rules of the DCNM-LAN Server Administration feature.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1396005]Step 3 Above the Summary pane, click the Set Global Threshold link to set a global threshold rule for the following parameters:
 
      
      	 [bookmark: pgfId-1395722]Round trip time
 
      	 [bookmark: pgfId-1395736]Forward delay
 
      	 [bookmark: pgfId-1395820]Reverse delay
 
     
 
     [bookmark: pgfId-1395821]The global threshold setting is applied to all the sessions in the Summary Table.
 
     [bookmark: pgfId-1395822]Step 4 Above the Summary pane, click the VLAN-CoS button to view the sessions grouped by VLAN-CoS.
 
     [bookmark: pgfId-1209900]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1392602][bookmark: 93843]Using the New Path Latency Session Wizard
 
     [bookmark: pgfId-1209901]You can use the New Path Latency Session wizard to create a new seesion.
 
    
 
     
      [bookmark: pgfId-1209945]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1396228]Step 1 From the Feature Selector pane, choose Network Analysis > Path Latency Monitoring (PONG).
 
     [bookmark: pgfId-1392703]The Summary pane appears in the Contents pane.
 
     [bookmark: pgfId-1396236]Step 2 In the Summary pane, right-click and choose New Path Latency Session in the context menu.
 
     [bookmark: pgfId-1396253]The New Path Latency Session wizard appears.
 
     [bookmark: pgfId-1396237]Step 3 In the Select Session Monitor Option of Interest screen, enter the following:
 
      
      	 [bookmark: pgfId-1396307]Session Name
 
     
 
     [bookmark: pgfId-1396449](Length: 1 to 256 characters)
 
      
      	 [bookmark: pgfId-1396345]VLAN
 
     
 
     [bookmark: pgfId-1396463](Value: 1 to 4094)
 
      
      	 [bookmark: pgfId-1396350]Class of Service (CoS)
 
     
 
     [bookmark: pgfId-1401636]
 
      
       
        
        [bookmark: pgfId-1401621]Table 34-3 CoS Values and Corresponding Traffic Types
 
        
        
         
         	 
           
           [bookmark: pgfId-1401728]User Priority 
          
  
         	 
           
           [bookmark: pgfId-1401730]Traffic Type 
          
  
        
 
         
         	[bookmark: pgfId-1401696]0
  
         	[bookmark: pgfId-1401698]Background
  
        
 
         
         	[bookmark: pgfId-1401700]1
  
         	[bookmark: pgfId-1401702]Best Effort
  
        
 
         
         	[bookmark: pgfId-1401704]2
  
         	[bookmark: pgfId-1401706]Excellent Effort
  
        
 
         
         	[bookmark: pgfId-1401708]3
  
         	[bookmark: pgfId-1401710]Critical Applications
  
        
 
         
         	[bookmark: pgfId-1401712]4
  
         	[bookmark: pgfId-1401714]Video, < 100 ms latency
  
        
 
         
         	[bookmark: pgfId-1401716]5
  
         	[bookmark: pgfId-1401718]Voice, < 10 ms latency
  
        
 
         
         	[bookmark: pgfId-1401720]6
  
         	[bookmark: pgfId-1401722]Internetwork Control
  
        
 
         
         	[bookmark: pgfId-1401724]7
  
         	[bookmark: pgfId-1401726]Network Control
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1396327]Step 4 In the Select Option section, choose one of the following options:
 
      
      	 [bookmark: pgfId-1396521]Monitor latency between source VDC and destination VDC.
 
      	 [bookmark: pgfId-1396533]Monitor latency between source and destination VDC including source switching delay.
 
      	 [bookmark: pgfId-1396535]Monitor latency between source and destination VDC including destination switching delay.
 
      	 [bookmark: pgfId-1396580]Monitor latency between source and destination VDC including both switching delays.
 
     
 
     [bookmark: pgfId-1396525]Under the Monitor latency between source VDC and destination VDC option, you can additionally choose to measure the latency between switches that have Fabric Path mode connectivity. The latency measurements are measured between the source and destination switches but do not include the switching delay of both the end switches. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1396674]Note For the switches that are in a classical ethernet cloud, the wizard allows you to choose their VDC MAC addresses/IP addresses/hostnames in the following wizard screen.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1396526]Click Next to continue.
 
     [bookmark: pgfId-1396698]Step 5 In the Select Source and Destination Switch screen, do the following:
 
      
      	 [bookmark: pgfId-1396804]Choose the source switch by clicking on the ellipses next to the Select Source Switch field. Highlight the device in the screen that appears and click  OK to enter your selection.
 
      	 [bookmark: pgfId-1396818]Choose the destination switch by clicking on the ellipses next to the Select Destination Switch field. Highlight the device in the screen that appears and click  OK to enter your selection.
 
     
 
     [bookmark: pgfId-1396827]Depending on the earlier selection that you made in the Select Option section of the wizard, Table 34-4 list the required and optional information that you must enter in the Select Source and Destination Switch screen.
 
     [bookmark: pgfId-1401309]
 
      
       
        
        [bookmark: pgfId-1401334]Table 34-4 [bookmark: 36796]Required and Optional Information
 
        
        
         
         	 
           
           [bookmark: pgfId-1401391]Option 
          
  
         	 
           
           [bookmark: pgfId-1401393]Required 
          
  
         	 
           
           [bookmark: pgfId-1401395]Optional 
          
  
        
 
         
         	[bookmark: pgfId-1401401]Monitor latency between source VDC and destination VDC
  
         	 
           
           	 [bookmark: pgfId-1401403]Source and destination
 
          
  
         	 
           
           	 [bookmark: pgfId-1401405]Egress/outbound interface through which the packet flows out from the source.
 
          
  
        
 
         
         	[bookmark: pgfId-1401407]Monitor latency between source and destination VDC including source switching delay
  
         	 
           
           	 [bookmark: pgfId-1401409]Source and destination
 
           	 [bookmark: pgfId-1401410]Inject/ingress interface through which the packet needs to be injected from the source switch. Also requires the source static MAC address associated with the interface.
 
          
  
         	 
           
           	 [bookmark: pgfId-1401412]N/A
 
          
  
        
 
         
         	[bookmark: pgfId-1401414]Monitor latency between source and destination VDC including destination switching delay
  
         	 
           
           	 [bookmark: pgfId-1401416]Source and destination
 
           	 [bookmark: pgfId-1401417]Egress/outbound interface through which the packet terminates at the destination switch. Also requires the destination static MAC address associated with the interface.
 
          
  
         	 
           
           	 [bookmark: pgfId-1401419]Egress/outbound interface through which the packet flows out from the source.
 
          
  
        
 
         
         	[bookmark: pgfId-1401428]Monitor latency between source and destination VDC including both switching delays
  
         	 
           
           	 [bookmark: pgfId-1401430]Source and destination
 
           	 [bookmark: pgfId-1401431]Inject/ingress interface through which the packet needs to be injected from the source switch. Also requires source static MAC address associated with the interface.
 
           	 [bookmark: pgfId-1401432]Egress/outbound interface through which the packet terminates at the destination switch. Also requires the destination static MAC address associated with the interface.
 
          
  
         	 
           
           	 [bookmark: pgfId-1401434]N/A
 
          
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1397153]Note You can enter any arbitrary unique static MAC address that points to the selected interface. To configure a new static MAC address, use one of the following recommended addresses to avoid any conflict with globally administered MAC addresses (associated with any other host/devices):
 
      
      	 [bookmark: pgfId-1397195]X2XX.XXXX.XXXX
 
      	 [bookmark: pgfId-1397204]X6XX.XXXX.XXXX
 
      	 [bookmark: pgfId-1397213]XAXX.XXXX.XXXX
 
      	 [bookmark: pgfId-1397221]XEXX.XXXX.XXXX
 
     
 
     [bookmark: pgfId-1397226]where X is a hexadecimal value.
 
     [bookmark: pgfId-1396853]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1396858]Click Next to continue.
 
     [bookmark: pgfId-1396730]Step 6 In the dialog box that appears, click OK to start input verification.
 
     [bookmark: pgfId-1402463]The Input Verification screen appears and the results are displayed.
 
     [bookmark: pgfId-1396336]Input verification verifies the following:
 
      
      	 [bookmark: pgfId-1397396]Path latency measurement between specified devices.
 
      	 [bookmark: pgfId-1397401]Packet traversal between the specified devices. 
 
     
 
     [bookmark: pgfId-1396744]If the verification fails, you must specify the information that you entered earlier in the wizard.
 
     [bookmark: pgfId-1397435]Table 34-5 lists the additional settings that are available in the Input Verification window:
 
     [bookmark: pgfId-1402497]
 
      
       
        
        [bookmark: pgfId-1402502]Table 34-5 [bookmark: 16247]Input Verification Settings
 
        
        
         
         	 
           
           [bookmark: pgfId-1402591]Setting 
          
  
         	 
           
           [bookmark: pgfId-1402593]Description 
          
  
         	 
           
           [bookmark: pgfId-1402595]Value 
          
  
        
 
         
         	[bookmark: pgfId-1402544]Monitor Interval
  
         	[bookmark: pgfId-1402546]Interval of time between data collection points.
  
         	[bookmark: pgfId-1402548]0.5 - 5 minutes 
 [bookmark: pgfId-1402549](Default: 5 minutes)
  
        
 
         
         	[bookmark: pgfId-1402551]End Time
  
         	[bookmark: pgfId-1402553]Time of session termination
  
         	[bookmark: pgfId-1402555]N/A
  
        
 
         
         	[bookmark: pgfId-1402557]Calculate Jitter
  
         	[bookmark: pgfId-1402559]Variance of inter packet RTT delay
  
         	[bookmark: pgfId-1402561]Default: unchecked
  
        
 
         
         	[bookmark: pgfId-1402563]No. of Packets to send
  
         	[bookmark: pgfId-1402565]Packet count to send for the session to measure latency.
 [bookmark: pgfId-1402566]To calculate jitter (inter packet delay variance), more than 1 packet has to be sent.
  
         	[bookmark: pgfId-1402568]1 -5 packets
 [bookmark: pgfId-1402569](Default: 1 packet)
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1397453]Click Finish after a successful verification and to enter the settings.
 
     [bookmark: pgfId-1402649]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1392966][bookmark: 79106]Viewing Session Statistics
 
     [bookmark: pgfId-1392991]You can view session statistics from the Summary pane.
 
    
 
     
      [bookmark: pgfId-1397885]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1397886]Step 1 From the Feature Selector pane, choose Network Analysis > Path Latency Monitoring (PONG).
 
     [bookmark: pgfId-1397887]The Summary pane appears in the Contents pane.
 
     [bookmark: pgfId-1397902]Step 2 Right-click a session and choose Go To Statistics in the context menu.
 
     [bookmark: pgfId-1397889]The statistics for the session appear as a chart and a table of detailed information in the Details pane.
 
     [bookmark: pgfId-1397890]Step 3 In the Details pane, click the Path Latency tab to display RTT information about each path.
 
     [bookmark: pgfId-1397931]Step 4 In the Details pane, right-click to display a context menu of additional statistical displays:
 
      
      	 [bookmark: pgfId-1397948]Path specific switching delay–Switching delay of all the switches traversed in each path.
 
      	 [bookmark: pgfId-1397949]Path specific link delay–Link delay at each hop traversed in each path.
 
      	 [bookmark: pgfId-1397950]Switching delay of each switch across different paths traversed in the session.
 
      	 [bookmark: pgfId-1397951]Link delay of each link across different paths traversed in the session.
 
     
 
     [bookmark: pgfId-1397976]Step 5 In the Details pane, click the Session Report tab to display overall statistical information about the session.
 
     [bookmark: pgfId-1397968]The information can be exported as an Excel .xls file by cllicking the export button near the top of the table.
 
     [bookmark: pgfId-1402686]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1399913][bookmark: 12973]Related Documents
 
    [bookmark: pgfId-1399914]For additional information related to the topology map, see the following sections:
 
    [bookmark: pgfId-1399934]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1399917]Related Topic 
         
  
        	 
          
          [bookmark: pgfId-1399919]Document Title 
         
  
       
 
        
        	[bookmark: pgfId-1399921]Device discovery
  
        	[bookmark: pgfId-1399926]Chapter 27, “Administering Device Discovery”
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1399936][bookmark: 92503]Feature History for Network Analysis
 
    [bookmark: pgfId-1399940]Table 34-6 lists the release history for this feature.
 
    [bookmark: pgfId-1399964]
 
     
      
       
       [bookmark: pgfId-1399947]Table 34-6 [bookmark: 50557]Feature History for Topology 
 
       
       
        
        	 
          
          [bookmark: pgfId-1399953]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1399955]Releases 
         
  
        	 
          
          [bookmark: pgfId-1399957]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1399959]Network Analysis support
  
        	[bookmark: pgfId-1399961]5.2(0)
  
        	[bookmark: pgfId-1399963]Support for Network Analysis was added.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1280401]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1382529][bookmark: 27743]Maintaining the Cisco DCNM-LAN Database[bookmark: marker-1388135] 
      
      
 
     
 
 
    [bookmark: pgfId-1382531]This chapter describes how to maintain the Cisco Data Center Network Manager for LAN (DCNM-LAN) database.
 
    [bookmark: pgfId-1382533]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1381568]Information About Database Maintenance
 
     	 [bookmark: pgfId-1381572]Licensing Requirements for Database Maintenance
 
     	 [bookmark: pgfId-1381576]Prerequisites for Database Maintenance
 
     	 [bookmark: pgfId-1381580]Guidelines and Limitations for Database Maintenance
 
     	 [bookmark: pgfId-1381584]Performing Database Maintenance
 
     	 [bookmark: pgfId-1388159]Additional References
 
     	 [bookmark: pgfId-1388161]Feature History for DCNM-LAN Database Maintenance
 
    
 
   
 
    
     [bookmark: pgfId-1388802][bookmark: 14255]Information About Database Maintenance
 
    [bookmark: pgfId-1388162]DCNM-LAN uses a PostgreSQL database or an Oracle database to store all data, including configuration information from managed devices, events and statistical data gathered from managed devices, and DCNM-LAN user information. In addition to scripts that you can run to perform database maintenance, DCNM-LAN provides features to help you delete events and statistical data that you no longer need.
 
    [bookmark: pgfId-1386983]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1387154]Automatic and Manual Purging of Data
 
     	 [bookmark: pgfId-1387074]Database Backup
 
     	 [bookmark: pgfId-1387097]Database Clean
 
     	 [bookmark: pgfId-1387006]Database Restore
 
    
 
     
      [bookmark: pgfId-1381610][bookmark: 58558]Automatic and Manual Purging of Data
 
     [bookmark: pgfId-1381611]You can use the Auto-Synchronization with Devices feature to delete unwanted event data and the Statistical Data Collection feature to delete unwanted statistical data. DCNM-LAN supports automatic purging of both types of data. You can configure the following aspects of automatic data purging:
 
      
      	 [bookmark: pgfId-1381612]Days of the week and time of day that automatic purging occurs.
 
      	 [bookmark: pgfId-1381613]Whether DCNM-LAN determines which data to purge by the age of the data or by a maximum number of database entries.
 
      	 [bookmark: pgfId-1388893]For event-related data, whether DCNM-LAN determines which events to purge by event severity.
 
     
 
     [bookmark: pgfId-1381614]We recommend that you configure automatic purging of events and statistical data to ensure that the DCNM-LAN database size does not grow too large.
 
     [bookmark: pgfId-1387402]You can also manually purge events and statistical data.
 
     [bookmark: pgfId-1387460]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1387224]Automatic and Manual Purging of Event Data
 
      	 [bookmark: pgfId-1387195]Automatic and Manual Purging of Statistical Data
 
     
 
    
 
     
      [bookmark: pgfId-1389371][bookmark: 62368]Database Backup
 
     [bookmark: pgfId-1389373]You can use the Cisco DCNM database backup script to create a backup file of the DCNM-LAN database.
 
     [bookmark: pgfId-1391138]We strongly recommend that you regularly back up the DCNM-LAN database and that you archive backup files in a secure location that is not on the DCNM-LAN server system. You should retain the backup files as long as required by the standards of your organization.
 
    
 
     
      [bookmark: pgfId-1390118][bookmark: 12870]Database Clean
 
     [bookmark: pgfId-1390119]You can use the Cisco DCNM database clean script /usr/local/cisco/dcm/dcnm/bin/clean-dcnm-db.sh to clean the DCNM-LAN database. Cleaning removes all DCNM-LAN data from the database and is a necessary step prior to restoring the DCNM-LAN database. Any database records that have not been backed up are lost when you clean the database.
 
     [bookmark: pgfId-1392894]You can also clean the database if you want to delete all data and rebuild your DCNM-LAN implementation without restoring data from a backup.
 
    
 
     
      [bookmark: pgfId-1392939][bookmark: 33742]Database Restore
 
     [bookmark: pgfId-1392940]You can use the Cisco DCNM database restore script to restore the DCNM-LAN database from a backup file. The backup file must have been created by the DCNM-LAN database backup script included in the same release of DCNM-LAN that you are restoring the data to. For example, if you are running Cisco DCNM Release 5.0(2), you should only perform database restoration from a backup of Cisco DCNM Release 5.0(2).
 
     [bookmark: pgfId-1391043]Also, the backup file must have been created from the same database type and release that you are restoring the data to. For example, if you are restoring data to an Oracle 11g database, the backup file must have been created from an Oracle 11g database.
 
     [bookmark: pgfId-1395200]Before you restore a DCNM-LAN database, you should clean the database. Restoring a database without cleaning the database can have unpredictable results.
 
    
 
   
 
    
     [bookmark: pgfId-1395202][bookmark: 51127]Licensing Requirements for Database Maintenance
 
    [bookmark: pgfId-1395203]The following table shows the licensing requirements for this feature:
 
    [bookmark: pgfId-1381632]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1381622]Product 
         
  
        	 
          
          [bookmark: pgfId-1381624]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1381626]DCNM-LAN
  
        	[bookmark: pgfId-1381628]Database maintenance requires no license. Any feature not included in a license package is bundled with the DCNM-LAN and is provided at no charge to you. For information about obtaining and installing a Cisco DCNM LAN Enterprise license, see the Cisco DCNM Installation and Licensing Guide, Release 7.1.x.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1381634][bookmark: 78783]Prerequisites for Database Maintenance
 
    [bookmark: pgfId-1381635]Database maintenance has the following prerequisites:
 
     
     	 [bookmark: pgfId-1381638]You must have successfully installed the DCNM-LAN server.
 
     	 [bookmark: pgfId-1386715]Cleaning the DCNM-LAN database requires that you stop the DCNM-LAN server.
 
     	 [bookmark: pgfId-1386720]Restoring the DCNM-LAN database requires the following:
 
    
 
    [bookmark: pgfId-1391202] – You must have a backup file created from exactly the same release of DCNM-LAN that you are restoring with the backup file.
 
    [bookmark: pgfId-1391253] – You must have a backup file created from exactly the same database type and release that you are restoring data to.
 
    [bookmark: pgfId-1397199] – You must have a backup file that was created from a DCNM-LAN database running in the same operating system as the database that you want to restore. For example, backup files made from a database running in Microsoft Server 2003 can only be used to restore other DCNM-LAN databases running in Microsoft Server 2003.
 
   
 
    
     [bookmark: pgfId-1393398][bookmark: 87804]Guidelines and Limitations for Database Maintenance[bookmark: marker-1393397]
 
    [bookmark: pgfId-1393399]Database maintenance has the following configuration guidelines and limitations:
 
     
     	 [bookmark: pgfId-1393400]We recommend that you configure automatic purging of statistical data and event data to ensure that the DCNM-LAN database size does not grow too large.
 
     	 [bookmark: pgfId-1382882]We recommend that you perform backups on a regular basis. Follow the standards of your organization to determine how frequently you should perform backups.
 
     	 [bookmark: pgfId-1393132]You can only restore a DCNM-LAN database from a backup of the same release of DCNM-LAN. For example, if you are running Cisco DCNM Release 5.0(2), you should only perform database restoration from a backup of Cisco DCNM Release 5.0(2).
 
     	 [bookmark: pgfId-1393156]You can only restore a DCNM-LAN database from a backup of the same database type and release as the current database. For example, if the current database is an Oracle 11g database, you can only restore it with a backup file made from an Oracle 11g database.
 
     	 [bookmark: pgfId-1397219]You can only restore a DCNM-LAN database from a backup file that was made from a DCNM-LAN database running in the same operating system as the database that you want to restore. For example, backup files made from a database running in Microsoft Server 2003 can only be used to restore other DCNM-LAN databases running in Microsoft Server 2003.
 
    
 
   
 
    
     [bookmark: pgfId-1393134][bookmark: 54640]Performing Database Maintenance
 
    [bookmark: pgfId-1393135]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1381667]Backing Up the DCNM-LAN Database
 
     	 [bookmark: pgfId-1381675]Cleaning a DCNM-LAN Database
 
     	 [bookmark: pgfId-1381679]Restoring a DCNM-LAN Database from a Backup File
 
    
 
     
      [bookmark: pgfId-1383271][bookmark: 91967]Backing Up the DCNM-LAN Database[bookmark: marker-1388122]
 
     [bookmark: pgfId-1384090]You can back up the DCNM-LAN database with the backup script. The DCNM-LAN server installer configures the backup script with the database username and database name that you specified during server installation.
 
    
 
     
      [bookmark: pgfId-1231951]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1384416]Step 1 On the DCNM-LAN server, access a command prompt.
 
     [bookmark: pgfId-1384762]Step 2 Use the cd command to change the directory to the bin directory under the Cisco DCNM installation directory, as follows:
 
     [bookmark: pgfId-1388353]cd path
 
     [bookmark: pgfId-1384787]where path is the relative or absolute path to the bin directory. For Microsoft Windows, the default path to the bin directory is C:\Program Files\dcm\dcnm\bin. For RHEL, the default path to the bin directory is /usr/local/cisco/dcm/dcnm/bin.
 
     [bookmark: pgfId-1384459]Step 3 Run the Cisco DCNM database backup script. The script name depends upon the server operating system and database type, as shown in the following table:
 
     [bookmark: pgfId-1392005]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1391424]Server Operating System 
          
  
         	 
           
           [bookmark: pgfId-1391426]Database Type 
          
  
         	 
           
           [bookmark: pgfId-1391428]Backup Script Name 
          
  
        
 
         
         	 [bookmark: pgfId-1391430]Microsoft Windows
  
         	[bookmark: pgfId-1391432]PostgreSQL
  
         	[bookmark: pgfId-1391434]backup-pgsql-dcnm-db.bat
  
        
 
         
         	[bookmark: pgfId-1391438]Oracle
  
         	[bookmark: pgfId-1391440]backup-oracle-dcnm-db.bat
  
        
 
         
         	 [bookmark: pgfId-1391442]Linux
  
         	[bookmark: pgfId-1391444]PostgreSQL
  
         	[bookmark: pgfId-1391446]backup-pgsql-dcnm-db.sh
  
        
 
         
         	[bookmark: pgfId-1391450]Oracle
  
         	[bookmark: pgfId-1391452]backup-oracle-dcnm-db.sh
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1393409]Step 4 Enter the filename for the backup that you are creating.
 
     [bookmark: pgfId-1393410]Step 5 At the confirmation prompt, enter y to continue with the backup.
 
     [bookmark: pgfId-1393411]Step 6 Verify that the backup file was created as you specified and has a file size greater than zero.
 
      
      	 [bookmark: pgfId-1385263]On Linux, use the  ls -l command.
 
      	 [bookmark: pgfId-1385285]On Microsoft Windows, use the  dir command.
 
     
 
     [bookmark: pgfId-1385262]Step 7 Store the backup file in a safe location. We recommend that you copy the backup file to a secure location that is off the DCNM-LAN server system so that you can protect your data from the potential of a catastrophic hardware failure.
 
     [bookmark: pgfId-1121424]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1385154]Example
 
     [bookmark: pgfId-1385155]The following example from a Windows server shows how to create a backup named masterbackup.bkp from a PostgreSQL DCNM-LAN database that was installed using default values:
 
      
      [bookmark: pgfId-1385229]C:\Documents and Settings\Administrator>cd "C:\Program Files\Cisco Systems\dcm\dcnm\bin" 
     
 
      
      [bookmark: pgfId-1385230] 
     
 
      
      [bookmark: pgfId-1391699]C:\Program Files\Cisco Systems\dcm\dcnm\bin>backup-pgsql-dcnm-db.bat 
     
 
      
      [bookmark: pgfId-1391700] ======================================================== 
     
 
      
      [bookmark: pgfId-1391701] 
     
 
      
      [bookmark: pgfId-1391702] Database Postgres Environment 
     
 
      
      [bookmark: pgfId-1391703] 
     
 
      
      [bookmark: pgfId-1391704] PostgreSQL Bin Path : ""C:\Program Files\Cisco Systems\dcm\db"\bin" 
     
 
      
      [bookmark: pgfId-1391705] 
     
 
      
      [bookmark: pgfId-1391706] DCNM Database Name : "dcmdb" 
     
 
      
      [bookmark: pgfId-1391707] 
     
 
      
      [bookmark: pgfId-1391708] DCNM Database User Name : "dcnmuser" 
     
 
      
      [bookmark: pgfId-1391709] 
     
 
      
      [bookmark: pgfId-1391710] ======================================================== 
     
 
      
      [bookmark: pgfId-1391711] 
     
 
      
      [bookmark: pgfId-1391712] 
     
 
      
      [bookmark: pgfId-1391713]Please enter the filename to be used for Database Backup:masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1391714]"" 
     
 
      
      [bookmark: pgfId-1391715]"Database Schema "dcnmuser" will be backed up in filename : masterbackup.bkp" 
     
 
      
      [bookmark: pgfId-1391716]"" 
     
 
      
      [bookmark: pgfId-1385233]Continue y/n [n] : y 
     
 
      
      [bookmark: pgfId-1391760]. 
     
 
      
      [bookmark: pgfId-1391761]. 
     
 
      
      [bookmark: pgfId-1391762]. 
     
 
      
      [bookmark: pgfId-1391747]Database backup File: woobie1 
     
 
      
      [bookmark: pgfId-1385234] Operation Completed 
     
 
      
      [bookmark: pgfId-1391756]C:\Program Files\Cisco Systems\dcm\dcnm\bin>dir masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1385235] Volume in drive C has no label. 
     
 
      
      [bookmark: pgfId-1385236] Volume Serial Number is D415-F632 
     
 
      
      [bookmark: pgfId-1385237] 
     
 
      
      [bookmark: pgfId-1385238] Directory of C:\Program Files\PostgreSQL\8.2\bin 
     
 
      
      [bookmark: pgfId-1385239] 
     
 
      
      [bookmark: pgfId-1385240]06/15/2009 01:53 PM 900,129 masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1385241] 1 File(s) 900,129 bytes 
     
 
      
      [bookmark: pgfId-1385242] 0 Dir(s) 23,960,858,624 bytes free 
     
 
      
      [bookmark: pgfId-1385243] 
     
 
      
      [bookmark: pgfId-1385046]C:\Program Files\Cisco Systems\dcm\dcnm\bin> 
     
 
      
      [bookmark: pgfId-1385105] 
     
 
    
 
     
      [bookmark: pgfId-1118604][bookmark: 31973]Cleaning a DCNM-LAN Database[bookmark: marker-1173978]
 
     [bookmark: pgfId-1119030]You can use the DCNM-LAN database clean script to clean the database, which deletes all data from the DCNM-LAN database. You might want to clean the database for the following reasons:
 
      
      	 [bookmark: pgfId-1385754]You want to restore the DCNM-LAN database from a backup.
 
      	 [bookmark: pgfId-1391835]You want to delete all data and rebuild your DCNM-LAN implementation without restoring data from a backup.
 
     
 
     [bookmark: pgfId-1391852]The DCNM-LAN server installer configures the clean script with the database username and database name that you specified during the server installation.
 
    
 
     
      [bookmark: pgfId-1391836]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1391837]Back up the DCNM-LAN database. Any data not preserved in a backup is lost when you clean the database.
 
     [bookmark: pgfId-1385517]Stop the DCNM-LAN server. The DCNM-LAN server must be down before you can finish the database cleaning procedure. For more information, see the “Stopping DCNM-LAN Servers” section.
 
    
 
     
      [bookmark: pgfId-1119848]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1385558]Step 1 On the DCNM-LAN server, access a command prompt.
 
     [bookmark: pgfId-1385842]Step 2 If you have not already done so, stop the DCNM-LAN server. For more information, see the “Stopping DCNM-LAN Servers” section.
 
     [bookmark: pgfId-1391890]Step 3 Use the cd command to change the directory to the bin directory under the Cisco DCNM installation directory, as follows:
 
     [bookmark: pgfId-1391891]cd path
 
     [bookmark: pgfId-1391892]where path is the relative or absolute path to the bin directory. For Microsoft Windows, the default path to the bin directory is C:\Program Files\dcm\dcnm\bin. For RHEL, the default path to the bin directory is /usr/local/cisco/dcm/dcnm/bin.
 
     [bookmark: pgfId-1391893]Step 4 Run the Cisco DCNM database clean script. The script name depends upon the server operating system and database type, as shown in the following table:
 
     [bookmark: pgfId-1392001]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1391969]Server Operating System 
          
  
         	 
           
           [bookmark: pgfId-1391971]Database Type 
          
  
         	 
           
           [bookmark: pgfId-1391973]Clean Script 
          
  
        
 
         
         	 [bookmark: pgfId-1391975]Microsoft Windows
  
         	[bookmark: pgfId-1391977]PostgreSQL
  
         	[bookmark: pgfId-1391979]clean-pgsql-dcnm-db.bat
  
        
 
         
         	[bookmark: pgfId-1391983]Oracle
  
         	[bookmark: pgfId-1391985]clean-oracle-dcnm-db.bat
  
        
 
         
         	 [bookmark: pgfId-1391987]Linux
  
         	[bookmark: pgfId-1391989]PostgreSQL
  
         	[bookmark: pgfId-1391991]clean-pgsql-dcnm-db.sh
  
        
 
         
         	[bookmark: pgfId-1391995]Oracle
  
         	[bookmark: pgfId-1391997]clean-oracle-dcnm-db.sh
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1392014]Step 5 At the confirmation prompt, enter y to continue with cleaning the database.
 
     [bookmark: pgfId-1385791]Step 6 If you want to restore the DCNM-LAN database from a backup, proceed to the “Restoring a DCNM-LAN Database from a Backup File” section. Do not start the DCNM-LAN server.
 
     [bookmark: pgfId-1385814]If you do not want to restore the DCNM-LAN database from a backup and want to rebuild your DCNM-LAN implementation manually, start the DCNM-LAN server. See the “Starting a Single DCNM-LAN Server” section.
 
     [bookmark: pgfId-1119858]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1385980]Example
 
     [bookmark: pgfId-1386052]The following example from a Windows server shows how to clean a PostgreSQL DCNM-LAN database that was installed using default values:
 
      
      [bookmark: pgfId-1392029]C:\Documents and Settings\Administrator>cd "C:\Program Files\Cisco Systems\dcm\dcnm\bin" 
     
 
      
      [bookmark: pgfId-1392030] 
     
 
      
      [bookmark: pgfId-1392059]C:\Program Files\Cisco Systems\dcm\dcnm\bin>clean-pgsql-dcnm-db.bat 
     
 
      
      [bookmark: pgfId-1392060] 
     
 
      
      [bookmark: pgfId-1392061] ======================================================== 
     
 
      
      [bookmark: pgfId-1392062] 
     
 
      
      [bookmark: pgfId-1392063] Database Postgres Environment 
     
 
      
      [bookmark: pgfId-1392064] 
     
 
      
      [bookmark: pgfId-1392065] PostgreSQL Bin Path : ""C:\Program Files\Cisco Systems\dcm\db"\bin" 
     
 
      
      [bookmark: pgfId-1392066] 
     
 
      
      [bookmark: pgfId-1392067] DCNM Database Name : "dcmdb" 
     
 
      
      [bookmark: pgfId-1392068] 
     
 
      
      [bookmark: pgfId-1392069] DCNM Database User Name : "dcnmuser" 
     
 
      
      [bookmark: pgfId-1392070] 
     
 
      
      [bookmark: pgfId-1392071] DCNM Database SuperUser Name : "cisco" 
     
 
      
      [bookmark: pgfId-1392072] ========================================================= 
     
 
      
      [bookmark: pgfId-1392073] 
     
 
      
      [bookmark: pgfId-1392074] 
     
 
      
      [bookmark: pgfId-1392075] 
     
 
      
      [bookmark: pgfId-1392076] *************************************************************************** 
     
 
      
      [bookmark: pgfId-1392077] PLEASE MAKE SURE THE DCNM SERVICE IS SHUTDOWN BEFORE RUNNING THIS SCRIPT!! 
     
 
      
      [bookmark: pgfId-1392078] *************************************************************************** 
     
 
      
      [bookmark: pgfId-1392079] 
     
 
      
      [bookmark: pgfId-1392080] 
     
 
      
      [bookmark: pgfId-1392081]DCNM database schema "dcnmuser" will be deleted permanently... 
     
 
      
      [bookmark: pgfId-1392082] 
     
 
      
      [bookmark: pgfId-1392083]Please Confirm y/n [n] : y 
     
 
      
      [bookmark: pgfId-1392084]. 
     
 
      
      [bookmark: pgfId-1392085]. 
     
 
      
      [bookmark: pgfId-1392086]. 
     
 
      
      [bookmark: pgfId-1392087] Operation Completed 
     
 
      
      [bookmark: pgfId-1386105]C:\Program Files\Cisco Systems\dcm\dcnm\bin> 
     
 
      
      [bookmark: pgfId-1392114] 
     
 
    
 
     
      [bookmark: pgfId-1118637][bookmark: 69928]Restoring a DCNM-LAN Database from a Backup File[bookmark: marker-1388105]
 
     [bookmark: pgfId-1375865]You can use the Cisco DCNM database restore script to restore the DCNM-LAN database from a backup file. The restore script cleans the database prior to restoring it.
 
    
 
     
      [bookmark: pgfId-1375867]BEFORE YOU BEGIN
 
     [bookmark: pgfId-1392255]Locate the backup file that you want to use to restore the DCNM-LAN database.
 
     [bookmark: pgfId-1383981]Ensure that the backup file that you want to use to restore the database was made from the same release of DCNM-LAN. For example, you can only restore a Cisco DCNM Release 5.0(2) database from a backup file created from a Cisco DCNM Release 5.0(2) database.
 
     [bookmark: pgfId-1392191]Ensure that the backup file was made from the same database type and release as the current database. For example, you can only restore an Oracle 11g database from a backup file made from an Oracle 11g database.
 
     [bookmark: pgfId-1397248]Ensure that the backup file was made from a DCNM-LAN database running in the same operating system as the DCNM-LAN server that you want to restore the database to. For example, backup files made from a database running in Microsoft Server 2003 can only be used to restore other DCNM-LAN databases running in Microsoft Server 2003.
 
     [bookmark: pgfId-1384008]The DCNM-LAN server must be stopped while you are restoring the database.
 
    
 
     
      [bookmark: pgfId-1118932]DETAILED STEPS
 
     
 
     [bookmark: pgfId-1386112]Step 1 On the DCNM-LAN server, access a command prompt.
 
     [bookmark: pgfId-1392645]Step 2 If you have not already done so, stop the DCNM-LAN server. For more information, see the “Stopping DCNM-LAN Servers” section.
 
     [bookmark: pgfId-1392271]Step 3 Use the cd command to change the directory to the bin directory under the Cisco DCNM installation directory, as follows:
 
     [bookmark: pgfId-1392272]cd path
 
     [bookmark: pgfId-1392273]where path is the relative or absolute path to the bin directory. For Microsoft Windows, the default path to the bin directory is C:\Program Files\dcm\dcnm\bin. For RHEL, the default path to the bin directory is /usr/local/cisco/dcm/dcnm/bin.
 
     [bookmark: pgfId-1392274]Step 4 Run the Cisco DCNM database restore script. The script name depends upon the server operating system and database type, as shown in the following table:
 
     [bookmark: pgfId-1392360]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1392563]Server Operating System 
          
  
         	 
           
           [bookmark: pgfId-1392565]Database Type 
          
  
         	 
           
           [bookmark: pgfId-1392567]Restore Script 
          
  
        
 
         
         	 [bookmark: pgfId-1392569]Microsoft Windows
  
         	[bookmark: pgfId-1392571]PostgreSQL
  
         	[bookmark: pgfId-1392573]restore-pgsql-dcnm-db.bat
  
        
 
         
         	[bookmark: pgfId-1392577]Oracle
  
         	[bookmark: pgfId-1392579]restore-oracle-dcnm-db.bat
  
        
 
         
         	 [bookmark: pgfId-1392581]Linux
  
         	[bookmark: pgfId-1392583]PostgreSQL
  
         	[bookmark: pgfId-1392585]restore-pgsql-dcnm-db.sh
  
        
 
         
         	[bookmark: pgfId-1392589]Oracle
  
         	[bookmark: pgfId-1392591]restore-oracle-dcnm-db.sh
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1392655]Step 5 Enter the name of the backup file that you want to use to restore the DCNM-LAN database.
 
     [bookmark: pgfId-1392656]Step 6 At the confirmation prompt, enter y to continue with the database restore.
 
     [bookmark: pgfId-1386132]Step 7 To resume using DCNM-LAN, start the DCNM-LAN server. See the “Starting a Single DCNM-LAN Server” section.
 
     [bookmark: pgfId-1386136]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1386237]Example
 
     [bookmark: pgfId-1386290]The following example from a Microsoft Windows server shows how to restore a DCNM-LAN PostgreSQL database that was installed using default values and using a backup file named masterbackup.bkp that exists in the bin directory Cisco DCNM installation directory:
 
      
      [bookmark: pgfId-1392681]C:\Documents and Settings\Administrator>cd "C:\Program Files\Cisco Systems\dcm\dcnm\bin" 
     
 
      
      [bookmark: pgfId-1392682] 
     
 
      
      [bookmark: pgfId-1392690] 
     
 
      
      [bookmark: pgfId-1392691]C:\Program Files\Cisco Systems\dcm\dcnm\bin>restore-pgsql-dcnm-db.bat 
     
 
      
      [bookmark: pgfId-1392692] ======================================================== 
     
 
      
      [bookmark: pgfId-1392693] 
     
 
      
      [bookmark: pgfId-1392694] Database Postgres Environment 
     
 
      
      [bookmark: pgfId-1392695] 
     
 
      
      [bookmark: pgfId-1392696] PostgreSQL Bin Path : ""C:\Program Files\Cisco Systems\dcm\db"\bin" 
     
 
      
      [bookmark: pgfId-1396042] 
     
 
      
      [bookmark: pgfId-1396043] DCNM Database Name : "dcmdb" 
     
 
      
      [bookmark: pgfId-1396044] 
     
 
      
      [bookmark: pgfId-1392700] DCNM Database User Name : "dcnmuser" 
     
 
      
      [bookmark: pgfId-1392701] 
     
 
      
      [bookmark: pgfId-1392702] ======================================================== 
     
 
      
      [bookmark: pgfId-1392703] 
     
 
      
      [bookmark: pgfId-1392704] 
     
 
      
      [bookmark: pgfId-1392705] *************************************************************************** 
     
 
      
      [bookmark: pgfId-1392706] PLEASE MAKE SURE THE DCNM SERVICE IS SHUTDOWN BEFORE RUNNING THIS SCRIPT!! 
     
 
      
      [bookmark: pgfId-1392707] *************************************************************************** 
     
 
      
      [bookmark: pgfId-1392708] 
     
 
      
      [bookmark: pgfId-1392709] 
     
 
      
      [bookmark: pgfId-1392710] 
     
 
      
      [bookmark: pgfId-1392711]Please enter the filename to be used for Database Restore:masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1392712]"" 
     
 
      
      [bookmark: pgfId-1392713]"Database Schema "dcnmuser" will be Restore from filename : masterbackup.bkp" 
     
 
      
      [bookmark: pgfId-1392714]"" 
     
 
      
      [bookmark: pgfId-1392715]Continue y/n [n] : y 
     
 
      
      [bookmark: pgfId-1392716] 
     
 
      
      [bookmark: pgfId-1392717]"Cleaning the database... 
     
 
      
      [bookmark: pgfId-1392718]. 
     
 
      
      [bookmark: pgfId-1392719]. 
     
 
      
      [bookmark: pgfId-1392720]. 
     
 
      
      [bookmark: pgfId-1392721]"Done" 
     
 
      
      [bookmark: pgfId-1392722]pg_restore: connecting to database for restore 
     
 
      
      [bookmark: pgfId-1392723]. 
     
 
      
      [bookmark: pgfId-1392724]. 
     
 
      
      [bookmark: pgfId-1392725]. 
     
 
      
      [bookmark: pgfId-1392726]Restored Database from : masterbackup.bkp 
     
 
      
      [bookmark: pgfId-1392727] Operation Completed 
     
 
      
      [bookmark: pgfId-1386280]C:\Program Files\Cisco Systems\dcm\dcnm\bin> 
     
 
      
      [bookmark: pgfId-1386288] 
     
 
    
 
   
 
    
     [bookmark: pgfId-1381983][bookmark: 53004]Additional References
 
    [bookmark: pgfId-1381984]For additional information related to maintaining the DCNM-LAN database, see the following sections:
 
     
     	 [bookmark: pgfId-1381988]Related Documents
 
     	 [bookmark: pgfId-1381992]Standards
 
    
 
     
      [bookmark: pgfId-1382013][bookmark: 16521]Related Documents
 
     [bookmark: pgfId-1382342]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1381996]Related Topic 
          
  
         	 
           
           [bookmark: pgfId-1381998]Document Title 
          
  
        
 
         
         	[bookmark: pgfId-1382000]Automatic purge of event data
  
         	[bookmark: pgfId-1382005]Chapter 29, “Administering Auto-Synchronization with Devices”
  
        
 
         
         	[bookmark: pgfId-1382007]Automatic purge of statistical data
  
         	[bookmark: pgfId-1382012]Chapter 30, “Administering Statistical Data Collection”
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1382024][bookmark: 55398]Standards
 
     [bookmark: pgfId-1382350]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1382017]Standards 
          
  
         	 
           
           [bookmark: pgfId-1382019]Title 
          
  
        
 
         
         	[bookmark: pgfId-1382021]No new or modified standards are supported by this feature, and support for existing standards has not been modified by this feature.
  
         	[bookmark: pgfId-1382023]—
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1393641][bookmark: 92503]Feature History for DCNM-LAN Database Maintenance
 
    [bookmark: pgfId-1393645]Table 35-1 lists the release history for this feature.
 
    [bookmark: pgfId-1393669]
 
     
      
       
       [bookmark: pgfId-1393652]Table 35-1 [bookmark: 50557]Feature History for DCNM-LAN Database Maintenance 
 
       
       
        
        	 
          
          [bookmark: pgfId-1393658]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1393660]Releases 
         
  
        	 
          
          [bookmark: pgfId-1393662]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1393664]Database maintenance scripts
  
        	[bookmark: pgfId-1393666]5.0(2)
  
        	[bookmark: pgfId-1393668]No change from Release 4.2(3).
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1326799]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1007671][bookmark: 95993]DCNM-SAN Event Management 
      
      
 
     
 
 
    [bookmark: pgfId-1018953]DCNM Event Management tool (EMAN) offers event management capability directly in Cisco MDS, Nexus 7000 and 5000 series switches to monitor events and take informational or corrective action as events occur, or when a threshold is reached. EMAN captures the state of the switches during critical situations helping to take immediate recovery actions and gather information to perform root-cause analysis. 
 
    [bookmark: pgfId-1018955]An event is generated when the object matches specified values or crosses specified thresholds. When it detects an event, EMAN will parse the event for the host name, severity and then determine the host-to-application dependency by comparing the event in the host table. EMAN monitors these events to detect the severity type such as warning, critical and emergency of the events. It will also list the impacted components such as a host, ISL or a storage port. Switch health and performance threshold are the two event types that the EMAN monitor.
 
    [bookmark: pgfId-1010285]This Appendix contains the following sections:
 
     
     	 [bookmark: pgfId-1010286]Benefits of the Event Management Tool
 
     	 [bookmark: pgfId-1010318]DCNM-SAN Event Management
 
     	 [bookmark: pgfId-1023735]DCNM-SAN Event Classification
 
    
 
   
 
    
     [bookmark: pgfId-1010288][bookmark: 50444]Benefits of the Event Management Tool
 
    [bookmark: pgfId-1019119]EMAN tracks resource utilization and resource depletion by monitoring events in 45000 ports and 240 switches. It also provides a mechanism to send notifications whenever the specified threshold values are exceeded by any of the components. This notification helps network administrators diagnose resource utilization issues and prioritize resources making it more scalable.
 
    [bookmark: pgfId-1019121]EMAN helps in addressing component issues real time by performing the following functions:
 
     
     	 [bookmark: pgfId-1019172]Monitoring resource usage.
 
     	 [bookmark: pgfId-1019124]Using resource threshold pre-sets.
 
     	 [bookmark: pgfId-1019125]Generating alerts when resource utilization reaches the specified level.
 
     	 [bookmark: pgfId-1019203]Provides dependency path mapping.
 
    
 
   
 
    
     [bookmark: pgfId-1019215][bookmark: 29941]DCNM-SAN Event Management 
 
    [bookmark: pgfId-1019239]This section describes how DCNM handles asynchronous transfer events from the managed switches and contains the following topics:
 
     
      [bookmark: pgfId-1019479][bookmark: 16366]Events
 
     [bookmark: pgfId-1019480]The following are the three primary methods by which DCNM detects events:
 
      
      	 [bookmark: pgfId-1019401]SNMP—The Simple Network Management Protocol v1 (SNMPv1) event detector allows an event to be generated when the object matches specified values or crosses specified thresholds. The Cisco MDS 9000 switch can contain up to 10 trap destinations. The unmanaged fabrics or switches are removed from the list of traps destinations.
 
      	 [bookmark: pgfId-1019278]Syslog—DCNM-SAN receives syslog messages and are logged in the events table in the database and archived on each switch. 
 
      	 [bookmark: pgfId-1019406]Fabric Model— DCNM-SAN can function even without receiving SNMP traps from the managed switches. DCNM-SAN polls for traps every 5 minutes and does a deeper discovery every 30 minutes by default. 
 
     
 
    
 
     
      [bookmark: pgfId-1019709]Purpose
 
     [bookmark: pgfId-1019710]Asynchronous event handling serves the following purposes:
 
      
      	 [bookmark: pgfId-1019711]Model Update—DCNM-SAN design the model of the physical and logical connectivity of each fabric. Asynchronous events enables real time synchronization with the fabric. In cases such as a linkdown, this model quickly updates the event without polling the fabric. However, for major changes such as an ISL link change, this model polls the fabric to synchronize.
 
      	 [bookmark: pgfId-1019520]Log—All the events are logged into a database. The number of events that can be logged is set to 10,000 by default. You can view this log in the Cisco DCNM-SAN Client and in Cisco DCNM Web Client. The Cisco DCNM Web Client stores all events in the database unless you do not apply any filteres. The Cisco DCNM-SAN Client log is restricted to the fabric(s) that are opened in the client’s interface. TheCisco DCNM-SAN Client automatically updates the table as new events appear. 
 
      	 [bookmark: pgfId-1019500]Map—The Cisco DCNM-SAN Client’s updates the map automatically when topology changes.
 
     
 
    
 
     
      [bookmark: pgfId-1019691]Forwarding
 
     [bookmark: pgfId-1019692]Events are forwarded in three ways:
 
      
      	 [bookmark: pgfId-1019726]Cisco Call Home—The Cisco MDS 9000 series switches generates an email at the event of a critical event such as a module down etc. You can customize this email to include additional information. You can use Cisco DCNM-SAN client to configure Cisco call home feature and it has no operational dependency on Cisco DCNM.
 
      	 [bookmark: pgfId-1019728]EMC Call Home—If you enable this feature, the Cisco DCNM server generates an EMC call home email at the event of a critical event such as a linkDown event etc. This email is created in XML format.
 
      	 [bookmark: pgfId-1019730]Event Forwarding—You can optionally choose to send an email or SNMP traps from Cisco DCNM for any or all events that are logged into the database.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1019853][bookmark: 36467]DCNM-SAN Event Classification
 
     
      [bookmark: pgfId-1019861]Port Events
 
     [bookmark: pgfId-1019866]Port events provides real-time information about the operational status of the host ports, storage ports, ISLs, NPV etc in your network. At the event of a fault, the Cisco DCNM EMAN generates an event or events that are rolled up into an alert. The port events are broadly classified into two as follows:
 
      
      	 [bookmark: pgfId-1019886]Service Impacting—Indicates the severity of the event that impacts the service. Examples are PMON, RMON and SFP events.
 
      	 [bookmark: pgfId-1019887]Outage—Indicates the severity of the event that impacts the functioning of the device. Exampls are link up/down and threshold events.
 
     
 
    
 
     
      [bookmark: pgfId-1019869]Event Log Format
 
     [bookmark: pgfId-1020000]Events log consists of parseable information that is available to higher level management applications in the following format:
 
      
      [bookmark: pgfId-1020025] <fabric>/<switch> <localTime> <severity> <type> <description> 
     
 
     [bookmark: pgfId-1020023]
 
      
      	 [bookmark: pgfId-1019873]Fabric/Switch—The name of the fabric or the switch.
 
      	 [bookmark: pgfId-1020113]LocalTime—The date and time of the event occurred. The time is in the following format: hh:mm:ss.ttt. The date is in the following format: MM/DD/YYYY.
 
      	 [bookmark: pgfId-1020114]Severity—Event severity level, combination of single events, or a range of event severity levels. The severity contains one of the following. 
 
     
 
     [bookmark: pgfId-1020115] – Emergencies
 
     [bookmark: pgfId-1020029] – Alert
 
     [bookmark: pgfId-1020030] – Critical 
 
     [bookmark: pgfId-1020108] – Error
 
     [bookmark: pgfId-1020031] – Warning
 
     [bookmark: pgfId-1020032] – Notice
 
     [bookmark: pgfId-1020033] – Informational
 
     [bookmark: pgfId-1020034] – Debugging
 
      
      	 [bookmark: pgfId-1019876]Type—Type of events.
 
     
 
     [bookmark: pgfId-1020088] – Fabric
 
     [bookmark: pgfId-1020089] – FICON
 
     [bookmark: pgfId-1020090] – IVR
 
     [bookmark: pgfId-1020091] – License
 
     [bookmark: pgfId-1020092] – Other
 
     [bookmark: pgfId-1020093] – Port Alarm
 
     [bookmark: pgfId-1020094] – Port Up and Port Down
 
     [bookmark: pgfId-1020096] – Security
 
     [bookmark: pgfId-1020097] – Switch Hardware
 
     [bookmark: pgfId-1020098] – Switch Manageability
 
     [bookmark: pgfId-1020099] – Threshold
 
     [bookmark: pgfId-1020100] – VSAN
 
     [bookmark: pgfId-1020101] – Zone
 
      
      	 [bookmark: pgfId-1019877]Description—Description of the event in the following format: 
 
     
 
      
      [bookmark: pgfId-1020140]<portType>: <name>, Port: <interface>, VSAN: <vsanId(s)>, <condition>
 
     
 
     [bookmark: pgfId-1020227]
 
    
 
     
      [bookmark: pgfId-1020228]Event Types
 
    
 
     
      [bookmark: pgfId-1020233]IVR
 
     [bookmark: pgfId-1020242]Table C-1 IVR Events 
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1020276]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1020278]Description 
          
  
        
 
         
         	[bookmark: pgfId-1020346]civrDomainConflictNotify
  
         	[bookmark: pgfId-1020282]
  
        
 
         
         	[bookmark: pgfId-1020348]civrZoneActivationDoneNotify
  
         	[bookmark: pgfId-1020286]
  
        
 
         
         	[bookmark: pgfId-1020350]civrZoneCompactNotify
  
         	[bookmark: pgfId-1020290]
  
        
 
         
         	[bookmark: pgfId-1020352]civrZoneDeactivationDoneNotify
  
         	[bookmark: pgfId-1020294]
  
        
 
         
         	[bookmark: pgfId-1020354]civrDomainConflictNotify
  
         	[bookmark: pgfId-1020298]
  
        
 
         
         	[bookmark: pgfId-1020356]civrAfidConfigNotify
  
         	[bookmark: pgfId-1020302]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1020441]
 
    
 
     
      [bookmark: pgfId-1020442]License
 
     [bookmark: pgfId-1020481]Table C-2 Licence Events
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1020454]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1020456]Description 
          
  
        
 
         
         	[bookmark: pgfId-1020544]clmLicenseExpiryNotify
  
         	[bookmark: pgfId-1020460]
  
        
 
         
         	[bookmark: pgfId-1020546]clmLicenseExpiryWarningNotify
  
         	[bookmark: pgfId-1020464]
  
        
 
         
         	[bookmark: pgfId-1020548]clmLicenseFileMissingNotify
  
         	[bookmark: pgfId-1020468]
  
        
 
         
         	[bookmark: pgfId-1020550]clmNoLicenseForFeatureNotify
  
         	[bookmark: pgfId-1020472]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1020374]Port Alarm
 
     [bookmark: pgfId-1020574]Any RMON event that relates to an interface object.
 
     [bookmark: pgfId-1020590]Table C-3 Port Alarm Event
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1020594]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1020596]Description 
          
  
        
 
         
         	[bookmark: pgfId-1020598]cIfXcvrMonStatusChangeNotif
  
         	[bookmark: pgfId-1020600]
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1020576]
 
    
 
     
      [bookmark: pgfId-1020577]Port Up and Port Down
 
     [bookmark: pgfId-1020578]Model-generated events relating to Host, Storage, ISL, NP_Links
 
     [bookmark: pgfId-1024111]Table C-4 IVR Events 
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1024084]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1024086]Description 
          
  
        
 
         
         	[bookmark: pgfId-1024203]linkup
  
         	[bookmark: pgfId-1024090]
  
        
 
         
         	[bookmark: pgfId-1024205]linkDown
  
         	[bookmark: pgfId-1024094]
  
        
 
         
         	[bookmark: pgfId-1024207]cieLinkUp
  
         	[bookmark: pgfId-1024098]
  
        
 
         
         	[bookmark: pgfId-1024209]cieLinkDown
  
         	[bookmark: pgfId-1024102]
  
        
 
         
         	[bookmark: pgfId-1024211]connUnitPortStatusChange
  
         	[bookmark: pgfId-1024125]
  
        
 
         
         	[bookmark: pgfId-1024213]fcNameServerEntryAdd
  
         	[bookmark: pgfId-1024129]
  
        
 
         
         	[bookmark: pgfId-1024215]fcNameServerEntryDelete
  
         	[bookmark: pgfId-1024133]
  
        
 
         
         	[bookmark: pgfId-1024217]fcTrunkIfDownNotify
  
         	[bookmark: pgfId-1024137]
  
        
 
         
         	[bookmark: pgfId-1024219]fcTrunkIfUpNotify
  
         	[bookmark: pgfId-1024106]
  
        
 
         
         	[bookmark: pgfId-1024221]cieDelayedLinkUpDownNotif
  
         	[bookmark: pgfId-1024110]
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1020583]Note Port Moved events will not be logged.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1020377]Security
 
     [bookmark: pgfId-1020749]Table C-5 Security Event Types
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1020914]Event Name 
          
  
         	 
           
           [bookmark: pgfId-1020916]Description 
          
  
        
 
         
         	[bookmark: pgfId-1021028]casServerStateChange
  
         	[bookmark: pgfId-1020920]
  
        
 
         
         	[bookmark: pgfId-1021030]cfcspAuthFailTrap
  
         	[bookmark: pgfId-1020924]
  
        
 
         
         	[bookmark: pgfId-1021032]ciscoPsmFabricBindDenyNotifyNew
  
         	[bookmark: pgfId-1020928]
  
        
 
         
         	[bookmark: pgfId-1021034]ciscoEnhIpsecFlowBadSa
  
         	[bookmark: pgfId-1020932]
  
        
 
         
         	[bookmark: pgfId-1021036]ciscoEnhIpsecFlowSetupFail
  
         	[bookmark: pgfId-1020936]
  
        
 
         
         	[bookmark: pgfId-1021038]ciscoEnhIpsecFlowSysFailure
  
         	[bookmark: pgfId-1020940]
  
        
 
         
         	[bookmark: pgfId-1021040]ciscoEnhIpsecFlowTunnelStart
  
         	[bookmark: pgfId-1020944]
  
        
 
         
         	[bookmark: pgfId-1021042]ciscoEnhIpsecFlowTunnelStop
  
         	[bookmark: pgfId-1020948]
  
        
 
         
         	[bookmark: pgfId-1021044]ciscoIPsecProvCryptomapAdded
  
         	[bookmark: pgfId-1020952]
  
        
 
         
         	[bookmark: pgfId-1021046]ciscoIPsecProvCryptomapAttached
  
         	[bookmark: pgfId-1020956]
  
        
 
         
         	[bookmark: pgfId-1021048]ciscoIPsecProvCryptomapDeleted
  
         	[bookmark: pgfId-1020960]
  
        
 
         
         	[bookmark: pgfId-1021050]ciscoIPsecProvCryptomapDetached
  
         	[bookmark: pgfId-1020984]
  
        
 
         
         	[bookmark: pgfId-1021052]ciscoIkeConfigOperStateChanged
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         	[bookmark: pgfId-1023379]virtualNwIfDeleteEntryNotify
  
         	[bookmark: pgfId-1022646]
  
        
 
         
         	[bookmark: pgfId-1023381]vlanTrunkPortDynamicStatusChange
  
         	[bookmark: pgfId-1022650]
  
        
 
         
         	[bookmark: pgfId-1023383]vrrpTrapAuthFailure
  
         	[bookmark: pgfId-1022654]
  
        
 
         
         	[bookmark: pgfId-1023385]vrrpTrapNewMaster
  
         	[bookmark: pgfId-1022658]
  
        
 
         
         	[bookmark: pgfId-1023387]vtpConfigDigestError
  
         	[bookmark: pgfId-1022662]
  
        
 
         
         	[bookmark: pgfId-1023389]vtpConfigRevNumberError
  
         	[bookmark: pgfId-1022666]
  
        
 
         
         	[bookmark: pgfId-1023391]vtpLocalModeChanged
  
         	[bookmark: pgfId-1022670]
  
        
 
         
         	[bookmark: pgfId-1023393]vtpMtuTooBig
  
         	[bookmark: pgfId-1022674]
  
        
 
         
         	[bookmark: pgfId-1023395]vtpPruningStateOperChange
  
         	[bookmark: pgfId-1022678]
  
        
 
         
         	[bookmark: pgfId-1023397]vtpServerDisabled
  
         	[bookmark: pgfId-1022682]
  
        
 
         
         	[bookmark: pgfId-1023399]vtpVersionInUseChanged
  
         	[bookmark: pgfId-1022686]
  
        
 
         
         	[bookmark: pgfId-1023401]vtpVersionOneDeviceDetected
  
         	[bookmark: pgfId-1022690]
  
        
 
         
         	[bookmark: pgfId-1023403]vtpVlanCreated
  
         	[bookmark: pgfId-1022694]
  
        
 
         
         	[bookmark: pgfId-1023405]vtpVlanDeleted
  
         	[bookmark: pgfId-1022698]
  
        
 
         
         	[bookmark: pgfId-1023407]vtpVlanRingNumberConflict
  
         	[bookmark: pgfId-1022702]
  
        
 
         
         	[bookmark: pgfId-1023409]wwnmType1WwnAvailableNotify
  
         	[bookmark: pgfId-1022706]
  
        
 
         
         	[bookmark: pgfId-1023411]wwnmType1WwnShortageNotify
  
         	[bookmark: pgfId-1022710]
  
        
 
         
         	[bookmark: pgfId-1023413]wwnmTypeOtherWwnAvailableNotify
  
         	[bookmark: pgfId-1022714]
  
        
 
         
         	[bookmark: pgfId-1023415]wwnmTypeOtherWwnShortageNotify
  
         	[bookmark: pgfId-1022718]
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1021880]
 
     [bookmark: pgfId-1021881]
 
     [bookmark: pgfId-1008042]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1007671][bookmark: 95993]Vcenter Plugin 
      
      
 
     
 
 
    [bookmark: pgfId-1018955]VMware Vcenter plugin allows you to monitor the Cisco Unified Computing System™ (Cisco UCS), Cisco Nexus, and Cisco MDS 9000 Family platforms through Cisco Prime DCNM.
 
    [bookmark: pgfId-1025814]The Cisco Prime DCNM plug-in for VMware Vcenter adds a multihop view and monitoring of Ethernet and Fibre Channel Cisco Nexus and Cisco MDS 9000 Family topologies. The increased visibility into virtualized infrastructure helps network administrators locate performance anomalies that may cause service degradation. It also aids to eliminate virtual computing and networking as a root cause of the problem.
 
    [bookmark: pgfId-1010285]This Appendix contains the following sections:
 
     
     	 [bookmark: pgfId-1010286]Associating Vcenter with the Datasource
 
     	 [bookmark: pgfId-1010318]Registering Vcenter plugin
 
     	 [bookmark: pgfId-1023735]Triggering the plugin
 
     	 [bookmark: pgfId-1027368]Removing the plugin
 
    
 
   
 
    
     [bookmark: pgfId-1010288][bookmark: 50444]Associating Vcenter with the Datasource
 
    [bookmark: pgfId-1019119]To associate the Vcenter with the datasource, Cisco DCNM must discover the LAN and SAN devices.
 
    [bookmark: pgfId-1026068]Navigate to Admin > Data Source > Fabric to check if the LAN/SAN devices are discovered on the Cisco DCNM Web Client. In the Admin > Data Sources > VMWare block, click + to add the Vcenter to the datasource.
 
   
 
    
     [bookmark: pgfId-1026442][bookmark: 76915]Registering Vcenter plugin
 
    [bookmark: pgfId-1026487]To register the Vcenter plugin, run the RegisterPlugin script. Enter the Vcenter IP address, Vcenter username, Vcenter password, and complete URL of the DCNM server. The plugin configuration file is stored in the DCNM server.
 
     
     [bookmark: pgfId-1026488]Example:  
    
 
     
     [bookmark: pgfId-1026778]RegisterPlugin.bat -add 172.22.29.87 admin nbv123 https://dcnm-san-001:443 
    
 
   
 
    
     [bookmark: pgfId-1026807][bookmark: 59932]Triggering the plugin
 
    [bookmark: pgfId-1026850]When user clicks on the menu, it will show the login page first, and then will launch an internal browser which will show the host dashboard.
 
   
 
    
     [bookmark: pgfId-1019215][bookmark: 29941]Removing the plugin
 
    [bookmark: pgfId-1019239]To remove the Vcenter plugin, run the RegisterPlugin script. Enter the Vcenter IP address, Vcenter username, Vcenter password, and complete URL of the DCNM server. The plugin configuration file is located in the DCNM server.
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1006077][bookmark: 94595]Interface Nonoperational Reason Codes 
      
      
 
     
 
 
     
      
       
       [bookmark: pgfId-1041193]Table B-1 [bookmark: 87507]Reason Codes for Nonoperational States 
 
       
       
        
        	 
          
          [bookmark: pgfId-1041199]Reason Code 
         
  
        	 
          
          [bookmark: pgfId-1041201]Description 
         
  
        	 
          
          [bookmark: pgfId-1041203]Applicable Modes 
         
  
       
 
        
        	[bookmark: pgfId-1041206][bookmark: marker-1041205]Link failure or not connected
  
        	[bookmark: pgfId-1041208]Physical layer link is not operational.
  
        	 [bookmark: pgfId-1041210]All
  
       
 
        
        	[bookmark: pgfId-1041213][bookmark: marker-1041212]SFP not present
  
        	[bookmark: pgfId-1041215]The small form-factor pluggable (SFP) hardware is not plugged in.
  
       
 
        
        	[bookmark: pgfId-1041219]Initializing
  
        	[bookmark: pgfId-1041221]The physical layer link is operational and the protocol initialization is in progress.
  
       
 
        
        	[bookmark: pgfId-1041226]Reconfigure fabric in progress
  
        	[bookmark: pgfId-1041228]The fabric is currently being reconfigured.
  
       
 
        
        	[bookmark: pgfId-1041233][bookmark: marker-1041232]Offline
  
        	[bookmark: pgfId-1041235]Cisco MDS SAN-OS waits for the specified R_A_TOV time before retrying initialization.
  
       
 
        
        	[bookmark: pgfId-1041241]Inactive
  
        	[bookmark: pgfId-1041244]The interface VSAN is deleted or is in a suspended state.
 [bookmark: pgfId-1041245]To make the interface operational, assign that port to a configured and active VSAN.
  
       
 
        
        	[bookmark: pgfId-1041249]Hardware failure
  
        	[bookmark: pgfId-1041251]A hardware failure is detected.
  
       
 
        
        	[bookmark: pgfId-1041256]Error disabled
  
        	[bookmark: pgfId-1041258]Error conditions require administrative attention. Interfaces may be error-disabled for various reasons. For example:
 
          
          	 [bookmark: pgfId-1041259]Configuration failure.
 
          	 [bookmark: pgfId-1041262]Incompatible [bookmark: marker-1041260]buffer-to-buffer [bookmark: marker-1041261]credit configuration.
 
         
 [bookmark: pgfId-1041263]To make the interface operational, you must first fix the error conditions causing this state; and next, administratively shut down or enable the interface.
  
       
 
        
        	[bookmark: pgfId-1041270]Isolation due to [bookmark: marker-1041268]ELP[bookmark: marker-1041269] failure
  
        	[bookmark: pgfId-1041272]Port negotiation failed.
  
        	 [bookmark: pgfId-1041274]Only E ports and TE ports 
  
       
 
        
        	[bookmark: pgfId-1041277]Isolation due to [bookmark: marker-1041276]ESC failure
  
        	[bookmark: pgfId-1041279]Port negotiation failed.
  
       
 
        
        	[bookmark: pgfId-1041284]Isolation due to [bookmark: marker-1041283]domain overlap
  
        	[bookmark: pgfId-1041286]The Fibre Channel domains (fcdomain) overlap.
  
       
 
        
        	[bookmark: pgfId-1041291]Isolation due to [bookmark: marker-1041290]domain ID assignment failure
  
        	[bookmark: pgfId-1041293]The assigned domain ID is not valid.
  
       
 
        
        	[bookmark: pgfId-1041298]Isolation due to other side [bookmark: marker-1041297]E port isolated
  
        	[bookmark: pgfId-1041300]The E port at the other end of the link is isolated.
  
       
 
        
        	[bookmark: pgfId-1041304]Isolation due to invalid fabric reconfiguration
  
        	[bookmark: pgfId-1041306]The port is isolated due to fabric reconfiguration.
  
       
 
        
        	[bookmark: pgfId-1041311]Isolation due to domain manager disabled
  
        	[bookmark: pgfId-1041313]The fcdomain feature is disabled.
  
       
 
        
        	[bookmark: pgfId-1041318]Isolation due to [bookmark: zones]zone merge failure
  
        	[bookmark: pgfId-1041320]The zone merge operation failed.
  
       
 
        
        	[bookmark: pgfId-1041325]Isolation due to [bookmark: marker-1041324]VSAN mismatch
  
        	[bookmark: pgfId-1041327]The VSANs at both ends of an ISL are different.
  
       
 
        
        	[bookmark: pgfId-1041332]Nonparticipating
  
        	[bookmark: pgfId-1041335][bookmark: marker-1041334]FL ports cannot participate in loop operations. It may happen if more than one FL port exists in the same loop, in which case all but one FL port in that loop automatically enters nonparticipating mode. 
  
        	[bookmark: pgfId-1041337]Only FL ports and TL ports
  
       
 
        
        	[bookmark: pgfId-1041340][bookmark: marker-1041339]PortChannel administratively down
  
        	[bookmark: pgfId-1041342]The interfaces belonging to the PortChannel are down.
  
        	 [bookmark: pgfId-1041344]Only PortChannel interfaces
  
       
 
        
        	[bookmark: pgfId-1041346]Suspended due to[bookmark: marker-1044533] incompatible speed
  
        	[bookmark: pgfId-1041348]The interfaces belonging to the PortChannel have incompatible speeds.
  
       
 
        
        	[bookmark: pgfId-1041352]Suspended due to[bookmark: marker-1044534] incompatible mode
  
        	[bookmark: pgfId-1041354]The interfaces belonging to the PortChannel have incompatible modes.
  
       
 
        
        	[bookmark: pgfId-1041358]Suspended due to [bookmark: marker-1044535]incompatible remote switch [bookmark: marker-1041359]WWN
  
        	 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    [bookmark: pgfId-997490]THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.
 
    [bookmark: pgfId-997491]THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.
 
    [bookmark: pgfId-997501]The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright  1981, Regents of the University of California. 
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